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EnviroSim License Agreement 

This is a legal agreement between you (either an individual or an entity) and EnviroSim 
Associates Ltd.  If you do not agree with the terms of this agreement, return the software 
and the accompanying material to EnviroSim. 
   

1. GRANT OF LICENSE.  EnviroSim grants you the right to use one copy of the 
enclosed EnviroSim software program on a single computer.  You may not network 
this software or otherwise use it on more than one computer at the same time.   

 
2. COPYRIGHT.  This software is owned by EnviroSim and is protected by Canadian 

copyright laws and international treaty provisions.  Therefore, you must treat the 
software like any other copyrighted material (for example, a book), with the following 
single exception.  EnviroSim authorizes you to make copies of the software so long 
as there is no possibility of it being used on more than one computer at the same 
time.  You may not copy the manual(s) or written materials accompanying the 
software.   

 
3. LICENSE VALIDITY.  The software verifies the license validity using a hardware-

based software protection device, hereafter called the HardLock Key.  This 
HardLock Key must be connected directly to a single PC on which the software is 
installed to execute the software. 

 
4. LEASE CONDITIONS. The GRANT OF LICENSE is limited to the period for which 

the LEASE is valid. The HardLock Key remains the property of EnviroSim and must 
be returned to EnviroSim if the lease is not renewed.   

 
5. OTHER RESTRICTIONS.  You may not sell, rent or lease the software or any of the 

accompanying materials (including, but not limited to HardLock Key).  You may not 
reverse engineer, decompile or disassemble the software.  
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Limited Warranty 
 
EnviroSim warrants that (a) the software will perform substantially in accordance with the 
User Manual(s) for a period of 90 days from the date of receipt; and (b) any hardware 
accompanying the software will be free from defects in materials and workmanship under 
normal use and service for a period of one (1) year from the date of receipt.  Any implied 
warranties on the software and hardware are limited to 90 days and one (1) year, 
respectively.   
 
EnviroSim's entire liability and your only remedy shall be, at EnviroSim's option, either (a) 
return of the purchase price or (b) repair or replacement of the software or hardware that 
does not meet EnviroSim's Limited Warranty.  This Limited Warranty is void if failure of the 
software or hardware has resulted from accident, abuse, or misapplication.   
 
EnviroSim disclaims all other warranties, either express or implied, including but not limited 
to implied warranties of merchantability and fitness for a particular purpose, with respect to 
the software, the accompanying manual(s) and written materials, and any accompanying 
hardware.   
 
In no event shall EnviroSim Associates Ltd. and/or it's owners be liable for any loss of 
profit, or any other commercial damage, including but not limited to special, incidental, 
consequential, or other damages arising out of the use of or inability to use this EnviroSim 
product. 
 
EnviroSim's entire liability under any provision of this agreement shall be limited to the 
amount paid by you for the software.   
 
Should you have any questions concerning this Agreement please contact:  
 
EnviroSim Associates Ltd.,  
7 Innovation Drive, Suite 205,  
Flamborough, Ontario   

L9H 7H9, CANADA. 
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Welcome To BioWin 

Welcome 
Welcome to the latest version of BioWin – BioWin 3 - a comprehensive simulation 
tool for biological wastewater treatment plant design, analysis and training.  The 
package was developed with the primary objective of providing a powerful tool to 
aid both the process designer and operators of these facilities. 

For getting started, go to the "BioWin Tutorials".  This set of tutorials and case 
studies is designed as a training exercise in the application of BioWin.  The primary 
objective is to provide "how to…" training on using the BioWin software itself.  
The case studies are not intended as a course in wastewater treatment process 
engineering.  Nevertheless, several of the case studies focus on process applications 
and identify interesting design and operating issues. 

There are two places where you can find more BioWin examples: 

• Select File|Open and browse to the Examples directory.  These systems 
are discussed in the Help section on BioWin Tutorials and Examples. 

• On the BioWin main window toolbar, at the end on the right, click on the 
arrow next to the icon that looks like a filing cabinet.  This brings down a 
list of pre-configured BioWin process files for a range of system 
configurations.  
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The BioWin wastewater treatment process simulator 

BioWin in Brief 
The user can define and analyze behavior of complex treatment plant configurations 
with single or multiple wastewater inputs.  An example of a plant configuration is 
shown below. 

Most types of wastewater treatment systems can be configured in BioWin using the 
many process modules.  These include: 

• A range of activated sludge bioreactor modules – suspended growth reactors 
(diffused air or surface aeration), various SBRs, media reactors for IFAS 
and MBBR systems, variable volume reactors. 

• Anaerobic and aerobic digesters. 

• Various settling tank modules – primary, ideal and 1-D model settlers. 

• Different input elements – wastewater influent (COD- or BOD-based), user-
defined (state variable concentrations), metal addition for chemical 
phosphorus precipitation (ferric or alum), methanol for denitrification. 

• Other process modules – holding tanks, equalization tanks, dewatering 
units, flow splitters and combiners.  

A crucial component of BioWin is the biological process model.  The BioWin model 
is unique in that it merges both activated sludge and anaerobic biological processes.  
Additionally, the model integrates pH and chemical phosphorus precipitation 
processes. 

It’s easy to use.  The program has the look and feel of the many other Windows 
applications.  When it is launched it comes up with the familiar interface and menu 
structure.  Complex treatment plant schemes can be configured rapidly through "drag 
and drop" mouse actions.  Functions are selected from the pull-down menus, using 
short cut keys, or by pointing the mouse and clicking on icons in the toolbar.  The 
user can also access many of the Windows functions usually embedded in a 
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Windows application; for example, selecting and configuring the printer setup.  
Context-sensitive Help is built into BioWin to provide on-line assistance, particularly 
for new users. 

Careful consideration has gone into the design of the package; for example, the 
hardware and software platforms, the object oriented software development system, 
the data structures, the user interface, and so on.  A primary aim has been the 
production of a package structured to allow on-going development in years to come. 

The BioWin simulator suite presently includes two modules: 

   

• A steady state module for analyzing systems based on constant 
influent loading and/or flow weighted averages of time-varying inputs.  
This unit is also very useful for mass balancing over complex plant 
configurations.  

• An interactive dynamic simulator where the user can operate and 
manipulate the treatment system "on the fly".  This module is ideal for 
training and for analyzing system response when subjected to time-
varying inputs or changes in operating strategy. 

 

About The Manual 
This manual is available to you in both printed and online format.  The content of 
both formats is identical – the choice is offered merely for your convenience.  For 
information on printing the manual, please see How To Print the Manual.  For 
information about the online help system, please see On-line Help. 

Layout 
Material in this manual divides into several parts: 

• Chapter 1 (this chapter) introduces you to BioWin. 

• Chapter 2 gives a quick tour of BioWin features. 
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• Chapter 3 provides an overview of the on-line help system available 
in BioWin and how it may be used to deliver information. 

• Chapter 4 contains information on BioWin's main simulation 
window. 

• Chapter 5 describes the different element types (i.e. unit processes) 
available in BioWin. 

• Chapter 6 introduces the BioWin album. 

• Chapter 7 examines the various methods available for creating charts 
and adding series to them. 

• Chapter 8 provides in-depth chart formatting procedures. 

• Chapter 9 provides in-depth series formatting procedures. 

• Chapter 10 looks at BioWin's powerful project management tools. 

• Chapter 11 gives an overview of the tools available for customizing 
BioWin to match your preferences. 

• Chapter 12 contains descriptions of useful BioWin interface tools and 
techniques. 

• Chapter 13 contains a set of tutorials and case studies designed as a 
training exercise in the application of BioWin. 

• Chapter 14 describes the various functional elements of the BioWin 
General Model. 

• Chapter 15 outlines the theory behind the three basic types of models 
BioWin uses in solid / liquid separation elements. 

• Chapter 16 details BioWin's approach to pH modeling. 

• Chapter 17 explains the gas-liquid mass transfer model used in 
BioWin 

• Chapter 18 provides a general description of the modeling of 
anaerobic processes in BioWin particularly as they would occur in 
anaerobic digestion processes. 

• Chapter 19 describes the biofilm model provided in BioWin. The 
model is implemented in the media bioreactor element and is calibrated 
to simulate MBBR and IFAS systems.. 

• Chapter 20 describes the sidestream model provided in BioWin. 

Typefaces and conventions used in this manual 
The following typefaces and conventions will be used throughout this manual when 
describing various procedures and techniques in BioWin: 

   

Typeface Refers To 

Example Text Italic text refers to chapter titles. 

Example Text Bold text in Arial font is used when 
describing objects and controls in dialog 
boxes, as well as the dialog box names.  
When you see text in this typeface used in 



 Welcome To BioWin  •  5 

the description of a dialog, that text will be 
on the dialog box. 

How To Print The Manual 
The BioWin manual is shipped in the form of one complete Adobe PDF.  The 
content of this document is identical to BioWin's online help – the help was built 
using the manual document as its source (Note that you also may print out individual 
topics from within the online help system).  If you wish, you may install this 
document to your computer and print it out as you desire.  However, if you wish to 
save disk space, you may choose to leave it on the CD, where it is located within the 
MANUAL directory.   

   

Online Help 
BioWin comes equipped with full featured, context-sensitive on-line help.  The help 
features an expanding/collapsing table of contents, a full multi-level keyword index, 
and a full text search.  The on-line help is built from the manual, so users will have a 
number of options available to them when in comes to accessing information. 

The help format used in BioWin is known as HTML help.  This format commonly is 
used in Microsoft Office applications, and will be familiar to most users.  This 
format delivers the help system via a two-paned web browser interface that displays 
the help system topic structure in the left pane and the selected topic in the right 
pane.  In this way, users can see where they are in the overall topic structure as they 
browse through the help system.  For more information on this style of help, please 
see the chapter entitled “Getting Help In BioWin”. 

Limitations 
BioWin is a very powerful analysis tool.  The program has been evaluated against an 
extensive data set and has been demonstrated to provide accurate simulation results 
for a range of systems.  Nevertheless, the user is cautioned that BioWin is merely a 
tool. 

BioWin incorporates a number of models.  These necessarily are not perfect and 
have limited ranges of applicability.  It is the responsibility of the user to carefully 
assess results generated by the program. 
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New Developments in BioWin 

What is New in Version 3 
The latest version of BioWin provides a host of additions and improvements to 
enhance your wastewater treatment plant simulations.  The main additions to Version 
3 in terms of modeling capacity are: 

• Biofilm model 

• Two-step nitrification and denitrification 

• Anammox bacteria 

Incorporation of two-step nitrification and denitrification and the growth of 
Anammox bacteria enhance the capacity of BioWin for detailed modeling of the 
various sidestream (e.g. digester centrate) treatment systems that have been 
developed in recent years. 

Note:  A new Sidestream Reactor element can be included in configurations.  This 
is mainly for convenience as it is easily distinguished from other activated sludge 
reactors on the drawing board.  The model applied in a sidestream reactor is no 
different from the model used in other units.  BioWin is based on a single integrated 
model for all biological and chemical reactions, and the same model is applied to any 
unit in a BioWin simulation.  The only difference for a Sidestream Reactor is that the 
“seed” values selected by BioWin when a simulation starts differ from those for a 
standard activated sludge bioreactor. 

Some of the additions, changes and upgrades in BioWin 3 are listed here.  [A number 
of the features added to BioWin Version 2 are also listed as a reminder to users]. 



 New Developments in BioWin  •  8 

 

Model Additions and Enhancements 
The additions to the Full Plant Edition of BioWin are significant advances in 
modeling of wastewater treatment plants.  BioWin tracks more organic and inorganic 
components than any other simulator, and allows a complete mass balance for 
recycled sidestreams and supernatants.  The integrated process model in BioWin 
works for any environmental condition, whether in aerated or unaerated activated 
sludge tanks, fermenters, sidestream reactors or digesters.  This allows seamless 
integration of the processes in the whole plant.   

A few Version 3 highlights 
• Development of a sophisticated biofilm model.  This has been 

implemented initially only for Media Bioreactors; that is, activated 
sludge suspended growth reactors that contain a free-floating carrier 
media for biofilm growth e.g. integrated fixed-film activated sludge 
(IFAS) and moving bed bioreactor (MBBR) systems.  The Media 
Bioreactor module also can be used to configure reasonable 
representations for other biofilm systems such as trickling filters, 
biological aerated filters, and tertiary denitrification filters.  For further 
details on the biofilm model review the "Biofilm" chapter. 

• Modeling nitrification as a two-step process; that is, conversion of 
ammonia to nitrite (NO2) – mediated by ammonia-oxidizing bacteria 
(AOBs), and conversion of nitrite to nitrate (NO3) – mediated by 
nitrite-oxidizing bacteria (NOBs).  For further details review the 
"Sidestream" chapter. 

• Denitrification by heterotrophs [ordinary heterotrophic organisms 
(OHOs), phosphorus-accumulating organisms (PAOs), or methanol-
utilizing heterotrophs (methylotrophs)] is modeled as a two-step 
process with conversion of nitrate to nitrite and then nitrogen gas. 

• Modeling the growth of Anammox bacteria; autotrophic organisms that 
combine ammonia and nitrite to form nitrogen gas without the addition 
of organic substrate.  For further details review the "Sidestream" 
chapter. 
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Version 2 highlights 
• BioWin includes accurate pH modeling and pH dependence of 

biological and chemical processes. 

• Integrated biological model for BNR activated sludge, fermenters, and 
anaerobic digesters. 

• Alum or ferric dosing model for phosphorus precipitation and chemical 
sludge formation integrated with the biological model. pH dependent 
precipitation kinetics. 

• Spontaneous struvite and hydroxyapatite precipitation processes. 

• Detailed tracking of inert solids content, and N and P balances in 
biological and chemical sludge. 

• Fast pH simulation using a unique model solution based on 
concentrations of strong acids and bases, the dissociation state of the 
phosphate, carbonate, ammonium and volatile organic acid system, 
chemical precipitation reactions, and stripping of components such as 
ammonia and carbon dioxide. 

• Improved modeling of denitrification with methanol addition - 
methanol-specific biomass, adaptation, minimum anoxic SRT, and 
substrate specific anoxic yields. 

• Magnesium and potassium uptake with biological phosphorus uptake.  
Release of stored magnesium in digesters. 

• Integrated digester model describes acidogenic phase (prefermenters) 
and methanogenic phase, predicts gas flow, composition and pH. 

• Surface aerators and brushes in addition to diffused aeration. 

• Improved, intuitive, customizable interface. Key variables for each 
process (OUR, Nitrate Production Rate, Specific Denitrification Rate, 
etc.) readily accessible. 

• Model Builder enables users to customize models or create their own - 
starting from scratch or by modifying existing models. 

• The International Modeling Kit includes standard models such as the 
ASM series and the double-exponential settler model. 

Usability Enhancements 
A number of features have been added to BioWin to streamline ease of use.   

Version 3 new features 
• In ideal separation devices (point settlers, dewatering units, and ideal 

clarifiers) a schedule can be defined to specify time varying percentage 
removals. 

• Oxygen transfer calculations are based on diffuser submergence (rather 
than tank depth). 

• When setting up charts in the Album, the list of variables that can be 
plotted is very extensive.  These have been grouped in separate 
category lists (state variables, combined variables, water chemistry 
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variables, commonly-plotted variables).  This simplifies selecting 
variables to plot. 

• Improved numerical solution techniques and more simulation method 
options. 

• Expanded and enhanced COM interface – including read/write access 
to influent totals and fractions as well as project temperature.  Read-
only access to all liquid phase state variables and the gas phase states of 
anaerobic digesters. 

• The facility to plot profiles of variable concentrations through layers in 
the biofilm in Media Bioreactors. 

• Itineraries are now completely independent of the “constant” value. 

• Additional alarms to alert the user to unusual conditions. 

• Thread / process priority management for BioWin users. 

• The ability to specify project start time from the project info dialog 
box. 

• Improved grid snap methods. 

• Oxygen transfer through the surface in anoxic zones. 

• Improved “fly-by” panels. 

• The facility to include / exclude media from media reactors. 

Features added in Version 2 
• State Point Analysis plot.  From BioWin 2.2 the user can plot the state 

point analysis flux curve for ideal and model secondary settlers as well 
as for SBR elements (some restrictions apply). 

• Chart annotation tools. 

• Multiple SRT calculation scenarios. 

• Plot SRT against time during dynamic simulations. 

• Automatically save dynamic simulations as they progress. 

• Parameters may be “unmonitored”. 

• Floating / docking toolbars. 

• Improved numerical procedures for steady state solver. 

• Locate a user-defined concentration within a model settling tank 
depth/concentration profile (e.g. use this to find where you think the 
sludge blanket is). 

• Display full or abbreviated names for state variables and other 
parameters. 

• The new Chart Master allows you to cascade multiple changes through 
selected charts in the BioWin Album. 

• Further improvements to powerful Report to Word™ option. 
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Opening a File from a Previous Version 
When you open a file created in an earlier version of BioWin, you will be presented 
with a dialog box that contains "conversion notes". These warnings reflect changes 
that have been made to the underlying model structure of BioWin. 

The content of the conversion notes depends on the whether the file being loaded 
was created in Version 2 or in an earlier version of BioWin. The most important 
aspects to recognize when loading a file from a previous version are: 

• Review inputs: BioWin Version 3 has several additional state variables.  
You should review your input elements to check that you have appropriate 
values for the new state variables and/or wastewater characteristic fractions. 

• Check model parameters: The new version incorporates additions and 
some modifications to the activated sludge and anaerobic digestion models. 
It is imperative that all model parameters (kinetic, stoichiometric, switching 
function parameters, etc.) should be checked carefully when loading a file 
created in an earlier version. 

• Re-run the simulation: When loading a file created in an earlier version 
of BioWin, you must re-run any simulations to get meaningful results. 

Conversion Notes 
Conversion notes are displayed when you open a file created in an earlier version of 
BioWin.  These are intended to prompt you to make changes in the BioWin file that 
will make it compatible with the latest version. It is imperative that all model 
parameters (kinetic, stoichiometric, switching function parameters, etc.) should be 
checked carefully. The following sections provide brief explanations for the different 
messages that appear, depending on the file version being loaded. 

All Alkalinities Will Be Converted 
Alkalinity is no longer a state variable in BioWin.  In influent streams you can still 
enter alkalinity (and pH) and BioWin will calculate the required dissolved CO2, 
anions and cations.  BioWin still calculates the alkalinity, but now it is determined 
from the equilibrium chemistry of the stream, rather than by a pseudo state variable. 

Additional State Variables Included - Review Inputs 
BioWin now has several additional state variables.  You should review your input 
elements to check that you have appropriate values for the new state variables and/or 
wastewater characteristic fractions, and that an appropriate pH is specified. 

Additional State Variables Included  AND Parameters 
Should Be Changed And New Parameters Added 
The new version incorporates additions and some modifications to the activated 
sludge and anaerobic digestion models. In the case of model additions (e.g. 
Anammox bacteria), BioWin will assign default values to all model parameters for 
the new model components. In the case of model modifications (e.g. two-step 
nitrification) parameter values from the earlier version will be mapped to the 
appropriate parameter in Version 3, and default values will be assigned to new model 
parameters.  Also, some small changes have been made to certain default parameter 
values. It is imperative that all model parameters (kinetic, stoichiometric, switching 
function parameters, etc.) should be checked carefully when loading a file created in 
an earlier version. 
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Unable to convert Alkalinity 
When loading an old file BioWin attempts to match the old alkalinity, by adding acid 
or base.  If it is unable to achieve a match this note occurs.  If you see this note you 
should check your influent streams and pH’s. 

Alkalinity Is No Longer A State Variable - Equation 
Discarded 
Alkalinity is no longer a BioWin state variable (it is still reported, but now it is 
determined from the equilibrium chemistry of the stream, rather than by a pseudo 
state variable .  This message occurs because you have used Alkalinity in a Model 
Builder model (previously called the Grey Box), but since it is no longer available 
as a state variable you will need to adjust your model to account for this. 

Enter Head Space Volume For Digesters 
The gas phase of the anaerobic digester element is now modeled, and you must 
specify the volume that BioWin should use for these calculations. 

Methane Production Now Reported As A Fraction 
Methane is now reported as a fraction – in earlier versions it was reported as a 
Methane production rate.  You will need to adjust you chart scales to see the new 
value (which should always be below 1). 

Hydrogen Production Now Reported As A Fraction 
Hydrogen is now reported as a fraction – in earlier versions it was reported as a 
Hydrogen production rate.  You will need to adjust you chart scales to see the new 
value (which should always be below 1). 

OUR And Denitrification Rate No Longer Reported For 
Anaerobic Digesters 
OUR and denitrification rate are no longer available for anaerobic digesters (OUR 
should generally be essentially zero anyway). 

Variable XXX No Longer Available - Check Your Graphs 
The variable “XXX” is no longer available – but BioWin has detected that you were 
monitoring it.  You will need to check your graphs as any series based on this will 
now be “static” showing only the values from the last simulation in a the previous 
version.  Generally if a variable has been removed from BioWin it has been replaced 
by a similar, usually more informative one. 

Aeration Parameters Can Now Also Be Global 
Aeration parameters can be globally specified now.  Old files are loaded with local 
aeration parameters so that any settings like Alpha, beta etc. are preserved.  In certain 
cases you may wish to have “local” aeration parameters (for example in a pure 
oxygen system where you need to change the oxygen content of the gas).  You can 
do this by selecting the Local parameters check box on the operation tab. 



 New Developments in BioWin  •  13 

New program version - resimulate to get meaningful 
results. 
The file loaded was created in an earlier version of BioWin. You must re-run any 
simulations to get meaningful results.   
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Quick Feature Tour 

Quick Feature Tour Overview 
This chapter highlights some of the features available in the latest version of 
BioWin.  These are demonstrated using the "An Example" configuration installed in 
the Data directory.  The purpose of this chapter is to provide a brief introduction. 

For specific examples on using BioWin, please see "BioWin Tutorials".  You can 
find more BioWin examples as follows: 

• Select File|Open and browse to the Examples directory.  These systems 
are discussed in the Help section on BioWin Tutorials and Examples. 

• On the BioWin main window toolbar, at the end on the right, click on the 
arrow next to the icon that looks like a filing cabinet.  This brings down a 
list of pre-configured BioWin process files for a range of system 
configurations. 
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The Interface 
The example system  shown below is a simple two-reactor activated sludge 
configuration. 

 
A simple two-reactor activated sludge configuration 

The BioWin main simulator window interface consists of: 

� Menus 

� Toolbars 

� Drawing Board 

� Summary Panes 

� Status Bar 

   

Setting up such a system is easy to do – it's a matter of minutes.  Buttons on the 
toolbar at the top of the main simulator window represent the various unit processes 
available in BioWin.  Simply click on a button, move your mouse cursor over the 
area on the drawing board where you want to place an element, and click the mouse 
button. 

Most types of wastewater treatment systems can be configured in BioWin using the 
many process modules.  These include: 

• A range of activated sludge bioreactor modules – suspended growth 
reactors (diffused air or surface aeration), various SBRs, media reactors 
for IFAS and MBBR systems, variable volume reactors. 

• Anaerobic and aerobic digesters. 

• Various settling tank modules – primary, ideal and 1-D model settlers. 

• Different input elements – wastewater influent (COD- or BOD-based), 
user-defined (state variable concentrations), metal addition for chemical 
phosphorus precipitation (ferric or alum), methanol for denitrification. 



 Quick Feature Tour  •  17 

• Other process modules – holding tanks, equalization tanks, dewatering 
units, flow splitters and combiners. 

Note:  A new Sidestream Reactor element can be included in configurations.  This 
is mainly for convenience as it is easily distinguished from other activated sludge 
reactors on the drawing board.  The model applied in a sidestream reactor is no 
different from the model used in other units.  BioWin is based on a single integrated 
model for all biological and chemical reactions, and the same model is applied to any 
unit in a BioWin simulation.  The only difference for a Sidestream Reactor is that the 
“seed” values selected by BioWin when a simulation starts differ from those for a 
standard activated sludge bioreactor. 

A quick way to gain access to local menus which contain commands specific to a 
particular object is through the use of the right mouse button.  For example, if you 
point to the influent element and right-click, you will get a local menu as shown 
below. 

 
Using the right mouse button gives access to local menus 

Element Information 
Double-clicking on a drawing board icon for an element in a configuration gives 
access to all pertinent information for that element.  For example, double-clicking on 
a bioreactor element allows access to physical and operational data, as well as the 
facility to set up data monitoring. 
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Dialog box allows access to all bioreactor information 

Once you've double-clicked on an element icon to gain access to this information, it's 
just a matter of clicking on the tab you are interested in.  For example, clicking on 
the Operation tab will allow you to change the bioreactor operating parameters 
shown below. 

   

 



 Quick Feature Tour  •  19 

The bioreactor operation tab 

Influent Data 
Setting up influent data is a quick and easy process.  If you double-click on an 
influent element drawing board icon, you will see the following dialog box. 

 
Access the influent properties to set up influent data 

Clicking the Edit data button as shown will open the Influent itinerary editor, as 
shown below. 

 
The variable influent itinerary editor 
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The Influent itinerary editor provides a spreadsheet-like interface for entering 
data.  BioWin even offers several different strategies for filling in blanks in your 
data!  It is very easy to import data into the itinerary editor from files or to copy it in 
from a spreadsheet – in fact, the data in the example shown above were pasted in 
from Microsoft Excel! 

Running A Simulation 
 Steady state balance tool 

 
 Dynamic simulation tool 

Steady state and dynamic simulations are run from the main simulator window.  
Once you have taken a few minutes to specify information for the various elements 
in your configuration, commencing a simulation is simply a matter of clicking the 
appropriate button on the toolbar! 

BioWin uses a powerful itinerary that allows the user to schedule many different 
operating conditions such as dissolved oxygen setpoints, air flowrates, and 
temperature.  For example, suppose that you were simulating varying temperature 
conditions.  With BioWin, you easily can set up a temperature schedule using the 
dialog box shown below. 

 
Scheduling operating conditions is not a problem! 

Help and Manual 
BioWin comes with an extensive manual which is shipped as a series of Microsoft 
Word documents each consisting of a chapter so you can easily print out the 
sections of specific interest. 

 Help Contents & Index 
 

Help on using help 

You may find this unnecessary as the contents of this manual are available via 
BioWin's online help.  You can access this help system via the toolbar help buttons.  
Another useful feature that makes BioWin easy to learn is context-sensitive help.  To 
get help that is relevant to a particular dialog box you are working in, simply hit the 
F1 key and BioWin will access related topics from the help system and display them 
to you. 
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A screen shot of the help system is shown below. 

 
A BioWin help window (Contents tab showing) 

Viewing Simulation Results 
The BioWin Album provides a fully integrated means to display simulation results.  
Using the album you can view data in the following formats: 

• Tables 

• Element-specific information displays 

• Charts 

   

 Opens the album Activating the album is as simple as clicking the appropriate button on the main 
window toolbar.  The album consists of a series of tabbed pages which may contain 
any or a combination of the above data display formats.  Shown below is the album 
with the active page displaying a chart. 
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The album interface 

Tables 
Here is an example of an album page containing two tables. 

 
An album page containing two tables 

Element-Specific Information 
Here are two examples of element-specific information displays; one for a bioreactor 
element and one for a settling tank element. 
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A bioreactor element-specific information display 

 
A settling tank element-specific information display 

Charts 
BioWin offers a wide variety of charting options.  Here are some examples. 
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A bar chart 

 
A three-dimensional line plot 
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A two-dimensional point plot 

 
A surface plot 
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A pie chart 

 
Place pictures (or your company's logo!) in the chart background for presentations 

Creating Reports 

Printing Reports 
BioWin incorporates a powerful automatic report generation feature.  With a single 
click, BioWin can generate a detailed printed report.  
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Customizing Reports 
The type of information that appears in the report is completely customizable. The 
general information that can be included in a report may be: 

• Project information (user name, plant name, project name, etc.); 

• A picture of the project flowsheet; 

• Global model parameter values; 

• Global temperature setting; 

• Album pages (charts, tables, etc.); 

• The SRT for the system (if one is available); 

• Any notes that have been entered in the BioWin Notes editor; 

   

The reporting can be customized to include element-specific information on an 
element-type basis. Users can choose whether or not they want to include 
information for element types (e.g. Bioreactor) in the report. The type of information 
included in the report for each type of element can be different and may include: 

• Physical data (volume, area, depth, # of diffusers, etc.); 

• Operating data (average or flow-weighted average); 

• Local settling parameters (if available); 

• Local biological model parameters (if available); 

• Aeration parameters (if available); 

   

Generating Reports in Microsoft WordTM 
If you prefer an electronic version, BioWin also can generate your report as a 
Microsoft Word™ document. Like the printed report, the information contained in 
the electronic version is completely customizable and may include many different 
forms. Once BioWin has generated the document for you, you may use it as a basis 
for an engineering report, or cut and paste its contents into another document. 

Related functionality includes the ability to print out all or ranges of the album 
pages. You can also set the number of album pages per printed page. 

Additionally, BioWin has its own internal Notes editor (shown below) to help keep 
track of project details. 
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BioWin's internal simulation notes editor 

Exporting Results to a Word Processor or 
Spreadsheet 
It also is very easy to get results from BioWin into your word processor or 
spreadsheet.  Charts, tables, system configuration layouts, etc. can be copied and 
pasted from BioWin to your reports.  Tables can be exported as tabbed text and then 
quickly converted to tables, such as the one below which is a section of a Word 
document. 

 
A BioWin table exported to a word processing application 

Customizing 
There are a variety of features that can be customized in BioWin. These are outlined 
briefly below. 

Customizing Environment Settings 
BioWin offers users the ability to customize a number of environment settings to suit 
their needs.  For example, some of the customizable features include: 

• Printing options 
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• Report Options 

• Automatic Logging 

• File Locations 

• Explorer Options 

• System Settings 

   

Access to the customizable features is managed through a central location, shown 
below. 

 
All customizable environment settings accessed through one dialog box 

Customizing Project Settings 
BioWin offers users the ability to customize a number of new project settings to suit 
their needs.  For example, some of the customizable features include: 

• Drawing board appearance 

• Pipe Settings 

• Unit System Settings 

• Template Settings for the Album 

   

Access to the customizable features is managed through a central location, shown 
below. 
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All customizable new project settings accessed through one dialog box 

Customizing Charts 
Finally, you can customize how BioWin generates new charts using the Chart 
Master and chart templates as shown below. 

 
Chart Master 
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Model Information 
BioWin is not only a slick simulator package.  The user has ready access to detailed 
model features for the many operations.  Model parameters may be accessed 
conveniently from a single Model parameter editor, shown below. 

BioWin offers many utilities to facilitate process analysis.  These include: 

• Adjusting kinetic parameters and temperature in individual units; 

• Simulation of biological activity in secondary clarifiers; 

• Scheduling of many different operating parameters such as 
temperature, dissolved oxygen setpoint, air flowrate, and flow 
routing/splitting. 

   

 
Model parameters may be changed through a single editor 
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Getting Help In BioWin 

Using The BioWin Help System 
BioWin’s help system may be accessed with one of two methods: 

1. The main simulator window menu command Help|Contents and 
index; 

 Help Contents & Index 2. Clicking the Help Contents and 
Index button on the main toolbar of the main simulator window. 

When the help system is opened, you will see a two-paned window with the right 
pane showing the contents of the currently selected topic (or a default start topic if 
one is not selected) and the left pane showing the Contents, Search, and 
Favorites tab, depending on which tab was active when the help system was last 
exited.  Note that the relative size of the panes can be changed by dragging the pane 
dividing bar.  The two-paned window is shown below. 

 
The Windows 98/HTML Help two-paned window 

The buttons at the top of the two paned window have the following functions: 
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Button Function 

Hide / Show Used to toggle the left pane between hidden and visible states. 

Locate Clicking this button will display the contents tab in the left pane 
and highlight the topic that you currently are viewing.  This 
button is useful for locating related topics when using the Index 
or Search tab. 

Back Moves one topic back in your browse history.  Takes you to the 
last topic that you viewed. 

Forward Moves one topic forward in your browse history.  Takes you to 
the previous topic you viewed. 

Print A dialog box opens that allows you to choose whether you want 
the current topic or the current topic and all its sub-topics to be 
printed. 

Options Sets display options for your help system – it is recommended 
that these options be left set to their defaults. 

Note that at the bottom of each topic there are two arrows.  These are the Browse 
Sequence arrows, which may be used to move through the help system topic 
hierarchy one topic at a time. 

Help Contents Tab 
One advantage of the BioWin help is that when the Contents tab is selected, it is 
possible to view topics and the help system outline structure simultaneously, as 
shown in the picture below. 

 
The Help Contents Tab 

You can expand and collapse levels of the help system outline by clicking on the 
book icons or titles of the levels.  If there is text associated with a level, it will be 
displayed in the right pane.  When you locate the topic you wish to view, click on it 
and the topic contents will be displayed in the right pane. 
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Help Search Tab 
When the Windows 98/HTML style help Search tab is selected, it is possible to 
view your search results and topics simultaneously, as shown in the picture below. 

 
The Help Search tab 

To use the search utility, type in the keyword(s) or phrase that you are searching for, 
and click the List Topics button.  This will display the list of topics containing the 
keyword(s) or phrase that you searched for.  To view a topic, you can either double-
click on the topic title or click topic title and then click the Display button, and the 
topic contents with your search term(s) highlighted will be displayed in the right 
pane. 

Help Favorites Tab 
Another feature of the BioWin help is the Favorites tab, shown below. 
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The Help Favorites tab 

Once you have found a topic using the Contents or Search tabs, you can add it to 
a list of favorites so that you can easily access it repeatedly.  To do this,  

1. Locate the topic that you want to add using the Contents or Search 
tab. 

2. Click the Favorites tab. 

3. The topic you currently are viewing will be displayed in the right pane, 
and at the bottom of the left pane the topic title will be displayed in the 
Current topic box. 

4. To add the current topic to you list of favorites, click the Add button. 

5. The topic will be added to the Topics list in the left pane. 

6. To view other topics in the Topics list, double-click the topic, or click 
the topic then click the Display button. 

7. To remove a topic from the list, click the topic title and then click the 
Remove button. 

Popups and Jumps 
In BioWin’s help topics, you may encounter text that is blue and underlined.  This 
means that the text represents a popup or hyperlink jump.  If the text represents a 
popup, then clicking on the text will open a small “popup” window.  Popups usually 
are used for definitions, small pictures, etc.  When you are done viewing the contents 
of the popup, simply position your mouse cursor outside of the popup window and 
click once, or press any key on your keyboard to close it. 

If the text represents a hyperlink jump, clicking on that text will send you to another 
location in the help file – usually a topic that contains material relevant to the text 
that denoted the jump.  Note that when you do this, the help engine tracks your 
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position in the help system outline if you have the Contents tab selected so you 
know your location in the help system hierarchy.  To return to the topic that you 
jumped from, click the Back button. 

Context Sensitive Help In BioWin 
Context sensitive help is an advance in help; it is a system that makes it easier for 
users to find help immediately on topics that are relevant to the operations they are 
performing in BioWin.   

When context sensitive help is called, the help system is opened with a topic that is 
related to the dialog box or menu command that you want help on.  From this topic it 
is easy to navigate to other related topics. 

There are a number of ways that the utility of context sensitive help may be 
employed: 

Context Sensitive Help on a Dialog Box 
To get context sensitive help on a dialog box, press the F1 key on your keyboard.  
Certain dialog boxes have red text at the bottom to remind you of this functionality.  
It also is possible to click on this text to invoke the help – the mouse cursor will 
display a question mark when you fly over this text, as shown below: 

 
Dialog box with clickable context sensitivity reminder (notice the mouse cursor) 

Context Sensitive Help on a Window Menu 
Command 
To get context sensitive help on a window menu command, hold your mouse cursor 
over that command so that it is highlighted in blue as shown below and press the F1 
key on your keyboard. 
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A highlighted menu command 

Context Sensitive Help on a Charting Dialog Box 
Additional context sensitive help may be obtained for charting dialog boxes by 
clicking the ? in the upper right hand corner and then clicking on a dialog box 
control. 

 
Chart dialog box with clickable context sensitivity ? in upper right hand corner 
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Main Simulator Window 

Parts of the Main Window 
The BioWin main window consists of five main parts: 

1. menus 

2. toolbars 

3. drawing board 

4. summary panes 

5. status bar 

   

 
The main simulator window 

The following sections give an outline of each part. 
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Main Window Menus 
The various menus available in the main window are located at the top of the 
window.  The menus available are: 

• File 

• Edit 

• Tools 

• Project 

• View 

• Simulate 

• Help 

   

Each menu may be accessed with either of two methods: 

1. Click on the text of the menu, or; 

2. Hold down the Alt key on your keyboard and press the letter on the 
keyboard corresponding to the underlined letter in the menu title.  For 
example, Alt+F will access the File menu. 

Toolbars 
This section illustrates the various buttons found on the BioWin main window 
toolbars, and gives a description of each button’s function.  The BioWin toolbars can 
be toggled on/off with the menu command Tools|Toolbars.  Note that the 
configure and calculator toolbars can also “float” over the drawing board in palette 
mode, or be docked in alternate locations (e.g. along the bottom or side of the 
drawing board).  More information on the calculator toolbar may be found in Solids 
Retention Time Calculationin Manage Projects. 
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BioWin drawing board with floating toolbar in palette mode 

 
BioWin drawing board with docked toolbar 

Note : If a toolbar is closed while in palette mode, use the menu command 
Tools|Toolbars to get it back. 

Main Description 

 New Configuration File:  Click this button to close the current 
configuration and open a new one. 

 Open Configuration File:  Click this button to open a configuration file 
from disk. 

 Save Configuration File:  Click this button to save the current 
configuration file to disk. 

 Print Configuration:  Click this button to print a configuration using 
current printer settings. 

 Show/Hide Configure Toolbar:  Click this button to toggle the 
configure toolbar from visible to hidden.  

 View BioWin Album:  Click this button to open the BioWin album. 

 View BioWin Explorer:  Click this button to open the BioWin explorer. 

 View Project Notes:  Click this button to open the project notes editor. 

 SRT Calculator/Control:  Click this button to open to calculate or 
control the sludge age for a configuration. 

 Check Simulation Data:  Click this button to check that you have 
specified physical and operating data for all the elements in your 
configuration and that all elements in the configuration are properly 
connected with pipes. 

 Steady State Solver:  Click this button to open the steady state solver. 

 Dynamic Simulation:  Click this button to begin a dynamic simulation. 
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 Help on Help:  Click this button to access help on the help system. 

 Help Contents & Index:  Click this button to access the help system. 

 Pre-configured File Cabinet:  Click the arrow next to this button to 
select and load pre-configured BioWin process files (e.g. various BNR 
configurations). 

 Zoom Tool:  Click this button to activate the zoom tool. 

Configure  

 Element Selection Tool:  Click this button to obtain the drawing board 
pointer to select/move/copy/edit process layout elements. 

 Influent:  Click this button to add an influent element to a configuration. 

 Influent (BOD):  Click this button to add a BOD influent element to a 
configuration. 

 Methanol:  Click this button to add a methanol addition stream to a 
configuration. 

 Metal Addition:  Click this button to add a metal stream (for chemical 
phosphorus removal) to a configuration. 

 Influent (State Variable):  Click this button to add a state variable 
influent element to a configuration. 

 Effluent:  Click this button to add an effluent element to a configuration. 

 Sludge Output:  Click this button to add a sludge output element to a 
configuration.  The information displayed in the main window summary 
panes for this output are more relevant to a solids stream than a regular 
effluent (you may still use a regular effluent element for a solids stream if 
you wish). 

 Bioreactor:  Click this button to add a bioreactor element to a 
configuration. 

 Brush Aerator Bioreactor:  Click this button to add a brush aerator 
bioreactor element to a configuration. 

 Surface Aerator Bioreactor:  Click this button to add a surface aerator 
bioreactor element to a configuration. 

 Variable Volume / Batch Bioreactor:  Click this button to add a 
variable volume / batch bioreactor to a configuration. 

 Aerobic Digester:  Click this button to add an aerobic digester element 
to a configuration. 

 Grit Tank:  Click this button to add a grit tank element to a configuration. 

 Equalization Tank:  Click this button to add an equalization tank 
element to a configuration. 

 Single Tank Sequencing Batch Reactor:  Click this button to add a 
single tank sequencing batch reactor (STSBR) to a configuration. 

 SBR + 1 Mix/Settle Prezone:  Click this button to add an SBR + 1 
mix/settle prezone element to a configuration. 

 SBR + 1 Always-Mixed Prezone:  Click this button to add an SBR + 1 
always-mixed prezone element to a configuration. 

 SBR + 2 Mix/Settle Prezones:  Click this button to add an SBR + 2 
mix/settle prezones element to a configuration. 

 SBR + 2 Always-Mixed Prezones:  Click this button to add an SBR + 
2 always-mixed prezones element to a configuration. 

 Dewatering Unit:  Click this button to add a dewatering unit element to a 
configuration. 
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 Activated Primary Settler:  Click this button to add an activated 
primary settling tank element to a configuration. 

 Anaerobic Digester:  Click this button to add an anaerobic digester 
element to a configuration. 

 Sidestream Mixer:  Click this button to add a sidestream mixer element 
to a configuration. 

 General Mixer:  Click this button to add a general mixer element to a 
configuration (the functionality of the two mixer styles is identical, 
however it is easier to connect multiple streams to a general mixer). 

 Splitter:  Click this button to add a splitter element to a configuration. 

 Primary Settler:  Click this button to add a primary settler element to a 
configuration. 

 Point Settler:  Click this button to add a point settler element to a 
configuration. 

 Ideal Secondary Settler:  Click this button to add an ideal secondary 
settler element to a configuration. 

 Model Secondary Settler:  Click this button to add a model secondary 
settler element to a configuration. 

 Model Builder Unit:  Click this button to add a model builder unit to a 
configuration. 

 Pipe:  Click this button to add a pipe element to a configuration. 

 
Drawing Board Scale Setting:  Click the arrow to access a list of 
drawing board scale views, or enter a value directly. 

Drawing Board 
Replaces the Configure and 
Simulate windows of the 
previous BioWin versions.  

The drawing board is the largest part of the BioWin main window.  This is where 
you set up the process layout that you will be simulating by placing various 
elements, specifying their properties, and connecting them with pipes.  A number of 
procedures can be carried out from the drawing board – some of the common ones 
are outlined in this section. 

 

Place an Element on the Drawing Board 
3. With the mouse cursor, click the button corresponding to the element 

you want on the configure toolbar. 

Element Placement 
Cursor 

4. Move the cursor onto the drawing board.  When you do this, the cursor 
will change to the element placement cursor.  Click on the drawing 
board where you want the element to be placed. 

5. If you wish to place more of the same element type, continue clicking 
on the desired drawing board locations. 

6. Repeat steps 1-3 for all of the different element types in your 
configuration.   

If after placing the element on the drawing board, you want to change the element's 
vertical or horizontal orientation: 

Element Selection Tool 1. Click on the element selection tool from the configure toolbar 

2. Right-click the element, and from the resulting popup menu, choose 
Flip horizontal or Flip vertical (the latter option only is available 
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for elements such as splitters and mixers).  

Name an Element on the Drawing Board 

Element Selection Tool 

Element Selection 
Cursor 

3. Click on the element selection tool from the configure toolbar. 

4. Move the cursor over the element on the drawing board you wish to 
name.  When you do so, the cursor will change to the element selection 
cursor. 

5. Right-click on the element.  In the resulting pop-up menu, select 
Name… 

6. Enter the desired name for the element in the resulting dialog box and 
click OK. 

 

Select Multiple Elements on the Drawing Board 
To select multiple elements by dragging with the mouse: 

Element Selection Tool 7. Click on the element selection tool from the configure toolbar. 

8. Position the cursor above and to the left of the group of elements on the 
drawing board you wish to select. 

9. Hold the mouse button and drag the cursor to a position below and to 
the right of the group of elements you wish to select. 

10. Release the mouse button. 

To select multiple elements by clicking with the mouse, while holding either the 
Shift or Ctrl key, click on each element of the group you wish to select. 

Move an Element on the Drawing Board 

Element Selection Tool 

Element Selection Cursor 

11. Click on the element selection tool from the configure toolbar. 

12. Move the cursor over the element on the drawing board you wish to 
move.  When you do so, the cursor will change to the element selection 
cursor. 

13. Click on the element and while holding down the mouse button, drag 
the element to the desired new location. 

   

Note:  You also can move multiple elements simultaneously.  Select the group of 
elements you wish to move, click on one of them, and drag the group to the desired 
new location. 

Copy Elements on the Drawing Board 

Element Selection Tool 14. Click on the element selection tool from the configure toolbar. 
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Element Selection Cursor 

15. Move the cursor over the element you wish to copy.  When you do so, 
the cursor will change to the element selection cursor. 

16. Click and hold the mouse button. 

17. While holding down the Ctrl key, drag the cursor to the location on the 
drawing board where you want the copy of the element to appear. 

18. Release the mouse button. 

19. Release the Ctrl key. 

   

Note:  You also can copy multiple elements simultaneously.  Select the group of 
elements you wish to copy, position the cursor over one of the elements in the group 
and then proceed to step 3 above. 

Delete an Element from the Drawing Board 

Element Selection Tool 

Selection Cursor 

20. Click on the element selection tool from the configure toolbar. 

21. Move the cursor over the element on the drawing board you wish to 
delete.  When you do so, the cursor will change to the element selection 
cursor. 

22. Click on the element and press the Delete key on your keyboard.  
Click Yes on the resulting confirmation dialog. 

23. Repeat steps 1-3 for the various elements in your configuration you 
wish to delete. 

   

Note:  You also can delete multiple elements simultaneously.  Select the group of 
elements that you wish to delete, press the Delete key on your keyboard, and click 
Yes on the confirmation dialog. 

Connect Elements with Pipes 

Pipe Tool 

Pipe Start 

 

Pipe Crosshairs 

No Pipe Allowed 

 

Pipe End 

 

No Pipe Allowed 

24. Click the pipe tool on the configuration toolbar. 

25. When you move the cursor onto the drawing board, the cursor will 
change to the "pipe start" cursor. 

26. Place the cursor over the element area where you wish the pipe to start 
from. 

27. If the location is appropriate, a set of crosshairs will appear on the "pipe 
start" cursor. 

28. If the location is inappropriate, the cursor will change to a circle with a 
slash through it to indicate that a pipe may not begin at that location. 

29. Click once and move the cursor to the desired location of the element 
where you wish the pipe to end, and click again. 

30. As you move the pipe towards the element where you wish it to end, 
the cursor will change to the "pipe end" cursor. 

31. If the location of the pipe terminus is appropriate, this cursor will 
remain. 
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 32. If the location is inappropriate, the cursor will change to a circle with a 
slash through it to indicate that a pipe may not end at that location. 

33. Repeat steps 3-9 until you have connected all your elements with pipes. 

 

Access Element Properties from the Drawing Board 

Element Selection Tool 

Selection Cursor 

34. Click on the element selection tool from the configure toolbar. 

35. Move the cursor over the element on the drawing board you wish to 
view the properties of.  When you do so the cursor will change to the 
element selection cursor. 

36. Right-click on the element and select Properties… in the resulting 
pop-up menu, or double-click on the element. 

   

Note:  You may also access an element's properties by double-clicking the element. 

Zoom In on a Drawing Board Area 

Zoom Tool 

Zoom Cursor 

 

 

37. Click on the zoom tool from the configure toolbar. 

38. Move the zoom cursor to a position above and to the left of the area on 
the drawing board that you wish to zoom in on. 

39. Click and drag the cursor down and to the right of the area you wish to 
zoom in on. 

40. Release the mouse button to finish. 

   

Scale Setting 
You may also zoom in by selecting or typing in a desired zoom percentage setting on 
the configure toolbar. 

Printing the Drawing Board 
You can print out the BioWin drawing board using the File|Print Flowsheet… 
command.  This command will invoke the print drawing board dialog box, which is 
shown below: 
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Dialog box used for printing the drawing board 

Use the Printer drop list box to select the printer you want to use for printing.  The 
Printer Setup… button will open the printer setup dialog box which will allow you 
to access the printer’s properties, set paper size, page orientation, and a number of 
other printer options (the options presented to you will be dependant on the printer 
you have).  The Print button will send the print job to the printer and the printout 
will match the preview that is shown.  The Close button closes this dialog box and 
returns you to the drawing board. 

Using the Paper Orientation group, specify whether you want the printing to be 
done on a Portrait or Landscape page.  The print preview gives you an idea of 
what the printout will look like under each format. 

If you do not wish to see the size of the margins for your print job, you may de-select 
the box labeled View Margins.  You can control the margins using three different 
methods: 

41. Using the Margins (%) spin edits, you can adjust each margin as you 
like.  The four spin edit boxes each control the margin that shares its 
position, that is, the top spin edit controls the top margin, the bottom 
spin edit controls the bottom margin, and so on.  When you change a 
value, you will see changes in the print preview accordingly. 

 

 
Resize Cursors  

 
Drag Print Object 

42. You may drag each margin using the mouse.  Position the mouse cursor 
over the margin you wish to adjust until the horizontal or vertical resize 
cursor appears.  Click the mouse button, hold it, and drag the margin to 
the position you wish it to occupy.  Notice that when you finish 
dragging it, the values in the Margins (%) spin edits will have been 
updated. 

43. By moving the object to be printed around on the page.  When the 
mouse cursor takes the form of a hand, you may click and drag the 
entire object around on the page until it is in the desired position.  
Notice that when you finish dragging it, the values in the Margins (%) 
spin edits will have been updated. 
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If after applying any one of these methods of adjusting margins you wish to reset the 
margins to the default values, you may do so by clicking the Reset Margins 
button. 

If you want the printed picture of the drawing board to have the same length and 
width proportions as the actual drawing board, then select the box labeled Fix 
aspect. 

Main Window Summary Panes 
The purpose behind the main window summary panes is to provide a brief amount of 
information about various elements that have been placed on the drawing board.  
Two summary panes are found at the bottom of the main simulator window.  The left 
pane contains a small table that lists an element’s name, type, and its physical 
dimensions.  The right pane contains a picture of the element and detailed, element-
specific information about various compounds and parameters. 

View Element Information in the Summary Panes 

Element Selection Tool 44. Click on the element selection tool from the configure toolbar. 

45. Hold the cursor over the element that you wish to view summary 
information about. 

   

Note:  Information also will be displayed in the summary panes if you hold any one 
of the “pipe” cursors over an element.  Also note that the airflow per diffuser figure 
shown in the right summary pane for SBR elements is for the main zone only. 

It also is possible to "freeze" the summary panes so that they display information 
about a specific element regardless of where you move your cursor.  To do this, 
follow these steps: 

46. Hold your mouse cursor over either the left or right pane, and right-
click. 

47. From the small popup menu that appears, choose Select… 

48. A dialog box will open – from the Elements drop list box, select the 
element in your configuration that you want to "freeze" the summary 
panes on. 

49. Click the Close button to finish.  You should now be able to move the 
mouse cursor around your configuration without the summary panes 
changing. 

If at any time you want to return the summary panes to the mode where they display 
information on the element your mouse cursor is held over, simply right-click on 
either of the panes and choose Fly by from the small popup menu that appears. 

Resize the Summary Panes 
To change the horizontal dimensions of the summary panes: 

Horizontal Resize 

50. Position the cursor over the vertical line that divides the two panes such 
that the horizontal resize cursor appears. 

51. When the horizontal resize cursor appears, click and drag the cursor 
until the panes have the desired widths. 

To change the vertical dimensions of the summary panes: 
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Vertical Resize 

52. Position the cursor at the top of the summary panes, just below the 
drawing board horizontal scroll bar such that the vertical resize cursor 
appears. 

53. When the vertical resize cursor appears, click and drag the cursor until 
the panes have the desired heights. 

Main Window Status Bar 
The status bar at the bottom of the BioWin main window displays two main classes 
of information – simulation status information and model details information. 

Simulation Status Information 
The status bar at the bottom of the main window operates in two modes; different 
information is displayed in each mode. 

In the first mode, the status bar provides a brief hint or description of toolbar buttons 
and menu items if the mouse cursor is held over them. 

In the second mode (i.e. when the cursor is not held over a toolbar button or menu 
item), the status bar displays information about the status of the configuration, and 
whether a steady state solution has been found for the configuration: 

• When you are adding elements to a configuration, the status bar will 
display the message Building configuration. 

• When you have connected all the elements with pipes, the status bar 
will display the message Configuration complete. 

• Once you have specified physical and operating data for all of the 
elements in the configuration, the status bar will display the message 
Ready to simulate. 

• During each of these phases, the status bar also will display the 
message No steady state solution. 

• Once you have found a steady state solution, the status bar will display 
the message Steady state solution. 

• If you have set up SRT calculation for your project (see Solids 
Retention Time Calculation in "Managing BioWin Projects"), the 
SRT (days) section of the status bar will display the steady state SRT 
in days. 

• If you are performing a dynamic simulation and you have set up SRT 
calculation, the SRT (days) section of the status bar will display an 
"instantaneous" SRT (denoted by an asterisk) in days.  This is 
calculated based on the current mass and wastage rate in your system.  
To increase the update frequency of the status bar, see Data Interval 
in "Managing BioWin Projects". 

• The fourth portion (moving from left to right) of the status bar displays 
the global temperature and the current database interval separated by a 
colon. For example: the following display indicates that the global 
temperature is 25 degrees Celsius, and the database interval is 2 hours.   

25.0 °C: 2.00 Hours 

• The fifth portion (moving from left to right) of the status bar will 
display the number of alarms that have been triggered for the current 
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configuration.  For more information on alarms, please see the alarm 
topics in the Customizing BioWin and Managing BioWin 
Projects sections. 

   

Model Details Information 
This section of the status bar contains information about the models being used in the 
current project: 

• At the left end of the status bar is a button labeled Model 
options…Clicking this button offers rapid access to the model options 
being used in the current project (see Model Options). 

   

As you move from left to right a number of model details are given (note that if an 
option is active, the status bar text is bold, not grayed out): 

• The next section notifies you whether the BioWin integrated activated 
sludge / anaerobic digestion model or a user-defined builder model is 
being used. 

• Moving further to the right, the next section notifies you if oxygen 
modeling project is toggled on or off.  (See reference to Oxygen 
Modeling in Model Options). 

• The next section tells you if the activated sludge kinetic equations are 
incorporating pH inhibition effects. 

• The next section notifies you if spontaneous precipitation of Struvite, 
HDP, and HAP are being modeled. 

• The next section shows whether chemical phosphorous removal is 
being modeled. 

• The next section tells you which one-dimensional settler model is being 
used in model settlers 

BioWin Explorer 
The BioWin explorer provides a means to display information about the elements 
that make up a configuration.  You access the explorer from the main simulator 
window via the menu choice View|Explorer.  From the explorer, you may return to 
the main simulator window or open the BioWin album using the respective menu 
commands View|Main and View|Album.  The explorer window is split into two 
main panes, as shown in the picture below.  The left pane displays an 
expandable/collapsible outline of the elements that make up the current 
configuration.  The right pane displays information related to the selected node of the 
outline. 

   



 Main Simulator Window  •  51 

 
The BioWin explorer 

Note :  The information contained in the right pane will be updated each time you 
click on any branch of the expandable/collapsible outline in the left pane.  Since the 
information displayed in the BioWin explorer is not updated automatically, you 
should always click on the branch that you are viewing to ensure that the information 
is current before recording or reporting it. 

Navigating in the Explorer 
There are different ways to move about in the explorer; the method you choose is a 
matter of preference only as the various techniques accomplish the same goals.  A 
small box beside a node indicates that node contains sub-nodes.  If there is a  “+”  
sign in the box, this indicates that the node may be expanded to display its sub-
nodes.  To expand the node, you may either click on the “+” sign, or double-click the 
node title (i.e. the text immediately to the right of the box).  If there is a  “-” sign in 
the box, this indicates that the node currently is expanded and displaying all its sub-
nodes.  To collapse the node, you may either click on the “-” sign or double-click the 
node title. 

When the explorer initially is opened, the top node entitled “Elements” is displayed 
in the left pane.  In the first column of the right pane, all the elements that make up 
the current configuration are listed, grouped by element type and sorted within each 
group by the order in which they were added to the configuration.  The remaining 
columns in the right pane contain the current values of a number of compounds and 
variables (the information displayed here can be changed – see Explorer Options).  
Double-clicking on a row in this list will open up the properties dialog box for the 
element in question and allow you to edit physical, operational, and monitoring 
settings.  This is equivalent to right-clicking the element on the drawing board and 
choosing Properties… from the resulting pop-up menu, or double-clicking the 
element icon on the drawing board. 

Expanding the “Elements” node shows all of its sub-nodes; these consist of a node 
for each of the different element types in the configuration.  Clicking on an element-
type node causes the right pane to display a list of the elements of that type that 
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currently are in the configuration in the first column, with current values of a number 
of compounds and variables in subsequent columns.  Double-clicking on a row in 
this list will have the same effect as described above. 

Clicking on an individual element node causes the right pane to display current 
values of a number of compounds and variables for that element.  Double-clicking 
this row will allow you to access the element's properties.  Expanding an individual 
element node will display the State variables node and, if appropriate, the 
Parameters node. 

Clicking on the State variables node for an element causes the right pane to 
display a list of the current values of all state variables for that element, as well as 
the mass rate for each.  Clicking on the Parameters node for an element causes the 
right pane to display a row of the local model parameters for that element.  Double-
clicking this row will open the Model parameter editor to allow these local 
model parameter values to be edited. 

Explorer Appearance 
You can adjust the width of the explorer columns in the right pane in two ways: 

Horizontal Resize 

• Hold your cursor over the right dividing line of the column you want to 
resize in the column heading row.  When you do this, your cursor will 
change to the horizontal resize cursor.  Click the mouse and drag the 
column dividing line until the column is the desired size 

• To size a column so that it fits the widest value displayed in that 
column, simply click on the column heading.  Note that this will undo 
any resizing you have done with method (1) as it sets the other columns 
to a “standard” width. 

It also is possible to change the relative width of the two main explorer panes.  When 
you hold your cursor over the vertical bar that separates the left and right panes, you 
will see the horizontal resize cursor appear.  If you click and hold the mouse button, 
you will be able to drag the bar to the left or right, which will change the relative 
widths of the left and right panes. 

Running Simulations in BioWin 
This section provides detailed information about the menu commands available in 
the Simulate menu of the main simulator window. 

Note :  For systems that are difficult to solve, see Tips for Systems that are 
Difficult to Solve in "Managing BioWin Projects". 

Check Simulate Data 
Use this command to ensure that you have properly specified data for all the 
elements in your configuration, and that all the elements in the configuration are 
connected with pipes.  If you have elements in your configuration that are not 
connected with pipes, the other commands in the Simulate menu will be grayed 
out, and when you choose Check simulate data, the following dialog box will 
appear to notify you which elements are not properly connected.  The elements that 
are not connected will be listed in the Incomplete pipe connections list, and if 
you click on an element in this group, the missing connection will be displayed in the 
Missing connection(s) list. 
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Dialog box used for checking simulation data 

Note :  Invoking this command also shows you the Data not specified for list 
which contains the names of elements that you have not yet specified physical and 
operating parameters for.  Even if you wish to use the default values, you must 
acknowledge this by viewing the properties of the element if you wish to remove 
them from the list.  You could do this by closing the dialog box, and accessing the 
properties for the elements in the list from the drawing board.  However, a quicker 
method is to double-click on element names in the Data not specified for list.  
This will open the properties dialog box for the element you double-clicked on.  
Once the properties dialog is closed, you will be returned to the Check simulate 
data dialog box and the element that you double-clicked on will have been removed 
from the list. 

Once you have specified data and pipe connections for all elements, all lists in the 
Check simulate data dialog box will be empty.  You may then invoke other 
commands in the Simulate menu. 

Flow Balance 
This command will open the flow solver dialog box, seen below.  Note that if you 
have not specified physical and operating data for the elements in your configuration, 
you will be presented with the Check simulation data dialog box – you can 
bypass this warning by clicking the Accept button. 
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Simulator controls and information display 

Clicking the Pause button will suspend the flow balance solver at the current time 
shown. 

Clicking the Play button either begins the flow balance solver or resumes it if the 
Pause button has been clicked. 

Clicking the Stop button will terminate the flow balance solver at the current time 
shown. 

Clicking the Details button shows / hides the flow balance solver information.  The 
information displayed consists of the iteration number of the two most recent solver 
iterations, the error of each iteration (i.e. the maximum difference between the 
current iteration values and the steady state solution values), and the time that has 
elapsed between the two most recent iterations. 

Steady State Balance 
This command will open the steady state solver dialog box, seen below.  Note that if 
you have not specified physical and operating data for the elements in your 
configuration, you will be presented with the Check simulation data dialog box – 
you can bypass this warning by clicking the Accept button. 

 
Simulator controls and information display 

Clicking the Pause button will suspend the steady state solver at the current time 
shown. 

Clicking the Play button either begins the steady state solver or resumes it if the 
Pause button has been clicked. 

Clicking the Stop button will terminate the steady state solver at the current time 
shown. 
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Clicking the Details button shows / hides the steady state solver information.  The 
information displayed consists of the iteration number of the two most recent solver 
iterations, the error of each iteration (i.e. the maximum difference between the 
current iteration values and the steady state solution values), and the time that has 
elapsed between the two most recent iterations. 

The Start from group contains three options for controlling the starting conditions 
that the steady state solver uses in obtaining a solution.  If you select Seed values, 
BioWin will use its seeding algorithm to place numerical seed values in all the 
elements of a configuration.  The seeding algorithm is based on various factors 
including the influent loading and the seed sludge age specified on the Numerical 
parameters tab accessed via the Project|Current Project Options menu 
command.  If you select Current values, whatever numerical values exist in a 
configuration’s elements will be used as steady state solver starting values, i.e. 
BioWin will not use its seeding algorithm.  This option can be useful if you have 
already solved a steady state on a complex system and a minor change requiring a 
new solution has been made.  Quite often starting from a steady state rather than re-
seeding will result in a quick solution.  If the Use complex seed is selected, the 
following sequence of events takes place: 

• The configuration is seeded using the average loading conditions and 
the user-specified seed sludge age. 

• BioWin begins to run a dynamic simulation using the average loading 
conditions.  Two progress bars display information about the dynamic 
simulation – the top bar shows the progress towards the maximum 
dynamic simulation time of 20 days, and the bottom bar indicates the 
“stability” of the dynamic simulation. 

• When one of these criteria is met, the BioWin steady state solver will 
begin its solution routine using the current values for seeding.  Note 
that the user may interrupt this process and force the steady state solver 
to begin with whatever current values are present before one of the two 
criteria has been met. 

   

Note :  The right portion of the main simulator window status bar contains 
information about whether or not a steady state solution has been found for the 
current configuration. 

Dynamic Simulation 
This command will open the dynamic simulation dialog box, seen below.  Note that 
if you have not specified physical and operating data for the elements in your 
configuration, you will be presented with the Check simulation data dialog box – 
you can bypass this warning by clicking the Accept button. 

 
Simulator controls and information display 
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Clicking the Pause button will suspend the dynamic simulation at the current time 
shown. 

Clicking the Play button either begins a dynamic simulation or continues one if the 
simulator has been paused (either by pressing the Pause button or by reaching the 
end of a previous dynamic simulation).  If the Play button is clicked to begin a 
dynamic simulation, the following dialog box will be seen: 

 
Dialog used to begin a dynamic simulation 

In the Simulate start group, you choose the time at which the dynamic simulation 
will begin: 

• If you select Simulate from project start date then 12:00 AM on the day 
that you specified as the simulation start date on the Project information 
tab accessed from the Project|Info menu command will be used. 

• If you select Continue from then the time at which the previous 
dynamic simulation was stopped will be used. 

• If you select Simulate from, then you may specify the exact day (using 
the calendar that appears when the drop arrow is clicked) and time 
(using the spin edit box) at which the dynamic simulation will start.  
Note that if this option is chosen, then the current contents of the 
database will be cleared and any time series charts will be cleared or 
saved in the album (depending on the options you have set on the 
General tab in the Tools|Customize menu). 

In the Simulation stop group, there are two methods for specifying the length of 
the dynamic simulation: 

• If you select Simulate for, then you may specify the length of the 
dynamic simulation in days. 

• If you select Simulate until, then you may specify the exact length of 
the dynamic simulation by choosing the day (using the calendar that 
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appears when the drop arrow is clicked) and time on that day (using the 
spin edit box) at which the dynamic simulation will end. 

   

The Simulate start conditions group contains options that pertain to numerical 
seeding at the start of the dynamic simulation: 

• If you select Seed values, the simulator will be seeded with default 
state variable values. 

• If you select Current values, then the simulator will be seeded with 
the current values of state variables. 

Clicking Start will begin the dynamic simulation using your specified choices. 

If the Play button is clicked to restart a dynamic simulation after the simulator has 
been paused, the following dialog box will be seen: 

 
Dialog used to continue a dynamic simulation 

In the Simulation duration group, you can specify the ending time of the dynamic 
simulation: 

• If you select Continue for, then you may specify the length of the 
dynamic simulation in days.  If you want the simulation to end at the 
time you specified at the beginning of the simulation (i.e. you simply 
want to continue after pausing mid-simulation), do not change this 
value. 

• If you select Continue until, then you may specify the exact length of 
the dynamic simulation by choosing the day (using the calendar that 
appears when the drop arrow is clicked) and time on that day (using the 
spin edit box) at which the dynamic simulation will end.  If you want 
the simulation to end at the time you specified at the beginning of the 
simulation (i.e. you simply want to continue), do not change this value. 

Clicking Continue will resume your dynamic simulation. 
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Element Types 

Influent 
The influent element is used to control the wastewater flow/composition to your 
process configuration.  When you add an influent element to your configuration, you 
can control the type (i.e. constant or variable) of influent and the wastewater 
fractions.  For information on monitoring parameters/variables for this element, 
please see Monitoring Data. 

 
The influent monitor items tab 

Influent Type 
The Influent type tab, shown in the figure below, is used to specify the influent 
element as one of two possible types:  constant or variable.  A constant influent’s 
wastewater flow/composition is constant during a steady state simulation, but may be 
modified by the user during a dynamic simulation.  The wastewater 
flow/composition of a constant influent may be changed during a dynamic 
simulation only if the simulator is paused. 
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The influent type tab 

A variable influent element represents a user-specified time-varying flow / 
composition stream entering the system.  For steady state calculations the mass 
average of the time-varying flow / composition pattern is used.  Each set of 
conditions has an associated starting time; this time is the dynamic simulation time at 
which these conditions will start to be used.  The scheduled influent places the 
following restrictions on the starting time for each set of conditions: 

   

1. The starting time for each set of conditions must be greater than the 
starting time for the previous set.   

2. The first set of conditions must start at time 0. 

3. The starting time of the final set of conditions must be less than the 
time specified in the Cycle duration edit box.   

During a dynamic simulation each set of influent conditions is used from when the 
simulation time equals its starting time until the simulation time reaches the starting 
time of the following set of conditions.  The final set of influent conditions is used 
from its starting time until the Cycle duration time is reached.  At the end of the 
cycle the process is repeated using the Cycle duration time as time zero. 

Clicking the Edit data button will present you with a dialog that is dependant on the 
type of influent.  If the influent is constant, you will be presented with the Edit 
influent dialog box.  If the influent is scheduled, you will be presented with the 
Edit influent itinerary dialog box.  For more information on the use of these 
dialog boxes, please see Itinerary Editors 

Clicking the Check pH and alkalinity settings button will check that the pH and 
alkalinity values that you have entered are consistent.  That is, that BioWin is able to 
provide an acceptable mix of dissolved carbon dioxide, anions and cations to match 
the settings you have specified.  This process is recommended although it can be 
time consuming for large influent itineraries (e.g. greater than one thousand rows).  
Should you decide not to do it then BioWin will generate an alarm if the condition is 
encountered during a simulation. 
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You also may input data by loading a previously saved data file.  Clicking the From 
file button will present you with the Open influent file dialog box.  Using this 
dialog box, select the influent data file you want and click Open to finish. 

You also may save a data file if you feel that you may want to use it again.  Clicking 
the To file button will present you with the Save influent file dialog box.  Using 
this dialog box, save the data file under a name and location that you will remember. 

Wastewater Fractions 
The Wastewater fractions tab, shown in the figure below, is used to specify the 
fractional composition of the influent wastewater. 

 
The influent wastewater fractions tab 

You may  specify the following fractional values: 

Name Description 

Fbs Fraction of total influent COD which is readily biodegradable
[(Sbsc + Sbsa) / Total influent COD] 

Fac Fraction of readily biodegradable COD which is VFAs 
[ Sbsa / (Sbsa+Sbsc) ] 

Fxsp Fraction of slowly biodegradable influent COD which is 
particulate [Xsp / (Xsc + Xsp)] 

Fus Fraction of total influent COD which is soluble 
unbiodegradable 

Fup Fraction of total influent COD which is particulate 
unbiodegradable 

Fna Fraction of influent TKN which is ammonia 

Fnox Fraction of influent biodegradable organic nitrogen which is 
particulate 

Fnus Fraction of influent TKN which is soluble unbiodegradable 
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Fpo4 Fraction of influent TP which is phosphate 

FupN The N:COD ratio for the influent particulate unbiodegradable 
COD 

FupP The P:COD ratio for the influent particulate unbiodegradable 
COD 

FZbh Fraction of total influent COD which is non-polyP 
heterotrophic organisms. 

FZba Fraction of total influent COD which is autotrophic 
organisms. 

FZaob Fraction of total influent COD which is ammonia oxidizing 
organisms. 

FZnob Fraction of total influent COD which is nitrite oxidizing 
organisms. 

FZamob Fraction of total influent COD which is anaerobic ammonia 
oxidizing organisms. 

FZbp Fraction of total influent COD which is polyP heterotrophic 
organisms. 

FZbpa Fraction of total influent COD which is propionic acid 
acetogen organisms. 

FZbam Fraction of total influent COD which is acetoclastic 
methanogen organisms. 

FZbhm Fraction of total influent COD which is H2-utilizing 
methanogen organisms 

FZbm Fraction of total influent COD which is anoxic methanol 
utilizing organisms 

Note:  If you enter values for FZbh, FZaob, FZnob, FZamob, FZba, FZbp, FZbpa, 
FZbam, FZbhm, or FZbm remember that organisms contain nitrogen and 
phosphorus. 

An explanation of the fractionation of influent nitrogen may be helpful at this point.  
Ammonia is given by: 

tna3 TKNFNH ⋅=  

Soluble unbiodegradable organic nitrogen is given by: 

tnusUS TKNFN ⋅=  

Nitrogen from organisms present in the influent is calculated by the sum of the 
products of the various organism concentrations and their respective nitrogen 
fractions, i.e.: 

∑ χ⋅χ= ZB,NfZbOrganismsN  

Unbiodegradable particulate nitrogen is given by: 

tupN,upIN CODFFX ⋅⋅=  

The remaining organic nitrogen is broken into particulate and soluble components.  
Particulate biodegradable organic nitrogen is given by: 

( ) noxINUS3tON FOrganismsNXNNHTKNX ⋅−−−−=  

Soluble biodegradable organic nitrogen is given by: 
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( ) ( )noxINUS3tOS F1OrganismsNXNNHTKNN −⋅−−−−=  

Similarly, an explanation of the fractionation of influent phosphorus is as follows.  
Soluble orthophosphate is given by: 

TPFPO 4po4 ⋅=  

Phosphorus from organisms present in the influent is calculated by the sum of the 
products of the various organism concentrations and their respective phosphorus 
fractions, i.e.: 

∑ χ⋅χ= ZB,PfZbOrganismsP  

Unbiodegradable particulate phosphorus is given by: 

tupP,upIP CODFFX ⋅⋅=  

The remaining particulate biodegradable organic phosphorus is given by: 

OrganismsPXPOTPX IP4OP −−−=  

Influent (State Variable) 
The influent (state variable) element is used to control the wastewater 
flow/composition to your process configuration.  The influent (state variable) 
element differs from the standard influent element in that its 
composition is specified in terms of state variable concentrations, 
rather than total concentrations (e.g. COD, TKN) and fractions (e.g. FUP, 
fNA).  For information on monitoring parameters/variables for this element, please 
see Monitoring Data. 

 
The influent (state variable) monitor items tab 
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Influent (State Variable) Type 
The Influent (state variable) type tab, shown in the figure below, is used to 
specify the state variable influent element as one of two possible types:  constant 
or variable.  A constant state variable influent’s wastewater flow/composition is 
constant during a steady state simulation, but may be modified by the user during a 
dynamic simulation.  The wastewater flow/composition of a constant state variable 
influent may be changed during a dynamic simulation only if the simulator is paused. 

 
The influent (state variable) type tab 

A variable state variable influent element represents a user-specified time-varying 
flow / composition stream entering the system.  For steady state calculations the 
mass average of the time-varying flow / composition pattern is used.  Each set of 
conditions has an associated starting time; this time is the dynamic simulation time at 
which these conditions will start to be used.  The variable state variable influent 
places the following restrictions on the starting time for each set of conditions: 

   

1. The starting time for each set of conditions must be greater than the 
starting time for the previous set. 

2. The first set of conditions must start at time 0. 

3. The starting time of the final set of conditions must be less than the 
time specified in the Cycle duration edit box.   

During a dynamic simulation each set of state variable influent conditions is used 
from when the simulation time equals its starting time until the simulation time 
reaches the starting time of the following set of conditions.  The final set of state 
variable influent conditions is used from its starting time until the Cycle duration 
time is reached.  At the end of the cycle the process is repeated using the Cycle 
duration time as time zero. 



 Element Types  •  65 

Clicking the Edit data button will present you with a dialog that is dependant on the 
type of state variable influent.  If the state variable influent is constant, you will be 
presented with the Edit influent dialog box.  If the influent is scheduled, you will 
be presented with the Edit influent itinerary dialog box.  For more information on 
the use of these dialog boxes, please see Itinerary Editors. 

You also may input data by loading a previously saved data file.  Clicking the From 
file button will present you with the Open influent file dialog box.  Using this 
dialog box, select the influent data file you want and click Open to finish. 

You also may save a data file if you feel that you may want to use it again.  Clicking 
the To file button will present you with the Save influent file dialog box.  Using 
this dialog box, save the data file under a name and location that you will remember. 

Influent (BOD) 
The BOD influent element is used to control the wastewater flow/composition to 
your process configuration.  The BOD influent element differs from the 
standard influent element in that its organic strength is specified in 
terms of BOD concentration, rather than COD concentration.  For 
information on monitoring parameters/variables for this element, please see 
Monitoring Data. 

 
The BOD influent monitor items tab 

Influent (BOD) Type 
The BOD Influent type tab, shown in the figure below, is used to specify the BOD 
influent element as one of two possible types:  constant or variable.  A constant 
BOD influent’s wastewater flow/composition is constant during a steady state 
simulation, but may be modified by the user during a dynamic simulation.  The 
wastewater flow/composition of a constant BOD influent may be changed during a 
dynamic simulation only if the simulator is paused. 
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The BOD influent type tab 

A variable BOD influent element represents a user-specified time-varying flow / 
composition stream entering the system.  For steady state calculations the mass 
average of the time-varying flow / composition pattern is used.  Each set of 
conditions has an associated starting time; this time is the dynamic simulation time at 
which these conditions will start to be used.  The BOD influent places the following 
restrictions on the starting time for each set of conditions: 

   

1. The starting time for each set of conditions must be greater than the 
starting time for the previous set. 

2. The first set of conditions must start at time 0. 

3. The starting time of the final set of conditions must be less than the 
time specified in the Cycle duration edit box. 

During a dynamic simulation each set of BOD influent conditions is used from when 
the simulation time equals its starting time until the simulation time reaches the 
starting time of the following set of conditions.  The final set of BOD influent 
conditions is used from its starting time until the Cycle duration time is reached.  
At the end of the cycle the process is repeated using the Cycle duration time as 
time zero. 

Clicking the Edit data button will present you with a dialog that is dependant on the 
type of BOD influent.  If the BOD influent is constant, you will be presented with 
the Edit influent dialog box.  If the influent is scheduled, you will be presented 
with the Edit influent itinerary dialog box.  For more information on the use of 
these dialog boxes, please see Itinerary Editors. 

You also may input data by loading a previously saved data file.  Clicking the From 
file button will present you with the Open influent file dialog box.  Using this 
dialog box, select the influent data file you want and click Open to finish. 

Clicking the Check pH and alkalinity settings button will check that the pH and 
alkalinity values that you have entered are consistent.  That is, that BioWin is able to 
provide an acceptable mix of dissolved carbon dioxide, anions and cations to match 
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the settings you have specified.  This process is recommended although it can be 
time consuming for large influent itineraries (e.g. greater than one thousand rows).  
Should you decide not to do it then BioWin will generate an alarm if the condition is 
encountered during a simulation. 

You also may save a data file if you feel that you may want to use it again.  Clicking 
the To file button will present you with the Save influent file dialog box.  Using 
this dialog box, save the data file under a name and location that you will remember. 

Influent (BOD) Wastewater Fractions 
The Wastewater fractions tab, shown in the figure below, is used to specify the 
fractional composition of the BOD influent wastewater.  Note that these fractions are 
in terms of COD.  Even though the overall wastewater strength is entered in terms of 
BOD, the BioWin model calculates the strength in terms of COD, and uses these 
fractions to place values in the state vector. 

It should also be noted that the value of the fraction Fxsp is calculated by BioWin 
based on the VSS of the BOD influent.  Therefore any value entered by the user for 
this fraction will be overwritten. 

 
The BOD influent wastewater fractions tab 

You may  specify the following fractional values: 

Name Description 
Fbs Fraction of total influent COD which is readily biodegradable

[(Sbsc + Sbsa) / Total influent COD] 
Fac Fraction of readily biodegradable COD which is VFAs 

[ Sbsa / (Sbsa+Sbsc) ] 
Fxsp Fraction of slowly biodegradable influent COD which is 

particulate [Xsp / (Xsc + Xsp)].  Note that this value is back-
calculated by BioWin based on the VSS value entered in the 
BOD influent. 

Fus Fraction of total influent COD which is soluble 
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unbiodegradable 
Fup Fraction of total influent COD which is particulate 

unbiodegradable 
Fna Fraction of influent TKN which is ammonia 

Fnox Fraction of influent biodegradable organic nitrogen which is 
particulate 

Fnus Fraction of influent TKN which is soluble unbiodegradable 

Fpo4 Fraction of influent TP which is phosphate 

FupN The N:COD ratio for the influent particulate unbiodegradable 
COD 

FupP The P:COD ratio for the influent particulate unbiodegradable 
COD 

FZbh Fraction of total influent COD which is non-polyP 
heterotrophic organisms. 

FZaob Fraction of total influent COD which is ammonia oxidizing 
organisms. 

FZnob Fraction of total influent COD which is nitrite oxidizing 
organisms. 

FZamob Fraction of total influent COD which is anaerobic ammonia 
oxidizing organisms. 

FZbp Fraction of total influent COD which is polyP heterotrophic 
organisms. 

FZbpa Fraction of total influent COD which is propionic acid 
acetogen organisms. 

FZbam Fraction of total influent COD which is acetoclastic 
methanogen organisms. 

FZbhm Fraction of total influent COD which is H2-utilizing 
methanogen organisms 

FZbm Fraction of total influent COD which is anoxic methanol 
utilizing organisms 

Note:  If you enter values for FZbh, FZaob, FZnob, FZamob, FZba, FZbp, FZbpa, 
Fzbam, FZbhm, or FZbm remember that organisms contain nitrogen and phosphorus. 

An explanation of the fractionation of influent nitrogen may be helpful at this point.  
Ammonia is given by: 

tna3 TKNFNH ⋅=  

Soluble unbiodegradable organic nitrogen is given by: 

tnuUS TKNFN ⋅=  

Nitrogen from organisms present in the influent is calculated by the sum of the 
products of the various organism concentrations and their respective nitrogen 
fractions, i.e.: 

∑ χ⋅χ= ZB,NfZbOrganismsN  

Unbiodegradable particulate nitrogen is given by: 

tupN,upIN CODFFX ⋅⋅=  

The remaining organic nitrogen is broken into particulate and soluble components.  
Particulate biodegradable organic nitrogen is given by: 
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( ) noxINUS3tON FOrganismsNXNNHTKNX ⋅−−−−=  

Soluble biodegradable organic nitrogen is given by: 

( ) ( )noxINUS3tOS F1OrganismsNXNNHTKNN −⋅−−−−=  

Similarly, an explanation of the fractionation of influent phosphorus is as follows.  
Soluble orthophosphate is given by: 

TPFPO 4po4 ⋅=  

Phosphorus from organisms present in the influent is calculated by the sum of the 
products of the various organism concentrations and their respective phosphorus 
fractions, i.e.: 

∑ χ⋅χ= ZB,PfZbOrganismsP  

Unbiodegradable particulate phosphorus is given by: 

tupP,upIP CODFFX ⋅⋅=  

The remaining particulate biodegradable organic phosphorus is given by: 

OrganismsPXPOTPX IP4OP −−−=  

Methanol 
The methanol influent element is used to control the flow/composition of a methanol 
addition stream to your process configuration.  For information on monitoring 
parameters/variables for this element, please see Monitoring Data. 

 
The methanol influent element monitor items tab 
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Methanol Influent Type 
The Methanol input type tab, shown in the figure below, is used to specify the 
methanol influent element as one of three possible types:  constant , variable or 
paced.  A constant methanol influent’s flow/composition is constant during a steady 
state simulation, but may be modified by the user during a dynamic simulation.  The 
methanol flow/composition may be changed during a dynamic simulation only if the 
simulator is paused. 

 
The methanol influent type tab 

A methanol influent element represents a user-specified time-varying flow / 
composition stream entering the system.  For steady state calculations the mass 
average of the time-varying flow / composition pattern is used.  Each set of 
conditions has an associated starting time; this time is the dynamic simulation time at 
which these conditions will start to be used.  The methanol influent places the 
following restrictions on the starting time for each set of conditions: 

   

1. The starting time for each set of conditions must be greater than the 
starting time for the previous set. 

2. The first set of conditions must start at time 0. 

3. The starting time of the final set of conditions must be less than the 
time specified in the Cycle duration edit box.   

During a dynamic simulation each set of methanol influent conditions is used from 
when the simulation time equals its starting time until the simulation time reaches the 
starting time of the following set of conditions.  The final set of methanol influent 
conditions is used from its starting time until the Cycle duration time is reached.  
At the end of the cycle the process is repeated using the Cycle duration time as 
time zero. 
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Clicking the Edit data button will present you with a dialog that is dependant on the 
type of methanol influent.  If the methanol influent is constant, you will be presented 
with the Edit influent dialog box.  If the methanol influent is scheduled, you will be 
presented with the Edit influent itinerary dialog box.  For more information on 
the use of these dialog boxes, please see Itinerary Editors.  If the methanol influent 
is flow paced, you will be presented with the Methanol Pacing Specification 
dialog box. 

 
The methanol pacing specification dialog box 

There are two options for pacing method: 

1. Mass flow paced 

2. Flow paced 

If Mass flow paced is selected, you may enter a number in the  Pace at  text box 
area as a % of the mass of, and then select an influent component as the basis for 
flow pacing from the drop list of components.  You can also specify the influent 
element as the basis for mass flow pacing from the drop list of influent elements in 
the configuration. 

 If Flow paced is selected, you may enter a number in the Pace at  text box area 
as a % , and then select the influent element as the basis for flow pacing from the 
drop list of influent elements in the configuration. 

You also may input variable methanol influent data by loading a previously saved 
data file.  Clicking the From file button will present you with the Open influent 
file dialog box.  Using this dialog box, select the methanol influent data file you 
want and click Open to finish. 

You also may save a data file if you feel that you may want to use it again.  Clicking 
the To file button will present you with the Save influent file dialog box.  Using 
this dialog box, save the data file under a name and location that you will remember. 

Specifying Methanol Influent Concentrations 
BioWin places default values for a 100 % methanol solution in the methanol influent 
element.  This section outlines how these numbers are calculated.  Using the 
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following methodology, you can specify concentration values for different methanol 
strengths. 

COD / Mass Ratio 
The COD / mass ratio for methanol (CH3OH) can be calculated as follows from 
balancing the equation for the complete oxidation of methanol to carbon dioxide and 
water: 

OH2COO
2
3

OHCH 2223 +⇒+  

That is, 1.5 moles (48 g) of oxygen is required to oxidize 1 mole (32 g) of methanol.  
So the COD / mass ratio for methanol is (48 g / 32 g) 1.5.  You can see the methanol 
concentration number changing by a factor of 1.5 in BioWin when you change 
between methanol concentration units of mg/L and mgCOD/L. 

Methanol Composition 
From Chemical Engineer's Handbook, the specific gravity of pure methanol is 0.792.  
That is, it has a density of 0.792 kg/L.  Using the COD / mass ratio calculated above, 
this corresponds to a COD concentration of (1.5*0.792) 1.188 kgCOD/L, or 1, 188, 
000 mgCOD/L. 

Note that if your methanol solution is specified in terms of molar concentration, 
convert to a mass concentration using the molecular weight for methanol of 32 g / 
mole. 

Reference 
Perry, R.H., Chilton, C.H. (1973)  Chemical Engineer's Handbook.  McGraw-Hill 
Inc. 

Metal Addition Influent 
The metal addition influent element is used to control the flow/composition of a 
metal addition stream to your process configuration.  For information on monitoring 
parameters/variables for this element, please see Monitoring Data. 
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The metal addition influent element monitor items tab 

Metal Addition Influent Type 
The Metal addition input type tab, shown in the figure below, is used to specify 
the metal addition influent element as one of two possible types:  constant, 
variable, or paced.  A constant metal addition influent’s flow/composition is 
constant during a steady state simulation, but may be modified by the user during a 
dynamic simulation.  The metal flow/composition may be changed during a dynamic 
simulation only if the simulator is paused. 
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The metal addition influent type tab 

A metal addition influent element represents a user-specified time-varying flow / 
composition stream entering the system.  For steady state calculations the mass 
average of the time-varying flow / composition pattern is used.  Each set of 
conditions has an associated starting time; this time is the dynamic simulation time at 
which these conditions will start to be used.  The metal addition influent places the 
following restrictions on the starting time for each set of conditions: 

   

1. The starting time for each set of conditions must be greater than the 
starting time for the previous set. 

2. The first set of conditions must start at time 0. 

3. The starting time of the final set of conditions must be less than the 
time specified in the Cycle duration edit box. 

During a dynamic simulation each set of metal addition influent conditions is used 
from when the simulation time equals its starting time until the simulation time 
reaches the starting time of the following set of conditions.  The final set of metal 
addition influent conditions is used from its starting time until the Cycle duration 
time is reached.  At the end of the cycle the process is repeated using the Cycle 
duration time as time zero. 

Clicking the Edit data button will present you with a dialog that is dependant on the 
type of metal addition influent.  If the metal addition influent is constant, you will be 
presented with the Edit influent dialog box.  If the metal addition influent is 
scheduled, you will be presented with the Edit influent itinerary dialog box.  For 
more information on the use of these dialog boxes, please see Itinerary Editors. .  
If the metal addition influent is flow paced, you will be presented with the Metal 
Pacing Specification dialog box. 
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The metal pacing specification dialog box 

There are two options for pacing method: 

1. Mass flow paced 

2. Flow paced 

If Mass flow paced is selected, you may enter a number in the  Pace at  text box 
area as a % of the mass of, and then select an influent component as the basis for 
flow pacing from the drop list of components.  You can also specify the influent 
element as the basis for mass flow pacing from the drop list of influent elements in 
the configuration. 

 If Flow paced is selected, you may enter a number in the Pace at  text box area 
as a % , and then select the influent element as the basis for flow pacing from the 
drop list of influent elements in the configuration. 

You also may input data by loading a previously saved data file.  Clicking the From 
file button will present you with the Open influent file dialog box.  Using this 
dialog box, select the metal addition influent data file (*.mef) you want and click 
Open to finish. 

You also may save a data file if you feel that you may want to use it again.  Clicking 
the To file button will present you with the Save influent file dialog box.  Using 
this dialog box, save the data file under a name and location that you will remember. 

Note:  You can change the metal used by the metal addition influent on the Model 
tab which can be accessed via the Project|Current Project Options menu 
command. 
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Effluent 
The effluent element has no model.  It is used as a receptacle for the conduit from the 
final element in a chain.  As such the effluent element is used primarily for the 
various checks that BioWin performs on the system integrity.  For information on 
monitoring parameters/variables for this element, please see Monitoring Data. 

 
The effluent monitor items tab 

Sludge Effluent 
The sludge effluent element has no model.  It is used as a receptacle for the conduit 
from the final element in a chain.  As such the effluent element is used primarily for 
the various checks that BioWin performs on the system integrity.  For information on 
monitoring parameters/variables for this element, please see Monitoring Data. 

The sludge effluent element differs from a regular effluent element only in the 
information that is displayed in the Main Simulator Window Summary Panes when 
you hover over it with the cursor.  Information displayed includes VSS and TSS 
expressed in % solids, nutrient percentages of the sludge, and sludge mass rates.  
Therefore, this element is useful as a receptacle for WAS flows and other solids train 
process flows. 
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The sludge effluent monitor items tab 

Model Builder Reactor 
The model builder reactor element allows you to incorporate your own models into 
BioWin simulations.  This element allows you to input your own stoichiometry and 
rate equations involving any or all of BioWin's state variables.  You may specify 
parameters related to the operation and control of the model builder reactor element, 
the volume variability, and the model that it uses.  For information on monitoring 
parameters/variables for this element, please see Monitoring Data. 
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The model builder element monitor items tab 

Model Builder Reactor Dimensions 
The Dimensions tab, shown below, allows the user to enter the physical 
dimensions of a model builder reactor element. 
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The model builder reactor dimensions tab 

There are two methods for entering the dimensions: by Area and depth, or by 
Volume and depth.  The method is specified by clicking on the appropriate radio 
button.  If you select by area and depth, the model builder reactor element area and 
depth must be entered in the Area and Depth text edit boxes.  If you select by 
volume and depth, the model builder reactor element volume and depth must be 
entered in the Volume and Depth text edit boxes.  Regardless of the method you 
choose, you also must specify a Width for the element.  Units are shown to the right 
of the edit boxes.  The element name and type, and a picture of the element also are 
shown. 

Model Builder Reactor Operation 
The Operation tab, shown below, allows the user to enter operating parameters for 
a model builder reactor element such as aeration specifications and local 
temperature, as well as specify user-defined model stoichiometry and rate equations. 
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The model builder reactor operation tab 

There are two methods for specifying aeration:  either by a DO setpoint or by an 
Air supply rate.  The aeration method is specified by clicking on the appropriate 
radio button.  When DO setpoint is selected, the setpoint concentration must be 
specified.  You may specify either a Constant setpoint or a Scheduled DO 
setpoint pattern (clicking the Pattern…  button will open the Edit DO setpoint 
itinerary dialog box).  You may wish to place a restriction on the maximum 
allowable air flowrate that may be used to achieve the desired DO setpoint.  This is a 
useful feature for investigating the ability of air equipment to achieve desired DO 
setpoints. 

When Air supply rate is selected, the air flowrate must be specified.  You may 
specify either a Constant air flowrate or a Scheduled air flowrate pattern 
(clicking the Pattern… button will open the Edit air flow itinerary dialog box). 

You may also specify that the model builder reactor element is Unaerated. 

The mechanical mixing Power input (unaerated reactors) can be specified.  
This is used to calculate the velocity gradient in the vessel. 

A Local temperature also may be specified for a model builder reactor element.  
When you click on the check box for local temperature, the Specify temperature 
by radio button group is enabled.  You may then specify either a Constant or 
Scheduled temperature.  If constant temperature is selected, you may enter the 
value in the edit box.  If scheduled temperature is selected the Pattern… button 
becomes active.  Clicking this button presents you with the Edit temperature 
itinerary dialog box. 

There are a number of methods for specifying what model the model builder reactor 
element uses.  If you want to have a local, user-defined model where you set up 
stoichiometry and rate equations, select the box labeled Local Builder model.  
This will activate the button labeled Specify local model….  Clicking this button 
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will open the Model Builder dialog box, which allows you to enter stoichiometry 
and rate equations for any or all of BioWin's state variables.  The use of this tool is 
explained in more detail in the Model Builder section. 

If you wish, you may also choose to incorporate BioWin reactions into your model 
builder reactor element.  If you want to do this, select the box labeled Include 
BioWin reactions. 

Note that if you wish to change any of the aeration model parameters, click the 
Model parameters… button to open the Model parameter editor dialog box 
(Note that this changes the aeration model parameters on a local level only). 

You also can specify Local BioWin kinetic parameters for the activated sludge 
model used in the model builder reactor element, if you have selected the Include 
BioWin reactions option.  If you click on the check box for local BioWin kinetic 
parameters, then clicking the Model parameters… button opens the Model 
parameter editor dialog box allowing you access to the various activated sludge 
model kinetic parameters. 

To specify local aeration parameters (e.g. alpha and beta factors), check the box 
labeled Local aeration parameters. 

To model the concentrations of the constituents of the aeration gas (e.g. oxygen, 
carbon dioxide, etc.), check the box labeled Model gas phase.  If this option is 
selected you may also enter a percentage value for the Gas hold-up (i.e. the 
percentage of the total reactor volume occupied by aeration gas). 

Model Builder Reactor Initial Values 
The Initial values tab, shown below, is used for specifying the initial settings for 
model builder reactor element concentrations and volume. 
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The model builder reactor element initial values tab with the Seed values option active 

Use the Initial liquid hold-up field to enter a value to specify the % of full setting.  
This initial liquid hold-up volume will be used for steady state calculations.  It 
should be noted here that the lower and upper limits on this value are 0.02 and 99.98 
%, respectively.  This reflects the fact that this is the liquid volume, and allows for 
small differences between liquid volume and reactor volume for inlet and outlet 
pipes. 

There are two methods for setting up Initial concentrations in the model builder 
reactor element.  The dialog box shown above illustrates the first case where the 
Seed values option is selected.  When this option is selected, BioWin applies 
default seed values for all the state variables (except volume, which you specify) in 
the same manner it would for bioreactor elements. 

The dialog box shown below illustrates the second case where the Specify values 
option is selected.  In this case, an editable list of state variables is displayed in the 
dialog box.  This allows you to enter your own seed values for state variables in the 
model builder reactor element.  These will be inserted in the model builder reactor 
element when you begin a steady state simulation, or when you begin a dynamic 
simulation and choose to use seed values. 

 
The model builder reactor element initial values tab with the Specify values option active 

When the specified seed values get inserted in the model builder reactor element is 
determined by the Set initial values on OK option.  If this option is not checked: 

   

• The specified seed values will be placed in the model builder reactor 
element at the beginning of a steady state simulation if you elect to start 
from seed conditions; 
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• The specified values will be placed in the model builder reactor 
element at the beginning of a dynamic simulation if you elect to seed 
the simulation. 

If this option is checked, the specified values are placed in the model builder reactor 
element when you click OK to close the dialog box, overriding any existing 
state variable values.  Therefore, the state variable values at the beginning of a 
dynamic simulation will be the same regardless of whether or not you choose to re-
seed. 

The use of this option is illustrated in the example at the end of the Variable 
Volume/Batch Bioreactor Initial Values section later in this chapter. 

Model Builder Reactor Outflow 
Remember for steady state 
simulations, the initial liquid 
hold-up volume will be used 
for calculations. 

The model builder reactor element Outflow tab, shown below, is used to specify the 
overflow behavior.  The overflow behavior can be generalized as follows: 

   

• Whenever the model builder reactor element is full, it overflows at the 
influent rate, regardless of the overflow setting. 

• Whenever the model builder reactor element is empty and the outflow 
rate is set higher than the influent rate, the model builder reactor 
element will only have an outflow equal to the influent flow, so as not 
to have negative volume.  If the outflow rate is set lower than the 
influent rate, then the model builder reactor element will begin to fill 
up. 

The following is a description of the behavior of the three outflow settings: 

   

• Overflow only – the model builder reactor element fills up, and then 
overflows at the influent flow rate (this setting could be used to 
simulate start-up of a bioreactor). 

• Constant outflow – the outflow always tries to attain the specified 
constant rate, except when physically constrained (i.e. when the model 
builder reactor element is full or empty) 

• Flow pattern – the outflow always tries to attain the current specified 
pattern rate, except when physically constrained (i.e. when the model 
builder reactor element is full or empty).  To specify a pattern, click the 
Pattern… button when it becomes active.  For more information , see 
the Liquid outflow itinerary section. 
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The model builder reactor element outflow tab 

Equalization Tank 
The equalization tank is a completely mixed vessel in which there is no reaction.  
You may change aspects of the equalization tank’s dimensions and operation.  For 
information on monitoring parameters/variables for this element, please see 
Monitoring Data. 
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The equalization tank monitor items tab 

Equalization Tank Dimensions  
The Dimensions tab, shown below, allows the user to enter the physical 
dimensions of a tank element. 

 
The equalization tank dimensions tab 
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There are two methods for entering the dimensions: by Area and depth, or by 
Volume and depth.  The method is specified by clicking on the appropriate radio 
button.  If you select by area and depth, the tank area and depth must be entered in 
the Area and Depth text edit boxes.  If you select by volume and depth, the tank 
volume and depth must be entered in the Volume and Depth text edit boxes.  
Regardless of the method you choose, you also must specify a Width for the 
element.  Units are shown to the right of the edit boxes.  The element name and type, 
and a picture of the element also are shown.  

Equalization Tank Operation 
The Operation tab, shown below, allows the user to enter operating parameters for 
an equalization tank element. 

 
The equalization tank operation tab 

You may specify Equalization tank mode (either a constant or variable liquid 
volume) by clicking on the appropriate radio button.  If the Constant liquid 
volume mode is selected, the outflow rate is equal to the inflow rate, and no other 
operating data are required; the liquid volume is equal to the volume entered in the 
dimensions tab. 

If the Variable liquid volume mode is selected, the Outflow rate and Initial 
liquid hold-up (as a percentage of the full volume) must be specified.  Edit boxes 
are provided for entering the outflow rate and initial liquid hold-up; flow units are 
shown adjacent to these. 

Bioreactor 
The bioreactor simulates the activated sludge process in a continuous stirred tank 
reactor (CSTR).  Complex activated sludge systems can be configured by arranging a 
number of bioreactors in series/parallel.  You may specify parameters related to the 
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operation and control of the bioreactor element.  For information on monitoring 
parameters/variables for this element, please see Monitoring Data. 

 
The bioreactor monitor items tab 

Bioreactor Dimensions  
The Dimensions tab, shown below, allows the user to enter the physical 
dimensions of a bioreactor element. 
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The bioreactor dimensions tab 

There are two methods for entering the dimensions: by Area and depth, or by 
Volume and depth.  The method is specified by clicking on the appropriate radio 
button.  If you select by area and depth, the bioreactor area and depth must be 
entered in the Area and Depth text edit boxes.  If you select by volume and depth, 
the bioreactor volume and depth must be entered in the Volume and Depth text edit 
boxes.  Regardless of the method you choose, you also must specify a Width for the 
element.  Units are shown to the right of the edit boxes.  The element name and type, 
and a picture of the element also are shown. 

Bioreactor Operation  
The Operation tab, shown below, allows the user to enter operating parameters for 
a bioreactor element, such as aeration specifications and local temperature, as well as 
change local model parameters. 
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The bioreactor operation tab 

There are two methods for specifying aeration:  either by a DO setpoint or by an 
Air supply rate.  The aeration method is specified by clicking on the appropriate 
radio button.  When DO setpoint is selected, the setpoint concentration must be 
specified.  You may specify either a Constant setpoint or a Scheduled DO 
setpoint pattern (clicking the Pattern…  button will open the Edit DO setpoint 
itinerary dialog box).  You may wish to place a restriction on the maximum 
allowable air flowrate that may be used to achieve the desired DO setpoint.  This is a 
useful feature for investigating the ability of air equipment to achieve desired DO 
setpoints. 

When Air supply rate is selected, the air flowrate must be specified.  You may 
specify either a Constant air flowrate or a Scheduled air flowrate pattern 
(clicking the Pattern… button will open the Edit air flow itinerary dialog box). 

The mechanical mixing Power input (unaerated reactors) can be specified.  
This is used to calculate the velocity gradient in the vessel. 

Note : If you wish to change any of the aeration model parameters, click the Model 
parameters… button to open the Model parameter editor dialog box (Note that 
this changes the aeration model parameters on a local level only). 

A Local temperature also may be specified for a bioreactor element.  When you 
click on the check box for local temperature, the Specify temperature by radio 
button group is enabled.  You may then specify either a Constant or Scheduled 
temperature.  If constant temperature is selected, you may enter the value in the edit 
box.  If scheduled temperature is selected the Pattern… button becomes active.  
Clicking this button presents you with the Edit temperature itinerary dialog box. 

You also can specify Local kinetic parameters for the activated sludge model 
used in the bioreactor element.  If you click on the check box for local kinetic 
parameters, then clicking the Model parameters… button opens the Model 
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parameter editor dialog box allowing you access to the various activated sludge 
model kinetic parameters. 

To specify local aeration parameters (e.g. alpha and beta factors), check the box 
labeled Local aeration parameters. 

To model the concentrations of the constituents of the aeration gas (e.g. oxygen, 
carbon dioxide, etc.), check the box labeled Model gas phase.  If this option is 
selected you may also enter a percentage value for the Gas hold-up (i.e. the 
percentage of the total reactor volume occupied by aeration gas). 

Media Bioreactor 
The media bioreactor can be used to simulate activated sludge processes which 
involve a mixture of fixed and suspended phases.  Complex activated sludge systems 
can be configured by arranging a number of media bioreactors in series/parallel.  
You may specify parameters related to the operation and control of the media 
bioreactor element.  For information on monitoring parameters/variables for this 
element, please see Monitoring Data. 

 
The monitor items tab 

Media bioreactor Dimensions  
The Dimensions tab, shown below, allows the user to enter the physical 
dimensions of a media bioreactor element. 
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The dimensions tab 

There are two methods for entering the dimensions: by Area and depth, or by 
Volume and depth.  The method is specified by clicking on the appropriate radio 
button.  If you select by area and depth, the media bioreactor area and depth must be 
entered in the Area and Depth text edit boxes.  If you select by volume and depth, 
the media bioreactor volume and depth must be entered in the Volume and Depth 
text edit boxes.  Regardless of the method you choose, you also must specify a 
Width for the element.  Units are shown to the right of the edit boxes.  The element 
name and type, and a picture of the element also are shown. 

Media and model specification  
The Media and model specification tab, shown below, has two areas.  The first 
area (Model options) allows the user to specify whether the media should be 
considered for this simulation, the number of layers to use when modeling the 
biofilm attached to the media and the liquid boundary layer thickness.  
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The Media and model specification tab 

The media area of this tab, allows the user to specify the type and quantity of media 
to be used in the vessel  The “% of the reactor filled with media” determines the 
amount of media and consequently the area of media for biofilm growth.  The media 
volume is calculated by multiplying the reactor volume with the media fill fraction 
(the percentage/100) and the “Specific volume”.   The area for biofilm growth is 
calculated by multiplying the reactor volume with the media fill fraction (the 
percentage/100) and the “Specific area”.  BioWin also attempts to correct the liquid 
volume for the media and  biofilm growth.  The liquid volume in the media 
bioreactor is determined as follows: 

Liquid volume = Vessel volume  

                         – Media Volume  

                         – (Media area * Assumed Film thickness for tank volume correction) 

Media bioreactor Operation  
The Operation tab, shown below, allows the user to enter operating parameters for 
a media bioreactor element, such as aeration specifications and local temperature, as 
well as change local model parameters. 
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The operation tab 

There are two methods for specifying aeration:  either by a DO setpoint or by an 
Air supply rate.  The aeration method is specified by clicking on the appropriate 
radio button.  When DO setpoint is selected, the setpoint concentration must be 
specified.  You may specify either a Constant setpoint or a Scheduled DO 
setpoint pattern (clicking the Pattern…  button will open the Edit DO setpoint 
itinerary dialog box).  You may wish to place a restriction on the maximum 
allowable air flowrate that may be used to achieve the desired DO setpoint.  This is a 
useful feature for investigating the ability of air equipment to achieve desired DO 
setpoints. 

When Air supply rate is selected, the air flowrate must be specified.  You may 
specify either a Constant air flowrate or a Scheduled air flowrate pattern 
(clicking the Pattern… button will open the Edit air flow itinerary dialog box). 

The mechanical mixing Power input (unaerated reactors) can be specified.  
This is used to calculate the velocity gradient in the vessel. 

Note : If you wish to change any of the aeration model parameters, click the Model 
parameters… button to open the Model parameter editor dialog box (Note that 
this changes the aeration model parameters on a local level only). 

A Local temperature also may be specified for a media bioreactor element.  When 
you click on the check box for local temperature, the Specify temperature by 
radio button group is enabled.  You may then specify either a Constant or 
Scheduled temperature.  If constant temperature is selected, you may enter the 
value in the edit box.  If scheduled temperature is selected the Pattern… button 
becomes active.  Clicking this button presents you with the Edit temperature 
itinerary dialog box. 

You also can specify Local kinetic parameters for the activated sludge model 
used in the media bioreactor element.  If you click on the check box for local kinetic 
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parameters, then clicking the Model parameters… button opens the Model 
parameter editor dialog box allowing you access to the various activated sludge 
model kinetic parameters. 

To specify local aeration parameters (e.g. alpha and beta factors), check the box 
labeled Local aeration parameters. 

To model the concentrations of the constituents of the aeration gas (e.g. oxygen, 
carbon dioxide, etc.), check the box labeled Model gas phase.  If this option is 
selected you may also enter a percentage value for the Gas hold-up (i.e. the 
percentage of the total reactor volume occupied by aeration gas). 

Surface Aerator Bioreactor 
The surface aerator bioreactor simulates the activated sludge process in a continuous 
stirred tank reactor (CSTR) similarly to a regular bioreactor.  However, aeration may 
be entered in terms of power supply rather than air supply.  You may specify 
parameters related to the operation and control of the surface aerator bioreactor 
element.  For information on monitoring parameters/variables for this element, 
please see Monitoring Data. 

 
The surface aerator bioreactor monitor items tab 

Surface Aerator Bioreactor Dimensions  
The Dimensions tab, shown below, allows the user to enter the physical 
dimensions of a surface aerator bioreactor element. 
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The surface aerator bioreactor dimensions tab 

There are two methods for entering the dimensions: by Area and depth, or by 
Volume and depth.  The method is specified by clicking on the appropriate radio 
button.  If you select by area and depth, the surface aerator bioreactor area and depth 
must be entered in the Area and Depth text edit boxes.  If you select by volume and 
depth, the surface aerator bioreactor volume and depth must be entered in the 
Volume and Depth text edit boxes.  Regardless of the method you choose, you also 
must specify a Width for the element.  Units are shown to the right of the edit boxes.  
The element name and type, and a picture of the element also are shown. 

Surface Aerator Bioreactor Operation  
The Operation tab, shown below, allows the user to enter operating parameters for 
a surface aerator bioreactor element, such as aeration specifications and local 
temperature, as well as change local model parameters. 
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The surface aerator bioreactor operation tab 

There are two methods for specifying aeration:  either by a DO setpoint or by a 
Power supply rate.  The aeration method is specified by clicking on the 
appropriate radio button.  When DO setpoint is selected, the setpoint concentration 
must be specified.  You may specify either a Constant setpoint or a Scheduled 
DO setpoint pattern (clicking the Pattern…  button will open the Edit DO 
setpoint itinerary dialog box).  You may wish to place a restriction on the 
maximum allowable power supply rate that may be used to achieve the desired DO 
setpoint.  This is a useful feature for investigating the ability of air equipment to 
achieve desired DO setpoints. 

When Power supply rate is selected, the power supply rate must be specified.  
You may specify either a Constant power supply rate or a Scheduled power 
supply rate pattern (clicking the Pattern… button will open the Edit power 
supply rate itinerary dialog box). 

Note that if you wish to change any of the aeration model parameters, click the 
Model parameters… button to open the Model parameter editor dialog box 
(Note that this changes the aeration model parameters on a local level only). 

A Local temperature also may be specified for a surface aerator bioreactor 
element.  When you click on the check box for local temperature, the Specify 
temperature by radio button group is enabled.  You may then specify either a 
Constant or Scheduled temperature.  If constant temperature is selected, you may 
enter the value in the edit box.  If scheduled temperature is selected the Pattern… 
button becomes active.  Clicking this button presents you with the Edit 
temperature itinerary dialog box. 

You also can specify Local kinetic parameters for the activated sludge model 
used in the surface aerator bioreactor element.  If you click on the check box for 
local kinetic parameters, then clicking the Model parameters… button opens the 
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Model parameter editor dialog box allowing you access to the various activated 
sludge model kinetic parameters. 

To specify local aeration parameters (e.g. alpha and beta factors), check the box 
labeled Local aeration parameters. 

Brush Aerator Bioreactor 
The brush aerator bioreactor simulates the activated sludge process in a continuous 
stirred tank reactor (CSTR) similarly to a regular bioreactor.  However, aeration may 
be entered in terms of power supply rather than air supply.  You may specify 
parameters related to the operation and control of the brush aerator bioreactor 
element.  For information on monitoring parameters/variables for this element, 
please see Monitoring Data. 

 
The brush aerator bioreactor monitor items tab 

Brush Aerator Bioreactor Dimensions  
The Dimensions tab, shown below, allows the user to enter the physical 
dimensions of a brush aerator bioreactor element. 
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The surface aerator bioreactor dimensions tab 

There are two methods for entering the dimensions: by Area and depth, or by 
Volume and depth.  The method is specified by clicking on the appropriate radio 
button.  If you select by area and depth, the brush aerator bioreactor area and depth 
must be entered in the Area and Depth text edit boxes.  If you select by volume and 
depth, the brush aerator bioreactor volume and depth must be entered in the Volume 
and Depth text edit boxes.  Regardless of the method you choose, you also must 
specify a Width for the element.  Units are shown to the right of the edit boxes.  The 
element name and type, and a picture of the element also are shown. 

Brush Aerator Bioreactor Operation  
The Operation tab, shown below, allows the user to enter operating parameters for 
a brush aerator bioreactor element, such as aeration specifications and local 
temperature, as well as change local model parameters. 
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The brush aerator bioreactor operation tab 

There are two methods for specifying aeration:  either by a DO setpoint or by a 
Power supply rate.  The aeration method is specified by clicking on the 
appropriate radio button.  When DO setpoint is selected, the setpoint concentration 
must be specified.  You may specify either a Constant setpoint or a Scheduled 
DO setpoint pattern (clicking the Pattern…  button will open the Edit DO 
setpoint itinerary dialog box).  You may wish to place a restriction on the 
maximum allowable power supply rate that may be used to achieve the desired DO 
setpoint.  This is a useful feature for investigating the ability of air equipment to 
achieve desired DO setpoints. 

When Power supply rate is selected, the power supply rate must be specified.  
You may specify either a Constant power supply rate or a Scheduled power 
supply rate pattern (clicking the Pattern… button will open the Edit power 
supply rate itinerary dialog box). 

Note that if you wish to change any of the aeration model parameters, click the 
Model parameters… button to open the Model parameter editor dialog box 
(Note that this changes the aeration model parameters on a local level only). 

A Local temperature also may be specified for a brush aerator bioreactor element.  
When you click on the check box for local temperature, the Specify temperature 
by radio button group is enabled.  You may then specify either a Constant or 
Scheduled temperature.  If constant temperature is selected, you may enter the 
value in the edit box.  If scheduled temperature is selected the Pattern… button 
becomes active.  Clicking this button presents you with the Edit temperature 
itinerary dialog box. 

You also can specify Local kinetic parameters for the activated sludge model 
used in the brush aerator bioreactor element.  If you click on the check box for local 
kinetic parameters, then clicking the Model parameters… button opens the 
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Model parameter editor dialog box allowing you access to the various activated 
sludge model kinetic parameters. 

To specify local aeration parameters (e.g. alpha and beta factors), check the box 
labeled Local aeration parameters. 

Variable Volume/Batch Bioreactor 
The variable volume/batch bioreactor simulates the activated sludge process in a 
variable volume continuous stirred tank reactor (CSTR).  You can specify 
parameters related to the operation and control of the variable volume/batch 
bioreactor element, as well as parameters related to the initial conditions.  For 
information on monitoring parameters/variables for this element, please see 
Monitoring Data. 

 
The variable volume/batch bioreactor monitor items tab 

Variable Volume/Batch Bioreactor Dimensions 
The Dimensions tab, shown below, allows the user to enter the physical 
dimensions of a variable volume/batch bioreactor element. 
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The variable volume/batch bioreactor dimensions tab 

There are two methods for entering the dimensions: by Area and depth, or by 
Volume and depth.  The method is specified by clicking on the appropriate radio 
button.  If you select by area and depth, the variable volume/batch bioreactor area 
and depth must be entered in the Area and Depth text edit boxes.  If you select by 
volume and depth, the variable volume/batch bioreactor volume and depth must be 
entered in the Volume and Depth text edit boxes.  Regardless of the method you 
choose, you also must specify a Width for the element.  Units are shown to the right 
of the edit boxes.  The element name and type, and a picture of the element also are 
shown. 

Variable Volume/Batch Bioreactor Operation 
The Operation tab, shown below, allows the user to enter operating parameters for 
a variable volume/batch bioreactor element, such as aeration specifications and local 
temperature, as well as change local model parameters. 
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The variable volume/batch bioreactor operation tab 

There are two methods for specifying aeration:  either by a DO setpoint or by an 
Air supply rate.  The aeration method is specified by clicking on the appropriate 
radio button.  When DO setpoint is selected, the setpoint concentration must be 
specified.  You may specify either a Constant setpoint or a Scheduled DO 
setpoint pattern (clicking the Pattern…  button will open the Edit DO setpoint 
itinerary dialog box).  You may wish to place a restriction on the maximum 
allowable air flowrate that may be used to achieve the desired DO setpoint.  This is a 
useful feature for investigating the ability of air equipment to achieve desired DO 
setpoints. 

When Air supply rate is selected, the air flowrate must be specified.  You may 
specify either a Constant air flowrate or a Scheduled air flowrate pattern 
(clicking the Pattern… button will open the Edit air flow itinerary dialog box. 

The mechanical mixing Power input (unaerated reactors) can be specified.  
This is used to calculate the velocity gradient in the vessel. 

Note : If you wish to change any of the aeration model parameters, click the Model 
parameters… button to open the Model parameter editor dialog box (Note that 
this changes the aeration model parameters on a local level only). 

A Local temperature also may be specified for a variable volume/batch bioreactor 
element.  When you click on the check box for local temperature, the Specify 
temperature by radio button group is enabled.  You may then specify either a 
Constant or Scheduled temperature.  If constant temperature is selected, you may 
enter the value in the edit box.  If scheduled temperature is selected the Pattern… 
button becomes active.  Clicking this button presents you with the Edit 
temperature itinerary dialog box. 

You also can specify Local kinetic parameters for the activated sludge model 
used in the variable volume/batch bioreactor element.  If you click on the check box 
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for local kinetic parameters, then clicking the Model parameters… button opens 
the Model parameter editor dialog box allowing you access to the various 
activated sludge model kinetic parameters. 

To specify local aeration parameters (e.g. alpha and beta factors), check the box 
labeled Local aeration parameters. 

To model the concentrations of the constituents of the aeration gas (e.g. oxygen, 
carbon dioxide, etc.), check the box labeled Model gas phase.  If this option is 
selected you may also enter a percentage value for the Gas hold-up (i.e. the 
percentage of the total reactor volume occupied by aeration gas). 

Variable Volume/Batch Bioreactor Initial Values 
The Initial values tab, shown below, is used for setting up the initial settings for 
variable volume/batch bioreactor concentrations and volume. 

 
The variable volume/batch bioreactor initial values tab with the Seed values option active 

Use the Initial liquid hold-up field to enter a value to specify the % of full setting.  
This initial liquid hold-up volume will be used for steady state calculations.  It 
should be noted here that the lower and upper limits on this value are 0.02 and 
99.98%, respectively.  This reflects the fact that this is the liquid volume, and allows 
for small differences between liquid volume and reactor volume for inlet and outlet 
pipes. 

There are two methods for setting up Initial concentrations in the variable 
volume/batch bioreactor.  The dialog box shown above illustrates the first case where 
the Seed values option is selected.  When this option is selected, BioWin applies 
default seed values for all the state variables (except volume, which you specify) in 
the same manner it would for other bioreactor elements. 

The dialog box shown below illustrates the second case where the Specify values 
option is selected.  In this case, an editable list of state variables is displayed in the 
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dialog box.  This allows you to enter your own seed values for state variables in the 
variable volume/batch bioreactor.  These will be inserted in the variable 
volume/batch bioreactor when you begin a steady state simulation, or when you 
begin a dynamic simulation and choose to use seed values. 

 
The variable volume/batch bioreactor initial values tab with the Specify values option active 

When the specified seed values get inserted in the variable volume/batch bioreactor 
is determined by the Set initial values on OK option.  If this option is not 
checked: 

   

• The specified seed values will be placed in the variable volume/batch 
bioreactor at the beginning of a steady state simulation if you elect to 
start from seed conditions; 

• The specified values will be placed in the variable volume/batch 
bioreactor at the beginning of a dynamic simulation if you elect to seed 
the simulation. 

If this option is checked, the specified values are placed in the variable volume/batch 
bioreactor when you click OK to close the dialog box, overriding any existing 
state variable values.  Therefore, the state variable values at the beginning of a 
dynamic simulation will be the same regardless of whether or not you choose to re-
seed. 

The use of this option is best explained by the example illustrated below.  In this 
example, we want to feed a variable volume/batch bioreactor (the bottom train with 
blue pipes) with a portion of the waste from a normal bioreactor that is running at 
steady state conditions (i.e. the top train with red pipes).  However, we don't want the 
variable volume/batch bioreactor to start up at steady state – we want to specify start-
up conditions and then investigate the dynamic behavior. 
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Example system illustrating the use of variable volume / batch bioreactor seeding options 

To obtain steady state conditions, set up the configuration and run a steady state 
simulation.  Next, on the variable volume/batch bioreactor Initial values tab, select 
the Specify values option for initial concentrations and enter the desired state 
variable start-up conditions for the batch test.  Select the Set initial values on OK 
option so that the start-up values are immediately placed in the variable 
volume/batch bioreactor.  Now when the dynamic simulation is started, choose to 
use the Current values in elements to begin.  In this example, the Set initial 
values on OK option is what allows us to have unique start-up conditions in the 
batch test. 

Variable Volume/Batch Bioreactor Outflow 
Remember for steady state 
simulations, the initial liquid 
hold-up volume will be used 
for calculations. 

The variable volume/batch bioreactor element Outflow tab, shown below, is used to 
specify the overflow behavior.  The overflow behavior can be generalized as 
follows: 

   

• Whenever the variable volume/batch bioreactor is full, it overflows at 
the influent rate, regardless of the overflow setting. 

• Whenever the variable volume/batch bioreactor is empty and the 
outflow rate is set higher than the influent rate, the variable 
volume/batch bioreactor will only have an outflow equal to the influent 
flow, so as not to have negative volume.  If the outflow rate is set lower 
than the influent rate, then the variable volume/batch bioreactor will 
begin to fill up. 

The following is a description of the behavior of the three outflow settings: 

   

• Overflow only – the variable volume/batch bioreactor fills up, and 
then overflows at the influent flow rate (this setting would be used to 
simulate start-up of a bioreactor). 

• Constant outflow – the outflow always tries to attain the specified 
constant rate, except when physically constrained (i.e. when the 
variable volume/batch bioreactor is full or empty) 

• Flow pattern – the outflow always tries to attain the current specified 
pattern rate, except when physically constrained (i.e. when the variable 
volume/batch bioreactor is full or empty).  To specify a pattern, click 
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the Pattern… button when it becomes active.  For more information , 
see the Liquid outflow itinerary section. 

 
The variable volume/batch bioreactor outflow settings tab 

Sidestream reactor 
The sidestream reactor simulates the activated sludge process in a continuous stirred 
tank reactor (CSTR).  Complex activated sludge systems can be configured by 
arranging a number of sidestream reactors in series/parallel.  You may specify 
parameters related to the operation and control of the sidestream reactor element.  
For information on monitoring parameters/variables for this element, please see 
Monitoring Data. 
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The monitor items tab 

Sidestream Reactor Dimensions  
The Dimensions tab, shown below, allows the user to enter the physical 
dimensions of a sidestream reactor element. 
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The dimensions tab 

There are two methods for entering the dimensions: by Area and depth, or by 
Volume and depth.  The method is specified by clicking on the appropriate radio 
button.  If you select by area and depth, the sidestream reactor area and depth must 
be entered in the Area and Depth text edit boxes.  If you select by volume and 
depth, the sidestream reactor volume and depth must be entered in the Volume and 
Depth text edit boxes.  Regardless of the method you choose, you also must specify 
a Width for the element.  Units are shown to the right of the edit boxes.  The 
element name and type, and a picture of the element also are shown. 

Sidestream Reactor Operation  
The Operation tab, shown below, allows the user to enter operating parameters for 
a sidestream reactor element, such as aeration specifications and local temperature, 
as well as change local model parameters. 

 
The operation tab 

There are two methods for specifying aeration:  either by a DO setpoint or by an 
Air supply rate.  The aeration method is specified by clicking on the appropriate 
radio button.  When DO setpoint is selected, the setpoint concentration must be 
specified.  You may specify either a Constant setpoint or a Scheduled DO 
setpoint pattern (clicking the Pattern…  button will open the Edit DO setpoint 
itinerary dialog box).  You may wish to place a restriction on the maximum 
allowable air flowrate that may be used to achieve the desired DO setpoint.  This is a 
useful feature for investigating the ability of air equipment to achieve desired DO 
setpoints. 

When Air supply rate is selected, the air flowrate must be specified.  You may 
specify either a Constant air flowrate or a Scheduled air flowrate pattern 
(clicking the Pattern… button will open the Edit air flow itinerary dialog box). 
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The mechanical mixing Power input (unaerated reactors) can be specified.  
This is used to calculate the velocity gradient in the vessel. 

Note : If you wish to change any of the aeration model parameters, click the Model 
parameters… button to open the Model parameter editor dialog box (Note that 
this changes the aeration model parameters on a local level only). 

A sidestream reactor element has the Local temperature option selected by 
default as if is frequently used to model digester effluents that may be elevated in 
temperature.  Although the default setting is a constant temperature of 35 degrees 
celcius the Specify temperature by radio button allows you to specify either a 
Constant or Scheduled temperature.  If constant temperature is selected, you may 
enter the value in the edit box.  If scheduled temperature is selected the Pattern… 
button becomes active.  Clicking this button presents you with the Edit 
temperature itinerary dialog box. 

You also can specify Local kinetic parameters for the activated sludge model 
used in the sidestream reactor element.  If you click on the check box for local 
kinetic parameters, then clicking the Model parameters… button opens the 
Model parameter editor dialog box allowing you access to the various activated 
sludge model kinetic parameters. 

To specify local aeration parameters (e.g. alpha and beta factors), check the box 
labeled Local aeration parameters. 

To model the concentrations of the constituents of the aeration gas (e.g. oxygen, 
carbon dioxide, etc.), check the box labeled Model gas phase.  If this option is 
selected you may also enter a percentage value for the Gas hold-up (i.e. the 
percentage of the total reactor volume occupied by aeration gas). 

 

Single-Tank Sequencing Batch Reactor 
The single-tank sequencing batch reactor (STSBR) is the simplest SBR element 
available in BioWin.  However, it still can be a complex unit to incorporate into a 
configuration.  You may specify parameters related to the STSBR dimensions, cycle 
operation, starting values, and underflow rates.  For information on monitoring 
parameters/variables for this element, please see Monitoring Data. 
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The STSBR monitor items tab 

STSBR Dimensions 
The Dimensions tab, shown below, allows the user to enter the physical 
dimensions of a STSBR element. 
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The STSBR dimensions tab 

There are two methods for entering the dimensions: by Area and depth, or by 
Volume and depth.  The method is specified by clicking on the appropriate radio 
button.  If you select by area and depth, the STSBR area and depth must be entered 
in the Area and Depth text edit boxes.  If you select by volume and depth, the 
STSBR volume and depth must be entered in the Volume and Depth text edit 
boxes.  Units are shown to the right of the edit boxes.  Regardless of the method you 
choose, you also must specify a Width for the STSBR. 
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Flow distribution in a Single-tank SBR 

BioWin uses the  Width parameter to calculate the length of the STSBR.  The length 
is then divided into three equally sized zones.  Flow enters the first zone at the level 
specified by the Feed layer.  Underflow leaves the STSBR at the bottom of the 
third zone, and decant and/or overflow leaves the STSBR at the top of the third zone. 

Some further explanation of how BioWin uses the SBR dimensions is warranted.  
When you set the dimensions, you specify a Volume, Depth and Width (and 
Length is calculated).  Now think of a 2-d side-on view of the SBR with flow from 
left to right, as shown above. 

For example, imagine the full depth is 5 m and the length is 15 m.  When settling 
starts, this is what happens: 

   

• The horizontal length of the SBR is divided into three equal-length 
subsections (each 5 m in this case). 

• The vertical direction is divided into 10 equal-depth layers.  [Note:  as 
the level goes down during decanting - with no feed - the number of 
layers stays at 10, and the depth of each layer decreases].  That is, think 
of each length section as being 10 layers stacked on top of each other 
(and there are 3 sections). 

• Each of the three sections is treated as a vertical settler.  That is, the 
SBR (during settling) is 3 side-by-side settlers, with a total of 30 cells 
(each completely mixed i.e. of uniform composition). 

Consider the dimensions of each of the 30 cells: 

   

• The horizontal area of each cell is Width * (Length/3) = W * 5 m 
here. 

• The end area of each cell is Width * (Liquid Depth/10) = W * 0.5 m 
(0.5 m when it is full).  [Note: in this case the ratio of cell horizontal to 
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side area is 5 : 0.5 = 10 : 1 (if tank is full - but ratio increases when tank 
level drops)]. 

For the moment. assume that there is no inflow during decanting.  Decant is removed 
from the top-right cell.  During decanting several things happen (apart from settling 
in each of the 3 sections): 

   

• Say 1 (incremental) unit of volume is removed from the top-right cell 
(at the composition of the top right cell). 

• Overall, the volume of each of the 30 cells must be decreased by 1 unit 
/ 30 (the length of each cell is fixed, so the depth must decrease). 

• 29/30ths of the unit volume must get into the top right cell.  That is, 
overall 1/30th of the volume must be removed from each of the other 
29 cells. 

• The 29/30ths gets into the top right cell from the cell to the left and 
from the cell below it. 

• The cell at the bottom left of the SBR is a special case - there is no flow 
into it - only outflow of 1/30th. This flow leaves via the top surface and 
via the right hand end surface. The flow leaving each of the 2 surfaces 
is proportional to the areas of each surface. 

• Flow balances around each of the other 28 cells is handled in a similar 
manner, doing a simultaneous flow balance on each cell.  For the 
typical cell, there can be: 

• Flow out of the top surface; 

• Flow out the right side; 

• Flow in through the bottom surface; and 

• Flow in through the left surface. 

If there is influent flow during decanting, the flow balance is just slightly more 
complex, but happens in a similar fashion.  Note that this explanation makes the 
process sound like a step-by-step calculation.  In reality, what happens is a whole 
series of simultaneous integrations with error checking. 

A Minimum decant level must also be specified as a percentage of the total 
STSBR volume.  This level is the lowest liquid level that can be achieved by 
decanting liquid out of the top of the STSBR.  Note that it is possible to obtain lower 
liquid levels in a cycle than this value, but to get lower than this level, the liquid 
would have to go out via the underflow. 

The Feed layer also is specified on this tab.  This is the layer where liquid flow is 
introduced to the element.  Note that the layers are numbered such that layer 1 is near 
the top, and number 9 is near the bottom.  The feed flow is distributed throughout the 
STSBR according to the vessel geometry. 

STSBR Operation 
The Operation tab, shown below, allows the user to enter operating parameters for 
a STSBR element, such as cycle patterns, decant flow rates, aeration specifications 
and local temperature, as well as change local model parameters. 
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The STSBR operation tab 

The major operational settings of the STSBR are those related to Cycle settings.  
The Cycle length or duration is the total time that will elapse before the cycle 
begins to repeat itself.  The first event to take place in the cycle is the end of the 
mixing phase/beginning of the settling phase.  You specify this event time with the 
Mix until/Start settling at: spin edit control.  Note that the dialog provides you 
with feedback as to the length of your settling period   The second event to take place 
is the beginning of the decant phase.  You specify this event time with the 
Decant/Draw starting at: spin edit control.  Note that the dialog provides you 
with feedback as to the length of your decant period.  Experimenting with these 
settings will reveal that settling and decanting take place simultaneously – but the 
settling phase length always must be greater than the decant phase length.  Finally, 
you may set up a cycle offset if you wish using the Offset cycle by: control. 

Note that BioWin assumes 
that there is no influent or 
underflow activity during the 
decant period and bases the 
calculation for required 
decant flowrate on that 
premise. 

The next operational setting is the Decant flowrate setting.  You may specify this 
with one of two possible methods.  If you know the flowrate you wish to decant at, 
then choose the At a constant rate of: option and enter the desired value.  If you 
wish BioWin to calculate the decant flowrate for you, select the To minimum 
decant level option.  The decant flowrate is calculated as follows.  At the 
beginning of the decant period, the simulator looks at the difference between the 
current liquid volume and the specified minimum decant volume.  It then calculates 
the necessary flowrate to decant the available liquid during the decant period. 

You can specify the STSBR aeration settings by clicking the SBR aeration… 
button which will show the following dialog box. 
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The STSBR aeration setting dialog box 

There are two methods for specifying aeration:  either by a DO setpoint or by an 
Air supply rate.  The aeration method is specified by clicking on the appropriate 
radio button.  When DO setpoint is selected, the setpoint concentration must be 
specified.  You may specify either a Constant setpoint or a Scheduled DO 
setpoint pattern (clicking the Pattern…  button will open the SBR DO setpoint 
itinerary dialog box).  You may wish to place a restriction on the maximum 
allowable air flowrate that may be used to achieve the desired DO setpoint.  This is a 
useful feature for investigating the ability of air equipment to achieve desired DO 
setpoints. 

When Air supply rate is selected, the air flowrate must be specified.  You may 
specify either a Constant air flowrate or a Scheduled air flowrate pattern 
(clicking the Pattern… button will open the SBR air flowrate itinerary dialog 
box). 

Note that if you wish to change any of the aeration model parameters, click the 
Model parameters… button in the main STSBR Operation tab to open the 
Model parameter editor dialog box (Note that this changes the aeration model 
parameters on a local level only).. 

A Local temperature also may be specified for a STSBR element.  When you 
click on the check box for local temperature, the Specify temperature by radio 
button group is enabled.  You may then specify either a Constant or Scheduled 
temperature.  If constant temperature is selected, you may enter the value in the edit 
box.  If scheduled temperature is selected the Pattern… button becomes active.  
Clicking this button presents you with the Edit temperature itinerary dialog box. 

You also can specify Local kinetic parameters for the activated sludge model 
used in the STSBR decant/settling phase.  For the mixing phase, the global 
model parameter values are used.  If you click on the check box for local kinetic 
parameters, then clicking the Model parameters… button opens the Model 
parameter editor dialog box allowing you access to the various activated sludge 
model kinetic parameters. 

To specify local aeration parameters (e.g. alpha and beta factors), check the box 
labeled Local aeration parameters. 

To model the concentrations of the constituents of the aeration gas (e.g. oxygen, 
carbon dioxide, etc.), check the box labeled Model gas phase.  If this option is 
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selected you may also enter a percentage value for the Gas hold-up (i.e. the 
percentage of the total reactor volume occupied by aeration gas). 

STSBR Initial Values 
The Initial values tab, shown below, is used for setting up the initial settings for 
STSBR element concentrations and volume. 

 
The STSBR initial values tab with the Seed values option active 

Use the Initial liquid hold-up field to enter a value to specify the % of full setting.  
It should be noted here that the lower and upper limits on this value are 0.02 and 
99.98%, respectively.  This reflects the fact that this is the liquid volume, and allows 
for small differences between liquid volume and reactor volume for inlet and outlet 
pipes. 

There are two methods for setting up Initial concentrations in the STSBR.  The 
dialog box shown above illustrates the first case where the Seed values option is 
selected.  When this option is selected, BioWin applies default seed values for all the 
state variables (except volume, which you specify) in the same manner it would for 
other bioreactor elements. 

The dialog box shown below illustrates the second case where the Specify values 
option is selected.  In this case, an editable list of state variables is displayed in the 
dialog box.  This allows you to enter your own seed values for state variables in the 
STSBR.  These will be inserted in the STSBR when you begin a dynamic simulation 
and choose to use seed values. 
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The STSBR initial values tab with the Specify values option active 

When the specified seed values get inserted in the STSBR is determined by the Set 
initial values on OK option.  If this option is not checked: 

   

• The specified values will be placed in the STSBR at the beginning of a 
dynamic simulation if you elect to seed the simulation. 

If this option is checked, the specified values are placed in the STSBR when you 
click OK to close the dialog box, overriding any existing state variable 
values.  Therefore, the state variable values at the beginning of a dynamic 
simulation will be the same regardless of whether or not you choose to re-seed. 

STSBR Underflow 
The STSBR Underflow tab shown below allows you to set up underflow rates and 
patterns for the STSBR element. 



118  •  Element Types  

 
The STSBR underflow settings tab 

The Underflow type may be specified as a Constant underflow or a Flow 
pattern by selecting the appropriate option.  If you select Constant underflow, 
you may enter the desired underflow rate in the edit field.  If you select Flow 
pattern, clicking the Pattern… button will open the Underflow rate itinerary 
dialog box. 

The STSBR underflow may be used for several functions: 

   

1. As a wastage stream; 

2. A mixed liquor recycle to a mixer element in front of the STSBR; 

3. As both a wastage and a recycle by placing a splitter element between 
the underflow and the mixer element in front of the STSBR. 

SBR with Always-Mixed Prezone(s) 
This type of SBR allows you to have hydraulically-linked prezones that are 
continuously mixed, even when the decant zone is in settle mode.  The following 
SBR/always-mixed prezone combinations are available: 

   

• SBR+1 Prezone 

• SBR+2 Prezones 
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BioWin allows you to have internal recycles between the prezones and the SBR, as 
shown in the following diagram. 

 

SBR  
ZONE   

MIXED 
PREZONE   

SBR  
ZONE   

2nd MIXED 
PREZONE  

1st MIXED 
PREZONE   

 
Flow recycles and patterns that can be set up between an SBR and its prezone(s) 

The following sections describe the dialog boxes for the SBR with one and two 
always-mixed prezone(s), respectively. 

SBR with One Always-Mixed Prezone 
This type of SBR provides one hydraulically linked, always-mixed zone separated 
from the fill/draw SBR zone by a baffle.  You may specify parameters related to the 
SBR dimensions, cycle operation, starting values, and underflow rates.  You also 
may specify operating conditions for the always-mixed prezone.  For information on 
monitoring parameters/variables for this element, please see Monitoring Data. 
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The SBR with one always-mixed prezone monitor items tab 

SBR + 1 Always-Mixed Prezone Dimensions 
The SBR Dimensions tab, shown below, allows the user to enter the physical 
dimensions of the SBR zone of an SBR + 1 always-mixed prezone element. 
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The SBR zone dimensions tab 

There are two methods for entering the dimensions: by Area and depth, or by 
Volume and depth.  The method is specified by clicking on the appropriate radio 
button.  If you select by area and depth, the SBR zone area and depth must be 
entered in the Area and Depth text edit boxes.  If you select by volume and depth, 
the SBR zone volume and depth must be entered in the Volume and Depth text edit 
boxes.  Units are shown to the right of the edit boxes.  Regardless of the method you 
choose, you also must specify a Width for the SBR zone. 
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Flow distribution in the SBR zone 

BioWin uses the  Width parameter to calculate the length of the SBR zone.  The 
length is then divided into three equally sized zones.  Flow enters the first zone at the 
level specified by the Feed layer.  Underflow leaves the SBR zone at the bottom of 
the third zone, and decant and/or overflow leaves the SBR zone at the top of the third 
zone. 

Some further explanation of how BioWin uses the SBR dimensions is warranted.  
When you set the dimensions, you specify a Volume, Depth and Width (and 
Length is calculated).  Now think of a 2-d side-on view of the SBR with flow from 
left to right, as shown above. 

For example, imagine the full depth is 5 m and the length is 15 m.  When settling 
starts, this is what happens: 

   

• The horizontal length of the SBR is divided into three equal-length 
subsections (each 5 m in this case). 

• The vertical direction is divided into 10 equal-depth layers.  [Note:  as 
the level goes down during decanting - with no feed - the number of 
layers stays at 10, and the depth of each layer decreases].  That is, think 
of each length section as being 10 layers stacked on top of each other 
(and there are 3 sections). 

• Each of the three sections is treated as a vertical settler.  That is, the 
SBR (during settling) is 3 side-by-side settlers, with a total of 30 cells 
(each completely mixed i.e. of uniform composition). 

Consider the dimensions of each of the 30 cells: 

   

• The horizontal area of each cell is Width * (Length/3) = W * 5 m 
here. 
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• The end area of each cell is Width * (Liquid Depth/10) = W * 0.5 m 
(0.5 m when it is full).  [Note: in this case the ratio of cell horizontal to 
side area is 5 : 0.5 = 10 : 1 (if tank is full - but ratio increases when tank 
level drops)]. 

For the moment. assume that there is no inflow during decanting.  Decant is removed 
from the top-right cell.  During decanting several things happen (apart from settling 
in each of the 3 sections): 

   

• Say 1 (incremental) unit of volume is removed from the top-right cell 
(at the composition of the top right cell). 

• Overall, the volume of each of the 30 cells must be decreased by 1 unit 
/ 30 (the length of each cell is fixed, so the depth must decrease). 

• 29/30ths of the unit volume must get into the top right cell.  That is, 
overall 1/30th of the volume must be removed from each of the other 
29 cells. 

• The 29/30ths gets into the top right cell from the cell to the left and 
from the cell below it. 

• The cell at the bottom left of the SBR is a special case - there is no flow 
into it - only outflow of 1/30th. This flow leaves via the top surface and 
via the right hand end surface. The flow leaving each of the 2 surfaces 
is proportional to the areas of each surface. 

• Flow balances around each of the other 28 cells is handled in a similar 
manner, doing a simultaneous flow balance on each cell.  For the 
typical cell, there can be: 

• Flow out of the top surface; 

• Flow out the right side; 

• Flow in through the bottom surface; and 

• Flow in through the left surface. 

If there is influent flow during decanting, the flow balance is just slightly more 
complex, but happens in a similar fashion.  Note that this explanation makes the 
process sound like a step-by-step calculation.  In reality, what happens is a whole 
series of simultaneous integrations with error checking. 

A Minimum decant level must also be specified as a percentage of the height.  
This level is the lowest liquid level that can be achieved by decanting liquid out of 
the top of the SBR zone.  Note that it is possible to obtain lower liquid levels in a 
cycle than this value, but to get lower than this level, the liquid would have to go out 
via the underflow. 

The Feed layer also is specified on this tab. This is the layer where liquid flow 
from the always mixed prezone is introduced to the main SBR zone. Note that the 
layers are numbered such that layer 1 is near the top, and number 9 is near the 
bottom. 

Single Always-Mixed Prezone Setup 
The Prezone 1 tab shown below is used for specifying the volume and aeration 
settings of the prezone for the SBR + 1 always-mixed prezone element. 
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The single always-mixed prezone configuration tab 

You can specify the volume of the prezone using the Volume text edit field.  You 
can set up the prezone aeration operation by clicking the Prezone 1 aeration… 
button.  Doing so will present you with the dialog box shown below. 

 
The single always-mixed prezone aeration settings dialog box 

There are two methods for specifying aeration:  either by a DO setpoint or by an 
Air supply rate.  The aeration method is specified by clicking on the appropriate 
radio button.  When DO setpoint is selected, the setpoint concentration must be 
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specified.  You may specify either a Constant setpoint or a Scheduled DO 
setpoint pattern (clicking the Pattern…  button will open the Edit DO setpoint 
itinerary dialog box).  You may wish to place a restriction on the maximum 
allowable air flowrate that may be used to achieve the desired DO setpoint.  This is a 
useful feature for investigating the ability of air equipment to achieve desired DO 
setpoints. 

When Air supply rate is selected, the air flowrate must be specified.  You may 
specify either a Constant air flowrate or a Scheduled air flowrate pattern 
(clicking the Pattern… button will open the Edit air flow itinerary dialog box). 

SBR + 1 Always-Mixed Prezone SBR Zone Operation 
The SBR Operation tab, shown below, allows the user to enter operating 
parameters for the SBR zone of an SBR + 1 always-mixed prezone element, such as 
cycle patterns, decant flow rates, aeration specifications and local temperature, as 
well as change local model parameters. 

 
The SBR zone operation tab 

The major operational settings of the SBR zone of the SBR + 1 always-mixed 
prezone are those related to Cycle settings.  The Cycle length or duration is 
the total time that will elapse before the cycle begins to repeat itself.  The first event 
to take place in the cycle is the end of the mixing phase/beginning of the settling 
phase.  You specify this event time with the Mix until/Start settling at: spin edit 
control.  Note that the dialog provides you with feedback as to the length of your 
settling period   The second event to take place is the beginning of the decant phase.  
You specify this event time with the Decant/Draw starting at: spin edit control.  
Note that the dialog provides you with feedback as to the length of your decant 
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period.  Experimenting with these settings will reveal that settling and decanting take 
place simultaneously – but the settling phase length always must be greater than the 
decant phase length.  Finally, you may set up a cycle offset if you wish using the 
Offset cycle by: control. 

Note that BioWin assumes 
that there is no influent or 
underflow activity during the 
decant period and bases the 
calculation for required 
decant flowrate on that 
premise. 

The next operational setting is the Decant flowrate setting.  You may specify this 
with one of two possible methods.  If you know the flowrate you wish to decant at, 
then choose the At a constant rate of: option and enter the desired value.  If you 
wish BioWin to calculate the decant flowrate for you, select the To minimum 
decant level option.  The decant flowrate is calculated as follows.  At the 
beginning of the decant period, the simulator looks at the difference between the 
current liquid volume and the specified minimum decant volume.  It then calculates 
the necessary flowrate to decant the available liquid during the decant period. 

You can specify the SBR zone aeration settings by clicking the SBR aeration… 
button which will show the following dialog box. 

 
The SBR zone aeration setting dialog box 

There are two methods for specifying aeration:  either by a DO setpoint or by an 
Air supply rate.  The aeration method is specified by clicking on the appropriate 
radio button.  When DO setpoint is selected, the setpoint concentration must be 
specified.  You may specify either a Constant setpoint or a Scheduled DO 
setpoint pattern (clicking the Pattern…  button will open the SBR DO setpoint 
itinerary dialog box).  You may wish to place a restriction on the maximum 
allowable air flowrate that may be used to achieve the desired DO setpoint.  This is a 
useful feature for investigating the ability of air equipment to achieve desired DO 
setpoints. 

When Air supply rate is selected, the air flowrate must be specified.  You may 
specify either a Constant air flowrate or a Scheduled air flowrate pattern 
(clicking the Pattern… button will open the SBR air flow itinerary dialog box. 

Note that if you wish to change any of the aeration model parameters, click the 
Model parameters… button in the main Operation tab to open the Model 
parameter editor dialog box (Note that this changes the aeration model parameters 
on a local level only). 

A Local temperature also may be specified for an SBR + 1 always-mixed prezone 
element.  When you click on the check box for local temperature, the Specify 
temperature by radio button group is enabled.  You may then specify either a 
Constant or Scheduled temperature.  If constant temperature is selected, you may 
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enter the value in the edit box.  If scheduled temperature is selected the Pattern… 
button becomes active.  Clicking this button presents you with the Edit 
temperature itinerary dialog box. 

You also can specify Local kinetic parameters for the activated sludge model 
used in the SBR zone decant/settling phase.  For the mixing phase (and for the 
prezone), the global model parameter values are used.  If you click on the check box 
for local kinetic parameters, then clicking the Model parameters… button opens 
the Model parameter editor dialog box allowing you access to the various 
activated sludge model kinetic parameters. 

To specify local aeration parameters (e.g. alpha and beta factors), check the box 
labeled Local aeration parameters. 

To model the concentrations of the constituents of the aeration gas (e.g. oxygen, 
carbon dioxide, etc.), check the box labeled Model gas phase.  If this option is 
selected you may also enter a percentage value for the Gas hold-up (i.e. the 
percentage of the total reactor volume occupied by aeration gas). 

SBR + 1 Always-Mixed Prezone Initial Values 
The Initial values tab, shown below, is used for setting up the initial settings for 
SBR + 1 always-mixed prezone concentrations and volume. 

 
The SBR + 1 always-mixed prezone initial values tab with the Seed values option selected 

Use the Initial liquid hold-up field to enter a value to specify the % of full setting.  
It should be noted here that the lower and upper limits on this value are 0.02 and 
99.98%, respectively.  This reflects the fact that this is the liquid volume, and allows 
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for small differences between liquid volume and reactor volume for inlet and outlet 
pipes. 

There are two methods for setting up Initial concentrations in the SBR + 1 
always-mixed prezone.  The dialog box shown above illustrates the first case where 
the Seed values option is selected.  When this option is selected, BioWin applies 
default seed values for all the state variables (except volume, which you specify) in 
the same manner it would for other bioreactor elements in all of the zones (i.e. 
including the prezone). 

The dialog box shown below illustrates the second case where the Specify values 
option is selected.  In this case, an editable list of state variables is displayed in the 
dialog box.  This allows you to enter your own seed values for state variables in the 
SBR + 1 always-mixed prezone.  These will be inserted in each zone of the SBR + 1 
always-mixed prezone element when you begin a dynamic simulation and choose to 
use seed values. 

 
The SBR + 1 always-mixed prezone initial values tab with the Specify values option selected 

When the specified seed values get inserted in the SBR + 1 always-mixed prezone is 
determined by the Set initial values on OK option.  If this option is not checked: 

   

• The specified values will be placed in the SBR + 1 always-mixed 
prezone at the beginning of a dynamic simulation if you elect to seed 
the simulation. 

If this option is checked, the specified values are placed in the SBR + 1 always-
mixed prezone when you click OK to close the dialog box, overriding any 
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existing state variable values.  Therefore, the state variable values at the 
beginning of a dynamic simulation will be the same regardless of whether or not you 
choose to re-seed. 

SBR + 1 Always-Mixed Prezone Underflow 
The SBR + 1 always-mixed prezone element SBR Underflow tab shown below 
allows you to set up underflow rates and patterns for the SBR zone. 

 
The SBR zone underflow settings tab 

The Underflow type may be specified as a Constant underflow or a Flow 
pattern by selecting the appropriate option.  If you select Constant underflow, 
you may enter the desired underflow rate in the edit field.  If you select Flow 
pattern, clicking the Pattern… button will open the Underflow rate itinerary 
dialog box. 

The SBR zone underflow may be used for several functions: 

   

1. As a wastage stream; 

2. A mixed liquor recycle to a mixer element in front of the SBR + 1 
always-mixed prezone element; 

3. As both a wastage and a recycle by placing a splitter element between 
the underflow and the mixer element in front of the SBR + 1 always-
mixed prezone element. 
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SBR with Two Always-Mixed Prezones 
This type of SBR provides two hydraulically linked, always-mixed zones separated 
from the fill/draw SBR zone by a baffle.  You may specify parameters related to the 
SBR dimensions, cycle operation, starting values, and underflow rates.  You also 
may specify operating conditions for the always-mixed prezone.  For information on 
monitoring parameters/variables for this element, please see Monitoring Data. 

 
The SBR + 2 always-mixed prezones monitor items tab 

SBR + 2 Always-Mixed Prezones Dimensions 
The SBR Dimensions tab, shown below, allows the user to enter the physical 
dimensions of the SBR zone of an SBR + 2 always-mixed prezones element. 
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The SBR + 2 always-mixed prezones dimensions tab 

There are two methods for entering the dimensions: by Area and depth, or by 
Volume and depth.  The method is specified by clicking on the appropriate radio 
button.  If you select by area and depth, the SBR zone area and depth must be 
entered in the Area and Depth text edit boxes.  If you select by volume and depth, 
the SBR zone volume and depth must be entered in the Volume and Depth text edit 
boxes.  Units are shown to the right of the edit boxes.  Regardless of the method you 
choose, you also must specify a Width for the SBR zone. 
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Flow distribution in the SBR zone 

BioWin uses the  Width parameter to calculate the length of the SBR zone.  The 
length is then divided into three equally sized zones.  Flow enters the first zone at the 
level specified by the Feed layer.  Underflow leaves the SBR zone at the bottom of 
the third zone, and decant and/or overflow leaves the SBR zone at the top of the third 
zone. 

Some further explanation of how BioWin uses the SBR dimensions is warranted.  
When you set the dimensions, you specify a Volume, Depth and Width (and 
Length is calculated).  Now think of a 2-d side-on view of the SBR with flow from 
left to right, as shown above. 

For example, imagine the full depth is 5 m and the length is 15 m.  When settling 
starts, this is what happens: 

   

• The horizontal length of the SBR is divided into three equal-length 
subsections (each 5 m in this case). 

• The vertical direction is divided into 10 equal-depth layers.  [Note:  as 
the level goes down during decanting - with no feed - the number of 
layers stays at 10, and the depth of each layer decreases].  That is, think 
of each length section as being 10 layers stacked on top of each other 
(and there are 3 sections). 

• Each of the three sections is treated as a vertical settler.  That is, the 
SBR (during settling) is 3 side-by-side settlers, with a total of 30 cells 
(each completely mixed i.e. of uniform composition). 

Consider the dimensions of each of the 30 cells: 

   

• The horizontal area of each cell is Width * (Length/3) = W * 5 m 
here. 
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• The end area of each cell is Width * (Liquid Depth/10) = W * 0.5 m 
(0.5 m when it is full).  [Note: in this case the ratio of cell horizontal to 
side area is 5 : 0.5 = 10 : 1 (if tank is full - but ratio increases when tank 
level drops)]. 

For the moment. assume that there is no inflow during decanting.  Decant is removed 
from the top-right cell.  During decanting several things happen (apart from settling 
in each of the 3 sections): 

   

• Say 1 (incremental) unit of volume is removed from the top-right cell 
(at the composition of the top right cell). 

• Overall, the volume of each of the 30 cells must be decreased by 1 unit 
/ 30 (the length of each cell is fixed, so the depth must decrease). 

• 29/30ths of the unit volume must get into the top right cell.  That is, 
overall 1/30th of the volume must be removed from each of the other 
29 cells. 

• The 29/30ths gets into the top right cell from the cell to the left and 
from the cell below it. 

• The cell at the bottom left of the SBR is a special case - there is no flow 
into it - only outflow of 1/30th. This flow leaves via the top surface and 
via the right hand end surface. The flow leaving each of the 2 surfaces 
is proportional to the areas of each surface. 

• Flow balances around each of the other 28 cells is handled in a similar 
manner, doing a simultaneous flow balance on each cell.  For the 
typical cell, there can be: 

• Flow out of the top surface; 

• Flow out the right side; 

• Flow in through the bottom surface; and 

• Flow in through the left surface. 

If there is influent flow during decanting, the flow balance is just slightly more 
complex, but happens in a similar fashion.  Note that this explanation makes the 
process sound like a step-by-step calculation.  In reality, what happens is a whole 
series of simultaneous integrations with error checking. 

A Minimum decant level must also be specified as a percentage of the height.  
This level is the lowest liquid level that can be achieved by decanting liquid out of 
the top of the SBR zone.  Note that it is possible to obtain lower liquid levels in a 
cycle than this value, but to get lower than this level, the liquid would have to go out 
via the underflow. 

The Feed layer also is specified on this tab.  This is the layer where liquid flow is 
introduced to the element.  Note that the layers are numbered such that layer 1 is near 
the top, and number 9 is near the bottom.  The feed flow is distributed throughout the 
SBR + 2 always-mixed prezones element according to the vessel geometry. 

First Always-Mixed Prezone Setup 
The Prezone 1 tab shown below is used for specifying the volume and aeration 
settings of the first prezone for the SBR + 2 always-mixed prezones element. 
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The first always mixed prezone configuration tab 

You can specify the volume of the first prezone using the Volume text edit field.  
You can set up the first prezone aeration operation by clicking the Prezone 1 
aeration… button.  Doing so will present you with the dialog box shown below. 

 
The first prezone aeration settings dialog box 

There are two methods for specifying aeration:  either by a DO setpoint or by an 
Air supply rate.  The aeration method is specified by clicking on the appropriate 
radio button.  When DO setpoint is selected, the setpoint concentration must be 
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specified.  You may specify either a Constant setpoint or a Scheduled DO 
setpoint pattern (clicking the Pattern…  button will open the Edit DO setpoint 
itinerary dialog box).  You may wish to place a restriction on the maximum 
allowable air flowrate that may be used to achieve the desired DO setpoint.  This is a 
useful feature for investigating the ability of air equipment to achieve desired DO 
setpoints. 

When Air supply rate is selected, the air flowrate must be specified.  You may 
specify either a Constant air flowrate or a Scheduled air flowrate pattern 
(clicking the Pattern… button will open the Edit air flow itinerary dialog box). 

Second Always-Mixed Prezone Setup 
The Prezone 2 tab shown below is used for specifying the volume and aeration 
settings of the second prezone for the SBR + 2 always-mixed prezones element. 

 
The second always mixed prezone configuration tab 

You can specify the volume of the second prezone using the Volume text edit field.  
You can set up the second prezone aeration operation by clicking the Prezone 2 
aeration… button.  Doing so will present you with the dialog box shown below. 
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The second prezone aeration settings dialog box 

There are two methods for specifying aeration:  either by a DO setpoint or by an 
Air supply rate.  The aeration method is specified by clicking on the appropriate 
radio button.  When DO setpoint is selected, the setpoint concentration must be 
specified.  You may specify either a Constant setpoint or a Scheduled DO 
setpoint pattern (clicking the Pattern…  button will open the Edit DO setpoint 
itinerary dialog box).  You may wish to place a restriction on the maximum 
allowable air flowrate that may be used to achieve the desired DO setpoint.  This is a 
useful feature for investigating the ability of air equipment to achieve desired DO 
setpoints. 

When Air supply rate is selected, the air flowrate must be specified.  You may 
specify either a Constant air flowrate or a Scheduled air flowrate pattern 
(clicking the Pattern… button will open the Edit air flow itinerary dialog box). 

SBR + 2 Always-Mixed Prezones SBR Zone Operation 
The SBR Operation tab, shown below, allows the user to enter operating 
parameters for the SBR zone of an SBR + 2 always-mixed prezones element, such as 
cycle patterns, decant flow rates, aeration specifications and local temperature, as 
well as change local model parameters. 
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The SBR + 2 always-mixed prezones operation tab 

The major operational settings of the SBR zone of the SBR + 2 always-mixed 
prezones are those related to Cycle settings.  The Cycle length or duration is 
the total time that will elapse before the cycle begins to repeat itself.  The first event 
to take place in the cycle is the end of the mixing phase/beginning of the settling 
phase.  You specify this event time with the Mix until/Start settling at: spin edit 
control.  Note that the dialog provides you with feedback as to the length of your 
settling period   The second event to take place is the beginning of the decant phase.  
You specify this event time with the Decant/Draw starting at: spin edit control.  
Note that the dialog provides you with feedback as to the length of your decant 
period.  Experimenting with these settings will reveal that settling and decanting take 
place simultaneously – but the settling phase length always must be greater than the 
decant phase length.  Finally, you may set up a cycle offset if you wish using the 
Offset cycle by: control. 

Note that BioWin assumes 
that there is no influent or 
underflow activity during the 
decant period and bases the 
calculation for required 
decant flowrate on that 
premise. 

The next operational setting is the Decant flowrate setting.  You may specify this 
with one of two possible methods.  If you know the flowrate you wish to decant at, 
then choose the At a constant rate of: option and enter the desired value.  If you 
wish BioWin to calculate the decant flowrate for you, select the To minimum 
decant level option.  The decant flowrate is calculated as follows.  At the 
beginning of the decant period, the simulator looks at the difference between the 
current liquid volume and the specified minimum decant volume.  It then calculates 
the necessary flowrate to decant the available liquid during the decant period. 

You can specify the SBR zone aeration settings by clicking the SBR aeration… 
button which will show the following dialog box. 
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The SBR zone aeration setting dialog box 

There are two methods for specifying aeration:  either by a DO setpoint or by an 
Air supply rate.  The aeration method is specified by clicking on the appropriate 
radio button.  When DO setpoint is selected, the setpoint concentration must be 
specified.  You may specify either a Constant setpoint or a Scheduled DO 
setpoint pattern (clicking the Pattern…  button will open the SBR DO setpoint 
itinerary dialog box).  You may wish to place a restriction on the maximum 
allowable air flowrate that may be used to achieve the desired DO setpoint.  This is a 
useful feature for investigating the ability of air equipment to achieve desired DO 
setpoints. 

When Air supply rate is selected, the air flowrate must be specified.  You may 
specify either a Constant air flowrate or a Scheduled air flowrate pattern 
(clicking the Pattern… button will open the SBR air flow itinerary dialog box). 

Note that if you wish to change any of the aeration model parameters, click the 
Model parameters… button in the main Operation tab to open the Model 
parameter editor dialog box (Note that this changes the aeration model parameters 
on a local level only). 

A Local temperature also may be specified for an SBR + 2 always-mixed 
prezones element.  When you click on the check box for local temperature, the 
Specify temperature by radio button group is enabled.  You may then specify 
either a Constant or Scheduled temperature.  If constant temperature is selected, 
you may enter the value in the edit box.  If scheduled temperature is selected the 
Pattern… button becomes active.  Clicking this button presents you with the Edit 
temperature itinerary dialog box. 

You also can specify Local kinetic parameters for the activated sludge model 
used in the SBR zone decant/settling phase.  For the mixing phase (and for the 
prezones), the global model parameter values are used.  If you click on the check box 
for local kinetic parameters, then clicking the Model parameters… button opens 
the Model parameter editor dialog box allowing you access to the various 
activated sludge model kinetic parameters. 

To specify local aeration parameters (e.g. alpha and beta factors), check the box 
labeled Local aeration parameters. 

To model the concentrations of the constituents of the aeration gas (e.g. oxygen, 
carbon dioxide, etc.), check the box labeled Model gas phase.  If this option is 
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selected you may also enter a percentage value for the Gas hold-up (i.e. the 
percentage of the total reactor volume occupied by aeration gas). 

SBR + 2 Always-Mixed Prezones Initial Values 
The Initial values tab, shown below, is used for setting up the initial settings for 
SBR + 2 always-mixed prezones concentrations and volume. 

 
The SBR + 2 always-mixed prezones initial values tab with the Seed values option selected 

Use the Initial liquid hold-up field to enter a value to specify the % of full setting.  
It should be noted here that the lower and upper limits on this value are 0.02 and 
99.98%, respectively.  This reflects the fact that this is the liquid volume, and allows 
for small differences between liquid volume and reactor volume for inlet and outlet 
pipes. 

There are two methods for setting up Initial concentrations in the SBR + 2 
always-mixed prezones.  The dialog box shown above illustrates the first case where 
the Seed values option is selected.  When this option is selected, BioWin applies 
default seed values for all the state variables (except volume, which you specify) in 
the same manner it would for other bioreactor elements in all of the zones (i.e. 
including the prezones). 

The dialog box shown below illustrates the second case where the Specify values 
option is selected.  In this case, an editable list of state variables is displayed in the 
dialog box.  This allows you to enter your own seed values for state variables in the 
SBR + 2 always-mixed prezones element.  These will be inserted in each zone of the 
SBR + 2 always-mixed prezones element when you begin a dynamic simulation and 
choose to use seed values. 
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The SBR + 2 always-mixed prezones initial values tab with the Specify values option selected 

When the specified seed values get inserted in the SBR + 2 always-mixed prezones 
is determined by the Set initial values on OK option.  If this option is not 
checked: 

   

• The specified values will be placed in the SBR + 2 always-mixed 
prezones at the beginning of a dynamic simulation if you elect to seed 
the simulation. 

If this option is checked, the specified values are placed in the SBR + 2 always-
mixed prezones when you click OK to close the dialog box, overriding any 
existing state variable values.  Therefore, the state variable values at the 
beginning of a dynamic simulation will be the same regardless of whether or not you 
choose to re-seed. 

SBR + 2 Always-Mixed Prezones Underflow 
The SBR + 2 always-mixed prezones SBR Underflow tab shown below allows you 
to set up underflow rates and patterns for the SBR zone. 
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The SBR zone underflow settings tab 

The Underflow type may be specified as a Constant underflow or a Flow 
pattern by selecting the appropriate option.  If you select Constant underflow, 
you may enter the desired underflow rate in the edit field.  If you select Flow 
pattern, clicking the Pattern… button will open the Underflow rate itinerary 
dialog box. 

The SBR zone underflow may be used for several functions: 

   

1. As a wastage stream; 

2. A mixed liquor recycle to a mixer element in front of the SBR + 2 
always-mixed prezones element; 

3. As both a wastage and a recycle by placing a splitter element between 
the underflow and the mixer element in front of the SBR + 2 always-
mixed prezones element. 

SBR + 2 Always-Mixed Prezones Internal Recycle Flows 
The SBR + 2 always-mixed prezones element SBR internal recycle flows tab 
shown below allows you to set up recycles between the SBR zone and the second 
prezone, and between the second and first prezone. 
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The SBR internal recycle flows tab 

You may have a recycle flow which goes from the second prezone to the first one.  If 
you select Constant recycle, you may enter the desired recycle flowrate in the edit 
field.  If you select Recycle pattern, clicking the Pattern… button will open the 
Recycle flowrate itinerary dialog box. 

You also may have a recycle flow which goes from the SBR zone to the second 
prezone.  If you select Constant recycle, you may enter the desired recycle 
flowrate in the edit field.  If you select Recycle pattern, clicking the Pattern… 
button will open the Recycle flowrate itinerary dialog box. 

Two final points should be noted with regard to internal recycle flows: 

   

1. It is possible to have a recycle flow from the SBR zone to the first 
prezone by returning the SBR zone underflow (or a portion of it) to the 
input of the SBR + 2 always-mixed prezones element. 

2. Internal recycle flows are set to zero when the SBR zone goes into 
settle/decant mode. 

SBR with Mix/Settle Prezone(s) 
This type of SBR allows you to have hydraulically-linked prezones that go into 
settling mode when the decant zone goes into settle mode.  The following SBR with 
mix/settle prezone combinations are available: 
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• SBR + 1 Prezone 

• SBR + 2 Prezones 

BioWin allows you to have internal recycles between the prezones and the SBR, as 
shown in the following diagram. 

 

SBR  
ZONE   

MIX/SET 
PREZONE   

SBR  
ZONE   

2nd MIX/SET 
PREZONE  

1st MIX/SET
PREZONE   

 
Flow recycles and patterns that can be set up between an SBR and its prezone(s) 

The following sections describe the dialog boxes for the SBR with one and two 
mix/settle prezone(s), respectively. 

SBR with One Mix/Settle Prezone 
This type of SBR provides one hydraulically linked, mix/settle zone separated from 
the fill/draw SBR zone by a baffle.  You may specify parameters related to the SBR 
dimensions, cycle operation, starting values, and underflow rates.  You also may 
specify operating conditions for the mix/settle prezone.  For information on 
monitoring parameters/variables for this element, please see Monitoring Data. 
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The SBR with one mix/settle prezone monitor items tab 

SBR + 1 Mix/Settle Prezone Dimensions 
The SBR Dimensions tab, shown below, allows the user to enter the physical 
dimensions of the SBR zone of an SBR + 1 mix/settle prezone element. 



 Element Types  •  145 

 
The SBR zone dimensions tab 

There are two methods for entering the dimensions: by Area and depth, or by 
Volume and depth.  The method is specified by clicking on the appropriate radio 
button.  If you select by area and depth, the SBR zone area and depth must be 
entered in the Area and Depth text edit boxes.  If you select by volume and depth, 
the SBR zone volume and depth must be entered in the Volume and Depth text edit 
boxes.  Units are shown to the right of the edit boxes.  Regardless of the method you 
choose, you also must specify a Width for the SBR zone. 
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Flow distribution in the SBR zone 

BioWin uses the  Width parameter to calculate the length of the SBR zone.  The 
length is then divided into three equally sized zones.  Underflow leaves the SBR 
zone at the bottom of the third zone, and decant and/or overflow leaves the SBR 
zone at the top of the third zone. 

Some further explanation of how BioWin uses the SBR dimensions is warranted.  
When you set the dimensions, you specify a Volume, Depth and Width (and 
Length is calculated).  Now think of a 2-d side-on view of the SBR with flow from 
left to right, as shown above. 

For example, imagine the full depth is 5 m and the length is 15 m.  When settling 
starts, this is what happens: 

   

• The horizontal length of the SBR is divided into three equal-length 
subsections (each 5 m in this case). 

• The vertical direction is divided into 10 equal-depth layers.  [Note:  as 
the level goes down during decanting - with no feed - the number of 
layers stays at 10, and the depth of each layer decreases].  That is, think 
of each length section as being 10 layers stacked on top of each other 
(and there are 3 sections). 

• Each of the three sections is treated as a vertical settler.  That is, the 
SBR (during settling) is 3 side-by-side settlers, with a total of 30 cells 
(each completely mixed i.e. of uniform composition). 

Consider the dimensions of each of the 30 cells: 

   

• The horizontal area of each cell is Width * (Length/3) = W * 5 m 
here. 

• The end area of each cell is Width * (Liquid Depth/10) = W * 0.5 m 
(0.5 m when it is full).  [Note: in this case the ratio of cell horizontal to 
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side area is 5 : 0.5 = 10 : 1 (if tank is full - but ratio increases when tank 
level drops)]. 

For the moment. assume that there is no inflow during decanting.  Decant is removed 
from the top-right cell.  During decanting several things happen (apart from settling 
in each of the 3 sections): 

   

• Say 1 (incremental) unit of volume is removed from the top-right cell 
(at the composition of the top right cell). 

• Overall, the volume of each of the 30 cells must be decreased by 1 unit 
/ 30 (the length of each cell is fixed, so the depth must decrease). 

• 29/30ths of the unit volume must get into the top right cell.  That is, 
overall 1/30th of the volume must be removed from each of the other 
29 cells. 

• The 29/30ths gets into the top right cell from the cell to the left and 
from the cell below it. 

• The cell at the bottom left of the SBR is a special case - there is no flow 
into it - only outflow of 1/30th. This flow leaves via the top surface and 
via the right hand end surface. The flow leaving each of the 2 surfaces 
is proportional to the areas of each surface. 

• Flow balances around each of the other 28 cells is handled in a similar 
manner, doing a simultaneous flow balance on each cell.  For the 
typical cell, there can be: 

• Flow out of the top surface; 

• Flow out the right side; 

• Flow in through the bottom surface; and 

• Flow in through the left surface. 

If there is influent flow during decanting, the flow balance is just slightly more 
complex, but happens in a similar fashion.  Note that this explanation makes the 
process sound like a step-by-step calculation.  In reality, what happens is a whole 
series of simultaneous integrations with error checking. 

A Minimum decant level must also be specified as a percentage of the height.  
This level is the lowest liquid level that can be achieved by decanting liquid out of 
the top of the SBR zone.  Note that it is possible to obtain lower liquid levels in a 
cycle than this value, but to get lower than this level, the liquid would have to go out 
via the underflow. 

Note that unlike the SBR + 1 always-mixed prezone and SBR + 2 always-mixed 
prezones elements, you do not specify a feed layer – the feed is input to the top of a 
prezone and flow leaves from the bottom of a prezone. 

Single Mix/Settle Prezone Setup 
The Prezone 1 tab shown below is used for specifying the volume of the prezone 
for the SBR + 1 mix/settle prezone element. 
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The single mix/settle prezone configuration tab 

You can specify the volume of the prezone using the Volume text edit field. 

SBR + 1 Mix/Settle Prezone SBR Zone Operation 
The SBR Operation tab, shown below, allows the user to enter operating 
parameters for the SBR zone of an SBR + 1 mix/settle prezone element, such as 
cycle patterns, decant flow rates, aeration specifications and local temperature, as 
well as change local model parameters. 
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The SBR zone operation tab 

The major operational settings of the SBR zone of the SBR + 1 mix/settle prezone 
are those related to Cycle settings.  The Cycle length or duration is the total 
time that will elapse before the cycle begins to repeat itself.  The first event to take 
place in the cycle is the end of the mixing phase/beginning of the settling phase.  
You specify this event time with the Mix until/Start settling at: spin edit control.  
Note that the dialog provides you with feedback as to the length of your settling 
period   The second event to take place is the beginning of the decant phase.  You 
specify this event time with the Decant/Draw starting at: spin edit control.  Note 
that the dialog provides you with feedback as to the length of your decant period.  
Experimenting with these settings will reveal that settling and decanting take place 
simultaneously – but the settling phase length always must be greater than the decant 
phase length.  Finally, you may set up a cycle offset if you wish using the Offset 
cycle by: control. 

Note that BioWin assumes 
that there is no influent or 
underflow activity during the 
decant period and bases the 
calculation for required 
decant flowrate on that 
premise. 

The next operational setting is the Decant flowrate setting.  You may specify this 
with one of two possible methods.  If you know the flowrate you wish to decant at, 
then choose the At a constant rate of: option and enter the desired value.  If you 
wish BioWin to calculate the decant flowrate for you, select the To minimum 
decant level option.  The decant flowrate is calculated as follows.  At the 
beginning of the decant period, the simulator looks at the difference between the 
current liquid volume and the specified minimum decant volume.  It then calculates 
the necessary flowrate to decant the available liquid during the decant period. 

You can specify the SBR zone aeration settings by clicking the SBR aeration… 
button which will show the following dialog box. 
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The SBR zone aeration setting dialog box 

There are two methods for specifying aeration:  either by a DO setpoint or by an 
Air supply rate.  The aeration method is specified by clicking on the appropriate 
radio button.  When DO setpoint is selected, the setpoint concentration must be 
specified.  You may specify either a Constant setpoint or a Scheduled DO 
setpoint pattern (clicking the Pattern…  button will open the SBR DO setpoint 
itinerary dialog box).  You may wish to place a restriction on the maximum 
allowable air flowrate that may be used to achieve the desired DO setpoint.  This is a 
useful feature for investigating the ability of air equipment to achieve desired DO 
setpoints. 

When Air supply rate is selected, the air flowrate must be specified.  You may 
specify either a Constant air flowrate or a Scheduled air flowrate pattern 
(clicking the Pattern… button will open the SBR air flow itinerary dialog box). 

You can set up the prezone aeration operation by clicking the Prezone 1 
aeration… button.  Doing so will present you with the dialog box shown below. 

 
The single mix/settle prezone aeration settings dialog box 

There are two methods for specifying aeration:  either by a DO setpoint or by an 
Air supply rate.  The aeration method is specified by clicking on the appropriate 
radio button.  When DO setpoint is selected, the setpoint concentration must be 
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specified.  You may specify either a Constant setpoint or a Scheduled DO 
setpoint pattern (clicking the Pattern…  button will open the SBR DO setpoint 
itinerary dialog box).  You may wish to place a restriction on the maximum 
allowable air flowrate that may be used to achieve the desired DO setpoint.  This is a 
useful feature for investigating the ability of air equipment to achieve desired DO 
setpoints. 

When Air supply rate is selected, the air flowrate must be specified.  You may 
specify either a Constant air flowrate or a Scheduled air flowrate pattern 
(clicking the Pattern… button will open the SBR air flow itinerary dialog box). 

Note that if you wish to change any of the aeration model parameters, click the 
Model parameters… button in the main Operation tab to open the Model 
parameter editor dialog box (Note that this changes the aeration model parameters 
on a local level only). 

A Local temperature also may be specified for an SBR + 1 mix/settle prezone 
element.  When you click on the check box for local temperature, the Specify 
temperature by radio button group is enabled.  You may then specify either a 
Constant or Scheduled temperature.  If constant temperature is selected, you may 
enter the value in the edit box.  If scheduled temperature is selected the Pattern… 
button becomes active.  Clicking this button presents you with the Edit 
temperature itinerary dialog box. 

You also can specify Local kinetic parameters for the activated sludge model 
used in the prezone and SBR zone decant/settling phase.  For the mixing phase, 
the global model parameter values are used.  If you click on the check box for local 
kinetic parameters, then clicking the Model parameters… button opens the 
Model parameter editor dialog box allowing you access to the various activated 
sludge model kinetic parameters. 

To specify local aeration parameters (e.g. alpha and beta factors), check the box 
labeled Local aeration parameters. 

To model the concentrations of the constituents of the aeration gas (e.g. oxygen, 
carbon dioxide, etc.), check the box labeled Model gas phase.  If this option is 
selected you may also enter a percentage value for the Gas hold-up (i.e. the 
percentage of the total reactor volume occupied by aeration gas). 

SBR + 1 Mix/Settle Prezone Initial Values 
The Initial values tab, shown below, is used for setting up the initial settings for 
SBR + 1 mix/settle prezone concentrations and volume. 
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The SBR + 1 mix/settle prezone initial values tab with the Seed values option selected 

Use the Initial liquid hold-up field to enter a value to specify the % of full setting.  
It should be noted here that the lower and upper limits on this value are 0.02 and 
99.98%, respectively.  This reflects the fact that this is the liquid volume, and allows 
for small differences between liquid volume and reactor volume for inlet and outlet 
pipes. 

There are two methods for setting up Initial concentrations in the SBR + 1 
mix/settle prezone.  The dialog box shown above illustrates the first case where the 
Seed values option is selected.  When this option is selected, BioWin applies 
default seed values for all the state variables (except volume, which you specify) in 
the same manner it would for other bioreactor elements in all of the zones (i.e. 
including the prezone). 

The dialog box shown below illustrates the second case where the Specify values 
option is selected.  In this case, an editable list of state variables is displayed in the 
dialog box.  This allows you to enter your own seed values for state variables in the 
SBR + 1 mix/settle prezone.  These will be inserted in each zone of the SBR + 1 
mix/settle prezone element when you begin a dynamic simulation and choose to use 
seed values. 
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The SBR + 1 mix/settle prezone initial values tab with the Specify values option selected 

When the specified seed values get inserted in the SBR + 1 mix/settle prezone is 
determined by the Set initial values on OK option.  If this option is not checked: 

   

• The specified values will be placed in the SBR + 1 mix/settle prezone 
at the beginning of a dynamic simulation if you elect to seed the 
simulation. 

If this option is checked, the specified values are placed in the SBR + 1 mix/settle 
prezone when you click OK to close the dialog box, overriding any existing 
state variable values.  Therefore, the state variable values at the beginning of a 
dynamic simulation will be the same regardless of whether or not you choose to re-
seed. 

SBR + 1 Mix/Settle Prezone Underflow 
The SBR + 1 mix/settle prezone SBR Underflow tab shown below allows you to 
set up underflow rates and patterns for the SBR zone of this element. 
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The SBR zone underflow settings tab 

The Underflow type may be specified as a Constant underflow or a Flow 
pattern by selecting the appropriate option.  If you select Constant underflow, 
you may enter the desired underflow rate in the edit field.  If you select Flow 
pattern, clicking the Pattern… button will open the Underflow rate itinerary 
dialog box. 

The SBR zone underflow may be used for several functions: 

   

1. As a wastage stream; 

2. A mixed liquor recycle to a mixer element in front of the SBR + 1 
mix/settle prezone element; 

3. As both a wastage and a recycle by placing a splitter element between 
the underflow and the mixer element in front of the SBR + 1 mix/settle 
prezone element. 

SBR with 2 Mix/Settle Prezones 
This type of SBR provides two hydraulically linked, mix/settle zones separated from 
the fill/draw SBR zone by a baffle.  You may specify parameters related to the SBR 
dimensions, cycle operation, starting values, and underflow rates.  You also may 
specify operating conditions for the mix/settle prezones.  For information on 
monitoring parameters/variables for this element, please see Monitoring Data. 
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The SBR with two mix/settle prezones monitor items tab 

SBR + 2 Mix/Settle Prezones Dimensions 
The SBR Dimensions tab, shown below, allows the user to enter the physical 
dimensions of the SBR zone of an SBR + 2 mix/settle prezones element. 
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The SBR zone dimensions tab 

There are two methods for entering the dimensions: by Area and depth, or by 
Volume and depth.  The method is specified by clicking on the appropriate radio 
button.  If you select by area and depth, the SBR zone area and depth must be 
entered in the Area and Depth text edit boxes.  If you select by volume and depth, 
the SBR zone volume and depth must be entered in the Volume and Depth text edit 
boxes.  Units are shown to the right of the edit boxes.  Regardless of the method you 
choose, you also must specify a Width for the SBR zone. 
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Flow distribution in the SBR zone 

BioWin uses the  Width parameter to calculate the length of the SBR zone.  The 
length is then divided into three equally sized zones.  Underflow leaves the SBR 
zone at the bottom of the third zone, and decant and/or overflow leaves the SBR 
zone at the top of the third zone. 

Some further explanation of how BioWin uses the SBR dimensions is warranted.  
When you set the dimensions, you specify a Volume, Depth and Width (and 
Length is calculated).  Now think of a 2-d side-on view of the SBR with flow from 
left to right, as shown above. 

For example, imagine the full depth is 5 m and the length is 15 m.  When settling 
starts, this is what happens: 

   

• The horizontal length of the SBR is divided into three equal-length 
subsections (each 5 m in this case). 

• The vertical direction is divided into 10 equal-depth layers.  [Note:  as 
the level goes down during decanting - with no feed - the number of 
layers stays at 10, and the depth of each layer decreases].  That is, think 
of each length section as being 10 layers stacked on top of each other 
(and there are 3 sections). 

• Each of the three sections is treated as a vertical settler.  That is, the 
SBR (during settling) is 3 side-by-side settlers, with a total of 30 cells 
(each completely mixed i.e. of uniform composition). 

Consider the dimensions of each of the 30 cells: 

   

• The horizontal area of each cell is Width * (Length/3) = W * 5 m 
here. 

• The end area of each cell is Width * (Liquid Depth/10) = W * 0.5 m 
(0.5 m when it is full).  [Note: in this case the ratio of cell horizontal to 
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side area is 5 : 0.5 = 10 : 1 (if tank is full - but ratio increases when tank 
level drops)]. 

For the moment. assume that there is no inflow during decanting.  Decant is removed 
from the top-right cell.  During decanting several things happen (apart from settling 
in each of the 3 sections): 

   

• Say 1 (incremental) unit of volume is removed from the top-right cell 
(at the composition of the top right cell). 

• Overall, the volume of each of the 30 cells must be decreased by 1 unit 
/ 30 (the length of each cell is fixed, so the depth must decrease). 

• 29/30ths of the unit volume must get into the top right cell.  That is, 
overall 1/30th of the volume must be removed from each of the other 
29 cells. 

• The 29/30ths gets into the top right cell from the cell to the left and 
from the cell below it. 

• The cell at the bottom left of the SBR is a special case - there is no flow 
into it - only outflow of 1/30th. This flow leaves via the top surface and 
via the right hand end surface. The flow leaving each of the 2 surfaces 
is proportional to the areas of each surface. 

• Flow balances around each of the other 28 cells is handled in a similar 
manner, doing a simultaneous flow balance on each cell.  For the 
typical cell, there can be: 

• Flow out of the top surface; 

• Flow out the right side; 

• Flow in through the bottom surface; and 

• Flow in through the left surface. 

If there is influent flow during decanting, the flow balance is just slightly more 
complex, but happens in a similar fashion.  Note that this explanation makes the 
process sound like a step-by-step calculation.  In reality, what happens is a whole 
series of simultaneous integrations with error checking. 

A Minimum decant level must also be specified as a percentage of the height.  
This level is the lowest liquid level that can be achieved by decanting liquid out of 
the top of the SBR zone.  Note that it is possible to obtain lower liquid levels in a 
cycle than this value, but to get lower than this level, the liquid would have to go out 
via the underflow. 

Note that unlike the SBR + 1 always-mixed prezone and SBR + 2 always-mixed 
prezones elements, you do not specify a feed layer – the feed is input at the top of the 
first prezone. 

First Mix/Settle Prezone Setup 
The Prezone 1 tab shown below is used for specifying the volume of the first 
prezone for the SBR + 2 mix/settle prezones element. 



 Element Types  •  159 

 
The first mix/settle prezone configuration tab 

You can specify the volume of the prezone using the Volume text edit field. 

Second Mix/Settle Prezone Setup 
The Prezone 2 tab shown below is used for specifying the volume of the second 
prezone for the SBR + 2 mix/settle prezones element. 
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The second mix/settle prezone configuration tab 

You can specify the volume of the prezone using the Volume text edit field. 

SBR + 2 Mix/Settle Prezones SBR Zone Operation 
The SBR Operation tab, shown below, allows the user to enter operating 
parameters for the SBR zone of an SBR + 2 mix/settle prezones element, such as 
cycle patterns, decant flow rates, aeration specifications and local temperature, as 
well as change local model parameters. 
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The SBR zone operation tab 

The major operational settings of the SBR zone of the SBR + 2 mix/settle prezones 
are those related to Cycle settings.  The Cycle length or duration is the total 
time that will elapse before the cycle begins to repeat itself.  The first event to take 
place in the cycle is the end of the mixing phase/beginning of the settling phase.  
You specify this event time with the Mix until/Start settling at: spin edit control.  
Note that the dialog provides you with feedback as to the length of your settling 
period   The second event to take place is the beginning of the decant phase.  You 
specify this event time with the Decant/Draw starting at: spin edit control.  Note 
that the dialog provides you with feedback as to the length of your decant period.  
Experimenting with these settings will reveal that settling and decanting take place 
simultaneously – but the settling phase length always must be greater than the decant 
phase length.  Finally, you may set up a cycle offset if you wish using the Offset 
cycle by: control. 

Note that BioWin assumes 
that there is no influent or 
underflow activity during the 
decant period and bases the 
calculation for required 
decant flowrate on that 
premise. 

The next operational setting is the Decant flowrate setting.  You may specify this 
with one of two possible methods.  If you know the flowrate you wish to decant at, 
then choose the At a constant rate of: option and enter the desired value.  If you 
wish BioWin to calculate the decant flowrate for you, select the To minimum 
decant level option.  The decant flowrate is calculated as follows.  At the 
beginning of the decant period, the simulator looks at the difference between the 
current liquid volume and the specified minimum decant volume.  It then calculates 
the necessary flowrate to decant the available liquid during the decant period. 

You can specify the SBR zone aeration settings by clicking the SBR aeration… 
button which will show the following dialog box. 
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The SBR zone aeration setting dialog box 

There are two methods for specifying aeration:  either by a DO setpoint or by an 
Air supply rate.  The aeration method is specified by clicking on the appropriate 
radio button.  When DO setpoint is selected, the setpoint concentration must be 
specified.  You may specify either a Constant setpoint or a Scheduled DO 
setpoint pattern (clicking the Pattern…  button will open the SBR DO setpoint 
itinerary dialog box).  You may wish to place a restriction on the maximum 
allowable air flowrate that may be used to achieve the desired DO setpoint.  This is a 
useful feature for investigating the ability of air equipment to achieve desired DO 
setpoints. 

When Air supply rate is selected, the air flowrate must be specified.  You may 
specify either a Constant air flowrate or a Scheduled air flowrate pattern 
(clicking the Pattern… button will open the SBR air flow itinerary dialog box). 

You can set up the first prezone aeration operation by clicking the Prezone 1 
aeration… button.  Doing so will present you with the dialog box shown below. 

 
The first mix/settle prezone aeration settings dialog box 

There are two methods for specifying aeration:  either by a DO setpoint or by an 
Air supply rate.  The aeration method is specified by clicking on the appropriate 
radio button.  When DO setpoint is selected, the setpoint concentration must be 
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specified.  You may specify either a Constant setpoint or a Scheduled DO 
setpoint pattern (clicking the Pattern…  button will open the SBR DO setpoint 
itinerary dialog box).  You may wish to place a restriction on the maximum 
allowable air flowrate that may be used to achieve the desired DO setpoint.  This is a 
useful feature for investigating the ability of air equipment to achieve desired DO 
setpoints. 

When Air supply rate is selected, the air flowrate must be specified.  You may 
specify either a Constant air flowrate or a Scheduled air flowrate pattern 
(clicking the Pattern… button will open the SBR air flow itinerary dialog box). 

Clicking the Prezone 2 aeration… button allows you to specify aeration settings 
for the second prezone using the same dialog boxes as those used for the first zone, 
shown above. 

Note that if you wish to change any of the aeration model parameters, click the 
Model parameters… button in the main Operation tab to open the Model 
parameter editor dialog box (Note that this changes the aeration model parameters 
on a local level only). 

A Local temperature also may be specified for an SBR + 2 mix/settle prezones 
element.  When you click on the check box for local temperature, the Specify 
temperature by radio button group is enabled.  You may then specify either a 
Constant or Scheduled temperature.  If constant temperature is selected, you may 
enter the value in the edit box.  If scheduled temperature is selected the Pattern… 
button becomes active.  Clicking this button presents you with the Edit 
temperature itinerary dialog box. 

You also can specify Local kinetic parameters for the activated sludge model 
used in the prezones and SBR zone decant/settling phase.  For the mixing phase, 
the global model parameter values are used.  If you click on the check box for local 
kinetic parameters, then clicking the Model parameters… button opens the 
Model parameter editor dialog box allowing you access to the various activated 
sludge model kinetic parameters. 

To specify local aeration parameters (e.g. alpha and beta factors), check the box 
labeled Local aeration parameters. 

To model the concentrations of the constituents of the aeration gas (e.g. oxygen, 
carbon dioxide, etc.), check the box labeled Model gas phase.  If this option is 
selected you may also enter a percentage value for the Gas hold-up (i.e. the 
percentage of the total reactor volume occupied by aeration gas). 

SBR + 2 Mix/Settle Prezones Initial Values 
The Initial values tab, shown below, is used for setting up the initial settings for 
SBR + 2 mix/settle prezones concentrations and volume. 
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The SBR + 2 mix/settle prezones initial values tab with the Seed values option selected 

Use the Initial liquid hold-up field to enter a value to specify the % of full setting.  
It should be noted here that the lower and upper limits on this value are 0.02 and 
99.98%, respectively.  This reflects the fact that this is the liquid volume, and allows 
for small differences between liquid volume and reactor volume for inlet and outlet 
pipes. 

There are two methods for setting up Initial concentrations in the SBR + 2 
mix/settle prezones.  The dialog box shown above illustrates the first case where the 
Seed values option is selected.  When this option is selected, BioWin applies 
default seed values for all the state variables (except volume, which you specify) in 
the same manner it would for other bioreactor elements in all of the zones (i.e. 
including the prezones). 

The dialog box shown below illustrates the second case where the Specify values 
option is selected.  In this case, an editable list of state variables is displayed in the 
dialog box.  This allows you to enter your own seed values for state variables in the 
SBR + 2 mix/settle prezones.  These will be inserted in each zone of the SBR + 2 
mix/settle prezones element when you begin a dynamic simulation and choose to use 
seed values. 
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The SBR + 2 mix/settle prezones initial values tab with the Specify values option selected 

When the specified seed values get inserted in the SBR + 2 mix/settle prezones is 
determined by the Set initial values on OK option.  If this option is not checked: 

   

• The specified values will be placed in the SBR + 2 mix/settle prezones 
at the beginning of a dynamic simulation if you elect to seed the 
simulation. 

If this option is checked, the specified values are placed in the SBR + 2 mix/settle 
prezones when you click OK to close the dialog box, overriding any existing 
state variable values.  Therefore, the state variable values at the beginning of a 
dynamic simulation will be the same regardless of whether or not you choose to re-
seed. 

SBR + 2 Mix/Settle Prezones Underflow 
The SBR + 2 mix/settle prezones SBR Underflow tab shown below allows you to 
set up underflow rates and patterns for the SBR zone. 
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The SBR zone underflow settings tab 

The Underflow type may be specified as a Constant underflow or a Flow 
pattern by selecting the appropriate option.  If you select Constant underflow, 
you may enter the desired underflow rate in the edit field.  If you select Flow 
pattern, clicking the Pattern… button will open the Underflow rate itinerary 
dialog box. 

The SBR zone underflow may be used for several functions: 

   

1. As a wastage stream; 

2. A mixed liquor recycle to a mixer element in front of the SBR + 2 
mix/settle prezones element; 

3. As both a wastage and a recycle by placing a splitter element between 
the underflow and the mixer element in front of the SBR + 2 mix/settle 
prezones element. 

SBR + 2 Mix/Settle Prezones Internal Recycle Flows 
The SBR + 2 mix/settle prezones element SBR internal recycle flows tab shown 
below allows you to set up recycles between the SBR zone and the second prezone, 
and between the second and first prezone. 
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The SBR internal recycle tab 

You may have a recycle flow which goes from the second prezone to the first one.  If 
you select Constant recycle, you may enter the desired recycle flowrate in the edit 
field.  If you select Recycle pattern, clicking the Pattern… button will open the 
Recycle flowrate itinerary dialog box. 

You also may have a recycle flow which goes from the SBR zone to the second 
prezone.  If you select Constant recycle, you may enter the desired recycle 
flowrate in the edit field.  If you select Recycle pattern, clicking the Pattern… 
button will open the Recycle flowrate itinerary dialog box. 

Two final points should be noted with regard to internal recycle flows: 

   

1. It is possible to have a recycle flow from the SBR zone to the first 
prezone by returning the SBR zone underflow (or a portion of it) to the 
input of the SBR + 2 mix/settle prezones element. 

2. Internal recycle flows are set to zero when the SBR zone goes into 
settle/decant mode. 

Aerobic Digester 
The aerobic digester simulates the aerobic digestion process in a CSTR.  You may 
specify parameters related to the operation and control of the aerobic digester 
element.  For information on monitoring parameters/variables for this element, 
please see Monitoring Data. 
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The aerobic digester monitor items tab 

Aerobic Digester Dimensions 
The Dimensions tab, shown below, allows the user to enter the physical 
dimensions of an aerobic digester element. 
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The aerobic digester dimensions tab 

There are two methods for entering the dimensions: by Area and depth, or by 
Volume and depth.  The method is specified by clicking on the appropriate radio 
button.  If you select by area and depth, the aerobic digester area and depth must be 
entered in the Area and Depth text edit boxes.  If you select by volume and depth, 
the aerobic digester volume and depth must be entered in the Volume and Depth 
text edit boxes.  Regardless of the method you choose, you also must specify a 
Width for the element.  Units are shown to the right of the edit boxes.  The element 
name and type, and a picture of the element also are shown. 

Aerobic Digester Operation  
The Operation tab, shown below, allows the user to enter operating parameters for 
an aerobic digester element, such as aeration specifications and local temperature, as 
well as change local model parameters. 

 
The aerobic digester operation tab 

There are two methods for specifying aeration:  either by a DO setpoint or by an 
Air supply rate.  The aeration method is specified by clicking on the appropriate 
radio button.  When DO setpoint is selected, the setpoint concentration must be 
specified.  You may specify either a Constant setpoint or a Scheduled DO 
setpoint pattern (clicking the Pattern…  button will open the Edit DO setpoint 
itinerary dialog box).  You may wish to place a restriction on the maximum 
allowable air flowrate that may be used to achieve the desired DO setpoint.  This is a 
useful feature for investigating the ability of air equipment to achieve desired DO 
setpoints. 

When Air supply rate is selected, the air flowrate must be specified.  You may 
specify either a Constant air flowrate or a Scheduled air flowrate pattern 
(clicking the Pattern… button will open the Edit air flow itinerary dialog box). 



170  •  Element Types  

The mechanical mixing Power input (unaerated reactors) can be specified.  
This is used to calculate the velocity gradient in the vessel. 

Note : If you wish to change any of the aeration model parameters, click the Model 
parameters… button to open the Model parameter editor dialog box (Note that 
this changes the aeration model parameters on a local level only). 

A Local temperature also may be specified for a aerobic digester element.  When 
you click on the check box for local temperature, the Specify temperature by 
radio button group is enabled.  You may then specify either a Constant or 
Scheduled temperature.  If constant temperature is selected, you may enter the 
value in the edit box.  If scheduled temperature is selected the Pattern… button 
becomes active.  Clicking this button presents you with the Edit temperature 
itinerary dialog box. 

You also can specify Local kinetic parameters for the activated sludge model 
used in the aerobic digester element.  If you click on the check box for local kinetic 
parameters, then clicking the Model parameters… button opens the Model 
parameter editor dialog box allowing you access to the various activated sludge 
model kinetic parameters. 

To specify local aeration parameters (e.g. alpha and beta factors), check the box 
labeled Local aeration parameters. 

To model the concentrations of the constituents of the aeration gas (e.g. oxygen, 
carbon dioxide, etc.), check the box labeled Model gas phase.  If this option is 
selected you may also enter a percentage value for the Gas hold-up (i.e. the 
percentage of the total reactor volume occupied by aeration gas). 

Anaerobic Digester 
The anaerobic digester simulates the anaerobic digestion process in a CSTR.  You 
may specify parameters related to the operation and control of the anaerobic digester 
element.  For information on monitoring parameters/variables for this element, 
please see Monitoring Data. 
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The anaerobic digester monitor items tab 

Anaerobic Digester Dimensions 
The Dimensions tab, shown below, allows the user to enter the physical 
dimensions of an anaerobic digester element. 

 
The anaerobic digester dimensions tab 
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There are two methods for entering the dimensions: by Area and depth, or by 
Volume and depth.  The method is specified by clicking on the appropriate radio 
button.  If you select by area and depth, the anaerobic digester area and depth must 
be entered in the Area and Depth text edit boxes.  If you select by volume and 
depth, the anaerobic digester volume and depth must be entered in the Volume and 
Depth text edit boxes.  Regardless of the method you choose, you also must specify 
a Width for the element.  Units are shown to the right of the edit boxes.  The 
element name and type, and a picture of the element also are shown. 

You must also enter the Head space volume and the Head space pressure for 
the anaerobic digester. 

Anaerobic Digester Model 
The Model tab, shown below, allows the user to specify parameters impacting the 
model used in the anaerobic digester element (such as local temperature) and also 
specify local model parameters. 

 
The anaerobic digester model tab 

You can select Local kinetic parameters and click the Edit parameters… 
button in order to specify kinetic parameters for the anaerobic digester that are 
different from the configuration global parameters. 

You can select whether you want BioWin to Calculate tank pH or you can Use a 
specified value if you wish. 

A Local temperature may be specified for an anaerobic digester element.  When 
you click on the check box for local temperature, the Specify temperature by 
radio button group is enabled.  You may then specify either a Constant or 
Scheduled temperature.  If constant temperature is selected, you may enter the 
value in the edit box.  If scheduled temperature is selected the Pattern… button 
becomes active.  Clicking this button presents you with the Edit temperature 
itinerary dialog box. 
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Anaerobic Digester Initial Values 
The Initial values tab, shown below, is used for specifying the initial settings for 
anaerobic digester element concentrations and volume. 

 
The anaerobic digester initial values tab with the Seed values option active 

Use the Initial liquid hold-up field to enter a value to specify the % of full setting.  
This initial liquid hold-up volume will be used for steady state calculations.  It 
should be noted here that the lower and upper limits on this value are 0.02 and 
99.98%, respectively.  This reflects the fact that this is the liquid volume, and allows 
for small differences between liquid volume and reactor volume for inlet and outlet 
pipes. 

There are two methods for setting up Initial concentrations in the anaerobic 
digester element.  The dialog box shown above illustrates the first case where the 
Seed values option is selected.  When this option is selected, BioWin applies 
default seed values for all the state variables (except volume, which you specify) in 
the same manner it would for bioreactor elements. 

The dialog box shown below illustrates the second case where the Specify values 
option is selected.  In this case, an editable list of state variables is displayed in the 
dialog box.  This allows you to enter your own seed values for state variables in the 
anaerobic digester element.  These will be inserted in the anaerobic digester element 
when you begin a steady state simulation, or when you begin a dynamic simulation 
and choose to use seed values. 
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The anaerobic digester element initial values tab with the Specify values option active 

When the specified seed values get inserted in the anaerobic digester element is 
determined by the Set initial values on OK option.  If this option is not checked: 

   

• The specified seed values will be placed in the anaerobic digester 
element at the beginning of a steady state simulation if you elect to start 
from seed conditions; 

• The specified values will be placed in the anaerobic digester element at 
the beginning of a dynamic simulation if you elect to seed the 
simulation. 

If this option is checked, the specified values are placed in the anaerobic digester 
element when you click OK to close the dialog box, overriding any existing 
state variable values.  Therefore, the state variable values at the beginning of a 
dynamic simulation will be the same regardless of whether or not you choose to re-
seed. 

The use of this option is illustrated in the example at the end of the Variable 
Volume/Batch Bioreactor Initial Values section in this chapter. 
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Anaerobic Digester Outflow 
Remember for steady state 
simulations, the initial liquid 
hold-up volume will be used 
for calculations. 

The anaerobic digester element Outflow tab, shown below, is used to specify the 
overflow behavior.  The overflow behavior can be generalized as follows: 

   

• Whenever the anaerobic digester element is full, it overflows at the 
influent rate, regardless of the overflow setting. 

• Whenever the anaerobic digester element is empty and the outflow rate 
is set higher than the influent rate, the anaerobic digester element will 
only have an outflow equal to the influent flow, so as not to have 
negative volume.  If the outflow rate is set lower than the influent rate, 
then the anaerobic digester element will begin to fill up. 

The following is a description of the behavior of the three outflow settings: 

   

• Overflow only – the anaerobic digester element fills up, and then 
overflows at the influent flow rate. 

• Constant outflow – the outflow always tries to attain the specified 
constant rate, except when physically constrained (i.e. when the 
anaerobic digester element is full or empty) 

• Flow pattern – the outflow always tries to attain the current specified 
pattern rate, except when physically constrained (i.e. when the 
anaerobic digester element is full or empty).  To specify a pattern, click 
the Pattern… button when it becomes active.  For more information , 
see the Liquid outflow itinerary section. 

 
The anaerobic digester outflow tab 
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Pipes 
The Pipe line options tab, shown below, allows the user to specify pipe display 
options.  You can access this dialog box by double-clicking a pipe on the drawing 
board or right-clicking a pipe and choosing Properties... from the resulting popup 
menu. 

 
The pipe line options tab 

There are five pipe styles from which you can select by clicking the appropriate radio 
button: 

   

1. Open box; 

2. Straight; 

3. Step; 

4. Step (middle) – this is the default pipe style; 

5. U-shape 

An example of the selected option is shown in the picture on the lower part of the 
tab.  Pipes must start from and end at an element.  Clicking once on a pipe will 
reveal that it has “tag” points (denoted by small circles on the pipe).  If a circle is red, 
then it may be moved.  The various pipe styles differ in how these points may be 
moved by dragging them around the drawing board. 

The Open Box style has two points which may be moved.  This makes the Open 
Box style the most flexible of the available styles.  This flexibility is useful in 
avoiding pipes crossing over one another and going through elements in complex 
configurations with internal recycles.  The first point (i.e. the point closest to the 
pipe's beginning) is free to move up and down in the vertical direction, as shown in 
the picture below. 
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The first point for an open box pipe can move in the vertical direction 

The second point (i.e. the middle point of the three) is free to move about in the 
horizontal direction, as shown in the picture below. 

 
The second point for an open box can move in the horizontal direction 

The Straight style has two points as shown in the picture below.  Neither of these 
points may be moved – the pipe simply is a straight line drawn between the two 
elements. 
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A straight pipe's points may not be moved about the drawing board 

The Step style has one point which may be moved.  The first point (i.e. the point 
closest to the pipe's beginning) may be moved about in the horizontal direction, as 
shown in the picture below. 

 
A step pipe has one point which may be moved horizontally 

The Step (middle) style has three points as shown in the picture below.  None of 
these points may be moved – the pipe automatically forms a step at the point halfway 
between the elements. 
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A step (middle) pipe has no moveable points 

The U-shape style has one point which may be moved.  The first point (i.e. the 
point closest to the pipe's beginning) may be moved about in the vertical direction, as 
shown in the picture below. 

 
A U-shape has one point which may be moved vertically 

You can change line or arrow properties for individual pipes so that they are different 
from the settings you have chosen in Project|Current Project Options… by 
clicking on the check box labeled Local pipe options; a Line options… button 
and Arrow size and Arrow angle spin edit boxes will appear. 

The “arrow angle” refers to 
the acute angle between the 
arrow side and the pipe line.  
For example, if you want 
arrows with “flat” bases, set 
the arrow side angle to the 
maximum of 60 degrees. 

To change the Color, Width, and Style of the lines used to represent pipes on the 
drawing board, click on the Line options… button.  You may increase the arrow 
size on the lines used to represent pipes.  The arrow angle also can be changed. 

Grit Removal Tank 
The grit removal tank element is used to simulate the removal of sand and other 
inerts in a system.  You may specify details regarding the physical specifications, 
flow split method, and solids separation operation of the grit tank.  For information 
on monitoring parameters/variables for this element, please see Monitoring Data. 
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The grit removal tank monitor items tab 

Grit Removal Tank Dimensions 
The Dimensions tab, shown below, allows the user to enter the physical 
dimensions of a grit removal tank element. 

 
The grit removal tank dimensions tab 
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There are two methods for entering the dimensions: by Area and depth, or by 
Volume and depth.  The method is specified by clicking on the appropriate radio 
button.  If you select by area and depth, the grit removal tank area and depth must be 
entered in the Area and Depth text edit boxes.  If you select by volume and depth, 
the grit removal tank volume and depth must be entered in the Volume and Depth 
text edit boxes.  Regardless of the method you choose, you also must specify a 
Width for the element.  Units are shown to the right of the edit boxes.  The element 
name and type, and a picture of the element also are shown. 

Grit Removal Tank Split Method 
The Flow split tab, shown below, allows the user to specify the flow split method 
for a grit removal tank. 

 
The grit removal tank split method tab 

The method of specifying the flow split for a grit removal tank may be selected from 
a number of options.  You can specify the flow using a Ratio, Fraction, or 
Underflow rate by clicking on the corresponding radio button.  If you specify an 
underflow rate (denoted by the symbol U), it will result in a constant underflow out 
the bottom of the grit removal tank.  Note that when the grit removal tank is 
operating in this mode, if the influent flow is less than the set Underflow rate, then 
all of the influent flow will be sent to the underflow.  If you specify either the Ratio 
or Fraction split method, then the underflow will be calculated using the 
corresponding formula based on the overflow rate (denoted by the symbol O) and the 
underflow rate U. 

Next to the split method radio group is an edit box; if the split method is selected 
from the radio group, the value may be entered in the edit box.  Units are shown 
adjacent to the edit box (where applicable) and the label of the edit box changes to 
indicate the chosen split method. 

The split method group also contains a Constant check box; if the flow split does 
not vary with time this box should be checked.  It should be noted that this check box 
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applies only to the split methods listed in the radio group and is checked by default.  
If the Constant check box is unchecked, the Pattern… button becomes active so 
you can enter a time-varying pattern for the flow split.  Clicking this button presents 
you with the Edit split itinerary dialog box. 

The underflow rate also can be Paced with an influent stream.  To select the flow 
paced option, click on the Paced at check box.  The percentage of the influent flow 
rate may then be specified, and the influent stream for flow pacing may be selected 
from the drop list box which shows all influent streams available for your system. 

Grit Removal Tank Operation 
The Operation tab, shown below, allows you to specify the amount of grit removed 
by the grit removal tank element. 

 
The grit removal tank operation tab 

There are two edit boxes on this tab.  The Percentage grit removal may be 
entered in the first edit box.  This is the average percentage grit removal, and may 
differ from the instantaneous percentage removal observed in a dynamic simulation. 

The second edit box is provided for specifying the Grit zone volume fraction; 
this is the grit zone fraction of a unit volume.  The concentration of the underflow 
(grit stream) can be modified by adjusting this fraction. 

Ideal Primary Settler 
The ideal primary settler (clarifier) element is used to model settlement of particulate 
material in a wastewater stream which does not contain activated sludge mixed 
liquor (e.g. a raw influent stream).  You may specify the physical characteristics, the 
flow split method, and the solids separation operation of the primary settler.  For 
information on monitoring parameters/variables for this element, please see 
Monitoring Data. 
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The ideal primary settling tank monitor items tab 

Ideal Primary Settler Dimensions 
The Dimensions tab, shown below, allows the user to enter the physical 
dimensions of an ideal primary settler element. 

 
The ideal primary settler dimensions tab 
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There are two methods for entering the dimensions: by Area and depth, or by 
Volume and depth.  The method is specified by clicking on the appropriate radio 
button.  If you select by area and depth, the ideal primary settler area and depth must 
be entered in the Area and Depth text edit boxes.  If you select by volume and 
depth, the ideal primary settler volume and depth must be entered in the Volume 
and Depth text edit boxes.  Regardless of the method you choose, you also must 
specify a Width for the element.  Units are shown to the right of the edit boxes.  The 
element name and type, and a picture of the element also are shown. 

Ideal Primary Settler Split Method 
The Flow split tab, shown below, allows the user to specify the flow split method 
for an ideal primary settler. 

 
The ideal primary settler flow split method tab 

The method of specifying the flow split for an ideal primary settler may be selected 
from a number of options.  You can specify the flow using a Ratio, Fraction, or 
Underflow rate by clicking on the corresponding radio button.  If you specify an 
underflow rate (denoted by the symbol U), it will result in a constant underflow out 
the bottom of the ideal primary settler.  Note that when the ideal primary settler is 
operating in this mode, if the influent flow is less than the set Underflow rate, then 
all of the influent flow will be sent to the underflow.  If you specify either the Ratio 
or Fraction split method, then the underflow will be calculated using the 
corresponding formula based on the overflow rate (denoted by the symbol O) and the 
underflow rate U. 

Next to the split method radio group is an edit box; if the split method is selected 
from the radio group, the value may be entered in the edit box.  Units are shown 
adjacent to the edit box (where applicable) and the label of the edit box changes to 
indicate the chosen split method. 

The split method group also contains a Constant check box; if the flow split does 
not vary with time this box should be checked.  It should be noted that this check box 
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applies only to the split methods listed in the radio group and is checked by default.  
If the Constant check box is unchecked, the Pattern… button becomes active so 
you can enter a time-varying pattern for the flow split.  Clicking this button presents 
you with the Edit split itinerary dialog box. 

The underflow rate also can be Paced with an influent stream.  To select the flow 
paced option, click on the Paced at check box.  The percentage of the influent flow 
rate may then be specified, and the influent stream for flow pacing may be selected 
from the drop list box which shows all influent streams available for your system. 

Ideal Primary Settler Operation 
The Operation tab, shown below, allows the user to enter configuration 
specifications for an ideal primary settling tank. 

 
The ideal primary settler operation tab 

There are two edit boxes on this tab.  The first edit box is used to enter the 
Percentage solids removal for the ideal primary settler; the Sludge blanket 
height may be specified using the second box.  Sludge blanket height is expressed 
as a fraction of the total settler height 

Activated Primary Settler 
The activated primary settler (clarifier) element is used to model settlement of 
particulate material in a wastewater stream which does not contain activated sludge 
mixed liquor (e.g. a raw influent stream).  The aspect which differentiates the 
activated primary settler element from the ideal primary settler element is the former 
is capable of modeling biological activity which may take place in a primary settler.  
You may specify the physical characteristics, the flow split method, the solids 
separation operation, and the model details of the activated primary settler.  For 
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information on monitoring parameters/variables for this element, please see 
Monitoring Data. 

 
The activated primary settling tank monitor items tab 

Activated Primary Settler Dimensions 
The Dimensions tab, shown below, allows the user to enter the physical 
dimensions of an activated primary settler element. 
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The activated primary settler dimensions tab 

There are two methods for entering the dimensions: by Area and depth, or by 
Volume and depth.  The method is specified by clicking on the appropriate radio 
button.  If you select by area and depth, the activated primary settler area and depth 
must be entered in the Area and Depth text edit boxes.  If you select by volume and 
depth, the activated primary settler volume and depth must be entered in the 
Volume and Depth text edit boxes.  Regardless of the method you choose, you also 
must specify a Width for the element.  Units are shown to the right of the edit boxes.  
The element name and type, and a picture of the element also are shown. 

Activated Primary Settler Split Method 
The Flow split tab, shown below, allows the user to specify the flow split method 
for an activated primary settler. 

 
The activated primary settler flow split method tab 

The method of specifying the flow split for an activated primary settler may be 
selected from a number of options.  You can specify the flow using a Ratio, 
Fraction, or Underflow rate by clicking on the corresponding radio button.  If 
you specify an underflow rate (denoted by the symbol U), it will result in a constant 
underflow out the bottom of the activated primary settler.  Note that when the 
activated primary settler is operating in this mode, if the influent flow is less than the 
set Underflow rate, then all of the influent flow will be sent to the underflow.  If 
you specify either the Ratio or Fraction split method, then the underflow will be 
calculated using the corresponding formula based on the overflow rate (denoted by 
the symbol O) and the underflow rate U. 

Next to the split method radio group is an edit box; if the split method is selected 
from the radio group, the value may be entered in the edit box.  Units are shown 
adjacent to the edit box (where applicable) and the label of the edit box changes to 
indicate the chosen split method. 
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The split method group also contains a Constant check box; if the flow split does 
not vary with time this box should be checked.  It should be noted that this check box 
applies only to the split methods listed in the radio group and is checked by default.  
If the Constant check box is unchecked, the Pattern… button becomes active so 
you can enter a time-varying pattern for the flow split.  Clicking this button presents 
you with the Edit split itinerary dialog box.. 

The underflow rate also can be Paced with an influent stream.  To select the flow 
paced option, click on the Paced at check box.  The percentage of the influent flow 
rate may then be specified, and the influent stream for flow pacing may be selected 
from the drop list box which shows all influent streams available for your system. 

Activated Primary Settler Operation 
The Operation tab, shown below, allows the user to enter configuration 
specifications for an activated primary settling tank. 

 
The activated primary settler operation tab 

There are two edit boxes on this tab.  The first edit box is used to enter the 
Percentage solids removal for the activated primary settler; the Sludge 
blanket height may be specified using the second box.  Sludge blanket height is 
expressed as a fraction of the total settler height. 

Activated Primary Settler Model 
The Model tab, shown below, allows the user to specify parameters impacting the 
model used in the activated primary settler element (such as local temperature) and 
also specify local model parameters. 
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The activated primary model tab 

You can select Local kinetic parameters and click the Edit parameters… 
button in order to specify kinetic parameters for the activated primary that are 
different from the configuration global parameters. 

You can select whether you want BioWin to Calculate tank pH or you can Use a 
specified value if you wish. 

A Local temperature may be specified for an activated primary settler element.  
When you click on the check box for local temperature, the Specify temperature 
by radio button group is enabled.  You may then specify either a Constant or 
Scheduled temperature.  If constant temperature is selected, you may enter the 
value in the edit box.  If scheduled temperature is selected the Pattern… button 
becomes active.  Clicking this button presents you with the Edit temperature 
itinerary dialog box. 

Ideal Secondary Settler 
The ideal secondary settler (clarifier) element is used to model settlement of 
particulate material in a wastewater stream containing activated sludge mixed liquor 
based on an idealized solids separation model.  You may specify the physical 
characteristics, the flow split method, the solids separation operation, and biological 
reaction of the ideal secondary settler.  For information on monitoring 
parameters/variables for this element, please see Monitoring Data. 
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The ideal secondary settler monitor items tab 

Ideal Secondary Settler Dimensions 
The Dimensions tab, shown below, allows the user to enter the physical 
dimensions of an ideal secondary settler element. 

 
The ideal secondary settler dimensions tab 
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There are two methods for entering the dimensions: by Area and depth, or by 
Volume and depth.  The method is specified by clicking on the appropriate radio 
button.  If you select by area and depth, the ideal secondary settler area and depth 
must be entered in the Area and Depth text edit boxes.  If you select by volume and 
depth, the ideal secondary settler volume and depth must be entered in the Volume 
and Depth text edit boxes.  Regardless of the method you choose, you also must 
specify a Width for the element.  Units are shown to the right of the edit boxes.  The 
element name and type, and a picture of the element also are shown. 

Ideal Secondary Settler Split Method 
The Flow split tab, shown below, allows the user to specify the flow split method 
for an ideal secondary settler. 

 
The ideal secondary settler flow split method tab 

The method of specifying the flow split for an ideal secondary settler may be 
selected from a number of options.  You can specify the flow using a Ratio, 
Fraction, or Underflow rate by clicking on the corresponding radio button.  If 
you specify an underflow rate (denoted by the symbol U), it will result in a constant 
underflow out the bottom of the ideal secondary settler.  Note that when the ideal 
secondary settler is operating in this mode, if the influent flow is less than the set 
Underflow rate, then all of the influent flow will be sent to the underflow.  If you 
specify either the Ratio or Fraction split method, then the underflow will be 
calculated using the corresponding formula based on the overflow rate (denoted by 
the symbol O) and the underflow rate U. 

Next to the split method radio group is an edit box; if the split method is selected 
from the radio group, the value may be entered in the edit box.  Units are shown 
adjacent to the edit box (where applicable) and the label of the edit box changes to 
indicate the chosen split method. 

The split method group also contains a Constant check box; if the flow split does 
not vary with time this box should be checked.  It should be noted that this check box 
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applies only to the split methods listed in the radio group and is checked by default.  
If the Constant check box is unchecked, the Pattern… button becomes active so 
you can enter a time-varying pattern for the flow split.  Clicking this button presents 
you with the Edit split itinerary dialog box. 

The underflow rate also can be Paced with an influent stream.  To select the flow 
paced option, click on the Paced at check box.  The percentage of the influent flow 
rate may then be specified, and the influent stream for flow pacing may be selected 
from the drop list box which shows all influent streams available for your system. 

Ideal Secondary Settler Operation 
The Operation tab, shown below, allows the user to enter configuration 
specifications for an ideal secondary settling tank. 

 
The ideal secondary settler operation tab 

There are two edit boxes on this tab.  The first edit box is used to enter the 
Percentage solids removal for the ideal secondary settler; the Sludge blanket 
height may be specified using the second box.  Sludge blanket height is expressed 
as a fraction of the total settler height 

Ideal Secondary Settler Biological Modeling 
The ideal secondary settler Biological model tab, shown below, allows the user to 
specify whether biological reactions in the settler are modeled, and if so, model 
options such as local kinetic parameters and local temperature. 
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The ideal secondary settler biological modeling tab 

If you wish to model biological reaction in the ideal secondary settler, click on the 
check box for Biological reaction; this switches on the activated sludge processes 
and enables the Local kinetic parameters and Local temperature check boxes. 

If you wish to specify Local kinetic parameters for the ideal secondary settler 
(i.e. kinetic parameters that are different from those specified under the 
Project|Model parameters… menu), click on the check box for local kinetic 
parameters, then click the Model parameters… button to open the Model 
parameter editor dialog box which allows you to access the various activated 
sludge model kinetic parameters. 

A Local temperature also may be specified for an ideal secondary settler.  When 
you click on the check box for local temperature, the Specify temperature by 
radio button group is enabled.  You may then specify either a Constant or 
Scheduled temperature.  If constant temperature is selected, you may enter the 
value in the edit box.  If scheduled temperature is selected the Pattern… button 
becomes active.  Clicking this button presents you with the Edit temperature 
itinerary dialog box. 

Point Secondary Settler 
The point secondary settler (clarifier) element is similar to the ideal secondary settler 
element and is used to model settlement of particulate material in a wastewater 
stream containing activated sludge mixed liquor based on an idealized solids 
separation model.  The distinctive feature of this element is that it has no volume.  
You may specify the flow split method and the solids removal percentage - because 
the element has no volume, biological reactions may not be modeled.  For 
information on monitoring parameters/variables for this element, please see 
Monitoring Data. 
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The point secondary settler monitor items tab 

Point  Secondary Settler Split Method 
The Flow split tab, shown below, allows the user to specify the flow split method 
for a point secondary settler. 

 
The point secondary settler flow split method tab 
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The method of specifying the flow split for a point secondary settler may be selected 
from a number of options.  You can specify the flow using a Ratio, Fraction, or 
Underflow rate by clicking on the corresponding radio button.  If you specify an 
underflow rate (denoted by the symbol U), it will result in a constant underflow out 
the bottom of the point secondary settler.  Note that when the point secondary settler 
is operating in this mode, if the influent flow is less than the set Underflow rate, 
then all of the influent flow will be sent to the underflow.  If you specify either the 
Ratio or Fraction split method, then the underflow will be calculated using the 
corresponding formula based on the overflow rate (denoted by the symbol O) and the 
underflow rate U. 

Next to the split method radio group is an edit box; if the split method is selected 
from the radio group, the value may be entered in the edit box.  Units are shown 
adjacent to the edit box (where applicable) and the label of the edit box changes to 
indicate the chosen split method. 

The split method group also contains a Constant check box; if the flow split does 
not vary with time this box should be checked.  It should be noted that this check box 
applies only to the split methods listed in the radio group and is checked by default.  
If the Constant check box is unchecked, the Pattern… button becomes active so 
you can enter a time-varying pattern for the flow split.  Clicking this button presents 
you with the Edit split itinerary dialog box. 

The underflow rate also can be Paced with an influent stream.  To select the flow 
paced option, click on the Paced at check box.  The percentage of the influent flow 
rate may then be specified, and the influent stream for flow pacing may be selected 
from the drop list box which shows all influent streams available for your system. 

Point Secondary Settler Operation 
The Operation tab, shown below, allows the user to enter configuration 
specifications for a point secondary settling tank. 

 
The point secondary settler operation tab 
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There is an edit box on this tab that is used to enter the Percent solids removal 
for the point secondary settler. 

Model Secondary Settler 
The model secondary settler (clarifier) element is used to model settlement of 
particulate material in a wastewater stream containing activated sludge mixed liquor 
based on a one-dimensional flux model.  You may specify the physical 
characteristics, the flow split method, and the solids separation operation of the 
model secondary settler.  For information on monitoring parameters/variables for this 
element, please see Monitoring Data. 

 
The model secondary settler monitor items tab 

Model Secondary Settler Dimensions 
The Dimensions tab, shown below, allows the user to enter the physical 
dimensions of a model secondary settler element. 
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The model secondary settler dimensions tab 

There are two methods for entering the dimensions: by Area and depth, or by 
Volume and depth.  The method is specified by clicking on the appropriate radio 
button.  If you select by area and depth, the model secondary settler area and depth 
must be entered in the Area and Depth text edit boxes.  If you select by volume and 
depth, the model secondary settler volume and depth must be entered in the Volume 
and Depth text edit boxes.  Regardless of the method you choose, you also must 
specify a Width for the element.  Units are shown to the right of the edit boxes.  The 
element name and type, and a picture of the element also are shown. 

Model Secondary Settler Split Method 
The Flow split tab, shown below, allows the user to specify the flow split method 
for a model secondary settler. 



198  •  Element Types  

 
The model secondary settler flow split method tab 

The method of specifying the flow split for a model secondary settler may be 
selected from a number of options.  You can specify the flow using a Ratio, 
Fraction, or Underflow rate by clicking on the corresponding radio button.  If 
you specify an underflow rate (denoted by the symbol U), it will result in a constant 
underflow out the bottom of the model secondary settler.  Note that when the model 
secondary settler is operating in this mode, if the influent flow is less than the set 
Underflow rate, then all of the influent flow will be sent to the underflow.  If you 
specify either the Ratio or Fraction split method, then the underflow will be 
calculated using the corresponding formula based on the overflow rate (denoted by 
the symbol O) and the underflow rate U. 

Next to the split method radio group is an edit box; if the split method is selected 
from the radio group, the value may be entered in the edit box.  Units are shown 
adjacent to the edit box (where applicable) and the label of the edit box changes to 
indicate the chosen split method. 

The split method group also contains a Constant check box; if the flow split does 
not vary with time this box should be checked.  It should be noted that this check box 
applies only to the split methods listed in the radio group and is checked by default.  
If the Constant check box is unchecked, the Pattern… button becomes active so 
you can enter a time-varying pattern for the flow split.  Clicking this button presents 
you with the Edit split itinerary dialog box. 

The underflow rate also can be Paced with an influent stream.  To select the flow 
paced option, click on the Paced at check box.  The percentage of the influent flow 
rate may then be specified, and the influent stream for flow pacing may be selected 
from the drop list box which shows all influent streams available for your system. 

Model Secondary Settler Operation 
The Operation tab, shown below, allows the user to enter configuration 
specifications for the model secondary settling tank. 
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The model secondary settler operation tab 

The Number of layers used to model the secondary settler can be modified using 
the spin edit box.  The minimum number of layers allowed for the model is 5, the 
default is 10.  Increasing the number of layers will improve the resolution of the 
predicted settler profile. 

You also may specify the Top feed layer and the Number of feed layers using 
spin edit boxes.  The feed layer refers to the layer into which the applied solids 
loading is placed.  Feed points are not allowed in the top or bottom layers. 

Model Secondary Settler Biological Modeling 
The model secondary settler Biological model tab, shown below, allows the user 
to specify whether biological reactions in the settler are modeled, and if so, model 
options such as local kinetic parameters and local temperature. 
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The model secondary settler biological modeling tab 

If you wish to model biological reaction in the model secondary settler, click on the 
check box for Biological reaction; this switches on the activated sludge processes 
and enables the Local kinetic parameters and Local temperature check boxes. 

If you wish to specify Local kinetic parameters for the model secondary settler 
(i.e. kinetic parameters that are different from those specified under the 
Project|Model parameters… menu), click on the check box for local kinetic 
parameters, then click the Model parameters… button to open the Model 
parameter editor dialog box which allows you to access the various activated 
sludge model kinetic parameters. 

A Local temperature also may be specified for a model secondary settler.  When 
you click on the check box for local temperature, the Specify temperature by 
radio button group is enabled.  You may then specify either a Constant or 
Scheduled temperature.  If constant temperature is selected, you may enter the 
value in the edit box.  If scheduled temperature is selected the Pattern… button 
becomes active.  Clicking this button presents you with the Edit temperature 
itinerary dialog box. 

Dewatering Unit 
The dewatering unit element used to simulate the separation of liquid and solids in 
an influent stream to increase the solids concentration.  You may specify details 
regarding the flow split method and the solids separation operation of the dewatering 
unit.  For information on monitoring parameters/variables for this element, please see 
Monitoring Data. 
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The dewatering unit monitor items tab 

Dewatering Unit Split Method 
The Flow split tab, shown below, allows the user to specify the flow split method 
for a dewatering unit. 

 
The dewatering unit flow split method tab 
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The method of specifying the flow split for a dewatering unit may be selected from a 
number of options.  You can specify the flow using a Ratio, Fraction, or 
Underflow rate by clicking on the corresponding radio button.  If you specify an 
underflow rate (denoted by the symbol U), it will result in a constant underflow out 
the bottom of the dewatering unit.  Note that when the dewatering unit is operating in 
this mode, if the influent flow is less than the set Underflow rate, then all of the 
influent flow will be sent to the underflow.  If you specify either the Ratio or 
Fraction split method, then the underflow will be calculated using the 
corresponding formula based on the overflow rate (denoted by the symbol O) and the 
underflow rate U. 

Next to the split method radio group is an edit box; if the split method is selected 
from the radio group, the value may be entered in the edit box.  Units are shown 
adjacent to the edit box (where applicable) and the label of the edit box changes to 
indicate the chosen split method. 

The split method group also contains a Constant check box; if the flow split does 
not vary with time this box should be checked.  It should be noted that this check box 
applies only to the split methods listed in the radio group and is checked by default.  
If the Constant check box is unchecked, the Pattern… button becomes active so 
you can enter a time-varying pattern for the flow split.  Clicking this button presents 
you with the Edit split itinerary dialog box. 

The underflow rate also can be Paced with an influent stream.  To select the flow 
paced option, click on the Paced at check box.  The percentage of the influent flow 
rate may then be specified, and the influent stream for flow pacing may be selected 
from the drop list box which shows all influent streams available for your system. 

Dewatering Unit Operation 
The Operation tab, shown below, allows you to specify the degree of thickening 
obtained by the dewatering unit. 

 
The dewatering unit operation tab 
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The edit box on this tab is used to enter the Percent solids removal. 

Splitter 
Splitters divide a stream on a mass / flow (constant density) basis.  You may specify 
physical characteristics of the splitter and the method used by the splitter to split the 
influent flow.  For information on monitoring parameters/variables for this element, 
please see Monitoring Data. 

 
The splitter monitor items tab 

Splitter Dimensions 
The Dimensions tab, shown below, allows the user to enter the physical 
dimensions of a splitter element. 
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The splitter dimensions tab 

Flow splitters are assumed to be dimensionless unless otherwise specified.  The 
dimensions tab for elements which do not require a volume such as splitters contains 
a Node (without volume) check box; if you wish to enter a volume, deselect this 
option.  You may then enter the splitter Volume in the edit box.  Note that if you are 
using volumeless (i.e. node) splitters in your configuration you should be aware of 
recursion in your flow network.  Units are shown to the right of the edit box.  This 
tab also shows the element name and type, and a picture of the element. 

Splitter Flow Split 
The Flow split tab, shown below, allows the user to specify the type of splitter and 
the flow specifications. 
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The splitter flow split method tab 

There are four different splitter types, each of which may be configured from this 
tab.  These are: 

   

1. Conventional 

2. Flow paced 

3. Router 

4. Bypass 

A conventional splitter can operated on a constant or pattern basis.  To operate in the 
constant mode, select the box labeled Constant.  Next you must select a method 
used to split the flow using the Specify split method radio button group (Ratio, 
Fraction, Rate in side, or Rate in main).  Once you have chosen a split method, 
you must enter the value for the ratio, fraction, or flow in the text edit area that will 
be labeled according to the choice you have made.  If you specify a maximum rate in 
the side or main output stream (denoted by the symbols S and M, respectively), it 
will result in a constant flow to the stream.  Note that when these methods are used, 
if the influent flow is less than the specified rate, then all of the influent flow will be 
sent to the stream for which the rate was specified.  If you specify either the Ratio or 
Fraction split method, then the output stream flows will be calculated using the 
corresponding formula based on the side and main output stream flows. 

If the Constant check box is unchecked, the Pattern… button becomes active so 
you can enter a time-varying pattern for the flow split.  Use the Specify split 
method radio button group (Ratio, Fraction, Rate in side, or Rate in main) to 
choose the split method that you want to set a pattern for.  Next, click the Pattern… 
button to access the Edit split itinerary dialog box which you may use to enter 
your pattern. 

Options for a flow paced splitter are found in the Flow pacing group.  Select the 
Paced at check box.  You may now specify the remaining two items required for a 
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flow paced splitter.  Enter a number in the text edit area labeled % of, and then select 
an influent element as the basis for flow pacing from the drop list box of influent 
elements in the configuration.  Note that when you select to use a flow paced splitter, 
the side stream output is paced as a percentage of the selected influent. 

Options for a router are located in the Routing group.  Select the Flow router 
check box.  Click on the Routing pattern… button which will now be enabled to 
open the Edit router itinerary dialog box.  Note that when you select to use a 
router, you are using a timed pattern to switch between a fraction of 0 and 1.  That is, 
all flow goes either to the main or side output stream according to the time interval 
pattern you specify. 

Options for a bypass splitter are located in the Bypass group.  Select the Bypass 
weir check box.  When you do this, you will be able to enter a value in the Flow 
text edit area.  This value will set the maximum allowable flow in the main output 
stream.  Any flow in excess of this value will bypass the main output stream and be 
directed to the side output stream. 

Side Stream Mixer 
Mixers combine multiple streams into a single stream.  You may specify details 
regarding the physical characteristics of the mixer element.  For information on 
monitoring parameters/variables for this element, please see Monitoring Data. 

 
The mixer monitor items tab 

Side Stream Mixer Dimensions 
The Dimensions tab, shown below, allows the user to enter the physical 
dimensions of a mixer element. 
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The mixer dimensions tab 

Mixers are assumed to be dimensionless unless otherwise specified.  The dimensions 
tab for elements which do not require a volume such as mixers contains a Node 
(without volume) check box; if you wish to enter a volume, deselect this option.  
You may then enter the mixer Volume in the edit box.  Note that if you are using 
volumeless (i.e. node) mixers in your configuration, you should be aware of 
recursion in your flow network.  Units are shown to the right of the edit box.  This 
tab also shows the element name and type, and a picture of the element. 

Generally mixer volumes are very small in comparison with other vessels in a 
configuration.  Consequently these elements often may be modeled as nodes without 
volume.  The use of node elements in BioWin will substantially improve simulator 
performance for both dynamic and steady state simulations.  The mixer with volume 
is modeled as a "completely mixed" sump. 

General Mixer 
Mixers combine multiple streams into a single stream.  You may specify details 
regarding the physical characteristics of the mixer element.  For information on 
monitoring parameters/variables for this element, please see Monitoring Data. 
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The general mixer monitor items tab 

General Mixer Dimensions 
The Dimensions tab, shown below, allows the user to enter the physical 
dimensions of a mixer element. 

 
The mixer dimensions tab 
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Mixers are assumed to be dimensionless unless otherwise specified.  The dimensions 
tab for elements which do not require a volume such as mixers contains a Node 
(without volume) check box; if you wish to enter a volume, deselect this option.  
You may then enter the mixer Volume in the edit box.  Note that if you are using 
volumeless (i.e. node) mixers in your configuration, you should be aware of 
recursion in your flow network.  Units are shown to the right of the edit box.  This 
tab also shows the element name and type, and a picture of the element. 

Generally mixer volumes are very small in comparison with other vessels in a 
configuration.  Consequently these elements often may be modeled as nodes without 
volume.  The use of node elements in BioWin will substantially improve simulator 
performance for both dynamic and steady state simulations.  The mixer with volume 
is modeled as a "completely mixed" sump. 





 BioWin Album  •  211 

BioWin Album 

Parts of the Album 
The BioWin album provides users with a powerful tool for displaying results of 
simulations.  It provides you with a means for displaying simulation results in a 
variety of manners.  You may display your simulation results in a numerical format 
using BioWin’s customizable table and element specific information displays. 

Perhaps the greatest strength of the album is that it provides you with an interface for 
displaying your simulation results in a variety of rich graphical formats.  Because 
these charting capabilities are so powerful, there are three major sections of the 
manual devoted to them.  For information related to creating charts, please see 
“Creating Charts & Adding Series”.  For information on chart formatting, please see 
Chart Formatting Procedures”.  Finally, “Series Formatting Procedures” contains 
information detailing the various formatting options for different series styles. 

The BioWin album is accessed from the main simulator window via the menu choice 
View|Album.  Note that once you have set up the album to appear as you desire, 
closing it will not result in a loss of your changes.  The album and the information it 
contains are saved along with the BioWin configuration file. 

The BioWin album consists of three main parts: 

1. Menus 

2. Pages 

3. Panes 

The following sections give an outline of each part. 
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The BioWin album 

   

Album Menus 
The various menus available in the BioWin album are located at the top of the 
window.  The menus available are: 

   

• Album 

• Database 

• View 

   

Each menu may be accessed with either of two methods: 

   

1. Click on the text of the menu, or; 

2. Hold down the Alt key on your keyboard and press the letter on the 
keyboard corresponding to the underlined letter in the menu title.  For 
example, Alt+A will access the Album menu. 

Album Pages and Panes 
Pages are used as “containers” for panes in the BioWin album.  You may have as 
many pages as you desire in the album.  Only one page at a time may be viewed; you 
may select a page for viewing by clicking on its tab.  Each page can contain up to 
four panes, and BioWin offers a number of different pane layouts on any page as 
shown in the picture below. 
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BioWin album page layout gallery 

In most cases, the panes on a page are resizable to offer further flexibility.  Panes are 
used as “containers” for the various information displays in the BioWin album, i.e.: 

1. Charts 

2. Element information 

3. Tables 

   

After you have assigned one of these displays to a pane, it is possible to switch to 
one of the other remaining two.   

Since there is a large amount of information related to charts, they will not be 
discussed in this chapter.  .  For information related to charts, please see “Creating 
Charts & Adding Series”, Chart Formatting Procedures” and “Series Formatting 
Procedures”. For information regarding (2) and (3), see the relevant sections later in 
this chapter.  Next, a number of common procedures related to album pages and 
panes will be covered. 

Add a Page to the Album 
1. Click Album|Add Page… (you also can access this command by 

right-clicking on an existing album page's tab). 

2. Click on the pane layout for the page from the gallery of available 
choices. 

3. If you want a page name different from the default given, enter a name 
for the new page in the New album page name: text edit area.  This 
is the text that appears in the page tab. 

4. Click OK to finish adding the page. 

Move a Page in the Album 
1. Right-click the tab of the album page that you wish to move (i.e. 

change order of). 
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2. Select Move page from the resulting popup menu and you will be 
presented with the dialog box shown below. 

 
Dialog box used to move pages around in the album 

   

3. The dialog box will list the other pages currently contained in the 
album.  Select the page that you want to place the page you are moving 
in front of, and click OK. 

   

Note:  If you double-click on a page name listed in the Move page dialog box, the 
page you are moving will be placed in front of that page before you click OK.  You 
can use this feature to quickly "try out" several locations for the page you are 
moving. 

Delete a Page from the Album 
1. Click on the tab of the album page you want to delete to make it the 

current page. 

2. Select Album|Delete current page (you also may access this 
command by right-clicking on the tab of the page you wish to delete). 

Rename An Album Page 
1. Click on the tab of the album page you wish to rename to make it the 

current page. 

2. Select Album|Rename current page (you also can access this 
command by right-clicking on the tab of the page you wish to rename). 

Switch Display Types 
1. Right-click on the album chart, table, or element information display 

that you wish to replace with another type. 

2. If you right-click on a chart and select the Chart option you will be 
presented with the dialog box shown below. 
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Dialog Box used to switch from chart to table or element information display 

   

3. From the sub-menu, select one of the possible two other types. 

4. If you right-click on a table or element information display you will be 
presented with the dialog box shown below. 

 
Dialog Box used to switch to chart or element information display 

   

5. From the sub-menu, select one of the possible two other types. 

Delete a Display 
Right-click on the album chart, table, or element information display 
that you wish to delete. 

   

• If you are deleting a table or element information display, select 
the Delete Current… option from the resulting popup menu as 
shown below. 

 
Dialog Box used to delete current table 
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• If you are deleting a chart, select the Chart option from the 
resulting popup, then select Delete Current Chart…from the 
resulting flyout. 

 
Dialog Box used to delete current chart 

   

Resize Panes 
Hold the mouse cursor over a dividing line adjacent to the album pane that you wish 
to resize. 

   

Horizontal Resize 

• If the dividing line is vertical, your cursor will change to the horizontal 
resize cursor.  Click the mouse button and drag the dividing line to 
change to horizontal size of the pane. 

Vertical Resize 

• If the dividing line is horizontal, your cursor will change to the vertical 
resize cursor.  Click the mouse button and drag the dividing line to 
change the vertical size of the pane. 

Note:  The panes in the layout that consists of four equally sized panes on a page 
may not be resized.  This is the only layout where resizing of panes is not permitted. 

Album Page Templates 
If you have set up a set of album pages that you would like to re-use as a template in 
another BioWin project, you can save them as Album Page Template files (*.atp).  
For more information, please see the following section. 

Opening Album Pages 
The album File|Open pages command will present you with the Open dialog box 
set to look for files with the extension *.atp (album template pages). 

Use this dialog box to locate the *.atp pages that you want to open.  When you have 
located the file, you may open it by double-clicking on it, or clicking it and then 
clicking Open.  When you open the *.atp file, the pages and their associated  panes 
and information displays (i.e. charts, tables, element) will be added to the BioWin 
album.  Note that any pages already in the album are not overwritten.  Also, if any of 
the charts in the *.atp file contain series, those series will not be contained in the 
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current database; essentially they are inactive lines drawn on the chart.  If you want 
to add series to the charts that you have added via this command, you may do so. 

Save Album Pages 
The album File|Save pages command saves the current group of album pages and 
allows you to specify a name and location.  When you choose this command, you 
will be presented with the File Save dialog box.  When you have done this, type the 
name you want for the file in the File name: text edit area.  Note that you do not 
have to specify the file extension – BioWin will add the proper extension (.atp) to 
your file.  When you are satisfied with your file name, click the Save button.  When 
you save a file, the following information is saved: 

   

• The pages, their names, and location in the workbook relative to each 
other; 

• The pane layout on each page; 

• The type of information display on each pane (i.e. chart, table, element 
summary); 

• Formatting of charts and series with their data.  Note that when you 
save a chart in this manner, only the formatting is saved – series links to 
the database will not be saved and the series essentially become 
inactive lines. 

Printing Album Pages 
The Album|Print pages command should be used when you want to print multiple 
or all of the album pages.  Selecting this command will present you with the dialog 
box shown below. 

 
Dialog box used for printing multiple or all of the album pages 
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The Album pages to print section allows you to choose between printing All X 
pages (X changes according to the number of pages in the current album), or a 
Range of pages (when the option is selected, you may enter text in the from and to 
spin edit boxes). 

Once you have selected the album pages that you want to print, you can choose 
between one of four Album page layout options: 

   

1. The top left option will result in the contents of each album page being 
printed on an entire page.  For example if an album page contains only 
one chart, that chart will be printed on an entire page.  If an album page 
contains two panes with a chart on each, then the two charts will be 
printed on an entire page. 

2. The top right option will print the contents of each album page to one 
horizontal half of a page.  Each printed page will contain two BioWin 
album pages. 

3. The bottom left option will print the contents of each album page to one 
vertical half of a page in the report.  Each printed page will contain two 
BioWin album pages. 

4. The bottom right option will print the contents of each album page to 
one quarter of a page in the report.  Each printed page will contain four 
BioWin album pages. 

The General section contains a number of generic printing options.  You can select 
your page Orientation to be Landscape or Portrait.  You can specify the 
Number of copies of each page that you would like to print.  The Printer 
setup… button will open the printer setup dialog box which will allow you to 
access the printer’s properties, set paper size, page orientation, and a number of other 
printer options (the options presented to you will be dependant on the printer you 
have). 

Once you are satisfied with your layout settings, click the OK button to print. 

Album Element Information Displays 
BioWin has two preset element information displays for viewing in the album.  They 
provide a quick means of displaying information about a particular element in your 
configuration.  Like any other information display, these may be added to any pane 
on a page. 

Element specific information 
includes parameters that are 
relevant only to certain types 
of elements.  For example, 
Solids Loading Rate only 
applies to settlers, Oxygen 
Utilization Rate applies only 
to aerated bioreactors, etc. 

The two types of element information display are State variable and Summary.  
Both types of display are divided into two main sections.  The State variable 
display lists information about all the state variables for the selected element, 
including their concentrations and mass flow rates in the left section.  The 
Summary display lists information about various compounds (e.g. Volatile 
Suspended Solids, Chemical Oxygen Demand, etc.) for the selected element, 
including their concentrations and mass flow rates in the left section.  In the bottom 
section of the display, element specific information is displayed. 

In the right section, both types of display show general information about the 
selected element such as the element name, the location in the element from where 
the compound / state variable data are obtained (i.e. Input, Output, Underflow), and 
where appropriate, physical data such as element dimensions and temperature.  You 
may control the location in the element from where the compound / state variable 
data are obtained by clicking the Options button.  Note that this may not be 
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appropriate for all element types since for certain elements (e.g. effluent) the location 
is irrelevant.  For splitters, if you want to see data for the side stream, you should 
select the Alt. output option. 

Both types of display also allow you to resize the columns in the left section where 
names, concentrations, and mass flow rates of state variables / compounds are listed.  
Also, you can change the space allocated in the pane for each section by holding 
your mouse over the vertical or horizontal line which divides the two sections of the 
display until the resize cursor appears, and dragging the vertical line. 

Example element information displays are shown below. 

 
A "summary" element information display 

 
A "state variable" element information display 
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Add an Element Info Display From The Album 

 
Tab used for creation of element information displays 

   

1. Right-click on the album pane where you want to place an element 
information display. 

2. Select Element info from the resulting pop-up menu. 

3. In the Elements drop list box, select the element that you want to 
display information for. 

4. In the View type radio button group, select State variable view or 
Summary view. 

5. Click Close to finish. 

   

Add an Element Info Display From the Drawing Board 
   

Element Selection Tool 

Selection Cursor 

1. Click on the element selection tool 
from the configure toolbar. 

2. Move the cursor over the element 
on the drawing board for which 
you wish to add an element 
information display.  When you do 
so, the cursor will change to the 
element selection cursor. 

3. Right-click on the element, and select Add to album from the resulting 
popup menu. 
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4. From the resulting flyout menu, select either Element info (Summary) 
or Element info (State variables).  A new page will be added to the 
album for the element information display you have selected. 

   

Album Table Displays 
To allow users more flexibility for displaying information about elements, BioWin 
also offers the functionality of creating customized tables for display in the album.  
In these tables, it is possible to include all or any combination of the elements in the 
current configuration.  You also may choose the compounds and/or variables 
included in the table.  Once you have added a table, you may add more elements to it 
or remove existing ones if you wish.  You also can resize the columns in the table. 

A two-pane album page with example tables is shown below. 

 
An album page showing two example tables 

Add a Table Display 
1. Right-click on the blank album pane where you wish to place the table. 

2. Select Table from the resulting pop-up menu. 
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Tab used to choose elements for table display 

   

3. A dialog will open with the Choose elements tab displayed.  From 
the Elements tree view, select the element(s) that you wish to include 
in the table. 

• If you wish to include all the elements from a group (for example, 
all the Bioreactors), click on the group heading and then click the 
right-pointing arrow to move them all to the Selected Elements 
list. 

• If you wish to include only certain elements from a group (or 
groups), then click on the plus sign (+) next to the group heading to 
expand it, click on the specific element you want to include, and 
then click the right-pointing arrow to move it to the Selected 
Elements list. 

• If you want to change the order in which the Selected Elements 
will appear in the table, move the elements around by clicking on 
them and then clicking the Up/Down arrows. 

4. Now click the Choose compounds tab.  In the Compounds list, 
select the compounds that you wish to appear in your table, and add 
them to the Selected compounds list by clicking the right-pointing 
arrow.  To select multiple compounds; 

• Select contiguous multiple compounds by clicking on the first 
desired compound, holding down the Shift key, and clicking the 
last desired compound. 

• Select non-contiguous multiple series by holding the Ctrl key and 
clicking on the different desired compounds. 
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Tab used to choose compounds for inclusion in table display 

   

5. If you wish to re-add certain compounds, place a check in the box 
labeled Duplicates, and re-add the compounds. 

6. If you want to change the order in which the compounds will appear in 
the table, move the compounds around by clicking on them and then 
clicking the Up/Down arrows. 

7. Click OK to finish. 

Edit Table Entries 
To add to the elements listed in the table: 
   

1. In the album, double-click on any row of the table, or right-click and 
select Edit Table… from the resulting popup menu. 

2. Click the Choose elements tab of the resulting dialog box. 

3. If you wish to include all the elements from a group (for example, all 
the Bioreactors), click on the group heading and then click the right-
pointing arrow to move them all to the Selected Elements list. 

4. If you wish to include only certain elements from a group (or groups), 
then click on the plus sign (+) next to the group heading to expand it, 
click on the specific element you want to include, and then click the 
right-pointing arrow to move it to the Selected Elements list. 

5. Click OK to finish. 

To delete an element from the table: 
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1. Double-click on any row of the table, or right-click and select Edit 

Table… from the resulting popup menu. 

2. Click the Choose elements tab of the resulting dialog box. 

3. In the Selected elements list, click on the element you wish to 
remove and press the Delete key on your keyboard. 

4. Click OK to finish. 

To change the order of the elements in the table: 
   

1. Double-click on any row of the table, or right-click and select Edit 
Table… from the resulting popup menu. 

2. Click the Choose elements tab of the resulting dialog box. 

3. Change the order of the elements in the Selected elements list by 
clicking on elements and clicking the Up/Down arrows. 

4. Click OK to finish. 

To add compounds to the table: 
   

1. Double-click on any row of the table, or right-click and select Edit 
Table… from the resulting popup menu. 

2. Click the Choose compounds tab of the resulting dialog box. 

3. In the Compounds list, select the compounds that you wish to appear 
in your table, and add them to the Selected compounds list by 
clicking the right-pointing arrow.  Select contiguous multiple 
compounds by clicking on the first desired compound, holding down 
the Shift key, and clicking the last desired compound.  Select non-
contiguous multiple compounds by holding the Ctrl key and clicking 
on the different desired compounds. 

4. If you wish to re-add certain compounds, place a check in the box 
labeled Duplicates, and re-add the compounds. 

5. Click OK to finish. 

To delete a compound from the table: 
   

1. Double-click on any row of the table, or right-click and select Edit 
Table… from the resulting popup menu. 

2. Click the Choose compounds tab of the resulting dialog box. 

3. In the Selected compounds list, click on the compound you wish to 
remove and press the Delete key on your keyboard. 

4. Click OK to finish. 

To change the order of the compounds in the table: 
   

1. Double-click on any row of the table, or right-click and select Edit 
Table… from the resulting popup menu. 
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2. Click the Choose compounds tab of the resulting dialog box. 

3. Change the order of the compounds in the Selected compounds list 
by clicking on compounds and clicking the Up/Down arrows. 

4. Click OK to finish. 

Resize Table Columns 
You can resize columns in a table in one of two ways: 

Horizontal Resize 

• Open the album page containing the table you want to resize columns 
for.  Hold your cursor over the right dividing line of the column you 
want to resize in the column heading row.  When you do this, your 
cursor will change to the horizontal resize cursor.  Click the mouse and 
drag the column dividing line until the column is the desired size. 

• To size a column so that it fits the widest value displayed in that 
column, simply click on the column heading.  Note that this will undo 
any resizing you have done with the first method as it sets the other 
columns to a “standard” width. 

Specialized Types of Table Displays 
There are a number of tables that display data that are different from or not available 
in standard tables.  A summary of these specialized tables is given in the following 
sections.  Specialized tables are added to the album and edited similarly to standard 
tables, as outlined in the previous sections.  Any procedures that differ from the 
standards are highlighted below. 

Mass Rate Tables 
To allow users more flexibility for displaying information about elements, BioWin 
offers the functionality of creating customized mass rate tables for display in the 
album.  In these tables, it is possible to include all or any combination of the 
elements in the current configuration.  You also may choose the compounds and/or 
variables included in the mass rate table.  Once you have added a mass rate table, 
you may add more elements to it or remove existing ones if you wish.  You also can 
resize the columns in the table.  The mass rates shown in these tables are in kg/d if 
Metric flow units are being used, and lb/d if Imperial flow units are being used. 

An album page with an example mass rate table is shown below. 

 
An album page showing a mass rate table 
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Add a Mass Rate Table 
1. Right-click on the album pane where you wish to place the mass rate 

table. 

2. Select Mass rate table… from the resulting pop-up menu. 

3. Continue as you would for a standard table. 

Aeration tables 
To allow users more flexibility for displaying information about bioreactor-class 
elements BioWin also offers the functionality of creating tables especially for the 
display of aeration details in the album.  In these tables, it is possible to include all or 
any combination of the bioreactor-class elements in the current configuration.  You 
also may choose the compounds and/or variables included in the aeration table.  
Once you have added an aeration table, you may add more bioreactor-class elements 
to it or remove existing ones if you wish. 

A two-pane album page with example aeration tables is shown below. 

 
Example aeration tables (top pane shows a default aeration table, bottom pane shows an 
edited aeration table) 

Add an Aeration table 
1. Right-click on the album pane where you wish to add the aeration table. 

2. From the resulting popup menu, select Aeration details.  The 
aeration table will be added to the album pane with the default 
parameters and variables shown. 

Unit Group Table 
One problem with ordinary tables is that they may only contain information for 
parameters that are common to all types of elements.  For example, with an ordinary 
table you cannot select to display Solids Loading Rate for a clarifier element.  
This is because Solids Loading Rate is a parameter that is unique to clarifier 
elements. 
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Unit group tables give you the flexibility to generate tables for elements that have 
unique parameters, such as clarifiers.  Once you have added a unit group table, you 
may add additional compounds to it or remove existing ones if you wish. 

A two-pane album page with example unit group tables is shown below. 

   

 
Example unit group tables (top pane shows a default unit group table for clarifier element, 
bottom pane shows an edited unit group table for clarifier element) 

Add a Unit Group Table 
1. Right-click on the album pane where you wish to add the unit group 

table. 

2. From the resulting popup menu, select Unit group table.  You will 
then be presented with the Select element type dialog shown below: 
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Dialog used to select the type of element to include in the unit group table 

   

3. In the Element type list, click on the type of element that you want to 
include in your unit group table. 

4. Click the Close button to generate the unit group table.  You may now 
edit the table to add additional information if you wish. 

Album Chart Sub-Menu 
This section provides information about the menu commands available in the Chart 
sub-menu of the pop-up menu that results from right-clicking on a chart in the 
BioWin album.  Note that some of these commands also may be accessed by right-
clicking on a table or element information display, but in this case, they will be 
accessible directly from the resulting pop-up menu as opposed to a sub-menu. 

Copy 
Use this command to place a copy of the current display (i.e. chart, table, element 
summary, aeration table) on the Windows clipboard.  This will make the display 
available for pasting into another application such as a word processor. 

Add To Notes 
When this command is invoked for an element information display, table,  or 
aeration table display, BioWin will place a tab-delimited text version of the table into 
the Simulation Notes editor.  If this command is invoked for a chart display, you will 
be prompted to save the chart file in a graphics file format of your choice, and the 
file location path will be placed into the Simulation Notes editor for your reference. 
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Print… 
This command will invoke the album display print dialog box, shown below: 

 
Dialog box used for printing album charts, tables, or element information displays 

Use the Printer drop list box to select the printer you want to use for printing.  The 
Printer Setup… button will open the printer setup dialog box which will allow you 
to access the printer’s properties, set paper size, page orientation, and a number of 
other printer options.  The Print button will send the print job to the printer and the 
printout will match the preview which is shown.  The Close button closes this 
dialog box and returns you to the album. 

Using the Paper Orientation group, specify whether you want the printing to be 
done on a Portrait or Landscape page.  The print preview gives you an idea of 
what the printout will look like under each format. 

If you do not wish to see the size of the margins for your print job, you may de-select 
the box labeled View Margins.  You can control the margins using three different 
methods: 

   

1. Using  the Margins (%) Spin Edits, you can adjust each margin as you 
like.  The four Spin Edit boxes each control the margin that shares its 
position, that is, the top Spin Edit controls the top margin, the bottom 
Spin Edit controls the bottom margin, and so on.  When you change a 
value, you will see changes in the print preview accordingly. 

 

 
Resize Cursors 

2. You may drag each margin using the mouse.  Position the mouse 
cursor over the margin you wish to adjust until the horizontal or 
vertical resize cursor appears.  Click the mouse button, hold it, and 
drag the margin to the position you wish it to occupy.  Notice that 
when you finish dragging it, the values in the Margins (%) Spin Edits 
will have been updated. 
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Drag Print Object 

3. By moving the object to be printed around on the page.  When the 
mouse cursor takes the form of a hand, you may click and drag the 
entire object around on the page until it is in the desired position.  
Notice that when you finish dragging it, the values in the Margins (%)
Spin Edits will have been updated. 

If after applying any one of these methods of adjusting margins you wish to reset the 
margins to the default values, you may do so by clicking the Reset Margins 
button. 

You can use the Chart Detail scroll bar to adjust the text size on your print job.  
Sliding the scroll towards More decreases the size of text on your chart and gives 
greater prevalence to the chart on the printout.  Sliding the scroll towards Normal 
increases the size of the text on your chart and gives less prevalence to the chart on 
the printout. 

Note:  If you are having trouble with a table print preview not fitting into the 
margins, ensure that you have a True Type font (font styles with a TT after their 
name) selected in your Project | Current Project Options - Drawing board 
options tab. 

Export… 
This command allows you to save the current chart in a number of different graphic 
formats.  When you choose Export… from the Display sub-menu, you will be 
presented with a dialog box that has the same functionality as the File Save dialog 
box. 

In the Save as type: drop list box, you may choose from one of the many different 
graphic formats supported by BioWin.  When you have specified the file name, 
location, and type, click the Save button.  For some formats (e.g. JPEG), this will 
open a dialog that allows specification of further options relevant to the selected 
graphic format.  Note that if you want to be able to import the chart into another 
BioWin project, you should export it in Tee Chart (*.TEE) format. 

Import… 
This command allows you to import a chart that you have previously created and 
exported using BioWin.  This command is different from the Album|Open 
pages… command in that it may be used to add individual charts to any album 
page, while the Album|Open pages… command is used to open pages containing 
charts, tables, and element summaries.  When you choose Import… from the 
Display sub-menu, you will be presented with a dialog box that has the same 
functionality as the File Open dialog box. 

Note that only charts that have been exported in Tee Chart (*.TEE) format are 
available for importing.  Once you have located the chart you wish to import, click 
the Open button to import it to the current chart display.  The imported chart will 
replace the current chart display.  Any series that exist on the imported chart will not 
be linked to the current database – they essentially are inactive drawings on the chart.  
However, the Import… command is useful if you wish to compare values from 
another project or set of simulations to current values, if you wish to use similar 
chart and series formatting, or if you wish to import charts from other applications 
which use the Tee Chart (*.TEE) format. 
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Change to Table… 
This command will change the current display from a chart or an element summary 
to a table (or a new table if the current display is already a table).  Values from the 
current chart, element summary, or table will not be placed in the table; this 
command is simply for changing the type of display in the current pane. 

Change to Element info… 
This command will change the current display from a chart or table to an element 
summary (or a different type of element summary if the current display is already an 
element summary).  Values from the current chart, element summary, or table will 
not be placed in the element summary; this command is simply for changing the type 
of display in the current pane. 

Change to Chart 
This command will change the current display from a table or element summary to a 
chart.  Values from the current element summary or table will not be placed in the 
chart; this command is simply for changing the type of display in the current pane. 

Delete current… 
This command will delete the current display from an album pane.  This command is 
useful if you wish to delete one information display from a multi-pane album page 
without deleting or changing the displays on the other panes of the page. 
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Creating Charts & Adding Series 

Charts in BioWin 
Charts are used in BioWin to display various types of series.  It is possible to change 
the formatting of certain chart properties.  For more information see “Chart 
Formatting Procedures”. 

Add a Chart To The Album 
1. Open the album by selecting View|Album in the BioWin main 

window. 

2. Add a new page to the album by selecting Album|Add page… 

3. From the Select new album page gallery, select the desired layout. 

4. Right-click on the pane that you want the chart to occupy. 

5. Choose Chart from the resulting pop-up menu. 

Series Styles in BioWin 
A series may be any one of a variety of styles including: 

   

• Line 

• Fast Line 

• Point 

• Bar (Horizontal and Vertical) 

• Area 

• Pie 

• Surface 

Users will find that certain series styles are best suited to specific series types.  For 
example, applying the Pie series style to time series data is probably not as effective 
as using the Line or Fast Line series style.  Each series style has its own set of unique 
formatting options.  For further information on changing these formatting options, 
see “Series Formatting Procedures”. 
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Series Available From The Album 
BioWin offers users a number of different series types that may be used to plot data.  
This section outlines information and procedures related to series types that may be 
added to a chart from the album. 

Time Series (Album) 
This series type is used for time series analysis of data.  It is unique in that the user 
may specify the element location (i.e. Input, Output, Underflow) from which data for 
the series are obtained.  Also, this is the only type of series for which you may plot 
element-specific information (e.g. Solids Loading Rate for settling tank elements, 
Oxygen Utilization Rates for bioreactor elements, etc). 

Add a Time Series From the Album 
1. Right-click on an album chart and click Add Series in the resulting 

pop-up menu. 

2. On the Time series tab, select the element you wish to plot a variable 
for from the Element name drop list box. 

 
The time series (from album) dialog box 

   

3. Select the location in the element where you wish to obtain the plotting 
data from (i.e. Input, Output {overflow}, Underflow) using the 
Location radio button group. 

4. Choose a parameter to plot from the Element specific, Water 
Chemistry, State variables, or Combined list boxes.  If you want 
to add more than one parameter from a given group, you may do so.  
To select a contiguous group, click the first parameter of the group, and 
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while holding the Shift key, click the last parameter of the group.  To 
select non-contiguous parameters, hold the Ctrl key and click the 
desired parameters in succession. 

5. Click the Plot selected button. 

6. From the Time series gallery, choose the desired series style that 
you wish to apply.  If you want your chart to have a three-dimensional 
appearance, ensure that the box labeled 3D is checked and click OK. 

7. Click the Close button to finish. 

Note:  You may only select multiple parameters in one list box at a time.  If you 
want to plot more than one parameter and they are not in the same list box, you must 
repeat steps 3-6 for each parameter.  Some features of the dialog box described 
above will only appear for certain elements.  For example, the underflow location 
option only will appear for elements that have underflows (such as settling tank 
elements).  Also, the element specific list box only will appear for elements that have 
unique data types (such as bioreactors). 

Multi Time Series 
Multi time series provide a quick means with which to plot a chosen compound in a 
number of different elements.  For example, you quickly can generate a group of 
series that show the ammonia concentration in each bioreactor.  Note that for this 
series type the data for plotting are taken from the main output of the element (for 
example, the overflow of a settler). 

Add a Multi Time Series 
1. Right-click on an album chart and click Add Series in the resulting 

pop-up menu. 

2. Click on the Multi Time series tab of the Add Series dialog box. 

3. In the Elements tree view list, select the elements that you wish to 
include in the profile plot. 
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The multi time series dialog 

   

• If you wish to include all the elements from a group (for example, 
all the Bioreactors), click on the group heading and then click the 
right-pointing arrow to move them all to the Selected elements 
list. 

• If you wish to include only certain elements from a group (or 
groups), then click on the plus sign (+) next to the group heading to 
expand it, click on the specific element you want to include, and 
then click the right-pointing arrow to move it to the Selected 
elements list. 

4. If you want to change the order in which the Selected elements will 
appear in the multi time series plot, move the elements around by 
clicking on them and clicking the up/down arrows. 

5. Select the compound that you wish to plot from the Compound drop 
list box. 

6. Click the Plot selected button. 

7. From the Time series gallery, choose the desired series style that 
you wish to apply to your profile.  If you want your chart to have a 
three-dimensional appearance, ensure that the box labeled 3D is 
checked and click OK. 

8. Click the Close button to finish. 

Note:  You may repeat steps 5-7 if you wish to generate multi time series for more 
than one compound on a chart. 
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Mass Rate Series 
Mass rate series allow you to plot the mass rate against time for state variables and 
compounds.  Note that for this series type the data for plotting are taken from the 
main output of the element (for example, the overflow of a settler). 

Add a Mass Rate Series 
1. Right-click on an album chart and click Add Series in the resulting 

pop-up menu. 

2. Click on the Mass Rate tab of the Add Series dialog box. 

3. In the Elements tree view list, select the elements that you wish to 
include in the mass rate plot. 

 
The mass rate series dialog 

   

• If you wish to include all the elements from a group (for example, 
all the Bioreactors), click on the group heading and then click the 
right-pointing arrow to move them all to the Selected elements 
list. 

• If you wish to include only certain elements from a group (or 
groups), then click on the plus sign (+) next to the group heading to 
expand it, click on the specific element you want to include, and 
then click the right-pointing arrow to move it to the Selected 
elements list. 

4. If you want to change the order in which the Selected elements will 
appear in the mass rate plot, move the elements around by clicking on 
them and clicking the up/down arrows. 
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5. Select the compound that you wish to plot from the drop list box below 
the element list. 

6. Click the Plot selected mass rate button. 

7. From the Time series gallery, choose the desired series style that 
you wish to apply to your profile.  If you want your chart to have a 
three-dimensional appearance, ensure that the box labeled 3D is 
checked and click OK. 

8. Click the Close button to finish. 

Note:  You may repeat steps 5-7 if you wish to generate mass rate series for more 
than one compound on a chart. 

Current Value 
For a group of selected elements (or a single element), a current value series will 
show the most recent (with respect to simulation start time) value of a chosen 
compound.  During a dynamic simulation, the series will be updated and redrawn 
after each data interval.  For a steady-state simulation, the series will represent the 
final steady-state values. 

Current value plots are best suited to a specific group of the available series styles, 
such as Bar, Pie, and Area.  As such, the choice of styles in the gallery is limited to 
these. 

Add a Current Value Series 
1. Right-click on an album chart and click Add Series in the resulting 

pop-up menu. 

2. Click on the Current value tab of the Add Series dialog box. 

3. In the Elements tree view list, select the element(s) that you wish to 
include in the current value plot. 
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The current value series dialog 

   

• If you wish to include all the elements from a group (for example, 
all the bioreactors), click on the group heading and then click the 
right-pointing arrow to move them all to the Selected elements 
list. 

• If you wish to include only certain elements from a group (or 
groups), then click on the plus sign (+) next to the group heading to 
expand it, click on the specific element you want to include, and 
then click the right-pointing arrow to move it to the Selected 
elements list. 

4. If you want to change the order in which the Selected elements will 
appear in the current value plot, move the elements around by clicking 
on them and clicking the up/down arrows. 

5. Select the compound that you wish to plot from the Compound drop 
list box. 

6. Click the Plot selected button. 

7. From the Current value series gallery, choose the desired series 
style that you wish to apply.  If you want your chart to have a three-
dimensional appearance, ensure that the box labeled 3D is checked and 
click OK. 

8. Click the Close button to finish. 

Note:  If you wish you may have more than one current value series on a chart.  
Simply repeat steps 5-7 for each compound that you wish to have a current value 
series for.  Keep in mind however that this works best for Bar and Area charts, since 
Pie charts are drawn over top of one another. 
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Current Value (by type) 
For a group of selected elements (or a single element) from a chosen element class 
(e.g. bioreactor, clarifier), a current value (by type) series will show the most recent 
(with respect to simulation start time) value of a chosen compound.  During a 
dynamic simulation, the series will be updated and redrawn after each data interval.  
For a steady-state simulation, the series will represent the final steady-state values. 

The compounds that may be plotted in an ordinary current value series are limited to 
those that are common to all element types.  For example, in an ordinary current 
value series, you may not plot OUR for a bioreactor, as this parameter is specific to 
bioreactor-class elements.  The current value (by type) series overcomes this 
limitation by allowing you to first choose the type of element that the plot data are 
from, and then offering a customized list of compounds based on the element type.  
For example, if you select a clarifier element, you will be able to plot current values 
of Solids Loading Rate. 

Add a Current Value (by type) Series 
1. Right-click on an album chart and click Add Series in the resulting 

pop-up menu. 

2. Click on the Current value (by type) tab of the Add Series dialog 
box. 

3. In the Element types list, select the element type that you wish to 
include in the current value (by type) plot. 

 
The current value(by type) series dialog 

   

4. Click the Plots for selected element type… button to open a 
dialog that allows you to choose the elements and compounds for your 
plot.  This dialog is shown below: 
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Dialog used for selecting elements and element-specific compounds 

   

5. If you want to change the order in which the Selected elements will 
appear in the current value plot, move the elements around by clicking 
on them and clicking the up/down arrows. 

6. Select the compound that you wish to plot from the Component drop 
list box. 

7. Click the Plot selected button to plot a Bar series.  You may change 
the series style after finishing your plot if you wish. 

8. Click the Close button to finish. 

Note:  If you wish you may have more than one current value (by type) series on a 
chart.  Simply repeat steps 6-8 for each compound that you wish to have a current 
value series for. 

Composite Sample Series 
A composite sample series can be used to plot composite sampling data for a given 
parameter in one or more elements.  You may specify the sampling period (e.g. a 
daily composite, a weekly composite, etc.), any offsets that will take place in the 
sampling period, and whether you want the data to be flow weighted average or a 
simple average. 

An important concept is the Sampling period.  The sample is taken and plotted at 
the end of the sampling period.  For example, if you have a 1 day period (i.e. a daily 
composite), then the first sample will be taken and plotted at the end of the first 24 
hour period, and at the end of each 24 hour period thereafter.  Note that the sampling 
period must be greater than the database data interval, otherwise the sample will not 
be a composite. 

Another important concept is the Offset.  This is the amount by which you step into 
the sampling period when you start simulating.  This concept is perhaps best 
illustrated by an example.  Say you have a 24 hour period, with a 16 hour offset, and 
your simulation start time is 12:00 AM.  Since you are stepping into the sampling 
period at the 16 hour point, this means that the first point will be sampled and plotted 
in 8 hours (recall from the discussion of sampling period above that samples are 
always taken and plotted at the end of the sampling period).  This means that your 
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first sample will be taken and plotted at 8:00 AM on the first day, and then at 8:00 
AM each day thereafter for the duration of the simulation. 

Note:  It should be noted that composite sampling data are not added to BioWin's 
database. 

You may choose to plot flow weighted averages of your samples, or simple averages.  
If you choose to have flow weighted average values plotted, the following formula 
will be used for n points (where Q is flow and C is concentration): 
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If you choose to have simple average values plotted, then the following formula will 
be used: 
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Add a Composite Series 
1. Right-click on an album chart and click Add Series in the resulting 

pop-up menu. 

2. Click on the Composite tab of the Add Series dialog box. 

3. In the Elements tree view list, select the element(s) for which you 
wish to plot composite data. 
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The composite series dialog. 

   

4. You may use the up/down arrows next to the Selected elements list 
to change the order in which the series are plotted if you wish. 

5. From the Compound drop list, select the parameter for which you 
wish to plot composite samples. 

6. Select your Sampling period (recall that data are sampled and 
plotted at the end of the sampling period). 

7. You may select an offset at the beginning of the simulation using the 
Offset sample by control (recall that this is the amount that you step 
into the sampling period – see above discussion). 

8. Click the Plot selected button.  From the series gallery, select the 
series style you want to use.  For composite plots, Point Series are 
useful. 

9. Click OK to close the series gallery. 

10. Click Close to finish. 

Surface Series 
Surface series can be used for spatial profiles of a given compound.  For example, 
say you have a configuration with three bioreactors, and you want to show the 
ammonia profile over the bioreactors.  The ammonia concentration would be plotted 
on the Y (vertical) axis, the bioreactor number would be plotted on the X (horizontal) 
axis, and time would be plotted on the Z axis. 

Add a Surface Series 
1. Right-click on an album chart and click Add Series in the resulting 

pop-up menu. 

2. Click on the Surface tab of the Add Series dialog box. 

3. In the Elements tree view list, select the element(s) that you wish to 
include in the surface plot. 
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The surface series dialog 

   

• If you wish to include all the elements from a group (for example, 
all the bioreactors), click on the group heading and then click the 
right-pointing arrow to move them all to the Selected elements 
list. 

• If you wish to include only certain elements from a group (or 
groups), then click on the plus sign (+) next to the group heading to 
expand it, click on the specific element you want to include, and 
then click the right-pointing arrow to move it to the Selected 
elements list. 

4. If you want to change the order in which the Selected elements will 
appear in the surface plot, move the elements around by clicking on 
them and clicking the up/down arrows. 

5. Select the horizontal axis that you want time to be recorded on.  If you 
check the box labeled Time on Z axis, then time will be recorded on 
the Z axis (the axis that goes into the screen).  If this box is left 
unselected, then time will be recorded on the X axis (the horizontal 
axis). 

6. Set your Plot resolution.  If you want a fine grid, decrease the value 
in the spin edit box.  If you want a coarse grid, increase the value.  Note 
that fine grids look better, but will increase demand on system 
resources. 

7. Select the compound that you wish to plot from the Compound drop 
list box. 

8. Click the Plot selected button. 

9. Click the Close button to finish. 
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Special Series (Album) 
BioWin comes with some plots that are generated semi-automatically.  These include 
process volume, mass fraction, and SRT plots.  For process volume and mass 
fraction plots, you only are required to select the elements that you want included in 
the plots.  BioWin then performs the necessary calculations and generates the plot.  
For SRT plots, you simply select the calculated SRT. that you want to plot 
dynamically.  You then may customize the appearance of the chart using BioWin's 
powerful chart and series formatting tools. 

Add a Special Series From the Album 
If you want to add a process volume or mass fraction series: 
   

1. Right-click on an album chart and click Add Series in the resulting 
pop-up menu. 

2. Click on the Special tab of the Add Series dialog box. 

3. In the Elements tree view, select the element(s) that you wish to 
include in the special plot. 

   

 
The special series (from album) dialog 

   

• If you wish to include all the elements from a group (for example, 
all the bioreactors), click on the group heading and then click the 
right-pointing arrow to move them all to the Selected elements 
list. 
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• If you wish to include only certain elements from a group (or 
groups), then click on the plus sign (+) next to the group heading to 
expand it, click on the specific element you want to include, and 
then click the right-pointing arrow to move it to the Selected 
elements list. 

4. If you want to change the order in which the Selected elements will 
appear in the special plot, move the elements around by clicking on 
them and clicking the up/down arrows. 

5. When you are satisfied with the order of the included elements, click on 
the Plot volume pie button to generate a pie series showing the 
volume fraction of each selected element, or click on the Plot mass 
pie button to generate a pie series showing the mass fraction of each 
selected element. 

6. Click the Close button to finish. 

If you want to add a time series plot of a calculated SRT: 
   

1. Right-click on an album chart and click Add Series in the resulting 
pop-up menu. 

2. Click on the Special tab of the Add Series dialog box. 

3. In the SRT group of the Other plots section, select the calculated 
SRT that you want to plot, and click the Plot… button. 

4. From the Time series gallery, choose the desired series style that 
you wish to apply.  If you want your chart to have a three-dimensional 
appearance, ensure that the box labeled 3D is checked and click OK. 

5. Click the Close button to finish. 

Imported Series 
BioWin offers the functionality of plotting imported data.  This is useful particularly 
for comparing simulation results to observed data (if you are calibrating BioWin, for 
example).  There are two types of series you can plot using imported data: 

   

1. Final value 

2. Time series (X-Y) 

A Final value series allows you to plot the last value from the column(s) of data 
that you select.  Therefore, this series type is similar to a current value series for 
imported data and is suited to styles such as bar and pie series. 

A Time series allows you to plot all of the values in an imported data column 
against all of the values in another imported data column (usually the imported time 
column).  Therefore, this series type is best suited to styles such as line and point 
series. 

Add an Imported Series 
1. Right-click on an album chart and click Add Series in the resulting 

pop-up menu. 

2. Click on the Imported tab of the Add Series dialog box. 
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3. Using the Imported Name(s) drop list box, select the name of a file 
or block of data (from the clipboard) you have imported to the 
database. 

 
The imported series dialog 

   

4. If you want to import a file to the database from this dialog box, you 
may do so by clicking the Import… button.  For more information on 
importing data from a file, please see Importing Data. 

5. Select the Plot type. 

If you select a Final value series: 

   

1. From the Y Value column(s) list, select the columns that you want to 
plot the final value of.  To select a contiguous group of columns, click 
the first column of the group, and while holding the Shift key, click the 
last column of the group.  To select non-contiguous columns, hold the 
Ctrl key and click the desired columns in succession. 

2. Click the Plot selected button. 

3. From the General series gallery, choose the desired series style that 
you wish to apply.  If you want your chart to have a three-dimensional 
appearance, ensure that the box labeled 3D is checked and click OK. 

4. Click the Close button to finish. 

If you select a Time series: 
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1. From the X Value column list, select the column that you want to use 
as the independent variable in the plot.  If you have selected a column 
containing time values, then checking the box labeled Add 
simulation start date/time to X values will synchronize the 
imported time values to the original database time values.  This option 
will allow you to plot a time series generated using imported data on 
the same axes as a time series that uses non-imported data. 

2. From the Y Value column(s) list, select the columns that you want to 
use as independent variables.  To select a contiguous group of columns, 
click the first column of the group, and while holding the Shift key, 
click the last column of the group.  To select non-contiguous columns, 
hold the Ctrl key and click the desired columns in succession.  Each 
column that you select will yield a series on the chart. 

3. Click the Plot selected button. 

4. From the General series gallery, choose the desired series style that 
you wish to apply.  If you want your chart to have a three-dimensional 
appearance, ensure that the box labeled 3D is checked and click OK. 

5. Click the Close button to finish. 

 

General Plot (Album) 
This tab can be used to plot current value series or X-Y “scatter” plots.  It is unique 
in that the user may specify the element location (i.e. Input, Output, Underflow) 
from which data for the series are obtained.  From this tab you may also plot 
element-specific information (e.g. Solids Loading Rate for settling tank elements, 
Oxygen Utilization Rates for bioreactor elements, etc) in either a “current 
value” or “X-Y scatter” type plot. 

Note: Parameters selected for plotting will automatically be added to the list of 
“Monitored” items. 

Add a General “Current Value” Series From the Album 
1. Right-click on an album chart and click Add Series in the resulting 

pop-up menu. 

2. On the General Plot tab, select the element you wish to plot a 
variable for from the Element name drop list box. 
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The general plot (from album) dialog box 

   

3. Select the location in the element where you wish to obtain the plotting 
data from (i.e. Input, Output {overflow}, Underflow) using the 
Location radio button group. 

4. Choose a parameter to plot from the Element specific, Water 
Chemistry, State variables, or Combined list boxes.  If you want 
to add more than one parameter from a given group, you may do so.  
To select a contiguous group, click the first parameter of the group, and 
while holding the Shift key, click the last parameter of the group.  To 
select non-contiguous parameters, hold the Ctrl key and click the 
desired parameters in succession. 

5. Click the Add selected à button. 

6. The item(s) that you have selected are listed in the Selected 
components for plotting list box.  You can change the order of the 
parameters using the “up” and “down” arrows on the right of the list 
box, and delete a parameter by selecting it and then hitting the Del key. 

7. To add additional parameters for the selected element repeat steps 3 
through 6.  To add parameters for a different element repeat steps 2 
through 6. 

8. Type a name for the series in the edit box directly below the Selected 
components for plotting list box. 

9. Make sure that the Current values plot box is checked. 

10. Press the Plot selected … button. 

11. From the General series gallery, choose the desired series style that 
you wish to apply.  If you want your chart to have a three-dimensional 
appearance, ensure that the box labeled 3D is checked and click OK. 
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12. To add another Current value series repeat steps 2 through 11. 

13. Click the Close button to finish. 

   

Note:  You may only select multiple parameters in one list box at a time.  If you 
want to plot more than one parameter and they are not in the same list box, you must 
repeat steps 3-6 for each parameter.  Some features of the dialog box described 
above will only appear for certain elements.  For example, the underflow location 
option only will appear for elements that have underflows (such as settling tank 
elements).  Also, the element specific list box only will appear for elements that have 
unique data types (such as bioreactors). 

   

Add a General “X-Y Scatter” Series From the Album 
1. Right-click on an album chart and click Add Series in the resulting 

pop-up menu. 

2. On the General Plot tab make sure that the Current values plot box 
is not checked. 

3. In an X-Y scatter plot the first parameter selected is plotted on the X 
axis and the second parameter is plotted on the y axis.  Any other 
parameters listed in the Selected components for plotting list box 
are not used.  You can change the order of the parameters using the 
“up” and “down” arrows on the right of the list box, and delete a 
parameter by selecting it and then hitting the Del key. 

4. Select the element you wish to plot a variable for from the Element 
name drop list box. 
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The general plot (from album) dialog box 

   

5. Select the location in the element where you wish to obtain the plotting 
data from (i.e. Input, Output {overflow}, Underflow) using the 
Location radio button group. 

6. Choose a parameter to plot from the Element specific, Water 
Chemistry, State variables, or Combined list boxes.   

7. Click the Add selected Æ button. 

8. To add a second parameter for the selected element repeat steps 5 
through 7.  To add parameters for a different element repeat steps 4 
through 7. 

9. The items that you have selected are listed in the Selected 
components for plotting list box (the axis that will be used for each 
parameter is shown to the left of the parameter. 

10. Type a name for the series in the edit box directly below the Selected 
components for plotting list box. 

11. Press the Plot selected … button. 

12. From the General series gallery, choose the desired series style that 
you wish to apply.  If you want your chart to have a three-dimensional 
appearance, ensure that the box labeled 3D is checked and click OK. 

13. To add another X-Y scatter plot series repeat steps 4 through 12. 

14. Click the Close button to finish. 

Note:  In an X-Y scatter plot a time history of both of the parameters is required, so 
when you first add the series there may not be any data to show.  Since the 
parameters involved in the scatter plot are automatically monitored the plot will 
show when a dynamic simulation is run. 

   

Series Available From The Drawing Board 
In the previous section, procedures for adding series to charts from the album view 
were outlined.  This section covers procedures related to charts created directly from 
the drawing board by right-clicking on elements, and the specialized series that 
result. 

When you add a series from the drawing board, a page with a chart in which to plot 
the series will be added automatically to the album (even if the album is closed or in 
the background at the time).  If the album was last closed or placed in the 
background with a page already containing a chart selected, BioWin will ask you if 
you want to plot the series you are adding from the drawing board in the existing 
chart.  You may agree to this, or by declining choose to have BioWin add a new page 
with a chart in which to plot the series.  Note that if the last selected album page 
contains multiple panes (where at least one of the panes contains a chart), a chart 
must have been selected (i.e. clicked on) before the album was closed in order for 
BioWin to give you the option of adding the drawing board-generated series to that 
chart.  If the chart was not selected upon closing the album, you will not be offered 
the option of adding the drawing board series to it – BioWin will add a new page 
with a chart for the drawing board-generated series. 
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Time Series (Drawing Board) 
This series type is used for time series analysis of data.  It is unique in that the user 
may specify the element location (i.e. Input, Output, Underflow) from which data for 
the series are obtained.  Also, this is the only type of series for which you may plot 
element-specific information (e.g. Solids Loading Rate for settling tank elements, 
Oxygen Utilization Rates for bioreactor elements, etc.). 

Add a Time Series From the Drawing Board 
1. In the drawing board, right-click on the element that you wish to create 

a time series for. 

2. From the resulting popup menu, select Add to album.  Next, select 
Chart… from the resulting flyout.  If you are presented with the choice 
of adding the series to an existing chart, click Yes or No. 

3. On the Time series tab, select the location in the element where you 
wish to obtain the plotting data from (i.e. Input, Output {overflow}, 
Underflow) using the Location radio button group. 

 
The time series (from drawing board) dialog 

   

4. Choose a parameter to plot from the Element specific, Water 
Chemistry, State variables, or Combined list boxes.  If you want 
to add more than one parameter from a given group, you may do so.  
To select a contiguous group, click the first parameter of the group, and 
while holding the Shift key, click the last parameter of the group.  To 
select non-contiguous parameters, hold the Ctrl key and click the 
desired parameters in succession. 

5. Click the Plot selected button. 

6. From the Time series gallery, choose the desired series style that 
you wish to apply.  If you want your chart to have a three-dimensional 
appearance, ensure that the box labeled 3D is checked and click OK. 
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7. Click the Close button to finish. 

Note:  You may only select multiple parameters in one list box at a time.  If you 
want to plot more than one parameter and they are not in the same list box, you must 
repeat steps 3-6 for each parameter.  Some features of the dialog box described 
above will only appear for certain elements.  For example, the underflow location 
option only will appear for elements that have underflows (such as settling tank 
elements).  Also, the element specific list box only will appear for elements that have 
unique data types (such as bioreactors). 

Special Series (Drawing Board) 
BioWin comes with a collection of special series that are generated automatically.  
You simply choose the type of special series and BioWin performs the necessary 
calculations to generate the data required.  You may then format the series and chart 
as you wish.  Note that these series are a special form of current value series – that is 
they display the most recent data with respect to simulation start time. 

The available special series are listed here with a description: 
Special Series Description 
All nitrogen concentrations Displays the current concentration of all 

nitrogen species for the selected element. 
Soluble nitrogen concentrations Displays the current concentration of all 

soluble nitrogen species for the selected 
element. 

Biomass concentrations Displays the current concentration of 
autotrophs, heterotrophs, poly-p 
heterotrophs, and endogenous residue for the 
selected element. 

COD concentrations Displays the current COD concentrations 
(including biomass expressed in terms of 
COD) for the selected element. 

COD concentrations excluding biomass Displays the current COD concentrations 
(excluding biomass expressed in terms of 
COD) for the selected element. 

Add a Special Series From the Drawing Board 
1. In the drawing board, right-click on the element that you wish to create 

a special series for. 

2. From the resulting popup menu, select Add to album.  Next, select 
Chart… from the resulting flyout.  If you are presented with the choice 
of adding the series to an existing chart, click Yes or No. 

3. On the Special tab, click the radio button next to the special series you 
want. 
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The special series (from drawing board) dialog 

   

4. Click the Plot selected button. 

5. From the Current value series gallery, choose the desired series 
style that you wish to apply.  If you want your chart to have a three-
dimensional appearance, ensure that the box labeled 3D is checked and 
click OK. 

6. Click the Close button to finish. 

Note:  You may add more than one special series to a chart by repeating steps 3-5.  
Keep in mind that this will not work well for Pie series since they are drawn over top 
of one another. 

SOTE (%) Series 
A SOTE (%) series is useful for comparing alternate aeration system designs.  It 
allows you to quickly plot SOTE (%) as a function of airflow rate per diffuser for the 
current reactor diffuser coverage (the area of diffusers divided by the area of the 
tank).  In addition, you may plot SOTE (%) as a function of airflow rate per diffuser 
for alternate diffuser coverage to compare a number of different design scenarios.  
Note that an Album Template Page with typical SOTE (%) numbers has been 
provided in the BioWin Templates directory. 

Note:  If an SOTE plot is generated for an SBR element that incorporates prezones, 
the plot information applies to the main SBR zone only.  The information on the 
plot does not apply to the prezone(s). 

Add a SOTE (%) Series 
1. In the drawing board, right-click on the element that you wish to create 

a SOTE (%) series for. 
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2. From the resulting popup menu, select Add to album.  Next, select 
Chart… from the resulting flyout.  If you are presented with the choice 
of adding the series to an existing chart, click Yes or No. 

3. On the SOTE(%) tab, select the cases you would like to plot SOTE for 
(i.e. for the current diffuser coverage and alternate coverage that you 
may specify using the %coverage spin edit boxes). 

 
The SOTE(%) series dialog 

   

4. You may change the number of pints that will be plotted in each series 
using the Number of points per curve setting.  Increasing this 
value tends to result in smoother curves. 

5. Click the Plot selected… button to plot the series.  Click Close to 
close the dialog box.  You may now open the album and look at your 
SOTE plot. 

SBR Profile Series 
A SBR profile series is useful for viewing how a parameter changes with depth over 
the length of a sequencing batch reactor.  The resulting plot is a three-dimensional 
chart that shows SBR length along either the x-axis (horizontal axis) or the z-axis 
(axis going into the screen), depending on the option you choose.  Concentration of 
the various parameters will be plotted on the y-axis (vertical axis), and the third axis 
will be assigned to SBR depth. 

Add a SBR Profile Series 
1. In the drawing board, right-click on the SBR element that you wish to 

create a SBR profile series for. 

2. From the resulting popup menu, select Add to album.  Next, select 
Profile plot… from the resulting flyout.  If you are presented with the 
choice of adding the series to an existing chart, click Yes or No. 



256  •  Creating Charts & Adding Series  

3. Using the dialog box shown below, select the Orientation of the 
profile plot by choosing to plot SBR length on the x-axis (Length on 
X) or SBR length on the z-axis (Length on Z). 

 
The SBR profile series dialog box 

   

4. From the State variables and Combined lists, choose the 
parameters you wish to plot and click the Plot selected button.  Note 
that you can plot multiple parameters on one chart by repeating this 
step before clicking the Close button to finish. 

Settling Tank Profile Series 
A settling tank profile series is useful for viewing how a parameter changes over the 
depth of a settling tank element (or other separator-type elements such as grit 
removal tanks, dewatering units, and ideal primary clarifiers).  There are two 
different types of profile series: 

   

1. Current value 

2. Time series (surface) 

A Current value settling tank profile series shows the most recent (with respect to 
simulation start time) values of the chosen parameter(s) over the depth of the settling 
tank.  During a dynamic simulation, the settling tank profile series will be updated 
and redrawn after each data interval.  For a steady-state simulation, the settling tank 
profile series will represent the final steady-state values. 

A Time series (surface) settling tank profile series shows the history of a 
parameter changing over the depth of a settling tank.  This history is illustrated as a 
surface where the leading edge represents the most recent profile. 

Add a Settling Tank Profile Series 
1. In the drawing board, right-click on the settling tank element that you 

wish to create a profile series for. 

2. From the resulting popup menu, select Add to album.  Next, select 
Profile plot… from the resulting flyout.  If you are presented with the 
choice of adding the series to an existing chart, click Yes or No. 
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3. Select the Profile type. 

If you select a Current value settling tank profile: 

 
The current value settler profile series dialog 

   

1. From the Orientation radio button group, select whether you want to 
plot Concentration on X, or Concentration on Y.  In making this 
choice you are specifying whether you want the concentration of the 
parameter you are plotting on the vertical (Y) or horizontal (X) axis.  
The settling tank depth will be plotted on the axis you do not select. 

2. Select the parameter you want to plot the profile of from the State 
variables or Combined list boxes. 

3. Click the Plot selected button. 

4. From the General series gallery, choose the desired series style that 
you wish to apply.  If you want your chart to have a three-dimensional 
appearance, ensure that the box labeled 3D is checked and click OK. 

5. Click the Close button to finish. 

If you select a Time series (surface) settling tank profile: 

 
The time series (surface) settler profile series dialog 
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1. From the Orientation radio button group, select whether you want to 
plot Time on X, or Time on Z.  In making this choice you are 
specifying whether you want the time history of the parameter you are 
plotting to go along the horizontal (X) or Z (going into the screen) axis.  
Settling tank depth will be plotted on the axis you do not select, and for 
surface profiles concentration of the parameter you are plotting always 
is assigned to the vertical (Y) axis. 

2. Select the parameter you want to plot the profile of from the State 
variables or Combined list boxes. 

3. Set your Plot resolution.  If you want a fine grid, decrease the value 
in the spin edit box.  If you want a coarse grid, increase the value.  Note 
that fine grids look better, but will increase demand on system 
resources. 

4. Click the Plot selected button. 

5. Click the Close button to finish. 

Function Series 
This section gives an overview of the general concept behind a function series, 
outlines the basic procedure for adding a function series to a chart, and gives detailed 
descriptions of the function series types available in BioWin. 

A function is a series type available from the album that uses one or more existing 
series in a chart as its data source in order to perform a functional operation.  For 
example, if you have two line series ‘A' and ‘B’ and you apply the ADD function to 
those series, a third series ‘C’ will be generated which has the sum of series ‘A’ and 
‘B’ values as its data source.  Note that some of the functions available are able to 
use multiple series as inputs (e.g. the multiply function), while other functions may 
not have multiple series as inputs (e.g. the momentum function). 

Once a function series has been added to a chart, it can be formatted and manipulated 
just like a regular series.  There is one important property that distinguishes function 
series from non-function series.  That property is Period. 

Period refers to the repetition of the chosen function.  For example, say you have a 
series with data for an entire year.  The average of all points for the year will yield 
one value (the year’s average) that may be displayed as a flat line across the chart.  
The monthly average will calculate an average for each month and could be 
displayed as twelve different points across the chart of one year.  This example 
shows that different results will be calculated depending upon the period defined. 

Setting the period to a value of 0 means that all points in the series will be used and 
the function will only be calculated once.  Setting the period to a value of 1 means 
that each point in the series will be used and the function will be calculated n times 
for n points.  Setting the period to a value of 2 means that the function will be 
calculated on each successive group of two points so that the function will be 
calculated n/2 times for n points.  In general, setting the period to a value of p for n 
points means that the function will be calculated n/p times. 

Add a Function Series 
1. Right-click on the chart and click Add Series in the resulting pop-up 

menu. 
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2. On the Functions tab, click the New Function… button. 

 
The function series dialog 

   

3. Choose the function that you wish to apply from the BioWin 
Functions Gallery. 

 
The function series gallery 

   

4. From the Available list, select the series that you wish to use as the 
function series data source and move them to the Selected list in one 
of the following ways: 
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• You may move all of the series by clicking on the button marked 
with two right-pointing chevrons. 

• You may move contiguous multiple series by clicking on the first 
desired series, and while holding down the Shift key, double-
clicking the last desired series. 

• You may move non-contiguous multiple series by holding the Ctrl 
key, clicking on the desired series, and double-clicking on the last 
desired series. 

• You may move series one at a time by either double clicking on 
each series or clicking on each series and then clicking the button 
marked with one right-pointing chevron. 

You may also use all of these techniques for removing series from the 
Selected list, using the buttons marked with left-pointing chevrons. 

   

5. For certain function types, you may be presented with other options 
such as Period, Fitted Curve Order, Weighted, or Weight %.  Set 
these to the appropriate value.  For more information on these 
parameters, refer to the section regarding the specific function you have 
chosen. 

6. If you wish you may enter a name for the function series in the Series 
Name text edit area. 

7. When you are satisfied with your function series settings, click the 
Close button to finish.  At any point before this final step you may 
change the type of function you are applying using the Function drop 
list box. 

Add function 
This function adds data from one or more series. 

If only one series is defined for the add function, only values for that series will be 
used in function calculations.  For example, if you have a series ‘A’ and you apply 
the add function to it with a period of 0, then the resulting function series will be a 
flat line representing the total of all the values for series ‘A’. 

If two or more series are defined for the add function, values for all the series defined 
will be used in function calculations.  For example, if you have two series ‘A’ and 
‘B’ and you apply the add function to them, the resulting function series will be a 
line with points corresponding to the sum of each pair of ‘A’ and ‘B’ values. 

Average function 
The average function takes the numerical average of values for one or more series. 

n

Y
Y i∑=  

period defined the in points ofnumber  then where =  

If only one series is defined for the average function, only values for that series will 
be used in function calculations.  For example, if you have a series ‘A’ and you 
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apply the add function to it with a period of 0, then the resulting function series will 
be a flat line representing the average of all the values for series ‘A’. 

If two or more series are defined for the average function, values for all the series 
defined will be used in function calculations.  For example, if you have two series 
‘A’ and ‘B’ and you apply the average function to them, then the resulting function 
series will be a line with points corresponding to the average of each pair of ‘A’ and 
‘B’ values. 

Divide function 
The divide function divides data in one series by data from another series. 

This function requires at least two input series.  The second series defined for the 
function is the denominator; therefore the order in which the series are placed in the 
Selected list is important.  For example, if you have two series ‘A’ and ‘B’ defined 
for the divide function in that order, the resulting function series will be a line with 
points corresponding to the division of each pair of (‘A’ / ‘B’) values. 

If you add more than two series then the first series will be divided by the second, 
then that result is divided by the third, and so on. 

Count function 
The count function returns the number of points in an input data series.  This 
function does not apply to multiple input series.  If more than one series in placed in 
the Selected list, only the first will be used.  Note also that since the function needs 
to look at each point in the input series, no choice is given as to what the period is set 
to. 

For example, say that a series ‘A’ with 100 data points is the selected series for the 
count function.  The resulting function series will be a flat line across the chart 
originating at 100 on the vertical axis. 

Cumulative function 
The cumulative function adds each point of an input data series in succession to give 
a total cumulative value for the input series values.  Since this function needs to look 
at each data point in the input series, no choice is given as to what the period is set 
to. 

For example, say a series ‘A’ is selected for the cumulative function.  The resulting 
cumulative function series will be a line originating at the same location as the first 
point in series ‘A’ with each successive point representing the “running total” of 
series ‘A’. 

If more than one series is selected, then each point of the cumulative function 
represents the sum of the “running totals” for each series. 

Curve fit function 
The curve fit function performs a polynomial Gaussian calculation on the input 
series data and draws a smooth curve over the input series points.  Note that you are 
not asked to define a period for the curve fitting function, as the function requires 
that all points be used in order to perform a proper fit.  Also, this function does not 
apply to multiple series. 
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The “order” of a polynomial 
may also be referred to as its 
“degree”. 

You must specify the Fitted Curve Order that you wish to apply to your data.  
This is the order of the polynomial that will be fit to the data.  For example, entering 
a value of 2 for this parameter means that a quadratic polynomial will be fit to the 
data.  Entering 3 will attempt to fit a cubic polynomial, and so on.  Note that the 
maximum curve order calculated by BioWin is 15. 

Exponential average function 
This function calculates an exponentially weighted moving average according to the 
following formula: 
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High weighting factors give more weight to recent series values, and low weight 
factors give more weight to historical series points. 

High function 
The high function picks out the maximum value of one or more series. 

If two or more series are defined for the high function, values for all the series 
defined will be used in function calculations at each period point.  For example, if 
you have two series ‘A’ and ‘B’ and you apply the high function to them, then the 
resulting function series will be a line with points corresponding to the maximum of 
each pair of ‘A’ and ‘B’ values. 

Low function 
The low function picks out the minimum value of one or more series. 

If two or more series are defined for the low function, values for all the series 
defined will be used in function calculations at each period point.  For example, if 
you have two series ‘A’ and ‘B’ and you apply the low function to them, then the 
resulting function series will be a line with points corresponding to the minimum of 
each pair of ‘A’ and ‘B’ values. 

Momentum function 
The momentum function subtracts the first value from the last value over a defined 
period.  This function only applies to a single input series.  You may find that this 
function is especially useful for steady state analysis. When a system is at steady 
state, the momentum function over a defined period (e.g. 1 day) for a compound (e.g. 
TSS) should be close to zero. 

For example, if you are running a simulation at an initial Solids Retention Time 
(SRT) and you make a step change to the SRT by changing your wastage rate, the 
system will need about 3-4 SRTs to return to steady state.  You can use the 
momentum function to indicate when your system has returned to steady state. 
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Initially after the change in SRT, you will notice the momentum function move away 
from zero. As the system returns to steady state, you should see the momentum 
function return to zero. 

Moving average function 
A p period moving average function provides a calculated average value for the 
current and preceding (p-1) points according to the following formula: 
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You also are given the option to calculate a weighted moving average, according to 
the following formula: 
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In contrast to the ordinary moving average where all of the preceding data points are 
weighted equally, for the weighted average the most recent points are weighted more 
heavily and on the basis of the value of X rather than on the number of points.  This 
may be useful for calculating a moving average on imported data series in which the 
X values are not evenly spaced. 

Multiply function 
The multiply function multiplies data for as many series as you like. 

If two or more series are defined for the multiply function, values for all the series 
defined will be used in function calculations.  For example, if you have two series 
‘A’ and ‘B’ and you apply the multiply function to them, then the resulting function 
series will be a line with points corresponding to the product of each pair of ‘A’ and 
‘B’ values. 

Subtract function 
The subtract function subtracts data in one series from another series. 
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This function requires two input series.  The second series defined for the function 
will be subtracted from the first, so the order in which the source series are placed in 
the Selected list is important.  For example, if you have two series ‘A’ and ‘B’ 
defined for the subtract function in that order, the resulting function series will be a 
line with points corresponding to the subtraction of each pair of ‘A’ and ‘B’ values. 

Trend function 
The trend function fits a best fit trend line to data points.  This function does not 
apply to multiple series, so if more than one series is placed in the Selected list, a 
trend line will be fit to the first in the list.  Also, since this function requires that each 
point in the input data series be used, no choice is given as to what the period may 
be. 
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Chart Formatting Procedures 

Chart Formatting Note 
One of BioWin’s helpful charting features is that changes you make to a chart are 
displayed “on the fly” as you make them.  This is an excellent way to learn the 
functionality of the chart editing/formatting controls since you immediately see the 
results of clicking various buttons, spin edit boxes, and other dialog box controls in 
the background.  The associations between dialog controls and their resultant 
changes to the chart are learned much more quickly than if you have to exit the 
dialog or manually apply the changes before you see their effects. 

In many instances entering a value of "0" in a chart formatting field means that 
BioWin will resort to a default value for the selected property (eg. the increment of 
an axis scale). 

Chart Axis Procedures 
This section outlines the basic procedure you need to know in order to change and 
manipulate chart axis properties, and also gives a number of specific related 
procedures.  The section is structured such that the order of its sub-topics follows the 
order of the sub-tabs on the Edit Axes main tab. 

The key is to understand the use of the Axes list box.  In general, most axis 
manipulations are done via the following procedure: 

   

1. Right-click on the chart to open the Edit menu, and then click Edit 
Axes. 

2. Select the axis (i.e. Left, Right, Top, Bottom) that you want to 
change with the Axes list. 

3. Select one of the four sub-tabs to change general axis properties such as 
Scale, Titles, etc. 

4. Make the desired specific changes to the axis you have specified using 
the options on the sub-tabs. 

Next, some procedures that may be accessed directly from the Edit Axis main tab 
will be outlined. 
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Axis editor tab and sub-tabs 

Remove a Chart Axis 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Axes. 

2. In the Axes list, select the axis you want to remove. 

3. Un-check the box labeled Visible. 

4. Click the Close button to finish. 

Note:  To remove another axis, repeat steps 1-3. 

Axis Scale Procedures 
This section contains procedures that can be executed from the Scale sub-tab of the 
Edit Axes tab.  The topics all are related to controlling the numerical properties of 
the chart axes such as scale increment, scale maximum and minimums, and the type 
of axis (i.e. logarithmic, inverted). 
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The axis scale editor sub-tab 

Set Axis Scale Maximum and Minimum Values 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Axes. 

2. Select the axis you wish to set scale maximum and/or minimum values 
for using the Axes list. 

3. If you want BioWin to set the scale maximum and minimum 
automatically, check the box labeled Automatic and go to step 8.  If 
you want to manually set one or both of the values, go to Step 4. 

4. Un-check the box labeled Automatic. 

5. Uncheck Auto button for the value (i.e. maximum or minimum) you 
wish to manually set and click the Change button. 

6. Enter your desired value in the resulting dialog box and click OK. 

• If you have set the axis to Date/Time Format, then the dialog box 
will allow you to set the desired maximum or minimum in 
date/time formats. 

7. If you would like to set the remaining value (i.e. maximum or 
minimum) manually, repeat Step 5.  To have BioWin automatically set 
the remaining value, check the box labeled Auto for that value. 

8. Click the Close button to finish. 

Note:  If you do not see the series you expect to when you first look at a chart, 
check the box labeled Automatic to ensure that all series are contained within the 
axes boundaries. 

Set Axis Scale Increment 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Axes. 
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2. Select the axis you wish to set scale increment for using the Axes list. 

3. Click the Change... button. 

4. Enter your desired increment in the resulting dialog box and click OK. 

• If you have set the axis to Date/Time Format, then the dialog box 
will allow you to set the desired increment in time units. 

5. Click the Close button to finish. 

Note : Entering a value of "0" in the Axis Increment field will result in BioWin 
determining the axis increment automatically. 

Set Axis Scale Type 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Axes. 

2. Select the axis you wish to set the scale type for using the Axes list. 

• If you want the selected axis to have a logarithmic scale, check the 
box labeled Logarithmic. 

• If you want the axis scale inverted (i.e. minimum value at the top 
of a vertical axis), check the box labeled Inverted. 

3. Click the Close button to finish. 

Axis Title Procedures 
This section contains procedures that can be executed from the Title sub-tab of the 
Edit Axes tab.  The topics covered all are related to creating and formatting chart 
axis titles, including adding a title, changing the axis title font, changing the axis title 
area size, and changing the axis title angle. 

 
The axis title editor sub-tab 
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Add an Axis Title 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Axes. 

2. Select the axis you wish to add a title to using the Axes list. 

3. Click the Title sub-tab. 

4. In the text edit area labeled Title, enter the text for your title. 

5. Click the Close button to finish. 

Change the Axis Title Area Size 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Axes. 

2. Select the axis you wish to change the title area size for using the Axes 
list. 

3. Click the Title sub-tab. 

4. If you have not already done so, enter the text for your title in the text 
edit area labeled Title. 

5. Click the spin edit box labeled Size to change the title area size by 1-
point increments, or enter a value using the keyboard. 

6. Click the Close button to finish. 

Note : Entering a value of "0" in the Axis Title Area Size field will result in BioWin 
determining the size automatically. 

Change the Axis Title Angle 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Axes. 

2. Select the axis you wish to change the title angle for using the Axes 
list. 

3. Click the Title sub-tab. 

4. If you have not already done so, enter the text for your title in the text 
edit area labeled Title. 

5. Click the spin edit box labeled Angle to change the title angle by 90-
degree increments, or enter a value using the keyboard. 

6. Click the Close button to finish. 
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Change the Axis Title Font 

 
The axis title text editor sub-tab 

   

1. Right-click on the chart to open the Edit menu, and then click Edit 
Axes. 

2. Select the axis you wish to change the title font for using the Axes list. 

3. Click the Title sub-tab. 

4. If you have not already done so, enter the text for your title in the text 
edit area labeled Title. 

5. Click the Text sub-tab to display the font properties. 

6. Click the Font… button to display the Font Properties dialog box and 
select the Font (e.g. Arial, Times New Roman, etc), the Font Style 
(e.g. Italic, Bold, etc.), Size, and Color until the Sample Text has 
the appearance you want. 

7. Click the OK button to close the Font Properties dialog box. 

8. Click the Color button in the Shadow… group to display the Color 
dialog box and select from the Basic Colors to add a shadow to your 
text if desired. 

9. Click the OK button to close the Color dialog box. 

10. Click the spin edit boxes to adjust the horizontal and vertical aspects of 
the shadow or enter a value from the keyboard. 

11. Click the Inter-char spacing spin edit box to adjust the character 
spacing or enter a value from the keyboard. 

12. Click the Close button to finish. 
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Change the Axis Title Border 

 
The axis title border editor dialog box 

   

1. Right-click on the chart to open the Edit menu, and then click Edit 
Axes. 

2. Select the axis you wish to change the title font for using the Axes list. 

3. Click the Title sub-tab. 

4. If you have not already done so, enter the text for your title in the text 
edit area labeled Title. 

5. Click the Text sub-tab to display the font properties. 

6. Click the Outline… button to display the Border Editor dialog box and 
select the Style, Color and Width of border you require around the 
title. 

7. Click the OK button to close the Border Editor dialog box. 

8. Click the Close button to finish. 

 

Axis Label Procedures 
This section contains procedures that can be executed from the Labels sub-tab of 
the Edit Axes tab.  The topics covered include procedures for changing the axis 
label font, position, and style. 
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The tick labels editor sub-tab 

   

Change the Axis Label Options 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Axes. 

2. Select the axis you wish to change the label font for using the Axes 
list. 

3. Click the Labels sub-tab. 

4. Ensure that the box labeled Visible is checked. 

5. Click the spin edit box labeled Size to change the amount of space 
between the title and the axes labels by 1-point increments, or enter a 
value using the keyboard. 

7. Click the spin edit box labeled Angle to change the label angle by 90-
degree increments, or enter a value using the keyboard. 

8. Click the spin edit box labeled Min Separation % to change the 
space between axis labels in 10 percent increments, or enter a value 
using the keyboard. 

9. Check the box labeled Multi-line to word wrap your axis label. 

10. Check the box labeled Round First to round multi-decimal labels to 
one decimal point.  Note this option only works with certain styles (eg. 
Auto and Value). 

11. Check the box labeled Label on Axis to include or exclude the first 
and last axis labels. 

12. Click the Close button to finish. 
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Change the Axis Label Style 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Axes. 

2. Select the axis you wish to change the label font for using the Axes 
list. 

3. Click the Labels sub-tab. 

4. Ensure that the box labeled Visible is checked. 

5. Use the radio buttons in the area labeled Style to adjust the display of 
the axis values (eg. Text, Label, Value). 

6. Click the Close button to finish. 

Change the Axis Label Format 

 
The axis label format dialog box 

   

1. Right-click on the chart to open the Edit menu, and then click Edit 
Axes. 

2. Select the axis you wish to change the label font for using the Axes 
list. 

3. Click the Labels sub-tab. 

4. Ensure that the box labeled Visible is checked. 

5. Click the Format sub-tab. 

6. Use the drop-down list labeled Values Format to adjust the display of 
the axis values or see the sections BioWin Number Formats and 
BioWin Date / Time Formats. 

7. Click the Close button to finish. 
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BioWin Number Formats 
This section contains an overview of the various number formats that are available in 
BioWin.  Although this information is applicable elsewhere, it has been included 
here since it will most likely be needed in relation to chart axis labeling. 

Specifier Description 
0 Digit placeholder.  If the value being formatted has a digit in the 

position where the ‘0’ appears in the format string, then that digit is 
copied to the output string.  Otherwise, a ‘0’ is stored in that position in 
the output string. 

# Digit placeholder.  If the value being formatted has a digit in the 
position where the ‘#’ appears in the format string, then that digit is 
copied to the output string.  Otherwise nothing is stored in that position 
in the output string. 

. Decimal point.  The first ‘.’ character in the format string determines the 
location of the decimal separator in the formatted value; any additional 
‘.’ characters are ignored.  The actual character used as a decimal 
separator in the output string is specified in the Number Format of the 
International section of the Windows Control Panel. 

, Thousand separator.  If the format string contains one or more ‘,’ 
characters, the output will have thousand separators inserted between 
each group of three digits to the left of the decimal point.  The 
placement and number of ‘,’ characters in the format string does not 
affect the output, except to indicate that thousand separators are wanted.  
The actual character used as a thousand separator in the output string is 
specified in the Number Format of the International section of the 
Windows Control Panel. 

E+ Scientific notation.  If any of the strings ‘E+’, ‘E-’, ‘e+’, or ‘e-’ are 
contained in the format string, the number is formatted using scientific 
notation.  A group of up to four ‘0’ characters can immediately follow 
the ‘E+’, ‘E-’, ‘e+’, or ‘e-’ to determine the minimum number of digits 
in the exponent.  The ‘E+’ or ‘e+’ formats cause a plus sign to be output 
for positive exponents and a minus sign to be output for negative 
exponents.  The ‘E-’ and ‘e-’ formats output a sign character only for 
negative exponents. 

'xx'/"xx" Characters enclosed in single or double quotes are output as-is, and do 
not affect formatting. 

; Separates sections for positive, negative, and zero numbers in the format 
string. 

The locations of the leftmost ‘0’ before the decimal point in the format string and the 
rightmost ‘0’ after the decimal point in the format string determine the range of 
digits that are always present in the output string. 

The number being formatted is always rounded to as many decimal places as there 
are digit placeholders (‘0’ or ‘#’) to the right of the decimal point.  If the format 
string contains no decimal point, the value being formatted is rounded to the nearest 
whole number. 

If the number being formatted has more digits to the left of the decimal separator that 
there are digit placeholders to the left of the ‘.’ character in the format string, the 
extra digits are output before the first digit placeholder. 

To allow different formats for positive, negative, and zero values, the format string 
can contain between one and three sections separated by semicolons: 

   

1. One section:  The format string applies to all values; 
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2. Two sections:  The first section applies to positive values and zeros, 
and the second section applies to negative values; 

3. Three sections:  The first section applies to positive values, the second 
applies to negative values, and the third section applies to zeros. 

If the section for negative values or the section for zero values is empty, that is there 
is nothing between the semicolons that delimit the section, the section for the 
positive values is used instead. 

If the section for positive values is empty, or if the entire format string is empty, the 
value is formatted using general floating-point formatting with 15 significant digits.  
General floating-point formatting is also used if the value has more than 18 digits to 
the left of the decimal point and the format string does not specify scientific notation.  

The following table shows some sample formats and the results produced when the 
formats are applied to different values: 

Format String 1234 -1234 0.5 0 
None Specified 1234 -1234 0.5 0 
0 1234 -1234 1 0 
0.00 1234.00 -1234.00 0.50 0.00 
#.## 1234 -1234 .5  
#,##0.00 1,234.00 -1,234.00 0.50 0.00 
#,##0.00;(#,##0.00) 1,234.00 (1,234.00) 0.50 0.00 
#,##0.00;;Zero 1,234.00 -1,234.00 0.50 Zero 
0.000E+00 1.234E+03 -1.234E+03 5.000E-01 0.000E+00 
#.###E-0 1.234E3 -1.234E3 5E-1 0E0 

BioWin Date / Time Formats 
This section contains an overview of the various date/time formats that are available 
in BioWin.  Although this information is applicable elsewhere, it has been included 
here since it will most likely be needed in relation to chart axis labeling. 

Specifier Description 
C Displays the date followed by the time. 
D Displays the day as a number without a leading zero (1-31). 
dd Displays the day as a number without a leading zero (01-31). 
ddd Displays the day as an abbreviation (Sat-Sun). 
dddd Displays the day as a full name (Saturday-Sunday). 
ddddd Displays the date in a short format. 
dddddd Displays the date in a long format. 
M Displays the month as a number without a leading zero (1-12).  If the 

‘m’ specifier immediately follows an ‘h’ or ‘hh’ specifier, the minute 
rather than the month is displayed. 

mm Displays the month as a number with a leading zero (01-12).  If the 
‘mm’ specifier immediately follows an ‘h’ or ‘hh’ specifier, the minute 
rather than the month is displayed. 

mmm Displays the month as an abbreviation (Jan-Dec). 
mmmm Displays the month as a full name (January-December). 
yy Displays the year as a two-digit number (00-99). 
yyyy Displays the year as a four-digit number (0000-9999). 
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H Displays the hour as a number without a leading zero (0-23). 
hh Displays the hour as a number with a leading zero (00-23). 
N Displays the minute as a number without a leading zero (0-59). 
nn Displays the minute as a number with a leading zero (00-59). 
S Displays the second as a number without a leading zero (0-59). 
ss Displays the second as a number with a leading zero (00-59). 
T Displays the time using a short format. 
Tt Displays the time using a long format. 
am/pm Uses the 12-hour clock for the preceding ‘h’ or ‘hh’ specifier, and 

displays ‘am’ for any hour before noon, and ‘pm’ for any hour after 
noon.  The am/pm specifier can use lower, upper, or mixed case, and the 
result is displayed accordingly. 

a/p Uses the 12-hour clock for the preceding ‘h’ or ‘hh’ specifier, and 
displays ‘a’ for any hour before noon, and ‘p’ for any hour after noon. 

Ampm Uses the 12-hour clock for the preceding ‘h’ or ‘hh’ specifier, and 
displays a default am string for any hour before noon, and a default pm 
string for any hour after noon. 

/ Displays the date separator character. 
: Displays the time separator character. 
'xx'/"xx" Characters enclosed in single or double quotes are displayed as-is, and 

do not affect formatting. 

Format specifiers may be written in upper case as well as lower case letters - both 
produce the same result. 

If the string given by the format parameter is empty, the date and time is formatted as 
if a ‘c’ format specifier had been given. 

 

Change the Axis Label Font 

 
The axis label text editor dialog box 
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1. Right-click on the chart to open the Edit menu, and then click Edit 
Axes. 

2. Select the axis you wish to change the label font for using the Axes list 

3. Click the Labels sub-tab. 

4. Ensure that the box labeled Visible is checked. 

5. Click the Text sub-tab to display the font properties. 

6. Click the Font… button to display the Font Properties dialog box and 
select the Font (e.g. Arial, Times New Roman, etc), the Font Style 
(e.g. Italic, Bold, etc.), Size, and Color until the Sample Text has 
the appearance you want. 

7. Click the OK button to close the Font Properties dialog box. 

8. Click the Color button in the Shadow… group to display the Color 
dialog box and select from the Basic Colors to add a shadow to your 
text if desired. 

9. Click the OK button to close the Color dialog box. 

10. Click the spin edit boxes to adjust the horizontal and vertical aspects of 
the shadow or enter a value from the keyboard. 

11. Click the Inter-char spacing spin edit box to adjust the character 
spacing or enter a value from the keyboard. 

12. Click the Close button to finish. 

Change the Axis Label Border 

 
The axis title border editor dialog box 

   

1. Right-click on the chart to open the Edit menu, and then click Edit 
Axes. 

2. Select the axis you wish to change the title font for using the Axes list. 

3. Click the Label sub-tab. 

4. If you have not already done so, enter the text for your title in the text 
edit area labeled Axis Title. 

5. Click the Text sub-tab to display the font properties. 

6. Click the Outline… button to display the Border Editor dialog box and 
select the Style, Color and Width of border you require around the 
title. 

7. Click the OK button to close the Border Editor dialog box. 
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8. Click the Close button to finish. 

Tick Formatting Procedures 
This section contains procedures that can be executed from the Tick Formats sub-
tab of the Edit Axes tab.  The topics covered include procedures for specifying the 
appearance of the chart axes, grid, and axes ticks. 

 
The tick formatting editor sub-tab 

Change the Chart Axis Formatting 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Axes. 

2. Select the axis you wish to change the formatting for using the Axes 
list. 

3. Click the Ticks sub-tab. 

4. Click the Axis... button to open the border color editor. 

5. Make sure that the box labeled Visible is checked. 

6. Select the axis width you want from the Width spin edit box. 

7. To change the axis color, select the Color... button to open the color 
selection dialog box. 

8. Click on the axis color you want and then click OK to close the color 
selection dialog box. 

9. Click OK to close the border editor. 

10. Click the Close button to finish. 
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Change the Chart Major Grid Formatting 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Axes. 

2. Select the axis you wish to change the formatting for using the Axes 
list. 

3. Click the Ticks sub-tab. 

4. Click the Grid... button to open the border editor. 

5. Make sure that the box labeled Visible is checked. 

6. Select the grid style you want from the Style drop-down list. 

7. Select the grid width you want from the Width spin edit box. 

8. To change the grid color, select the Color... button to open the color 
selection dialog box. 

9. Click on the grid color you want and then click OK to close the color 
selection dialog box. 

10. Click OK to close the border editor. 

11. Click the Close button to finish. 

Change the Axis Major Tick Formatting 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Axes. 

2. Select the axis you wish to change the formatting for using the Axes 
list. 

3. Click the Ticks sub-tab. 

4. Click the Ticks... button to open the border editor. 

5. Make sure that the box labeled Visible is checked. 

6. Select the major tick style you want from the Style drop-down list. 

7. Select the major tick width you want from the Width spin edit box. 

8. To change the major tick color, select the Color... button to open the 
color selection dialog box. 

9. Click on the major tick color you want and then click OK to close the 
color selection dialog box. 

10. Click OK to close the border color editor. 

11. If you only want the major ticks where labels are, ensure that the box 
labeled At Labels Only is checked. 

12. If you want to increase the size of the major ticks, use the Len spin edit 
box. 

13. Click the Close button to finish. 

Change the Axis Inner Tick Formatting 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Axes. 
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2. Select the axis you wish to change the formatting for using the Axes 
list. 

3. Click the Ticks sub-tab. 

4. Click the Inner... button to open the border editor. 

5. Make sure that the box labeled Visible is checked. 

6. Select the major tick style you want from the Style drop-down list. 

7. Select the major tick width you want from the Width spin edit box. 

8. To change the major tick color, select the Color... button to open the 
color selection dialog box. 

9. Click on the major tick color you want and then click OK to close the 
color selection dialog box. 

10. Click OK to close the border editor. 

11. If you only want the major ticks where labels are, ensure that the box 
labeled At Labels Only is checked. 

12. If you want to increase the size of the major ticks, use the Len spin edit 
box. 

13. Click the Close button to finish. 

Change the Axis Minor Tick Formatting 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Axes. 

2. Select the axis you wish to change the formatting for using the Axes 
list. 

3. Click the Minor sub-tab. 

4. Click the Ticks... button to open the border editor. 

5. Make sure that the box labeled Visible is checked. 

6. Select the minor tick style you want from the Style drop-down list. 

7. Select the minor tick width you want from the Width spin edit box. 

8. To change the minor tick color, select the Color... button to open the 
color selection dialog box. 

9. Click on the minor tick color you want and then click OK to close the 
color selection dialog box. 

10. Click OK to close the border editor. 

11. If you only want the minor ticks where labels are, ensure that the box 
labeled At Labels Only is checked. 

12. If you want to increase the size of the minor ticks, use the Length spin 
edit box. 

13. If you want to increase the number of minor ticks, use the Count spin 
edit box. 

14. Click the Close button to finish. 
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Change the Chart Minor Grid Formatting 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Axes. 

2. Select the axis you wish to change the formatting for using the Axes 
list. 

3. Click the Minor sub-tab. 

4. Click the Grid... button to open the border editor. 

5. Make sure that the box labeled Visible is checked. 

6. Select the grid style you want from the Style drop-down list. 

7. Select the grid width you want from the Width spin edit box. 

8. To change the grid color, select the Color... button to open the color 
selection dialog box. 

9. Click on the grid color you want and then click OK to close the color 
selection dialog box. 

10. Click OK to close the border editor. 

11. Click the Close button to finish. 

 

Chart Title Procedures 
This section contains procedures that can be executed from the Edit Title tab.  Note 
that in BioWin charting terminology, a chart title may be either a Title at the top of 
the chart, or Footer at the bottom of the chart.  It is possible to have both on the same 
chart, as well as a Subtitle and Subfooter.  This section includes procedures for 
adding a chart title, changing a title’s font and alignment, adding a frame to a title, 
and adding a fill pattern, gradient or shadow to the title frame. 
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The chart title style editor tab 

Add a Chart Title 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Titles. 

2. If you want the title above the chart, select Title in the drop list box.  If 
you want the title below the chart, select Foot. 

3. Ensure that the box labeled Visible is checked. 

4. In the Text edit area; change the default text to the title you desire. 

5. Click the Close button to finish. 

Note:  If no chart title is desired, un-check the box labeled Visible.  If titles above 
and below the chart are desired, perform the above procedure twice, i.e. once for the 
Title and once for the Foot.  A Subtitle and Subfooter can be added in the same 
way. 

Change the Chart Title Alignment 
1. Specify which title you want to change in the drop-down list box. 

2. In the Alignment radio button group select Left, Center, or Right. 
3. Click the Close button to finish. 

Change the Chart Title Position 

 
The chart title position editor tab 

   

1. Specify which title you want to change in the drop-down list box. 

2. Select the Position sub-tab. 

3. Check the Custom box. 
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4. Adjust the Left and Top measurements by clicking the spin edit boxes 
or type in a value from the keyboard. 

5. Click the Close button to finish. 

Add a Frame to the Chart Title 

 
The chart title format editor tab 

   

1. Specify which title you want to change in the drop-down list box. 

2. Select the Format sub-tab. 

3. Make sure that the Transparent check box is unchecked. 

4. Click the Frame... button to open the border editor. 

5. Make sure that the box labeled Visible is checked. 

6. Select the frame style you want from the Style drop-down list. 

7. Select the frame width you want from the Width spin edit box. 

8. To change the frame color, select the Color... button to open the color 
selection dialog box. 

9. Click on the frame color you want and then click OK to close the color 
selection dialog box. 

10. Click OK to close the border editor. 

11. Click the Close button to finish. 
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Add a Fill Pattern and Color to a Chart Title Frame 

 
The pattern color editor dialog box 

   

1. Specify which title you want to change in the drop-down list box. 

2. Select the Format sub-tab. 

3. Click the Pattern... button to open the fill pattern editor. 

4. Select the fill style you want from the list box. 

5. To change the fill color, select the Color... button to open the color 
selection dialog box. 

6. Click on the color you want and then click OK to close the color 
selection dialog box. 

7. Click OK to close the fill pattern editor. 

8. Click the Close button to finish. 

Add an Image to a Chart Title Frame 
1. Specify which title you want to change in the drop-down list box. 

2. Select the Format sub-tab. 

3. Click the Pattern... button to open the fill pattern editor. 

4. To add an image, select the Browse... button to open the file selection 
dialog box. 

5. Choose the graphic image you want and then click OK to close the file 
selection dialog box. 

6. Click OK to close the fill pattern editor. 

7. Click the Close button to finish. 
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Change the Chart Title Font Properties 

 
The chart title text editor tab 

   

1. Specify which title you want to change in the drop-down list box. 

2. Click the Text sub-tab to display the font properties. 

3. Click the Font… button to display the Font Properties dialog box and 
select the Font (e.g. Arial, Times New Roman, etc), the Font Style 
(e.g. Italic, Bold, etc.), Size, and Color until the Sample Text has 
the appearance you want. 

4. Click the OK button to close the Font Properties dialog box. 

5. Click the Color button in the Shadow… group to display the Color 
dialog box and select from the Basic Colors to add a shadow to your 
text if desired. 

6. Click the OK button to close the Color dialog box. 

7. Click the spin edit boxes to adjust the horizontal and vertical aspects of 
the shadow or enter a value from the keyboard. 

8. Click the Inter-char spacing spin edit box to adjust the character 
spacing or enter a value from the keyboard. 

9. Click the Close button to finish. 
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Add a Gradient to a Chart Title Frame 

 
The chart title gradient editor tab 

   

1. Specify which title you want to change in the drop-down list box. 

2. Select the Gradient sub-tab. 

3. Ensure the Visible box is checked. 

4. Select a direction (eg. Left Right, Top Bottom) for the gradient from 
the Direction drop-down list. 

5. In the Colors section of the dialog box, use the Start, Middle and 
End buttons to select the colors for the gradient.  If no middle color is 
required, check the No Middle box. 

6. To reverse the start and end colors, use the Swap button. 

7. Click the Close button to finish. 

Note : In order see the gradient you must make sure that the Transparent check 
box on the Format tab is unchecked. 
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Add an Shadow to a Chart Title Frame 

 
The chart title shadow editor tab 

   

1. Specify which title you want to change in the drop-down list box. 

2. Select the Shadow sub-tab. 

3. Click the Color button to display the Color dialog box and select from 
the Basic Colors to add a shadow to your text if desired. 

4. Click the OK button to close the Color dialog box. 

5. Click the Size spin edit box to adjust the depth of the shadow or enter a 
value from the keyboard. 

6. Click the Close button to finish. 

 

Chart Legend Procedures 
This section contains topics covering procedures that can be executed from the Edit 
Legend tab.  The procedures outlined include a variety of chart legend formatting 
options such as outlines, three-dimensional appearance, position and fonts.  The list 
below contains some general legend tips: 

   

• To have no legend, un-check the box labeled Visible. 

• To reverse the order in which series are placed in the legend, check the 
box labeled Inverted. 

• To add check boxes beside each item in the legend, check the box 
labeled Check boxes. 
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• To change the color of the text in the legend to match the series in the 
graph, check the box labeled Font Series Color. 

 
The chart legend style editor tab 

Legend Styles 
This section gives descriptions of the various legend styles that may be applied to 
chart legends in BioWin.  Generally, the Automatic style is the Legend Style best 
suited for most series types. 

There are two attributes that control the appearance of legends in BioWin.  The 
Legend Style determines the possible content of the legend.  The Text Style 
determines the layout of the legend content.  The table below describes the possible 
legend styles. 

Style Description 

Automatic 
Generally, if there is only one series on your chart, this style is 
will show the series values.  If there are two or more series, 
this style will show the names of the various series. 

Series Names Shows the names of all series in a chart.  Since only names are 
shown in the legend, Text Styles do not apply. 

Series Values The legend shows information for only the first series in the 
chart. 

Last Values The legend shows information for the last point of each series 
in the chart. 

Tip:  To control the numeric format of your legend entries, change the series Label 
Number Format.  To do this: 

   
1. Right-click the chart and select Edit Series. 

2. From the series drop list box, select the series corresponding to the 
legend entry you want to change the numeric formatting of. 
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3. Click on the Series tab. 

4. Click on the General sub-tab 

5. In the Formats group, change the Values or Percents formatting to 
the style you want. 

6. Click OK to finish. 

Legend Text Styles 
This section gives examples of the various legend text styles that may be applied to 
BioWin chart legends.  The table below provides a simple example of the available 
legend text styles. 

Style Example 
Plain Unaerated 
Right Value Unaerated 37, 970.173 
Left Value 37, 970.173 Unaerated 
Right Percent Unaerated 26.6 %  
Left Percent 26.6 % Unaerated 
X Value 0 
Value 37, 970.173 
Percent 26.6 % 
X and Value 0 37, 970.173 
X and Percent 0 26.6 % 

For example, consider the process mass plot shown below.  The legend shown in this 
picture has the Left Percent legend text style applied. 

 
Process mass plot with Left Percent Legend Text Style applied to legend 

Some of the legend text styles mentioned above refer to series "points".  In BioWin 
charts, a point can refer to a bar of a bar series, or a pie slice of a pie series.  Note 
that time series (e.g. Line and point series) points do not have names. 
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Tip:  To control the numeric format of your legend entries, change the series Label 
Number Format.  To do this: 

   
1. Right-click the chart and select Edit Series. 

2. From the series drop list box, select the series corresponding to the 
legend entry you want to change the numeric formatting of. 

3. Click on the Series tab. 

4. Click on the General sub-tab 

5. In the Formats group, change the Values or Percents formatting to 
the style you want. 

6. Click OK to finish. 

Note:  When you apply a Legend Text Style that involves percent, the individual 
point percentages are calculated as follows.  The total sum of the point values is 
calculated.  Then each individual point percentage is calculated by dividing the point 
value by the total sum of the points. 

Change the Chart Legend Vertical Spacing 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Legend. 

2. Select the legend spacing you want from the Vert Spacing spin edit 
box. 

3. Click the Close button to finish. 

Add Dividing Lines to a Legend 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Legend. 

2. Click the Dividing Lines... button to open the border editor. 

3. Make sure that the box labeled Visible is checked. 

4. Select the dividing line style you want from the Style drop-down list 

5. Select the dividing line width you want from the Width spin edit box. 

6. To change the dividing line color, select the Color... button to open the 
color selection dialog box. 

7. Click on the dividing line color you want and then click OK to close 
the color selection dialog box. 

8. Click OK to close the border editor. 

9. Click the Close button to finish. 
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Change the Legend Position 

 
Chart legend position dialog box 

   

1. Right-click on the chart to open the Edit menu, and then click Edit 
Legend. 

2. Click the Position sub-tab. 

3. Make sure that the box labeled Resize Chart is checked, so that the 
chart will reposition itself according to the legend position you select. 

4. In the Position group, use the radio buttons to choose Left, Right, 
Top or Bottom. 

5. Adjust the amount of space between the legend and the chart using the 
Margin spin edit box. 

6. Fine-tune the position of the legend using the Position Offset % spin 
edit box. 

7. Set up a custom location by checking the box labeled Custom and 
adjusting the Left and Top spin edit boxes. 

8. Click the Close button to finish. 
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Change the Appearance of Legend Symbols 

 
Chart legend symbols dialog box 

   

1. Right-click on the chart to open the Edit menu, and then click Edit 
Legend. 

2. Click the Symbols sub-tab. 

3. Adjust the size of the legend symbols using the Width spin edit box. 

4. Choose between Percent and Pixels in the Width Units drop-down 
list. 

5. Position the symbols on the Left or Right of the legend text with the 
Position drop-down list. 

6. Remove the space between symbols by checking the box labeled 
Continuous.  Note this option is only effective if the legend is located 
on the left or right of the chart. 

7. Click the Close button to finish. 
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Change the Chart Legend Color and Pattern 

 
Chart legend format dialog box 

   

1. Right-click on the chart to open the Edit menu, and then click Edit 
Legend. 

2. Click the Format sub-tab. 

3. Select the Color... button to open the color selection dialog box. 

4. Click on the legend background color you want and then click OK to 
close the color selection dialog box. 

5. If a background pattern is required, select the Pattern… button to 
open the pattern color editor dialog box. 

6. Select the fill style you want from the list box. 

7. To change the fill color, select the Color... button to open the color 
selection dialog box. 

8. Click on the color you want and then click OK to close the color 
selection dialog box. 

9. Click OK to close the pattern color editor. 

10. Click the Close button to finish. 
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Add a Frame to the Chart Legend 

 
Border editor dialog box 

   

1. Right-click on the chart to open the Edit menu, and then click Edit 
Legend. 

2. Click the Format sub-tab. 

3. Select the Frame... button to open the border editor dialog box. 

4. Make sure that the box labeled Visible is checked. 

5. Select the frame style you want from the Style drop-down list. 

6. Select the frame width you want from the Width spin edit box. 

7. To change the frame color, select the Color... button to open the color 
selection dialog box. 

8. Click on the frame color you want and then click OK to close the color 
selection dialog box. 

9. Click OK to close the border editor. 

10. If a rounded box is required, check the box labeled Round Frame. 

11. If a three-dimensional effect is required, select Raised or Lowered 
from the Bevel drop-down list.  The depth of this effect can be 
adjusted with the Size spin edit box. 

12. Click the Close button to finish. 
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Change the Chart Legend Font 

 
Chart legend text dialog box 

   

1. Right-click on the chart to open the Edit menu, and then click Edit 
Legend. 

2. Click the Text sub-tab. 

3. Click the Font... button to open the font properties dialog box. 

4. Specify the Font (e.g. Arial, Times New Roman, etc), the Font Style 
(e.g. Italic, Bold, etc.), Size, and Color until the Sample Text has 
the appearance you want. 

5. Click the OK button to close the font properties dialog box. 

6. Click the Color button in the Shadow… group to display the Color 
dialog box and select from the Basic Colors to add a shadow to your 
text if desired. 

7. Click the OK button to close the Color dialog box. 

8. Click the spin edit boxes to adjust the horizontal and vertical aspects of 
the shadow or enter a value from the keyboard. 

9. Click the Inter-char spacing spin edit box to adjust the character 
spacing or enter a value from the keyboard. 

10. Click the Close button to finish. 
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Add a Color Gradient to the Chart Legend 

 
Chart legend gradient dialog box 

   

1. Right-click on the chart to open the Edit menu, and then click Edit 
Legend. 

2. Select the Gradient sub-tab. 

3. Ensure the Visible box is checked. 

4. Select a direction (eg. Left Right, Top Bottom) for the gradient from 
the Direction drop-down list. 

5. In the Colors section of the dialog box, use the Start, Middle and 
End buttons to select the colors for the gradient.  If no middle color is 
required, check the No Middle box. 

6. To reverse the start and end colors, use the Swap button. 

7. Click the Close button to finish. 
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Add a Shadow to the Chart Legend 

 
Chart legend shadow dialog box 

   

1. Right-click on the chart to open the Edit menu, and then click Edit 
Legend. 

2. Select the Shadow sub-tab. 

3. Click the Color button to display the Color dialog box and select from 
the Basic Colors to add a shadow to your text if desired. 

4. Click the OK button to close the Color dialog box. 

5. Click the Size spin edit box to adjust the depth of the shadow or enter a 
value from the keyboard. 

6. Click the Close button to finish. 

Other Chart Options and Procedures 
This section consists of procedures and options that change the general appearance of 
charts.  All of these procedures can be executed after right clicking on the chart to 
open the Edit menu, then clicking Edit Options. 

Chart Options 
This section consists of procedures that can be executed from the Chart tab of the 
Edit Options menu choice. 
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Change the Series Order 

 
Chart series options dialog box 

   

1. Right-click on the chart to open the Edit menu, and then click Edit 
Options. 

2. Select the Series tab. 

3. Click on the series that needs to be moved in the series list. 

4. Click the  or  button to change the order of the selected item in 
the list. 

5. Click the Close button to finish. 

Note:  Use the check boxes beside the series to temporarily remove them from the 
chart display.  This dialog box can also be used to Delete the selected series and edit 
the Title… text. 

Change the Series Type 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Series tab. 

3. Click on the series that needs to be changed in the series list. 

4. Click the Change… button to display the general series gallery dialog 
box. 
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General series type dialog box 

   

5. Uncheck the box labeled 3D to display two dimensional chart types if 
required. 

6. Click any chart type that you would like to use for the series. 

7. Click OK to close the series type dialog box. 

8. Click the Close button to finish. 

Chart Panel Options 
This section consists of procedures that can be executed from the Panel sub-tab of 
the Chart tab in the Edit Options menu choice.  It includes procedures for 
changing the background appearance and border options for your chart. 

Changing the Chart Background Color 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Chart tab. 

3. Click the Panel sub-tab to access the panel options. 

4. Click the Background sub-tab. 
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Chart panel background dialog box 

   

5. Click the Color… button to display the Color dialog box and select 
from the Basic Colors to add a color to the chart background. 

6. Click the OK button to close the Color dialog box. 

7. Click the Close button to finish. 

Note: This option can also be used to add an image to the chart background using 
the Browse… button in the section labeled Back Image.  This opens a file 
selection dialog box from which you can choose a graphic image (such as a company 
logo) to place behind the chart.  Once an image is chosen, options from the Style 
radio button list are available to control the display of the image.  Choose between 
Stretch, Tile and Center. 

Adding a Border to the Chart 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Chart tab. 

3. Click the Panel sub-tab to access the panel options. 

4. Click the Borders sub-tab. 



 

 Chart Formatting Procedures  •  301 

 
Chart panel borders dialog box 

   

5. Click the check box labeled Border to add a single line around the 
entire chart. 

6. Use the radio buttons in the Bevel Inner and Bevel Outer sections to 
add or remove Lowered or Raised bevel effects. 

7. Adjust the width of the bevel effects using the Width spin edit boxes. 

8. Click the Close button to finish. 

Below is an example of a chart with the effects chosen in the dialog box 
above: 
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An example of a chart with beveled inner and outer borders 

Adding a Gradient to the Chart Background 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Chart tab. 

3. Click the Panel sub-tab to access the panel options. 

4. Click the Gradient sub-tab. 

 
Chart panel gradient dialog box 
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5. Ensure the Visible box is checked. 

6. Select a direction (eg. Left Right, Top Bottom) for the gradient from 
the Direction drop-down list. 

7. In the Colors section of the dialog box, use the Start, Middle and 
End buttons to select the colors for the gradient.  If no middle color is 
required, check the No Middle box. 

8. To reverse the start and end colors, use the Swap button. 

9. Click the Close button to finish. 

Adjust the Appearance of Chart Walls 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Chart tab. 

3. Click the Walls sub-tab to access the wall display options. 

 
Chart walls dialog box 

   

4. If you want the walls of the chart to be transparent, un-check the box 
labeled Visible Walls.  If you want to see them, make sure that this 
box is checked. 

5. To change the color of a three-dimensional wall, select the desired wall 
by clicking on the appropriate sub-tab (Left, Right, Bottom or 
Back), and select the Color... button to open the color selection dialog 
box. 

6. Click on the wall color you want and then click OK to close the color 
selection dialog box. 
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7. To change the border of a three-dimensional wall, select the desired 
wall by clicking on the appropriate sub-tab (Left, Right, Bottom or 
Back), and select the Border... button to open the border color editor. 

8. Make sure that the box labeled Visible is checked. 

9. Select the wall border style you want from the Style radio button 
group. 

10. Select the wall border width you want from the Width spin edit box. 

11. To change the wall border color, select the Color... button to open the 
color selection dialog box. 

12. Click on the wall border color you want and then click OK to close the 
color selection dialog box. 

13. Click OK to close the border color editor. 

14. To change the pattern of a three-dimensional wall, select the desired 
wall by clicking on the appropriate sub-tab (Left, Right, Bottom or 
Back), and select the Pattern... button to open the pattern selection 
dialog box. 

15. Click on the wall pattern you want and then click OK to close the 
pattern selection dialog box.  

16. To change the gradient of a three-dimensional wall, select the desired 
wall by clicking on the appropriate sub-tab (Left, Right, Bottom or 
Back), and select the Gradient... button to open the gradient selection 
dialog box. 

17. Ensure the Visible box is checked. 

18. Select a direction (eg. Left Right, Top Bottom) for the gradient from 
the Direction drop-down list. 

19. In the Colors section of the dialog box, use the Start, Middle and 
End buttons to select the colors for the gradient.  If no middle color is 
required, check the No Middle box. 

20. To reverse the start and end colors, use the Swap button. 

21. Click OK to close the gradient selection dialog box. 

22. To change the size of a three-dimensional wall, select the desired wall 
by clicking on the appropriate sub-tab (Left, Right, Bottom or 
Back), and adjust the value in the Size spin edit box. 

23. To remove any of these options from an individual wall, click the 
appropriate sub-tab (Left, Right, Bottom or Back), and remove the 
check from the box labeled Visible. 

24. Click the Close button to finish. 

Adjust Chart Three-Dimensional Appearance 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Chart tab. 

3. Click the 3D sub-tab to access the 3D display options. 
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Chart 3D dialog box 

   

4. If you want your chart to have a three-dimensional appearance, ensure 
that the box labeled 3 Dimensions is checked.   

5. If you do not want your chart to have a three-dimensional appearance, 
ensure that the box labeled 3 Dimensions is cleared.   

6. To adjust the three-dimensional depth of the chart, increase or decrease 
the value in the 3D % spin edit box.   

7. Checking the Orthogonal check box and increasing or decreasing the 
value in the Angle spin edit box can further adjust the three-
dimensional appearance.   

8. To adjust the size of the chart on the page, drag the point in the section 
labeled Zoom.   

9. To rotate the chart on the page, first uncheck the box labeled 
Orthogonal, and then drag the point in the section labeled Rotation.   

10. To change the elevation of the chart on the page, first uncheck the box 
labeled Orthogonal, and then drag the point in the section labeled 
Elevation.   

11. The chart can be moved to the left or right on the page by dragging the 
point in the section labeled Horiz Offset.   

12. The chart can be moved up or down on the page by dragging the point 
in the section labeled Vert Offset.   

13. Click the Close button to finish.   
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Series Options 
For information on the procedures that can be executed from the Series tab of the 
Edit Options menu choice, please see “Series Formatting Procedures”. 

Tools Options 
This section consists of procedures that can be executed from the Tools tab of the 
Edit Options menu choice.  It includes procedures for customizing your graph 
including hand-drawn lines, annotations and page numbering.  This section is 
organized so that its sub-topics appear in the same order as the options that appear 
when all tools are added to the Tools dialog box. 

Adding a Tool 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Tools tab. 

3. Click the Add… button to access the tools list 

 
Tools gallery dialog box 

   

4. Click on the tool you would like to use (eg. Annotation). 

5. Click the Add button to finish. 

Repeat these steps as necessary to add the tools you would like to use to the 
Tools dialog box. 

 

Adding an Annotation to the Chart 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Tools tab. 
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3. Click the Add… button to access the tools list and Add the 
Annotation tool if necessary.  See the Adding a Tool section for 
more information. 

 
Tools annotation options dialog box 

   

4. In the section labeled Text, type the annotation you require, pressing 
the Enter key each time you want to start a new line.  The annotation 
box in the graph will automatically adjust to the width and height of the 
lines you type. 

5. To change the position of the annotation within the graph, use the Auto 
drop-down list in the Position section to choose a location (Left top, 
Left bottom, Right top, Right bottom). 

6. To set a custom location for the annotation, check the box labeled 
Custom, and adjust the position using the Left and Top spin edit 
boxes. 

7. Click the Close button to finish. 

Changing the Annotation Format 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Tools tab. 

3. Click the Add… button to access the tools list and Add the 
Annotation tool if necessary.  See the Adding a Tool section for 
more information. 

4. Click the Format sub-tab. 
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Tools annotation format dialog box 

   

5. Select the Color... button to open the color selection dialog box. 

6. Click on the background color you want and then click OK to close the 
color selection dialog box. 

7. Click OK to close the border color editor. 

8. To adjust the appearance of the annotation frame, select the Frame... 
button to open the color selection dialog box. 

9. Make sure that the box labeled Visible is checked. 

10. Select the frame style you want from the Style drop-down list. 

11. Select the frame width you want from the Width spin edit box. 

12. To change the frame color, select the Color... button to open the color 
selection dialog box. 

13. Click on the frame color you want and then click OK to close the color 
selection dialog box. 

14. Click OK to close the border editor. 

15. If a rounded box is required, check the box labeled Round Frame. 

16. If a three-dimensional effect is required, select Raised or Lowered 
from the Bevel drop-down list.  The depth of this effect can be 
adjusted with the Size spin edit box. 

17. If a background pattern is required, select the Pattern… button to 
open the pattern color editor dialog box. 

18. Select the fill style you want from the list box. 
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19. To change the fill color, select the Color... button to open the color 
selection dialog box. 

20. Click on the color you want and then click OK to close the color 
selection dialog box. 

21. Click OK to close the pattern color editor. 

22. Click the Close button to finish. 

Changing the Annotation Text 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Tools tab. 

3. Click the Add… button to access the tools list and Add the 
Annotation tool if necessary.  See the Adding a Tool section for 
more information. 

4. Click the Text sub-tab. 

 
Tools annotation text dialog box 

   

5. Click the Font… button to display the Font Properties dialog box and 
select the Font (e.g. Arial, Times New Roman, etc), the Font Style 
(e.g. Italic, Bold, etc.), Size, and Color until the Sample Text has 
the appearance you want. 

6. Click the OK button to close the Font Properties dialog box. 

7. Click the Color button in the Shadow… group to display the Color 
dialog box and select from the Basic Colors to add a shadow to your 
text if desired. 

8. Click the OK button to close the Color dialog box. 
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9. Click the spin edit boxes to adjust the horizontal and vertical aspects of 
the shadow or enter a value from the keyboard. 

10. Click the Inter-char spacing spin edit box to adjust the character 
spacing or enter a value from the keyboard. 

11. Click the Close button to finish. 

Changing the Annotation Gradient 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Tools tab. 

3. Click the Add… button to access the tools list and Add the 
Annotation tool if necessary.  See the Adding a Tool section for 
more information. 

4. Click the Gradient sub-tab. 

 
Tools annotation gradient dialog box 

   

5. Ensure the Visible box is checked. 

6. Select a direction (eg. Left Right, Top Bottom) for the gradient from 
the Direction drop-down list. 

7. In the Colors section of the dialog box, use the Start, Middle and 
End buttons to select the colors for the gradient.  If no middle color is 
required, check the No Middle box. 

8. To reverse the start and end colors, use the Swap button. 

9. Click the Close button to finish. 
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Changing the Annotation Shadow 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Tools tab. 

3. Click the Add… button to access the tools list and Add the 
Annotation tool if necessary.  See the Adding a Tool section for 
more information. 

4. Click the Shadow sub-tab. 

 
Tools annotation shadow dialog box 

   

5. Click the Color button to display the Color dialog box and select from 
the Basic Colors to add a shadow to your text if desired. 

6. Click the OK button to close the Color dialog box. 

7. Click the Size spin edit box to adjust the depth of the shadow or enter a 
value from the keyboard. 

8. Click the Close button to finish. 

Adding Axis Arrows to the Chart 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Tools tab. 

3. Click the Add… button to access the tools list and Add the Axis 
Arrows tool if necessary.  See the Adding a Tool section for more 
information. 
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Tools axis arrows dialog box 

   

4. To choose the location of the axis arrows, select from the Axis drop-
down list (Left axis, Right axis, Top axis or Bottom axis). 

5. To change the color of the axis arrows, click the Border… button to 
open the border editor dialog box. 

6. Make sure that the box labeled Visible is checked. 

7. Select the arrow width you want from the Width spin edit box. 

8. To change the arrow color, select the Color... button to open the color 
selection dialog box. 

9. Click on the arrow color you want and then click OK to close the color 
selection dialog box. 

10. Click OK to close the border editor dialog box. 

11. To change the axis arrow pattern, click the Pattern… button to open 
the pattern selection dialog box. 

12. Click to select the pattern you require from the pattern list. 

13. To change the pattern color, select the Color... button to open the color 
selection dialog box. 

14. Click on the pattern color you want and then click OK to close the 
color selection dialog box. 

15. Click OK to close the pattern selection dialog box. 

16. To adjust the length of the axis arrows, increase or decrease the value 
in the Length spin edit box. 

17. To choose the location for the axis arrows, select from the Location 
drop-down list (Start, End or Both). 
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18. To control the amount by which the axis is scrolled when the arrows 
are clicked on, change the Scroll percentage setting.  You can also 
change the scrolling direction by checking the Inverted Scroll box. 

19. Click the Close button to finish. 

Adding a Color Band to the Chart 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Tools tab. 

3. Click the Add… button to access the tools list and Add the Color 
Band tool if necessary.  See the Adding a Tool section for more 
information. 

 
Tools color band dialog box 

   

4. To choose the location for the color band, select from the Axis drop-
down list (Left axis, Right axis, Top axis or Bottom axis). 

5. To change the color of the color band, click the Border… button to 
open the border editor dialog box. 

6. Make sure that the box labeled Visible is checked. 

7. Select the border width you want from the Width spin edit box. 

8. To change the border color, select the Color... button to open the color 
selection dialog box. 

9. Click on the border color you want and then click OK to close the color 
selection dialog box. 

10. To change the border style, select from the Style drop-down list. 
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11. Click OK to close the border editor dialog box. 

12. To change the color band pattern, click the Pattern… button to open 
the pattern selection dialog box. 

13. Click to select the pattern you require from the pattern list. 

14. To change the pattern color, select the Color... button to open the color 
selection dialog box. 

15. Click on the pattern color you want and then click OK to close the 
color selection dialog box. 

16. Click OK to close the pattern selection dialog box. 

17. To change the gradient of a color band, select the Gradient... button to 
open the gradient selection dialog box. 

18. Ensure the Visible box is checked. 

19. Select a direction (eg. Left Right, Top Bottom) for the gradient from 
the Direction drop-down list. 

20. In the Colors section of the dialog box, use the Start, Middle and 
End buttons to select the colors for the gradient.  If no middle color is 
required, check the No Middle box. 

21. To reverse the start and end colors, use the Swap button. 

22. Click OK to close the gradient selection dialog box. 

23. To change the color of a color band, select the Color... button to open 
the color selection dialog box. 

24. Click on the color you want and then click OK to close the color 
selection dialog box. 

25. To adjust the position of the color band on the selected axis, increase or 
decrease the values in the Start value and End value boxes. 

26. To draw the color band behind the graph, ensure the Draw Behind 
box is checked. 

27. If Draw Behind is unchecked, adjust the transparency of the color 
band using the Transparency spin edit box. 

28. Click the Close button to finish. 

Adding a Color Line to the Chart 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Tools tab. 

3. Click the Add… button to access the tools list and Add the Color 
Line tool if necessary.  See the Adding a Tool section for more 
information. 
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Tools color line dialog box 

   

4. To choose the axis location for the color line, select from the Axis 
drop-down list (Left axis, Right axis, Top axis or Bottom axis). 

5. To change the color of the color line, click the Border… button to 
open the border editor dialog box. 

6. Make sure that the box labeled Visible is checked. 

7. Select the border width you want from the Width spin edit box. 

8. To change the border color, select the Color... button to open the color 
selection dialog box. 

9. Click on the border color you want and then click OK to close the color 
selection dialog box. 

10. To change the border style, select from the Style drop-down list. 

11. Click OK to close the border editor dialog box. 

12. To adjust the position of the color line on the selected axis, increase or 
decrease the value in the Value box. 

13. To reposition the color line inside the graph using the mouse, check the 
box labeled Allow Drag.  The No Limit Drag check box will allow 
you to position the color line anywhere inside or outside the graph. 

Adding a Cursor to the Chart 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Tools tab. 
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3. Click the Add… button to access the tools list and Add the Cursor 
tool if necessary.  See the Adding a Tool section for more 
information. 

 
Tools cursor dialog box 

   

4. To change the style of the cursor, select between Horizontal, Vertical 
and Both from the Style drop-down list. 

5. The location of the cursor can be set to follow your mouse if you check 
the box labeled Follow Mouse.  If this box is unchecked, you must 
move the cursor lines manually by dragging. 

6. The cursor will snap to the data points on the selected axis if you check 
the box labeled Snap. 

7. To change the appearance of the cursor, click the Pen… button to open 
the border editor dialog box. 

8. Make sure that the box labeled Visible is checked. 

9. Select the cursor width you want from the Width spin edit box. 

10. To change the cursor color, select the Color... button to open the color 
selection dialog box. 

11. Click on the cursor color you want and then click OK to close the color 
selection dialog box. 

12. To change the style of the cursor, select from the Style drop-down list. 

13. Click OK to close the border editor dialog box. 

14. Click the Close button to finish. 
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Moving the Series Marks 
To use the Drag Marks tool discussed in this section, the series marks must be 
visible.  To make the marks visible, right-click on the chart to open the Edit menu, 
then click Edit Options.  Select the Series tab and then the Marks sub-tab.  
Finally, ensure the box labeled Visible is checked. 

   

1. Right-click on the chart to open the Edit menu, and then click Edit 
Options. 

2. Select the Tools tab. 

3. Click the Add… button to access the tools list and Add the Drag 
Marks tool if necessary.  See the Adding a Tool section for more 
information. 

 
Tools drag marks dialog box 

   

4. All series marks will be movable at this stage.  To adjust only a specific 
series in the graph, select from the drop-down list labeled Series. 

5. To return the marks to their original positions, use the Reset 
positions button in this dialog box. 

6. Click the Close button to finish. 

7. Adjust the position of the series marks in the graph as required by 
dragging. 

Drawing Lines in the Chart 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 
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2. Select the Tools tab. 

3. Click the Add… button to access the tools list and Add the Draw 
Line tool if necessary.  See the Adding a Tool section for more 
information. 

 
Tools draw line dialog box 

   

4. Ensure the box labeled Active is checked.  If this is not checked, you 
will be unable to draw lines and any drawn lines will be removed from 
the chart. 

5. Ensure the box labeled Enable drawing is checked. 

6. To change the mouse button used to draw lines in the chart, select from 
Left, Right or Middle in the Mouse button drop-down list. 

7. To change the appearance of the lines, click the Pen… button to open 
the border editor dialog box. 

8. Make sure that the box labeled Visible is checked. 

9. Select the line width you want from the Width spin edit box. 

10. To change the line color, select the Color... button to open the color 
selection dialog box. 

11. Click on the line color you want and then click OK to close the color 
selection dialog box. 

12. To change the style of the line, select from the Style drop-down list. 

13. Click OK to close the border editor dialog box. 

14. If you wish to move the drawn lines by dragging with the mouse, 
ensure the box labeled Enable Select is checked. 

15. Click the Close button to finish. 
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Using the Image Tool 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Tools tab. 

3. Click the Add… button to access the tools list and Add the Image 
tool if necessary.  See the Adding a Tool section for more 
information. 

 
Tools image dialog box 

   

4. To add an image, select the Browse... button to open the file selection 
dialog box. 

5. Choose the graphic image you want and then click OK to close the file 
selection dialog box. 

6. Click the Close button to finish. 

Displaying Series Labels by Pointing 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Tools tab. 

3. Click the Add… button to access the tools list and Add the Mark 
Tips tool if necessary.  See the Adding a Tool section for more 
information. 
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Tools mark tips dialog box 

   

4. Ensure the box labeled Active is checked. 

5. Select the series you wish to display mark tips for using the drop-down 
list labeled Series. 

6. Choose the content of the mark tip (eg. Label, Label and Percent, 
Percent Total, etc.) from the drop-down list labeled Style. 

7. Choose the mouse action (Move or Click) that will cause the mark tip 
to display using the radio buttons in the section labeled Mouse 
action. 

8. To adjust the time delay between the mouse action and the display of 
the mark tip, increase or decrease the value in the Delay spin edit box. 

9. Click the Close button to finish. 

Emphasizing Data with a Pointer 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Tools tab. 

3. Click the Add… button to access the tools list and Add the Nearest 
Point tool if necessary.  See the Adding a Tool section for more 
information. 
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Tools nearest point dialog box 

   

4. To choose the series you wish to point at, select from the drop-down 
list labeled Series. 

5. To change the appearance of the pointer, click the Pen… button to 
open the border editor dialog box. 

6. Make sure that the box labeled Visible is checked. 

7. Select the line width you want from the Width spin edit box. 

8. To change the line color, select the Color... button to open the color 
selection dialog box. 

9. Click on the line color you want and then click OK to close the color 
selection dialog box. 

10. To change the style of the line, select from the Style drop-down list. 

11. Click OK to close the border editor dialog box. 

12. To change the pattern of the pointer, click the Brush… button to open 
the pattern selection dialog box. 

13. Click to select the pattern you require from the pattern list. 

14. To change the pattern color, select the Color... button to open the color 
selection dialog box. 

15. Click on the pattern color you want and then click OK to close the 
color selection dialog box. 

16. Click OK to close the pattern selection dialog box. 

17. If a line from the mouse to the data point is desired, ensure the box 
labeled Draw Line is checked. 
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18. To adjust the size of the pointer, increase or decrease the value in the 
Size spin edit box. 

19. To change the style of the pointer, choose from Circle, Rectangle, 
Diamond or None from the Style drop-down list. 

20. Click the Close button to finish. 

Custom Page Numbering 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Tools tab. 

3. Click the Add… button to access the tools list and Add the Page 
Number tool if necessary.  See the Adding a Tool section for more 
information. 

 
Tools page number options dialog box 

   

4. Ensure the check box labeled Active is checked. 

5. In the section labeled Text, edit the page number as required, pressing 
the Enter key each time you want to start a new line.  The page number 
box in the graph will automatically adjust to the width and height of the 
lines you type. 

6. To change the position of the page number within the graph, use the 
Auto drop-down list in the Position section to choose a location 
(Left top, Left bottom, Right top, Right bottom). 

7. To set a custom location for the page number, check the box labeled 
Custom, and adjust the position using the Left and Top spin edit 
boxes. 
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8. Click the Close button to finish. 

Changing the Page Number Format 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Tools tab. 

3. Click the Add… button to access the tools list and Add the Page 
Number tool if necessary.  See the Adding a Tool section for more 
information. 

4. Click the Format sub-tab. 

 
Tools page number format dialog box 

   

5. Select the Color... button to open the color selection dialog box. 

6. Click on the background color you want and then click OK to close the 
color selection dialog box. 

7. Click OK to close the border color editor. 

8. To adjust the appearance of the page number frame, select the 
Frame... button to open the color selection dialog box. 

9. Make sure that the box labeled Visible is checked. 

10. Select the frame style you want from the Style drop-down list. 

11. Select the frame width you want from the Width spin edit box. 

12. To change the frame color, select the Color... button to open the color 
selection dialog box. 

13. Click on the frame color you want and then click OK to close the color 
selection dialog box. 
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14. Click OK to close the border editor. 

15. If a rounded box is required, check the box labeled Round Frame. 

16. If a three-dimensional effect is required, select Raised or Lowered 
from the Bevel drop-down list.  The depth of this effect can be 
adjusted with the Size spin edit box. 

17. If a background pattern is required, select the Pattern… button to 
open the pattern color editor dialog box. 

18. Select the fill style you want from the list box. 

19. To change the fill color, select the Color... button to open the color 
selection dialog box. 

20. Click on the color you want and then click OK to close the color 
selection dialog box. 

21. Click OK to close the pattern color editor. 

22. Click the Close button to finish. 

 

Changing the Page Number Text 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Tools tab. 

3. Click the Add… button to access the tools list and Add the Page 
Number tool if necessary.  See the Adding a Tool section for more 
information. 

4. Click the Text sub-tab. 

 
Tools page number text dialog box 
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5. Click the Font… button to display the Font Properties dialog box and 
select the Font (e.g. Arial, Times New Roman, etc), the Font Style 
(e.g. Italic, Bold, etc.), Size, and Color until the Sample Text has 
the appearance you want. 

6. Click the OK button to close the Font Properties dialog box. 

7. Click the Shadow… button to display the Color dialog box and select 
from the Basic Colors to add a shadow to your text if desired. 

8. Click the OK button to close the Color dialog box. 

9. Click the spin edit boxes to adjust the horizontal and vertical aspects of 
the shadow or enter a value from the keyboard. 

10. Click the Inter-char spacing spin edit box to adjust the character 
spacing or enter a value from the keyboard. 

11. Click the Close button to finish. 

Changing the Page Number Gradient 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Tools tab. 

3. Click the Add… button to access the tools list and Add the Page 
Number tool if necessary.  See the Adding a Tool section for more 
information. 

4. Click the Gradient sub-tab. 

 
Tools page number gradient dialog box 
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5. Ensure the Visible box is checked. 

6. Select a direction (eg. Left Right, Top Bottom) for the gradient from 
the Direction drop-down list. 

7. In the Colors section of the dialog box, use the Start, Middle and 
End buttons to select the colors for the gradient.  If no middle color is 
required, check the No Middle box. 

8. To reverse the start and end colors, use the Swap button. 

9. Click the Close button to finish. 

Changing the Page Number Shadow 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Tools tab. 

3. Click the Add… button to access the tools list and Add the Page 
Number tool if necessary.  See the Adding a Tool section for more 
information. 

4. Click the Shadow sub-tab. 

 
Tools page number shadow dialog box 

   

5. Click the Color button to display the Color dialog box and select from 
the Basic Colors to add a shadow to your text if desired. 

6. Click the OK button to close the Color dialog box. 

7. Click the Size spin edit box to adjust the depth of the shadow or enter a 
value from the keyboard. 

8. Click the Close button to finish. 
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Using the Rotate Tool 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Tools tab. 

3. Click the Add… button to access the tools list and Add the Rotate 
tool if necessary.  See the Adding a Tool section for more 
information. 

 
Tools rotate dialog box 

   

4. Ensure the box labeled Active is checked. 

5. Click the Close button to finish. 

6. To rotate the graph freehand, press and hold the left mouse button and 
drag the graph as required. 

Disabling a Chart Tool 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Tools tab. 

3. Choose the tool you want to disable from the list. 

4. Remove the check from the box labeled Active. 

5. Click the Close button to finish. 
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Export Options 
This section contains procedures for exporting your chart to other programs and 
includes a discussion of the different file types that are available, as well as sending 
your chart through email. 

Selecting the File Format Settings 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Export tab. 

 
Export picture dialog box 

   

3. Select the Picture sub-tab. 

4. Choose the file format you want to use (Metafile, Bitmap, GIF or 
JPEG) using the radio buttons in the Format section. 

5. Adjust specific file format options for export by selecting the Options 
sub-tab and applying the desired settings.  Note that the options 
available vary with the file format selected. 

6. Adjust the width and height of the exported chart by selecting the Size 
sub-tab and increasing or decreasing the values in the Width and 
Height spin edit boxes.  To keep the chart size in perspective, check 
the box labeled Keep aspect ratio. 

Including Series Data 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Export tab. 
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3. Select the Native sub-tab. 

 
Export native dialog box 

   

4. To include the series data with the chart for export, check the box 
labeled Include Series data. 

5. To determine the size of the file to be exported, check the box labeled 
File Size. 

Selecting the Data Series Format Settings 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Export tab. 

3. Select the Data sub-tab. 
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Export data dialog box 

   

4. Select the data series you wish to export using the drop-down list 
labeled Series. 

5. Choose the file format for the data series (Text, XML, HTML-Table 
or Excel) using the radio buttons in the Format section. 

6. Include the point index, point labels and header information by 
checking the boxes in the section labeled Include. 

Exporting an Email Attachment 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Export tab. 

3. Select the export settings required using the Picture, Native and Data 
sub-tabs. 

4. Click the Send… button to open the personal folders dialog box. 

5. Enter your password and press OK. 

6. Your Email program will create a new email message and attach the 
file.  Complete the message and send it.  Close your Email program 
when finished. 

Exporting to a File 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Export tab. 
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3. Select the export settings required using the Picture, Native and Data 
sub-tabs. 

4. Click the Save… button to open the Save As dialog box. 

5. Enter a filename for the file and choose the storage location. 

6. Click the Save button. 

7. Click the Close button to finish. 

Print Options 
This section contains procedures for printing your charts, including options for 
printer setup, printer selection and page setup. 

Print Preview the Chart 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Print tab. 

 
Print preview dialog box 

   

3. This dialog box can be used to: 

• Select your printer from the Printer drop-down list. 

• Choose your paper orientation (Portrait or Landscape) from the 
Orientation radio buttons. 

• Adjust the margins by dragging the margin lines on the previewed 
page. 
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• Dragging the pointer in the section called Detail between More 
and Normal will scale the chart text sizes.  Smaller text (More 
detail) generally looks better when printing. 

• Change your printer setup options (such as paper size, paper 
source) using the Setup… button. 

• Print the previewed page using the Print button. 

4. Click the Close button to finish. 

   

Changing the Paper Orientation 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Print tab. 

 
Print dialog box 

   

3. Change between Landscape and Portrait orientation using the radio 
buttons in the Orientation section. 

4. Click the Close or Print button to finish. 

Selecting a Printer 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Print tab. 



 

 Chart Formatting Procedures  •  333 

 
Printer selection drop-down list in the print dialog box 

   

3. Using the drop-down list labeled Printer, select the printer required. 

4. Click the Print button to finish. 

Adjusting the Chart Size 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Print tab. 

3. To adjust the chart margins and resize the chart, point the mouse at the 
dashed lines in the print preview area of the print dialog box and 
drag them to the desired position.  The print preview window will 
automatically display the adjusted chart  
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Margin adjustment in the print dialog box 

   

4. To adjust the level of detail, drag the pointer in the section labeled 
Detail between More and Normal. 

5. Click the Close or Print button to finish. 

Adjusting the Chart Position 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Print tab. 

3. Position the mouse over the graph in the print preview area.  The 
mouse pointer will change to an image of a hand. 
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Moving the chart in the print dialog box 

   

4. Drag the chart into the desired location. 

5. Click the Close or Print button to finish. 

Changing the Paper Size or Source 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Options. 

2. Select the Print tab. 

3. Click on the Setup… button to open the print setup dialog box. 
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Print setup dialog box 

   

4. Select the paper size (eg. Legal, A4, Executive) from the drop-down 
list labeled Size. 

5. Select the paper feed source for the printout (eg. Lower, Upper, 
Manual Feed) from the drop-down list labeled Source. 

6. Click the OK button to close the print setup dialog box. 

7. Click the Print or Close button to finish. 
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Series Formatting Procedures 

Series Formatting Note 
One of BioWin’s helpful series formatting features is that changes you make to a 
series are displayed “on the fly” as you make them.  This is an excellent way to learn 
the functionality of the series editing controls since you immediately see the results 
of clicking various buttons, spin edit boxes, and other dialog box controls in the 
background.  The associations between dialog controls and their resultant changes to 
the series are learned much more quickly than if you have to exit the dialog or 
manually apply the changes before you see their effects. 

Common Series Procedures 
This section covers procedures that are accessible from the Series tab of the Edit 
Series and Edit Options commands. 
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Tab used for series format manipulation 

Change a Series Style 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series or Edit Options command. 

2. In the Series list box on the Chart tab, select the series you want to 
change the style of. 

3. Click the Change... button. 

4. Select the new series style from the Series Gallery.  If a 3D style is 
required, ensure the 3D box is checked.  Click the OK button when 
done. 

5. Click the Close button to finish. 

Note:  To change the style of another series, repeat steps 2-4. 

Rename a Series 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series or Edit Options command. 

2. In the Series list box on the Chart tab, select the series you want to 
rename. 

3. Click the Title... button. 

4. Enter the new name in the Change Series Title dialog box, and click 
OK. 

5. Click the Close button to finish. 

Note:  To rename another series, repeat steps 2-4. 

Delete a Series From a Chart 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series or Edit Options command. 

2. In the Series list box on the Chart tab, select the series you want to 
delete. 

3. Click the Delete button. 

4. If you are sure you want to delete this series, click Yes in the 
confirmation box. 

5. Click the Close button to finish. 

Note:  To delete another series, repeat steps 2-4.  You can also delete series from the 
Edit Series List dialog box – if you have many series this may in fact be quicker. 

Add/Remove a Series in the Legend 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series or Edit Options command. 

2. Click the Series sub-tab. 

3. Click the General sub-tab. 

4. Add or remove the check from the box labeled Show in Legend. 
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5. Click the Close button to finish. 

Note:  To add/remove another series, repeat steps 2-4. 

Control the Axis that a Series is Plotted On 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series or Edit Options command. 

2. In the Series list box on the Chart tab, select the series you want to 
control. 

3. Click the Series sub-tab. 

4. Click the General sub-tab. 

5. Choose the position that you want the series plotted on (Top, Bottom 
or Top and Bottom) from the drop-down list in the section labeled 
Horizontal Axis. 

6. If you want this axis to have date/time formats, check the box labeled 
Date Time. 

7. In the Vertical Axis drop-down list select the vertical axis (Left, 
Right or Left and Right) that you want the series to be plotted on. 

8. If you want this axis to have date/time formats, check the box labeled 
Date Time. 

9. Click the Close button to finish. 

Note:  To change the axis for another series, repeat steps 2-8. 

   

   

Series Labeling Procedures 
This section outlines the various methods for changing the appearance of series 
labels, known as marks, including border, color, font, and style. 
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Dialog box used for manipulating series marks 

Adding Labels to a Chart 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series or Edit Options command. 

2. In the Series list box on the Chart tab, select the series you want to 
control. 

3. Click the Marks sub-tab. 

4. Make sure that the box labeled Visible is checked 

5. Click the Close button to finish. 

Series Label Styles 
This section gives an outline and examples of the various series label styles that are 
available in BioWin. 

Style Example 
Value 1234 
Percent 12 % 
Label Mass 
Label & Percent Mass 25 % 
Label & Value Mass 1234 
Legend Depends on Legend Text Style 
Percent Total 12 % of 1234 
Label & Percent Total Mass 12 % of 1234 
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Xvalue 4321 

Change the Series Label Style 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series or Edit Options command. 

2. In the Series drop-down list on the Series tab, select the series you 
want to control. 

3. Click the Marks sub-tab. 

 
Dialog box used to manipulate the style of chart marks 

   

4. Make sure that the box labeled Visible is checked. 

5. In the Style drop-down list select the label style that you want for the 
series. 

6. Click the Close button to finish. 

Note:  To change the label style for another series, repeat steps 2-5. 

Change the Series Label Number Format 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series or Edit Options command. 

2. In the Series drop-down list on the Series tab, select the series you 
want to control. 

3. Click the Marks sub-tab. 
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4. Click the General sub-tab. 

In the Formats group, change the Values or Percents formatting to the style you 
want.  Refer to the  BioWin Number Formats topic below for more information. 

   

5. Click OK to finish. 

BioWin Number Formats 
This section contains an overview of the various number formats that are available in 
BioWin.  Although this information is applicable elsewhere, it has been included 
here since it will most likely be needed in relation to chart labeling. 

Specifier Description 
0 Digit placeholder.  If the value being formatted has a digit in the 

position where the ‘0’ appears in the format string, then that digit is 
copied to the output string.  Otherwise, a ‘0’ is stored in that position in 
the output string. 

# Digit placeholder.  If the value being formatted has a digit in the 
position where the ‘#’ appears in the format string, then that digit is 
copied to the output string.  Otherwise nothing is stored in that position 
in the output string. 

. Decimal point.  The first ‘.’ character in the format string determines the 
location of the decimal separator in the formatted value; any additional 
‘.’ characters are ignored.  The actual character used as a decimal 
separator in the output string is specified in the Number Format of the 
International section of the Windows Control Panel. 

, Thousand separator.  If the format string contains one or more ‘,’ 
characters, the output will have thousand separators inserted between 
each group of three digits to the left of the decimal point.  The 
placement and number of ‘,’ characters in the format string does not 
affect the output, except to indicate that thousand separators are wanted.  
The actual character used as a thousand separator in the output string is 
specified in the Number Format of the International section of the 
Windows Control Panel. 

E+ Scientific notation.  If any of the strings ‘E+’, ‘E-’, ‘e+’, or ‘e-’ are 
contained in the format string, the number is formatted using scientific 
notation.  A group of up to four ‘0’ characters can immediately follow 
the ‘E+’, ‘E-’, ‘e+’, or ‘e-’ to determine the minimum number of digits 
in the exponent.  The ‘E+’ or ‘e+’ formats cause a plus sign to be output 
for positive exponents and a minus sign to be output for negative 
exponents.  The ‘E-’ and ‘e-’ formats output a sign character only for 
negative exponents. 

'xx'/"xx" Characters enclosed in single or double quotes are output as-is, and do 
not affect formatting. 

; Separates sections for positive, negative, and zero numbers in the format 
string. 

The locations of the leftmost ‘0’ before the decimal point in the format string and the 
rightmost ‘0’ after the decimal point in the format string determine the range of 
digits that are always present in the output string. 

The number being formatted is always rounded to as many decimal places as there 
are digit placeholders (‘0’ or ‘#’) to the right of the decimal point.  If the format 
string contains no decimal point, the value being formatted is rounded to the nearest 
whole number. 
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If the number being formatted has more digits to the left of the decimal separator that 
there are digit placeholders to the left of the ‘.’ character in the format string, the 
extra digits are output before the first digit placeholder. 

To allow different formats for positive, negative, and zero values, the format string 
can contain between one and three sections separated by semicolons: 

   

4. One section:  The format string applies to all values; 

5. Two sections:  The first section applies to positive values and zeros, 
and the second section applies to negative values; 

6. Three sections:  The first section applies to positive values, the second 
applies to negative values, and the third section applies to zeros. 

If the section for negative values or the section for zero values is empty, that is there 
is nothing between the semicolons that delimit the section, the section for the 
positive values is used instead. 

If the section for positive values is empty, or if the entire format string is empty, the 
value is formatted using general floating-point formatting with 15 significant digits.  
General floating-point formatting is also used if the value has more than 18 digits to 
the left of the decimal point and the format string does not specify scientific notation.  

The following table shows some sample formats and the results produced when the 
formats are applied to different values: 

Format String 1234 -1234 0.5 0 
None Specified 1234 -1234 0.5 0 
0 1234 -1234 1 0 
0.00 1234.00 -1234.00 0.50 0.00 
#.## 1234 -1234 .5  
#,##0.00 1,234.00 -1,234.00 0.50 0.00 
#,##0.00;(#,##0.00) 1,234.00 (1,234.00) 0.50 0.00 
#,##0.00;;Zero 1,234.00 -1,234.00 0.50 Zero 
0.000E+00 1.234E+03 -1.234E+03 5.000E-01 0.000E+00 
#.###E-0 1.234E3 -1.234E3 5E-1 0E0 

 

Change the Series Label Border 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series or Edit Options command. 

2. In the Series drop-down list on the Series tab, select the series you 
want to control. 

3. Click the Marks sub-tab. 

4. Click the Style sub-tab. 

5. Make sure that the box labeled Visible is checked. 

6. Click the Format sub-tab. 
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Dialog box used for formatting marks 

   

7. Click the Frame... button to open the border color editor. 

8. Make sure that the box labeled Visible is checked. 

9. Select the label border style you want from the Style drop-down list. 

10. Select the label border width you want from the Width spin edit box. 

11. To change the label border color, select the Color... button to open the 
color selection dialog box. 

12. Click on the label border color you want and then click OK to close the 
color selection dialog box. 

13. Click OK to close the border color editor. 

14. Click the Close button to finish. 

Note:  To change the label border for another series, repeat steps 2-13.  If you don't 
want series labels to extend beyond the chart axis boundaries, check the box labeled 
Clip Labels. 

Change the Series Label Color 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series or Edit Options command. 

2. In the Series drop-down list on the Series tab, select the series you 
want to control. 

3. Click the Marks sub-tab. 

4. Click the Style sub-tab. 
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5. Make sure that the box labeled Visible is checked. 

6. Click the Format sub-tab. 

 
Dialog box used for formatting marks 

   

7. Click the Color... button to open the color selection dialog box. 

8. Click on the label color you want and then click OK to close the color 
selection dialog box. 

9. Click the Close button to finish. 

Note:  To change the label color for another series, repeat steps 2-8.  If you want the 
series labels to be clear, make the label color white. 

Change the Series Label Pattern 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series or Edit Options command. 

2. In the Series drop-down list on the Series tab, select the series you 
want to control. 

3. Click the Marks sub-tab. 

4. Click the Style sub-tab. 

5. Make sure that the box labeled Visible is checked. 

6. Click the Format sub-tab. 
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Dialog box used for formatting marks 

   

7. Click the Pattern... button to open the pattern color editor dialog box. 

8. Select the pattern style you want from the pattern list. 

9. To change the pattern color, select the Color... button to open the color 
selection dialog box. 

10. Click on the pattern color you want and then click OK to close the 
color selection dialog box. 

11. Click OK to close the pattern color editor. 

12. Click the Close button to finish. 

Note:  To change the label pattern for another series, repeat steps 2-11 

Change the Series Label Font 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series or Edit Options command. 

2. In the Series drop-down list on the Series tab, select the series you 
want to control. 

3. Click the Marks sub-tab. 

4. Make sure that the box labeled Visible is checked. 

5. Click the Text sub-tab. 
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Dialog box used for manipulating the text of series marks 

   

6. Click the Font... button to open the font properties dialog box. 

7. Specify the Font (e.g. Arial, Times New Roman, etc), the Font Style 
(e.g. Italic, Bold, etc.), Size, and Color until the Sample Text has 
the appearance you want. 

8. Click the OK button to close the font properties dialog box. 

9. To add an outline effect to the font, click the Outline… button to open 
the border editor dialog box. 

10. Choose the Color, Style and Width for the outline you require. 

11. Click the OK button to close the border editor dialog box. 

12. To adjust the amount of white space between the characters, increase or 
decrease the value in the Inter-char spacing spin edit box. 

13. Click the Close button to finish. 

Note:  To change the label font for another series, repeat steps 2-12. 

Change the Series Label Gradient 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series or Edit Options command. 

2. In the Series drop-down list on the Series tab, select the series you 
want to control. 

3. Click the Marks sub-tab. 

4. Make sure that the box labeled Visible is checked. 
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5. Click the Gradient sub-tab. 

 
Dialog box used to add a gradient to series marks 

   

6. Ensure the Visible box is checked. 

7. Select a direction (eg. Left Right, Top Bottom) for the gradient from 
the Direction drop-down list. 

8. In the Colors section of the dialog box, use the Start, Middle and 
End buttons to select the colors for the gradient.  If no middle color is 
required, check the No Middle box. 

9. To reverse the start and end colors, use the Swap button. 

10. Click the Close button to finish. 

Note:  To change the label gradient for another series, repeat steps 2-9. 

Change the Series Label Shadow 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series or Edit Options command. 

2. In the Series drop-down list on the Series tab, select the series you 
want to control. 

3. Click the Marks sub-tab. 

4. Make sure that the box labeled Visible is checked. 

5. Select the Shadow sub-tab. 
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Dialog box used to add a shadow to series marks 

   

6. Click the Color button to display the Color dialog box and select from 
the Basic Colors to add a shadow to your text if desired. 

7. Click the OK button to close the Color dialog box. 

8. Click the Size spin edit box to adjust the depth of the shadow or enter a 
value from the keyboard. 

9. Click the Close button to finish. 

Note:  To change the label shadow for another series, repeat steps 2-8. 

Edit the Series List 
This section describes a number of ways to manipulate the series that are plotted on a 
chart.  Right-clicking on a chart and selecting Edit Series List… from the resulting 
popup menu will open the following dialog box. 
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The Edit Series List dialog box 

Hide/Show a Series 
This dialog box allows you to turn the display of a series in a chart on or off.  Note 
that this does not remove the series from the chart; rather it simply toggles a series' 
visibility.  To show or hide a series in a chart, add or remove the check box beside 
the series name in the dialog box.  If you want to remove a series, click on the series 
and press the Delete key on your keyboard. 

Change the Series Plotting Order 
You can use this dialog box to change the order in which series are plotted on a 
chart.  To do this, click on a series name so that it is highlighted, and then click the 
up or down arrow.  Note that when you do this, the order in which series are listed in 
the legend changes accordingly. 

Change a Series Color 
The color of each series is shown next to its name in the series list.  Double-clicking 
on the color will open up the Color Selection dialog box.  You can then use this 
dialog box to change the color of the series. 

Fast Line Series Procedures 
This section is an overview of formatting procedures that can be executed from the 
Format sub-tab of the Edit Series tab for a Fast Line Series.  

Fast Line series can be used for traditional engineering X-Y plots, time series 
analysis, etc.  In BioWin they particularly are useful for displaying dynamic 
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simulation results.  Fast Line series have fewer display options than the regular Line 
series, but they draw quicker and therefore are useful if you are plotting several 
series at once.  The Fast Line series style trades display options for speed of 
execution. 

 
Fast line series formatting options 

Change the Fast Line Series Appearance 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series. 

2. In the Series drop-down list on the Series tab, select the fast line 
series you want to change the appearance of. 

3. Click the Format sub-tab. 



 

352  •  Series Formatting Procedures  

 
Fast line series formatting options 

   

4. Ensure that the box labeled Visible is checked. 

5. Change the width of the line using the Width spin edit box. 

6. Change the line style using the Style: radio button group.  Note that 
this option is not available if the line width is greater than one due to 
screen resolution restrictions. 

7. Click the Color... button to open the color selection dialog box. 

8. Click on the fast line series color you want and then click OK to close 
the color selection dialog box. 

9. Click the Close button to finish. 

Line Series Procedures 
This is an overview of formatting procedures that can be executed from the Format 
and Point sub-tabs of the Edit Series tab for a Line Series.  

Line series can be used for traditional engineering X-Y plots, time series analysis, 
etc.  In BioWin they particularly are useful for displaying dynamic simulation 
results. 
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Line series line formatting options 

 
Line series point formatting options 

Change the Line Series Color 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series. 
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2. In the Series drop-down list on the Series tab, select the line series 
you want to change the appearance of. 

3. Click the Format sub-tab. 

 
Line series line formatting options 

   

4. Click the Color... button to open the color selection dialog box. 

5. Click on the line series color you want and then click OK to close the 
color selection dialog box. 

6. Click the Close button to finish. 

Change the Line Series Border 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series. 

2. In the Series drop-down list on the Series tab, select the line series 
you want to change the appearance of. 

3. Click the Format sub-tab. 
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Line series line formatting options 

   

4. Click the Border... button to open the border color editor. 

5. Make sure that the box labeled Visible is checked. 

6. Select the line series border style you want from the Style radio button 
group. 

7. Select the line series border width you want from the Width spin edit 
box. 

8. To change the line series border color, select the Color... button to 
open the color selection dialog box. 

9. Click on the line series border color you want and then click OK to 
close the color selection dialog box. 

10. Click OK to close the border color editor. 

11. Click the Close button to finish. 

Change the Line Series Pattern and Mode 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series. 

2. In the Series drop-down list on the Series tab, select the line series 
you want to change the pattern or mode of. 

3. Click the Format sub-tab. 
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Line series line formatting options 

   

4. To change the line series pattern, select a new one from the Pattern… 
button and click OK when finished. 

5. If you want each instance of the chosen pattern to have a unique color, 
check the box labeled Color Each. 

6. If you want the Line Mode to be such that the line is drawn in a stair-
step manner between your data points, check the box labeled Stairs.  
To invert the stair-step pattern, check the box labeled Inverted. 

7. Click the Close button to finish. 

Change the Line Series Point General Appearance 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series. 

2. In the Series drop-down list on the Series tab, select the line series 
you want to change point general appearance of. 

3. Click the Points sub-tab. 
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Line series point formatting options 

   

• Ensure that the box labeled Visible is checked. 

• Change the size of the points using the Width and Height spin 
edit boxes.  To adjust the axes to accommodate the point size, 
check the box labeled Inflate Margins. 

• To change the point marker, use the Style: drop list box to select a 
new one. 

• If you choose Square point markers, you can give them a three-
dimensional appearance by checking the box labeled 3D. 

7. Click the Close button to finish. 

Change the Line Series Point Color 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series. 

2. In the Series drop-down list on the Series tab, select the line series 
you want to change point general appearance of. 

3. Click the Points sub-tab. 
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Line series point formatting options 

   

4. Ensure that the box labeled Visible is checked. 

5. Click the Pattern... button to open the pattern selection dialog box. 

6. Click the Color… button to open the color selection dialog box. 

7. Click on the line series point color you want and then click OK to close 
the color selection dialog box. 

8. Click the Close button to finish. 

Change the Line Series Point Border 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series. 

2. In the Series drop-down list on the Series tab, select the line series 
you want to change point general appearance of. 

3. Click the Points sub-tab. 
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Line series point formatting options 

   

4. Ensure that the box labeled Visible is checked. 

5. Click the Border... button to open the border color editor. 

6. Make sure that the box labeled Visible is checked. 

7. Select the line series point border style you want from the Style radio 
button group. 

8. Select the line series point border width you want from the Width spin 
edit box. 

9. To change the line series point border color, select the Color... button 
to open the color selection dialog box. 

10. Click on the line series point border color you want and then click OK 
to close the color selection dialog box. 

11. Click OK to close the border color editor. 

12. Click the Close button to finish. 

Point Series Procedures 
This is an overview of procedures that can be executed from the Format sub-tab of 
the Edit Series tab for a Point Series.  

Point series are useful for X-Y plots, especially if the data are scattered or irregular.  
Quite often they are used to represent experimental data on a plot comparing 
observed and predicted results. 
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Point series formatting options 

Change the Point Series General Appearance 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series. 

2. In the Series drop list box, select the point series you want to change 
the appearance of. 

3. Click the Format sub-tab. 

4. Ensure that the box labeled Visible is checked. 

5. Change the size of the points using the Width and Height spin edit 
boxes.  To adjust the axes to accommodate the point size, check the box 
labeled Inflate Margins. 

6. To change the point marker, use the Style: drop list box to select a new 
one. 

7. If you choose Square point markers, you can give them a three-
dimensional appearance by checking the box labeled 3D. 

8. If you want each point in the series to have a random, different color, 
check the box labeled Color Each. 

9. Click the Close button to finish. 

Change the Point Series Pattern 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series. 

2. In the Series drop list box, select the point series you want to change 
the color of. 



 

 Series Formatting Procedures  •  361 

3. Click the Format sub-tab. 

4. Ensure that the box labeled Visible is checked. 

5. Click the Pattern... button to open the pattern selection dialog box. 

6. Click on the pattern you want and then click OK to close the pattern 
selection dialog box. 

7. Click the Close button to finish. 

Change the Point Series Border 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series. 

2. In the Series drop list box, select the point series you want to change 
the border of. 

3. Click the Format sub-tab. 

4. Ensure that the box labeled Visible is checked. 

5. Click the Border... button to open the border color editor. 

6. Make sure that the box labeled Visible is checked. 

7. Select the point border style you want from the Style radio button 
group. 

8. Select the point border width you want from the Width spin edit box. 

9. To change the point border color, select the Color... button to open the 
color selection dialog box. 

10. Click on the point border color you want and then click OK to close the 
color selection dialog box. 

11. Click OK to close the border color editor. 

12. Click the Close button to finish. 

Bar Series Procedures 
This is an overview of formatting procedures that can be executed from the Format 
sub-tab of the Edit Series tab for a Bar Series (Vertical and Horizontal).  Note 
that when adding a new bar series to a chart, BioWin assumes that the bar series will 
consist of vertical bars.  If this is not suitable for your chart, then you may change the 
bar series so that it uses horizontal bars by using the Change… option. 

Bar series are useful for current value plots and displaying steady-state simulation 
results.  Multiple bar series can be "stacked" to illustrate proportional differences. 



 

362  •  Series Formatting Procedures  

 
Bar series formatting options 

Change the Bar Series Color 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series. 

2. In the Series drop list box, select the bar series you want to change the 
color of. 

3. Click the Format sub-tab. 
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Bar series formatting options 

   

4. If you want each bar in the series to have a random, different color, 
check the box labeled Color Each. 

5. If you want all the bars to have the same color, click the Color... 
button to open the color selection dialog box. 

6. Click on the bar color you want and then click OK to close the color 
selection dialog box. 

7. If your bar series is three-dimensional and you want to have a shadow 
effect on the three-dimensional face, check the box labeled Dark Bar 
3D Sides. 

8. Click the Close button to finish. 

Change the Bar Series Border 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series. 

2. In the Series drop list box, select the bar series you want to change the 
border of. 

3. Click the Format sub-tab. 
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Bar series formatting options 

   

4. Click the Border... button to open the border color editor. 

5. Make sure that the box labeled Visible is checked. 

6. Select the bar border style you want from the Style drop-down list 
box. 

7. Select the bar border width you want from the Width spin edit box. 

8. To change the bar border color, select the Color... button to open the 
color selection dialog box. 

9. Click on the bar border color you want and then click OK to close the 
color selection dialog box. 

10. Click OK to close the border color editor. 

11. Click the Close button to finish. 

Change the Bar Series Pattern 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series. 

2. In the Series drop list box, select the bar series you want to change the 
pattern of. 

3. Click the Format sub-tab. 
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Bar series formatting options 

   

4. Click the Pattern... button to open the fill pattern editor. 

5. Make sure that the box labeled No pattern is un-checked. 

6. Select the pattern style you want from the Style radio button group. 

7. To change the pattern color, select the Color... button to open the color 
selection dialog box. 

8. Click on the pattern color you want and then click OK to close the 
color selection dialog box. 

9. Click OK to close the fill pattern editor. 

10. Click the Close button to finish. 

Change the Bar Series Shapes and Positions 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series. 

2. In the Series drop list box, select the bar series you want to change the 
shape and/or position of. 

3. Click the Format sub-tab. 
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Bar series formatting options 

   

• To change the shape of the bars in your bar series, use the Style: 
drop list box to choose from a variety of shapes. 

• You can change the amount of space between the bars in a series 
by changing the value in the % Bar Width: spin edit box.  
Increasing the value increases the width of the bars, thus 
decreasing the space between them. 

• You can shift the position of the bars in a series using the % Bar 
Offset: spin edit box.  This property especially is useful when 
plotting multiple bar series on the same chart. 

• If you want margins between the bars in a series and the chart 
boundaries, check the box labeled Bar Side Margins. 

• If you are labeling the bars in a series you can reduce the amount 
that labels will overwrite each other by checking the box labeled 
Auto Mark Position. 

4. Click the Close button to finish. 

Control Bar Placement for Multiple Bar Series 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series. 

2. In the Series drop list box, select one of the bar series.  In this special 
case of series formatting, selecting one bar series also will result in 
changes to the other bar series. 

3. Click the Stack sub-tab. 
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Bar series stack options 

   

4. In the Multiple Bar: radio button group choose one of the following 
options for bar placement: 

• None: This will place corresponding bars in each series in front of 
one another.  However, if your chart is three-dimensional you will 
be able to see portions of all the series. 

• Side: This will place corresponding bars in each series beside one 
another. 

• Stacked: This will place corresponding bars in each series on top 
of one another. 

• Stacked 100%: This will place corresponding bars in each series 
on top of one another showing the relative size of each bar on a 
100 % scale. 

• Side All:  This will place each complete series side by side. 

5. To have bar bottoms for a series start at the zero coordinate, check the 
box labeled Use Origin.  To have them begin at a different ordinate 
value, uncheck this box and input the desired starting value. 

6. Click the Close button to finish. 

Pie Series Procedures 
This is an overview of formatting procedures that can be executed from the Format 
sub-tab of the Edit Series tab for a Pie Series.  
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Pie series are useful for displaying proportional or fractional data when you desire to 
show the size of the portions relative to each other.  For example, pie series may be 
used to display wastewater characteristic fractions, plant sludge mass fractions, plant 
volume fractions, etc.  They also are a good method for displaying results in current 
value plots. 

 
Pie series formatting options 

Change the Pie Series General Appearance 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series. 

2. In the Series drop list box, select the pie series you want to change the 
appearance of. 

3. Click the Circled sub-tab. 
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Pie series circled options 

   

• If you want your pie series to be circular in shape, check the box 
labeled Circled Pie. 

• If you want to have an elliptical pie series, adjust the dimensions 
using the Horizontal and Vertical spin edit boxes in the Radius 
section.  To let BioWin determine your elliptical radii, check the 
boxes labeled Auto. 

• To rotate the pie chart, change the value in the Rotation: spin edit 
box. 

4. Click the Close button to finish. 

Change the Pie Series Color and Pattern 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series. 

2. In the Series drop list box, select the pie series you want to change the 
appearance of. 

3. Click the Format sub-tab. 

4. If you would rather have patterns as opposed to solid color fills for your 
pie slices, check the box labeled Patterns. 

5. If you choose to have pattern fills, you can change the underlying pie 
color.  Click the Back Color... button to open the color selection 
dialog box, select the pie color you want, and click OK. 

6. Click the Close button to finish. 
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Change the Pie Series Border 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series. 

2. In the Series drop list box, select the pie series you want to change the 
border of. 

3. Click the Format sub-tab. 

 
Pie series formatting options 

   

4. Click the Border... button to open the border color editor. 

5. Make sure that the box labeled Visible is checked. 

6. Select the pie series border style you want from the Style drop-down 
list box. 

7. Select the pie series border width you want from the Width spin edit 
box. 

8. To change the pie series border color, select the Color... button to open 
the color selection dialog box. 

9. Click on the pie series border color you want and then click OK to 
close the color selection dialog box. 

10. Click OK to close the border color editor. 

11. Click the Close button to finish. 

Change the Pie Series Three-Dimensional Appearance 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series. 
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2. In the Series drop list box, select the pie series you want to change the 
three-dimensional appearance of. 

3. Click the Circled sub-tab. 

 
Pie series circled options 

   

4. If you want your pie series to be three-dimensional, check the box 
labeled 3 Dimensions. 

5. If you want the three-dimensional pie face to have color, check the box 
labeled Color.  To give this color a slightly darker tint than the top of 
the pie series, check the box labeled Dark 3D on the Format tab. 

6. To have a darker shadow effect on the three-dimensional pie face, 
increase the value in the Horiz. Size and Vert. Size spin edit boxes in 
the section labeled Shadow. 

7. To change the shadow color, click the Color... button to open the color 
selection dialog box, select the shadow color you want, and click OK. 

8. Click the Close button to finish. 

Arrange the Pie Series Slices 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series. 

2. In the Series drop list box, select the pie series you want to change the 
three-dimensional appearance of. 

3. Click the Format sub-tab. 
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• If you want to place emphasis on the largest pie slice, use the 
Explode biggest spin edit box to separate the largest slice from 
the rest of the pie. 

• You can change the arrangement order of the pie slices using the 
Order drop list box. 

• You can combine all pie slices below a specified value or 
percentage into a single slice.  To do this: 

1. Use the Style drop list box to choose the criteria (below a certain 
value or percent) you want to use to group slices. 

2. In the Value text edit area, enter the cut-off value.  All pie slices 
below this value will be combined into one pie. 

3. You can label the grouped slices.  Click the Labels tab and ensure 
that Show Series Labels is checked.  Now click back on the 
Format tab and enter your text in the Label text edit area at the 
bottom of the dialog box. 

Area Series Procedures 
This is an overview of formatting procedures that can be executed from the Format 
and Points sub-tabs of the Edit Series tab for an Area Series. 

Area series are somewhat of a combination of a line chart and a bar chart.  They 
provide a richer way of displaying line chart data in three dimensions, and offer 
some of the stacking properties of multiple bar series to illustrate proportional 
differences.  As such they are useful for displaying results in current value charts. 

 
Area series formatting options 
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Area series point formatting options 

Change the Area Series General Appearance 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series. 

2. In the Series drop list box, select the area series you want to change 
the appearance of. 

3. Click the Format sub-tab. 
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Area series format options 

   

• If you want a pattern (drawn in black lines) on the face of your 
area series, use the Pattern drop list box to select the one you 
desire. 

• To have the points that define the area series joined in a “stair-
step” pattern, check the box labeled Stairs. 

4. Click the Close button to finish. 

Change the Area Series Color 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series. 

2. In the Series drop list box, select the area series you want to change 
the color of. 

3. Click the Format sub-tab. 
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Area series format options 

   

4. If you want each area segment in the series to have a random, different 
color, check the box labeled Color Each. 

5. If you want all the area segments to have the same color, click the 
Color... button to open the color selection dialog box. 

6. Click on the area color you want and then click OK to close the color 
selection dialog box. 

7. Click the Close button to finish. 

Change the Area Series Border 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series. 

2. In the Series drop list box, select the area series you want to change 
the border of. 

3. Click the Format sub-tab. 
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Area series format options 

   

4. Click the Border... button to open the border color editor. 

5. Make sure that the box labeled Visible is checked. 

6. Select the area border style you want from the Style radio button 
group. 

7. Select the area border width you want from the Width spin edit box. 

8. To change the area border color, select the Color... button to open the 
color selection dialog box. 

9. Click on the area border color you want and then click OK to close the 
color selection dialog box. 

10. Click OK to close the border color editor. 

11. Click the Close button to finish. 

Change the Area Series Lines 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series. 

2. In the Series drop list box, select the area series you want to change 
the lines of. 

3. Click the Format sub-tab. 
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Area series format options 

   

4. Click the Area Lines... button to open the border color editor. 

5. Make sure that the box labeled Visible is checked. 

6. Select the area line style you want from the Style radio button group. 

7. Select the area line width you want from the Width spin edit box. 

8. To change the area line color, select the Color... button to open the 
color selection dialog box. 

9. Click on the area line color you want and then click OK to close the 
color selection dialog box. 

10. Click OK to close the border color editor. 

11. Click the Close button to finish. 

Control Area Placement for Multiple Area Series 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series. 

2. In the Series drop list box, select one of the area series.  In this special 
case of series formatting, selecting one area series also will result in 
changes to the other area series. 

3. Click the Format sub-tab. 
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Area series format options 

   

4. In the Multiple Areas: radio button group choose one of the 
following options for area series placement: 

• None: This will place each area series in front of one another.  
However, if your chart is three-dimensional you will be able to see 
portions of all the series. 

• Stacked: This will place each area series on top of one another. 

• Stacked 100%: This will place each area series on top of one 
another showing the relative size of each area on a 100 % scale. 

5. Click the Close button to finish. 

Change the Area Series Point General Appearance 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series. 

2. In the Series drop list box, select the area series you want to change 
the point general appearance of. 

3. Click the Point sub-tab. 
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Area series point options 

   

• Ensure that the box labeled Visible is checked. 

• Change the size of the points using the Width and Height spin 
edit boxes.  To adjust the axes to accommodate the point size, 
check the box labeled Inflate Margins. 

• To change the point marker, use the Style: drop list box to select a 
new one. 

• If you choose Square point markers, you can give them a three-
dimensional appearance by checking the box labeled 3D. 

• To give this color a slightly darker tint than the top of the pie 
series, check the box labeled Dark 3D. 

4. Click the Close button to finish. 

Change the Area Series Point Pattern 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series. 

2. In the Series drop list box, select the area series you want to change 
the point color of. 

3. Click the Point sub-tab. 
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Area series point options 

   

4. Ensure that the box labeled Visible is checked. 

5. Click the Pattern... button to open the pattern selection dialog box. 

6. Click on the area series point pattern you want and then click OK to 
close the color selection dialog box. 

7. Click the Close button to finish. 

Change the Area Series Point Border 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series. 

2. In the Series drop list box, select the area series you want to change 
the point border of. 

3. Click the Point sub-tab. 
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Area series point options 

   

4. Ensure that the box labeled Visible is checked. 

5. Click the Border... button to open the border color editor. 

6. Make sure that the box labeled Visible is checked. 

7. Select the area series point border style you want from the Style radio 
button group. 

8. Select the area series point border width you want from the Width spin 
edit box. 

9. To change the area series point border color, select the Color... button 
to open the color selection dialog box. 

10. Click on the area series point border color you want and then click OK 
to close the color selection dialog box. 

11. Click OK to close the border color editor. 

12. Click the Close button to finish. 

Surface Series Procedures 
This is an overview of formatting procedures that can be executed from the Format 
and Grid sub-tabs of the Edit Series tab for a Surface Series. 

Surface series can be used for spatial profiles of a given compound.  For example, 
say you have a configuration with three bioreactors, and you want to show the 
ammonia profile over the bioreactors.  The ammonia concentration would be plotted 
on the Y (vertical) axis, the bioreactor number would be plotted on the X (horizontal) 



 

382  •  Series Formatting Procedures  

axis, and time would be plotted on the Z axis.  They also are useful for displaying 
time-histories of secondary settler depth - concentration profiles. 

 
Surface series formatting options 

 
Surface series grid options 
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Surface Series Gridline Appearance 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series. 

2. In the Series drop list box, select the surface series you want to 
change the gridlines of. 

3. Click the Format sub-tab. 

 
Surface series formatting options 

   

4. Click the Pen… button to open the border color editor. 

• To turn the gridlines on or off, check or uncheck the box labeled 
Visible. 

• To change the gridline thickness, increase or decrease the value in 
the Width spin edit box. 

• To change the line style (e.g. solid, dashed, etc.) used to draw the 
gridlines, click the appropriate radio button in the Style radio 
button group.  Note that you may not have a Width greater than 1 
with any style other than Solid. 

• To change the gridline color button, click the Color button to open 
the color selection dialog box. 

5. When you are satisfied with the appearance of your surface series 
gridlines, click OK to close the border color editor. 

6. Click the Close button to finish. 
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Surface Series Drawing Mode 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series. 

2. In the Series drop list box, select the surface series you want to 
change the drawing mode of. 

3. Click the Format sub-tab. 

 
Surface series formatting options 

   

4. From the Drawing Mode radio button group, choose from the 
following: 

• To have a colored surface, choose Solid mode. 

• To have a surface with only the gridlines showing, choose 
WireFrame mode. 

• To have your surface drawn with a series of small dots, choose 
DotFrame mode.  Note that this mode may be difficult to see with 
some color combinations. 

5. When you are satisfied with the appearance of your surface series, click 
the Close button to finish. 

Surface Series Color Mode 
1. Right-click on the chart to open the Edit menu, and then click Edit 

Series. 

2. In the Series drop list box, select the surface series you want to 
change the color mode of. 
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3. Click the Grid 3D sub-tab. 

 
Surface series grid options 

   

4. From the Color Mode radio button group, choose from the following: 

• To have one color for the entire surface, choose Series Color 
mode.  Click on the color button next to this option to open the 
color selection dialog box if you want to change the color. 

• To have a gradient color fill for the surface, choose Range mode.  
Click on the From: and To: color boxes to change the colors used.  
The From: color is assigned to points with the largest Y value (i.e. 
the "high" points in the surface), and the To: color is assigned to 
points with the lowest Y value (i.e. the "low" points in the surface). 

• To have a stepped color fill for the surface, choose Palette mode.  
The value in the Steps spin edit box determines the range of 
colors used in the surface fill, and the height of each point in the 
surface determines its assigned color from that range. 

5. When you are satisfied with the appearance of your surface, click 
Close to finish. 
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Managing BioWin Projects 

Setting Project Options 
Project options are specific to the current project.  When you set current project 
options, they will override any similar settings that you have applied to your BioWin 
defaults with the Project|New Project Options command.  For example, if you 
have set your default flowsheet color to be blue with the Project|New Project 
Options command, but for “Project A” you want the drawing board color to be 
white, then you would set the drawing board color to white in “Project A” using the 
Project|Current Project Options command.  Now the drawing board color for 
“Project A” will be white, regardless of the default values you have set. 

Since project options are file specific, they “travel” with that file.  For example, if 
you define a set of project options for “Project A” on your copy of BioWin and then 
open the “Project A” file in a colleague's copy of BioWin, you still will see your 
defined project options.  As before, these project options will override any similar 
settings that the owner of the other copy of BioWin has set as defaults using the 
Project|New Project Options command. 

Drawing Board Options 
This section outlines the various project options that can be set for the drawing 
board.  The drawing board options may be accessed in the main simulator window 
by choosing Project|Current Project Options from the menu and selecting the 
Drawing board tab, shown in the picture below. 
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Current project drawing board options tab 

Aspects of the Drawing board appearance that may be changed include the 
Font and the Color.  Clicking the Font… button will open the font properties 
dialog box and will allow you to change the font that is used to label element 
pictures on the drawing board.  Selecting a new color from the drop list box will 
change the background color of the drawing board.  Notice that a preview of the 
drawing board background color and the selected font is given in the dialog box. 

The Drawing board size also may be changed.  Changing the values in the Width 
and Height spin edit boxes will change the overall dimensions of the drawing board.  
The size of the main window occupied by the drawing board is not changed, 
however, the overall size is changed as evidenced by a change in the size of the 
scroll box in the scroll bar.  The default values of 6,000 by 2,000 translate roughly to 
60 by 20 inches.  It should be mentioned here that if you plan to be performing copy 
and paste actions with Microsoft Word, the size of drawing board that you can copy 
into Word is limited to 22 by 22 inches.  The zoom limits of the drawing board can 
be set so that zooming can only take place between minimum and maximum levels. 

The Drawing board snap resolution can be changed in either or both the X and Y 
directions.  The snap feature helps you align elements precisely on the drawing 
board.  When you place or move an element on the drawing board, it aligns itself 
(i.e. “snaps”) to the nearest grid point (grid points are invisible).  Therefore, 
increasing the snap values results in a coarser grid for the elements to snap to which 
means that you have less control over their placement.  Decreasing the snap values 
results in a finer grid for the elements to snap to which means that you have 
increased control over their placement. 

You can change the drawing board Element display.  You can choose to have the 
display of element names either on or off. 
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Pipe Options 
You can change the default style for new pipes in a project by choosing one of the 
four available styles in the Default new pipe style group.  For information on the 
various pipe styles, see the Pipes topic in the Element Types chapter. 

The “arrow angle” refers to 
the acute angle between the 
arrow side and the line.  For 
example, if you want arrows 
with “flat” bases, set the 
arrow side angle to the 
maximum of 60 degrees. 

You also can control the appearance of pipes in your project, using the 
Project|Current Project Options menu command and selecting the Pipe tab, 
shown in the figure below.  To change the Color, Width, and Style of the lines 
used to represent pipes on the drawing board, click on the Pipe Lines… button.  
You may increase the arrow size on the lines used to represent pipes.  The arrow 
angle also can be changed. 

 
Current project pipe options tab 

Note that it also is possible to change pipe line and arrow settings for individual 
pipes.  Access the properties of the pipe you wish to change by double-clicking it or 
right-clicking it and selecting Properties… from the resulting pop-up menu.  Next, 
check the box labeled Local pipe options and you will be presented with the same 
set of options that have just been outlined; however, these changes will affect this 
particular pipe only. 
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Pipe line options dialog box 

Unit System 
This section outlines the various options that can be set for the unit system used in a 
project.  The project unit system may be accessed in the main simulator window by 
choosing Project|Current Project Options from the menu and selecting the Unit 
system tab, shown in the picture below. 
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Project unit system options 

In the Flow units radio button group, you may choose from the following: 

   

• cubic meters per day (m3/d) 

• litres per day (L/d) 

• megalitres per day (ML/d) 

• megagallons per day (mgd) 

It should be noted that the same basis is used for flow and volume.  For example, if 
you choose L/d as your flow unit, then volumes (e.g. for bioreactors, settling tanks) 
will be in litres also.  Note that air flowrates are in units of m3/hr. 

If you choose mgd as your flow basis, then the following imperial units will be used 
for other calculations in BioWin: 

Measure Imperial Unit 
Length feet (ft) 
Area square feet (ft2) 
Mass pounds (lbs) 
Pressure pounds per square inch (psi) 
Air Flow Standard Cubic Feet per Minute 
Specific Velocity gal/ft2/d 
Mass Loading Rate lbs/ft2/d 
Concentration milligrams per litre (mg/L) 
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In the BOD basis radio button group, you may choose the length of time that 
BioWin uses to calculate BOD values.  You may choose between 5, 7, and 20 day 
BOD. 

Model Options 
This section outlines the various project model options that can be modified in order 
to remedy any solution problems and improve simulation speed.  These parameters 
may be accessed in the main simulator window by choosing Project|Current 
Project Options from the menu and selecting the Model tab, shown in the picture 
below. 

 
Current project model options 

There are a number of options for the model used in biological processes: 

   

• You can choose whether or not you want to use the BioWin activated 
sludge process / anaerobic digestion model.  Likely the only time that 
you would un-check this box is if you want to run another model in the 
biological processes (e.g. one of the IWA models).  For details on the 
BioWin integrated ASP/AD model, please refer to the Activated 
Sludge Model and Anaerobic Digestion Modeltopics in the 
Process Model Formulation chapter. 

• You can choose whether or not you use the current project’s Model 
Builder model.  If the BioWin model is unselected and the Model 
Builder model is selected, then only processes specified in the Model 
Builder model will be used.  If both the BioWin and Model Builder 
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models are selected, then the Model Builder model will act as an 
“overlay” to the BioWin model.  For information on using the Model 
Builder, please see the Model Builder topic in the Element Types 
chapter. 

• Using the provided check box, users can select whether or not to use 
oxygen modeling.  When this option is selected BioWin will model the 
impact of DO transfer in streams (from unit to unit and in the recycles) 
and the DO concentration in bioreactors when aeration is specified in 
terms of an airflow rate rather than a setpoint DO concentration.  This 
selection impacts execution times, particularly for dynamic simulations.  
The following points should be noted regarding this option: 

1. If DO modeling is not switched on, and DO is specified by setpoint 
concentration in bioreactors, BioWin still computes oxygen uptake 
rates and other aeration features such as SOTR, OTR, SOTE, OTE, 
and air flow rate. 

2. If DO modeling is not switched on, and an air flow rate is specified 
for a bioreactor, the user is warned to switch on the DO modeling 
option so that the DO concentration in the bioreactor is calculated. 

3. If the user specifies a DO concentration for an input element and 
DO modeling is switched off, BioWin will ignore the specified DO 
concentration (i.e. the DO value will be taken as zero). 

4. If a DO value is entered for an input element and DO modeling is 
switched off, the DO value will not be changed in the file (even if 
the file is saved while DO modeling is switched off). 

• Many of the process rates in the BioWin ASP/AD model are impacted 
by pH.  If you would like to model pH inhibition in the model, you can 
do so by selecting the option in this dialog box.  If you do not want to 
account for pH impacts on model rates, un-check this option. 

• BioWin has the ability to model precipitation of Struvite, HDP, and 
HAP.  If you would like to model these reactions, this box should be 
checked.  For details on the modeling of these reactions, please see the 
Spontaneous Chemical Precipitation section of the Process 
Model Formulation chapter 

• You can select whether or not to model chemical phosphorus 
precipitation reactions.  If you select to model chemical phosphorus 
precipitation reactions, be sure to select the metal (i.e. iron or 
aluminum) to be used in the precipitation reactions.  Note that the metal 
selected here will impact the interface shown in the Metal Addition 
Influent. 

• You can view the stoichiometry of the current model by clicking the 
Show calculated stoichiometry… button.  This button opens a 
window that shows the stoichiometry of the BioWin biological model 
that will be used at your current parameter values: 
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Stoichiometry of BioWin biological model at current parameter values 

   

• Finally, this dialog box allows you to choose between BioWin’s two 
available flux theory based settling models – a Modified Vesilind 
model or the well-known Double Exponential model.  Note that the 
model selected here only is active in model secondary settlers and SBR 
units (i.e. this choice does not impact the operation of point and ideal 
secondary settlers).  For more information on the Modified Vesilind 
and Double Exponential secondary settler models, please see the 
Settling Models section of the Process Model Formulation chapter. 

You can also get model-related information for any particular element in a 
configuration.  Right-clicking on an element and choosing either Mass balance… 
or Rates… displays the following model information. 

Mass Balance Window 
BioWin allows the user to see the mass balance of chemical oxygen demand (COD), 
nitrogen (N) and phosphorus (P) over any particular element.  This window allows 
the user to select the material of interest (COD, N or P) and view the mass flow rates 
in and out of the vessel.  At steady state conditions the mass balance should be zero, 
for each of these items, that is the amount of COD, N or P flowing should be the 
same as the amount flowing out of the vessel.  The figure below shows an example 
of a mass balance window for a bioreactor at steady state conditions. 

Note: Different elements may have slightly differing layouts for the mass balance 
window.  For example a clarifier element (which has no gas input uses the list box 
below the graphic to represent the underflow. 
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Mass balance window for a bioreactor at steady state conditions 

The list box on the left represents the liquid input to vessel and the list box on the 
right the output from the vessel.  The gas phase is represented by the list boxes above 
and below the graphic.   

Note: If the gas phase is not modeled then BioWin reports the amount transferred to 
or from the liquid phase rather than the actual gases stripped from the liquid phase 
(in COD units).  In the figure below the gas phase was modeled and consequently the 
oxygen reported in the lower list box represent the entire oxygen content of the gas, 
and the majority of the oxygen is also reported in the exit gas (top list box). 
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Mass balance window for a bioreactor at steady state conditions with gas phase modeled 

In each of the list boxes, any state variables that contribute to the material selected 
(COD, N, or P) are listed and the mass flow rate for each given.  You will notice that 
although the figure above shows the mass balance for COD the nitrate (NO3-N) state 
variable is listed in both the input and output list boxes and that it is negative.  This is 
because nitrate can be used as an electron acceptor.  The mass balance window takes 
this into account and therefore reports NO3-N as a negative number.  The mass 
balance window also accounts for the oxygen demand associated with ammonia so it 
too is reported in the list box.   

Note:  If the COD mass balance is selected then all items in the list box (including 
nitrogen components) are reported on COD units. 

   

Note: If nitrogen precipitates are present they may also be listed in the mass balance 
window for COD and N. 

Rates Window 
BioWin allows the user to view the rates of reactions in bioreactor vessels.  The rates 
window will normally be used only as a diagnostic tool for simulation difficulties.  
The rates window shows the rate ( mg L-1 d-1 ) for each of the processes in the 
BioWin biological model and the reaction term ( g d-1 ) for each of the state 
variables.  An example of the rates window is shown below. 

 
Rates window 

Note: The units of the reaction term are always in g d-1 regardless of your current 
project unit selection. 

Numerical Parameters 
This section outlines the various project model options that can be modified in order 
to remedy any solution problems and improve simulation speed.  These parameters 
may be accessed in the main simulator window by choosing Project|Current 
Project Options from the menu and selecting the Numerical Parameters tab, 
shown in the picture below. 
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Current project numerical parameters 

The Seed sludge age parameter is used to calculate seed values for the biological 
system.  The seed values help the BioWin solver engine to determine an appropriate 
solution for the system, or are used at the beginning of dynamic simulations (if you 
select to start a dynamic simulation from seed values). 

BioWin uses the seed sludge age that you specify, along with the strength of the 
influent wastewater and reactor volumes, to perform an approximate steady state 
calculation in order to guess at what the concentrations will be in elements.  The 
analysis is based on simple continuous flow steady state equations, so it only is 
approximate.  Note that the seed sludge age in no way affects the actual SRT of a 
plant configuration - this is set strictly by the mass of solids that are removed from 
the system each day (i.e. via wastage and decant). 

If you suspect an inappropriate solution, or if BioWin has trouble finding a steady 
state solution, the seed sludge age may be changed in order to provide different seed 
values.  These different seed values may improve the solution behavior. 

The Steady state solver is a powerful search algorithm provided in BioWin to 
solve the model under steady-state (constant flow, concentration and operating) 
conditions.  The BioWin Hybrid method utilizes a combination of the Newton-
Raphson (NR) second order search, and a Decoupled Linear Search (DLS).  
Both algorithms have advantages in certain situations, and BioWin will select the 
best method and switch between them if necessary.  Newton-Raphson prefers 
smooth, continuous functions, and can reduce the error by two orders of magnitude 
in an optimal case.  The DLS method uses much smaller steps and is not sensitive to 
sharp discontinuities and non-linearities. 
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Steady State Solver Options 
The user can select from the three available methods for steady state convergence.  
There also are a number of options (available by pressing the Options button) for 
the each of the different methods.  Key options are explained here. 

 
Steady state solver options 

Hybrid: 
Initial DLS EC (Decoupled Linear Search Error Criteria) (10) - BioWin will 
use the DLS method until it achieves an error of less than the initial DLS error 
criteria or it performs more than the initial DLS iterations [DLS Iter's" (2500)] at 
which time it will switch to the NR method. 

Non conv. (500) - This value is used to determine if the NR solver is stuck.  
Increasing it will make the solver consider itself stuck over a wider range of values. 

Bad NR inver. (5) - If the NR solver takes this many steps in the a direction which 
results in an increase in the error then DLS will be activated 

Modified Newton-Raphson: 
Step size (100%) - Use the original NR estimated steps for each state variable.  
Can be reduced to make the method more cautious. 

Derivative Method - This setting can be used to choose between central finite 
difference and forward finite difference numerical derivative approximations. 

Decoupled Linear Search: 
Grow by (3) - Step size increasing by 0.03% for successful iterations. 

Shrink by (18) - Step size decreasing by 1.8% for failed iterations. 

Max negative (50%) - Maximum allowed negative step. 

Max positive (50%) - Maximum allowed positive step. 

Initial size (5%) - Size of initial perturbation. 
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Error [0.01 (units of mg/L/d {g/m3/d} if using the default dC/dt and g/d if 
using dM/dt)] - Error criteria to stop iterations if mass balance is closer than this to 
the solution. 

Note:  You can set the steady state solver to use conservative parameter values if 
you have trouble finding a steady state solution for a configuration (see Tips for 
Systems that are Difficult to Solve below). 

Dynamic Simulator Options 
There are also options for the Dynamic Simulator.  Increasing the Maximum 
allowable error (0.1%) may improve dynamic simulation speed, but the reduced 
error criterion may also result in poorer mass balances.  The Step-size scaling 
factor (70%) determines how the dynamic solver adjusts the step size.   

There also are a number of options (available by pressing the Options button) for 
fine tuning the simulator performance.  You can also specify the Minimum size for 
relative error calculation (0.0001) which is the value below which error 
calculation will switch to absolute error. 

The Excessive negative rate damping section contains the setting to control the 
PowerMonod.  Traditionally Monod switching functions are used in activated sludge 
models to turn rates on and off depending on concentration of oxygen, substrates, 
nutrients, etc. In chemical systems however, the rates and functional concentration 
changes cover many orders of magnitudes. A standard Monod switching function 
provides about one order of magnitude reduction in the rate if the concentration 
decreases one order of magnitude.  In Chemical systems this is frequently 
insufficient to effectively shut down a chemical rate. This may result in an 
excessively slow dynamic simulation when a high negative rate is affecting a small 
concentration as the solver has to dramatically reduce the integration step size to 
prevent negative concentration values. In BioWin, under special circumstances, a 
more powerful switching function, (PowerMonod) is used to turn off precipitation 
rates based on the available soluble metal concentration. The PowerMonod 
expression is only applied during dynamic simulations. 

Concentration limit (default = 0.001 mg/L) - The PowerMonod function is 
only applied below this concentration limit.  This approach is in contrast to the 
traditional Monod switching functions that are applied at all concentrations.  
Reducing this concentration limit allows increased accuracy, but the simulation 
speed is impacted.  The concentration limit should never be increased beyond its 
default value (0.001 mg/L). 

Damping power (default value = 3) - This is an exponent applied to the Monod 
saturation function. The traditional Monod expression has a damping power of 1. 
The amount of damping increases as the Damping power is increased. In typical 
precipitation runs the default should provide satisfactory results. 

Under extreme pH values it may be necessary to increase the Damping power (to 5 
or 10) to improve simulation speed. 

Relative Monod constant (default value = 0.1) - The PowerMonod expression 
is applied in the range from 0 to Concentration limit. This parameter behaves like 
a half saturation value within this range.  The default value of 0.1 is equivalent to 
10% of the Concentration limit (0.1 * 0.001 = 0.0001 mg/L at the default values). 
Typically this parameter does not require adjustment. 

Rate/concentration ratio - The PowerMonod function will only be applied if: 

   

• the calculated rate is negative, and 
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• the absolute ratio of the calculated rate to the concentration is larger 
than this parameter.  

Typically this ratio normally does not need to be adjusted. 

 
Dynamic simulation options 

Tips for Systems that are Difficult to Solve 
By default BioWin uses an adaptive hybrid solver to search for a steady state 
solution.  This solver uses a combination of a modified Newton-Raphson method and 
an uncoupled search algorithm.  Typically the solver will find a solution in less than 
15 iterations, although for complex systems this might take longer.  

Note: After a system has been solved to a steady state solution it is almost always 
easier for the solver to converge on the solution from current values rather than from 
seed.  If a particular organism type is “washed-out” in a steady state solution then 
starting from current values may bias the solver against them and it may be better to 
start from seed.. 

If the solver is experiencing difficulties in finding a solution  the parameters uses in 
the solver are adapted automatically, nevertheless there may be situations where 
either the solver is still unable to determine the solution, or the user wishes to 
changes the solver parameters to improve performance.  [The solver does not 
improve the error value for more than 20-30 iterations, or becomes very slow.]  If 
you are experiencing difficulties in determining the steady state solution for a 
particular configuration you have a number of options. 

   

1. Check that volumes, flows, DO settings, influent concentrations are all 
valid. Try matching the seed sludge age of the system. If you are using 
SRT control, try fixed wastage flow first. 

2. Try using the complex seeding method (non SRT control systems). 
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Start your simulation. [Press F6 or select Simulate | Steady State]  
This will open the Steady State solver dialog box, check the Use 
Complex seed checkbox before pressing the Run button (as shown 
below). 

 
Press the play button to begin the simulation.  BioWin opens a dialog 
which shows the progress of the complex seeding.  This dialog is 
shown below. 

The complex seeding essentially performs a dynamic simulation at the 
steady state conditions.  The dialog box will close automatically if 
either the Dynamic time target or the Step size target is achieved.  
Generally it is not necessary to wait for the dialog box to close 
automatically as a short period of dynamic seeding will usually be 
sufficient to improve the performance and the user can press the Try 
Now! button at any time to start the main solver.  

3. A third approach is to try using more conservative settings for the 
solver. BioWin provides a set of Conservative parameter defaults 
(see Steady State Solver Optionsabove) or you can enter your own 
selection of parameter values.   

Note: Using the conservative values forces the solver to make smaller adjustments 
which usually increases the number of iterations but also stops very bad adjustments.  
These values are stored with the project file, and do not affect other simulations.  

   

Note: The BioWin default conservative values are particularly applicable to 
systems in which spontaneous chemical precipitation (HDP, Struvite) is probable as 
these reactions have extremely rapid reaction rates. 
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4. For certain systems it may be better to use only one of the solution 
techniques. That is rather than using the hybrid method, use either the 
modified Newton-Raphson method or the search algorithm.  The 
Numerical Parameters tab allows you to select any one of these 
methods. 

Note: The double exponential settler model is generally not well behaved for the 
Newton-Raphson method.  

5. Simplify the model. 

Simplify the model by turning off one (or more) of the options on the 
Model Options tab; namely  

• pH inhibition for activated sludge kinetics. 

• pH calculations. 

• Oxygen modeling. 

• Chemical precipitations. 

• Metal precipitation chemistry. 

Now try to solve the system, if a solution is achieved then you may 
start turning the options back on and resolving starting from the 
Current values.  

6. For very complex configurations with difficulties finding a solution a 
general step-wise method may be useful: 

• Simulate with pH modeling, limitation, etc turned off. 

• Enable pH modeling, simulate from current values. 

• Enable pH limitation, simulate from current values. 

• Enable Struvite, Ca-phosphates modeling (if required), simulate 
from current values. 

• Enable metal precipitation modeling(if required), simulate from 
current values. 

Repeat this step-wise method with conservative settings solver settings, 
or using only one of the solver method. 

7. If a configuration does not converge in spite of trying the methods 
described above: 

• Consider simplifying the configuration if at all possible. 

• Send the configuration (*.bwc file) with the description of the 
problem (exact steps) for support to info@envirosim.com) 

   

Note: Under some circumstances merely stopping and then restarting the solver 
from Current values will assist the solver.  This essentially resets the solver 
parameters, but provides different seed values. 

   

Note : The Solution not found message is displayed when the solver has : 
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• Identified a singular matrix – in which case you may be able to 
solve using the selecting the Decoupled Linear search option on the 
Numerical Parameters tab. 

• Exceeded the maximum number of iterations allowed – you should 
probably try one of the methods described above. 

• Experienced numerical instability or range problems  – you should 
probably try one of the methods described above. 

   

Solids Retention Time Calculation 
 SRT tool BioWin offers the functionality of Solids Retention Time (SRT) calculation for a 

project process configuration.  The dialog box shown below, accessed via the 
Project|Active SRT menu command or the calculate/control SRT tool, is used to 
supply BioWin with the information required to perform this calculation. 

An enhancement that has been made regarding SRT calculation is that BioWin now 
has the ability to store multiple SRT calculation scenarios.  For example, suppose 
that you want to look at the impact of effluent suspended solids on the SRT of a 
system.  To do this you could set up one SRT calculator that includes the effluent as 
a wastage element, and one SRT calculator that does not.  Another possible scenario 
would be if calculating the SRT for each sludge in a two sludge system. 

The first step in setting up an SRT calculator is to select the Project|Active SRT 
menu command or to click the New… button on the calculators toolbar.  When you 
do this, you will be presented with the following dialog box. 

 
Project SRT calculation dialog box 

Enter a name for this SRT calculation scenario in the text box provided.  You can 
make this SRT the Active SRT by clicking the check box with this label.  Next, you 
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must specify the elements in the configuration that will be used to calculate the total 
mass in the system.  To do this, click the Select elements for total mass… 
button.  When you do this, you will be presented with a two-paned dialog box, 
shown below. 

Note:  If you have set up more than one SRT calculator, the active SRT will be 
displayed in the main simulator window status bar.  To change the SRT calculator 
that currently is active, go to the calculators toolbar, select the SRT calculator you 
want to make active from the drop list, and click the Configure… button on the 
calculators toolbar. 

 
Dialog box used to select elements for total mass in SRT calculation 

In the left-hand Elements pane, there is an expandable/collapsible tree view of the 
various elements in the configuration.  You can expand/collapse the branches of this 
tree by clicking on the +/- signs next to the branches, or by double-clicking on the 
branch labels.  Using this navigation technique, locate the elements that you wish to 
include in the total mass calculation.  When you find an element that you wish to 
include, move it to the right-hand Selected elements pane by clicking on the 
element name and then clicking the right-pointing arrow located between the two 
panes.  When you have added all the elements that you wish to include in the total 
mass calculation, click the OK button. 

The next step in SRT calculation is to select the elements in the configuration from 
which wasting of solids is taking place.  To do this, click the Select wastage 
elements… button.  When you do this, you will be presented with another two-
paned dialog box, shown below. 
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Dialog box used to select wastage elements for SRT calculation 

In the left-hand Elements pane, there is an expandable/collapsible tree view of the 
various elements in the configuration.  You can expand/collapse the branches of this 
tree by clicking on the +/- signs next to the branches, or by double-clicking on the 
branch labels.  Using this navigation technique, locate the elements that solids are 
being wasted from.  When you find an element that you wish to include, you move it 
to the right-hand Selected elements pane by clicking on the element name and 
then clicking the right-pointing arrow located between the two panes.  When you 
have added all the elements that you wish to include in the total mass calculation, 
click the OK button.  Note that if any multi-output elements (e.g. clarifiers which 
have underflow and overflow outputs) are specified as wastage elements, BioWin 
assumes that solids wasting is occurring in their Side or Overflow streams. 

Now that you have completed the two required steps for SRT calculation, you may 
close this dialog by clicking OK.  The next time that you perform a steady state or 
dynamic simulation, the main window status bar will be updated and the SRT in time 
units of days will be displayed.  Note that the frequency of this update is governed by 
the summary pane refresh frequency. 

Note:  To remove an element (or elements) from the Selected elements column 
of either of the dialog boxes used to select elements for SRT calculation, click once 
on the element name so that it is highlighted blue, and press the Delete key on your 
keyboard. 

Once you have given BioWin the necessary information it needs to calculate the SRT 
for a configuration, you can extend BioWin's SRT calculation functionality by telling 
BioWin to control the wastage of solids from a particular splitter element in order to 
achieve a desired SRT.  To do this, check the box labeled Control SRT.  The dialog 
box will now change in appearance to the one shown below. 
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Project SRT calculation and control dialog box 

A Control SRT group now occupies the lower portion of the dialog box.  Two spin 
edit boxes (one marked d for days and one marked h for hours) are used for setting 
the desired SRT.  Using the Select SRT control splitter drop list box, you then 
may select the splitter element in the configuration that BioWin will use to control 
the wastage rate in order to achieve the desired SRT. BioWin assumes that the side 
stream of the splitter will be the wastage stream, and it changes the setting in the 
splitter element to control the side stream flow. When you click OK to close this 
dialog box, you will notice that the splitter that you specified as the control will have 
a new drawing board icon that shows a valve on the wastage stream.  Note that you 
will be unable to close this dialog box with the OK button if you have not specified 
all the required information. 

If you now perform a steady state simulation, BioWin will adjust the wastage rate 
out of the control splitter so that the SRT of the configuration is that which you have 
specified.  This SRT will be displayed in the main window status bar once the steady 
state solution has been found.  It should be noted that the SRT controller only sets 
the wastage rate for steady state conditions. If you begin a dynamic simulation after 
you complete a steady state simulation, the wastage flow rate will remain constant at 
the value calculated. That is, there is no control of wastage rates during a dynamic 
simulation. 

Note:  It is now possible to plot SRT against time.  If you have multiple SRT 
calculators set up, you can plot as many of them as you wish.  For information on 
setting up an SRT plot, see the Special Series (from Album) section of the 
“Creating Charts and Adding Series” chapter. 
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Specifying Project Details 
This section outlines the various details that can be specified for the project.  The 
project details may be accessed in the main simulator window via the Project|Info 
menu command, which will present you with the dialog box shown below. 

 
Dialog box used for entering project details and information 

The Project information group contains details on the current project: 

   

• Creation date:  this field indicates the date and time that the current 
BioWin project was created. 

• Last saved:  this field indicates the date and time that the current 
BioWin project was saved. 

• Simulation start date:  use this field to set the date that will be used 
as the default starting date for dynamic simulations.  Note that if you 
want to specify another date different from the one you specify here 
when doing a dynamic simulation, you may do so.  When you click the 
down arrow you will be shown a calendar from which you can choose 
the date.  The current day is circled in red, and the day that currently is 
selected is indicated by a solid blue oval.  You may use the left and 
right arrow buttons at the top of the calendar to move to different 
months. 

• User name:  use this field to indicate the name of the person 
responsible for the project. 

• Project name:  use this field to indicate the name of the project. 

• Project reference:  use this field to indicate the project reference 
code. 
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• Plant name:  use this field to indicate the name of the plant that the 
simulation project is for. 

Recording Project Notes 
The project note editor, shown in the picture below, is a tool that may be used to 
record information relevant to the current project.  You can access the editor via the 
menu command Project|Notes.  It is similar in operation to the WordPad utility 
that comes with Windows 95.  The notes that you make can have some formatting 
applied to them since they are Rich Text Format files (*.RTF).  When you save the 
BioWin project that the notes are associated with, the notes will be saved as a 
separate notes file (*.NTS) that can be accessed by other applications such as word 
processors since it is in standard rich text format.  Note that the notes will always be 
available in BioWin when the project they are associated with is active. 

 
The project notes editor 

Specifying Project Model Parameter Values 
BioWin allows you to override the default model parameter values for a project via 
the Project|Model Parameters command.  This command invokes the Model 
Parameters editor.  For information on this dialog box, see the Model Parameter 
Editor section.  The changes made to project model parameters using this tool will 
affect all elements in the project configuration except those that have local 
parameters specified. 

Specifying Project Temperature 
BioWin allows you to specify a global temperature for a project via the 
Project|Temperature command.  Invoking this command presents you with the 
Edit global temperature dialog box, shown below. 
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Dialog used to set the global project temperature 

In the Specify temperature by radio button group, you may choose from two 
options for global temperature.  If you want a constant temperature in your project 
elements, then enter the desired temperature value in the Constant value of text 
edit area.  Note that if you wish, you can override this global temperature in 
individual elements. 

If you want a time-varying temperature pattern, then select the Scheduled radio 
button.  This will activate the Pattern… button.  Clicking this button presents you 
with the Edit temperature itinerary dialog box. 

Note:  Use care when switching back and forth between constant and scheduled 
temperature values.  BioWin assigns the constant value to the first value of your 
schedule, and vice versa.  So in the case where you are switching between a constant 
value that is different from the first value of your scheduled pattern, ensure that these 
values are what you want them to be before running simulations. 

Managing Data 
Data management is an important component of BioWin projects.  This section 
covers topics related to the database BioWin uses to store simulation-generated and 
imported data for a project.  Data options and manipulation are accessed via the 
Project|Database menu in the main simulator window, and the Database menu 
in the album. 

Data Interval 
BioWin allows you to set data monitoring intervals on a project-to-project basis, via 
the Project|Data interval command.  This will present you with the Data 
interval editor, shown below. 
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Project data interval settings 

There are two data intervals that you may set if you wish, using the appropriate spin 
edit boxes.  The first is the Display / data interval.  This is the data interval that 
will be used by BioWin to log data into the database, and this value also will be used 
as the point drawing interval on charts and the data refresh interval for tables and 
element information displays. 

The second is the Summary pane update interval.  This is the time interval that 
BioWin will use to refresh the main window summary panes and status bar.  It 
should be noted that if this value is set to a very low number (i.e. high refresh 
frequency), it might result in decreased simulator speed because of the necessity to 
redraw the contents of the main window summary pane.  If you don't wish the 
summary panes to have any automatic refresh, enter a value of zero in each spin edit 
box.  One final point should also be mentioned.  Regardless of the value that you 
enter, the contents of the main window summary pane may be refreshed by holding 
the mouse cursor over an element, as long as the summary panes are in Fly by 
mode. 

Monitoring Data 
You have complete control over the project simulation data that are logged to the 
database.  This allows you to optimize the size of the project database so that you 
only record what you are interested in.  Selecting Project|Database|Monitor 
item… will present you with the dialog box shown below used for specifying the 
variables/parameters you want logged to the database. 
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Dialog used to set up monitoring for elements in a project configuration 

Select the element you wish to monitor an item for from the Element name drop 
list box.  The Location radio button group is used to choose the location in the 
element (i.e. Input, Output {overflow}, Underflow) where you wish to obtain the 
data to be logged.  Note that this group changes depending on the type of element 
you have selected.  For example, the underflow location only is shown for elements 
that have an underflow such as settlers.  For a selected element, you may choose the 
parameters/variables you wish to monitor using the Element specific, State 
variables, or Combined check list boxes.  Like the Location group, the 
Element specific list is dependant on the type of element selected. 

Another method to set up monitoring for an element is to use the Monitor items 
tab.  You can access this tab by right-clicking on the element in the drawing board 
and selecting Properties… from the resulting popup menu, or by double-clicking 
on the element.  Use of this tab is identical to that of the 
Project|Database|Monitor item… dialog, except for the fact that you don't select 
an element (you've done this by clicking on the element in the drawing board). 

If you find that you are always monitoring the same items in the same types of 
elements from project to project, you may want to use BioWin's Auto-logging 
feature.  You can use this feature to tell BioWin to always monitor certain 
parameters/variables on an element-type basis.  For more information, please see 
Automatic Logging Options. 

Un-monitoring Data 
BioWin now offers the functionality of un-monitoring state variables and parameters.  
You can un-monitor an item by following the procedure outlined for monitoring 
items (except that you un-check boxes for parameters that had been previously 
monitored).  This gives users increased control over what is logged to the BioWin 
database.  The following points regarding un-monitoring should be noted: 
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• When you plot a time series chart, BioWin automatically monitors 
the variables / parameters that you plot.  If the chart is deleted 
later, the items will be un-monitored. 

• If you set up monitoring for items following the procedure outlined 
above, create a chart of these items, and then delete the chart, the 
items will still be monitored. 

• If you set up monitoring for items following the procedure outlined 
above, create a chart of these items, and then attempt to un-monitor 
the items, BioWin will not allow the items to be un-monitored.  
That is, the items will still be monitored because this is required 
for the chart(s) using them.   

Note : if you delete the chart, the items will be un-monitored, i.e. BioWin 
“remembers” your disallowed attempt at un-monitoring and carries out the request 
when the chart(s) using the items are no longer present. 

Database Inventory 
BioWin offers a means to display what is being monitored to the project database, as 
well as manage data that have been imported.  Selecting 
Project|Database|Inventory list… will present you with the inventory dialog 
box, shown below. 

 
The database inventory list of monitored items 

This dialog lists the Database column titles.  Since these are named with the 
convention "lementName MonitoredParameter, by looking at the list you can 
see what is being logged to the database.  If you select the box labeled Include 
imported columns, the list also will show the column titles of any imported data 
that are contained in the database. 
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This dialog box also gives you the facility to manage data that you have imported 
into a BioWin project.  Clicking the Manage imported tab reveals the following 
dialog box. 

 
Dialog box used for managing imported data 

You can use the Imported name(s) drop list box to view the contents of the 
various data files that have been imported to the BioWin project database.  When 
you select a file, the column names are displayed in the X Value column and Y 
Value column(s) lists.  This is useful to verify that the file you have imported 
contains the data you are interested in.  If you decide that you no longer want the file 
to be included in the database, clicking the Delete… button will remove it. 

If you wish to import a data file into the database, clicking the Import… button will 
launch the procedure for doing so.  You will be presented with the Open File dialog 
box.  Once you have selected the file you want to import, the Import Wizard will 
take you through the remaining steps. 

Importing Data 
BioWin offers two methods for importing data to the project database.  You may 
import data from: 

   

1. A file, or; 

2. The clipboard if you have copied a selection. 

If you choose to import data from a file via the Project|Database|Import file… 
command, you will be presented with the Open File dialog box.  Once you have 
selected the file you want to import, the Import Wizard will take you through the 
remaining steps. 
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If you choose to import data from the clipboard via the Project|Database|Import 
clipboard… command, you will be presented with a dialog box that allows you to 
enter a brief description of the data, shown below. 

 
Dialog box for entering description of data imported from clipboard 

This dialog gives you a chance to assign a descriptive name to the data that you are 
importing from the clipboard.  This name will be associated with the block of data so 
that you recognize it when you attempt to use the imported data in other BioWin 
operations, such as plotting.  This option is not required for file imports as the file 
name is used to identify the data.  Once you have provided the clipboard data block 
with a name (or accepted the default name – do this with caution as you may end up 
with multiple identically-named imported data), the Import Wizard will take you 
through the remaining steps. 

Exporting Data 
BioWin offers two methods for exporting data from the project database.  You may 
export data to: 

   

1. A file, or; 

2. The clipboard. 

If you choose to export data to a file via the Project|Database|Export file… 
command, you will be presented with the Save File dialog box.  You may choose to 
export to one of the following file formats: 

   

1. Text file (*.txt) – in this format, columns of data will be delimited by 
tabs, which is a suitable format for import to a spreadsheet application. 

2. Comma-separated values (*.csv) – in this format, columns of data will 
be delimited by commas.  This file format also may be imported to a 
spreadsheet application. 

3. All file (*.*) – in this format, columns of data will be separated with a 
delimiter of your choice. 

Once you have used the Save File dialog box to specify a name, file type, and 
location for you exported data file you will be presented with the following dialog 
box: 
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Dialog box showing data to be exported to file 

A list shows the database column titles that will be exported.  By checking the box 
labeled Include imported columns, you can also export to this file any data that 
you have previously imported to the database.  Note that the Specify delimiter for 
export radio button group only will be available if you have selected the third file 
format from the above list. 

If you choose to export data to the clipboard via the Project|Database|Export 
clipboard… command, you will be presented with a dialog box identical to the one 
shown above with the exception that no choice of delimiters is offered.  Tabs will 
separate the data columns you paste to the clipboard since this is the best format for 
copying the data into a spreadsheet application. 

Custom Export Utility 
BioWin offers you an increased level of control over what is exported from the 
database, via the Database|Custom export file… and Database|Custom 
export clipboard… commands. 

These commands are different from the “non-custom” export database commands in 
that they allow you to select which elements you want to export data for, the 
parameters that you want to export, and the order of the parameters. 

If you choose to export data to a file via the Database|Custom export file… 
command, you will be presented with the Save File dialog box.  You may choose to 
export to one of the following file formats: 

   

1. Text file (*.txt) – in this format, columns of data will be delimited by 
tabs, which is a suitable format for import to a spreadsheet application. 
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2. Comma-separated values (*.csv) – in this format, columns of data will 
be delimited by commas.  This file format also may be imported to a 
spreadsheet application. 

3. All file (*.*) – in this format, columns of data will be separated with a 
delimiter of your choice. 

If you choose to export data to the clipboard via the Database|Custom export 
clipboard… command, no choice of delimiters is offered.  Tabs will separate the 
data columns you paste to the clipboard since this is the best format for copying the 
data into a spreadsheet application. 

Each of these commands allows you to select the elements that you want to export 
data for, using the following dialog box. 

 
Dialog used to select elements for the custom export commands 

From the Elements tree view, select the element(s) that you wish to export data for. 

   

• If you wish to include all the elements from a group (for example, 
all the Bioreactors), click on the group heading and then click the 
right-pointing arrow to move them all to the Selected elements 
list. 

• If you wish to include only certain elements from a group (or 
groups), then click on the plus sign (+) next to the group heading to 
expand it, click on the specific element you want to include, and 
then click the right-pointing arrow to move it to the Selected 
elements list. 
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• If you want to change the order of the Selected elements 
columns in the export, move the elements around by clicking on 
them and then clicking the Up/Down arrows.  In the above 
example, the leftmost columns of your exported data would be 
occupied by monitored parameters you have exported for the 
element named Unaerated, followed by those for the Aerobic 
element. 

Once you have selected the elements to export data for, click on the Choose 
compounds tab to select the parameters that you want to export for the selected 
elements.  This tab is shown below: 

 
Dialog used to select parameters for the custom export commands 

In the Compounds list, select the compounds that you wish to appear in your table, 
and add them to the Selected compounds list by clicking the right-pointing 
arrow.  To select multiple compounds: 

   

• Select contiguous multiple compounds by clicking on the first 
desired compound, holding down the Shift key, and clicking the 
last desired compound. 

• Select non-contiguous multiple series by holding the Ctrl key and 
clicking on the different desired compounds. 

If you want to change the order of the Selected compounds in the export, move 
the compounds around by clicking on them and then clicking the Up/Down arrows.  
In the above example, the columns (from left to right) of your exported data would 
be occupied by monitored parameters Zbh, Zba, Zbp, Zbpa, Xsp, and Xsc for the 
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element named Unaerated, followed by Zbh, Zba, Zbp, Zbpa, Xsp, and Xsc for 
the Aerobic element. 

You may have set up monitoring of some element-specific parameters such as solids 
loading rate for a secondary clarifier element, or OUR for a bioreactor element which 
you cannot select from the generic Compounds list.  If you wish to include these 
parameters in your export, place a check in the box labeled Element specific 
extra items.  By checking the box labeled Imported columns, you can also 
export any data that you have previously imported to the database. 

Note : using these two dialogs to export data requires that you have previously set 
up monitoring for the parameters in the appropriate elements, and run a dynamic 
simulation.  Use of these dialogs to export data does not set up monitoring. 

Exporting To GFX Files 
You can export the database in GFX format.  When you execute this command, you 
will be presented with the following dialog box. 

 
Dialog used for setting up database export to GFX file 

GFX *.Pn files may contain up to 16 parameters (e.g. VSS, TSS, CODt, etc.).  GFX 
*.Sn files contain the data corresponding to the *.Pn files.  The data are in 
hexadecimal integer format, and missing parameters (i.e. if the Pn file contains less 
than 16 parameters) are padded with FFFF.  These files will be stored in the 
subdirectory name that you specify in the Basename text entry area.  This 
subdirectory will be located beneath the BioWin Data directory. 

You must specify the Data log type as Boundary value or Linear average.  
GFX assumes 15-minute intervals; data logged to this file are expected to be the 
average for the 15 minutes (for the best approximation of this you can set the 
BioWin data interval to 15 minutes). 
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• A Boundary value export uses data taken from the BioWin database 
at 15-minute intervals. 

• A Linear average export uses data taken from the BioWin database 
at 15-minute intervals, but the data are linearly interpolated at the 
midpoints (i.e. 7.5, 22.5, 37.5 minutes) using surrounding data. 

Clicking the Start export button allows you to select the elements that you want to 
export data for, using the following dialog box: 

 
Dialog used to select elements for the GFX export 

From the Elements tree view, select the element(s) that you wish to export data for. 

   

• If you wish to include all the elements from a group (for example, 
all the Bioreactors), click on the group heading and then click the 
right-pointing arrow to move them all to the Selected elements 
list. 

• If you wish to include only certain elements from a group (or 
groups), then click on the plus sign (+) next to the group heading to 
expand it, click on the specific element you want to include, and 
then click the right-pointing arrow to move it to the Selected 
elements list. 

• If you want to change the order of the Selected elements 
columns in the export, move the elements around by clicking on 
them and then clicking the Up/Down arrows.  In the above 
example, the leftmost columns of your exported data would be 
occupied by monitored parameters you have exported for the 



 

420  •  Managing BioWin Projects  

element named Unaerated, followed by those for the Aerobic 
element. 

Once you have selected the elements to export data for, click on the Choose 
compounds tab to select the parameters that you want to export for the selected 
elements.  This tab is shown below: 

 
Dialog used to select parameters for the GFX export 

In the Compounds list, select the compounds that you wish to appear in your table, 
and add them to the Selected compounds list by clicking the right-pointing 
arrow.  To select multiple compounds: 

   

• Select contiguous multiple compounds by clicking on the first 
desired compound, holding down the Shift key, and clicking the 
last desired compound. 

• Select non-contiguous multiple series by holding the Ctrl key and 
clicking on the different desired compounds. 

If you want to change the order of the Selected compounds in the export, move 
the compounds around by clicking on them and then clicking the Up/Down arrows. 

You may have set up monitoring of some element-specific parameters such as solids 
loading rate for a secondary clarifier element, or OUR for a bioreactor element which 
you cannot select from the generic Compounds list.  If you wish to include these 
parameters in your export, place a check in the box labeled Element specific 
extra items. 
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Note : using these two dialogs to export data requires that you have previously set 
up monitoring for the parameters in the appropriate elements, and run a dynamic 
simulation.  Use of these dialogs to export data does not set up monitoring. 

Once you have selected the elements and compounds for exporting to the GFX file, 
click OK to begin the export process.  The status bar on the main exporting dialog 
will show the progress of the export process.  When this is finished, you can find the 
files in the folder with your specified Basename under the BioWin Data directory. 

Creating Project Reports 
There are two choices for generating reports containing information about the 
currently opened BioWin configuration.  The two options are Report to printer, 
and Report to WordTM.  Each option is explained in more detail below.  The 
information that is included in reports may be specified using the Report options 
tab accessed via the File|Report menu command. 

Report to Printer 
This command will generate a printed BioWin report.  When the command is 
selected, the following dialog box for controlling the layout of album pages in the 
report is opened. 

 
Dialog box used for controlling printed report layout 

The Album pages to print section allows you to choose between printing All X 
pages (X changes according to the number of pages in the current album), or a 
Range of pages (when the option is selected, you may enter text in the from and to 
spin edit boxes). 

Once you have selected the album pages that you want to include in the report, you 
can choose between one of four Album page layout options: 
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5. The top left option will result in the contents of each album page being 
printed on an entire page in the report.  For example if an album page 
contains only one chart, that chart will be printed on an entire page in 
the report.  If an album page contains two panes with a chart on each, 
then the two charts will be printed on an entire page in the report. 

6. The top right option will print the contents of each album page to one 
horizontal half of a page in the report.  Each page of the printed report 
will contain two BioWin album pages. 

7. The bottom left option will print the contents of each album page to one 
vertical half of a page in the report.  Each page of the printed report 
will contain two BioWin album pages. 

8. The bottom right option will print the contents of each album page to 
one quarter of a page in the report.  Each page of the printed report will 
contain four BioWin album pages. 

The General section contains a number of generic printing options.  You can select 
your report Orientation to be Landscape or Portrait.  You can specify the 
Number of copies of your report that you would like to print.  The Printer 
setup… button will open the printer setup dialog box which will allow you to 
access the printer’s properties, set paper size, page orientation, and a number of other 
printer options (the options presented to you will be dependant on the printer you 
have). 

Once you are satisfied with your report layout settings, click the OK button to send 
the report to the printer. 

Report to Word 
This command will generate a report in Microsoft WordTM document format.  Once 
you have generated the WordTM document, you may print it out, add your own text to 
it, copy sections of it into your company report documents, etc. 

Once you have specified the information that you want to be included in the report 
using the Report options tab accessed via the Tools|Customize menu 
command, select the File|Report|Report to WordTM command to begin the 
document generation process. 

After a few seconds, the Microsoft WordTM Save As dialog box will open.  An 
example of the dialog box is shown below (appearance may vary according to 
Windows system settings). 
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WordTM Save As dialog box 

Give your report document a meaningful name, and make sure you note the location 
you save it to (you may navigate to any folder, just as you would saving any 
document).   

Note : The report must be given a unique name.  You may not "save over" an 
existing file. 

Once you click the Save button, WordTM will open after a few seconds (time may 
vary depending on the speed of your computer).  You will then see material being 
placed in WordTM.  During this time your cursor likely will take the Windows 
"hourglass" form. 

Note : It is important not to attempt to perform any other operations while the report 
is being generated.  BioWin and Word make heavy use of the Windows clipboard 
during this operation, so any attempts to copy / paste may cause problems in the 
report generation process. 

When the report is complete, WordTM will be closed and BioWin will return to the 
foreground.  You may then locate the file and do what you wish with it. 

Alarms 
BioWin will notify you when certain conditions occur while you are performing a 
simulation.  At the end of a steady state simulation, BioWin will always display the 
following alert if any alarm conditions have been detected: 
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Notification displayed at the end of a steady state simulation if alarm conditions have been 
detected 

If you have set the Alarm list (on the General tab accessed via 
Tools|Customize… menu command) to any value greater than zero, clicking OK 
on the above notification will display a list showing the element in which the alarm 
condition occurred and the alarm condition.  The list also can be viewed at any time 
via the View|Alarms command.  An example of such a list is shown below. 

 
An example of an alarm list 

The alarm list also shows you the number of Current alarms (this information also 
is shown in the main window status bar), and the Maximum number of alarms 
logged (set in the Alarm list on the General tab accessed via 
Tools|Customize… menu command). 

If you have un-checked the box labeled Suppress alarms in dynamic 
simulations (on the General tab accessed via the Tools|Customize… menu 
command), BioWin will log alarm conditions encountered during dynamic 
simulations.  For these alarms, the time when they occurred is displayed in the alarm 
list (see third column in the screen shot above).  The list will be displayed when you 
choose to end a dynamic simulation. 

You may clear an alarm list by right-clicking in the list and selecting Clear from the 
resulting popup menu. 

Alarm conditions 
This section describes the various alarms that you may encounter in a project. 

Recursive Configuration 
You will be presented with this warning if your configuration is laid out in such a 
manner that you are attempting to connect a node splitter directly to a node mixer 
without first passing through an element that has a volume.  The simplest case 
illustrating this is shown below. 
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A simple example of a recursive configuration 

This situation is not allowed because there is no physical meaning to two node 
elements joined in sequence and the flow solver does not allow this physical 
impossibility. 

Flow Specifications Could Not Be Achieved 
This alarm occurs when the flow rate specified by the user could not be achieved 
because other constrains within the system override the user setting.  For example; 
the flow rate specified will result in negative flows elsewhere in the system, a 
variable volume tank with a specified outflow rate has run dry (or is overflowing), a 
constant rate split specification exceeds the influent flow to the splitter. 

Nitrogen Limited Conditions Occurred 
This alarm occurs when the nitrogen (ammonia and nitrate nitrogen) in a biological 
zone is sufficiently low to cause a 50% or more reduction in the reaction rates. 

Phosphorus Limited Conditions Occurred 
This alarm occurs when the phosphorous (PO4) in a biological zone are sufficiently 
low to cause a 50% or more reduction in the growth reaction rates. 

Magnesium Or Cation Limitation For P Uptake 
This alarm occurs when the magnesium or cation concentrations in a biological zone 
are sufficiently low to cause a 50% or more reduction in the in the biological uptake 
of phosphorus by polyphosphate accumulating organisms. 

More Than 10% Of Ammonia Is Stripped 
This alarm occurs when it appears that 10% or more of the influent ammonia to a 
biological zone is being stripped by the gas phase. 
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The Air Supply Required To Achieve The DO Setpoint 
Exceeds The Maximum Air Supply Rate 
This alarm occurs when the air supply rate required to achieve the DO setpoint 
entered by the user is higher that the maximum air supply rate specified by the user. 

The Air Supply Requested Exceeds The Maximum Air 
Supply Rate 
This alarm occurs when the air supply requested is higher that the maximum air 
supply rate (as specified by the user). 

The Power Supply Required To Achieve The DO Setpoint 
Exceeds The Maximum Power Supply Rate 
This alarm occurs when the power supply rate required to achieve the DO setpoint 
entered by the user is higher that the maximum power supply rate specified by the 
user. 

The Power Supply Requested Exceeds The Maximum 
Power Supply Rate 
This alarm occurs when the power supply requested is higher that the maximum 
power supply rate (as specified by the user). 

High Air Flow / Diffuser 
This alarm occurs when the air flowrate per diffuser exceeds the maximum air 
flowrate per diffuser specified by the user. 

DO In Tank Is Higher Than Specified Setpoint Due To DO In 
Input (Even Without Aeration) 
This alarm occurs when the DO setpoint specified by the user could not be achieved 
because the influent DO is higher than the DO setpoint and there is insufficient 
oxygen demand to lower the DO to the setpoint specified. 

Low / High pH Inhibition 
This alarm can apply to: 

   

• Autotrophs 

• Heterotrophs 

• Digesters 

These alarms occur when the pH in a biological zone is at a level where it is 
inhibiting the growth rate by 50% or more. 

pH (or IS) Could Not Be Calculated 
This alarm (including the High or Low bound varieties) occurs when there is an error 
calculating the pH or ionic strength. 
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Warning: High Ionic Strength (Activity Coefficients) 
These alarms occur when the ionic strength is too high to calculate the approximate 
activity coefficients.  The activity coefficients approximations calculated at an ionic 
strength of 3 are used instead.  
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Customizing BioWin 

Customizing the Project Appearance 
There are a number of parts and features of BioWin that can be customized to look 
how you want.  When you customize BioWin, you essentially are changing the 
default settings of the BioWin work environment and all new projects that are 
created therein.  The following sections discuss the dialog boxes that are accessed 
via the Project|New Project Options menu command that may be used to 
customize BioWin. 

The difference between customizing BioWin and setting individual project options 
should be emphasized.  For more information on the various project options which 
may be set for individual projects, refer to the "Managing BioWin Projects" chapter. 

Drawing Board Options 
This section outlines the various project options that can be set for the default 
drawing board.  The drawing board options may be accessed in the main simulator 
window by choosing Project|New Project Options from the menu and selecting 
the Drawing board tab, shown in the picture below. 
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New project drawing board options tab 

Aspects of the Drawing board appearance that may be changed include the 
Font and the Color.  Clicking the Font… button will open the font properties 
dialog box and will allow you to change the font that is used to label element 
pictures on the drawing board.  Selecting a new color from the drop list box will 
change the background color of the drawing board.  Notice that a preview of the 
drawing board background color and the selected font is given in the dialog box. 

The Drawing board size also may be changed.  Changing the values in the Width 
and Height spin edit boxes will change the overall dimensions of the drawing board.  
The size of the main window occupied by the drawing board is not changed, 
however, the overall size is changed as evidenced by a change in the size of the 
scroll box in the scroll bar.  The default values of 6,000 by 2,000 translate roughly to 
60 by 20 inches.  It should be mentioned here that if you plan to be performing copy 
and paste actions with Microsoft Word, the size of drawing board that you can copy 
into Word is limited to 22 by 22 inches.  The zoom limits of the drawing board can 
be set so that zooming can only take place between minimum and maximum levels. 

The Drawing board snap resolution can be changed in either or both the X and Y 
directions.  The snap feature helps you align elements precisely on the drawing 
board.  When you place or move an element on the drawing board, it aligns itself 
(i.e. “snaps”) to the nearest grid point (grid points are invisible).  Therefore, 
increasing the snap values results in a coarser grid for the elements to snap to which 
means that you have less control over their placement.  Decreasing the snap values 
results in a finer grid for the elements to snap to which means that you have 
increased control over their placement. 



 

 Customizing BioWin  •  431 

Pipe Options 
The “arrow angle” refers to 
the acute angle between the 
arrow side and the line.  For 
example, if you want arrows 
with “flat” bases, set the 
arrow side angle to the 
maximum of 60 degrees. 

You also can control the default appearance of pipes in your project, using the 
Project|New Project Options menu command and selecting the Pipe tab, shown 
in the figure below.  To change the Color, Width, and Style of the lines used to 
represent pipes on the drawing board, click on the Pipe Lines… button.  You may 
increase the arrow size on the lines used to represent pipes.  The arrow angle 
also can be changed.   

 
New project pipe options tab 

Note : It also is possible to change pipe line and arrow settings for individual pipes.  
Access the properties of the pipe you wish to change by double-clicking it or right-
clicking it and selecting Properties… from the resulting pop-up menu.  Next, 
check the box labeled Local pipe options and you will be presented with the same 
set of options that have just been outlined; however, these changes will affect this 
particular pipe only. 
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Pipe line options dialog box 

Setting the Unit System 
This section outlines the various options that can be set for the unit system used in a 
project.  The project unit system may be accessed in the main simulator window by 
choosing Project|New Project Options from the menu and selecting the Unit 
system tab, shown in the picture below. 
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New project unit system options 

In the Flow units radio button group, you may choose from the following: 

   

• cubic meters per day (m3/d) 

• litres per day (L/d) 

• megalitres per day (ML/d) 

• megagallons per day (mgd) 

It should be noted that the same basis is used for flow and volume.  For example, if 
you choose L/d as your flow unit, then volumes (e.g. for bioreactors, settling tanks) 
will be in litres also.   

Note : Air flowrates are in units of m3/hr. 

If you choose mgd as your flow basis, then the following imperial units will be used 
for other calculations in BioWin: 

Measure Imperial Unit 
Length feet (ft) 
Area square feet (ft2) 
Mass pounds (lbs) 
Pressure pounds per square inch (psi) 
Air Flow Standard Cubic Feet per Minute 
Specific Velocity gal/ft2/d 
Mass Loading Rate lbs/ft2/d 
Concentration milligrams per litre (mg/L) 
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In the BOD basis radio button group, you may choose the length of time that 
BioWin uses to calculate BOD values.  You may choose between 5, 7, and 20 day 
BOD. 

Using Project Templates 
This section outlines the various options that can be set for the album and notes 
templates you can use in a project.  Templates for albums and notes may be accessed 
in the main simulator window by choosing Project|New Project Options from 
the menu and selecting the Templates tab, shown in the picture below. 

 
New project templates dialog box 

When you first open the BioWin album, it will contain a default number of pages.  
You can customize the number of pages using the New Album starts with spin 
edit box.   

Note : These default pages contain one pane; if you want pages with multiple panes, 
you must add these manually. 

If you have a number of album pages set up with pane and display configurations set 
to your liking, you can set this group of pages as your default album template file so 
that the album will open containing these pages.  If you click the New Album from 
template radio button, the Select template file… button will be activated.  
Clicking this button will open a Select template dialog box allowing you to 
specify an album template pages (*.atp) file you have previously created in BioWin. 

The Use notes template file check box allows you to specify a file to use as a 
template when you execute the Project|Notes command.  Checking this box will 
activate the Select template file… button which will open a Select template 
dialog box when it is clicked, allowing you to specify a Rich Text Format (*.RTF) 
or Text (*.TXT) file that you have created with another application such as 
Microsoft Word. 



 

 Customizing BioWin  •  435 

Customizing The Work Environment 
There are a number of parts and features of BioWin that can be customized to behave 
how you want.  When you customize BioWin, you essentially are changing the 
default settings of the BioWin work environment and all new projects that are 
created therein.  The following sections discuss the dialog boxes that are accessed 
via the Tools|Customize menu command that may be used to customize BioWin. 

The difference between customizing BioWin and setting individual project options 
should be emphasized.  For more information on the various project options which 
may be set for individual projects, refer to the "Managing BioWin Projects" chapter. 

General Options 
The General tab, shown below, may be used to customize General settings for 
BioWin. 

 
Tab used to customize general options 

The number of files that are listed in the most recently used file list at the bottom of 
the main simulator window File menu can be changed using the Recent file list 
spin edit box. 

The number of alarms that are displayed at one time in the alarm list can be 
controlled by using the Alarm list spin edit box.  If you want BioWin to ignore 
alarms during dynamic simulations, place a check in the box labeled Suppress 
alarms in dynamic simulations.  Checking this box stops BioWin from 
checking any alarm conditions, so no alarms will be logged during dynamic 
simulations regardless of the number you have entered in the Alarm list spin edit 
box. 

You can select whether or not you want to be presented with the option for storing 
previous time series plots in the album.  This option is useful for comparing 
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the results of one simulation run with others.  When you restart a dynamic 
simulation, any series plotted from previous runs will remain on their respective 
charts.  The saved series keep their names but will have a number appended to them 
indicating with which run they are associated.  The naming convention is as follows: 

• Saved series are numbered 0 to n-1 

• Active series are numbered n 

where n is the current simulation run number. 

Note that you are able to 
format saved series as you 
would any other.  This 
includes assigning them new 
names if you wish. 

It is important to remember that saved series are simply lines on the charts for 
comparison purposes.  They are no longer contained in the database.  Perhaps this is 
best illustrated with an example.  Say you conduct a dynamic simulation for five 
days and plot effluent ammonia.  To assess the impact of the estimated maximum 
nitrifier growth rate, you change this model parameter.   You start another five day 
dynamic simulation from the same start date as the first run, and save the effluent 
ammonia time series. 

On your chart, there would be two series, "YourSeriesName#0" and 
"YourSeriesName#1".  The series with 0 appended to its name is the saved series 
containing results from the first five day run.  The series with 1 appended to its name 
contains results from the second five day run.  Now suppose at the end of the second 
five day run you decide to continue for another 5 days.  On your chart you would see 
"YourSeriesName#1" continuing to ten days, while "YourSeriesName#0" would be 
stopped at five days.  If you exported the database at the end of the second run, you 
would export ten days of effluent ammonia data generated with the second maximum 
nitrifier growth rate. 

You can specify whether you want BioWin to save dynamic runs 
automatically, and the frequency (in terms of dynamic simulation days) at which 
to save.  If this option is selected, BioWin will create backup files named filename.X, 
where filename is the name you have selected for the currently open BioWin file.  X 
will be integers indicating the number of automatic saves that have been performed.  
For example, say you set up BioWin to save dynamic runs automatically every 10 
days, and then commence a 30 day dynamic simulation on a file you have saved as 
mybiowinfile.bwc.  At the 10th day of the dynamic simulation, BioWin will save a 
file called mybiowinfile.1.  At the 20th day of the dynamic simulation, BioWin will 
save a file called mybiowinfile.2.  At the 30th day of the dynamic simulation, BioWin 
will save a file called mybiowinfile.3. 

Most users will want to allow BioWin to pre-allocate database memory for 
dynamic simulations.  When this option is selected, BioWin obtains the required 
amount of memory it will need before starting a dynamic simulation (the amount of 
memory required depends on the number of parameters being monitored in the 
database, the database monitoring frequency, and the length of the dynamic 
simulation).  Selecting this option may result in a slight delay at the beginning of 
long dynamic simulations, but will avoid problems with BioWin slowing down 
during long dynamic runs. 

A number of new charting features have been added to BioWin.  If you prefer to use 
the charting interface of the previous version, you can select the option for BioWin 
to display Simplified charting dialogs. 

The Element section may be used to customize the appearance of elements on the 
drawing board.  You can choose the types of elements for which you want to Show 
element names for – by placing a check beside the desired elements.   

To control the display of state variable naming, use the radio buttons in the State 
variable naming section to choose between Full names and Abbreviated.  For 
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example, the full name for nitrifying bacteria is “Autotrophs”, and the abbreviated 
name is “Zba”. 

The default model parameters for BioWin can be controlled using the Edit 
parameter defaults… button in the Parameter defaults section.  This button 
opens the Parameter editor dialog box (see Model Parameter Editors in the 
"Useful BioWin Interface Tools and Techniques" chapter).  Parameters can be 
modified and printed from this location.  Use the Reset BioWin Defaults button 
to restore the original settings for these parameters. 

Explorer Options 
Using the Tools|Customize menu command, using the Explorer options tab 
shown below, it is possible to customize the amount of information that is displayed 
in the right explorer pane when an element-type node or State variables node is 
clicked. 

 
Tab used to customize explorer options 

In the Element view checklist, you may specify the variables that will be 
displayed for an element when you click on its node or its parent node. 

You can control how many decimal places are displayed in the Explorer window 
using the Decimal places spin edit box.  You are able to have separate decimal 
place settings for Concentrations (e.g. ammonia concentration) and Others (e.g. 
flow values).  You also may control the Default width of the columns used to 
display results in the Explorer, and the alignment of the data using the Align drop 
list box. 
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Print Options 
The Printing options tab, shown below, may be used to customize print settings 
for BioWin. 

 
Customize printing options dialog box 

You can set up default printing Margins.  With the Page % spin edit boxes in the 
section labeled Margins, you can set the top, bottom, left, and right margins to a 
desired set of values.  Use the Panel % spin edit box to increase or decrease the 
white space between panes when you are printing out an album page.   

There are some defaults that apply only to Drawing board prints.  If you do not 
wish to print the border of the drawing board, then de-select the box labeled Print 
bounding rectangle.  By checking or un-checking the boxes in the Include 
group, you can control whether or not the details entered via the Project|Info… 
command will display on the printout.  If you choose to have some or all of this 
information displayed on drawing board printouts, then you can control the Font 
size using the spin edit box. 

You can specify a default level of Chart Detail to adjust the text size on your print 
jobs.  Sliding the scroll towards More decreases the size of text on your chart and 
gives greater prevalence to the chart on the printout.  Sliding the scroll towards 
Normal increases the size of the text on your chart and gives less prevalence to the 
chart on the printout.   

Note : When you are printing the drawing board or an album display, you will have 
the opportunity to override these defaults before finally sending the job the printer. 

There also are a number of options that apply only to printing of Tables.  The Title 
size % sets the size of the title font relative to the font size of the table text.  
Adjusting the Cell padding % changes the amount of space between the text in a 
table cell and the table cell boundaries.  The Grid pen width controls the thickness 



 

 Customizing BioWin  •  439 

of grid lines drawn in the table.  If you want the printed table scaled to fit into the 
print area that you have specified, select the Fit to print area option.  You can 
control the drawing of grid lines by selecting or de-selecting the Horizontal grid 
lines and Vertical grid lines options.  You also may choose to print your table as 
a BioWin Standard table, which is an elegant table with three horizontal lines:  at 
the top of the table, underlining the title, and at the bottom of the table.  To have 
equally sized columns in the table, select the Even column widths option.  Since 
the entries in the first column quite often are longer than other columns (since they 
contain names), there is an option to Autofit column 1 to avoid the truncation of 
the first column entries. 

If you want to include the project file name on the drawing board printout or on table 
printouts, check the box labeled Include file name. 

Report Options 
You may customize the information that is included in reports generated by BioWin 
using the Report options tab, shown below. 

 
Tab used to control BioWin report information 

This tab may be used to specify what will be included in BioWin reports (both 
printed and WordTM).  The top Include section of the tab can be used to specify 
whether or not general information items will be included in the report.  These are 
explained in the table below. 
Item Description 
Project info. Selecting this item will include information such as the Project 

Name, Plant Name, User name, file creation date, etc. 
Flowsheet Selecting this item will include a picture of the BioWin 

flowsheet in the report. 
Global parameters Selecting this item will include a tabular printout of all the 
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model parameters. 
Global temperature Selecting this item will include the global temperature in the 

report. 
Album pages Selecting this item will include each album page (both tabular 

and chart). 
SRT (if available) Selecting this item will include the SRT in the report, if one is 

available. 
Notes Selecting this item will include the contents of the Notes editor 

in the report. 

The contents of reports may be further customized on an element-by-element basis, 
using the Select element type report options section.  The Element types list 
contains all the possible element types that could be included in a BioWin 
configuration.  To include information for various element types in reports: 

   

1. Click on the element type you want to include in the Element types 
list, so that it is highlighted blue. 

2. Click the box labeled Include this element type in the report. 
3. Click the boxes next to the different types of information (Physical 

data, Operating data, Local settling parameters, Local 
biological parameters, Aeration parameters). 

4. Repeat this process for all the element types you wish to include in the 
report. 

Note : Possibly not all of the types of information may apply to a given element – if 
so, it will simply not be included in the report. 

Automatic Logging Options 
You can customize BioWin to automatically monitor element data using the 
Automatic logging tab, shown below.  For more information on managing data in 
BioWin, please see the Managing Data section. 
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Tab used to customize automatic logging settings 

From the Element types list, select the element that you wish to set up auto-
logging for.  Using the Location radio button group, specify where you want to 
obtain element data from, i.e. Input, Output, or Underflow. 

Note : The third location only will be shown for element types that have an 
underflow such as settling tanks. 

Finally, in the State variables, Combined, Water chemistry and Element 
specific check list boxes; select the items that you wish to be logged automatically 
to the database. 

When you set up auto-logging for an element type, the data that you specified to be 
monitored will automatically be written to the database for any elements added from 
that time forward, i.e. in the current project and all future projects (you can always 
modify the auto-logging options if you wish).  Elements already in the configuration 
(or other configurations) are not affected by this setting 

File Location Options 
You may customize the locations where BioWin saves various file types using the 
File locations tab, shown below. 
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Tab used to customize BioWin file locations 

To change the location of a file type, double-click on the file type’s row of the file 
type/location list or click the row once and then click the Modify location… 
button.  You will then be presented with a dialog box that you can use to specify a 
new location, such as the one shown below. 

 
Dialog box used to specify new file locations 

Select the drive you want to store the files on using the Drive: drop list box.  
Navigate through the existing folder structure by double-clicking on the folder icons.  
If you wish to create a folder, click the New Folder button.  When you are satisfied 
with the new location, click OK to return to the File locations tab. 

Clicking the Advanced… button will allow you to access the Advanced file 
locations tab.  From this tab you may choose to specify folders where you have 
placed custom drawing board image files or BioWin binary files.  Do not change 
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these unless you are aware of the implications – this option is for advanced users 
only. 

Chart Template Options 
BioWin offers a wide range of formatting options so that you may customize charts.  
While this range gives users a great deal of power and flexibility in specifying the 
appearance of their charts, it also could result in a good deal of repetition if you plan 
to generate a number of charts which will have the same appearance.  However, this 
repetition is eliminated by another useful feature of BioWin’s charting package – 
chart templates. 

The idea behind chart templates is to provide users with a means to pre-format their 
charts.  You can format the chart template to have the appearance that you want the 
charts to have.  Your current chart template (the chart shown in the Chart Master) 
is used as the basis for each new chart that you add to the album.  To change 
existing charts you can "Apply" the current chart template to those charts.  (See 
Applying a Chart Template). 

Creating a Chart Template 
To create a new chart template, select the Tools|Chart Master menu command to 
open the dialog box shown below.   

 
Chart Master used to customize the appearance of new charts 

The default color and line thickness for each series can be edited using the Series 
(1-16) buttons and Line thickness spin edit box in the Series defaults section. 



 

444  •  Customizing BioWin  

All other formatting options can be adjusted by double-clicking on the sample chart.  
This opens the chart editor dialog box as shown below. 

 
Chart editor dialog box 

This dialog box allows you to adjust all other content and formatting aspects of the 
chart that you can incorporate into your template.  Please refer to the Chart 
Formatting Procedures chapter for further information about using this dialog. 

Once you have adjusted the settings as required, click the Close button to finish. 

Saving a Chart Template 
To create a new chart template, select the Tools|Chart Master menu command to 
open the dialog box shown below.   
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Chart Master used to customize the appearance of new charts 

To save the chart formatting options you have set up into a template file for later use, 
click the Save as template file… button to open the Save dialog box.  Chart 
template files are saved with a .BCM file extension.  This file may be utilized later 
by clicking the Load template file… button and selecting the file from the Open 
dialog box. 

Note: You may still customize the chart formatting using the normal series editing 
procedures in the album. 

Applying a Chart Template 
Once the desired template is loaded using the Load template file… button, you 
have the option of applying it all charts in the project or just selected charts.  BioWin 
also allows you to control which specific formatting options will be applied from the 
template you are using. 

   

1. To control the specific formatting options you want to apply from the 
template you have loaded, click the Change "Apply" settings… 
button to open the chart master options dialog box. 
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Chart master options dialog box 

   

2. To apply a template to all charts in the project, click the Apply to All 
charts button. 

3. To apply a template to selected charts only, click the Apply to 
selected charts… button to open the Selected charts dialog box, 
shown below. 
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Chart selection dialog box 

   

4. Click on the desired chart in the area labeled Available on the left and 

press the  button to add it to the Selected list on the right. 

5. Click the Apply button, and then click the Close button to finish.  The 
loaded template will then be applied to the selected charts only. 

Changing Chart Master Options 
The Chart Master allows you to control exactly which aspects of your template you 
wish to apply.  For example, you may have already adjusted the Font used for your 
chart title, and do not wish to apply the Font used in your template.  Chart Master 
will allow you to exclude this when you apply the template to your chart if you click 
the Change "Apply" settings… button. 
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Change apply settings dialog box 

Each category will offer a variety of relevant settings with check boxes.  By 
removing the check from a setting, you are removing that feature from the template. 

Entire categories can be removed using the check box labeled Apply this 
category.  If you uncheck this box, all options for the category will be ignored 
when the template is applied. 

This dialog box also allows you to remove the Colors and Width settings in the 
section labeled Apply default series. 
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Useful BioWin Interface Tools 
and Techniques 

Model Parameter Editors 
BioWin model parameter editors, such as the example shown below, are used to 
change the parameters used in all of the various models employed by BioWin to 
perform simulations.  Parameter editors are accessed via the Project|Parameters 
menu command. 

Note : This section details the use of the model parameter editors.  For technical 
information about model parameters, please see the "Process Model Formulation" 
chapter. 

 
An example model parameter editor 
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Changing temperature 
dependency coefficients will 
increase or decrease the 
impact that a change in 
temperature will have on the 
model parameters. 

In model parameter editors, a spreadsheet-like interface is provided for entering 
parameter values.  Parameter names are listed in the first column, default values in 
the second column, and current values in the third column.  In the case of kinetic 
parameters, temperature dependency coefficients for each parameter also are listed.  
Only the non-grey column may be modified.  If you change a model parameter from 
the default value and accept your change, the value will be highlighted in bold red 
text the next time you view the editor. 

To change a value, click on the cell you would like to modify and enter a new value, 
or click on the number in the cell to edit that value.  You can use the arrow keys to 
move from one cell to the next.  A number of options for copying and pasting data, 
printing the editor tab, and multiplying column values are available by right clicking 
on the editor tab - these are outlined below. 

When you are working in a model parameter editor, a number of options for 
manipulating the parameter values are available by right clicking anywhere on a 
model parameter editor tab.  If you right-click and select Add to notes, BioWin 
will place a tab-delimited text version of the currently selected model parameter tab 
into the Simulation Notes editor.  This is useful for keeping records of model 
parameter values used in different simulation runs. 

If you right-click and select Copy from the resulting popup menu, the contents of 
the tab (including column headings, the values in non-editable cells, and the values 
in editable cells) will be copied to the Windows clipboard.  The clipboard contents 
then may be pasted into another application such as a word processor (all values will 
be separated by tabs) or a spreadsheet (each value will be placed in a separate cell). 

You also may paste data from the clipboard into a model parameter editor by right-
clicking and selecting Paste from the resulting popup menu. 

Note : The cell that currently is selected in the model parameter editor corresponds 
to the first value in the first column of the data that you are pasting from the 
clipboard. 

If BioWin does not recognize the format of the data that you are attempting to paste 
in, or if you select Paste special or Paste from file, the import wizard will be 
opened. 

If you want to print the model parameter editor values in tabular form, then you can 
right-click and select Print from the resulting popup menu.  When you do so, you 
will be presented with the following dialog box. 
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Dialog box used for printing model parameters 

Use the Printer drop list box to select the printer you want to use for printing.  The 
Printer Setup… button will open the printer setup dialog box which will allow you 
to access the printer’s properties, set paper size, page orientation, and a number of 
other printer options (the options presented to you will be dependant on the printer 
you have).  The Print button will send the print job to the printer and the printout 
will match the preview, which is shown.  The Close button closes this dialog box 
and returns you to the Model Parameter Editor. 

Using the Paper Orientation group, specify whether you want the printing to be 
done on a Portrait or Landscape page.  The print preview gives you an idea of 
what the printout will look like under each format. 

If you do not wish to see the size of the margins for your print job, you may de-select 
the box labeled View Margins.  You can control the margins using three different 
methods: 

   

 

 

 
Resize Cursors  

 
Drag Print Object 

54. Using the Margins (%) spin edits, you can adjust each margin as you 
like.  The four spin edit boxes each control the margin that shares its 
position, that is, the top spin edit controls the top margin, the bottom 
spin edit controls the bottom margin, and so on.  When you change a 
value, you will see changes in the print preview accordingly. 

55. You may drag each margin using the mouse.  Position the mouse cursor 
over the margin you wish to adjust until the horizontal or vertical resize 
cursor appears.  Click the mouse button, hold it, and drag the margin to 
the position you wish it to occupy.  Notice that when you finish 
dragging it, the values in the Margins (%) Spin Edits will have been 
updated. 

56. By moving the object to be printed around on the page.  When the 
mouse cursor takes the form of a hand, you may click and drag the 
entire object around on the page until it is in the desired position.  
Notice that when you finish dragging it, the values in the Margins (%) 
spin edits will have been updated 
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If after applying any one of these methods of adjusting margins you wish to reset the 
margins to the default values, you may do so by clicking the Reset Margins 
button. 

Note:  If you are having trouble with a print preview not fitting into the margins, 
ensure that you have a True Type font (font styles with a TT after their name) 
selected in your Project|Current Project Options - Drawing board options 
tab.  If you want to print all of the tabs in the model parameter editor, click the Print 
all button at the bottom of the model parameter editor dialog box as opposed to 
right-clicking and selecting Print from the resulting popup menu on each individual 
model parameter editor tab. 

Itinerary Editors 
A number of elements have properties that may be entered as scheduled patterns 
rather than constant values.  In this section, the use of the interfaces (called itinerary 
editors in BioWin) for entering these schedules is discussed. 

A number of options for manipulating the itinerary data are available by right 
clicking anywhere on the itinerary tab.  If you right-click and select Add to notes, 
BioWin will place a tab-delimited text version of the currently selected model 
parameter tab into the Simulation Notes editor.  This is useful for keeping track of 
changes you make when doing multiple simulation runs on a configuration. 

If you right-click and select Copy from the resulting popup menu, the contents of 
the tab (including column headings, the values in non-editable cells, and the values 
in editable cells) will be copied to the clipboard.  The clipboard contents then may be 
pasted into another application such as a word processor (all values will be separated 
by tabs) or a spreadsheet (each value will be placed in a separate cell). 

You also may paste data from the clipboard into an itinerary by right-clicking and 
selecting Paste from the resulting popup menu. 

Note : The cell that currently is selected in the itinerary editor corresponds to the 
first value in the first column of the data that you are pasting from the clipboard.  

If BioWin does not recognize the format of the data that you are attempting to paste 
in, or if you select Paste special or Paste from file, the import wizard will be 
opened. 

If you want to print the itinerary in tabular form, then you can right-click on the 
itinerary tab and select Print from the resulting popup menu.  When you do so, you 
will be presented with the following dialog box. 
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The print itinerary dialog 

Use the Printer drop list box to select the printer you want to use for printing.  The 
Printer Setup… button will open the printer setup dialog box which will allow you 
to access the printer’s properties, set paper size, page orientation, and a number of 
other printer options (the options presented to you will be dependant on the printer 
you have).  The Print button will send the print job to the printer and the printout 
will match the preview, which is shown.  The Close button closes this dialog box 
and returns you to the Itinerary Editor. 

Using the Paper Orientation group, specify whether you want the printing to be 
done on a Portrait or Landscape page.  The print preview gives you an idea of 
what the printout will look like under each format. 

If you do not wish to see the size of the margins for your print job, you may de-select 
the box labeled View Margins.  You can control the margins using three different 
methods: 

   

 

 

 
Resize Cursors  

 
Drag Print Object 

57. Using the Margins (%) 
spin edits, you can adjust each margin as you like.  The four spin edit 
boxes each control the margin that shares its position, that is, the top 
spin edit controls the top margin, the bottom spin edit controls the 
bottom margin, and so on.  When you change a value, you will see 
changes in the print preview accordingly. 

58. You may drag each margin using the mouse.  Position the mouse cursor 
over the margin you wish to adjust until the horizontal or vertical resize 
cursor appears.  Click the mouse button, hold it, and drag the margin to 
the position you wish it to occupy.  Notice that when you finish 
dragging it, the values in the Margins (%) Spin Edits will have been 
updated. 

59. By moving the object to be printed around on the page.  When the 
mouse cursor takes the form of a hand, you may click and drag the 
entire object around on the page until it is in the desired position.  
Notice that when you finish dragging it, the values in the Margins (%) 
spin edits will have been updated 
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If after applying any one of these methods of adjusting margins you wish to reset the 
margins to the default values, you may do so by clicking the Reset Margins 
button. 

Note:  If you are having trouble with a table print preview not fitting into the 
margins, ensure that you have a True Type font (font styles with a TT after their 
name) selected in your Project|Options Drawing board options tab. 

If you wish to apply a multiplication factor to one of the columns in the itinerary, 
right-click on the itinerary and select Multiply a column from the resulting popup 
menu.  When you do this, you will be presented with the following dialog box. 

 
Utility for multiplying a column of an itinerary 

Using the Multiply column number spin edit box, select the column that you 
wish to apply the multiplication factor to. 

Note : As you change the value in this spin edit box, the label beside it changes to 
the heading of the selected column so you know exactly which values you will be 
changing.  Once you have selected the column, then enter the multiplication factor in 
the by text edit box.  To complete the multiplication operation, click OK. 

If you wish to clear a column in an itinerary, right-click on the itinerary and select 
Clear a column from the resulting popup menu.  When you do this, you will be 
presented with the following dialog box. 

 
Utility for clearing a column of an itinerary 

Using the Clear column number spin edit box, select the column that you wish to 
clear. 

Note : As you change the value in this spin edit box, the label beside it changes to 
the heading of the selected column so you know exactly which values you will be 
changing.  Once you have selected a column, click OK to clear it. 
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The procedures outlined above are common to all itinerary editors in BioWin.  For 
the purpose of this manual, itinerary editors are divided into two broad classes: 

1. Standard Itineraries 

2. Special Itineraries 

Details and examples of these two classes are given in the following sections. 

Standard BioWin Itineraries 
The following points highlight the use of standard itineraries.  In the following 
sections, examples of standard itineraries are given. 

• The timed pattern may span minutes, days, or even months, depending 
on the length of the simulation period. 

• You can enter an influent pattern using the spreadsheet provided on this 
tab; start times may be entered in the first column, flow rates in the 
second column. 

• To enter or change a value, click on the cell you would like to modify 
and enter a new value, or click on the number in the cell to edit that 
value.  When you are satisfied with the value in a cell you may press 
the Enter (or Return) key on your keyboard, or click in another cell.  
You can use the arrow keys to move from one cell to the next; click the 
right mouse button to view a list of editing options. 

• The Cycle time is specified using an edit box; this is the duration of 
the pattern, and must be specified in so that the simulator knows when 
to start repeating the cycle. 

Note : If you have an event outside of the range of your cycle time, a warning will 
be displayed in red text at the bottom of the itinerary and you will not be able to 
close the itinerary until you rectify this.  You also may specify a Cycle offset; this 
will have the effect of offsetting your timed pattern from the start time of the 
simulation - that is, you "step into" your timed pattern by an amount equal to the 
cycle offset. 

• Time units may be selected using the radio buttons; you can specify 
days, hours, or minutes.  This tab also contains a group of radio buttons 
for specifying Flow units; there are four different unit options: L/d, 
ML/d, m3/d, and mgd (US). 

• You can increase or decrease the number of Rows (i.e. intervals) in a 
timed pattern using the spin edit box. 

• If there are blanks in your time column, you can click on the check box 
to Interpolate blank time cells (all influent specifications require 
associated time values).  There are a number of options for replacing 
blanks in the other columns.  You may choose from one of the 
following Blank fill styles: the last value or zero, a time-weighted 
average value, an interpolated value, or an average value.  Blank values 
are interpolated by default. 

1. If you select Last value or zero, then a blank cell will be filled 
with the value that is contained in the previous non-blank cell.  If 
BioWin finds no values in a column, then the column will be filled 
with zeroes.  This way, if you want a column filled with zeroes, 
you don't have to enter a zero in the first cell. 
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2. If you select Time weighted average value, BioWin will use the 
column's non-blank, non-zero cells to compute a time-weighted 
average.  This calculated time-weighted average will then be 
placed in all blank cells. 

3. If you select Interpolated value, BioWin will fill the blank cell (or 
groups of contiguous blank cells) with a linearly interpolated 
value.  The linear interpolation is based only on the points 
immediately adjacent to the blank cell(s).   

Note : If there are no values in the column and this option is selected, the column 
will be filled with zeroes. 

4. If you select Average value, BioWin will use the column's non-
blank, non-zero cells to compute a straight arithmetic average.  
This calculated average will then be placed in all blank cells. 

As outlined earlier, a number of options for copying and pasting data, printing the 
itinerary, and multiplying column values are available by right clicking on the 
itinerary tab. 

Note:  Use care when switching back and forth between constant and scheduled 
influents.  BioWin assigns the constant values to the first row of your schedule, and 
vice versa.  So in the case where you are switching between a constant influent that 
is different from the first row of your scheduled influent, ensure that the values are 
what you want them to be before running simulations. 

Split Itinerary 
This itinerary editor, shown below, allows the user to enter a scheduled pattern for an 
element's split method.  This dialog box applies to elements that split flows such as 
splitters, settlers (primary and secondary), grit tanks, and dewatering elements. 
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The split itinerary editor 

DO Setpoint Itinerary 
This itinerary editor, shown below, allows the user to enter a scheduled pattern for an 
element's DO setpoint.  This dialog box applies to aerated elements such as 
bioreactors and aerobic digesters. 
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A DO setpoint itinerary editor 

Air Flowrate Itinerary 
This itinerary editor, shown below, allows the user to enter a scheduled pattern for an 
element's air flowrate.  This dialog box applies to aerated elements such as 
bioreactors and aerobic digesters. 
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An air flowrate itinerary editor 

Power Supply Rate Itinerary 
This itinerary editor, shown below, allows the user to enter a scheduled pattern for an 
element's power supply rate.  This dialog box applies to surface aerated elements 
such as surface aerator bioreactors and brush aerator bioreactors. 
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An power supply rate itinerary editor 

Temperature Itinerary 
This itinerary editor, shown below, allows the user to enter a scheduled pattern for an 
element's temperature.  This dialog box applies to elements incorporating 
temperature such as bioreactors, SBRs and aerobic digesters. 
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A temperature itinerary editor 

Underflow Rate Itinerary 
This itinerary editor, shown below, allows the user to enter a scheduled pattern for an 
element's (e.g. an SBR or clarifier) liquid underflow. 
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Dialog box for entering a liquid underflow pattern 

Internal Recycle Flowrate Itinerary 
This itinerary editor, shown below, allows the user to enter a scheduled pattern for an 
element's (e.g. SBR + 2 always-mixed prezones) internal recycle flowrate. 
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Dialog box for entering an internal liquid recycle flowrate pattern 

Liquid Outflow Itinerary 
This itinerary editor, shown below, allows the user to enter a scheduled pattern for an 
element's (e.g. a variable volume/batch bioreactor) liquid outflow. 
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Dialog box for entering a liquid outflow pattern 

Special BioWin Itineraries 
The following points highlight the use of special itineraries.  In the following 
sections, examples of special itineraries are given, along with the distinguishing 
feature that makes them different from standard itineraries. 

   

• The timed pattern may span minutes, days, or even months, depending 
on the length of the simulation period. 

• You can enter an influent pattern using the spreadsheet provided on this 
tab; start times may be entered in the first column, flow rates in the 
second column. 

• To enter or change a value, click on the cell you would like to modify 
and enter a new value, or click on the number in the cell to edit that 
value.  When you are satisfied with the value in a cell you may press 
the Enter (or Return) key on your keyboard, or click in another cell.  
You can use the arrow keys to move from one cell to the next; click the 
right mouse button to view a list of editing options. 

• The Cycle time is specified using an edit box; this is the duration of 
the pattern, and must be specified in so that the simulator knows when 
to start repeating the cycle.  

Note : If you have an event outside of the range of your cycle time, a warning will 
be displayed in red text at the bottom of the itinerary and you will not be able to 
close the itinerary until you rectify this.  You also may specify a Cycle offset; this 
will have the effect of offsetting your timed pattern from the start time of the 
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simulation - that is, you "step into" your timed pattern by an amount equal to the 
cycle offset. 

• Time units may be selected using the radio buttons; you can specify 
days, hours, or minutes.  This tab also contains a group of radio buttons 
for specifying Flow units; there are four different unit options: L/d, 
ML/d, m3/d, and mgd (US). 

• You can increase or decrease the number of Rows (i.e. intervals) in a 
timed pattern using the spin edit box. 

• If there are blanks in your time column, you can click on the check box 
to Interpolate blank time cells (all influent specifications require 
associated time values).  There are a number of options for replacing 
blanks in the other columns.  You may choose from one of the 
following Blank fill styles: the last value or zero, a time-weighted 
average value, an interpolated value, or an average value.  Blank values 
are interpolated by default. 

1. If you select Last value or zero, then a blank cell will be filled 
with the value that is contained in the previous non-blank cell.  If 
BioWin finds no values in a column, then the column will be filled 
with zeroes.  This way, if you want a column filled with zeroes, 
you don't have to enter a zero in the first cell. 

2. If you select Time weighted average value, BioWin will use the 
column's non-blank, non-zero cells to compute a time-weighted 
average.  This calculated time-weighted average will then be 
placed in all blank cells. 

3. If you select Interpolated value, BioWin will fill the blank cell (or 
groups of contiguous blank cells) with a linearly interpolated 
value.  The linear interpolation is based only on the points 
immediately adjacent to the blank cell(s). 

Note : If there are no values in the column and this option is selected, the column 
will be filled with zeroes. 

4. If you select Average value, BioWin will use the column's non-
blank, non-zero cells to compute a straight arithmetic average.  
This calculated average will then be placed in all blank cells. 

As outlined earlier, a number of options for copying and pasting data, printing the 
itinerary, and multiplying column values are available by right clicking on the 
itinerary tab. 

Note:  Use care when switching back and forth between constant and scheduled 
influents.  BioWin assigns the constant values to the first row of your schedule, and 
vice versa.  So in the case where you are switching between a constant influent that 
is different from the first row of your scheduled influent, ensure that the values are 
what you want them to be before running simulations. 

Influent Itinerary 
The appearance of the influent itinerary editor depends on whether the influent type 
is constant or variable, and whether the influent element specifies wastewater 
composition in terms of totals and fractions (i.e. a standard influent), state variable 
concentrations (i.e. a state variable influent), a BOD influent, a methanol input, or a 
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metal addition influent.  If the influent is constant, then the influent data are entered 
in the simple dialogs shown below. 

 
A constant influent itinerary 

 
A constant state variable influent itinerary 
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A constant BOD influent itinerary 

 
A constant methanol influent itinerary 
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A constant metal addition influent itinerary 

If the influent type is variable, then the influent itinerary will appear as shown below 
to allow the user to enter a scheduled pattern. 

 
A variable influent itinerary 
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A variable state variable influent itinerary 

 
A variable BOD influent itinerary 
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A variable methanol influent itinerary 

 
A variable metal addition influent itinerary 

SBR DO Setpoint Itinerary 
This itinerary editor, shown below, allows the user to enter a scheduled pattern for an 
SBR element's DO setpoint. 
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An SBR DO setpoint itinerary editor 

Note : For the SBR DO setpoint itinerary, the Cycle time cannot be specified since 
it is linked to the SBR Operation cycle time.  The itinerary editor provides you with 
feedback by telling you the Maximum time span in which you can aerate (this is set 
by the SBR Mixing/Aeration cycle length – you cannot have aeration occurring 
during the Settling/Decant phase).  

   

Note : If you have an aeration event outside of the range of your maximum 
allowable time, a warning will be displayed in red text at the bottom of the itinerary 
and you will not be able to close the itinerary until you rectify this.  Notice also that 
you may not have a different Cycle offset than that of your SBR operation cycle 
offset. 

SBR Air Flowrate Itinerary 
This itinerary editor, shown below, allows the user to enter a scheduled pattern for an 
SBR element's air flowrate. 
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An SBR air flowrate itinerary editor 

Note : For the SBR air flowrate itinerary, the Cycle time cannot be specified since 
it is linked to the SBR Operation cycle time.  The itinerary editor provides you with 
feedback by telling you the Maximum time span in which you can aerate (this is set 
by the SBR Mixing/Aeration cycle length – you cannot have aeration occurring 
during the Settling/Decant phase).   

   

Note : If you have an aeration event outside of the range of your maximum 
allowable time, a warning will be displayed in red text at the bottom of the itinerary 
and you will not be able to close the itinerary until you rectify this.  Notice also that 
you may not have a different Cycle offset than that of your SBR operation cycle 
offset. 

Router Itinerary 
This itinerary editor, shown below, allows the user to specify a flow routing pattern 
for a splitter element. 
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A router itinerary for alternating flow routing 

You may specify either to Switch at intervals, or you may use a Scheduled 
pattern.  Click on the radio button to select the option you want.  If you select to 
switch the flow at regular intervals, you may enter the interval length in the edit 
boxes (hours and minutes).  If you choose a scheduled pattern, click on the Pattern 
button to open the router itinerary editor, shown below.  The operation of this 
itinerary editor is the same as other standard itinerary editors. 

 
Dialog box for entering a router pattern 
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Import Wizard 
In this section, the BioWin import wizard is discussed in detail.  The import wizard 
is invoked when you paste data into BioWin from the Windows Clipboard or from a 
file.  The import wizard takes you through the following steps: 

   

1. In the first step, you specify the type of delimiters that separate 
individual data values in the group that you are pasting.  From the 
Specify delimiter radio button group, select from Comma, Space, 
Tab, or Other (where you enter the delimiter that is used).  The 
viewing area at the bottom of the dialog box that shows the contents of 
the file that you are pasting is meant to assist you in choosing the 
correct delimiter by displaying the delimiters in the file.  The viewing 
area has a file size limit of 64 KB, so you will not be able to properly 
preview your file if it exceeds this limit.  This does not compromise 
BioWin's ability to import your data if the file size is greater than 64 
KB. 

 
The first step of the import wizard 

   

Note : If you have instances in your data file where you have data values separated 
by multiple delimiters, then you should check the box labeled Treat consecutive 
delimiters as one.  This will avoid pasting gaps into the itinerary.  This option 
will be enabled only when you have spaces or other delimiters in your data, to 
decrease the chances of this option causing BioWin to treat a missing data value as 
an extra delimiter, which would result in the deletion of the column containing the 
missing data value. 

2. In the second step, you are shown a preview of what the data will look 
like when it is pasted into the itinerary.  This is helpful to ensure that 
you have selected the proper options in the first step.  If you are not 
satisfied with the way the data looks, you can return to the previous 
step by clicking the Back button.  You can transpose the data you are 
pasting by switching between the Rows and Columns button in the 
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Data in: radio button group.  The preview will change to reflect these 
changes.  Also, if you wish to exclude the first row or several rows, you 
can increase the value in the Data starts in row spin edit box.  Once 
again, the preview will change to reflect these changes. 

 
The second step of the import wizard 

When you are happy with the preview of the data that will be pasted into the 
itinerary, click the OK button to finish the Paste special operation. 

Model Builder 
The model builder, shown in the picture below, is used to enter stoichiometry and 
rate equations for user-defined models.  The model builder may be invoked by 
clicking the Specify local model… button (if the Local Builder model option 
is selected) on the Operation tab of the model builder element.  Alternatively, the 
model builder may be invoked by selecting the Model Builder… command from 
the Project menu. 
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The model builder with activated sludge model number one (ASM 1) loaded 

The model builder allows you to perform a number of tasks related to creating your 
own models: 

   

• Enter stoichiometry and rate constants; 

• Enter processes which act on the BioWin state variables; 

• Enter stoichiometry and rate equations using a powerful equation 
editor; 

• Manage your model(s) by allowing you to import and export to various 
file formats. 

These tasks are explained in more detail in the following sections. 

Entering Model Constants 
You must assign your model constants a name and a value.  To enter a model 
constant, type the name of the constant in the Name text edit area.  Next, type the 
value you wish to assign to the constant in the Value text edit area. 

When you are satisfied with the name and value you have assigned to your constant, 
you may enter it into your model as a rate constant by clicking the Add to rate 
constants button.  When you do this, the constant will appear in the Rate 
constants list.  To enter the constant into your model as a stoichiometry constant, 
click the Add to stoich. constants button.  When you do this, the constant will 
appear in the Stoichiometric constants list. 

Note : When you add a constant to one of the two lists, the constant name and value 
remain in their respective text edit areas.  This makes it easy for you to enter the 
constant into both lists with the same name and value if you wish. 

If you wish to change a model constant, click on it in the Rate constants list or in 
the Stoichiometric constants list so that it is highlighted blue.  You can now 
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delete the constant if you wish by pressing the Delete key on your keyboard.  You 
can also edit the name and/or value of the constant by editing the entry in the Name 
and/or Value text edit area, and pressing the appropriate Add to… button. 

Entering Model Processes 
To add processes to your model, increase the value of the Number of processes 
spin edit box.  When you do this, additional unnamed processes will be added to 
your model.  In the example shown below, the unnamed processes Process 3 and 
Process 4 have been added to the model in the Stoichiometry and Rate 
equations sections. 

Note : Values of 0 are entered for stoichiometry and rate equations. 

 
Adding additional processes to your model 

To assign the processes names, simply click on the process name in the 
Stoichiometry section of the editor so that it is highlighted blue, and type in the 
new name.  Your changes will automatically be reflected in the Rate equations 
section.  In the example below, the new process named Process 3 has been 
renamed to a process called Auto Conversion. 



 

478  •  Useful BioWin Interface Tools and Techniques  

 
Changing the name of a process 

Entering Model Equations 
There are two methods for entering model equations.  If the equation is small and 
straightforward, you may be able to enter it directly into the appropriate model cell.  
To do this, click in the stoichiometry or rate equation cell where you wish to enter 
the equation.  When you do this, the text currently in the cell will be highlighted 
blue.  Clicking in the blue highlighted area will present you with a cursor that will 
allow you to enter your equation.  For more complex lengthy equations, you will 
probably find it easier to use the built in equation editor. 

Invoking the Equation Editor 
To invoke the equation editor, double-click in the stoichiometry or rate cell where 
you wish to enter an equation.  This will invoke the Equation editor, shown in the 
picture below. 

 
Equation editor showing the stoichiometric equation for the Dissolved Oxygen state variable 
for the autotroph growth process. 

Before proceeding further with explanation of the equation editor, the following 
points on exiting should be noted: 

1. To exit the equation editor without accepting the changes you 
have made, click the small x in the upper right hand corner of the 
equation editor window. 

2. To exit the equation editor and accept the changes you have 
made, click the Close and update button. 
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You can use the Set position to button to quickly move the cursor around within 
the equation editor.  The position refers to the number of spaces from the left (or 
beginning) of a line of text.  In the example picture above, the cursor has been 
jumped to the sixth position. 

Equation Editor Syntax 
The equation editor provides you with a large window into which you may enter 
your equation text.  You must take care to use proper mathematical syntax when you 
enter equations.  The required syntax is similar to that used when entering 
mathematical equations in computer code or spreadsheet formulas.  For example, say 
you wanted to change the equation shown above to have the term in brackets 
multiplied by the constant Ya.  The following syntax would not be correct, because 
the multiplication operator is missing: 

 
Incorrect multiplication syntax 

The equation shown below, with the correct multiplication syntax would be 
acceptable: 

 
Correct multiplication syntax 

Equation Editor Text Editing Features 
The equation editor has features commonly found in text editors.  You can highlight 
a section of equation text by dragging your mouse cursor over it.  You can then move 
the highlighted selection by clicking and dragging the mouse cursor.  The following 
keyboard shortcuts for using the Windows clipboard also are available: 

• To cut text, use the Ctrl+x keyboard combination; 

• To copy text, use the Ctrl+c keyboard combination; 

• To paste text, use the Ctrl+v keyboard combination. 

Equation Editor Popup Menu 
The equation editor also offers the powerful functionality of a right-click popup 
menu that makes writing your equations much easier.  If you right-click your mouse 
button anywhere within the equation editor window, you will be presented with a 
popup menu similar to the one shown below: 
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Equation editor right-click popup menu 

Selecting one of the popup menu choices will open a small window containing a list 
of variables, constants, or function/operator templates that you can place into your 
equation.  For example, selecting the Variable option opens a window that lists the 
BioWin state variables, shown below: 

 
State variable selection window 

To place a variable from this list into your current equation, simply locate the 
variable in the list and double-click it.  The popup window will close, and you will 
return to your equation, where you will see that the variable has been placed where 
you had located your cursor.  Two important points should be mentioned regarding 
the use of these popup windows: 

1. To close a popup window without adding an item to your equation, 
click the small x located in the upper right corner of the popup window. 

2. When you double-click an item and add it to your equation, BioWin 
also adds the item to the Windows clipboard.  Pressing Ctrl+v will add 
the item to the equation, until another item is added to the clipboard. 

Selecting the Stoichiometry constant option opens a window that lists the 
stoichiometry constants that you have defined for the model that you currently are 
working on.  For example, in the picture shown below, note that the constants listed 
coincide with those shown in the Stoichiometric constants list in the main 
model builder window shown previously.  To place a constant from this list into your 
current equation, simply locate the constant in the list and double-click it.  The 
popup window will close, and you will return to your equation, where you will see 
that the constant has been placed where you had located your cursor. 
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Stoichiometry constant selection window 

Selecting the Rate constant option opens a window that lists the rate constants that 
you have defined for the model that you currently are working on.  For example, in 
the picture shown below, note that the constants listed coincide with those shown in 
the Rate constants list in the main model builder window shown previously.  To 
place a constant from this list into your current equation, simply locate the constant 
in the list and double-click it.  The popup window will close, and you will return to 
your equation, where you will see that the constant has been placed where you had 
located your cursor. 

 
Rate constant selection window 

Selecting the Function / operator option opens a window that lists a number of 
function / operator templates that you may place in your equation.  To place a 
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function or operator from this list into your current equation, simply locate the 
function or operator in the list and double-click it.  The popup window will close, 
and you will return to your equation, where you will see that the function or operator 
template has been placed where you had located your cursor. 

 
Function / operator selection window 

For example, suppose you selected the x^y template from the list.  Using our 
previous DO stoichiometry equation example, you would see the following: 

 
Inserting a function template into an equation 

You could then quickly replace the x and y placeholders by highlighting them, right-
clicking, selecting Variable or one of the constants options, and inserting an item 
from a popup window.  Functions and operators are described with examples in the 
next section. 

Available Functions and Operators 
A more comprehensive list of functions and operators is tabulated below: 

Operator Description Example 

^ power operator 2 ^ 3 returns 8 

* multiply operator 3 * 4 returns 12 

/ divide operator 8 / 4 returns 2 

\ module operator.  Returns the 
module of a division. 

5 \ 2 returns 1 

+ sum operator 3 + 7 returns 10 
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- subtract operator 10 - 4 returns 6 

> greater than operator 4 > 3 returns 1 (true), and 1 > 6 
returns 0 (false) 

< less than operator 6 < 3 returns 0 (false), and 2 < 9 
returns 1 (true) 

>= greater than or equal to operator 6 >= 3 returns 1 (true) 

<= less than or equal to operator 7 <= 3 returns 0 (false) 

<> not equal to operator 5 <> 3 returns 1 (true) 

= equal to operator 3 = 8 returns 0 (false) 

if logical if operator.  Follows format 
if(condition; result if true; result if 
false) 

if(5<1; 1; 5) returns 5 since the 
condition tests false 

and logical and operator 3 and 2 returns 1 (true, because both 
are true) 

or logical or operator 3 or 0 returns 1 (true) 

xor logical xor operator 1 xor 1 returns 0 (false) 

   

Constant Value 

pi 3.1415926535897932385 

e 2.71828182846 - Same as Exp(1) 

   

Function Description Example 

Conc Switch Ks Applies the Ks 
switch to the 
variable Conc 

Alk Switch KsAlk applies the switching 
function KsAlk to the variable Alk 

TD(Const;Theta;Temp) Applies an 
Arrhenius 
temperature 
dependency 
relationship using 
the supplied 
arguments 

20TempConst −θ⋅  

TDRT(Const;Theta;Temp;
RefTemp) 

Applies an 
Arrhenius 
temperature 
dependency 
relationship using 
the supplied 
arguments 

fTempReTempConst −θ⋅  

Monod(RateAtTemp; 
Substrate; Ks) 

Places the supplied 
arguments into a 
Monod function SubstK

Substrat
RateAtTemp

S +
⋅

 

Monod[TD(Const;Theta; 
Temp); Substrate; Ks] 

Places the supplied 
arguments into a 
temperature-
dependant Monod 
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function 

PhInhib(phLow; pHHigh; 
pH) 

Places the supplied 
arguments into a 
two-sided pH 
inhibition function 










+

•







 +
+

•
+

•
+

K

K
K

K

2

KK
K

pHK
pH

pHK

K

LpH

HpH

HET,LpH

HpHLpH
LpH

HpHLpH

LpH

 

Neg Returns the 
negative of 
argument 

Neg(5) returns –5 

Not Returns 1 (true) if 
argument is 0 
(false). Returns 0 
(false) if argument 
is not equal to 0 

Not(1) returns 0 

Re Returns the real 
part of a complex 
number 

Re(5 + 4j) returns 5 

Im Returns the 
imaginary part of a 
complex number 

Im(5 + 4j) returns 4 

Exp Returns the 
exponential of 
argument 

Exp(1) returns 2.71828182846 

Sin Returns the sine of 
argument in 
radians 

Sin(pi/2) returns 1 

Cos Returns the cosine 
of argument in 
radians 

Cos(pi/2) returns 0 

Tan Returns the tangent 
of argument in 
radians 

Tan(pi/4) returns 1 

Asin Returns in radians 
the inverse sin of 
argument 

Asin(1) returns 1.57079632679 (pi/2) 

Acos Returns in radians 
the inverse cosine 
of argument 

Acos(1) returns 0 

Atan Returns the inverse 
tangent of 
argument 

Atan(1) returns 0.785398163397 

Abs Returns the 
absolute value of 
argument (or the 
complex module) 

Abs(-5) returns 5 

Sqrt Returns the square 
root of argument 

Sqrt(16) returns 4 



 

 Useful BioWin Interface Tools and Techniques  •  485 

U Returns the step-
function of 
argument 

U(-5) returns 0, and U(3) returns 1 

Rect Returns the rect 
function of 
argument 

If absolute value of argument is less the 0.5, 
returns 1. Otherwise, returns 0 

sinc Returns the sinc 
function of 
argument 

 

Ln Returns the natural 
log of argument 

Ln(2.71828182846) returns 1 

Round Returns the 
rounded number of 
argument 

Round(4.8) returns 5 

int Returns the int part 
of argument 

int(3.2) returns 3 

Odd Returns 1 (true) if 
rounded argument 
is odd. Returns 0 
(false) if rounded 
argument is even. 

Odd(3) returns 1 

Rand Returns a random 
number between 0 
and argument 

Rand(3) returns a random number between 
0 and 3 

Sinh Returns the 
hyperbolic sine of 
the argument 

Sinh(1) returns 1.17520119364 

Cosh Returns the 
hyperbolic cosine 
of the argument 

Cosh(1) returns 1.54308063482 

Tanh Returns the 
hyperbolic tangent 
of the argument 

Tanh(1) returns 0.761594155956 

Diode Returns 0 if the 
argument is less 
than or equal to 0. 
Returns the 
argument if 
argument is greater 
than 0 

Diode(-6) returns 0 and Diode(3) returns 3 

Verifying Equations 
As you enter equations in your model, you may want to use the Verify 
equations… button to ensure that you have no mistakes in your equations.  When 
you click this button, BioWin checks your equations for undeclared variables and 
constants (rate and stoichiometric).  BioWin also checks your equations for the 
proper syntax.  Finally, BioWin attempts to calculate the model equations.  This may 
be useful in discovering equation formula errors such as division by zero. 

You may find it useful to use the Verify equations… button each time you finish 
entering an equation. 
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Copying, Pasting, and Printing Equations 
A number of options for manipulating your model equation entries are available by 
right clicking in the stoichiometry and rate equation matrices. 

If you right-click and select Copy from the resulting popup menu, the contents of 
the stoichiometry or rate matrix (including column headings, the values in non-
editable cells, and the values in editable cells) will be copied to the clipboard.  The 
clipboard contents then may be pasted into another application such as a word 
processor (all values will be separated by tabs) or a spreadsheet (each value will be 
placed in a separate cell). 

You also may paste data from the clipboard into the stoichiometry or rate matrix by 
right-clicking and selecting Paste from the resulting popup menu. 

Note : The cell that currently is selected in the stoichiometry or rate matrix 
corresponds to the first value in the first column of the data that you are pasting from 
the clipboard. 

If BioWin does not recognize the format of the data that you are attempting to paste 
in, or if you select Paste special or Paste from file, the import wizard will be 
opened. 

If you want to print the stoichiometry or rate equation matrix in tabular form, then 
you can right-click and select Print from the resulting popup menu.  When you do 
so, you will be presented with the BioWin print dialog box, which is explained in 
detail in the Model Parameter Editor section earlier in this chapter. 

Managing Models 
Models that you create can be either project-specific (i.e. they are available only 
within the project that they were created), or available to all of your BioWin projects. 

If you create a model using the Project|Model Builder… command, then that 
model will be used by all model builder elements that you place in your 
configuration.  You can also have individual models that are local to their model 
builder elements (when you select the Local Builder model option on the 
Operation tab). 

Model Library 
You can make a model available to all of your BioWin projects by adding it to the 
Model Library.  When you have finished inputting your model in the model 
builder, you can add the model to the model library by clicking the Add to model 
library button.  Before you do this, be sure to enter a descriptive name in the Model 
Name text edit area for your reference purposes. 

Once you have added a model to the model library, it will be available to all of your 
BioWin projects.  You can open any model in the library into the model builder by 
clicking the Select from model library… button.  Doing so will open the 
following dialog box: 
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The Model Library management dialog box 

You may use the drop list selector to choose the model that you wish to load into the 
model builder, and press OK to do so.  You may also remove a model from the 
current library by selecting it and then clicking the Delete selected model button. 

You may also save a particular model library to disk as a further management 
method.  For example, say that your current library consists of activated sludge 
models.  You may want to begin working on digester models in the model builder, 
but you want to keep these separate from the activated sludge models.  To achieve 
this end, you could use the Export library models… button, which opens a Save 
model library dialog box.  This dialog box operates the same as a standard File 
Save dialog box, and allows you to save the current model library in the BioWin 
*.GML format.  In our example, you may want to save the activated sludge models 
as ActivatedSludgeModels.GML.  When you are finished with your digester 
models, you may want to save that library as DigesterModels.GML. 

You can load a saved GML file into the current library in one of two ways.  When 
you click the Load models… button, you are asked whether you want to Add 
models from file to this library (press "Yes"), or replace this library 
(press "No").  Selecting either option will present you with an Open model 
library dialog box that operates exactly like a standard File Open dialog.  
However, choosing the first option will append the models from the loaded GML file 
to the model list in the current library.  Choosing the second option will make the 
models from the loaded GML file the only models in the current library. 

Importing and Exporting Models 
You can also manage individual models.  You can save the model you are currently 
editing to disk by clicking the Export to file… button.  This opens the Save 
model file dialog box, which operates exactly like the standard File Save dialog 
box.  You may save your model in one of three possible file formats: 

1. BioWin Model files (*.mod) 

2. Text files (tab delimited) [*.txt] 

3. CSV files (no spaces) [*.CSV] 

BioWin Model files (*.mod) are an excellent method for saving your files as they 
move to and from BioWin seamlessly, and they also can be imported into Microsoft 
Excel as comma delimited files. 

You may also load a model from a file using the Import model from file… button.  
This will open the Open model file dialog box, which operates exactly like a 
standard File Open dialog.  You may open a file saved in any of the three formats 
discussed above. 
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 BioWin Tutorials and Examples 

Learning Objectives 
This set of tutorials and case studies is designed as a training exercise in the 
application of BioWin.  The primary objective is to provide "how to…" training on 
using the BioWin software itself.  The case studies are not intended as a course in 
wastewater treatment process engineering.  Nevertheless, several of the case studies 
focus on process applications and identify interesting design and operating issues. 

Start off with Tutorial #1.  This explains the basic concepts for applying BioWin and 
provides an overview of features.  You will be viewing a previously created file from 
the installation Data directory.  The remaining tutorials all involve setting up new 
systems.  Each tutorial is broken up into a number of subsections. 

The tutorial examples ask you to save files with the name format My Tutorial XX in 
the Tutorials subdirectory of the Data directory.  Completed tutorial configurations 
are also stored in that directory for reference as Tutorial XX. 

Suggestion:  Keep this Help file open and follow each tutorial step-by-step, 
switching back and forth to BioWin.  Alternatively, print a copy of the tutorial 
chapter (for printing instructions see How to print the manual in the "Welcome 
To BioWin" chapter).  

TUTORIAL 1 - BioWin Familiarization 
This familiarization tutorial demonstrates a number of the features in BioWin.  
Aspects covered in this tutorial include the basic BioWin interface, loading a BioWin 
configuration file, specifying data for configuration elements, and running steady 
state and dynamic simulations. 

The interface and loading a file 
Start BioWin and view the main simulator window.  All simulation tasks are 
executed from here.  The interface consists of menus, toolbars, the drawing board, 
summary panes and a status bar.  For a detailed description, view the "Main 
Simulator Window" chapter.  In this tutorial you will only get a brief overview. 

   

1. From the File menu, click on Open and load the An Example 
configuration file from the DATA directory.  The screen view will be 
similar to that shown below. 
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The example configuration 

   

Element Selection Tool 2. Move the cursor over the toolbar.  A fly-by hint appears when you pause 
over a button.  The Select/Drag/Edit tool at the left of the lower tool bar 
should be depressed (i.e. on) at this stage. 

3. A status bar at the bottom of the window displays various pieces of 
information. 

 
Selection Cursor 

4. Move the arrow cursor across the drawing board.  The cursor changes to a 
hand as you cross over elements on the drawing board.  When you pause 
over an element, information on that element appears in the two panes 
below the drawing board – physical data in the left pane and performance 
data in the right pane.  This function allows you to get a summary overview 
of system information. 

5. Move the cursor over an element and click the right mouse button.  A local 
menu appears. [Don’t select any options yet!].  This will allow you to 
access various options for that element (see below). 

   

Hint:  As a general rule when using BioWin, clicking the right mouse button often 
helps!  

Physical and operational data  
60. Move the cursor over the Aerobic element (a completely mixed 

aerated bioreactor) and double click – or click the right mouse button 
on the element and select the Properties command.  A tabbed editing 
dialog box opens (see below).  This contains all the physical and 
operational data for the element.  View the information on the 
Dimensions and Operation tabs. [Don’t change any information 
yet.  We’ll accept the sizing of this aerated zone with DO controlled at 
a setpoint of 2 mg/L]. 
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The Bioreactor Dimensions tab 

 
The Bioreactor Operation tab 

   

61. Now try double-clicking on other elements and view the details for this 
configuration. 

62. Click on an element and keep the left mouse button depressed.  You 
can drag and drop the element in a new position, and re-arrange the 
configuration to your liking.  

Hint:  Try right-clicking on the arrow head of a pipe, and view the Properties.  
There are a number of options for re-arranging the pipe layout.  
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Checking influent data 
1. Double click on the Influent element, and click on the Edit data 

button.  At this stage we won’t change any data. 

Hint:  When viewing influent data, point the cursor at a column heading and click 
the right mouse button.  There are many options for entering and manipulating data. 

2. Close the dialog. 

Hint:  The pane at the lower right displays the flow-weighted average influent 
concentrations. 

Viewing information and simulation results 
The panes below the drawing board provide a limited overview of system 
information.  Comprehensive information can be viewed in two ways – via the 
Explorer or in the Album. 

 
 
The Explorer button 

63. Select Explorer from the View menu – or click on the Explorer toolbar 
button – or press Ctrl + E.  This opens the Explorer - a tree-like view of 
system information. 

64. Experiment with expanding different levels.  Hint:  Try double clicking 
on an element name or the parameters item in the right panel. 

 
 
The Album button 

65. Select Album from the View menu – or click on the Album toolbar 
button – or press Ctrl + A.  This opens the Album.  This contains user-
customized information in the form of custom tables, pre-formatted 
element information, and charts.  The Album can contain many pages 
of information. 

66. Click on the page name tabs along the bottom and view the different 
examples.  Hint:  Try clicking the right mouse button on different parts 
of the Album pages (including the name tabs at the bottom). 

67. Select Add page from the Album menu, and choose one of the layout 
options.  After adding a page, click the right mouse button on a blank 
panel and experiment!  Expect to encounter difficulties at this stage – 
subsequent tutorials will provide detailed instructions. 

   

Running a steady state simulation 
Steady state simulations provide a solution for the system based on the flow-
weighted average influent loading to the system (and the time-weighted average for 
any timed operational changes such as a schedule of DO setpoints in an aerated 
reactor). 

   

 
Steady state button 

68. Select the Steady state command in the Simulate menu – or click on 
the Steady State button on the toolbar.  This opens the simulator 
player dialog.  Hint:  If you re-position the simulator player dialog at a 
convenient spot on the screen that’s where it’ll appear next time. 

69. Click on the play button.  A dialog box appears when BioWin has 
found the solution. 
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The steady state solver dialog box 

Note:  Most steady state solutions are found in ten or so iterations.  In unusual 
circumstances the solver may “stick” – that is, the error value does not change from 
iteration to iteration.  In this situation click on the stop button.  Often this indicates a 
difficulty with the influent data such as a nutrient deficiency (or an Alkalinity 
deficiency in an aerobic digester, perhaps).  Alternatively, you may have a “difficult-
to-solve” system.  One trick is to try conservative solver settings.  To do this, select 
the menu command Project|Current Project Options, click the Numerical 
Parameters tab, and click the Options… button in the Steady State Solver 
group.  At the bottom of the resulting dialog box there is a large button that you can 
click to set conservative solver parameters (see Steady State Solver Options in 
the Manage Projects chapter). 

Running a dynamic simulation 
Dynamic simulations show the time-varying system response based on the time-
varying influent loading to the system (and subject to any time-varying operational 
changes such as a schedule of DO setpoints in an aerated reactor). 

   

 
Dynamic Simulation button 

70. Select the Dynamic simulation command in the Simulate menu – or 
click on the Dynamic Simulation button on the toolbar.  This opens 
the simulator player dialog. 

71. Click on the play button.  This brings up a dialog box where you can 
set various options such as the duration of the simulation.  Clicking on 
the Start button starts the dynamic simulation. 

   

 
The dynamic simulator control dialog box 
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The dynamic simulation options dialog box 

Note:  Even if you are only interested in dynamic system response, it is useful to 
first calculate the steady state solution, and then start the dynamic simulation from 
these “Current” values. 

   

Note:  In the Album a time-series chart set up for 24 hours may appear blank or 
may not reflect a change you expected to see.  Perhaps you need to change the scale 
on the bottom axis depending on what you specified as the starting date for the 
simulation. 

Keeping track of things and generating reports 
 

 
Simulation Notes button 

BioWin offers a number of features to aid in creating attractive, professional reports. 
You have your own internal Notes editor (shown below) to help keep track of project 
details.  Access this scratch pad from the Project|Notes command or by clicking 
on the Notes button on the toolbar.  It also is very easy to get results from BioWin 
into your word processor, spreadsheet or other applications.  Charts, tables, the 
drawing board view of the system layout, etc. can be copied from BioWin and pasted 
to your report.  Tables can be exported as tabbed text and then quickly converted to 
tables. 
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BioWin's internal notes editor 

Customizing BioWin 
There are a number of parts and features of BioWin that can be customized to look 
how you want.  When you customize BioWin, you essentially are changing the 
default settings of the BioWin work environment and all new projects that are 
created therein.  This functionality is accessed via the Project|New Project 
Options menu command used to customize BioWin.  A detailed description of the 
features accessed from this tabbed dialog is provided in the "Customizing BioWin" 
chapter. 

 
Many facets of BioWin may be customized to suit your needs 

The Tools|Customize command defines your “default” setup for when you start a 
new project; for example, you may always want to start with US units.  You can 
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override these preferences for the current project through the Project|Current 
Project Options command. 

Since project options are file specific, they “travel” with that file. For example, if 
you define a set of project options for “Project A” on your copy of BioWin and then 
open the “Project A” file in someone else’s copy of BioWin, you still will see your 
defined project options. As before, these project options will override any similar 
settings that the owner of the other copy of BioWin has set as defaults using the 
Tools|Customize command. For more information on the various project options 
that may be set, please see Managing BioWin Projects" 

TUTORIAL 2A - Building a Configuration 
This tutorial demonstrates how to build a new configuration and add tables to the 
Album.  Aspects covered in this tutorial include building a BioWin configuration, 
moving and connecting elements on the drawing board, specifying data for elements, 
changing model parameter values, and setting up tables to record your simulation 
data. 

The tutorial 2A system 
A city in the U.S.A. has a nitrification/denitrification system – a Modified Ludzack 
Ettinger configuration.  Phosphorus removal is achieved in a tertiary chemical 
precipitation system.  The client experiences problems in the tertiary system.  You 
want to investigate achieving P removal biologically in the existing tankage.  The 
system has the following characteristics: 

   

Unaerated 
reactors: 

Four (each 1 MG) Depth = 12 ft DO = 2 mg/L 

Aerated 
reactors: 

Two (each 7.5 MG) Depth = 12 ft DO = 2 mg/L 

Clarifier (Ideal): Area = 123,000 ft2 Depth = 14 ft  

Influent: Average Flow = 88 
MGD 

  

 COD = 246 mg/L TKN = 24 mgN/L  

 TP = 5.4 mgP/L ISS = 15 mg/L  

 Alkalinity = 6 
mmol/L 

  

Wastewater 
fractions: 

fBS = 0.12 fUP = 0.10  

 fUS = 0.07 fNA = 0.75  

RAS recycle: 44 MGD (50%)   

NML recycle: 264 MGD (300%)   

Wastage rate: 1 MGD (constant 
rate) 

  

Temperature: 18°C   
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Nitrification rate: 0.8 /d   

   

 
The Tutorial 2A system configuration 

Adding elements to the drawing board 
Note:  When building the configuration, don’t interchange mixers with splitters or 
influents with effluents. 

   

Note:  In this tutorial we are using an ideal secondary settler.  Tutorial 1 used a 
model settler. 

   

 
Element Placement Cursor 

72. Run BioWin and change to US units via the Project|Current Project 
Options command. 

73. Add each of the units shown in the screen view above.  [We’ll connect 
units with pipes later].  Repeat the following three steps as you build 
the system in the drawing board:· 

• Click the button corresponding to the element you want on the 
configuration toolbar.· 

• Move the cursor onto the drawing board. When you do this, the cursor 
will change to the element placement cursor.  Click on the drawing 
board where you want the element to be placed.· 

• Change the names of the elements from the defaults to those shown in 
the screen view above (i.e. Influent, Zone #1, Zone #2,.Zone #3, Zone 
#4, Aerobic #1, Aerobic #2, Settler, Effluent, Wastage).  Right-click on 
each element and select the Name… command from the popup menu.  
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Note:  No names appear for the mixers, splitters and the settler in the screen view 
above.  This is one of the customizable features of BioWin.   You can make your 
own selection from the General tab via the Tools|Customize command. 

   

Note:  Your configuration may extend beyond the visible drawing board view.  You 
may wish to change the drawing board scale from the drop down list on the toolbar. 

   

Note:  This configuration includes mixers for the RAS stream and mixed liquor 
recycle in front of the first bioreactor.  It is not necessary to include these mixers – 
the streams could be connected directly to the front of the bioreactor. 

Rearranging and moving elements on the drawing 
board 
If you want to change an element's position: 
   

Element Selection Tool 74. Click on the element selection tool from the Configure toolbar. 

75. Move the cursor over the element on the drawing board you wish to 
move. 

76. Click on the element and while holding down the mouse button, drag 
the element to the desired new location. 

   

Note:  You also can move multiple elements simultaneously. Select the group of 
elements you wish to move, click on one of them, and drag the group to the desired 
new location. 

If you want to change an element's vertical or horizontal orientation: 
   

1. Click on the element selection tool from the configuration toolbar. 

2. Right-click the element, and from the resulting popup menu, choose 
Flip horizontal or Flip vertical (the latter option only is available 
for elements such as splitters and mixers).  

Connecting elements with pipes 
   

 Pipe Tool 

 Pipe Start Tool 

 

77. Click the pipe tool on the Configure toolbar. 

78. When you move the cursor onto the drawing board, the cursor will 
change to the "start" cursor. 

79. Place the cursor over the element area where you wish the pipe to start 
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 Pipe Start "OK" 

 No Pipe Allowed 

 

 Pipe End Cursor 

 

 No Pipe Allowed 

 

from. 

80. If the location is appropriate, a set of crosshairs will appear on the "pipe 
start" cursor. 

81. If the location is inappropriate, the cursor will change to a circle with a 
slash through it to indicate that a pipe may not begin at that location. 

82. Click the left mouse button once and move the cursor to the desired 
location of the element where you wish the pipe to end and click the 
left mouse button again. 

83. As you move the pipe towards the element where you wish it to end, 
the cursor will change to the "pipe end" cursor. 

84. If the location of the pipe terminus is appropriate, this cursor will 
remain. 

85. If the location is inappropriate, the cursor will change to a circle with a 
slash through it to indicate that a pipe may not end at that location. 

86. Repeat steps 3-9 until you have connected all your elements with 
pipes. 

   

This is important for 
arranging the 
configuration layout. 

Note:  To re-arrange a pipe’s position, click once on the arrow head of that pipe.  A 
series of circles appear at points along the pipe.  Try dragging-and-dropping.  

   

Note:  Try right clicking on the arrow head of a pipe, and view the Properties.  
There are a number of options for re-arranging the pipe layout and selecting pipe 
style. 

   

Specifying physical and operational data 
We now wish to enter all of the physical and operational data for this system 
specified earlier.  Each element (except influents and effluents) requires physical 
data, and this is specified in terms of either Volume/Depth or Area/Depth.  
Operational data depends on the type of element.  For example, units such as 
bioreactors require information on aeration and DO levels.  Units such as splitters 
and settlers also require information on the flow split in the side stream or underflow. 

Note:  There are many options for specifying operational data for the units in 
BioWin.  We only touch on a few options in this tutorial.  More complete 
information on the different options for each unit type is provided in the "Element 
Types" chapter. 

To specify data for each element (leave the influent for now): 
   

1. Double click on the element – or click the right mouse button and select 
the Properties command.  Specify data from the information listed 
earlier. 

2. For the influent element specify the type as Constant.  In this tutorial 
we only consider steady state performance.  
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File Save button 

When you are finished use the File|Save As… command – or click on the Save 
button on the toolbar - to save the configuration as My Tutorial 2 in the 
Data/Tutorials directory. 

Note:  Mixers and splitters can be defined as "dimensionless"; that is, nodes without 
volume.  This is preferable to using very small volumes compared to other process 
units in the configuration because small volumes may result in slow dynamic 
simulations. 

Specifying process temperature(s) 
Specify the global temperature for the system (18°C) via the 
Project|Temperature… menu. 

Note:  You can specify a local temperature for many of the units.  For example, 
view the Operation tab in the bioreactor dialog. 

Changing model parameters 
In this example we must specify a maximum nitrifier growth rate (referenced to 
20°C) of 0.80 /day.  All model parameters for the project are viewed/changed via the 
Project|Parameters… command.  In this case we want to go to the Kinetic menu 
and change the autotroph MuMax from the default of 0.90 to 0.80 /day. 

Note:  You can specify local model parameters for many of the units.  For example, 
view the Operation tab in the bioreactor dialog and note the check box labeled 
Local kinetic parameters.  

Checking that all data have been specified 
Before running a simulation BioWin must check to see that data have been specified 
for each of the elements. 

   

 
 
Check Simulate Data button 

1. Select the Check simulate data 
command from Simulate menu – or click on the Check data button on 
the toolbar.  A dialog box appears with a list of elements for which data 
have not been specified and/or elements without pipe connections.  

Note:  Don’t worry if you forget the check.  BioWin will remind you about missing 
data.  It may seem unnecessary to check data for elements (such as mixers) where 
you generally will accept the default values.  This only is necessary once. 

Adding tables to the Album 
You’ve now completed setting up the configuration.  [Remember: You’ve yet to run 
a simulation so data values may be garbage!].  We now want to add data tables to the 
Album.  Let’s set up a table similar to that shown below on Page 1 of the Album.  
This has rows for influent, all bioreactors, effluent and wastage, and columns for 
NH3-N, NO3-N, PO4-P, ISS, flow, VSS and TSS. 
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Table from the tutorial configuration 

   

 Album button 1. Select Album from the View 
menu – or click on the Album toolbar button – or press Ctrl + A.  
This opens the Album – it’s blank for now. 

2. Select Add Page from the 
Album menu and click OK. 

3. Right-click on the album page. 

4. Select Table from the popup 
menu.  

 
Dialog box used for choosing elements to include in your table 
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5. A dialog will open with the Choose elements tab displayed. From 
the Elements tree view, select the element(s) that you wish to include 
in the table.  

6. If you wish to include all the elements from a group (for example, all 
the bioreactors), click on the group heading and then click the right-
pointing arrow to move them all to the Selected Elements list. 

7. If you wish to include only certain elements from a group (or groups), 
then click on the plus sign (+) next to the group heading to expand it, 
click on the specific element you want to include, and then click the 
right-pointing arrow to move it to the Selected Elements list. 

8. If you want to change the order in which the Selected Elements will 
appear in the table, move the elements around by clicking on them and 
then clicking the Up/Down arrows. 

9. Now click the Choose compounds tab. In the Compounds list, 
select the compounds that you wish to appear in your table, and add 
them to the Selected compounds list by clicking the right-pointing 
arrow. To select multiple compounds: 

10. Select contiguous multiple compounds by clicking on the first desired 
compound, holding down the Shift key, and clicking the last desired 
compound. 

• Select non-contiguous multiple series by holding the Ctrl key and 
clicking on the different desired compounds. 

 
Dialog box used for selecting compounds for inclusion in your table 
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11. If you wish to re-add certain compounds, place a check in the box 
labeled Duplicates, and re-add the compounds. 

12. Click OK to finish.  

   

Note:  You can change the order of rows and columns in the table very easily.  
Right-click on the table, select the Edit table command, and use the Up/Down 
arrows. 

   

Note:  Try clicking the right mouse button on different parts of the Album pages 
(including the name tabs at the bottom – you can change the name of your tab to 
“Table” from “Page 1” if you wish). 

   

Note:  Moving the cursor over elements on the drawing board gives you a sneak 
preview of data in the panes below the drawing board. 

Adding element information to the Album 
The previous section showed how to set up a table in the Album.  You can also add 
pre-formatted element-specific information to the Album.  Let’s add information on 
the last aerated bioreactor (Aerobic #2) to Page 2 and for the settler to a new page of 
the Album.   

We’ll do this by two different methods. 
   

 Album button 1. Select Album from the View 
menu – or click on the Album toolbar button – or press Ctrl + A. 

2. Select Add Page from the 
Album menu and click OK. 

3. Right-click on the album page. 

4. Select Element info from the 
popup menu.  

5. Select Aerobic #2 from the drop-
down element list, and click on the Summary view radio button. 

We’ll add a similar table to the Album for the settler, but using a 
different method. 
   

   

   

   

 Album button 

1. Close the Album, and move the 
cursor over the settler in the drawing board. 

2. Right-click and select the Add to 
album|Element info (Summary) command. 

3. Select Album from the View 
menu – or click on the Album toolbar button – or press Ctrl + A.  The 
new table should appear on a new Album page.  
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Note:  Summary tables differ depending on the type of element.  For example, we 
see an overflow rate for the settler summary and an OUR for a bioreactor.  For more 
detailed instructions review the section on Album Element Information 
Displays in the "BioWin Album" chapter. 

TUTORIAL 2B - A Nutrient Removal Refresher 
This tutorial demonstrates application of BioWin to the system set up in Tutorial 2A.  
Aspects covered in this tutorial include phosphorus removal in an anaerobic selector, 
high-rate P removal systems, and high nitrification rate/high temperature conditions. 

Anaerobic selector modification (including P 
removal) 
   

 File Open button 1. If you have restarted BioWin open the file Tutorial 2 using the 
File|Open command – or click on the Open button on the toolbar. 

2. We’ll record results in the table below: 

   

Temp Nit. Rate NML 
Recycle 

SRT Effluent 
Ammonia 

Effluent 
Nitrate 

Effluent 
PO4-P 

       

       

       

       

       

       

       

       

   

3. Run the steady state simulation.  Tabulate the results, and note the 
nitrification, denitrification and P removal performance. 

4. You also need to record the SRT.  Click on the Project|Active SRT 
command – or click on the Active SRT button on the toolbar.  You 
can give this SRT a name if you like (to distinguish it in case you want 
to look at other SRT “scenarios”, e.g. a case where the sludge mass in 
the settler is included in the SRT calculation).  From the Select 
elements for total mass button, add all of the bioreactors.  Click the 
Select wastage elements button, expand the Effluent tree, and 
select the Wastage element.  The SRT will now appear on the status 
bar at the bottom of the screen. 

5. Discuss possible retrofit options to achieve biological P removal in the 
existing tankage. 

6. Try reducing the nitrified mixed liquor recycle rate (to zero). 
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Note:  In specifying the wastage element(s) for the SRT calculation we selected the 
Wastage output element.  We could also have selected the side stream (S) of 
the splitter where the waste stream is withdrawn.  However, don’t select both 
elements as this would count the wastage twice! 

   

Note:  We are calculating SRT based on the mass of sludge in the bioreactors.  We 
could include the sludge in the clarifier. 

   

Note:  If we include the secondary effluent in the SRT calculation we would be 
accounting for solids lost via that stream. 

High Rate P Removal System 
1. Now we wish to modify the system to attain P removal without 

nitrification (with the mixed liquor recycle set to zero).  To do this we 
increase the wastage rate to reduce SRT and wash out the nitrifiers.  
BioWin provides a convenient way to set the SRT to a specific value, 
and calculate the required wastage rate. 

 
 
SRT Calculation/Control 

2. Click on the Project|Active SRT
command – or click on the SRT button on the toolbar.  Place a check in 
the Control SRT box – new options appear in the lower part of the 
dialog. 

3. Select WAS splitter from the pull-down list, and specify the last SRT 
from your table.  Re-run the steady state simulation, and check that the 
wastage rate is 1 MGD. 

4. Re-run for an SRT of 5 days, and tabulate the results.  Reduce the SRT 
further to 4 days.  Have we washed out the nitrifiers? 

High Nitrification Rate / High Temperature 
Conditions 
Now we encounter an unusually high temperature summer.  What if the nitrification 
rate is high? 

   

1. Change the maximum nitrifier growth rate from the value of 0.8 to 
1.0/d. 

2. Change the temperature to 24°C. 

3. Repeat the simulation for an SRT of 4 days, and see if the nitrifiers still 
wash out. 

4. Decrease the SRT further to 3 days, and repeat.  Is the P removal 
performance good? 
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TUTORIAL 3 - Nitrification Dynamics and Setting up 
Charts 

This tutorial demonstrates dynamic simulations and a comparison of nitrification 
performance in a plug flow versus a completely mixed reactor configuration.  We 
will learn how to set up charts in the Album. 

Aspects covered in the tutorial include steady state and dynamic simulations, and 
setting up charts in the Album. 

The tutorial 3 system and the influent data 
For this demonstration we will split the influent flow (actual field data) equally 
between two parallel trains as shown in the BioWin screen view below. The system 
has the following characteristics: 

   

PFR reactors: Four (each 1.2 ML) Depth = 4.5 m DO = 2 mg/L 

CSTR reactor: One (4.8 ML) Depth = 4.5 m DO = 2 mg/L 

Clarifier (Ideal): Each Area = 1,000 m2 Depth = 4.8 m 

Influent: Accept default wastewater characteristics 

RAS recycle: Each 7.5 ML/d (50%)  

Wastage rate: Each 0.2 ML/d (constant 
rate) 

 

Temperature: 20°C   

Nitrification rate: 0.9 /d   
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The Tutorial 3 system configuration layout 

The following diurnal influent loading pattern for flow, COD, TKN, TP and ISS has 
been established. 

   

Time Flow 
(ML/d) 

COD 
(mg/L) 

TKN 
(mg/L) 

TP (mg/L) ISS (mg/L)

0 29.8 437 28.7 5.0 17 

2 20.4 401 29.2 5.3 12 

4 14.4 333 29.7 5.1 13 

6 14.3 341 29.8 4.8 8 

8 23.9 260 24.1 3.7 9 

10 37.6 279 33.5 4.7 16 

12 41.9 402 42.9 7.0 25 

14 40.5 383 40.5 6.9 27 

16 35.0 419 36.2 6.5 25 

18 32.6 411 31.8 5.9 18 

20 32.7 364 27.8 4.8 22 

22 34.0 406 26.2 4.4 21 

Set up the configuration and influent data 
1. Select a unit basis of ML and ML/d. 

2. Create the configuration shown above, and set up all of the physical 
and operational data. 

3. Double click on the influent element, click on the Edit data button, 
and enter the time-varying influent data recorded in the table above. 

Hint:  To save on typing all those numbers, open the Word document containing the 
table (Tutorials.doc), copy columns of data to the clipboard, and paste the data into 
BioWin.  When pasting a column of data, place the cursor in the top cell in a column. 

4. Save the file as My Tutorial 3 in the Data/Tutorials directory. 

5. Note the max. spec. growth rate from the 
Project|Parameters|Kinetic menu. 

Note:  In this system we do not include mixers for the influent and RAS streams.  
Both streams are connected directly to the front-end reactors in each train. 

Steady State Performance 
1. Run the steady state simulation. 

2. Open the Album and add a new page with two horizontal panes using 
the Album|Add page command. 
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3. In the upper pane, set up a table that shows flowrate, NH3-N, NO3-N, 
VSS and TSS for the upper section (plug flow part) of the plant; that is, 
in each reactor and in the effluent. 

4. Create a similar table in the lower pane, but for the lower section 
(completely mixed). 

5. Re-run the steady state simulation, and discuss the results. 

6. The tables on Page 7 (note that your page number may be different if 
you’ve started with a blank album) should be similar to that shown 
below. 

 
Your results after running a steady state 

Setting up charts 
There are many options for creating different types of chart in BioWin.  This tutorial 
will only show a few examples and a limited number of formatting options.  These 
will be the ammonia and oxygen utilization rate responses in the system.  More 
example charts are included in the An Example file.  For details on charting 
options refer to the chapters: 

   

• "Creating Charts & Adding Series" 

• "Chart Formatting Procedures" 

• "Series Formatting Procedures" 

Note:  The default chart template can be customized. 

Create a Time series chart 
In this section we set up a time series chart showing the ammonia concentration 
response in the completely mixed reactor, Cell CSTR, and in the effluent from this 
train. 

   

1. Open the Album and use the Album|Add page command to add a 
page  

2. Right click on the blank pane, and select the Chart command.  

3. Position the cursor over the chart, right click, and select Add Series.  
This opens on the Time series tab – the one we want for now. 

4. Select Cell CSTR in the Element name pull-down list, highlight 
NH3-N from the State variables list, and click the Plot selected 
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button.  Select the Line option from the Time series gallery, and 
press OK. 

5. Repeat this procedure to plot the effluent ammonia response.  Select 
Effluent CSTR in the Element name pull-down list, highlight NH3-
N from the State variables list, and click the Plot selected button. 
Select the Line option from the Time series gallery, and press OK. 

6. Click the Close button in the Add Series dialog box. 

7. On Page 2 (once again, your page numbering may be different – this is 
not a concern) of the Album set up a time series chart comparing the 
effluent ammonia concentrations for each of the two trains. 

Note:  No lines appear in the chart yet.  You must first run a dynamic simulation 
(see below). 

   

Note:  Setting up charts automatically adds the plotted items to the database. 

Create a Multi time series chart 
In this section we set up a multi time series chart showing the ammonia 
concentration response in each of the reactors in the plug flow train, Cells #1 to #4.  
The multi time series chart is a variation of the time series where you plot the same 
variable in multiple zones simultaneously.  

   

1. Open the Album and use the Album|Add page command to add a 
page  

2. Right click on the blank pane, and select the Chart command.  

3. Position the cursor over the chart, right click, and select Add Series.  
Select the Multi time series tab. 

4. Expand the Elements tree in the window on the left, and move the 
four bioreactor cells to the right Selected elements list by selecting 
each and clicking on the right-pointing arrow.  Select NH3-N from the 
Compound pull-down list, and click the Plot selected button.  
Select the Line option from the Time series gallery, and press OK. 

5. Click the Close button in the Add Series dialog box. 

Current value chart 
1. In this section we set up a current value chart showing the nitrate 

concentration in each of the reactors in the plug flow train, Cells #1 to 
#4.  A current value chart can be presented as an area, bar or pie plot.  

2. Open the Album and use the Album|Add page command to add a 
page  

3. Right click on the blank pane, and select the Chart command.  

4. Position the cursor over the chart, right click, and select Add Series.  
Select the Current value tab. 

5. Expand the tree in the Elements window on the left, and move the 
four bioreactor cells to the right Selected elements list.  Select 
NO3-N from the pull-down Compound list, and click the Plot 
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selected button.  Select the Bar option from the Current value 
series gallery, and press OK. 

6. Click the Close button in the Add Series dialog box. 

7. Right click on the legend and select the Edit Legend command.  
Change the Text style to Point name only. 

Your own time series charts 
Try setting up two time series charts (line plots) on one page in the Album. 

   

1. Open the Album and use the Album|Add page command to add a 
page.  Select the layout with two horizontal panes. 

2. In the upper pane set up a time series chart for the OUR (total) response 
in the four-in-series reactor plug flow train.  

3. In the lower pane set up a time series chart for the OUR (total) response 
in the single reactor completely mixed train.  

Dynamic simulations 
 

 
Dynamic Simulation button 

From the main simulator window, set the dynamic simulation running for 1 day 
either from the Simulate|Dynamic simulation menu command or by clicking on 
the Dynamic simulation toolbar button. After pressing the start button select the 
Start from and Current values options, and a simulation time of 1 day. 

   

1. When the dynamic simulation is complete press the stop button in the 
player dialog. 

Note:  You can switch to the Album while the simulation runs. 

2. View the simulation results in the Album. 

Note:  All of your time series plots are 3-D at this point – great for presentations!  
However, it may be simpler to interpret results from 2-D plots.  On the last page of 
the Album right click on the charts, select the Edit Options command and on the 3 
D sub-tab of the Chart tab, uncheck the 3 Dimensions box. 

3. Continue the simulation for another 4 days. Set the dynamic simulation 
running from the Simulate/Dynamic simulation menu command or 
by clicking on the Dynamic simulation toolbar button.  After 
pressing the start button select the Continue from and Current 
values options, and set the simulation time to 4 days.   

4. Open the Album while the simulation runs. 

5. When the dynamic simulation is complete press the stop button in the 
player dialog. 

6. View the results in the Album and discuss options for reducing "break-
through" of ammonia. 

7. Re-run the steady state simulation and then run the dynamic simulation 
for 2 days using the Start from option.  When the simulation is paused 
at 2 days, double click on each wastage splitter in the drawing board 
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and reduce each wastage rate from 0.2 to 0.1 ML/d.  Press the start 
button and continue the dynamic simulation for 8 days. 

Hint:  Try starting a dynamic simulation by pressing the F7 key when the Album is 
open. 

Editing the charts 
Move the dialog box to one 
side of the chart.  That way 
you will see the changes 
happen immediately without 
having to close the dialog. 

In setting up the charts you accepted many default charting options.  For example, 
automatic scaling of axes, the increments on axes, the grid appearance, the color 
selection, the legend format, the chart titles, etc.  The options are too numerous to 
list. 

Experiment with the many chart options.  Start by right clicking on a chart and 
selecting the various commands. 

TUTORIAL 4 – Secondary Clarifier Simulation 
This tutorial demonstrates aspects of modeling secondary clarifier performance with 
the one-dimensional settler model.  Aspects covered in this tutorial include model 
settler behavior under steady state and dynamic conditions. 

The tutorial 4 system 
For the demonstration we set up a simple one-reactor system with a model settler as 
shown in the BioWin screen view below. The system has the following 
characteristics: 

   

Bioreactor: 30 ML Depth = 4.5 m DO = 2 mg/L 

Clarifier (Model): Area = 4,000 m2 Depth = 4.0 m  

RAS recycle: Initially 100 ML/d 
(100%) 

  

Wastage rate: 6 ML/d (constant 
rate) 
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The Tutorial 4 system configuration 

   

1. Change to SI units (ML and ML/d) and set up the system. 

2. Double click on the influent element, click on the From file button, 
and load the file An Example.ifd from the DATA directory. 

3. Run a steady state simulation to check that you have specified all the 
necessary data. 

4. Use the File|Save As command to save the configuration as My 
Tutorial 4 in the Data/Tutorials directory. 

Note:  In this example the wastage stream effectively is withdrawn from the 
bioreactor, not the underflow.  This is termed hydraulic SRT control.  The reason for 
choosing this mode is that, irrespective of the underflow rate and the underflow TSS, 
the reactor TSS concentration will remain relatively constant.  By wasting mixed 
liquor from the reactor we will maintain a relatively constant SRT even when the 
underflow rate changes.  In this case wasting 6 ML/d from a bioreactor volume of 30 
ML translates into a 5 day SRT (but remember we aren’t accounting for sludge in the 
settler in this SRT calculation). 

Recording results and modifying the Album 
1. Add a page to the Album with two vertical panes.  Display the element 

information (summary) for the bioreactor and the model settler in the 
two panes.  Note: this step perhaps is not necessary – you’ll be able to 
get all the required information from the main simulator window. (TSS 
values, settler solids loading rate – SLR, settler specific overflow rate – 
SOR, etc.) 

2. We’ll record simulation results in the table below.  All of this 
information can be found either in the two-pane page you added to the 
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Album or by moving the cursor over elements in the drawing board and 
noting values displayed in the lower right pane. 

   

Underflow 
Rate 

Max 
Compactability

SLR SOR Effluent 
TSS 

Reactor 
TSS 

Underflow 
TSS 

       

       

       

       

       

       

Setting up a settler profile in the Album 
1. We want a view of the TSS concentration profile in the settler.  Move 

the cursor over the settler in the drawing board, right click, and select 
the Add to Album command.  Select Profile Plot… from the flyout 
menu.  In the dialog highlight Total suspended solids in the right hand 
Combined list, select Current values for the profile type, and the 
Concentration on X orientation option.  Click on the Plot selected 
button, select Line in the General series gallery, and close the 
dialog. 

2. The preceding step generated a new plot in the Album.  Open the 
Album – the new page should be visible – and confusing!  In the plot, 
concentration is on the x-axis (as selected above), and settler height is 
on the y-axis with the overflow concentration at the bottom – hence the 
confusion.  We should invert the y-axis to make the plot more sensible. 

3. Right click on the chart and select the Edit Axes command.  For the 
left axis, place a check in the Inverted box on the Scales sub-tab.  
Press the Close button. 

Note:  In this case we are simulating the settler as 10 layers in the vertical direction 
– numbered from top to bottom as 0 to 9. 

4. While we are editing the chart we should change the bottom axis 
(concentration) scale to have a minimum and maximum of 15,000 
mg/L, respectively.  Right click on the chart and select the Edit Axes 
command.  For the bottom axis, in the Scale tab uncheck the 
Automatic box, and use the Change… buttons to specify the 
Maximum and Minimum axis values.  Press the Close button. 

Steady state simulations 
1. Run the steady state simulation.  Note the effluent and underflow TSS, 

and the SLR and SOR.  View the settler profile in the Album. 

2. Change the underflow rate to 50 ML/d by double clicking on the settler 
in the drawing board and going to the Flow split tab.  Repeat the 
steady state simulation and record the results. 



 

514  •  BioWin Tutorials and Examples  

3. Change the underflow rate to 33 ML/d by double clicking on the settler 
in the drawing board and going to the Flow split tab.  Repeat the 
steady state simulation and record the results. 

Dynamic Simulations 
1. Add a page to the Album with two horizontal panes.  In the upper pane 

set up a time series chart (Line style) for the settler specific overflow 
rate, SOR.  Set minimum and maximum values on the left axis of 0 and 
20.  In the lower pane set up a time series chart (Line style) for the 
settler solids loading rate, SLR.  Set minimum and maximum values on 
the left axis of 0 and 200. 

Note:  Initially the charts will be blank because we have yet to run a dynamic 
simulation. 

2. Add another page to the Album with two horizontal panes.  In the 
upper pane set up a time series chart (Line style) for the effluent TSS.  
Set minimum and maximum values on the left axis of 0 and 30.  In the 
lower pane set up a time series chart (Line style) for the settler 
underflow TSS.  Set minimum and maximum values on the left axis of 
0 and 16,000. 

3. Start a dynamic simulation for 2 days.  Observe the predicted 
performance of the model settler in the Album. 

Hint:  If you start the simulation from the BioWin main window the Album 
disappears.  You can keep it open while the simulation is running if you use the F7 
key to start the simulation. 

4. When the simulation is paused change the RAS rate to 100 ML/d.  
Continue the simulation for another 3 days. 

5. When the simulation is paused change the RAS rate to flow-paced at 
33% (based on the influent flow).  Continue the simulation for another 
3 days. 

6. From the Project|Parameters|Settling... menu, on the Modified 
Vesilind tab, change the maximum sludge compactability to 8,000 
mg/L.  Continue the dynamic simulation for another 6 days.  Watch the 
settler profile and effluent TSS in the Album. 

7. Try other situations with changes to the settler area/depth, and changes 
to the sludge settling properties. 

Note:  Setting a low sludge compactability may cause problems with steady state 
simulations not converging.  This is a result of numerical solver problems because 
there can be multiple solutions to the mass balance equations.  In this situation, what 
you may wish to do in place of a steady state simulation is run a dynamic simulation 
for an extended period of 3 - 4 SRTs.  This should move to the steady state solution. 

TUTORIAL 5 - Aeration System Simulation 
This tutorial demonstrates diffused aeration system modeling. 

Aspects covered in this tutorial include effects of changing oxygen parameters under 
steady state and dynamic conditions. 
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The tutorial 5 system 
For the demonstration we will split the influent flow equally between two parallel 
trains as shown in the BioWin screen view below. The systems have the following 
characteristics: 

   

Bioreactors: Each 25 ML Depth = 3.0 m DO = 2 mg/L 

Clarifier 
(Ideal): 

Each Area = 2,000 m2 Depth = 4.0 m  

RAS recycle: Each 50 ML/d 
(100%) 

  

Wastage 
rate: 

Each 1.0 ML/d 
(constant rate) 

  

 
The system used for Tutorial 5 

   

1. Change to SI units (ML and ML/d) and set up the system. 

2. In the influent element, load the file An Example.ifd from the DATA 
directory 

3. Use the File|Save As command to save the configuration as My 
Tutorial 5 in the Data/Tutorials directory. 

Recording results and modifying the Album 
1. Add a new page to the Album with two vertical panes.  Display the 

element information (summary) for the top reactor and the bottom 
reactor in the two panes. 
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2. We’ll record simulation results in the table below.  All of this 
information can be found in the two-pane page you added to the 
Album. 

   

Depth Temp. αF DO OUR QAIR OTR SOTE(%)

3.0 20 0.5 2     

4.5 20 0.5 2     

6.0 20 0.5 2     

4.5 12 0.5 2     

4.5 20 0.5 4     

4.5 20 0.8 2     

        

        

Steady state simulations 
1. Run a steady state simulation and evaluate the predicted performance 

of the aeration system.  [Note: data for the top and bottom reactors 
should be the same.  If not, you must have an error because the two 
systems should be set up identically, each receiving half of the influent 
flow].  Tabulate one set of the results. 

2. Change the depth of the lower bioreactor in steps from 3.0 m to 4.5 and 
then 6.0 m.  For each change, re-run the steady state simulation, and 
tabulate the results for the new depth.   

3. Set the depth of each bioreactor to 4.5 m.  The global temperature for 
the system is 20°C.  Double click on the bottom cell to open the 
Properties dialog.  On the Operation tab, check the local 
temperature option, and specify a temperature of 12°C. Re-run the 
steady state simulation, and tabulate the results for the new 
temperature. 

4. Re-set the temperature to 20°C. Change the DO setpoint in the lower 
bioreactor to 4 mg/L, re-run the steady state simulation, and tabulate 
the results. 

5. Re-set the DO setpoints to 2 mg/L in each reactor.  Change α for the 
lower reactor to 0.8 (double-click on the Bottom Cell, click the 
Operation tab, check the Local aeration parameters box and 
click the Model Parameters button – you can find aeration 
parameters such as alpha and beta on the Aeration tab).  Re-run, and 
tabulate the results. 

6. Switch on oxygen transfer and DO modeling in the Project|Current 
Project Options menu on the Model tab.  Re-run the steady state 
simulation, and discuss differences in model predictions. 

7. Re-set the α values to 0.5.  Instead of specifying DO setpoints, switch 
to air supply rate and adjust the values.  
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Dynamic Simulations 
1. Modify the Album to include charts of air supply rate, DO and OURt 

for each of the aerated reactors. 

2. Start a dynamic simulation.  Observe the response of the aeration 
parameters. 

3. Pause the simulation and change aeration parameters.  Attempt to 
predict the effect of the change before continuing the simulation. 

TUTORIAL 6 – Setting Up an SBR System 
This tutorial provides an introduction to using sequencing batch reactor (SBR) 
modules in BioWin.  The system considered here is based on the simplest SBR 
module; namely, a single-tank unit (without prezones) where filling, settling and 
decanting all occurs in one zone without baffles. 

Important Notes: 
   

• This configuration is not proposed as a potential design.  Rather, the 
objective merely is to illustrate how to set up an SBR system in 
BioWin. 

• Detailed Help on the different SBR modules is provided in the Element 
Types"chapter. 

• There are certain basic issues to consider when simulating SBR 
systems.  See the introductory notes of the More Examples section 
later in this document. 

   

The System 
We wish to set up an SBR system with four identical units in parallel.  The layout of 
the system is shown in the figure below.  Each unit will operate on the same cycle, 
with equal periods for fill, react, settle and decant (1 hour each, with a total cycle 
time of 4 hours, and 6 cycles per day).  Influent to the system is directed sequentially 
to each of the four units for a fill period of one hour.  That is, SBR #1 receives 
influent for 1 hour (while SBR #2 is decanting, SBR #3 is settling, and SBR #4 is 
reacting).  At the end of the hour influent is directed to SBR #2 and each of the SBRs 
moves to the next stage in its cycle (SBR #1 starts the react period, SBR #3 starts 
decanting, and SBR #4 starts settling).  In summary, each SBR is operated on the 
same cycle, but the cycles are offset from the adjacent unit by one hour. 
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The four-unit SBR system configuration 

Suggested Approach 
The response and interactions in a four-unit system like this can be very complex.  
Even viewing the results can be confusing!  As an example, the chart below shows 
how the level in each SBR might change over 24 hours.  It is strongly suggested that 
the practical approach is to first set up a system that includes the flow division, but 
with only one of the trains; that is, only one SBR unit.  The system then can be 
debugged more readily. 

 
Volume plot for system incorporating all 4 SBRs 
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Setting up the One-Unit Configuration 
Set up the single-tank SBR system shown in the BioWin screen view below.  The 
characteristics that we will specify for the system are as follows: 

   
SBR (full) volume 20 ML 

Depth 4.5 m 

Width 66 m 

Minimum decant level 50% 

Cycle: Fill  1 hour 

 React  1 hour 

 Settle  1 hour 

 Decant  1 hour 

DO (fill and react phases) 2 mg/L 

Initial liquid hold-up 50% 

SBR underflow (for wastage): 20 ML/d from 1:45 to 2:00 hours in each 
cycle. 

 
The Tutorial 6 system configuration 

   

1. Change to SI units (ML and ML/d) and set up the system. 

2. Right click on elements to change names. 

3. Double click on the influent element, click on the From file button, 
and load the file An Example.ifd from the DATA directory. 

4. Use the File|Save As command to save the configuration as My 
Tutorial 6 in the Data/Tutorials directory. 
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Specifying the flow distribution information 
1. Double click on the first flow splitter element after the influent – or 

click the right mouse button and select the Properties command.  

2. Select the Flow split tab, and specify the splitter as a flow router by 
placing a check in the box at the lower left.  Click on the Routing 
pattern button, and specify that the flow is Switched at intervals of 
2 hours.  This directs all the influent to SBRs #1 and #2 for 2 hours, 
then to SBRs #3 and #4 for 2 hours, and so on. 

3. For each of the flow splitters in front of a pair of SBRs, double click on 
the element – or click the right mouse button and select the 
Properties command. Select the Flow split tab, and specify the 
splitter as a flow router by placing a check in the box at the lower left.  
Click on the Routing pattern button, and specify that the flow is 
Switched at intervals of 1 hour.  Any flow reaching the router from 
the upstream router is alternated between the two SBRs at one-hour 
intervals. 

 
 
File Save Button 

4. When you are finished use the 
File|Save As… command – or 
click on the Save button on the 
toolbar - to save the configuration 
as My Tutorial 6 in the 
Data/Tutorials directory. 

Specifying the SBR physical information 
1. Double click on the SBR element – or click the right mouse button and 

select the Properties command. 

2. On the SBR dimensions tab enter the SBR volume (full), depth and 
width (20 ML, 4.5 m, 66 m). 

3. On the Initial values tab enter the initial SBR liquid hold-up as 50% 
(of the maximum i.e. 10 ML). 

Specifying the SBR operational information 
For the SBR operation we wish to specify equal 1 hour periods for fill, react, settle 
and decant; that is, a 4 hour cycle.  The fill and react phases define the "mixed" 
period of operation, where it is assumed that the reactor contents are well-mixed 
through either aeration or mechanical mixing. 

Hint:  It is simplest if you adjust the cycle times in the order Mix start time, 
Decant start time, Cycle length.  BioWin is continually checking your input 
data, and won't allow things like decanting after the end of the cycle. 

   

Hint:  When reducing times from 1:00:00 (i.e. 1 day, zero hours, zero minutes) to 
say 4 hours, first increase the number of hours to 4 (i.e. 1:04:00) and then reduce the 
day unit (i.e. 0:04:00). 

   



 

 BioWin Tutorials and Examples  •  521 

1. On the SBR operation tab start by setting the Mix until / Start 
settling at time to 2 hours (i.e. fill + react). 

2. Set the Decant / Draw starting at time to 3 hours. 

3. Set the Cycle length or duration to 4 hours. 

4. Select the To minimum decant level option so that the SBR is 
decanted to 50% each cycle. 

5. Click on the SBR aeration button and specify a constant DO 
setpoint of 2 mg/L. 

Specifying the sludge wastage information 
We wish to waste sludge from the SBR at a rate of 20 ML/d for a period from 1:45 to 
2:00 during each cycle (i.e. 1.75 to 2.00 hours in decimal format).  This corresponds 
to a waste volume of 208 m3 per cycle. 

   

1. On the SBR underflow tab select the Flow pattern option and click 
on the Pattern button. 

2. Select hours in the Time in grid group. 

3. Set the Cycle time to 4 hours. 

4. In the grid enter the time and flow data as shown below. 

 
The SBR underflow tab showing the wastage information 

   

 
 
File Save Button 

Note : All the required information has been specified.  When you are finished use 
the File|Save As… command – or click on the Save button on the toolbar - to save 
the configuration as My Tutorial 6 in the Data/Tutorials directory. 
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Checking the system set-up 
We want to check that all the data has been specified correctly.  Generally this is 
achieved most easily by (1) following the SBR liquid hold-up over a 24 hour period 
(six cycles), and (2) checking that the flow routers are distributing the influent flow 
in the correct sequence.  [In this example the influent flow rate varies over the 24 
hour cycle, but is specified as constant for two-hour periods.  This simplifies 
checking the SBR volume response]. 

Note:  No lines appear in the charts until you run a dynamic simulation (see below).  

1. Open the Album on Page 1. 

2. Right click on the blank pane, and select the Chart command.  

3. Position the cursor over the chart, right click, and select Add Series. 
This opens on the Time series tab – the one we want for now. 

4. Select SBR #1 in the Element name pull-down list, highlight Liq. 
Vol. from the State variables list, and click the Plot selected 
button. Select the Fast line option from the Time series gallery, 
uncheck the 3D option, and press OK. 

5. Click the Close button in the Add Series dialog box. 

6. Repeat this procedure to plot the flow to each of the four parallel 
branches in Page 2.  Do this by sequentially selecting the Output and 
the Sidestream of each flow router as the series to plot. 

7. Repeat this procedure to plot the TSS concentration in SBR #1 in Page 
3. 

8. Repeat this procedure to plot the influent flow rate in Page 4. 

9. Rename the Album pages by right clicking on the tabs at the bottom of 
the Album. 

10. From the main simulator window, select the Project|Database|Data 
interval option, and change the interval to 15 minutes.  This is the 
interval at which monitored data are added to the database and charts. 

 
 
Dynamic Simulation Button 

11. From the main simulator window, 
set the dynamic simulation running 
for 1 day either from the 
Simulate|Dynamic simulation 
menu command or by clicking on 
the Dynamic simulation toolbar 
button (or press the F7 key).  After 
pressing the start button select the 
Start from and Seed values 
options, and a simulation time of 1 
day. 

12. View the response in the Album.  While the simulation is running open 
the Album by pressing Ctrl + A. 

13. Check that each SBR receives influent flow for the appropriate one-
hour intervals.  The album chart should appear as shown below. 
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Influent flow distribution 

   

14. Check that the SBR volume response is correct, as shown in the view 
below.  There should be 6 cycles over the 24 hours.  At the start of each 
cycle the volume should be 10 ML (50% hold-up).  For the first hour 
the level increases.  From 1:00 to 1:45 the level is constant, and then 
decreases by a small amount (208 m3) when wasting occurs over the 
last 15 minutes of the mixing period.  Decanting starts three hours into 
the cycle, and continues until the level reaches the 50% minimum at 4 
hours (end of the cycle).  During different cycles the extent of filling 
differs because the influent flow rate changes.  It is worth checking that 
the volume increase during a fill period corresponds to the amount of 
influent over that one-hour period. 
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The SBR liquid volume response 

Running the SBR simulation to reach a steady 
state 

 
 
Dynamic Simulation Button 

1. From the main simulator window, 
set the dynamic simulation running 
for 50 days either from the 
Simulate|Dynamic simulation 
menu command or by clicking on 
the Dynamic simulation toolbar 
button (or press the F7 key). After 
pressing the start button select the 
Start from and Seed values 
options, and a simulation time of 
50 days. 

2. In the Album monitor the TSS response as the system approaches a 
steady state.  While the simulation is running open the Album by 
pressing Ctrl + A.  Right click on the chart and use the Edit axes 
option to select the Automatic option for the Bottom axis.  This will 
automatically scale the chart. 

3. When the dynamic simulation is complete press the stop button in the 
player dialog.  For this system the response should have stabilized after 
approximately 40 days as shown in the view below.  In this case the 
simulation Start from date was October 14. 
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TSS response over 50 days 

Viewing the stable SBR response 
Now that the system has reached a steady state typically we will want to view the 
response over 24 hours (or individual cycles).  Usually it is most convenient to "set 
the clock back to time zero" (the Start from date of October 14 in this case), but 
start the simulation based on the Current values; that is the conditions after 50 
days of simulation.  This will save us from having to change the time axis repeatedly. 

   

 
 
Dynamic Simulation Button 

1. From the main simulator window, 
set the dynamic simulation running for 1 day either from the 
Simulate|Dynamic simulation menu command or by clicking on 
the Dynamic simulation toolbar button (or press the F7 key). After 
pressing the start button select the Start from and Current values 
options, and a simulation time of 1 day. 

2. When the dynamic simulation is complete press the stop button in the 
player dialog. 

3. In the Album view the simulated SBR response.  The view below 
shows the TSS response in SBR #1 over 24 hours (6 cycles).  For the 
first hour in each cycle (during fill) the concentration decreases as the 
volume increases.  From 2 to 3 hours (during react) the TSS remains 
near constant.  When settling commences the plotted TSS decreases 
rapidly.  This is the TSS concentration in the top layer of the SBR.  The 
maximum TSS changes from cycle to cycle because the amount of fill 
(and dilution) changes. 

4. Add additional charts to the Album. 

 
 
File Save Button 

5. At this point use the File|Save 
As… command – or click on the Save button on the toolbar - to save 
the configuration as My Tutorial 6 in the Data/Tutorials directory.  
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Note:  The file is being saved "as is".  This means that at a later date the file can be 
loaded, and re-run using the Start from and Current values options (i.e. the status 
of the system at the time of saving the file).  This obviates the need to run for an 
extended period to reach steady state 

 
TSS response over 24 hours 

The BioWin file for this system can be found in the Data/Tutorials directory under 
the name:  Tutorial 6.BWC. 

The Album includes charts for a large number of parameters. 

Important note:  Making changes to SBR physical or operational data often 
requires running the simulation for an extended period to attain a new steady state. 

More BioWin Examples 
A number of example configurations are provided on the installation CD.  These can 
be found in the Data\Examples directory.  These highlight some of the advanced 
features available in BioWin.  This chapter provides a brief description of the 
systems.  A level of familiarity with BioWin is assumed – detailed instructions for 
setting up the configurations such as those given in the Tutorials chapter are not 
given here.  Therefore, it is recommended that you complete the tutorial exercises 
earlier in this chapter before investigating these examples. 

Example SBR Systems 
Notes :  
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• The example configurations are not proposed as potential designs.  
Rather, the objective is to illustrate how to set up SBR systems in 
BioWin, based on the different SBR modules. 

• Detailed Help on the different SBR modules is provided in the 
"Element Types" chapter. 

• There are certain basic issues to consider when simulating SBR 
systems.  Read the Considerations in SBR Systems section before 
proceeding with the examples. 

• All the examples use the influent loading pattern from the file An 
Example.IFD, and default wastewater characteristic fractions. 

• The nitrifier maximum specific growth rate is set at 0.5 /day for all the 
examples. 

• SRT for all of the systems is in the range of 15 days.  Each case was 
simulated for 60 days to attain steady state, and then re-run for 24 hours 
using the Start from and Current values options before saving the 
files. 

   

Important note:  Making changes to SBR physical or operational data often 
requires running the simulation for an extended period to attain a new steady state. 

List of SBR Examples 
BioWin files for these systems can be found in the Data/Examples/SBR directory.  
The Albums include charts for a large number of parameters. 

   

1. Four-in-Parallel Aerobic SBRs 

2. Single Continuous Flow SBR with Unaerated Mixed Pre-zone  

3. Single Continuous Flow SBR with Unaerated Settling Pre-zone 

4. Single Continuous Flow SBR with Two Unaerated Mixed Pre-zones 

5. Single Continuous Flow SBR with Two Unaerated Settling Pre-zones 

6. Two-in-Parallel SBRs with Unaerated Mixed Pre-zone  

7. Two-in-Parallel SBRs with Unaerated Settling Pre-zone  

8. Two-in-Parallel SBRs with Two Unaerated Mixed Pre-zones  

9. Two-in-Parallel SBRs with Two Unaerated Settling Pre-zones  

10. Two-in-Parallel SBRs with Unaerated Constant-volume Pre-zone 

11. Two-in-Parallel Single-Tank SBRs with Unaerated/Aerated Periods 

12. Wastewater Characterization Fill-and-Draw SBR 

     

      

Considerations in SBR Systems 
Three aspects inherent to SBR systems require special consideration: 
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• Steady State 

• Sludge Age 

• Cycle Offsets 

Steady state with SBR systems 
SBR systems necessarily are dynamic, and the concept of steady state is not relevant.  
However, if we operate an SBR system with a fixed influent loading the SBR system 
will attain a quasi "steady state". [Note: the input could be either a Constant Input or 
a Variable Input].  That is, the SBR system response would be repeated identically 
from cycle to cycle, where the term "cycle" refers to the longest cycle in the dynamic 
system [not necessarily the cycle time of the SBR].  For example, the cycle time of a 
Variable Input influent element typically would be 24 hours, and this would be the 
quasi steady state cycle time (provided of course that the SBR cycle time is less than 
24 hours which usually is the case).  Even with a Constant Input, the quasi steady 
state "cycle" time may differ from the SBR cycle time.  For example, perhaps 
wastage only occurs every third cycle; in this case the steady state "cycle" time will 
be three times the cycle time of the SBR. 

A general guideline for the time a dynamic system takes to reach a quasi "steady 
state" is three to four times the longest time constant in the system.  In the case of 
activated sludge systems usually the longest time constant will be the sludge age (or 
SRT).  For SBR systems it is difficult to calculate an exact SRT so it is suggested 
that the appropriate procedure to identify when "steady state" is reached is by 
simulating for an extended period while viewing the TSS response. 

When setting up an SBR system it is suggested that you first simulate for an 
extended period until you attain a quasi "steady state".  Then save the file.  When 
you re-open the file at a later time, you start off from the "steady state" [by running 
the dynamic simulation from Current values when the dynamic simulation is 
started. 

Sludge age or SRT in SBR systems 
Sludge age (or SRT) is defined as the mass of sludge in the system divided by the 
mass of sludge wasted per day.  In practice sludge likely will be wasted from an SBR 
towards the end of the settle/decant phase.  At this time the sludge concentration is 
high and the waste volume will be lowest for a given mass wasted. 

Design of activated sludge systems usually is based on some notion of a desired 
SRT.  Experience with simulating SBRs indicates that it is difficult to estimate a 
required wastage rate for the target SRT if wasting occurs during settle/decant.  This 
difficulty is related to a number of factors:  quantifying the mass of sludge in the 
system, the sludge compactability, the changing sludge concentration at the base of 
the SBR during settle/decant, and the possibility of "rat holing" if the wastage rate is 
high. 

For simulation purposes it is simpler to achieve a desired SRT with reasonable 
accuracy through setting up the system for hydraulic SRT control; that is, wasting of 
mixed liquor during the mixed phase rather than wasting settled sludge.  For 
example, setting an SRT of 10 days requires wasting one tenth of the mixed reactor 
contents (volume) each day.  Even this approach is not explicitly suited to SBR 
systems because the liquid hold-up and mixed liquor solids concentration likely 
changes from cycle to cycle.  However, consideration of the liquid volume response 
usually allows a reasonable estimate of the volume of mixed liquor to waste so as to 
attain a given SRT.  For example, consider an SBR with a maximum volume of 20 



 

 BioWin Tutorials and Examples  •  529 

ML that is operated with 4 cycles per day, and decanted to 50% of the maximum 
each cycle.  A trial simulation will provide an estimate of the average hold-up at the 
end of each cycle; say this is 16 ML.  To attain an SRT of approximately 10 days 
requires wasting 1.6 ML of mixed liquor each day, or 0.4 ML/cycle.  In this case we 
could set up the wastage to operate over the last 15 minutes of the mixed period in 
each cycle, at a rate of 1.6 ML/h (i.e. 38.4 ML/d for 15 minutes).  

Hint:  In certain SBR configurations there is recycling of sludge (usually only during 
the mixed phase) from the decant zone to an upstream pre-zone or reactor.  This 
recycle can be set up using the SBR underflow.  Wasting of mixed liquor is achieved 
via a splitter in the recycle stream, as shown in the view below. 

 
SBR with recycle and wasting from the recycle 

Cycle offsets 
Individual units in parallel-unit SBR systems usually operate with the same cycle 
times of fill, react, settle and decant.  However, the cycles are staggered in time.  
This is achieved readily in BioWin through offsets. 

Hint:  Select the unit that first receives influent as the reference (zero offset).  An 
offset is specified for each of the other units.  Think of the offset as the "time into the 
cycle" for that unit when the reference unit first receives influent.  

Consider the four SBR system shown below.  Each unit operates on the same cycle, 
with equal periods for fill, react, settle and decant (1 hour each, with a total cycle 
time of 4 hours, and 6 cycles per day).  Influent to the system is directed sequentially 
to each of the four units for a fill period of one hour.  That is, SBR #1 receives 
influent for 1 hour (while SBR #2 is decanting, SBR #3 is settling, and SBR #4 is 
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reacting).  At the end of the hour influent is directed to SBR #2 and each of the SBRs 
moves to the next stage in its cycle (SBR #1 starts the react period, SBR #3 starts 
decanting, and SBR #4 starts settling).  Offsets will be specified as follows:  SBR #1 
is the reference; SBR #2 must be 3 hours "into the cycle" because in one hour it will 
receive influent; and so on.  In summary: 

   

Unit Offset (hours) 

SBR #1 Zero 

SBR #2 3 

SBR #3 2 

SBR #4 1 

   

 
Four-in-Parallel System 

Four-in-Parallel Aerobic SBRs 
The BioWin file for this system can be found in the Data/Examples/SBR 
directory under the name:  Four SBRs.BWC. 

This example completes the system set up in Tutorial 6.  There are four identical 
units in parallel.  Each unit operates on the same cycle, with equal periods for fill, 
react, settle and decant (1 hour each, with a total cycle time of 4 hours, and 6 cycles 
per day).  Influent to the system is directed sequentially to each of the four units for a 
fill period of one hour.  That is, SBR #1 receives influent for 1 hour (while SBR #2 
is decanting, SBR #3 is settling, and SBR #4 is reacting).  At the end of the hour 
influent is directed to SBR #2 and each of the SBRs moves to the next stage in its 
cycle (SBR #1 starts the react period, SBR #3 starts decanting, and SBR #4 starts 
settling).  In summary, each SBR is operated on the same cycle, but the cycles are 
offset from the adjacent unit by one hour.   
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Characteristics of the system: 
   
SBR (full) volume 20 ML  

Depth 4.5 m  

Width 66 m  

Minimum decant level 50%  

Cycle: Fill  1 hour  

 React  1 hour  

 Settle  1 hour  

 Decant  1 hour  

DO (fill and react 
phases) 

2 mg/L  

Initial liquid hold-up 50%  

SBR underflow (for 
wastage): 

20 ML/d from 1:45 to 2:00 
hours in each cycle. 

 

Offsets: Unit Offset (hours) 

 SBR #1 Zero 

 SBR #2 3 

 SBR #3 2 

 SBR #4 1 

 
The BioWin configuration 
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Example Album Chart 

Single Continuous Flow SBR with Unaerated Mixed 
Prezone  
The BioWin file for this system can be found in the Data/Examples/SBR 
directory under the name:  Continuous Flow SBR (mixed pre-zone).BWC. 

This single-SBR system is operated with continuous flow but intermittent decant.  
The SBR has an unaerated always-mixed prezone.  The prezone is hydraulically 
connected to the main SBR zone; that is, the liquid levels in both zones are the same 
during operation.  The SBR is operated on an 8-hour cycle, with a 6-hour aerated 
period in the main zone followed by 2 hours of settle/decant.  Effluent is decanted 
over the last half hour of the cycle (from 7:30 to 8:00).  The SBR main zone is 
aerated throughout the mixed period (fill-and-react period). 

Influent feed is continuous with an average diurnal flow of 100 ML/d.  The flow to 
the SBR continues during the settle-decant phase. 

There is a 100 ML/d recycle from the SBR underflow to the always-mixed prezone 
(using the SBR underflow stream).  This only operates during the 6-hour SBR mixed 
period, and is switched off when the SBR is in the settle-decant phase. 

Sludge wastage to control SRT is via the side stream of a timed node splitter in the 
recycle stream.  Wastage occurs at a rate of 48 ML/d over the last hour of the react 
period (5:00 to 6:00) immediately before settle/decant.  Note that the wastage flow 
rate from the side stream of the splitter must be less than the recycle rate when 
wasting occurs. 

Characteristics of the system: 
   
SBR main zone (full) 
volume 

100 ML  

Prezone (full) volume 20 ML  



 

 BioWin Tutorials and Examples  •  533 

Depth 4.5 m  

Width 150 m  

Minimum decant level 50%  

Cycle: Fill-and-react 6 hours  

 Settle  1.5 hours  

 Decant  0.5 hours  

DO (fill and react 
phases) 

2 mg/L  

DO (prezone) 0 mg/L  

Initial liquid hold-up 50%  

Influent flow (average) 100 ML/d  

SBR underflow (for 
recycle): 

100 ML/d from 0:00 to 6:00 
hours in each cycle. 

 

Waste flow 48 ML/d from 5:00 to 6:00 
hours in each cycle. 

 

 
The BioWin configuration 
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Example Album Chart 

Single Continuous Flow SBR with Unaerated 
Settling Prezone 
The BioWin file for this system can be found in the Data/Examples/SBR 
directory under the name:  Continuous Flow SBR (settle pre-zone).BWC. 

This single-SBR system is operated with continuous flow but intermittent decant.  
The SBR has an unaerated mix/settle prezone.  The prezone is hydraulically 
connected to the main SBR zone; that is, the liquid levels in both zones are the same 
during operation.  The SBR is operated on an 8-hour cycle, with a 6-hour aerated 
period in the main zone followed by 2 hours of settle/decant.  Note that the prezone 
is in settling mode whenever the main SBR zone is in settling/decant mode.  Effluent 
is decanted over the last half hour of the cycle (from 7:30 to 8:00).  The SBR main 
zone is aerated throughout the mixed period (fill-and-react period). 

Influent feed is continuous with an average diurnal flow of 100 ML/d.  The flow to 
the SBR continues during the settle-decant phase. 

There is a 100 ML/d recycle from the SBR underflow to the mix/settle prezone 
(using the SBR underflow stream).  This only operates during the 6-hour SBR mixed 
period, and is switched off when the SBR is in the settle-decant phase. 

Sludge wastage to control SRT is via the side stream of a timed node splitter in the 
recycle stream.  Wastage occurs at a rate of 48 ML/d over the last hour of the react 
period (5:00 to 6:00) immediately before settle/decant.  Note that the wastage flow 
rate from the side stream of the splitter must be less than the recycle rate when 
wasting occurs. 

Characteristics of the system: 
   
SBR main zone (full) 
volume 

100 ML  

Prezone (full) volume 20 ML  
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Depth 4.5 m  

Width 150 m  

Minimum decant level 50%  

Cycle: Fill-and-react 6 hours  

 Settle  1.5 hours  

 Decant  0.5 hours  

DO (fill and react 
phases) 

2 mg/L  

DO (prezone) 0 mg/L  

Initial liquid hold-up 50%  

Influent flow (average) 100 ML/d  

SBR underflow (for 
recycle): 

100 ML/d from 0:00 to 6:00 
hours in each cycle. 

 

Waste flow 48 ML/d from 5:00 to 6:00 
hours in each cycle. 

 

 
The BioWin configuration 



 

536  •  BioWin Tutorials and Examples  

 
Example Album Chart 

Single Continuous Flow SBR with Two Unaerated 
Mixed Prezones 
The BioWin file for this system can be found in the Data/Examples/SBR 
directory under the name:  Continuous Flow SBR (two mixed pre-
zones).BWC. 

This single-SBR system is operated with continuous flow but intermittent decant.  
The SBR has two unaerated always-mixed prezones.  The prezones are hydraulically 
connected to the main SBR zone; that is, the liquid levels in all three zones are the 
same during operation.  The SBR is operated on an 8-hour cycle, with a 6-hour 
aerated period in the main zone followed by 2 hours of settle/decant.  Effluent is 
decanted over the last half hour of the cycle (from 7:30 to 8:00).  The SBR main 
zone is aerated throughout the mixed period (fill-and-react period). 

Influent feed is continuous with an average diurnal flow of 100 ML/d.  The flow to 
the SBR continues during the settle-decant phase. 

There is a 100 ML/d recycle from the SBR underflow to the first always-mixed 
prezone (using the SBR underflow stream).  This only operates during the 6-hour 
SBR mixed period, and is switched off when the SBR is in the settle-decant phase. 

Sludge wastage to control SRT is via the side stream of a timed node splitter in the 
recycle stream.  Wastage occurs at a rate of 48 ML/d over the last hour of the react 
period (5:00 to 6:00) immediately before settle/decant.  Note that the wastage flow 
rate from the side stream of the splitter must be less than the recycle rate when 
wasting occurs. 

Characteristics of the system: 
   
SBR main zone (full) 
volume 

100 ML  

Prezone 1 (full) 
volume 

10 ML  
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Prezone 2 (full) 
volume 

10 ML  

Depth 4.5 m  

Width 150 m  

Minimum decant level 50%  

Cycle: Fill-and-react 6 hours  

 Settle  1.5 hours  

 Decant  0.5 hours  

DO (fill and react 
phases) 

2 mg/L  

DO (prezones) 0 mg/L  

Initial liquid hold-up 50%  

Influent flow (average) 100 ML/d  

SBR underflow (for 
recycle): 

100 ML/d from 0:00 to 6:00 
hours in each cycle. 

 

Waste flow 48 ML/d from 5:00 to 6:00 
hours in each cycle. 

 

 
The BioWin configuration 
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Example Album Chart 

Single Continuous Flow SBR with Two Unaerated 
Settling Prezones 
The BioWin file for this system can be found in the Data/Examples/SBR 
directory under the name:  Continuous Flow SBR (two settle pre-
zones).BWC. 

This single-SBR system is operated with continuous flow but intermittent decant.  
The SBR has two unaerated mix/settle prezones.  The prezones are hydraulically 
connected to the main SBR zone; that is, the liquid levels in all three zones are the 
same during operation.  The SBR is operated on an 8-hour cycle, with a 6-hour 
aerated period in the main zone followed by 2 hours of settle/decant.  Note that the 
prezones are in settling mode whenever the main SBR zone is in settling/decant 
mode.  Effluent is decanted over the last half hour of the cycle (from 7:30 to 8:00).  
The SBR main zone is aerated throughout the mixed period (fill-and-react period). 

Influent feed is continuous with an average diurnal flow of 100 ML/d.  The flow to 
the SBR continues during the settle-decant phase. 

There is a 100 ML/d recycle from the SBR underflow to the first mix/settle prezone 
(using the SBR underflow stream).  This only operates during the 6-hour SBR mixed 
period, and is switched off when the SBR is in the settle-decant phase. 

Sludge wastage to control SRT is via the side stream of a timed node splitter in the 
recycle stream.  Wastage occurs at a rate of 48 ML/d over the last hour of the react 
period (5:00 to 6:00) immediately before settle/decant.  Note that the wastage flow 
rate from the side stream of the splitter must be less than the recycle rate when 
wasting occurs. 

Characteristics of the system: 
   
SBR main zone (full) 
volume 

100 ML  

Prezone 1 (full) 10 ML  
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volume 

Prezone 2 (full) 
volume 

10 ML  

Depth 4.5 m  

Width 150 m  

Minimum decant level 50%  

Cycle: Fill-and-react 6 hours  

 Settle  1.5 hours  

 Decant  0.5 hours  

DO (fill and react 
phases) 

2 mg/L  

DO (prezones) 0 mg/L  

Initial liquid hold-up 50%  

Influent flow (average) 100 ML/d  

SBR underflow (for 
recycle): 

100 ML/d from 0:00 to 6:00 
hours in each cycle. 

 

Waste flow 48 ML/d from 5:00 to 6:00 
hours in each cycle. 

 

 
The BioWin configuration 
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Example Album Chart 

Two-in-Parallel SBRs with Unaerated Mixed 
Prezone  
The BioWin file for this system can be found in the Data/Examples/SBR 
directory under the name:  Two SBRs (mixed pre-zone).BWC. 

This system has two SBRs in parallel, each with an unaerated always-mixed prezone.  
The prezone is hydraulically connected to the main SBR zone; that is, the liquid level 
in both zones are the same during operation.  The SBRs are each operated on an 8-
hour cycle, with a 6-hour aerated period in the main zone followed by 2 hours of 
settle/decant.  Effluent is decanted over the last half hour of the cycle (from 7:30 to 
8:00).  Each SBR is aerated throughout the mixed period (fill-and-react period). 

Influent feed is continuous with an average diurnal flow of 100 ML/d.  The flow is 
routed to each train for 4 hour intervals (and flow is displaced to the downstream 
SBR).  Flow does not pass to the SBRs during the settle-decant phase.  The cycle for 
the second SBR has an offset of 4 hours. 

There is a 100 ML/d recycle from the SBR underflow to the always-mixed prezone 
(using the SBR underflow stream).  This only operates during the 6-hour SBR mixed 
period, and is switched off when the SBR is in the settle-decant phase. 

Sludge wastage to control SRT is via the side stream of a timed node splitter in the 
recycle stream.  Wastage occurs at a rate of 24 ML/d over the last hour of the react 
period (5:00 to 6:00) immediately before settle/decant.  Note that the wastage flow 
rate from the side stream of the splitter must be less than the recycle rate when 
wasting occurs. 

Characteristics of the system: 
   
SBR main zone (full) 
volume 

50 ML  

Prezone (full) volume 10 ML  
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Depth 4.5 m  

Width 105 m  

Minimum decant level 50%  

Cycle: Fill  4 hours  

 React  2 hours  

 Settle  1.5 hours  

 Decant  0.5 hours  

DO (fill and react 
phases) 

2 mg/L  

DO (prezone) 0 mg/L  

Initial liquid hold-up 50%  

Influent flow (average) 100 ML/d  

SBR underflow (for 
recycle): 

100 ML/d from 0:00 to 6:00 
hours in each cycle. 

 

Waste flow 24 ML/d from 5:00 to 6:00 
hours in each cycle. 

 

Offsets: Unit Offset (hours) 

 SBR #1 Zero 

 SBR #2 4 

 
The BioWin configuration 
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Example Album Chart 

Two-in-Parallel SBRs with Unaerated Settling 
Prezone  
The BioWin file for this system can be found in the Data/Examples/SBR 
directory under the name:  Two SBRs (settle pre-zone).BWC. 

This system has two SBRs in parallel, each with an unaerated mix/settle prezone.  
The prezone is hydraulically connected to the main SBR zone; that is, the liquid level 
in both zones are the same during operation.  The SBRs are each operated on an 8-
hour cycle, with a 6-hour aerated period in the main zone followed by 2 hours of 
settle/decant.  Note that the prezone is in settling mode whenever the main SBR zone 
is in settling/decant mode.  Effluent is decanted over the last half hour of the cycle 
(from 7:30 to 8:00).  Each SBR is aerated throughout the mixed period (fill-and-react 
period). 

Influent feed is continuous with an average diurnal flow of 100 ML/d.  The flow is 
routed to each train for 4 hour intervals (and flow is displaced to the downstream 
SBR).  Flow does not pass to the SBRs during the settle-decant phase.  The cycle for 
the second SBR has an offset of 4 hours. 

There is a 100 ML/d recycle from the SBR underflow to the mix/settle prezone 
(using the SBR underflow stream).  This only operates during the 6-hour SBR mixed 
period, and is switched off when the SBR is in the settle-decant phase. 

Sludge wastage to control SRT is via the side stream of a timed node splitter in the 
recycle stream.  Wastage occurs at a rate of 24 ML/d over the last hour of the react 
period (5:00 to 6:00) immediately before settle/decant.  Note that the wastage flow 
rate from the side stream of the splitter must be less than the recycle rate when 
wasting occurs. 

Characteristics of the system: 
   
SBR main zone (full) 
volume 

50 ML  
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Prezone (full) volume 10 ML  

Depth 4.5 m  

Width 105 m  

Minimum decant level 50%  

Cycle: Fill  4 hours  

 React  2 hours  

 Settle  1.5 hours  

 Decant  0.5 hours  

DO (fill and react 
phases) 

2 mg/L  

DO (prezone) 0 mg/L  

Initial liquid hold-up 50%  

Influent flow (average) 100 ML/d  

SBR underflow (for 
recycle): 

100 ML/d from 0:00 to 6:00 
hours in each cycle. 

 

Waste flow 24 ML/d from 5:00 to 6:00 
hours in each cycle. 

 

Offsets: Unit Offset (hours) 

 SBR #1 Zero 

 SBR #2 4 
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The BioWin configuration 

 
Example Album Chart 

Two-in-Parallel SBRs with Two Unaerated Mixed 
Prezones  
The BioWin file for this system can be found in the Data/Examples/SBR 
directory under the name:  Two SBRs (two mixed pre-zones).BWC. 
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This system has two SBRs in parallel, each with two unaerated always-mixed 
prezones.  The prezones are hydraulically connected to one another and to the main 
SBR zone; that is, the liquid levels in all three zones are the same during operation.  
The SBRs are each operated on an 8-hour cycle, with a 6-hour aerated period in the 
main zone followed by 2 hours of settle/decant.  Effluent is decanted over the last 
half hour of the cycle (from 7:30 to 8:00).  Each SBR is aerated throughout the 
mixed period (fill-and-react period). 

Influent feed is continuous with an average diurnal flow of 100 ML/d.  The flow is 
routed to each train for 4 hour intervals (and flow is displaced to the downstream 
SBR).  Flow does not pass to the SBRs during the settle-decant phase.  The cycle for 
the second SBR has an offset of 4 hours. 

There is a 100 ML/d recycle from the SBR underflow to the first always-mixed 
prezone (using the SBR underflow stream).  This only operates during the 6-hour 
SBR mixed period, and is switched off when the SBR is in the settle-decant phase. 

Sludge wastage to control SRT is via the side stream of a timed node splitter in the 
recycle stream.  Wastage occurs at a rate of 24 ML/d over the last hour of the react 
period (5:00 to 6:00) immediately before settle/decant.  Note that the wastage flow 
rate from the side stream of the splitter must be less than the recycle rate when 
wasting occurs. 

Characteristics of the system: 
   
SBR main zone (full) 
volume 

50 ML  

Prezone 1 (full) 
volume 

5 ML  

Prezone 2 (full) 
volume 

5 ML  

Depth 4.5 m  

Width 105 m  

Minimum decant level 50%  

Cycle: Fill  4 hours  

 React  2 hours  

 Settle  1.5 hours  

 Decant  0.5 hours  

DO (fill and react 
phases) 

2 mg/L  

DO (prezones) 0 mg/L  

Initial liquid hold-up 50%  

Influent flow (average) 100 ML/d  

SBR underflow (for 
recycle): 

100 ML/d from 0:00 to 6:00 
hours in each cycle. 

 

Waste flow 24 ML/d from 5:00 to 6:00 
hours in each cycle. 

 



 

546  •  BioWin Tutorials and Examples  

Offsets: Unit Offset (hours) 

 SBR #1 Zero 

 SBR #2 4 

 
The BioWin configuration 

 
Example Album Chart 
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Two-in-Parallel SBRs with Two Unaerated Settling 
Prezones  
The BioWin file for this system can be found in the Data/Examples/SBR 
directory under the name:  Two SBRs (two settle pre-zones).BWC. 

This system has two SBRs in parallel, each with two unaerated mix/settle prezones.  
The prezones are hydraulically connected to one another and to the main SBR zone; 
that is, the liquid levels in all three zones are the same during operation.  The SBRs 
are each operated on an 8-hour cycle, with a 6-hour aerated period in the main zone 
followed by 2 hours of settle/decant.  Note that the prezones are both in settling 
mode whenever the main SBR zone is in settling/decant mode.  Effluent is decanted 
over the last half hour of the cycle (from 7:30 to 8:00).  Each SBR is aerated 
throughout the mixed period (fill-and-react period). 

Influent feed is continuous with an average diurnal flow of 100 ML/d.  The flow is 
routed to each train for 4 hour intervals (and flow is displaced to the downstream 
SBR).  Flow does not pass to the SBRs during the settle-decant phase.  The cycle for 
the second SBR has an offset of 4 hours. 

There is a 100 ML/d recycle from the SBR underflow to the first mix/settle prezone 
(using the SBR underflow stream).  This only operates during the 6-hour SBR mixed 
period, and is switched off when the SBR is in the settle-decant phase. 

Sludge wastage to control SRT is via the side stream of a timed node splitter in the 
recycle stream.  Wastage occurs at a rate of 24 ML/d over the last hour of the react 
period (5:00 to 6:00) immediately before settle/decant.  Note that the wastage flow 
rate from the side stream of the splitter must be less than the recycle rate when 
wasting occurs. 

Characteristics of the system: 
   
SBR main zone (full) 
volume 

50 ML  

Prezone 1 (full) 
volume 

5 ML  

Prezone 2 (full) 
volume 

5 ML  

Depth 4.5 m  

Width 105 m  

Minimum decant level 50%  

Cycle: Fill  4 hours  

 React  2 hours  

 Settle  1.5 hours  

 Decant  0.5 hours  

DO (fill and react 
phases) 

2 mg/L  

DO (prezone) 0 mg/L  

Initial liquid hold-up 50%  
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Influent flow (average) 100 ML/d  

SBR underflow (for 
recycle): 

100 ML/d from 0:00 to 6:00 
hours in each cycle. 

 

Waste flow 24 ML/d from 5:00 to 6:00 
hours in each cycle. 

 

Offsets: Unit Offset (hours) 

 SBR #1 Zero 

 SBR #2 4 

 
The BioWin configuration 
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Example Album Chart 

Two-in-Parallel SBRs with Unaerated Constant-
volume Prezone 
The BioWin file for this system can be found in the Data/Examples/SBR 
directory under the name:  Two SBRs (constant volume pre-zone).BWC. 

This system has two SBRs in parallel, each preceded by a constant-volume unaerated 
reactor.  Note that the volume of each unaerated reactor is fixed; that is, it is not 
hydraulically connected to the SBR and its volume does not change during operation.  
The SBRs are each operated on an 8-hour cycle, with a 6-hour aerated period 
followed by 2 hours of settle/decant.  Effluent is decanted over the last half hour of 
the cycle (from 7:30 to 8:00).  Each SBR is aerated throughout the mixed period 
(fill-and-react period). 

Influent feed is continuous with an average diurnal flow of 100 ML/d.  The flow is 
routed to each train for 4 hour intervals (and flow is displaced to the downstream 
SBR).  Flow does not pass to the SBRs during the settle-decant phase.  The cycle for 
the second SBR has an offset of 4 hours. 

There is a 100 ML/d recycle from the SBR underflow to the unaerated reactor (using 
the SBR underflow stream).  This only operates during the 6-hour SBR mixed 
period, and is switched off when the SBR is in the settle-decant phase. 

Sludge wastage to control SRT is via the side stream of a timed node splitter in the 
recycle stream.  Wastage occurs at a rate of 24 ML/d over the last hour of the react 
period (5:00 to 6:00) immediately before settle/decant.  Note that the wastage flow 
rate from the side stream of the splitter must be less than the recycle rate when 
wasting occurs. 

Characteristics of the system: 
   
SBR (full) volume 50 ML  

Anaerobic volume 
(constant) 

10 ML  
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Depth 4.5 m  

Width 105 m  

Minimum decant level 50%  

Cycle: Fill  4 hours  

 React  2 hours  

 Settle  1.5 hours  

 Decant  0.5 hours  

DO (fill and react 
phases) 

2 mg/L  

DO (anaerobic) 0 mg/L  

Initial liquid hold-up 50%  

Influent flow (average) 100 ML/d  

SBR underflow (for 
recycle): 

100 ML/d from 0:00 to 6:00 
hours in each cycle. 

 

Waste flow 24 ML/d from 5:00 to 6:00 
hours in each cycle. 

 

Offsets: Unit Offset (hours) 

 SBR #1 Zero 

 SBR #2 4 

 
The BioWin configuration 
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Example Album Chart 

Two-in-Parallel Single-Tank SBRs with 
Unaerated/Aerated Periods 
The BioWin file for this system can be found in the Data/Examples/SBR 
directory under the name:  Two SBRs (single tank BNR).bwc. 

This system has two SBRs in parallel.  The SBRs are each operated on an 8-hour 
cycle, with a 6-hour fill-and-react period followed by 2 hours of settle/decant.  
Effluent is decanted over the last half hour of the cycle (from 7:30 to 8:00).  Each 
SBR is unaerated for the first 2 hours of the mixed period (fill-and-react period) and 
then is aerated until the start of settle-decant. 

Influent feed is continuous with an average diurnal flow of 100 ML/d.  The flow is 
routed to each train for 4 hour intervals.  Flow does not pass to the SBRs during the 
settle-decant phase.  The cycle for the second SBR has an offset of 4 hours. 

Sludge wastage to control SRT is via the SBR underflow.  Wastage occurs at a rate 
of 24 ML/d over the last hour of the react period (5:00 to 6:00) immediately before 
settle/decant. 

Characteristics of the system: 
   
SBR (full) volume 50 ML  

Depth 4.5 m  

Width 105 m  

Minimum decant level 50%  

Cycle: Fill  4 hours  

 React  2 hours  

 Settle  1.5 hours  

 Decant  0.5 hours  
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DO (0:00 to 2:00 
hours) 

0 mg/L  

DO (2:00 to 6:00 
hours) 

2 mg/L  

Initial liquid hold-up 50%  

Influent flow (average) 100 ML/d  

SBR underflow (for 
waste): 

24 ML/d from 5:00 to 6:00 
hours in each cycle. 

 

Offsets: Unit Offset (hours) 

 SBR #1 Zero 

 SBR #2 4 

 
The BioWin configuration 
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Example Album Chart 

Wastewater Characterization Fill-and-Draw SBR 
The BioWin file for this system can be found in the Data/Examples/SBR 
directory under the name:  Fill-and-Draw SBR.BWC. 

This example illustrates the operation of a fill-and-draw SBR used in a wastewater 
characterization exercise. 

The SBR is operated according to the sequence outlined in the table and chart below.  
The volume of the SBR is 10.5 m3 but only reaches a liquid hold-up of 10.1 m3. 

   

VP = 10.1 m3 Temperature = 20°C 

VWW = 8 m3 θX = 10.1/0.67 = 15 days 

qW = 0.67 m3/d  

Wastewater Parameter Value 
STI 465 mg COD/L 

NTI 34.1 mg N/L 

ISS 33 mg/L 

fBS 0.11 

fUS 0.05 

fUP 0.13 

fNA 0.48 

   

   

PHASE TIME REACTOR 
CONDITION 

ACTION 
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FILL T = 0  
(Instantaneous fill) 

Vww of wastewater is added to 
reactor containing Vp - Vww of mixed 
liquor, i.e. reactor is filled to the 
maximum volume (Vp). 

REACT T = 0 – 23:15 hours Reactor volume constant (Vp). 
Mixing and aeration on. 

WASTE T = 23:05 – 23:15 
hours 
(Instantaneous 
wastage) 

Mixing and aeration on. 
Withdraw volume of mixed liquor for 
wastage (qw). 

qw = Vp/θx. 

SETTLE T = 23:15 - 24 hours No mixing or aeration. 
Allow sludge to settle. 

DRAW T = 23:40 – 24 hours 
(Instantaneous draw of 
treated water) 

No mixing or aeration.   
Decant off supernatant (effluent) 
volume of (Vww - qw), leaving a 
volume of Vp – Vww in the reactor. 
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The BioWin configuration 

Configuring the system 
1. Set up the SBR configuration shown above.  Double-click the SBR 

element, and on the Dimensions tab, enter the appropriate volumes.  
Set the minimum decant level as 20 %.  Click OK to close the dialog 
box. 

2. Influent flow rate:  We wish to fill the reactor with the 8 m3 of influent 
over 5 minutes, starting at time zero.  The influent flow rate should be 
at least: 

d/m2304
day1
hr24

hr1
min60

min5
m8 3

3

=⋅⋅  

3. Double-click the influent element and specify the Influent type as 
variable.  Click the Edit data button to enter the influent 
characteristics and flows. 

4. Ensure that the Cycle time is set to 1 day. 

5. Below the cells for entering data, specify the Time in grid as minutes.  
Ensure that the Flow units are in m3/d. 

• The first row begins at time zero minutes.  Enter the flow 
calculated above in the flow column.  Enter the appropriate data in 
the various columns (i.e. COD, TKN, etc.). 

• After five minutes, we want to turn the flow off.  In the second row 
under the time column, type 5.  In the second row flow column, 
type 0.  You don't have to worry about entering wastewater data 
for the second row, so click Close to exit. 

6. Cycle operation:  Double-click the SBR element, and on the 
Operation tab, specify the cycle time as 24 hours (zero offset).  Mix 
the SBR from the start of the cycle until 23h15m.  Specify a constant 
DO setpoint of 3 mg/L.  Decant to the minimum level from 23h40m 
until the end of the cycle. 

7. Wastage:  We wish to waste a mixed liquor volume of 0.67 m3 over the 
last 10 minutes of the mixed period, i.e. from 23h05m to 23h15m (1385 
– 1395 minutes).  The wastage rate over this period should be: 

d/m48.96
day1

hr24
hr1
min60

min10
m67.0 3

3

=⋅⋅  

• On the SBR Underflow tab, select Flow pattern and click the 
Pattern… button.  Ensure that the Time in grid is in minutes.  In 
the first row of the itinerary, at time zero, enter 0 for the 
underflow.  In the second row, enter 1385 for the time and 96.48 
for the flow.  In the third row, enter 1395 for the time and 0 for the 
flow. 

Setting up charts and running simulations 
1. Open the album and set up charts for SBR TSS and Volume. 

2. In the main window Project|Database sub-menu, select Data 
interval… and set the monitoring interval to 5 minutes.  Often things 
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are changing rapidly in SBR systems, so a short data interval is 
necessary to track the changes. 

3. Begin a dynamic simulation and simulate for 20 days, starting from 
seed concentrations. 

4. Switch to the album and view the SBR volume response carefully.  
This often provides a check that you have set up the system correctly. 

5. View the TSS response.  As the simulation moves towards 20 days the 
TSS should "settle down" in the SBR.  Likely, after 20 days you will 
not yet have attained a steady state.  If so, continue the simulation until 
40 or 50 days as appropriate. 

6. If the system has yet to stabilize by 50 days, stop the simulation and 
restart the simulation for 20 days from Current conditions.  This 
sets the simulation clock back to zero, but you will be viewing the 
system response from Day 50 on. 

7. Continue simulation until you are satisfied that the system has attained 
a quasi "steady state".  Then Cancel the simulation and save the 
BioWin file. 

8. In the album, set up charts for VSS, ammonia and nitrate 
concentrations, and OUR.  Re-start the simulation for a 24 hour period, 
and examine the responses. 

9. Use the main window Project|Parameters|Kinetic… menu 
command to open the Model Parameter Editor and change the 
nitrification rate.  View the response. 

 
Example Album Chart 

Note:  If you change a parameter such as fUP which affects sludge production you 
must simulate for an extended period to allow the system to stabilize. 

Simultaneous Nitrification Denitrification (SND) 
1. Change the scale of the nitrate plot from 24 to 48 hours.  Simulate the 

response for 24 hours. 



 

 BioWin Tutorials and Examples  •  557 

2. Use the main window Project|Parameters|Kinetic… menu 
command to open the Model Parameter Editor and change the 
Heterotroph and SND DO switching function values from the defaults 
of 0.05 mg/L to 0.5 mg/L.  Continue the simulation until 48 hours, and 
view the difference in nitrate response. 

Using Builder Models 
BioWin 3.0 contains the international models ASM1, ASM2d and ASM3 from the 
International Water Association (IWA), in addition to the general BioWin activated 
sludge – digestion model (ASDM),. This chapter provides guidance on how to use 
these models. For model details, parameter values and calibration please consult the 
appropriate IWA Task Group Report. BioWin also contains Add-On models, such as 
CaCO3 precipitation, aerobic growth of methylotrophs and slow degradation of 
“inert” components in very long SRT systems. After the ASM section, you will find 
information about these Add-On models.  

General considerations for using ASMs 
The ASM series have fewer state variables than the ASDM model in BioWin. The 
following steps must be taken in order to build a configuration using these additional 
models: 

   

1. Build the configuration as usual. Take into account that the ASM series 
is meant to simulate only BOD removal, nitrification, denitrification, 
and in the case of ASM2d, biological phosphorus removal and 
precipitation. Do not use elements and processes that cannot be 
simulated with these models (digester, chemical addition, etc.) 

2. In Model Options (accessible by clicking the button at the bottom 
left-hand side of the BioWin main simulator window, or from 
Project|Current Project Options), disable the BioWin integrated 
model, pH calculation and pH limitation. Select the Use project 
Model Builder model option (see below). DO modeling is optional. 
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3. In the Project|Model Builder dialog box, click the Select from 
model library button and select the model you wish to use. Select OK 
for Overwrite Current model dialog box….  

4. In all influent elements, make sure that there are no influent 
concentrations (fractions) that cannot be handled by the specific model. 
The following table aids with identifying the various state variables that 
have different names in the three ASM models and their BioWin 
equivalent. 

   

Description Units BioWin 
2.1 

ASM1 ASM2d ASM3 

Non-polyP 
heterotrophs mgCOD/L ZBH XBH XH XBH 

Readily 
biodegradable 
complex COD 
(non-VFA) 

mgCOD/L SBSC SS SF SS 

Acetate mgCOD/L SBSA  SA  

Soluble inert 
COD mgCOD/L SUS SI SI SI 

Slowly 
biodegradable  
particulate 

mgCOD/L XSP XS XS XS 
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COD 

Particulate 
inert COD mgCOD/L XI XI XI XI 

Endogenous 
products mgCOD/L ZE XP   

Dissolved 
oxygen mgO2/L DO SO SO2 SO 

Autotrophs mgCOD/L ZBA XBA XAUT XBA 

Particulate 
biodegradable 
organic 
nitrogen 

mgN/L XON XND fraction fraction 

Soluble 
biodegradable 
organic 
nitrogen 

mgN/L NOS SND fraction fraction 

Ammonia N mgN/L NH3-N SNH SNH4 SNH 

Nitrate N mgN/L NO3-N SNO SNO3 SNO 

PolyP 
heterotrophs mgCOD/L ZBP  XPAO  

Stored PHA mgCOD/L SPHB  XPHA XSTO 

PO4 (including 
Metal 
complexed) 

mgP/L PO4-P  SPO4  

Releasable 
stored polyP mgP/L PP-LO  XPP  

Hydroxy-
dicalcium-
phosphate 

mgTSS/L XHDP  XMEOH  

Hydroxy-
apatite mgTSS/L XHAP  XMEP  

   

5. Uncheck pH calculations since the ASM series does not provide 
information about pH. 

6. Model parameter values for Builder models are changed in 
the Project | Model Builder window. 

7. This procedure replaces the BioWin model for all the 
elements in the configuration. It is possible to use any of 
the models in specific tanks, if the Model Builder unit is 
placed in a configuration. This way it is possible to 
compare different models within the same configuration. 

8. Editing the model. On clicking on an entry field in the 
Model Builder window, an equation editor window 
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appears. The window will contain the equation or value if a 
stoichiometry matrix element was clicked. The equation or 
element value can be changed in this window. The “set 
position” tab at the bottom of the equation editor window 
puts the cursor to the desired position but any part of an 
equation can be changed by moving to the desired position 
using the arrows or mouse, and editing. When finished 
editing, click on the “Close and update” tab at the bottom 
right hand side of the equation editor window. Or simply 
close the window if no changes are desired. The 
Stoichiometry window displays the Petersen matrix for the 
model. It apparently can be edited directly- I did not 
explore this. Also the matrix can be edited by clicking on a 
value. 

9. To change a rate constant value: Double click on the rate 
constant. The rate constant name will appear in the Name 
box in the middle of the pane and its value will appear in 
the value box below the Name box. Type the new value for 
the parameter. Then click on the “Add to rate constants” 
tab to register the change. 

10. If a stoichiometric constant is to be changed, double click 
on it and follow the procedure in the previous point except 
click on the “Add to stoichiometric constants” tab to 
register the change. 

11. The verify equations tab should be pressed after all changes 
to ensure that the model is verified by BioWin. 

12. Be aware that combined variables (TSS, BOD, etc.) are 
always calculated according to the BioWin method. It is 
recommended that only the model state variables are used 
to evaluate the model’s performance. The Explorer (CTRL-
E) is a useful tool to verify that only those state variables 
have values that are included in the model selected. Any 
influent concentration, state variable that is not handled by 
the model, will be treated as inert and will flow through the 
plant model unchanged.  

   

Using Add-on Models 
The BioWin Model Builder provides the user with the ability to build a new model 
using existing state variables (including the four user defined variables), or 
enhance/modify/add to the BioWin ASDM model. Three Add-on models are 
provided with BioWin 3.0 as examples: CaCO3 precipitation, Inert conversion and 
Aerobic Methylotroph growth.  
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87. Build the configuration as usual.  

88. In Model Options (accessible by clicking the button at the bottom left-
hand side of the BioWin main simulator window, or from 
Project|Current Project Options), select the Use project Model Builder 
model option. Leave the BioWin Integrated AS/AD model option and 
any other options selected that are desired. 

89. In the Project|Model Builder dialog box, click the Select from model 
library button and select the model add-on you wish to use. Select OK 
for Overwrite Current model dialog box….  

• CaCO3 precip – Add-on to model calcium carbonate precipitation 

• Aerobic MEOH – Add-on to model aerobic growth of 
methylotrophs on methanol 

• Inert conversion – Adding the possibility of slow conversion of 
inerts to biodegradable or soluble components  

Calcium carbonate precipitation Add-on 
This add-on inserts a CaCO3 precipitation/dissolution kinetic reaction into the 
BioWin model. UD4 is precipitated calcium carbonate in mgTSS/L units. The model 
is based on equilibrium water chemistry involving Ca2+ and CO32- ions and a 
measured solubility constant for CaCO3. The extension can be used to estimate if the 
conditions are conducive to calcium carbonate precipitation.  

Aerobic growth of methylotrophs Add-on 
In the default AS/AD model methylotrophs grow exclusively under anoxic 
conditions. This leads to high anoxic zone volume requirements. There is indication 
in the literature that aerobic growth of methylotrophs is possible or even likely. This 
Add-on allows aerobic growth of methylotrophs, in lack of information with the 
same yield and growth rates as under anoxic conditions. The constants can be 
modified.  

Inert conversion Add-on 
This model add-on will extend the validity of the BioWin model for very long sludge 
ages or systems where alternating environmental conditions cause “inert” 
components to degrade. Under conditions where cumulative SRT is longer than 30 
days, organic components that are normally considered inert (Xi and Ze) may start 
degrading. This add-on will introduce a first order reaction rate to inert organics (Xi) 
and endogenous residue (Ze) and convert them to slowly degradable particulates 
(Xsp).  

The rate constant Kdxi (default value of 0.0) can be found and edited (Enter constant 
name and value) in the Model Builder Editor (Project|Model Builder).   

The overall result from using this add-on is that higher VSS destruction rates can be 
achieved in agreement with measurements in aerobic digesters and other high sludge 
age systems. 

Influent Inorganic Suspended Solids may dissolve under long SRT conditions. This 
is also added as a third rate, generating cations and anions. At the moment there are 
no reliable measurements to estimate a rate constant, so the default value of zero is 
provided.     
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Other Systems 
For more example systems, please visit the EnviroSim web site 
(www.envirosim.com) where you can find many documented examples available for 
download. 
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Process Model Formulation 

Process Models Used in Biowin 
BioWin uses a general Activated Sludge/Anaerobic Digestion (ASDM) model which 
is referred to as the BioWin General Model.  The BioWin General Model has fifty 
state variables and sixty process expressions.  These expressions are used to describe 
the biological processes occurring  in activated sludge and anaerobic digestion 
systems, several chemical precipitation reactions, and the gas-liquid mass transfer 
behavior for six gases.  The model formulation requires pH determination which is 
described in the pH chapter.  This complete model approach frees the user from 
having to map one model’s output to another model’s input which significantly 
reduces the complexity of building full plant models, particularly those incorporating 
many different process units. 

This chapter provides an overview of the model and the parameters included in the 
model..  In some cases you will be referred to other documents that describe sections 
of the model in greater detail.  In this section the model parameters (kinetic, 
stoichiometric, settling and chemical constants) are listed in full with a brief 
description of the model process. Parameters that are of special importance (those 
having a direct impact on a measurable wastewater, effluent or plant characteristics) 
are highlighted in the tables.    

The default BioWin General Model can be augmented with additional processes or 
entirely replaced by other models which have been defined in the Model Builder. 
BioWin includes a library of Model Builder models. Details on the Model Builder 
are in the Model Builder section of the "Common Dialog" chapter. 

 For a list of the models included with BioWin, please see the Model Library for 
the Model Builder section later in this chapter. 

Activated Sludge Model 
The activated sludge model in BioWin contains the following functional categories. 

Growth and Decay of Ordinary Heterotrophic Oganisms 
Growth and Decay of Methylotrophs 
Hydrolysis, Adsorption, Ammonification and Assimilative denitrification 
Growth and Decay of Ammonia Oxidizing Biomass  
Growth and Decay of Nitrite Oxidizing Biomass  
Growth and Decay of ANaerobic AMMonia OXidizers (ANAMMOX) 
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Growth and Decay of Phosphorus Accumulating Organisms 

Note:  In an activated sludge system, under anaerobic conditions, the anaerobic 
processes described in the Anaerobic digestion section may also have a 
significant impact. 

These modules are described in detail below. 

Growth and Decay of Ordinary Heterotrophic 
Oganisms 
Number of Processes: 11 

Engineering Objective: BOD removal, denitrification  

Implementation: permanent, always active in the BioWin model 

Module Description: 
This group of processes describes the growth of ordinary heterotrophic organisms 
under aerobic and anoxic conditions and the decay of these organisms under all 
conditions. The activated sludge model allows for direct ordinary heterotrophic 
aerobic growth on acetate, propionate, readily biodegradeable complex substrate and 
methanol.  The organisms will tend to use the substrates in the order specified.  
Under anoxic conditions, the ordinary heterotrophs can use only three of the 
substrates, namely; acetate, propionate and readily biodegradable complex substrate.  
In the BioWin model, anoxic use of methanol is restricted to a specialized group of 
organisms (see anoxic methylotrophs). 

The base rate expression for each of the 10 growth processes is the product of the 
maximum specific growth rate, the heterotrophic biomass concentration and a 
Monod expression for one of the substrates.  This base rate is modified to account for 
environmental conditions (dissolved oxygen, nitrate and nitrite), nutrient limitations 
(ammonia, phosphate, other cations and anions), pH inhibition and substrate 
preference weighting.  BioWin uses ammonia as a nitrogen source for cell synthesis 
with all of the substrates under aerobic, anoxic and anaerobic conditions.  At low 
ammonia concentrations BioWin allows for assimilative ammonia production from 
either nitrate or nitrite in order to satisfy synthesis demands. 

Under anoxic conditions the base rate is also multiplied by the anoxic growth factor 
and preferentially uses nitrite as the electron acceptor.  The decay process has a rate 
that varies according to the electron acceptor environment. 

Model parameters affecting the performance of this module are listed below: 

   

Kinetic Parameters  
Menu Location: Project|Parameters|Kinetic|OHOs 

   

Name Default 
Value 

Unit Explanation 

Max. spec. growth 
rate 

3.2 d-1 Determines the maximum specific 
growth rate of heterotrophs. 
Substrate and nutrient limitations 
will decrease the growth rate. This 
parameter is sensitive only in very 
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high loaded plants (short SRT), and 
determines maximum BOD removal 
capacity.    

Substrate half sat. 5.0 mgCOD/L This parameter impacts the residual 
soluble substrate concentration in the 
effluent. The value is usually low in 
normal municipal plants.  

Anoxic growth 
factor 

0.5 - This parameter decreases the 
maximum specific growth rate under 
anoxic conditions.  Substrate and 
nutrient limitations may further 
reduce the growth rate.  

Aerobic decay 0.62 d-1 Decay rate constant under aerobic 
conditions.  This parameter impacts 
the endogenous respiration rate and 
VSS destruction during aerobic 
stabilization. 

Anoxic/anaerobic 
decay 

0.3 d-1 Decay rate constant in the absence of 
oxygen. 

   

Stoichiometric Parameters 
Menu Location: Project|Parameters|Stoichiometric| OHOs 
   

Name Default Value Unit Explanation 

Yield (Aerobic) 0.666 mgCOD/mgCOD Amount of biomass COD 
produced using one unit of 
readily biodegradable complex 
substrate COD. The remaining 
COD is oxidized. This 
parameter is very stable in 
municipal plants and seldom 
needs adjustment. In case there 
is a mismatch between 
measured and simulated sludge 
production and OUR, try 
adjusting the influent fup 
(unbiodegradable particulate 
COD fraction) parameter or 
check wastage and SRT.   

N in Biomass 0.07 mgN/mgCOD N content of heterotrophs. This 
parameter impacts the nitrogen 
available for nitrification and 
therefore oxygen demand. 

N in Inert 0.07 mgN/mgCOD N content of endogenous 
residue from heterotrophic 
decay.  

P in Biomass 0.022 mgP/mgCOD P content of heterotrophs. This 
parameter influence the P 
removal in non bio-P systems, 
and the P content of the sludge.  

P in Inert 0.022 mgP/mgCOD P content of endogenous residue 
from heterotrophic decay. 
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Endogenous 
Residue 

0.08 - Fraction of biomass that 
becomes inert upon decay.   

COD:VSS Ratio 1.42 mgCOD/mgVSS Conversion factor between 
biomass as measured in COD 
and its VSS content. This value 
is relatively stable for biomass. 

Yield (anoxic) 0.54 mgCOD/mgCOD Biomass yield on readily 
biodegradable complex 
substrate COD under anoxic 
conditions. 

Yield propionic 
(aerobic) 

0.5 mgCOD/mgCOD Biomass yield on propionic acid 
COD under aerobic conditions. 

Yield propionic 
(anoxic) 

0.41 mgCOD/mgCOD Biomass yield on propionic acid 
COD under anoxic conditions. 

Yield acetic 
(aerobic) 

0.4 mgCOD/mgCOD Biomass yield on acetic acid 
COD under aerobic conditions. 

Yield acetic 
(anoxic) 

0.32 mgCOD/mgCOD Biomass yield on acetic acid 
COD under anoxic conditions. 

Yield methanol 
(Aerobic)  

0.5 mgCOD/mgCOD Biomass yield on methanol 
COD under anoxic conditions. 

   

pH Inhibition 
Menu Location: Project|Parameters|Kinetic|pH 
   

Name Default Value Unit Explanation 

Heterotrophs 
low pH limit 

4.0 pH units At a pH equal to this value the growth rate 
of ordinary heterotrophic biomass will be 
reduced by 50%. Heterotrophs exhibit 
tolerance for pH changes – hence the wide 
pH range.   

Heterotrophs 
high pH 
limit 

10.0 pH units At a pH equal to this value the growth rate 
of ordinary heterotrophic biomass will be 
reduced by 50%. 

   

Switching Functions 
Menu Location: Project|Parameters|Kinetic|Switches 
   

Name Default Value Unit Explanation 

Heterotrophic 
DO half sat. 

0.05 mgO2/L This constant is used to switch off aerobic 
OHO activity under low DO conditions 
(that is in anaerobic and anoxic reactors). 

Aerobic denit. 
DO half sat. 

0.05 mgO2/L This constant is used to turn anoxic OHO 
growth processes on under low dissolved 
oxygen conditions. [Simultaneous or 
aerobic denitrification switch.]  

Anoxic NO3 0.1 mgN/L This constant is used to switch off anoxic 
growth processes using nitrate under low 
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half sat. nitrate conditions. 

Anoxic NO2 
half sat. 

0.1 mgN/L This constant is used to switch off anoxic 
growth processes using nitrite under low 
nitrite conditions. 

NH3 nutrient 
half sat. 

0.001 mgN/L This constant is used to slow all biomass 
growth processes at low ammonia-N 
concentrations (N nutrient limiting 
conditions – see assimilative 
denitrification). 

P nutrient half 
sat. 

0.001 mgP/L This constant is used to slow the growth 
of biomass when there is no phosphorus 
available as nutrient. 

Synthesis 
anion/cation half 
sat. 

0.01 
meq/L Half saturation concentration for anions 

and cations. 

   

Growth and Decay of Methylotrophs 
Number of Processes: 3 

Engineering Objective: denitrification using methanol  

Implementation: permanent, always active in the BioWin model 

Module Description: 
These processes describe the growth and decay of specialized heterotrophs using 
methanol under anoxic conditions. In the BioWin model anoxic methylotrophs can 
only growth under anoxic conditions using methanol as substrate and either nitrate or 
nitrite as an electron acceptor. They require a minimum “anoxic SRT ”  (similar in 
concept to the minimum aerobic SRT required by autotrophs) to maintain themselves 
in the activated sludge system without washing out. Nitrogen source for cell 
synthesis of these microorganisms is ammonia. The base rate expression for this 
growth process is the product of the maximum specific growth rate, the anoxic 
methylotrophs concentration and a Monod expression for methanol.  This base rate is 
modified to account for environmental conditions (dissolved oxygen, nitrate and 
nitrite), nutrient limitations (ammonia, phosphate, other cations and anions), pH 
inhibition and electron acceptor preference weighting.  BioWin preferentially uses 
nitrite as an electron acceptor. 

 

The single decay rate varies between an aerobic value and an unaerated value 
depending oxygen concentration. 

Model parameters are listed in: 

   

Kinetic Parameters 
Menu Location: Project|Parameters|Kinetic|Methylotrophs 
   

Name Default Value Unit Explanation 

Max. spec. growth 
rate of methanol 

1.3 d-1 Determines the maximum specific 
growth rate of methylotrophs. 
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utilizers Substrate and nutrient limitations 
will decrease the growth rate. This 
parameter will determine the 
necessary anoxic SRT to maintain 
a viable denitrifying population on 
methanol.  

Methanol half sat. 0.5 mgCOD/L This parameter impacts the 
residual methanol concentration       
bleeding out of the anoxic tank. 
The value is usually very low in 
normal municipal plants (once the 
suitable population has been 
established). 

Aerobic decay rate 
of methanol utilizers 

0.04 d-1 Decay rate constant under aerobic 
conditions.  This parameter 
impacts the minimum anoxic SRT. 

Anoxic/anaerobic 
decay rate of 
methanol utilizers 

0.03 d-1 Decay rate constant in the absence 
of oxygen.  This parameter 
impacts the minimum anoxic SRT. 

   

Stoichiometric Parameters 
Menu Location: Project|Parameters|Stoichiometric|Methylotrophs 
   

Name Default Value Unit Explanation 

Yield (anoxic) 0.4 mgCOD/mgCOD Anoxic methylotrophic biomass 
yield on readily methanol COD 
under anoxic conditions.  This 
parameter has significant impact 
on the methanol dosage  required 
to denitrify 1 mgN nitrate (3.2mg 
methanol/mgNO3-N by default) 

N in Biomass 0.07 mgN/ mgCOD N content of anoxic 
methylotrophs. 

N in Inert 0.07 mgN/ mgCOD N content of endogenous residue 
from anoxic methylotrophic 
organism decay.  

P in Biomass 0.022 mgP/ mgCOD P content of anoxic 
methylotrophs. 

P in Inert 0.022 mgP/ mgCOD P content of endogenous residue 
from anoxic methylotrophic 
organism decay. 

Endogenous 
Residue 

0.08 - Fraction of biomass that becomes 
inert upon decay.   

COD:VSS 
Ratio 

1.42 mgCOD/mgVSS Conversion factor between 
biomass as measured in COD and 
its VSS content. This value is 
relatively stable for biomass. 

   

pH Inhibition 
Menu Location: Project|Parameters|Kinetic|pH 
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Name Default Value Unit Explanation 

√Methanol tilizers 
low pH limit 

4.0 pH units At a pH equal to this value the growth 
rate of methylotrophs will be reduced 
by 50%. 

Methanol utilizers 
high pH limit 

10.0 pH units At a pH equal to this value the growth 
rate of methylotrophs will be reduced 
by 50%. 

   

Switching Functions 
Menu Location: Project|Parameters|Kinetic|Switches 

   

Name Default Value Unit Explanation 

Heterotrophic 
DO half sat. 

0.05 mgO2/L This constant is used to switch off aerobic 
activity under low DO conditions (that is 
in anaerobic and anoxic reactors).  

Anoxic NO3 
half sat. 

0.1 mgN/L This constant is used to switch off anoxic 
growth processes using nitrate under low 
nitrate conditions. 

Anoxic NO2 
half sat. 

0.1 mgN/L This constant is used to switch off anoxic 
growth processes using nitrite under low 
nitrite conditions. 

NH3 nutrient 
half sat. 

0.001 mgN/L This constant is used to slow all biomass 
growth processes at low ammonia-N 
concentrations (N nutrient limiting 
conditions – see assimilative 
denitrification). 

P nutrient half 
sat. 

0.001 mgP/L This constant is used to slow the growth 
of biomass when there is no phosphorus 
available as nutrient. 

Synthesis 
anion/cation half 
sat. 

0.01 
meq/L Half saturation concentration for anions 

and cations. 

 

Hydrolysis, Adsorption, Ammonification and 
Assimilative denitrification 
Number of Processes: 7 

Engineering Objective: Conversion of organic, nitrogen and phosphorus 
fractions 

Implementation: permanent, always active in the BioWin model 

Module Description: 
These processes are discussed here separately from the organism groupings because 
they involve more that one organism type (in general both the ordinary heterotrophic 
organisms and the phosphate accumulating organisms. 
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Hydrolysis of biodegradable particulate organic substrate to readily 
biodegradable complex substrate: The base rate is the product of the hydrolysis 
rate constant, the sum of the ordinary heterotrophs and the phosphate accumulating 
organisms, and a Monod expression for ratio of particulate substrate to organism 
COD.  There is an efficiency factor applied for anoxic conditions and another for 
anaerobic conditions.   

Hydrolysis of biodegradable particulate organic nitrogen and phosphorus: The 
hydrolysis of biodegradable particulate nitrogen (phosphorus) is assumed to proceed 
at the same rate as the biodegradable particulate organics but is adjusted by the ratio 
of biodegradable particulate organic nitrogen (phosphorus) to biodegradable 
particulate organic. 

Adsorption or flocculation of colloidal organic material to particulate organic 
material (occurring spontaneously as opposed to chemically facilitated 
flocculation with metal (ferric or alum) addition:  The rate is the product of the 
adsorption rate constant, the colloidal substrate concentration and the sum of the 
ordinary heterotrophs and the phosphate accumulating organism concentrations.  The 
rate is decreased as the ratio of particulate substrate to organism COD approaches the 
maximum adsorption ratio constant. 

Ammonification of soluble organic nitrogen to ammonia:  The rate is the product 
of the ammonification rate constant, the soluble organic nitrogen concentration and 
the sum of the ordinary heterotrophs and the phosphate accumulating organism 
concentrations.   

Assimilative denitrification of nitrate or nitrite to ammonia for synthesis:  
BioWin allows for the production of ammonia for synthesis by any organisms under 
low ammonia conditions (as ammonia becomes limiting for growth).  The 
assimilative process will use nitrite if it is available otherwise it will use nitrate.  The 
base rate is the product of the assimilation rate constant and the total organism COD.   
This base rate is modified to account for environmental conditions (off with 
ammonia, and selecting between nitrate and nitrite).   

Model parameters are listed in: 

   

Kinetic Parameters 
Menu Location: Project|Parameters|Kinetic|OHOs 

   

Name Default Value Unit Explanation 

Hydrolysis rate (AS) 2.1 d-1 Rate constant for hydrolysis of slowly 
degradable organics into readily 
degradable substrate; for activated sludge.

Hydrolysis half sat. 
(AS) 

0.06 -  Monod half saturation constant for the 
regulation of hydrolysis rate, expressed in 
terms of particulate substrate to 
heterotrophic biomass ratio; for activated 
sludge. 

Anoxic hydrolysis 
factor 

0.28 -  Rate reduction factor for hydrolysis under 
anoxic conditions. 

Anaerobic 
hydrolysis factor 

0.5 -  Rate reduction factor for hydrolysis under 
anaerobic conditions in activated sludge. 

Adsorption rate of 
colloids 

0.8 d-1 Conversion rate of colloidal material to 
particulate. 
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Ammonification rate 0.04 d-1 Conversion rate of soluble organic 
nitrogen compounds to ammonia 

Assimilative 
nitrate/nitrite 
reduction rate 

0.5 d-1 Conversion rate of nitrite and/or nitrate to 
ammonia under ammonia limited 
conditions 

Hydrolysis rate (AD) 0.1 d-1 Hydrolysis rate of particulate organics in 
anaerobic digesters 

Hydrolysis half sat. 
(AD) 

0.15 -  Monod half saturation constant for 
regulation of hydrolysis rate in anaerobic 
digesters, expressed in terms of 
particulate substrate to heterotrophic 
biomass ratio 

   

Stoichiometric Parameters  
None 

   

Switching Functions 
Menu Location: Project|Parameters|Kinetic|Switches 

 
Name Default Value Unit Explanation 

Heterotrophic 
DO half sat. 

0.05 mgO2/L This constant is used to switch off aerobic 
activity under low DO conditions (that is 
in anaerobic and anoxic reactors).  

Anoxic NO3 
half sat. 

0.1 mgN/L This constant is used to switch off anoxic 
growth processes using nitrate under low 
nitrate conditions. 

Anoxic NO2 
half sat. 

0.1 mgN/L This constant is used to switch off anoxic 
growth processes using nitrite under low 
nitrite conditions. 

NH3 nutrient 
half sat. 

0.001 mgN/L This constant is used to slow all biomass 
growth processes at low ammonia-N 
concentrations (N nutrient limiting 
conditions – see assimilative 
denitrification). 

   

Growth and Decay of Ammonia Oxidizing Biomass 
(AOB) 
Number of Processes: 2 

Engineering Objective: Nitrification 

Implementation: permanent, always active in the BioWin model 

Module Description: 
This biomass grows by oxidizing ammonia to nitrite and using the energy to 
synthesis organic material from inorganic carbon (fixing CO2). Nitrogen source for 
cell synthesis is ammonia.  
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The base rate expression for the growth process is the product of the maximum 
specific growth rate, the ammonia oxidizing biomass concentration and a Monod 
expression for ammonia.  This base rate is modified to account for environmental 
conditions (off at low dissolved oxygen and inhibited by nitrous acid), nutrient 
limitations (phosphate, inorganic carbon, other cations and anions) and pH 
inhibition.   

The decay rate varies between an aerobic value and an anoxic/anaerobic value 
depending dissolved oxygen concentrations. 

Model parameters are listed in: 

   

Kinetic Parameters 
Menu Location: Project|Parameters|Kinetic|AOB 
   

Name Default Value Unit Explanation 

Max. spec. 
growth rate 

0.9 d-1 Determines the maximum specific 
growth rate of ammonia oxidizing 
biomass. Substrate and nutrient 
limitations will decrease the growth rate. 
This parameter has a direct impact on the 
nitrification capacity.    

Substrate (NH4) 
half sat. 

0.7 mgN/L This parameter impacts the residual 
ammonia concentration in the effluent. 
The value is usually low in normal 
municipal plants.  

Aerobic decay 
rate 

0.17 d-1 Decay rate constant under aerobic 
conditions for ammonia oxidizing 
biomass. 

Anoxic/anaerobic 
decay rate 

0.08 d-1 Decay rate constant under non-aerobic 
conditions for ammonia oxidizing 
biomass. 

KiHNO2 0.005 mmol/L Nitrous acid inhibition concentration. 

   

Stoichiometric Parameters 
Menu Location: Project|Parameters|Stoichiometric|AOB 

   

Name Default Value Unit Explanation 

Yield 0.15 mgCOD/mgN AOB COD produced by oxidizing 1 
mg of ammonia. 

N in biomass 0.07 mgN/ mgCOD N content of AOB. 

N in inert 0.07 mgN/ mgCOD N content of endogenous residue 
from AOB decay.  

P in biomass 0.022 mgP/ mgCOD P content of AOB.  

P in inert 0.022 mgP/ mgCOD P content of endogenous residue 
from AOB decay. 

Fraction to 
endogenous 

0.08 - Fraction of biomass that becomes 
inert upon decay.   
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residue 

COD:VSS 
ratio 

1.42 mgCOD/mgVSS Conversion factor between biomass 
as measured in COD and its VSS 
content. This value is relatively 
stable for biomass. 

   

pH Inhibition 
Menu Location: Project|Parameters|Kinetic|pH 
   

Name Default Value Unit Explanation 

Autotrophs 
low pH limit 

5.5 pH units At a pH equal to this value the growth 
rate of AOB, NOB and ANAMMOX will 
be reduced by 50%. 

Autotrophs 
high pH limit 

9.5 pH units At a pH equal to this value the growth 
rate of AOB, NOB and ANAMMOX will 
be reduced by 50%. 

   

Switching Functions 
Menu Location: Project|Parameters|Kinetic|Switches 
   

Name Default Value Unit Explanation 

Ammonia 
oxidizer DO 
half sat. 

0.25 
mgO2/L This parameter is used to switch off 

ammonia oxidation by AOB under low 
DO conditions. 

P nutrient half 
sat. 0.001 

mgP/L This parameter is used to switch off the 
growth of biomass when there is no 
phosphorus available as nutrient. 

Autotroph 
CO2 half sat. 0.1 

mmol/L This parameter is used to switch off the 
growth of AOB, NOB and ANAMMOX 
when there is little inorganic carbon 
available. 

Synthesis 
anion/cation 
half sat. 

0.01 
meq/L Half saturation concentration for anions 

and cations. 

   

Growth and Decay of Nitrite Oxidizing Biomass 
(NOB) 
Number of Processes: 2 

Engineering Objective: Nitrification 

Implementation: permanent, always active in the BioWin model 

Module Description: 
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This biomass grows by oxidizing nitrite to nitrate and using the energy to synthesis 
organic material from inorganic carbon (fixing CO2). Nitrogen source for cell 
synthesis is ammonia.  

The base rate expression for the growth process is the product of the maximum 
specific growth rate, the nitrite oxidizing biomass concentration and a Monod 
expression for nitrite.  This base rate is modified to account for environmental 
conditions (off at low dissolved oxygen and inhibited by ammonia), nutrient 
limitations (ammonia, phosphate, inorganic carbon, other cations and anions) and pH 
inhibition.   

The decay rate varies between an aerobic value and an anoxic/anaerobic value 
depending dissolved oxygen concentrations. 

Model parameters are listed in: 

Kinetic Parameters 
Menu Location: Project|Parameters|Kinetic|NOB 
   

Name Default Value Unit Explanation 

Max. spec. 
growth rate 

0.7 d-1 Determines the maximum specific 
growth rate of nitrite oxidizing biomass. 
Substrate, nutrient limitations and 
environmental conditions will decrease 
the growth rate. This parameter has a 
direct impact on the nitrification 
capacity.    

Substrate (NO2) 
half sat. 

0.05 mgN/L This parameter impacts the residual 
nitrite concentration in the effluent. The 
value is usually very low in normal 
municipal plants.  

Aerobic decay 
rate 

0.17 d-1 Decay rate constant under aerobic 
conditions for nitrite oxidizing biomass. 

Anoxic/anaerobic 
decay rate 

0.08 d-1 Decay rate constant under non-aerobic 
conditions for nitrite oxidizing biomass. 

KiHNH3 0.075 mmol/L NH3 inhibition concentration. 

   

Stoichiometric Parameters 
Menu Location: Project|Parameters|Stoichiometric|NOB 

   

Name Default Value Unit Explanation 

Yield 0.09 mgCOD/mgN NOB COD produced by oxidizing 1 
mg of nitrite N. 

N in biomass 0.07 mgN/ mgCOD N content of NOB. 

N in inert 0.07 mgN/ mgCOD N content of endogenous residue 
from NOB decay.  

P in biomass 0.022 mgP/ mgCOD P content of NOB.  

P in inert 0.022 mgP/ mgCOD P content of endogenous residue 
from NOB decay. 
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Fraction to 
endogenous 
residue 

0.08 - Fraction of biomass that becomes 
inert upon decay.   

COD:VSS 
ratio 

1.42 mgCOD/mgVSS Conversion factor between biomass 
as measured in COD and its VSS 
content. This value is relatively 
stable for biomass. 

   

pH Inhibition 
Menu Location: Project|Parameters|Kinetic|pH 
   

Name Default Value Unit Explanation 

Autotrophs 
low pH limit 

5.5 pH units At a pH equal to this value the growth 
rate of AOB, NOB and ANAMMOX will 
be reduced by 50%. 

Autotrophs 
high pH limit 

9.5 pH units At a pH equal to this value the growth 
rate of AOB, NOB and ANAMMOX will 
be reduced by 50%. 

   

Switching Functions 
Menu Location: Project|Parameters|Kinetic|Switches 
   

Name Default 
Value 

Unit Explanation 

Nitrite oxidizer DO 
half sat. 0.5 

mgO2/L This parameter is used to switch off 
nitrite oxidation by NOB under low DO 
conditions. 

P nutrient half sat. 0.001 
mgP/L This parameter is used to switch off the 

growth of biomass when there is no 
phosphorus available as nutrient. 

Autotroph CO2 half 
sat. 0.1 

mmol/L This parameter is used to switch off the 
growth of AOB, NOB and ANAMMOX 
when there is little inorganic carbon 
available. 

Synthesis 
anion/cation half sat. 0.01 meq/L Half saturation concentration for anions 

and cations. 

   

Growth and Decay of ANaerobic AMMonia 
OXidizers (ANAMMOX) 
Number of Processes: 2 

Engineering Objective: Nitrification 

Implementation: permanent, always active in the BioWin model 

Module Description: 
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This biomass grows by converting ammonia and nitrite to nitrogen gas and nitrate.  
The energy from this process is used to synthesis organic material from inorganic 
carbon (fixing CO2). Nitrogen source for cell synthesis is ammonia.  

The base rate expression for the growth process is the product of the maximum 
specific growth rate, the ANAMMOX concentration, a Monod expression for 
ammonia and a Monod expression for nitrite.  This base rate is modified to account 
for environmental conditions (switched off under aerobic conditions and inhibited by 
nitrite), nutrient limitations (phosphate, inorganic carbon, other cations and anions) 
and pH inhibition.   

The decay rate varies between an aerobic and anoxic/anaerobic value depending 
dissolved oxygen concentrations.  Nitrite toxicity is modeled by increasing the decay 
rate by the product of the nitrite sensitivity constant and the nitrite concentration. 

Model parameters are listed in: 

Kinetic Parameters 
Menu Location: Project|Parameters|Kinetic|ANAMMOX 
   

Name Default 
Value 

Unit Explanation 

Max. spec. growth 
rate 

0.1 d-1 Determines the maximum specific 
growth rate of ANAMMOX. Substrate, 
nutrient limitations and environmental 
conditions will decrease the growth 
rate. This parameter has a direct impact 
on the nitrification capacity.    

Substrate (NH4) 
half sat. 

2.0 mgN/L Ammonia half saturation concentration 
for ANNAMOX.  

Substrate (NO2) 
half sat. 

1.0 mgN/L Nitrite half saturation concentration for 
ANNAMOX.  

Aerobic decay rate 0.019 d-1 Decay rate constant under aerobic 
conditions for ANNAMOX. 

Anoxic/anaerobic 
decay rate 

0.0095 d-1 Decay rate constant under non-aerobic 
conditions for ANNAMOX. 

Ki Nitrite 1000.0 mgN/L Nitrite inhibition concentration. 

Nitrite sensitivity 
constant 

0.016 L/ (d mgN) Nitrite toxicity constant. 

   

Stoichiometric Parameters 
Menu Location: Project|Parameters|Stoichiometric|ANNAMOX 

   

Name Default Value Unit Explanation 

Yield 0.114 mgCOD/mgN ANNAMOX produced by oxidizing 
1 mg of ammonia. 

Nitrate 
production 

2.28 mgN/mgCOD Nitrate production yield 

N in biomass 0.07 mgN/ mgCOD N content of ANNAMOX. 
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N in inert 0.07 mgN/ mgCOD N content of endogenous residue 
from ANNAMOX decay.  

P in biomass 0.022 mgP/ mgCOD P content of ANNAMOX.  

P in inert 0.022 mgP/ mgCOD P content of endogenous residue 
from ANNAMOX decay. 

Fraction to 
endogenous 
residue 

0.08 - Fraction of biomass that becomes 
inert upon decay.   

COD:VSS 
ratio 

1.42 mgCOD/mgVSS Conversion factor between biomass 
as measured in COD and its VSS 
content. This value is relatively 
stable for biomass. 

   

pH Inhibition 
Menu Location: Project|Parameters|Kinetic|pH 
   

Name Default Value Unit Explanation 

Autotrophs 
low pH limit 

5.5 pH units At a pH equal to this value the growth 
rate of AOB, NOB and ANAMMOX will 
be reduced by 50%. 

Autotrophs 
high pH limit 

9.5 pH units At a pH equal to this value the growth 
rate of AOB, NOB and ANAMMOX will 
be reduced by 50%. 

   

Switching Functions 
Menu Location: Project|Parameters|Kinetic|Switches 
   

Name Default Value Unit Explanation 

Anaerobic 
ammonia 
oxidizer DO 
half sat. 

0.01 

mgO2/L This parameter is used to switch on 
anaerobic ammonia oxidation by 
ANNAMOX under very low DO 
conditions. 

P nutrient half 
sat. 0.001 

mgP/L This parameter is used to switch off the 
growth of biomass when there is no 
phosphorus available as nutrient. 

Autotroph 
CO2 half sat. 0.1 

mmol/L This parameter is used to switch off the 
growth of AOB, NOB and ANAMMOX 
when there is little inorganic carbon 
available. 

Synthesis 
anion/cation 
half sat. 

0.01 
meq/L Half saturation concentration for anions 

and cations. 
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Growth and Decay of Phosphorus Accumulating 
Organisms 
Number of Processes: 15 

Engineering Objective: Biological phosphorus removal 

Implementation: permanent, always active in the BioWin model 

Module Description: 
This group of processes describes the growth and decay of polyphosphate 
accumulating organisms (PAOs) under all conditions. This includes descriptions of 
aerobic and anoxic growth, VFA sequestration and polyphosphate lysis. 

There are two maximum specific growth rates for PAOs under aerobic conditions.  
The lower growth rate constant is used under P limited conditions and has a different 
stoichiometry (no polyphosphate storage).  There are also two anoxic growth 
processes, one uses nitrate and the other nitrite.  Growth processes under phosphate 
rich conditions result in uptake of phosphate, and balancing calcium magnesium ions 
and other cations. A lack of these ions will stop the growth processes by appropriate 
Monod switches.  For all of these growth processes, the base growth rate is the 
product of the maximum specific rate constant, the PAO concentration and a Monod 
on the ratio PAO COD to PHA COD. This base rate is modified to account for 
environmental conditions (dissolved oxygen, nitrate and nitrite), nutrient limitations 
(ammonia, anions, cations, for polyphosphate storage magnesium, and calcium are 
also required) and pH inhibition.  BioWin uses ammonia as a nitrogen source for cell 
synthesis under aerobic, anoxic and anaerobic conditions.  At low ammonia 
concentrations BioWin allows for assimilative ammonia production from either 
nitrate or nitrite in order to satisfy synthesis demands. 

Under anoxic conditions the base rate is also multiplied by an anoxic growth factor 
and preferentially uses nitrite as the electron acceptor.   

The PAOs use energy store in polyphosphate to sequester acids and store them as 
store PHA.  In the BioWin model the PAOs can use both acetate and propionate for 
this process.  The base sequestration rate is the product of the sequestration rate 
constant, the PAO concentration and a Monod on the appropriate substrate (acetate 
or propionate) The base rate is switched on the availability of the stored 
polyphosphate (ratio of low molecular weight polyphosphate to PAO COD). 

There are two decay processes (aerobic and anoxic/anaerobic). Associated with each 
decay process is a lysis process for PHA, low and high molecular weight 
polyphosphate.  The lysis rates are directly proportional to the decay rate itself. 

There is one Poly-P cleavage process for anaerobic maintenance that releases 
phosphate if no oxygen is present.  This process is proportional to the 
anoxic/anaerobic decay rate. 

Model parameters are listed in: 

   

Kinetic Parameters 
Menu Location: Project|Parameters|Kinetic|PAOs 
   

Name Default Value Unit Explanation 

Max. spec. 
growth rate 

0.95 d-1 Determines the maximum attainable growth 
rate of phosphorus accumulating heterotrophic 
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organisms if no substrate, DO or P limitation 
occurs. 

Max. spec. 
growth rate, 
P-limited 

0.42 d-1 Determines the maximum attainable growth 
rate of phosphorus accumulating heterotrophic 
organisms under phosphorus limiting 
conditions. 

Substrate 
half sat. 

0.1 mgCO
D/L 

Half saturation constant for PHA, used as 
substrate by phosphorus accumulating 
organisms. 

Substrate 
half sat., P-
limited 

0.05 mgCO
D/L 

Half saturation constant for PHA, under 
phosphorus limiting conditions. 

Magnesium 
half sat. 

0.1 mgMg/
L 

Half saturation constant for Magnesium storage 
during poly-P synthesis. 

Cation half 
sat. 

0.1 meq/L Half saturation constant for cation (primarily 
potassium) storage during poly-P synthesis. 

Aerobic 
decay rate 

0.1 d-1 Decay rate constant in aerobic conditions. 

Anaerobic 
decay rate 

0.04 d-1 Decay rate constant when there is no oxygen 
available. 

Sequestration 
rate 

6.0 d-1 Rate constant for VFA sequestration to form 
PHA (stored substrate). 

Anoxic 
growth factor

0.33 - Together with the max. spec. growth rate, 
determines the maximum attainable growth rate 
if nitrate is available only as electron acceptor 
(and no substrate limitation occurs). 

   

Stoichiometric Parameters 
Menu Location: Project|Parameters|Stoichiometric|PAOs 
   

Name Default Value Unit Explanation 

Yield 
(aerobic) 

0.639 mgCOD/mgCOD Amount of biomass produced 
using one unit of substrate under 
aerobic conditions. The rest of the 
substrate will be oxidized. 

Yield 
(anoxic) 

0.52 mgCOD/mgCOD Amount of biomass produced 
using one unit of substrate under 
anoxic conditions. 

Aerobic 
P/PHA uptake

0.95 mgP/mgCOD Amount of P stored per unit of 
PHA oxidized in aerobic 
conditions 

Anoxic 
P/PHA uptake

0.35 mgP/mgCOD Amount of P stored per unit of 
PHA in anoxic conditions. 

Yield of PHA 
on 
sequestration 

0.889 mgCOD/mgCOD Amount of PHA stored when 1 mg 
of acetate or propionate is 
sequestered.   

N in biomass 0.07 mgN/ mgCOD N content of phosphorus 
accumulating organisms. Has a 
significant effect on nitrogen 
availability for nitrification and 
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therefore oxygen demand. 

N in part. 
inert 

0.07 mgN/ mgCOD N content of endogenous residue 
originating from phosphorus 
accumulating organism decay.  

N in sol. inert 0.07 mgN/ mgCOD N content of soluble inert organics 
originating from phosphorus 
accumulating organism decay. 

P in biomass 0.022 mgP/ mgCOD P content of phosphorus 
accumulating organisms, not 
including P stored in the form of 
Poly-P 

P in part. inert 0.022 mgP/ mgCOD P content of endogenous residue 
originating from phosphorus 
accumulating organism decay. 

Fraction to 
inert part. 

0.25 - Fraction of biomass that becomes 
particulate inert upon decay.   

Fraction to 
inert sol. 

0.2 - Fraction of biomass that becomes 
soluble inert upon decay. 

P/Ac release 
ratio 

0.49 mgP/mgCOD Amount of P released for one mg 
of acetate sequestered in the form 
of PHA 

COD:VSS 
Ratio 

1.42 mgCOD/mgVSS Conversion factor between 
biomass as measured in COD and 
its VSS content. This value is 
relatively stable for biomass. 

Yield of low 
PP 

0.94 mgP/mgP Fraction of P stored in releasable 
poly-P form (rest of P is stored in 
high molecular weight, non-
releasable poly-P) 

   

pH Inhibition 
Menu Location: Project|Parameters|Kinetic|pH 
   

Name Default Value Unit Explanation 

PolyP 
heterotrophs 
low pH limit 

4.0 pH units At a pH equal to this value the growth rate 
of poly phosphate accumulating biomass 
will be reduced by 50%. 

Poly P 
heterotrophs 
high pH 
limit 

10.0 pH units At a pH equal to this value the growth rate 
of poly phosphate accumulating biomass 
will be reduced by 50%. 

   

Switching Functions 
Menu Location: Project|Parameters|Kinetic|Switches 
   

Name Default Value Unit Explanation 

Heterotrophic 0.05 mgO2/L This constant is used to switch off aerobic 
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DO half sat. OHO activity under low DO conditions 
(that is in anaerobic and anoxic reactors). 

Anoxic NO3 
half sat. 

0.1 mgN/L This constant is used to switch off anoxic 
growth processes using nitrate under low 
nitrate conditions. 

Anoxic NO2 
half sat. 

0.1 mgN/L This constant is used to switch off anoxic 
growth processes using nitrite under low 
nitrite conditions. 

NH3 nutrient 
half sat. 

0.001 mgN/L This constant is used to slow all biomass 
growth processes at low ammonia-N 
concentrations (N nutrient limiting 
conditions – see assimilative 
denitrification). 

PolyP half 
sat. 

0.01 mgP/L This constant stops sequestration of VFA 
and P release as the ratio of low 
molecular weight polyphosphate to PAO 
COD falls.  

VFA 
sequestration 
half sat. 

5.0 mgCOD/L This is the half saturation concentration 
for the sequestration of acetate and 
propionate. 

P uptake half 
sat. 

0.15 mgP/L This constant stops growth with poly 
phosphate storeage at low soluble 
phosphate concentrations.  This constant 
will have an impact on the effluent 
soluble P concentration in a bio-P system. 

P nutrient half 
sat. 

0.001 mgP/L This constant is used to slow the growth 
of biomass when there is no phosphorus 
available as nutrient. 

Synthesis 
anion/cation 
half sat. 

0.01 
meq/L Half saturation concentration for anions 

and cations. 

   

Other Parameters 
Menu Location: Project|Parameters|Other|General 
   

Name Default 
Value 

Unit Explanation 

Mg to P mole 
ratio in 
polyphosphate 

0.3 molMg/molP Mole ratio of magnesium to phosphorus in 
stored polyphosphate. This magnesium is 
released when polyphosphate is used 
(together with the phosphate release). 

Cation to P mole 
ratio in 
polyphosphate  

0.3 meq/mmolP Mole ratio of other cations (primarily 
potassium) to phosphorus in stored 
polyphosphate. These cations are released 
when polyphosphate is used (together with 
the phosphate release). 

Ca to P mole 
ratio in 
polyphosphate  

0.05 molCa/molP Mole ratio of calcium to phosphorus in 
stored polyphosphate. This calcium is 
released when polyphosphate is used 
(together with the phosphate release). 
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Anaerobic Digestion Model 
The anaerobic digestion model in BioWin contains the following functional 
categories, modules 

Heterotrophic Growth through Fermentation 
Growth and Decay of Propionic Acetogens 
Growth and Decay of Methanogens 

These modules are described in detail below. 

Heterotrophic Growth through Fermentation 
Number of Processes: 2 

Engineering Objective: VFA generation (fermenters, digesters)  

Implementation: permanent, always active in the BioWin model 

Module Description: 
There are two pathways for the fermentation of readily biodegradable (complex) 
substrate to acetate, propionate, carbon dioxide and hydrogen.  The dominant 
pathway is governed by the dissolved hydrogen concentration. These processes are 
mediated by the ordinary heterotrophic organisms.  

The base rate expression for the fermentation growth process is the product of the 
maximum specific growth rate constant, the heterotrophic biomass concentration and 
a Monod expression for the readily biodegradable (complex) substrate.  This base 
rate is modified to account for nutrient limitations (ammonia, phosphate, other 
cations and anions) and pH inhibition.  In activated sludge vessels there is an 
anaerobic growth factor applied.  BioWin uses ammonia as a nitrogen source for cell 
synthesis.  

Model parameters affecting the performance of this module are listed below. 

Kinetic Parameters 
Menu Location: Project|Parameters|Kinetic|OHOs 
   

Name Default 
Value 

Unit Explanation 

Anoxic/anaerobic 
decay* 

0.3 d-1 Decay rate constant when there is no 
oxygen available. 

Fermentation rate 3.2 d-1 Maximum specific growth rate of 
heterotrophs under anaerobic 
conditions.  

Fermentation half 
sat. 

5.0 mgCOD/L Half saturation of complex substrate 
under anaerobic conditions 

Anaerobic growth 
factor (AS) 

0.125 - Growth rate reduction under 
anaerobic conditions in activated 
sludge 
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Stoichiometric Parameters 
Menu Location: Project|Parameters|Stoichiometric|OHOs 
   

Name Default Value Unit Explanation 

Yield 
(fermentation 
low H2) 

0.1 mgCOD/mgCOD Amount of biomass produced 
on one unit of complex 
substrate fermented, under low 
H2 concentration. 

Yield 
(fermentation 
high H2) 

0.1 mgCOD/mgCOD Amount of biomass produced 
on one unit of complex 
substrate fermented, under high 
H2 concentration. 

H2 yield 
(fermentation 
low H2) 

0.35 mgCOD/mgCOD Amount of hydrogen produced 
on one unit of complex 
substrate fermented, under low 
H2 concentration. 

H2 yield 
(fermentation 
high H2) 

0.0 mgCOD/mgCOD Amount of hydrogen produced 
on one unit of complex 
substrate fermented, under high 
H2 concentration. 

Propionate yield 
(fermentation 
low H2) 

0.0 mgCOD/mgCOD Amount of propionate produced 
on one unit of complex 
substrate fermented, under low 
H2 concentration. 

Propionate yield 
(fermentation 
high H2) 

0.7 mgCOD/mgCOD Amount of propionate produced 
on one unit of complex 
substrate fermented, under high 
H2 concentration. 

CO2 yield 
(fermentation 
low H2) 

0.7 mmolCO2/mmolH
AC 

Moles of CO2 produced per 
mole of acetate formed at low 
dissolved H2 concentrations. 

CO2 yield 
(fermentation 
high H2) 

0.0 mmolCO2/mmolH
AC 

Moles of CO2 produced per 
mole of acetate formed at high 
dissolved H2 concentrations.  

N in Biomass 0.07 mgN/ mgCOD N content of biomass. 

N in Inert 0.07 mgN/ mgCOD N content of endogenous 
residue originating from 
heterotrophic decay.  

P in Biomass 0.022 mgP/ mgCOD P content of heterotrophs. This 
parameter influences the P 
removal in non bio-P systems, 
and the P content of the sludge.  

P in Inert 0.022 mgP/ mgCOD P content of endogenous residue 
originating from heterotrophic 
decay. 

Endogenous 
Residue 

0.08 - Fraction of biomass that 
becomes inert upon decay.   

COD:VSS Ratio 1.42 mgCOD/mgVSS Conversion factor between 
biomass as measured in COD 
and its VSS content. This value 
is relatively stable for biomass. 
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pH Inhibition 
Menu Location: Project|Parameters|Kinetic|pH 
   

Name Default Value Unit Explanation 

Heterotrophs 
low pH limit 
(anaerobic) 

5.5 pH units At a pH equal to this value the growth 
rate of ordinary heterotrophic biomass  in 
an anaerobic will be reduced by 50%. 

Heterotrophs 
high pH limit 
(anaerobic) 

8.5 pH units At a pH equal to this value the growth 
rate of ordinary heterotrophic biomass  in 
an anaerobic will be reduced by 50%. 

   

Switching Functions 
Menu Location: Project|Parameters|Kinetic|Switches 
   

Name Default Value Unit Explanation 

Heterotrophic 
DO half sat. 

0.05 mgO2/L This constant is used to switch off 
aerobic OHO activity under low DO 
conditions (that is in anaerobic and 
anoxic reactors). 

Anoxic NO3 
half sat. 

0.1 mgN/L This constant is used to switch off 
anoxic growth processes using nitrate 
under low nitrate conditions. 

Anoxic NO2 
half sat. 

0.1 mgN/L This constant is used to switch off 
anoxic growth processes using nitrite 
under low nitrite conditions. 

NH3 nutrient 
half sat. 

0.001 mgN/L This constant is used to slow all 
biomass growth processes at low 
ammonia-N concentrations (N nutrient 
limiting. 

P nutrient half 
sat. 

0.001 mgP/L This constant is used to slow the growth 
of biomass when there is no phosphorus 
available as nutrient. 

Heterotrophic 
Hydrogen half 
sat. 

1.0 mgCOD/L This constant switches between two 
fermentation pathways, generating 
acetate and propionate in various ratios, 
depending on available H2 
concentration. 

Synthesis 
anion/cation half 
sat. 

0.01 
meq/L Half saturation concentration for anions 

and cations. 

   

Growth and Decay of Propionic Acetogens 
Number of Processes: 2 

Engineering Objective: anaerobic digestion 

Implementation: permanent, always active in the BioWin model 
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Module Description: 
These 2 processes describe the growth and decay of propionic acetogens, converting 
propionate to acetate, CO2 and hydrogen. Nitrogen source for cell synthesis is 
ammonia. The base rate expression the growth process is the product of the 
maximum specific growth rate, the propionic acetogen biomass concentration and a 
Monod expression for propionate.  This base rate is modified to account for 
environmental conditions (off unless anaerobic, inhibited by hydrogen and acetate), 
nutrient limitations (nitrogen, phosphate, other cations and anions) and pH inhibition.  
BioWin uses ammonia as a nitrogen source for cell synthesis. 

The decay process has a rate that varies according to the electron acceptor 
environment 

Model parameters are listed in: 

   

Kinetic Parameters 
Menu Location: Project|Parameters|Kinetic|Acetogens 
   

Name Default Value Unit Explanation 

Max. spec. 
growth rate 0.25 d-1 Maximum specific growth rate in the 

absence of substrate limitations. 

Substrate half 
sat. 10.0 

mgCOD/L Half saturation for regulation of growth 
rate, based on availability of propionate 
as substrate 

Acetate 
inhibition 10000 

mgCOD/L Acetate inhibition constant: high acetate 
concentrations inhibit propionic acetogen 
growth. 

Decay rate 0.05 d-1 Decay rate constant when there is no 
oxygen available. 

Aerobic 
decay rate 0.52 d-1 Decay rate constant in the presence of 

oxygen. 

   

Stoichiometric 
Menu Location: Project|Parameters|Stoichiometric|Acetogens 
   

Name Default Value Unit Explanation 

Yield 0.1 mgCOD/mgCOD Amount of biomass produced 
on one unit of propionate 
converted. 

H2 yield 0.4 mgCOD/mgCOD Amount of H2 produced on one 
unit of propionate converted. 

CO2 yield 1.0 mmolCO2/mmol Moles of CO2 produced per 
mole 

N in biomass 0.07 mgN/ mgCOD N content of propionic 
acetogens.  

N in 
endogenous 

0.07 mgN/ mgCOD N content of endogenous 
residue originating from 
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residue propionic acetogen decay.  

P in biomass 0.022 mgP/ mgCOD P content of propionic 
acetogens. 

P in 
endogenous 
residue 

0.022 mgP/ mgCOD P content of endogenous residue 
originating from propionic 
acetogen decay. 

Fraction to 
endogenous 
residue 

0.08 - Fraction of biomass that 
becomes inert upon decay.   

COD:VSS 
ratio 

1.42 mgVSS/mgCOD Conversion factor between 
biomass as measured in COD 
and its VSS content. This value 
is relatively stable for biomass. 

   

pH Inhibition 
Menu Location: Project|Parameters|Kinetic|pH 
   

Name Default Value Unit Explanation 

Propionic 
acetogens low 
pH limit 

4.0 pH units At a pH equal to this value the 
growth rate of propionic 
acetogens will be reduced by 
50%. 

Propionic 
acetogens 
high pH limit 

10.0 pH units At a pH equal to this value the 
growth rate of propionic 
acetogens will be reduced by 
50%. 

   

Switching Functions 
Menu Location: Project|Parameters|Kinetic|Switches 
 

Name Default Value Unit Explanation 

Heterotrophic 
DO half sat. 

0.05 mgO2/L This constant is used to switch off 
aerobic OHO activity under low DO 
conditions (that is in anaerobic and 
anoxic reactors). 

Anoxic NO3 
half sat. 

0.1 mgN/L This constant is used to switch off 
anoxic growth processes using nitrate 
under low nitrate conditions. 

Anoxic NO2 
half sat. 

0.1 mgN/L This constant is used to switch off 
anoxic growth processes using nitrite 
under low nitrite conditions. 

NH3 nutrient 
half sat. 

0.001 mgN/L This constant is used to slow all 
biomass growth processes at low 
ammonia-N concentrations (N nutrient 
limiting. 

P nutrient half 
sat. 

0.001 mgP/L This constant is used to slow the growth 
of biomass when there is no phosphorus 
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available as nutrient. 

Propionic 
acetogens 
Hydrogen limit 

5.0 mgCOD/L This constant is used to inhibit the 
growth of biomass when high levels of 
H2 are present.  

Synthesis 
anion/cation half 
sat. 

0.01 
meq/L Half saturation concentration for anions 

and cations. 

   

Growth and Decay of Methanogens 
Number of Processes: 6 

Engineering Objective: anaerobic digestion 

Implementation: permanent, always active in the BioWin model 

Module Description: 
These 6 processes describe the growth and decay of two of the principal groups of 
obligate anaerobic microorganisms (acetoclastic methanogens converting acetate (or 
methanol) to methane and CO2; and hydrogenotrophic methanogens, converting CO2 
(or methanol) and hydrogen to methane and water).  

The base rate expression for each of the 4 growth processes is the product of the 
maximum specific growth rate constant, the appropriate biomass concentration and a 
Monod expression for each of the substrates.  This base rate is modified to account 
for nutrient limitations (ammonia, phosphate, other cations and anions) and pH 
inhibition.  BioWin uses ammonia as a nitrogen source for cell synthesis 

For both populations, the decay rate that varies according to the electron acceptor 
environment. 

 

Model parameters are listed in: 

   

Kinetic Parameters 
Menu Location: Project|Parameters|Kinetic|Methanogens 
   

Name Default Value Unit Explanation 

Acetoclastic Mu 
Max 

0.3 d-1 Maximum specific growth rate for 
the acetoclastic biomass if no 
substrate limitation or inhibition 
occurs.  

H2-utilizing Mu 
Max 

1.4 d-1 Maximum specific growth rate for 
the H2-utilizing biomass if no 
substrate limitation or inhibition 
occurs. 

Acetoclastic Ks 100 mgCOD/L Half saturation for regulation of 
acetoclastic biomass growth rate, 
based on availability of acetate as 
substrate. 

Acetoclastic 0.5 mgCOD/L Half saturation concentration of 
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methanol Ks methanol for acetoclastic biomass. 

Hydrogenotrophic 
CO2 half sat. 

0.1 mmolCO2/L Half saturation for regulation of H2-
utilizing biomass growth rate, based 
on availability of CO2 as substrate. 

H2-utilizing Ks 0.1 mgCOD/L Half saturation for regulation of H2-
utilizing biomass growth rate, based 
on availability of hydrogen as 
substrate. 

H2-utilizing 
methanol Ks 

0.5 mgCOD/L Half saturation concentration of 
methanol for H2-utilizing biomass. 

Acetoclastic 
propionic 
inhibition 

10000 mgCOD/L Propionate inhibition constant: high 
levels of propionate inhibit 
acetoclastic biomass growth. 

Acetoclastic 
decay rate 

0.13 d-1 Decay rate constant when there is no 
oxygen available. 

Acetoclastic 
aerobic decay rate 

0.6 d-1 Decay rate constant in the presence 
of oxygen. 

H2-utilizing 
decay rate 

0.13 d-1 Decay rate constant when there is no 
oxygen available. 

H2-utilizing 
aerobic decay rate 

0.6 d-1 Decay rate constant in the presence 
of oxygen. 

   

Stoichiometric 
Menu Location: Project|Parameters|Stoichiometric|Methanogens 
   

Name Default Value Unit Explanation 

Acetoclastic 
yield 

0.1 mgCOD/mgCOD Amount of acetoclastic biomass 
produced using one unit of 
substrate (acetate). The rest of the 
substrate will be converted to 
CO2.   

Methanol 
acetoclastic 
yield 

0.1 mgCOD/mgCOD Acetoclastic biomass yield on 
one unit of methanol COD.   

H2-utilizing 
yield 

0.1 mgCOD/mgCOD Amount of H2-utilizing biomass 
produced using one unit of 
substrate (hydrogen). The rest of 
the substrate will be converted to 
methane and water.   

Methanol H2-
utilizing yield 

0.1 mgCOD/mgCOD H2-utilizing biomass yield on one 
unit of methanol COD 

N in 
acetoclastic 
biomass 

0.07 mgN/mgCOD N content of acetoclastic 
biomass. 

N in H2-
utilizing 
biomass 

0.07 mgN/mgCOD N content of H2-utilizing 
biomass. 

N in 
acetoclastic 
endog. residue 

0.07 mgN/mgCOD N content of endogenous residue 
originating from acetoclastic 
decay.  
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H2-utilizing N 
in endog. 
Residue 

0.07 mgN/mgCOD N content of endogenous residue 
originating from H2-utilizing 
biomass decay. 

P in 
acetoclastic 
biomass 

0.022 mgP/mgCOD P content of acetoclastic biomass.

P in H2-
utilizing 
biomass 

0.022 mgP/mgCOD P content of H2-utilizing biomass.

P in 
acetoclastic 
endog. residue 

0.022 mgP/mgCOD P content of endogenous residue 
originating from acetoclastic 
decay. 

P in H2-
utilizing endog. 
Residue 

0.022 mgP/mgCOD P content of endogenous residue 
originating H2-utilizing biomass. 

Acetoclastic 
fraction to 
endog. residue 

0.08 - Fraction of acetoclastic biomass 
that becomes inert upon decay.   

H2-utilizing 
fraction to 
endog. residue 

0.08 - Fraction of H2-utilizing biomass 
that becomes inert upon decay. 

Acetoclastic 
COD:VSS ratio

1.42 mgCOD/mgVSS Conversion factor between 
biomass as measured in COD and 
its VSS content. This value is 
relatively stable for biomass. 

H2-utilizing 
COD:VSS ratio

1.42 mgCOD/mgVSS Conversion factor between 
biomass as measured in COD and 
its VSS content. This value is 
relatively stable for biomass. 

   

pH Inhibition 
Menu Location: Project|Parameters|Kinetic|pH 
   

Name Default Value Unit Explanation 

Acetoclastic 
methanogens 
low pH limit 

5 pH units At a pH equal to this value the growth 
rate of the methanogens will be reduced 
by 50%. Methanogens are sensitive to 
low pH, the digester can easily turn acid.  

Acetoclastic 
methanogens 
high pH limit 

9 pH units At a pH equal to this value the growth 
rate of the methanogens will be reduced 
by 50% 

H2-utilizing 
methanogens 
low pH limit 

5 pH units At a pH equal to this value the growth 
rate of the methanogens will be reduced 
by 50%. Methanogens are sensitive to 
low pH, the digester can easily turn acid.  

H2-utilizing 
methanogens 
high pH limit 

9 pH units At a pH equal to this value the growth 
rate of the methanogens will be reduced 
by 50% 
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Switching Functions 
Menu Location: Project|Parameters|Kinetic|Switches 
   

Name Default Value Unit Explanation 

   

Name Default Value Unit Explanation 

Heterotrophic 
DO half sat. 

0.05 mgO2/L This constant is used to switch off 
aerobic OHO activity under low DO 
conditions (that is in anaerobic and 
anoxic reactors). 

Anoxic NO3 
half sat. 

0.1 mgN/L This constant is used to switch off 
anoxic growth processes using nitrate 
under low nitrate conditions. 

Anoxic NO2 
half sat. 

0.1 mgN/L This constant is used to switch off 
anoxic growth processes using nitrite 
under low nitrite conditions. 

NH3 nutrient 
half sat. 

0.001 mgN/L This constant is used to slow all 
biomass growth processes at low 
ammonia-N concentrations (N nutrient 
limiting. 

P nutrient half 
sat. 

0.001 mgP/L This constant is used to slow the growth 
of biomass when there is no phosphorus 
available as nutrient. 

Synthesis 
anion/cation half 
sat. 

0.01 
meq/L Half saturation concentration for anions 

and cations. 

   

Chemical Precipitation Model 
The Chemical Precipitation Model in BioWin describes insoluble metal salt 
formation that occurs in wastewater treatment plants under various environmental 
conditions. The objective of this model is to improve the prediction of soluble 
phosphate residuals and provide accurate chemical sludge production estimates. 
Phosphorus plays an active part both in biological and chemical processes in 
wastewater. It is an important part of the weak acid-base system, it is a nutrient and 
an energy-storage compound for various microorganisms and it readily forms 
insoluble precipitates with magnesium, calcium, as well as iron and aluminum ions if 
those are added to the wastewater. All these processes need to be taken into account 
for accurate effluent phosphorus predictions. 

The Chemical Precipitation Model in BioWin contains the following functional 
categories, modules 

Chemical Phosphorus Precipitation by Alum or Ferric 
Struvite and Calcium Phosphates Precipitation 

These modules are described in detail below. 
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Ferric or Alum Precipitation 
Number of Reactions: 6 

Engineering Objective: Chemical phosphorus removal 

Implementation: Optional, has to be activated in the BioWin model options  

Module Description: 
In the current implementation either Ferric or Aluminum phosphate precipitation can 
be selected as an option, but not both. Since precipitation is orders of magnitude 
faster than biological reactions, the model equations are expressed and solved using 
an equilibrium approach. The added metal will form an insoluble phosphate/hydroxo 
complex (Fe1.6H2PO4OH3.8 or Al0.8H2PO4OH1.4), a soluble metal-phosphate complex 
(FeH2PO4

2+ or AlHPO4
+), and any residual metal will be mostly bound in metal 

hydroxide precipitate (Fe(OH)3 or Al(OH)3). In equilibrium there is always a low 
concentration of free metal ions and soluble phosphate species in various dissociated 
or undissociated forms (PO4

3-, HPO4
2-, H2PO4

-, H3PO4). The phosphate species 
together with the soluble metal-phosphate complex cause the residual, soluble 
effluent phosphorus concentration. The reactions are handled using the proper 
solubility and dissociation equations. The distribution and residual concentration of 
these components is pH and dose dependent. For soluble phosphorus species in case 
of a large metal overdose the following graphs show the pH sensitivity: 

   

 
Figure 1 : pH sensitivity for soluble phosphorus species in case of a large metal overdose 

Model parameters are listed in: 

Menu Location: Project|Parameters|Other|Physico-chemical constants 

   

Name Default Value Unit Explanation 
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Equilibrium 
soluble PO4 
with Al 
dosing at pH 
7  

0.01 mgP/L This is the best achievable soluble PO4 
concentration when the solution is in equilibrium 
with the composite product of AlrH2PO4OH(3r-1) 
based on the following reaction equation: 

( ) ( ) AlP,sp
4.1

42
8.03 KOHPOHAl =





 −+ −

 

( ) ( ) AlP,sp
4.1

42
8.03 KOHPOHAl =





 −+ −

 

 

Al to P mole 
ratio (r) in 
Alr(H2PO4)(
OH)3r-1 
precipitation 

0.8 mmolA
l/mmol
P 

Under low doses and optimal pH this is the 
default molar ratio between the precipitated 
aluminum and phosphate ions. However the 
actual (observed) ratio will depend on pH, as well 
as the formation of other aluminum phosphate 
and hydroxide components. 

Al(OH)3 
solubility 
product 

1.2590E+9 mol/L This solubility constant is based on the reaction 
++ +↔+ H3)OH(AlOH3Al 32

3 , as 

expressed by: 
( )
( ) AlOH3,sp3

3

K
H

Al
=

+

+

 

The value of this constant should never be 
changed. The hydroxide precipitate formed in this 
reaction uses up aluminum ions and contributes to 
the non-stoichiometric Al/P ratios observed as 
well as the required overdose.  

AlHPO4+ 
dissociation 
constant 

7.9430E-13 mol/L This dissociation constant is based on the 
following reaction equation: 

( )( )
( ) 4iAlHPO

4

2
4

3

K
AlHPO

HPOAl
=

+

−+

 

This soluble aluminum phosphate complex will 
contribute to the residual soluble phosphate 
concentration measured.  

Equilibrium 
soluble PO4 
with Fe 
dosing at pH 
7 

0.01 mgP/L This is the best achievable soluble PO4 
concentration when the solution is in equilibrium 
with the composite product of Fe1.6H2PO4OH3.8 
based on the following reaction equation: 

( ) ( )( ) FePsp
rr KOHPOHFe ,

13
42

3 =
−−+ −

 

 

Fe to P mole 
ratio (r) in 
Fer(H2PO4)(
OH)3r-1 
precipitation 

1.6 mmolF
e/mmol
P 

Under low doses and optimal pH this is the 
default molar ratio between the precipitated ferric 
and phosphate ions. However the actual 
(observed) ratio will depend on pH, as well as the 
formation of other ferric phosphate and hydroxide 
components. 

Fe(OH)3 
solubility 
product 

0.05 mol/L This solubility constant is based on the reaction: 
++ +↔+ H3)OH(FeOH3Fe 32

3 , 
as expressed by: 
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( )
( ) FeOH3,sp3

3

K
H

Fe
=

+

+

 

The value of this constant should never be 
changed. The hydroxide precipitate formed in this 
reaction uses up ferric ions and contributes to the 
non-stoichiometric Fe/P ratios observed as well as 
the required overdose. 

FeH2PO4++ 
dissociation 
constant 

5.0120E-22 mol/L This dissociation constant is based on the 
following reaction equation: 

( )( )
( ) 42POiFeH2

42

42
3

K
POFeH

POHFe
=

+

−+

 

This soluble ferric phosphate complex will 
contribute to the residual soluble phosphate 
concentration measured. 

   

Spontaneous Chemical Precipitation 
Module Description: 
Magnesium and Calcium is present in most wastewaters and can spontaneously form 
precipitates. From the large number of phosphate and carbonate precipitates that can 
be formed under typical conditions, particularly under higher than neutral pH, the 
most important ones affecting soluble phosphorus levels are struvite (magnesium-
ammonium-phosphate, MgNH4PO4 

. 6H2O), and hydroxy-dicalcium-phosphate 
(HDP, Ca2HPO4(OH)2 ). 

Struvite typically forms in digesters, due to the high concentration of magnesium, 
ammonium and phosphate ions present. These ions are transported to the digester in 
the biomass and are released. BioWin (in the anaerobic module) describes Mg, N, 
and P release. The resulting struvite precipitation can occur particularly in pipes and 
on overflow weirs, where degassing of CO2 raises the pH. The model is described in 
detail in Musvoto et al. (2000).  

HDP (and many other types of calcium phosphates) can precipitate in the bioreactor 
due to pH changes occurring in the anaerobic/aerobic zones. Accurate prediction of 
phosphate levels in bio-P processes may require simulating the HDP precipitation – 
redissolution phenomena as well. BioWin contains one more calcium phosphate 
precipitate, hydroxy-apatite (HAP), that is considered a sink for calcium that does 
not redissolve. The model is described in Maurer et al. (1999).     

These precipitation processes are formulated with kinetic equations, according to the 
referenced papers. 

Number of Processes: 3 

Engineering Objective: Formation of Struvite and Calcium Phosphates 

Implementation: Optional, has to be activated in the BioWin model options 

Model parameters are listed in: 

Menu Location: Project|Parameters|Other|Physico-chemical rates 
   

Name Default Value Unit Explanation 
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Struvite 
precipitation rate 

3.0000E+10 d-1 The published precipitation rate 
(Musvoto et al. expressed in 
molar terms) is 3*1015. 
Simulation of other experiments 
suggests a much lower rate 
(Suzuki 1998). Mixing effects 
likely have an influence on the 
rate constant. The default 
selected is a compromise and can 
be changed in the range of 109 to 
3*1015. 

Struvite 
redissolution rate 

3.0000E+11 d-1 This constant has a lower 
importance as struvite 
redissolution is not typically 
encountered in wastewater 
processes.  

Struvite half sat. 1.0 mgTSS/L This is an empirical constant 
designed to provide continuity to 
the mathematical solution by 
maintaining low levels of struvite 
even under lower pH conditions. 
Its value should not be changed. 

HDP precipitation 
rate 

1.0000E+8 L/(molP.d) The value of this rate constant 
will affect how close to 
equilibrium the HDP 
precipitation reaction will be 
under the given hydraulic 
resident times. If it is necessary 
to change it, it should be changed 
together with the redissolution 
rate constant. 

HDP redissolution 
rate 

1.0000E+8 L/(molP.d) The value of this rate constant 
will affect how close to 
equilibrium the HDP 
redissolution reaction will be 
under the given hydraulic 
residence times. If it is necessary 
to change it, it should be changed 
together with the precipitation 
rate constant. 

HAP precipitation 
rate 

5.0000E-4 molHDP/(L.d) This constant rate will generate 
insoluble HAP that cannot be 
redissolved. 

   

Menu Location: Project|Parameters|Other|Physico-chemical constants 
   

Name Default Value Unit Explanation 

Struvite 
solubility 
product 

6.9180E-14 mol/L This solubility constant should not be 
changed 

HDP solubility 
product 

2.7500E-22 mol/L This solubility constant should not be 
changed 

HDP half sat. 1.0 mgTSS/L This is an empirical constant designed to 
provide continuity to the mathematical 
solution by maintaining low levels of 
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HDP even under lower pH conditions. Its 
value should not be changed. 

   

Settling Models 
Engineering Objective: Gravitational solid / liquid separation  

Implementation: Flux-based solids / liquid separation models (used in one-
dimensional model clarifier elements) 

Module Description: 
The general flux theory approach models solids settling in one dimension. In the 
one-dimensional approach solids and liquid movement in the vertical direction are 
assumed to be dominant and horizontal movement is ignored. The settling tank is 
divided into a number of layers in the vertical direction and a numerical technique is 
used to solve the mass balance equations in the vertical direction. The solution to the 
mass balance equations provides the solids concentration profile in the settling tank, 
and the solids concentration in the effluent and underflow.  For more details, please 
see the Flux Based Models section of the "Settling and Solid / Liquid Separation 
Models" chapter. 

BioWin offers two types of flux theory models: 

1 – Modified Vesilind 
2 – Double Exponential 

Each model has its own set of parameters; these are described below. 

   

Modified Vesilind Parameters 
Menu Location: Project|Parameters|Settling|Modified Vesilind 

   

Name Default Value Unit Explanation 

Maximum Vesilind 
settling velocity (V0) 

170 m/d The maximum attainable settling 
velocity at theoretically infinite dilution 
in the unmodified Vesilind relationship.  
Primarily affects clarification function.  
Higher values are associated with well-
settling sludge. 

Vesilind hindered 
zone settling 
parameter (K) 

0.37 L/g The term which describes the 
exponential decrease in settling velocity 
with increasing concentration in the 
Vesilind relationship.  Primarily affects 
the thickening function.  Higher values 
associated with poor settling sludge. 

Clarification 
switching function 

100 mg/L Switch applied in a Monod-type 
switching function to the Vesilind 
relationship.  Addresses unrealistically 
high settling velocities predicted at low 
solids concentrations by strict 
application of the Vesilind model as 
originally published.  Increasing the 
value for this switch will result in higher 
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effluent suspended solids predictions. 

Specified TSS 
conc.for height calc. 

2500 mg/L BioWin will locate and plot the height 
of the specified suspended solids 
concentration within the settler profile. 

Maximum 
compactability 
constant 

15,000 mg/L The specified value is used to limit the 
maximum suspended solids 
concentration that can be achieved in a 
model settler layer.  Also, as the solids 
concentration in a layer approaches this 
concentration, resuspension of solid 
particles occurs. 

   

Double Exponential Parameters 
Menu Location: Project|Parameters|Settling|Double Exponential 
   

Name Default Value Unit Explanation 

Maximum Vesilind 
settling velocity (V0) 

410 m/d The maximum attainable settling 
velocity at theoretically infinite dilution 
in the unmodified Vesilind relationship. 

Maximum (practical) 
settling velocity 
(V0') 

270 m/d The maximum settling velocity 
attainable in the Double Exponential 
model.  This constraint addresses the 
unrealistically high settling velocities 
predicted at low solids concentrations by 
strict application of the Vesilind model.  
Higher values are associated with well-
settling sludge. 

Hindered zone 
settling parameter 
(Kh) 

0.40 L/g The term which describes the 
exponential decrease in settling velocity 
with increasing concentration in Zone 4 
of the Double Exponential model where 
hindered settling dominates.  Higher 
values associated with poor settling 
sludge. 

Flocculent zone 
settling parameter 
(Kf) 

2.5 L/g The exponential term which describes 
settling behavior in Zone 2 of the 
Double Exponential model where 
flocculant settling is dominant.  Higher 
values associated with poor settling 
sludge. 

Maximum non-
settleable TSS 

20 mg/L The minimum attainable suspended 
solids concentration in a layer is 
calculated as a fraction of the settling 
tank influent solids concentration, but it 
may not be less than this user-specified 
value. 

Non-settleable 
fraction 

0.001 - The minimum attainable suspended 
solids concentration in a layer is 
calculated as a fraction of the settling 
tank influent solids concentration. 

Specified TSS conc. 
for height calc. 

2500 mg/L BioWin will locate and plot the height 
of the specified suspended solids 
concentration within the settler profile. 
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pH Model 
The pH model is described in detail in the "Modeling of pH in BioWin" chapter. 

Aeration and Gas Transfer Model 
Parameters used in BioWin's aeration and gas transfer model are accessed via a 
number of different tabs.  These are listed in the following sections. 

Number of Processes: 6 

Engineering Objective: Gas-liquid mass transfer  

Implementation: permanent, always active in the BioWin model 

Module Description: 
There are six gas-liquid mass transfer processes to allow interphase transfer of 
oxygen, carbon-dioxide, methane, nitrogen, ammonia and hydrogen. Details about 
the mass transfer model may be found in the "Gas-Liquid Mass Transfer" chapter. 

 

The Mass transfer model is impacted by the values of the following model 
parameters. 

Mass transfer Parameters 
Menu Location: Project|Parameters|Other|Mass transfer 
   

Name Default Value Unit Explanation 

KL for H2 17.0 m/d Liquid phase mass transfer coefficient for H2 

KL for CO2 10.0 m/d Liquid phase mass transfer coefficient for CO2 

KL for NH3 1.0 m/d Liquid phase mass transfer coefficient for NH3 

KL for CH4 8.0 m/d Liquid phase mass transfer coefficient for CH4 

KL for N2 15.0 m/d Liquid phase mass transfer coefficient for N2 

KL for O2 13.0 m/d Liquid phase mass transfer coefficient for O2 

Aeration Parameters 
Menu Location: Project|Parameters|Other|Aeration 
   

Name Default Value Unit Explanation 

Alpha (surf) OR 
Alpha F (diff) 

0.50 Unitless α is the ratio of the overall mass transfer 
coefficient in process water to the overall 
mass transfer coefficient in clean water.  
F (diffuser fouling factor) is the ratio of 
the overall mass transfer coefficient for a 
particular diffuser after a given time in 
service to that of a new diffuser in the 
same process water.  
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Beta 0.95 Unitless β is the ratio of the dissolved oxygen 
saturation concentration in process water 
to the saturation concentration in clean 
water 

Surface pressure 101.325 kPa Atmospheric pressure at field conditions. 

Fractional 
effective 
saturation depth 
(Fed) 

0.325 Unitless The effective saturation depth is the depth 
at which the total pressure (hydrostatic 
and atmospheric) would produce a 
saturation concentration equal to the 
steady state saturation concentration for 
the system. 

Supply gas CO2 0.035 vol. % The volume percentage of carbon dioxide 
in the supply gas to a diffused air system. 
This parameter is also used to determine 
the dissolved carbon dioxide saturation 
concentration for surface aerator systems. 

Supply gas O2 20.95 vol. % The volume percentage of oxygen in the 
supply gas to a diffused air system.  This 
parameter is also used to determine the 
dissolved oxygen saturation concentration 
for surface aerator systems. 

Off-gas CO2 2.0 vol. % The volume percentage of carbon dioxide 
in the gas leaving a diffused air system. 
[This parameter is not used if the gas 
phase is modeled.] 

Off-gas O2 18.8 vol. % The volume percentage of oxygen in the 
gas leaving a diffused air system. [This 
parameter is not used if the gas phase is 
modeled.] 

Off-gas H2 0.00 vol. % The volume percentage of hydrogen in 
the gas leaving a diffused air system. 
[This parameter is not used if the gas 
phase is modeled.] 

Off-gas NH3 0.00 vol. % The volume percentage of ammonia in the 
gas leaving a diffused air system. [This 
parameter is not used if the gas phase is 
modeled.] 

Surface 
turbulence factor 

2 Unitless This parameter indicated the intensity of 
mixing on the surface conditions (it has 
little impact in aerated systems).  

Set point 
controller gain 

1.0 Unitless This parameter may be used to increase 
the gain of the dissolved oxygen 
controller.  Typically the user would 
increase this value if the controller was 
slow in achieving the dissolved oxygen 
set point. 

   

Diffuser Parameters 
Location: ‘Model Parameters’ on Element “Operation” tab 
   

Name Default Value Unit Explanation 

k1 in C = k1(PC)0.25 2.5656  Correlation parameter 
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+ k2 

k2 in C = k1(PC)0.25 
+ k2 

0.04320  Correlation parameter 

Y in KLa = C UsgY 0.82000  Correlation parameter 

Area of one diffuser 0.04100 m2 Area of a single diffuser is required to 
determine the number of diffusers. 

% of tank area 
covered by diffusers 
(PC) 

10.00000 % Ratio of the total active diffuser area to 
the tank area as a percentage. 

Diffuser mounting 
height 

0.25 m Height of diffuser discharge above 
tank floor 

Min. air flow rate 
per diffuser 

0.50000 m3 hr-1 Minimum of X axis in SOTE plot.  

Max. air flow rate 
per diffuser 

10.00 m3 hr-1 Maximum of X axis in SOTE plot. 

   

Surface aerator Parameters 
Location: ‘Model Parameters’ on Element “Operation” tab 
   

Name Default Value Unit Explanation 

Surface aerator Std. 
oxygen transfer rate 

1.500000 kg O kW-1 hr-1 Standard oxygen transfer rate 
for rotary surface aerators 

Maximum power per 
rotor 

20.00000 kW The maximum power input per 
surface aerator is used to 
determine the number of 
aerators required. 

    

Model Library for the Model Builder 
The following builder models have been included with BioWin: 

   

• ASM1 

• ASM2d 

• ASM3 

• Aerobic growth of methylotrophs on methanol  

• Inert conversion 

• CaCO3 precipitation 

For more information on loading these models, and using the Model Builder 
interface in general, please see the Model Builder  section of the "Useful BioWin 
Interface Tools and Techniques"chapter. 

The following points should be noted when using these Builder models: 
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• OURc – the displayed value for this parameter is the carbonaceous 
OUR for the BioWin model only.  Therefore when a Model Builder 
model is active, oxygen demand from any user-defined processes are 
not included (OURn is similar but only applies to the oxygen utilized 
for AOB and NOB growth).  In summary, OURc and OURn only 
reflect the BioWin model terms; if there is no BioWin model used in 
the Model Builder then they will be zero. 

• OURt is calculated from the sum of all process rates that use or 
produce oxygen.  Consequently if the BioWin reactions are ON in the 
model builder then: 

   

• OURt - OURn - OURc = the OUR from the Model Builder reactions 

   

• and if BioWin reactions are Off in the Model Builder then: 

• OURt = the OUR from the Model Builder reactions. 

Definition of Combined Variables 
To model the range of system types it is necessary to track the concentrations of a 
large number of components (state variables) in each stream of a configuration. In 
certain cases tracking a number of the variables may be superfluous. For example, if 
a system incorporates only an aerobic activated sludge unit then all variables relating 
to biological phosphorus removal will have zero concentration values (polyP 
heterotrophic organism mass, stored polyphosphate, etc.). 

Each element in the configuration is modeled to provide a mass balance on the 
following state variables. 

   

Short name Full name Units 

Zbh Non-polyP heterotrophs  [mgCOD/L] 

Zbmeth Anoxic methanol utilizers  [mgCOD/L] 

Zaob Ammonia oxidizing biomass  [mgCOD/L] 

Znob Nitrite oxidizing biomass  [mgCOD/L] 

Zamox Anaerobic ammonia oxidizers  [mgCOD/L] 

Zbp PolyP heterotrophs  [mgCOD/L] 

Zbpa Propionic acetogens  [mgCOD/L] 

Zbam Acetoclastic methanogens  [mgCOD/L] 

Zbhm Hydrogenotrophic methanogens  [mgCOD/L] 

Ze Endogenous products  [mgCOD/L] 

Xsp Slowly bio. COD (part.)  [mgCOD/L] 

Xsc Slowly bio. COD (colloid.)  [mgCOD/L] 

Xi Part. inert. COD  [mgCOD/L] 

Xon Part. bio. org. N  [mgN/L] 

Xop Part. bio. org. P  [mgP/L] 

Xin Part. inert N  [mgN/L] 
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Xip Part. inert P  [mgP/L] 

Spha Stored PHA  [mgCOD/L] 

PP-lo Releasable stored polyP  [mgP/L] 

PP-hi Fixed stored polyP  [mgP/L] 

XPPCat PolyP bound cations  [mg/L] 

Sbsc Readily bio. COD (complex)  [mgCOD/L] 

Sbsa Acetate  [mgCOD/L] 

Sbsp Propionate  [mgCOD/L] 

Sbmeth Methanol  [mgCOD/L] 

SbH2 Dissolved H2  [mgCOD/L] 

CH4 Dissolved methane  [mg/L] 

NH3-N Ammonia N  [mgN/L] 

Nos Sol. bio. org. N  [mgN/L] 

NO2-N Nitrite N  [mgN/L] 

NO3-N Nitrate N  [mgN/L] 

N2 Dissolved nitrogen gas  [mgN/L] 

PO4-P (incl. MeP) PO4-P (Sol. & Me Complexed)  [mgP/L] 

Sus Sol. inert COD  [mgCOD/L] 

Nus Sol. inert TKN  [mgN/L] 

ISS Inorganic S.S.  [mgTSS/L] 

XStru Struvite  [mgTSS/L] 

XHDP Hydroxy-dicalcium-phosphate  [mgTSS/L] 

XHAP Hydroxy-apatite  [mgTSS/L] 

SMg Magnesium  [mg/L] 

SCa Calcium  [mg/L] 

Me Metal  [mg/L] 

SCat Other Cations (strong bases)  [meq/L] 

SAn Other Anions (strong acids)  [meq/L] 

SCO2 Total CO2 [mmol/L] [mmol/L] 

UD1 User defined 1  [mg/L] 

UD2 User defined 2  [mg/L] 

UD3 User defined 3 [mgVSS/L] [mgVSS/L] 

UD4 User defined 4  [mgTSS/L] 

DO Dissolved oxygen  [mg/L] 

Flow Flow Unit system dependant 

Liq.Vol. Liquid volume Unit system dependant 

Temp. Temperature Degrees celcius 

   

BioWin calculates a number of combined variables that may be displayed for certain 
elements.  The following table outlines these combined variables. 

   

Short name Full name Description 
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VSS Volatile 
suspended solids 

VSS is calculated converting all particulate COD state 
variables (biomasses, substrates and inert organics) 
with their proper COD/VSS ratios to VSS, adding 
User Defined Variable #3 and summing them. 
Biomasses have their own Fcv (COD/VSS) 
conversion factors, while for other components the 
ratios indicated in the 
Project|Parameters|Other|General dialog are 
used.  The VSS is calculated as follows: 
VASS + Ze/Fcv,ZBH + Xsp/Fcv,XSP + Xi/Fcv,XI + 
Sphb/Fcv,XSP +UD3 

VASS Volatile active 
suspended solids 

VASS is calculated converting all biomass state 
variables with their proper COD/VSS ratios to VSS, 
and summing them. Biomasses have their own Fcv 
(COD/VSS) conversion factor in the proper 
stoichiometric parameter forms.  The VASS is 
calculated as follows: 
Zbh/Fcv,ZBH+ Zbmeth/Fcv,ZBMETH + Zbaob/Fcv,ZBAOB 
+ Zbnob/Fcv,ZBNOB + Zbanammox/Fcv,ZBANAMMOX + 
Zbp/Fcv,ZBP + Zbpa/Fcv,ZBPA + Zbam/Fcv,ZBAM + 
Zbhm/Fcv,ZBHM 

TISS Total inorganic 
suspended solids 

TISS is the sum of inorganic solids from the influent 
(ISS), total precipitated solids, the poly-P content, 
UD4, and the organism ash content; that is: 
XPrec + ISS + PP-lo + PP-hi +XPPCat + UD4 + 
(VASS + Ze/Fcv,ZBH)*(1/(1-AshContent/100.0) - 1.0) 

TSS Total suspended 
solids 

TSS is calculated as a sum of VSS and TISS. 

XCOD Particulate COD Particulate COD is calculated as the sum of all 
particulate state variables that are expressed in COD, 
as follows: 
Zbh + Zbmeth + Zba + Zbp + Zbpa + Zbam + Zbhm + 
Ze + Xsp + Xi +Sphb 

SCOD Filtered COD Filtered COD is calculated as the sum of all soluble 
state variables that are expressed in COD, including 
the colloids and hydrogen as follows: 
Sbsc + Sbsa + Sbsp + SbMeth + Sh2 + Sus + Xsc 

COD Total Chemical 
Oxygen Demand 

Total COD is the sum of filtered and particulate COD. 

SPO4 Soluble PO4-P Soluble PO4-P is the sum of all inorganic phosphate 
species, including soluble metal phosphate complexes 
in case of metal dosage.  Note that biodegradable and 
unbiodegradable soluble and colloidal organic P is 
considered zero.  That is: 
(SolubleP & Metal-complexed P) - (MerH2PO4OH3r-1) 

TP Total P Total P is calculated as the sum of Soluble PO4-P, P 
content of biomasses and endogenous residue as a 
fraction, particulate inert and biodegradable organic P, 
P in releasable and fixed polyphosphate, and P bound 
in Struvite, HDP, HAP and metal phosphate 
precipitate if applicable.  That is: 
Zbh*Fzbp,ZBH + Zbmeth*Fzbp,ZBMETH + 
Zbaob*Fzbp,ZBAOB+ Zbnob*Fzbp,ZBNOB+ 
Zbanammox*Fzbp,ZBANAMMOX + Zbp*Fzbp,ZBP + 
Zbpa*Fzbp,ZBPA + Zbam*Fzbp,ZBAM + Zbhm* 
Fzbp,ZBHM + PP-lo + PP-hi + Xip + (SolubleP & 
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Metal-complexed P) + Xop + Xstru 
*(MWPhosphorus/MWStru) + 
XHDP*(MWPhosphorus/MWXHDP) + 
XHAP*(3*MWPhosphorus)/MWXHAP 

XPrec Total precipitated 
solids 

Precipitated solids are calculated as the sum of HDP, 
HAP, Struvite, Metal phosphate and metal hydroxide 
solids, that is: 
XHDP + XHAP + Xstru + MeOH3+ MerH2PO4OH3r-1 

STKN Filtered TKN Filtered TKN is ammonia-N, and soluble 
biodegradable and unbiodegradable organic nitrogen, 
that is: 
NH3 + Nos + Nus 

XTKN Particulate TKN Particulate TKN is calculated as the sum of the N 
content of biomasses, particulate inert and 
biodegradable organic N, and the N content of 
struvite; that is: 
Zbh*Fzbn,ZBH + Zbmeth*Fzbn,ZBMETH + 
Zbaob*Fzbn,ZBAOB + Zbnob*Fzbn,ZBNOB + 
Zbanammox*Fzbn,ZBANAMMOX + Zbp*Fzbn,ZBP + 
Zbpa*Fzbn,ZBPA + Zbam*Fzbn,ZBAM + 
Zbhm*Fzbn,ZBHM + XIN + XON + XStru * 
MWNitrogen/MWStru 

TKN Total Kjeldahl 
Nitrogen 

Total TKN is the sum of filtered and particulate TKN 

TSBOD Filtered 
Carbonaceous 
BOD 

See BOD section below 

TCBOD Total 
Carbonaceous 
BOD 

See BOD section below 

RBCOD Readily 
biodegradable 
COD 

RBCOD is the sum the VFA-COD, the complex 
readily biodegradable substrate and methanol, that is: 
Sbsc + Sbsa + Sbsp + SbMeth 

VFA Volatile fatty 
acids 

VFAs are calculated as the sum of acetate and 
propionate, that is: 
Sbsa +  Sbsp 

TN Total N TN is TKN and nitrate-N, that is: 
TKN+NO3-N 

TIN Total inorganic N TIN is ammonium, nitrate and struvite N, that is: 
NO3 + NH3 + (Xstru * MWNitrogen/MWStru) 

Alk Alkalinity Alkalinity is calculated from weak acid/base 
chemistry – see the "Modeling of pH in BioWin" 
chapter. 

pH pH pH is calculated from weak acid/base chemistry – see 
the "Modeling of pH in BioWin" chapter. 

   

Project|Parameters|Other|General 
   
Name Default 

Value 
Unit Explanation 
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Particulate substrate 
COD:VSS ratio 

1.60 mgCOD/mgVSS Conversion factor between 
particulate substrate as measured 
in COD and its VSS content. The 
average of this value and the 
biomass COD:VSS ratio will lead 
to the typical 1.48 
mgCOD/mgVSS ratio found in 
activated sludge. 

Particulate inert 
COD:VSS ratio 

1.60 mgCOD/mgVSS Conversion factor between 
particulate inert as measured in 
COD and its VSS content.  

Ash content of 
biomass (synthesis 
ISS) 

8.00 % Ash content of biomass.  ISS 
generated (uptake of  minerals and 
micronutrients) by biomass 
growth. 

Molecular weight of 
other anions 

35.50 mg/mmol Assume molecular weight of 
“other anions” state variable. 

Molecular weight of 
other cations 

39.10 mg/mmol Assume molecular weight of 
“other cations” state variable. 

Mg to P mole ratio in 
polyphosphate 

0.30 mmol Mg/mmol P Mole ratio of magnesium to 
phosphorus in polyphosphate.  

Cation to P mole ratio 
in polyphosphate 

0.30 meq/mmol P Mole ratio of magnesium to 
phosphorus in polyphosphate. 

Ca to P mole ratio in 
polyphosphate 

0.05 mmol Ca/mmol P Mole ratio of calcium to 
phosphorus in polyphosphate. 

Bubble rise velocity 
(anaerobic digester)   

23.9 cm/s The bubble rise velocity is used to 
calculate the gas holdup in 
anaerobic digesters.  Increasing 
the rise velocity will decrease the 
gas holdup. 

Bubble Sauter mean 
diameter (anaerobic 
digester)   

0.35 cm The Sauter mean diameter is the 
diameter of a sphere with the same 
volume to surface ratio as the 
volume to surface ratio of the total 
dispersion. 

Anaerobic digester 
gas hold-up factor 

1  This parameter can be used to 
adjust the digester mass transfer. 

Tank head loss per 
metre of length (from 
flow) 

0.0025 m/m This parameter is used to calculate 
the power dissipation from flow. 

Minimum air flow 
(per unit volume) 
without mixing 

1 m3/(m3d)  

   

COD and BOD in BioWin 
In the BioWin simulator characterization of the carbonaceous material in municipal 
wastewater is in terms of the chemical oxygen demand (COD).  This selection is 
based on a number of factors, but primarily because COD provides a consistent basis 
for description of the activated sludge process, and for quantifying sludge 
production, oxygen demand, etc.  The rationale for preferring COD over other 
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parameters such as biochemical oxygen demand (BOD) or total organic carbon 
(TOC) is discussed in this section. 

The simulator allows for calculation of soluble and total BOD for any input element, 
process unit, or stream.  The user may specify the time basis for the BOD calculation 
(5, 7, or 20 days).   

In many instances data on treatment plant operation are recorded in terms of the 
BOD for both the influent and effluent, usually reported as the 5-day value (BOD5).  
This section discusses a number of factors regarding the application of BioWin 
where data are recorded on a BOD basis, or where there is a requirement to quantify 
effluent BOD levels for regulatory purposes. 

BOD Calculations in BioWin 
The basis for modeling organic components in BioWin is the chemical oxygen 
demand (COD) parameter.  However, BioWin allows for calculation of soluble 
(filtered) and total carbonaceous biochemical oxygen demand (BOD) for any input 
element, process unit, or stream.  The user may specify the time basis for the BOD 
calculation (5, 7, or 20 days). 

Calculation of BOD is based on differing rates of degradation of the different 
components (e.g., influent biodegradable material (readily and slowly 
biodegradable), active organism masses which exert an endogenous oxygen demand 
and hence a BOD, etc.). Essentially BioWin uses analytical equations to estimate 
BOD. 

The objective here is to demonstrate the method used by BioWin in calculating 
filtered and total BOD concentrations, and show how the equations were developed.  
Understanding development of the equations presented below is facilitated by the 
figure below which illustrates the division of a wastewater stream into the different 
components. 

   

Definition of Terms 

B Endogenous decay rate constant (≅ 0.24 d-1) 

BODE Biochemical oxygen demand due to endogenous respiration  

BODS Soluble component of biochemical oxygen demand 

BODXSP Particulate slowly biodegradable component of biochemical oxygen demand 

BODXBH Active biomass component of biochemical oxygen demand 

BODT Total biochemical oxygen demand 

f Fraction of active mass remaining as endogenous residue (≅ 0.20) 

fBS Fraction of total influent COD which is readily biodegradable  

fUP Fraction of total influent COD which is unbiodegradable particulate 

fUS Fraction of total influent COD which is unbiodegradable soluble 

fXBH Fraction of total influent COD which is active organisms 

fXSP Fraction of slowly degradable COD which is particulate 

K First order rate constant for XSP degradation (≅ 0.40 d-1) 

(MO2)G Mass of oxygen utilized for growth on soluble substrate 

(MO2)E Mass of oxygen utilized for endogenous metabolism 

OUR Oxygen utilization rate (mg/L/day) 
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OURE Oxygen utilization rate due to endogenous metabolism 

OURG Oxygen utilization rate for substrate utilization (growth) 

SBS Soluble readily biodegradable COD concentration (mg COD/L) 

SBSA Soluble readily biodegradable volatile fatty acid COD concentration (mg 
COD/L) 

SBSP Soluble readily biodegradable propionate COD concentration (mg COD/L) 

SBMETH Soluble readily biodegradable methanol COD concentration (mg COD/L) 

SBSC Soluble readily biodegradable complex COD concentration (mg COD/L) 

SS Soluble (filtered) biodegradable COD concentration (mg COD/L) 

SUP Particulate unbiodegradable COD concentration (mg COD/L) 

SUS Soluble unbiodegradable COD concentration (mg COD/L) 

ST Total COD concentration (mg COD/L) 

T Time (d) 

XBH Active organism concentration (i.e. the sum of seven organism 
concentrations) (mg COD/L) 

XBH0 Active organism concentration at time zero (mg COD/L) 

XS Slowly biodegradable COD concentration (mg COD/L) 

XSC Slowly biodegradable colloidal COD concentration (mg COD/L) 

XSP Slowly biodegradable particulate COD concentration (mg COD/L) 

XSP0 Slowly biodegradable particulate COD concentration at time zero (mg 
COD/L) 

Y Yield of active organisms (≅ 0.666 mg cell COD mg COD-1) 

   

 

Division of municipal wastewater COD into constituent fractions 

Basis for BOD Calculations 
The approach for calculating BOD is to distinguish three components, and to 
calculate the BOD contribution for each component independently.  These 
components are as follows: 

   

1. BOD associated with utilization of soluble COD (both readily 
biodegradable and colloidal slowly biodegradable) and the biomass 
generated from this utilization; 
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2. BOD associated with utilization of slowly biodegradable particulate 
COD and the biomass generated from this utilization; and 

3. BOD exerted by active biomass present in the sample.  That is, biomass 
initially present; not biomass generated through utilization referred to 
in 1 and 2. 

The simulator provides values for SBSC, SBSA, XSC, XSP and XBH in any stream or 
process unit. When calculating BOD concentrations for input streams, the influent 
fractions provided by the user (or the default values) are used to calculate the 
appropriate concentrations.  

BOD Associated with Soluble Biodegradable COD 
(SS): 
For the purpose of BOD calculations, the “soluble” biodegradable COD (SS) can be 
considered to be the sum of the readily biodegradable COD (SBSC + SBSA+ SBSP+ 
SBMETH) and the biodegradable colloidal COD (XSC), i.e., 

   

SCBMETHBSPBSABSCS XSSSS   S ++++=  (1)

SCBMETHBSPBSABSCS XSSSS   S ++++=  (1)

The oxidation of this material occurs rapidly, and for the purpose of these 
calculations is assumed to occur instantaneously (i.e., at t = 0).  Assuming that the 
soluble biodegradable COD is oxidized instantly to form new cells: 

0)t time (at  SY   X  S S0BHS =⋅=→  (2)

then the mass of oxygen consumed for growth of these organisms (MO2)G is: 

SG S)Y  1(  )MO( ⋅−=  (3)

Assuming that the rate of change in organism concentration due to endogenous 
decay is first order with respect to the active organism concentration, an expression 
for active organism concentration can be obtained, i.e., 

   

BH
BH Xb  

dt
dX

⋅−=
 

(4)

Therefore, 
t b

0BHBH eX  X −⋅=  (5)

The BOD due to endogenous metabolism by the organisms generated from growth 
on SS can then be calculated using either of the methods described below. 

Method 1: 
From Eq.2 and Eq.5 , the endogenous mass loss at time t can be calculated: 

)e1(SY

)e1(X

X - XX

t b
S

t b
0BH

BH0BHBH

−

−

−⋅⋅=

−⋅=

=∆

 

(6)

and the mass of oxygen consumed for endogenous metabolism: 
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)e1(SY)1( 

X)1( )MO(
t b

S

BHE

−−⋅⋅⋅−=

∆⋅−=

f

f
 (7)

This is equal to the BOD due to endogenous decay, i.e., 

)e1(SY)1(

)e1(X)1(  BOD
t b

S

t b
0BHE

−

−

−⋅⋅⋅−=

−⋅⋅−=

f

f

 
(8)

The soluble BOD component can now be calculated by summing Eq. 3 and Eq. 8, 
i.e., 

)e1(SY)1( S)Y1(

)MO()MO(  BOD
t b

SS

EGS

−−⋅⋅⋅−+⋅−=

+=

f
 (9)

Method 2: 
The OUR due to endogenous metabolism can also be related to the rate of change in 
active organism concentration (taking into account that a fraction of the active mass 
becomes endogenous residue), i.e., 

t b
0BH

BH

BH
E

eX)1(b

X)1(b
dt

dX
)1( OUR

−⋅⋅−⋅=

⋅−⋅=

⋅−−=

f

f

f

 

(10)

The BOD due to endogenous decay is then the cumulative mass of oxygen used over 
time, i.e., 

CeX)1( 

Ce
b
1X)1(b

dteX)1(b

dt OURBOD

t b
0BH

t b
0BH

t

0

t b
0BH

t

0 EE

+⋅⋅−−=

+




−⋅⋅−⋅=

⋅−⋅=

=

−

−

−∫
∫

f

f

f

 

(11)

and since at t = 0, BODE = 0, 

0BHX)1(  C ⋅+= f  

Substituting the expression obtained for XBHO (Eq. 2) into the above gives an 
expression for the BOD due to endogenous decay: 

)e1(SY)1( 

)e1(X)1( 

X)1(eX)1( BOD

t b
S

t b
0BH

0BH
t b

0BHE

−

−

−

−⋅⋅⋅−=

−⋅⋅−=

⋅−+⋅⋅−−=

f

f

ff

 

(12)

This is the same expression obtained using Method 1 (Eq. 8).  The total soluble BOD 
portion is given by Eq. 9. 
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BOD Associated with Slowly Biodegradable 
Particulate COD (XSP): 
The biochemical oxygen demand related to the slowly biodegradable particulate 
material can be calculated from the cumulative oxygen consumption for growth on 
XSP and endogenous respiration exerted by organisms from this growth.  The OUR is 
the sum of two components: 

( )BH
SP

E

BHSP

EG

bX)1(  
dt

dX
)Y1(

dt
dX

)1(  
dt

dX
)Y1(  

OUROUR OUR

⋅−+







−⋅−=









−⋅−+








−⋅−=

+=

f

f

 

(13)

The rate of change in slowly biodegradable particulate substrate concentration is 
assumed to be first order with respect to substrate concentration, i.e., 

SP
SP Xk

dt
dX

⋅−=  

Therefore, 
t k

0SPSP eX  X −⋅=  (14)

The active organism concentration in Eq. 11 is obtained by integrating an expression 
for the rate of change of XBH.  This rate is a consequence of an increase due to 
growth on XSP, minus a decrease due to endogenous metabolism, i.e., 

BH
SPBH Xb  

dt
dX

Y  
dt

dX
⋅−







−⋅=
 

(15)

Substituting Eq. 14 into the above results in a linear differential equation for XBH as a 
function of time, i.e., 

( )
BH

t k
0SP

BH
t k

0SP

BH
SPBH

Xb ekYX

Xb eX
dt
d

Y

Xb  
dt

dX
Y  

dt
dX

⋅−⋅=

⋅−⋅−=

⋅−⋅−=

−

−

 

(16)

Or equivalently, 

t k
0SPBH

BH ekYXXb  
dt

dX −⋅=⋅+
 

(17)

An integration factor of ebt can be used to solve the differential equation.  
Multiplying both sides of the equation by ebt results in a simplified expression: 

t )k  b(
0SPBH

t b

t k
0SP

t b
BH

t bBHt b

ekYX)Xe(
dt
d

ekYXeXeb  
dt

dX
e

−

−

⋅=⋅

⋅⋅=⋅⋅+⋅

 

(18)

Integrating both sides of Eq. 18: 
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t bt k0SP
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(19)

At t = 0 XBH = XBHO, therefore solving for C gives: 

t b 0SP
0BH

t k 0SP
BH e
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X e
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(20)

Returning to Eq. 13 for the oxygen utilization rate and substituting for XBH: 
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(21)

Integrating Eq. 21 gives an expression for the BOD of the slowly biodegradable 
material as a function of time, i.e., 
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Assuming XBHO ≈ 0 and re-arranging the above expression, 
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(22)

The total BOD (if no biomass is present) is then the sum of BODS and BODXSP,. 
(Eqs. 9 and 22), i.e., 
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(23)

BOD Associated with Active Biomass  
In cases where there are active organisms present, the BOD exerted by the organisms 
can be calculated from the rate of change in active organisms due to endogenous 
metabolism, i.e.,  
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)e1(X)1(BOD t b 
BHXBH

−−⋅⋅−= f  (24)

This must then be added to the soluble and slowly degradable BODs to obtain the 
total BOD (i.e., sum Eqs. 23, and 24). 

Example 
This example demonstrates the BOD calculation procedure for an influent 
wastewater stream with the following characteristics: 
ST 500 mg COD/L 

fUS 0.10 

fUP 0.08 

fBS 0.20 

fXBH 0.00 

fXSP 0.75 

The influent “soluble” and slowly biodegradable concentrations are calculated using 
the influent fractions: 

L/COD mg 100

)500)(20.0(

S fS TBSBS

=

=

=

 

   

L/COD mg 310

)500)(0.020.008.010.01(

S )f-f- f-f1(X TXBHBSUPUSS

=

−−−−=

−=

 

   

L/COD mg 5.77

)310)(75.01(

X )f1(X SXSPSC

=

−=

−=

 

   

L/COD mg 5.232

)310)(75.0(

X )f(X SXSPSP

=

=

=
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L/COD mg 5.177
5.77100

XSS SCBSS

=
+=

+=

 

The soluble BOD5 can then be calculated using Eq.9 and the parameters listed below: 
f 0.20 

Y 0.666 mg COD/mg COD 

b 0.24 d-1 

k 0.40 d-1 

Note:  The parameter values for f and b are for endogenous respiration, and should 
not be confused with the corresponding terms used in the death-regeneration 
approach for modeling biomass decay. 

L/BOD mg 4.125

)e1)(5.177)(666.0)(20.01()5.177)(666.01(

)e1(SY)1( S)Y1( BOD

)5)(24.0(

t b
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−

−f

 

Similarly, the slowly degradable BOD5 can be calculated using Eq. 22. 
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In this example the active organism fraction is zero, therefore the total BOD5 is the 
sum of the BODS and the BODXSP, i.e., 

L/BOD mg 3.248
9.1224.125

BODBODBOD XSPST

=
+=

+=

 

Effluent BOD 
Knowledge of  the effluent BOD is useful for quantifying the impact of plant 
discharges on receiving water bodies, and often is of interest in terms of regulatory 
requirements and consent limits.  Currently BioWin provides information on a 
number of biodegradable components in any plant output stream (and internal 
streams).  Therefore it is a simple step to quantify both the soluble and total (soluble 
+ particulate) BOD.  In BioWin this calculation is based on differing rates of 
degradation of the different components [e.g. undegraded influent biodegradable 
material (readily and slowly biodegradable), active organism masses which exert an 
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endogenous oxygen demand and hence a BOD, etc.].  Essentially BioWin simulates 
a BOD test for the specified number of days and wastewater composition.  This 
should allow for more accurate estimation of BOD than is provided with models 
based on the BOD parameter. 

COD versus BOD as a Modeling Parameter 
The advantage of selecting COD as the parameter for quantifying the "strength" of 
organic material in the influent, as opposed to BOD or TOC, is that it provides a 
consistent basis for description of the activated sludge process.  Marais and Dold 
(1985) outlined the rationale which makes COD the appropriate parameter.  It is 
worth reviewing this rationale briefly as selection of the COD parameter is 
fundamental to the application of the models.  Briefly,  the suitability of COD is 
established by considering utilization of organic substrate.  In the process of 
metabolism the organic substrate serves two functions for the organisms as shown 
schematically in the arrow diagram below: 

   

1. A portion of the organic material is oxidized to CO2 and water, 
providing energy for maintaining the homeostatic balance for existing 
cell mass (osmotic pressure, ionic balance, membrane potential, etc.) 
and for (2) below.  The energy is provided by transferring electrons 
from the organic substrate through the electron transport chain to the 
terminal electron acceptor (oxygen in the case of an aerobic system, or 
nitrate under anoxic conditions).  Under the substrate limited conditions 
usually encountered in activated sludge systems the organisms utilize a 
relatively fixed fraction of the energy available from oxidation for the 
energy consuming processes. 

2. The remaining portion of the organic material is converted into new 
heterotrophic cell mass, utilizing energy available from process (1). 

Regarding the relative proportions allocated between (1) and (2), this is quantified by 
the ratio: 

utilized substrate
formed mass cell

YH =
 

(25)

termed the specific yield.  From theoretical considerations, under balanced growth 
conditions the specific yield, in terms of the mass of organisms produced per 
electron available for transfer in the biodegradable organic substrate, should be near 
constant.  This was confirmed by Payne (1970) who reviewed a large number of 
experimental results for both pure and mixed cultures of heterotrophic organisms.  
Therefore, if the electron donating potential of the organic substrate in the activated 
sludge system influent (consisting of a broad spectrum of compounds) is measured, it 
is possible to quantify sludge production [from YH] and oxygen demand [from (1 - 
YH)].  This observation provides the rationale for selecting the COD parameter. 

The electron donating capacity of organic material is measured in the COD test.  In 
the test each mole of oxygen (O2) accepts four electron equivalents (e- eq); therefore 
the COD is a direct measure of the electron donating potential.  The link between 
electron equivalents (COD) of the substrate, the near constant yield of organism 
mass per unit substrate COD, and the corresponding fixed oxygen requirement per 
unit substrate COD metabolized, make the COD a fundamental parameter in the 
analysis of activated sludge behavior.   
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Regarding the COD of the 
waste sludge, this may be 
measured directly by the 
COD test or may be estimated 
from the VSS measurement.  
Because cell mass has an 
approximately constant 
composition and is made up 
of an essentially fixed number 
of electron equivalents (e- eq) 
per unit mass, the COD/VSS 
ratio is near constant 
(approximately 1.48 
mgCOD/mgVSS). 

A factor which adds impetus to the selection is that mass balances can be made in 
terms of COD.  As electrons cannot be created or destroyed, in a biosystem operated 
at steady state the mass of COD entering with the influent per unit time must equal 
the sum of (1) the mass of COD leaving in the effluent, (2) the COD of the wasted 
sludge, and (3) the oxygen (or oxygen equivalent) consumed in the utilization of the 
organic material (from the oxygen utilization rate measurement); that is, a mass 
balance is possible. 

Characteristics of the COD as a measure of the "strength" of a wastewater are not 
realized by either the BOD or the TOC parameters.  The BOD measures only that 
portion of the e- eq in the substrate utilized for energy generation and excludes the 
portion of the substrate e- eq transformed into new cell mass.  Therefore BOD 
cannot be used as the basis for a mass balance.  The TOC is deficient in that the ratio 
of carbon/e- eq differs between organic compounds and therefore TOC is an 
inappropriate parameter when dealing with the mixed substrate influents to 
wastewater treatment plants. 

 
Schematic representation of the utilization of substrate by heterotrophic organisms showing 
the division between substrate oxidized for energy generation and growth of new cell mass. 

   

Note:  The user must specify influent concentrations in terms of COD; however, the 
simulator can estimate the soluble and total BOD for any input element, process unit, 
or stream.  The user may specify the time basis for the BOD calculation (5, 7, or 20 
days). 
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Settling and Solid / Liquid 
Separation Models 

Types of Models 
In BioWin there are three basic types of models used in solid / liquid separation 
elements: 

1. Point (i.e. dimensionless) 
2. Ideal (similar to point models, but with volume) 
3. Flux based 

This chapter outlines the theory behind the different model types and gives examples 
of BioWin elements that they are used in. 

Point Separation Models 
Point separation models perform a simple mass balance calculation to split the 
incoming solids into two streams.  The percentage removal specified by the user is 
based on a mass basis. 

For example, if a user specifies that a point separator has a 95% solids capture, the 
point separator reports 95% of the incoming total suspended solids mass to the 
“thickened” stream (e.g. the underflow of a point settling tank), and the remaining 
5% reports to the “clarified” stream (e.g. the overflow of a point settling tank). 

Examples of BioWin elements that use point separation models include 
Dewatering Units and Point Secondary Settlers. 

Ideal Separation Models 
Ideal solid / liquid separation models are very similar to point separation models 
except for the fact that they have volume.  The total volume of BioWin units 
employing ideal solid / liquid separation models is divided into two sub-volumes (a 
“thickened” or “sludge” volume and a “clarified” or “liquid” volume – the relative 
volume proportions are specified by the user). 

At steady state conditions, the mass coming out of the sludge volume zone will be 
the same as the mass entering it, and specifying the flow split (e.g. the underflow rate 
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for an ideal secondary settler) and the percent solids removal will completely define 
the mass balance around the unit.  

Under dynamic loading, the mass coming out of the sludge volume may not be the 
same as that coming in; however it may not fluctuate as much as that coming in 
because the sludge zone volume has an attenuating effect.  Consider the following 
mass balance equation on TSS for the sludge zone, assuming a 95% solids removal:  

OUTOUTININ CQCQ95.0V
t
C

Out Mass - In MassonAccumulati

⋅−⋅⋅=⋅
∂
∂

=
 

(1)

where C = TSS concentration (kg/m3), V = sludge zone volume (m3), Q = Flow rate 
(m3/d). 

For the steady state case, the change in concentration with respect to time is zero, so 
the left hand side of the above equation goes to zero.  Then the concentration out the 
bottom (COUT) may be obtained algebraically.  But for the dynamic case, this term 
may not necessarily be zero - it could be positive or negative depending on what is 
happening in the sludge zone, and in this case, the term involving the volume of the 
thickened sludge zone does not drop out to zero.  Therefore in a dynamic loading 
case, the volume of the sludge zone will affect the concentration coming out the 
bottom.  How much of an impact it has depends on the volume, the variability of the 
incoming load, etc. 

Examples of BioWin elements that use ideal separation models include Ideal 
Secondary Settlers, Ideal and Activated Primary Settling Tanksand Grit 
Removal Tanks. 

Note:  Grit removal elements are special cases that act only on inorganic suspended 
solids (ISS). 

Flux Based Models 
The general flux theory approach models solids settling in one dimension.  In the 
one-dimensional approach solids and liquid movement in the vertical direction are 
assumed to be dominant and horizontal movement is ignored.  The settling tank is 
divided into a number of layers in the vertical direction and a numerical technique is 
used to solve the mass balance equations in the vertical direction.  The solution to the 
mass balance equations provides the solids concentration profile in the settling tank, 
and the solids concentration in the effluent and underflow. 

When considering a one-dimensional model of a secondary settling tank, one must 
consider the behavior in three separate zones: 

   

1. The zone above the feed layer. 

2. The feed layer. 

3. The zone below the feed layer. 

This is necessary because the mass balance equations that describe a given layer 
change from zone to zone.  Above the feed layer, the bulk fluid movement (i.e. 
surface overflow rate) is upwards; therefore any solids transport associated with the 
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bulk fluid movement is upwards as well.  Below the feed layer, the bulk fluid 
movement (i.e. underflow rate) is downwards, so solids transport associated with the 
bulk fluid movement also is downwards.  At the feed layer, the solids mass loading 
of the feed must be considered, and there is both upwards and downwards bulk fluid 
movement.  [It is assumed that the feed flow is the sum of the overflow and the 
underflow, and the "flow split" occurs in this layer].  Also, the top layer in the first 
zone (i.e. overflow) and the bottom layer in the third zone (i.e. underflow) require 
special consideration.  The top layer in the first zone is unique as there is no solids 
flux into it.  The bottom layer in the third zone is unique as there only is bulk flux 
out of it.  Another requirement of one-dimensional secondary settling tank models is 
a quantitative relationship between solids concentration and settling velocity. 

BioWin offers two types of flux theory based models: 

   

1. Modified Vesilind 

2. Double Exponential 
   

Common Feature: Locate a Specified Suspended 
Solids Concentration 
A very powerful feature of both settling models is that a user can specify a 
suspended solids concentration and the model will locate and plot the height of that 
suspended solids concentration within the settler profile. 

For example, if a user has measured the concentration of the sludge blanket in a 
secondary settling tank to be 2,500 mg/L the model can locate the height of this 
concentration within its profile, and plot it with time.  This gives users a tool to track 
the approximate location of the sludge blanket. 

Modified Vesilind Secondary Settler Model 
The approach used in this model is to divide the settling tank into a number of layers 
(minimum of 5), with a solids concentration in each layer, resulting in an essentially 
one-dimensional model for sludge settling. 

The model is based essentially on standard solids flux analysis.  That is, the mass 
flux of solids out of each layer is assumed to be the sum of the gravity settling flux 
and the flux due to bulk movement (refer to the diagram below). 

Note:  Fewer layers may overestimate the mass of solids on the base (i.e. bottom 
layer) of the settling tank.  The underflow TSS concentration essentially is 
determined by the thickening factor [(QI + QR) / QR], and this will be the 
concentration in the bottom layer.  The height of the bottom layer (settler depth 
divided by the number of layers) largely determines the mass of sludge within an 
underloaded settling tank, so the layer depth should correspond to the depth of 
sludge on the base of the settling tank.  For example, to simulate the case of say a 1 
foot deep sludge layer in a 15 foot deep settling tank, set the number of layers to 15. 

For steady state calculations, BioWin uses a non-linear equation solver to determine 
the solids concentration in each layer of the settler.  A set of equations is obtained by 
generating mass balance expressions for the solids in each settler layer.  Solids 
entering the settling tank are assumed to be distributed instantaneously across the 
feed layer. 
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Solving the set of equations is not a trivial mathematical problem due to the 
exponential nature of the sludge settling velocity expression (described in more 
detail below).  Simulation problems can arise in situations where the solids loading 
rate to the settler is high (and the settler would probably fail in practice).  These 
problems are due to the fact that, under certain circumstances, the set of mass 
balance equations (one for each layer) can have multiple solutions.  If this is 
encountered during the iterative solution procedure BioWin may not be successful in 
moving away from a non-feasible solution to the correct solution. 

BULK MOVEMENT GRAVITY SETTLING

FEED LAYER

BOTTOM LAYER

TOP LAYER

LAYERS ABOVE
  FEED LAYER

LAYERS BELOW
  FEED LAYER

 
Representation of layered approach used in the Modified Vesilind settler model. 

Bulk flux terms are given by the product of the up or downflow velocity and layer 
concentration, i.e.: 

layer) feed (below X
A

Q
J

layer) feed (above X
A
Q

J

i
R

BULK

i
I

BULK

⋅=

⋅=

 (2)

where QI = plant influent flow, QR = settling tank uderflow rate, A = settling tank 
cross-sectional area, and Xi = suspended solids concentration in layer i. 

Gravity flux terms are given by the product of settling velocity and layer 
concentration, i.e.: 

ii,Si,S XVJ ⋅=  (3)
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where VS,i = settling velocity in layer i and Xi = suspended solids concentration in 
layer i. 

Sludge Settling Velocity 
The development of a model for the settling tank requires an expression for the 
settling velocity of the sludge.  In order to obtain this expression it is necessary to 
make a number of assumptions.  Firstly, zone settling (or “ hindered” settling) is 
assumed to be the main type of settling occurring in the settling tank.  That is, there 
is a distinct interface between settling particles and clarified liquid (i.e. the inter-
particle forces are sufficient for all particles in a given cross section to settle at the 
same rate regardless of particle size).  This means that the solids flux through the 
settling tank, which is given by the product of the solids concentration and the 
settling velocity, varies with depth in the settling tank. 

Sludge settling velocity is modeled according to the Vesilind equation for hindered 
settling.  The settling velocity in a given layer is given by: 

iXK
0i,S eVV −=  (4)

where V0  = maximum settling velocity (m/d), K = settling parameter (m3/kgTSS), 
and Xi = total suspended solids (TSS) concentration (kgTSS/m3) in layer i. 

The above equation can be fit to experimental data by regression to yield values for 
the settling parameters V0 and K.  A number of batch settling tests should be 
conducted to determine the zone settling velocity (VS) over a range of suspended 
solids (X) concentrations.  Referring to the diagram below, the zone settling velocity 
for a given solids concentration is determined from the slope of the first straight line 
portion of the interface height versus time plot as shown.  By taking the natural 
logarithm of both sides of the above equation, the following “linearized” expression 
is obtained: 

XKVlnVln 0S ⋅−=  (5)

A semi-log plot of ln(VS) versus X can then be used to estimate V0 and K.  The 
parameter K is given by the slope and V0 by the intercept of the line of best fit 
through the experimental data. 

A flux curve can then be generated as a continuous function using the Vesilind 
expression for settling velocity and the parameters derived from the experimental 
data (as shown).  The expression for the mass flux of solids can then be used in the 
mass balance expressions for each settler layer (the total flux being the sum of the 
gravity settling flux, as described by the Vesilind equation, and the flux due to the 
bulk movement of the liquid). 

Due to the extensive amount of experimental testing required to determine Vesilind 
model parameters, a number of correlations have been developed in order to estimate 
Vesilind model parameters from settleability measures such as  SVI, DSVI, etc.  
Extreme care should be taken in using these correlations, as their applicability may 
be limited [Bye & Dold (1998), Bye & Dold (1999)]. 
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Procedure used to obtain Vesilind settling velocity model parameters. 

Solids Resuspension and Compactability 
The Modified Vesilind settling model uses a maximum solids compactability in an 
attempt to mimic what takes place in the bottom layer of a settling tank.  As the 
solids concentration approaches the maximum solids compactability  resuspension of 
solid particles occurs.  The rate of solids resuspension is assumed to be proportional 
to the square of the difference between the solids concentration in a given layer and 
the maximum solids compactability.  The resuspension term essentially switches on 
as the solids concentration in a layer  approaches the maximum allowable.  
Increasing the solids compactability will reduce the rate of resuspension, resulting in 
fewer solids in the settling tank effluent.  The following figure illustrates the concept 
of solids resuspension. 
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delta TSS

RESUSP
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Representation of resuspension behavior in bottom layer 

Resuspension begins at solids concentration values slightly less than the maximum 
compactability XM.  Referring to the above diagram, the offset is 800 mg/L less than 
the maximum compactability.  Once the solids concentration in a layer gets above 
this offset concentration, resuspension begins.  

The resuspension velocity is proportional to the square of the difference between the 
layer solids concentration and the offset solids concentration (i.e. delta TSS in the 
above diagram).  

The resuspension velocity is then multiplied by the layer solids concentration to 
calculate the resuspension flux term.  This is done because the modified Vesilind 
settler model is flux-based and tracks the various flux terms (e.g. Vesilind, bulk, 
resuspension) that enter and leave layers.  

Settling Velocity Switching Function 
A criticism of Eq. 4 is that it over-predicts settling velocities at low concentrations.  
BioWin employs a switching function to switch off the sludge settling velocity 
expression at very low solids concentrations.  This provides a simplified method of 
modeling the poorly flocculating solids in the upper layers of the settling tank.  As 
the solids concentration approaches the settling velocity TSS switch the settling 
velocity approaches zero, and solids are carried upwards by the overflow stream 
(resulting in solids in the settling tank effluent). 

The settling velocity equation used by BioWin is: 









+

⋅= −

iS

iXK
0i,S XK

X
eVV i  (6)

where KS is the settling velocity switch, and other variables are the same as in Eq. 4.  
The switching function effect for a given combination of settling velocity parameters 
is shown in the figure below: 
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The settling velocity switch reduces the settling velocity at low concentration levels 

You can increase the suspended solids concentration at which settling velocity is 
decreased by increasing KS.  Varying the KS parameter is a possible way to vary the 
predicted effluent suspended solids. 

Avoiding Modified Vesilind Settler Model Problems 
BioWin’s steady state solution algorithm has been improved significantly, and the 
Modified Vesilind settling tank model is more robust as a result.  Occasionally users 
may encounter situations where the solver requires many iterations to move to a 
solution.  Often these problems can be addressed by increasing the maximum solids 
compactability.   

Other hints for handling settler problems are given below: 

   

1. It may be desirable to leave the settler profile window open during a  
simulation; this will allow the user to observe the movement of the 
sludge blanket throughout the simulation, and indicates when the settler 
is becoming overloaded. 

2. If the steady state solver cannot find a solution, then subsequent 
dynamic simulations should allow time for the settler to approach a 
solution (i.e. run the simulation over several sludge ages). 

3. In order to obtain an accurate solution under dynamic conditions it may 
be necessary to run the simulation over several sludge ages, until the 
starting point for the simulation reflects the actual conditions of the 
system at the start of the time period being simulated (i.e.  solids 
concentration in the bioreactor, position of sludge blanket, etc. are 
reasonably close to initial conditions of system). 
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Double Exponential Settler Model 
The Double Exponential settler model overcomes many of the difficulties that may 
be encountered with unrestricted solids flux models (e.g. the Modified Vesilind) 
under certain conditions. 

BULK MOVEMENT GRAVITY SETTLING

FEED LAYER

BOTTOM LAYER

TOP LAYER

LAYERS ABOVE
  FEED LAYER

LAYERS BELOW
  FEED LAYER

 
Representation of layered approach used in the Double Exponential settler model. 

Bulk flux terms are given by the product of the up or downflow velocity and layer 
concentration, i.e.: 
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 (7)

where QI = plant influent flow, QR = settling tank uderflow rate, A = settling tank 
cross-sectional area, and Xi = suspended solids concentration in layer i. 

An important aspect of this model is that the gravity flux out of a layer is not allowed 
to be greater than the gravity flux that can be transmitted out of the next layer.  This 
overcomes difficulties with “solids trapping” that can occur under certain loading 
conditions in unrestricted flux models like the Modified Vesilind model.  Once 
again, gravity flux terms are given by the product of settling velocity and layer 
concentration but incorporating the flux limit, i.e.: 
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( )1i1i,Sii,Si,S XV,XV minJ ++ ⋅⋅=  (8)

where VS,i = settling velocity in layer i and Xi = suspended solids concentration in 
layer i. 

Sludge Settling Velocity 
The Double Expontential settling tank model uses the settling velocity function 
proposed by Takacs et al. (1991).  The settling velocity function is applicable in 
regions of flocculent and hindered settling, and is given by: 

*
if

*
ih XK

0
XK

0i,S eVeVV −− −=  (9)

where V0  = maximum Vesilind settling velocity, Kh = hindered zone settling 
parameter, Kf = flocculent zone settling parameter, and X*i = Xi – Xmin where Xi is 
the total suspended solids concentration in layer i and Xmin is the minimum attainable 
suspended solids concentration. 

The minimum attainable suspended solids concentration in a layer (Xmin) is 
calculated as a fraction of the settling tank influent solids concentration: 

FEEDnsmin XfX ⋅=  (10)

Users may specify a maximum value for the Xmin parameter (the BioWin default for 
this parameter is 20 mg/L).  Another important user-specified parameter for the 
Double Exponential settling tank model is the maximum practical settling velocity, 
V0′.  This parameter sets the maximum gravitational settling velocity that is 
attainable by the solids.  A graphical representation of the Double Exponential 
settling velocity function is shown in the figure below [note that this figure is meant 
to be conceptual – it is not necessarily to scale (e.g. region I is disproportionately 
large in the figure)]. 
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The Double Exponential settling velocity function. 

The Double Exponential settling velocity function consists of four regions: 

   

1. In region I, the settling velocity is zero since the suspended solids 
concentration reaches the minimum attainable suspended solids 
concentration. 

2. In region II, the settling velocity increases with suspended solids 
concentration since it is strongly influenced by the flocculent nature of 
the solids – the behavior of this zone is strongly influenced by the value 
selected for Kf. 

3. In region III, settling velocity is independent of suspended solids 
concentration since it is hypothesized that solids particles have reached 
a maximum attainable size.  The settling velocity in this region is set by 
the maximum practical settling velocity, V0′. 

4. In region IV, hindered settling becomes the dominant process and the 
settling velocity function reduces to the Vesilind function.  The 
behavior of this zone is strongly influenced by the parameter Kh. 
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Modeling of pH in BioWin 

Importance of pH Modeling 
It has been recognized from the early stages of wastewater process modeling that pH 
is an important factor in simulating the performance of biological wastewater 
treatment processes, including activated sludge and anaerobic digestion.  The pH 
impacts the species distribution of the weak acid systems (carbonate, ammonia, 
phosphate, acetate, propionate, etc.) present in the process.  This in turn dictates the 
rate of many of the biological and physico-chemical phenomena occurring in these 
systems.  For example, (1) biological activity, that can be severely limited outside an 
optimal pH range, (2) chemical precipitation reactions when metal salts such as alum 
or ferric chloride are added for chemical P removal, (3) spontaneous precipitation of 
magnesium and calcium phosphates (struvite, HDP, HAP), and (4) stripping of 
ammonia at high pH.  It is difficult to model pH because the underlying components 
and reactions are so fast and complex.  The approach to date in activated sludge 
models has been to track alkalinity changes instead, and use that as a pseudo 
indicator of potential pH instability problems. This approach assumes that the pH 
remains approximately constant and is in a region where it does not impact 
biological activity.  Another disadvantage of using alkalinity is that it offers no 
means for modeling physico-chemical phenomena such as precipitation.  In systems 
with significant volatile fatty acid concentrations, such as acid fermenters or 
digesters or in systems where significant gas transfer may occur, the predicted 
alkalinity may not be a good indicator of steady pH conditions.  Calculation of the 
pH must consider the concentrations of strong acids and bases, the dissociation states 
of the weak acid, carbonate and phosphate systems, chemical precipitation reactions, 
and potential stripping of components involved in the acid-base systems such as 
ammonia and carbon dioxide.  All of these processes can be described using a kinetic 
approach (Musvoto et al., 2000), but the rates of many of the reactions involved 
typically are four to twenty orders of magnitude larger than typical biological rates.  
As a result, calculation of the pH using a kinetic-based model will significantly 
reduce simulation speed.  BioWin uses a mixed kinetic/equilibrium based approach 
to minimize the negative impact on simulations speed.  This approach is applicable 
across a wide range of biological treatment process models (i.e. ASM-series for 
activated sludge, ADM1 for anaerobic digesters, etc.). 

Model Description 
The pH model is based on the following elements: 
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1. Equilibrium modeling of the phosphate, carbonate, ammonium, volatile 
fatty acid systems and typical strong ions in wastewater (Mg2+, Ca2+, 
NO3

-, etc.).  

2. Incorporation of activity coefficients based on the ionic strength of the 
solution. 

3. Gas-liquid transfer of ammonia and carbon dioxide.  

4. Biological activity affecting compounds included in the model (e.g. 
CO2 and many others) 

Equilibrium expressions for the acid-base systems included in the model are shown 
in Table 1.  These equlibria represent the predominant acid-base systems occurring 
in wastewater treatment systems. 

All of the equilibrium expressions in Table 1 are expressed in terms of active 
concentrations rather than molar concentrations.  The interaction of ions in solution 
causes a deviation from ideal behaviour whereby the activity of the ions in 
equilibrium reactions is less than expected from the molar concentrations.  To 
account for this behaviour, the molar concentration of the ions is reduced by a factor 
known as the activity coefficient.  The reduced ionic concentration is called the 
active concentration, as determined in the following expression: 

[ ]iii Xf)X( =  (1)

where 

)X( i  = active concentration of Xi 

]X[ i  = molar concentration of ion Xi 

if  = activity coefficient of ion Xi 

Table 1:  Acid-base equilibrium expressions included in the general pH model 

System Equilibrium Expression 
Equilibrium 

Constant 
@20oC 

Water ( )( ) wKOHH =−+
 1510867.6 −×  

Carbonic acid ( )( )
( ) 1iCO

*
32

3
3

K
COH

HCOH
=

−+

 
71014.4 −×  

Carbonic acid ( )( )
( ) 2iCO

3

2
3

3
K

HCO

COH
=

−

−+

 
1110201.4 −×  

Acetic acid ( )( )
( )

iAc

3

3 K
COOHCH

COOCHH
=

−+

 
510754.1 −×  
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Propionic acid ( )( )
( )

Pri

23

23 K
COOHCHCH

COOCHCHH
=

−+

 
510318.1 −×  

Phosphoric acid ( )( )
( ) 1iPO

43

42
4

K
POH

POHH
=

−+

 310452.7 −×  

Phosphoric acid ( )( )
( ) 2iPO

42

2
4

4
K

POH

HPOH
=

−

−+

 
810103.6 −×  

Phosphoric acid ( )( )
( ) 3iPO

2
4

3
4

4
K

HPO

POH
=

−

−+

 
1310484.9 −×  

Ammonium ( )( )

( ) 3iNH

4

3 K
NH

NHH
=

+

+

 1010966.3 −×  

Activity coefficients are estimated in the BioWin pH model using the Davies 
equation, which is a simplification of the extended Debye-Hückel law. The activity 
coefficient (fi) for each ion i in solution is determined as follows (Loewenthal and 
Marais, 1976): 














µ−

µ+

µ
⋅⋅−= 2.0

1
Z5.0flog 2

ii  (2)

where 

iZ  = ionic charge of ion Xi 

µ  = ionic strength of solution 

Note that because the deviation from ideal solution behaviour is caused by 
electrostatic attraction between ions, the activity coefficient of a neutral species in 
solution (i.e. H2CO3

* ) is 1. 

The expression for ionic strength is as follows: 

[ ]∑
=

=µ
n

1i

2
ii ZX5.0  (3) 

where 

n  = the number of ionic species in solution 
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Since the overall charge of the solution must be neutral, the sum of the 
concentrations of the positively charged ions in solution must equal the sum of the 
negatively charged ion concentrations.  This charge balance relationship is expressed 
for the pH model as follows:  

[ ] [ ] [ ] [ ] [ ] [ ] [ ] [ ]
[ ] [ ] [ ] [ ] [ ] [ ]
[ ] [ ] [ ] [ ]−−−−

−−−−−−

+++++++

+++

++++++

=+++++++

AnionsNOCOOCHCHCOOCH

CO2HCOPO3HPO2POHOH

CationsMeHPOPOMeH2MeVCa2Mg2NHH

3233

2
33

3
4

2
442

4
2
42Me

22
4

 (4) 

In addition to the ionic species shown in Table 1, there are a number of other ions 
likely to occur in significant concentrations in wastewater treatment systems, and 
these have been included in the charge balance.  Calcium (Ca2+) and Magnesium 
(Mg2+) will be present in the natural source waters and general variables have also 
been added for cations (Cations+) and anions (Anions-) which can be used to account 
for additional species not included separately (for example, modeling addition of 
strong acids or bases - Na+, Cl-, etc.).  In addition to naturally occurring ions such as 
Mg and Ca the charge balance also includes a general term for metal species (Me) 
with charge VMe, which have been included to allow for modeling of chemical 
phosphorus removal.  (See the Ferric or Alum Precipitation section of the 
Process Model Formulation chapter). 

BioWin state variables track the total species concentrations for all the appropriate 
species thus the set of equations described by equations (1) through (4), the 
dissociation expressions in Table 1 and individual component material balances may 
be solved simultaneously to determine the individual ion concentrations, pH and 
ionic strength.  This allows material balances to be calculated for each of the total 
species concentrations.  For example, a material balance for total dissolved inorganic 
carbon in a reaction vessel is written as follows: 

)actionReNet()StrippingCO(SQSQ
dt

dM
2o,t2COo,Li,t2COi,L

L,t2CO +−−=  (5) 

where 

i,Subscript  = influent 

o,Subscript  = effluent 

L,t2COM  = mass of dissolved total inorganic carbon 

t2COS  = total dissolved inorganic carbon concentration 

LQ  = liquid flowrate 

actionReNet  = biological reaction rate 

   

[ ] L
*
32sat,2COGT2CO,L2 V)COHS(AkStrippingCO ⋅−⋅⋅−=  (6) 

where 

Lk  = liquid phase mass transfer coefficient 
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GTA  = specific interfacial area for gas transfer 

sat2COS  = saturation dissolved CO2 concentration 

[ ]*
32 COH = undissociated carbonic acid concentration 

The Net Production by Reaction term accounts for biological generation (e.g. 
from oxidation of organics by heteretrophs) and consumption (e.g. by autotrophs).  
The saturation concentration (SCO2sat) in the “Gas Stripping” term is calculated from 
a Henry’s law relationship at the system temperature and pressure.  A simplification 
of the model assumes that the gas phase concentration of the component is constant 
(i.e. atmospheric concentration for CO2, zero for ammonia), and therefore the 
saturation concentration of the dissolved component is constant for a given 
temperature.  However, for many systems (e.g., anaerobic digesters), a material 
balance is also required for the gas phase.  For the carbon dioxide component, the 
gas phase material balance is written as follows: 

)StrippingCO(GQGQ
dt

dM
2o,2COo,Gi,2COi,G

G,2CO
+−=  

where 

G,2COM = mass of CO2 in the gas phase 

GQ  = gas flowrate 

2COG  = gas phase carbon dioxide concentration 

Similar material balances (gas and liquid phase) are required for the total ammonia 
concentration.  For the other ionic species in solution (i.e. volatile acids, phosphate, 
etc.), there is no stripping and thus material balances for these components are 
written only for the liquid phase. 

Alkalinity determination 
Figure 1 shows a logarithmic-concentration versus pH diagram for the carbonate 
system.  This diagram was generated with the BioWin pH model by simulating a 
system with a total dissolved inorganic carbon concentration of 10 mmol/L, and 
successively adding an increasing amount of anion to the system to change the pH.  
The model determines alkalinity by noting that at the H2CO3* equivalence point [H+] 
= [HCO3

-].  This additional equation can then be used to solve the carbonate 
equilibrium explicitly to determine the [HCO3

-] concentration at the equivalence 
point (and consequently the pH).  From this a charge balance (at the equivalence 
point) can be used to calculate the amount of strong acid that would be required to 
move the solution from its current state to the H2CO3* equivalence point.  As a 
result, the impact of all of the ionic species included in the general pH model is 
considered in the calculation of alkalinity.  Note that the alkalinity is not explicitly 
related to the stoichiometry of the biological processes in the system when estimated 
with the pH model.  Instead, it is related to concentrations of ionic species at the 
current system state. 
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Figure 1:  Logarithmic concentration versus pH diagram for the carbonate system as 
generated by the general pH model 

Specifying pH and Alkalinity 
In certain influent elements BioWin allows the user to specify the pH and alkalinity.  
Since both of these values are “calculated” from the current system state, it is 
necessary for BioWin to adjust the certain state variables to achieve the desired pH 
and alkalinity. In this case BioWin adjusts the total carbon dioxide, the anions and 
the cations until it achieves the desired pH and alkalinity.  Note that it is possible to 
specify values that are not able to be achieved and BioWin will not warn you of the 
problem. 

Biological inhibition due to pH 
BioWin uses the calculated pH to determine the amount biological inhibition 
according to the following equation:  

( )

( ) ( )pHpHpHpH

pHpH

LowLimitHighLimit

HighLimititLow

Inhibition
−−

−

++











+

=
10101

1021 2
lim

 

(7) 

where 

pH  = Calculated pH 

LowLimitpH  = Low pH limit for a particular organism 

HighLimitpH  = High pH limit for a particular organism 
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The user may select to turn of pH inhibition (essentially setting inhibition to 1.0) in 
all elements except the anaerobic digester element and the activated primary element.  
These units require a pH, but the user can choose to specify the pH that will be used 
in that element (i.e. either the calculated value, or a user specified value). 

Note: Turning of pH inhibition (or specifying a pH in an element) does not stop 
BioWin from calculating the pH. 

Examples 
The following section contains a number of examples that highlight model 
performance and behavior. 

Titration of Acids and Bases 
Verification of the pH model included the simulation of various titrations of acids 
and bases in clean water.  The simulation configuration (Figure 2) consisted of a 
variable volume reactor to represent a titration vessel, and an influent stream with a 
constant flow to represent the standard solution.  The initial volume of the reactor 
was 50 L.  The flowrate of the standard solution was 1 L/min.  Table 2 summarizes 
simulated experimental conditions that represent the following types of titrations: 

   

• Strong acid titrated with a strong base standard solution; 

• Weak acid titrated with a strong base standard; 

• Weak base titrated with a strong acid standard; 

• Weak acid titrated with a weak base standard. 

The table shows the concentrations of the reagents, and the components and 
concentrations used in the model to reflect those conditions.  Note that in BioWin, 
the concentrations of reagents that are involved in the biological processes of the 
model (i.e. acetic acid and ammonia) are expressed in mg/L units.  The 
concentrations of reagents that are primarily part of the acid base system (i.e. cations 
and anions), are expressed in units of meq/L. 

Figures 3 to 6 show the results of the titration simulations compared to data from a 
standard chemistry text (Mortimer, 1975).  These results verify that the acid-base 
equilibrium chemistry is correctly formulated in the pH model.  The slight 
discrepancies between the actual and observed titration curves (for example, the 
equivalence point in Figure 4) are due to the incorporation of activity coefficients 
and the use of slightly different equilibrium constants in the general pH model. 
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Figure 2:  BioWin configuration for the simulation of various acid and base titration 
experiments 

   
Table 2:  Summary of simulated titration experiments  

Titration 
Vessel 

Reagent 

Standard 
Reagent 

Titration Vessel 
Initial 

Concentrations 

Standard Solution 
Concentrations 

0.10 N HCl 0.10 N NaOH [Anions-] = 100 meq/L [Cations] = 100 meq/L 

0.10 N CH3COOH 0.10 N NaOH [CH3COOH] = 6000 mg/L [Cations] = 100 meq/L 

0.10 N NH3 0.10 N HCl [NH3] = 1400 mg/L [Anions] = 100 meq/L 

0.10 N CH3COOH 0.10 N NH3 [CH3COOH] = 6000 mg/L [NH3] = 1400 mg/L 
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Figure 3:  Results from simulation of 0.10 N HCL titrated with 0.10 N NaOH. 

 
Figure 4:  Results from simulation of 0.10 N CH3COOH titrated with 0.10 N NaOH. 
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Figure 5:  Results from simulation of 0.10 N NH3 titrated with 0.10 N HCL. 

 
Figure 6:  Results from simulation of 0.10 N CH3COOH titrated with 0.10 N NH3. 

Considerations 
A pH model is essential for reliable simulation of many important wastewater 
treatment operations, including: 

   

1. Gas phase modeling which is important for modeling anaerobic 
digestion and precipitation processes.  Calculation of gas transfer rates 
requires knowledge of the species ionization states and consequently 
the pH of the system. 

2. Inhibition of biological activity at low and high pH. 
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3. Equilibrium-based, pH dependent modeling of aluminum and ferric 
dosing for phosphorus precipitation, including hydroxide sludge 
formation. 

4. Kinetic-based, pH dependent modeling of the spontaneous precipitation 
of struvite and calcium phosphates.  Accurate prediction of struvite 
precipitation also requires modeling of magnesium concentrations, both 
the soluble magnesium and that stored in organisms. 
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Gas-Liquid Mass Transfer 

Introduction to Gas-Liquid Mass Transfer 
Supply of oxygen constitutes a major operating cost for biological wastewater 
treatment systems.  Emphasis on energy conservation has highlighted the need to 
develop effective methods for design and operation of aeration systems.  Oxygen 
demand in activated sludge reactors varies with time, necessitating a varying oxygen 
supply rate to maintain the desired dissolved oxygen (DO) concentration.   

In diffused air systems bubbles are distributed from diffusers at the base of the 
reactor.  Mass transfer occurs between the rising bubbles and the mixed liquor.  The 
transfer of oxygen from the gas to the liquid is required to supply the oxygen 
requirements for the biological process.  A number of equipment and operational 
parameters interact to influence the efficiency and rate of transfer of oxygen; inter 
alia, diffuser pore size and density, and air flow rate.  These parameters determine 
factors such as bubble size, the rate of bubble rise, the bubble residence time in the 
reactor, the fractional gas hold-up, the interfacial surface area available for mass 
transfer, the change in oxygen partial pressure in the rising bubbles and the degree of 
turbulence.  Conditions in the mixed liquor also impact on the transfer; for example, 
temperature, ionic strength, presence of surface-active compounds, and solids 
concentration.  Quantifying the impact of all these factors on the overall mass 
transfer behavior is very difficult. 

This section explains briefly the gas-liquid mass transfer model used in BioWin.  
The discussion is structured in five parts: 

Mass Transfer Theory: A number of theoretical approaches for quantifying mass 
transfer have been proposed.  Researchers have used these theories as the basis for 
suggesting correlations for the design of aeration systems.  These theories are 
reviewed to highlight the assumptions required by each approach. 

BioWin Model for Mass Transfer:This section will provide details on the 
modeling approach used in BioWin.   

Modeling Fine Pore Diffuser Performance:This section describes parameters 
available in BioWin to match fine pore diffuser performance. 

Modeling Coarse Bubble Diffuser Performance:This section describes the 
parameters available in BioWin to match coarse bubble aeration performance.  

Basic Parameters and Relationships:This section defines a number of 
commonly used terms and their formulation.  The emphasis in this section is on 
oxygen mass transfer. 

Conclusion:This section provides an example illustrating the differences between 
the methods used in BioWin and more traditional approaches. 
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Mass Transfer Theory 
A number of theories have been proposed to explain the phenomenon of mass 
transfer in gas-liquid systems.  These theories divide into two groups, describing the 
behavior under either laminar or turbulent flow conditions.  Under laminar flow 
conditions, the mass transfer coefficient may be calculated directly since molecular 
diffusion prevails and the mathematics describing laminar flow and molecular 
diffusion are well defined.  However, most practical applications of mass transfer 
involve turbulent flow where the flow regime is not well defined, and turbulent and 
molecular diffusion interact to determine mass transfer behavior.  In bubble aeration 
systems such as those encountered in wastewater treatment applications turbulent 
flow conditions generally prevail.   

Mass Transfer Theories Under Turbulent Flow 
Conditions 
A number of theories have been proposed to describe mass transfer behavior under 
turbulent flow conditions.  The principles of the more commonly used theories are 
discussed briefly below.  Although there is some degree of overlap the theories 
generally fall into two major categories: those based on a rigid interface and those 
based on some form of surface renewal at the gas-liquid interface.   

Rigid Interface Theories 
Theories based on a rigid interface were the first to be proposed for modeling mass 
transfer behavior.  These are conceptually similar to theories describing conductive 
heat transfer, and are based on the film theory of Lewis & Whitman (1924).  In this 
approach it is proposed that the transfer process may be represented by molecular 
diffusion across a thin, static liquid film at the interfacial surface.  The driving force 
for mass transfer is the concentration gradient between the interface and the outer 
edge of the thin liquid film (Figure 1).  Using this representation, the liquid phase 
mass transfer coefficient, kL, may be found from molecular diffusion theory 
(knowing the diffusivity) provided the effective film thickness can be determined.  
The effective film thickness is commonly considered to be a function of the flow 
conditions only.  These models consequently predict that kL depends directly on the 
molecular diffusivity of the solute D.  However experimental data has refuted this 
prediction.  For example, Treybal (1981) reported that kL is proportional to Db where 
the exponent b varies from close to zero to 0.9. 

The primary reason for the inability of rigid interface models to provide acceptable 
estimates of mass transfer coefficients is that there is movement of the liquid at the 
interface.  Therefore the steady state situation depicted in (Figure 1) is not realistic 
and an alternate means for estimating the mass transfer coefficients is necessary.  
Nevertheless, mass transfer coefficients are still commonly called film transfer 
coefficients due to their historical origins in film theory.   
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Figure1 : Schematic representation of film theory for mass transfer 

Surface Renewal/Penetration Theories 
The inability of rigid film theory to accurately predict mass transfer coefficients 
resulted in the proposal of a number of theories which incorporate some degree of 
unsteady state transfer.  The most common of these theories are those which are 
based on the concept of surface renewal, where it is assumed that there is a continual 
interchange of liquid elements in contact with the gas phase.  Theories based on the 
surface renewal concept, or theories combining rigid interface theory with surface 
renewal theory, have been widely accepted (Prasher & Wills, 1973).  Perhaps the 
first surface renewal/penetration theory was proposed by Higbie (1935).  Higbie's 
penetration theory has been used by a number of authors; for example, Calderbank 
(1959); Calderbank & Moo-Young (1961); Meijboom & Vogtlander (1973); Akita & 
Yoshida (1974); Kiode et al. (1976); and Popel & Wagner (1991).  Modified surface 
renewal/penetration models have subsequently been presented and used by a number 
of authors (including Danckwerts 1951; Dobbins 1956; Marchello & Toor, 1963; 
Harriot, 1962; Sano et al. 1974; Hughmark, 1967; Treybal, 1981).  Most currently 
accepted correlations for mass transfer parameters make use of one or more of these 
theories.   

The mass transfer theories presented above are useful in determining the relationship 
between the mass transfer coefficient and other parameters involved in transfer.  
However they do not, in general, provide a direct means of predicting the transfer 
coefficient because they require the evaluation, or estimation of one or more of the 
hydrodynamic parameters in the model (exposure time, surface renewal rate, film 
thickness, or eddy depth).  Evaluation of the hydrodynamic parameters is most often 
achieved through analysis of experimental mass transfer data (Prasher & Wills, 
1973).   
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BioWin Model for Mass Transfer 
The mass transfer theories proposed suggest several possible mechanisms controlling 
the phenomenon of mass transfer in bubble aerated aqueous systems.  Determination 
of which mechanism most closely represents the actual transfer process must be 
based on experimental observations.  Since direct measurement of the liquid phase 
mass transfer coefficient is not usually possible, an average liquid phase mass 
transfer coefficient is generally inferred from experimental determinations of the 
overall mass transfer coefficient.   

The overall mass transfer coefficient, kLaL, may be determined from a mass balance 
on the experimental data.  Simultaneous mass balances for a component should be 
conducted on both the gas and liquid phases.  This is necessary to account for the 
depletion of oxygen in the bubbles and mass transfer of other solutes between the 
liquid and gas phases (e.g. carbon dioxide).  In general, to simplify the calculation 
procedure, certain assumptions are made regarding factors such as those mentioned 
above, as well as other factors such as the mixing conditions in both phases.  
Material balances can be written for each of the species concentrations (with gas 
phase interactions) by assuming that: 

   

1. The gas phase in the reactor is completely mixed – that is the 
concentration of the components in the bubbles is the same for all 
bubbles and uniform within each bubble.  [A similar, but more 
complicated model could be developed assuming plug flow of the gas 
through the liquid in the control volume.]  

2. The liquid phase is completely mixed – that is the liquid phase 
concentrations are uniform through out the control volume.  

3. The gas hold up is constant. 

These material balances can be expressed as follows: 

For the liquid phase: 

[ ] ( )[ ] jLjjjLLj
in
j

inj RxVCCakFCQCQ
dt

dM
UNTT

T +⋅−⋅⋅+⋅−⋅= ∞ )( ,
*α

 
(1) 

For the gas phase: 

[ ] ( )[ ]LjjjLLj
in
j

inj VCCakFcqcq
dt

dm
UN

⋅−⋅⋅−⋅−⋅= ∞ )( ,
*α

 
(2) 

where 

Tj
M

 
= Mass of component j (total of all ionization states) in the 
liquid phase 

inQ  
= Liquid flow into the control volume 

Q  
= Liquid flow out of the control volume 

in
jT

C
 

= Influent liquid concentration of component j (total of all 
ionization states) 

Tj
C

 
= Effluent liquid concentration of component j (total of all 
ionization states) 

( ) jLLak
 

= Overall liquid phase mass transfer coefficient for component j 
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( )
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= Ratio of process water to clean water both for a new, clean 
diffuser 

( )
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 timeService

LL

LL
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= Ratio of process water  after a given time in service to process 
water  for a new clean diffuser 

jC ,
*
∞  

= Saturated concentration of component j at the gas/liquid 
interface 

UNjC
 

= Bulk liquid concentration of unionized component j 

LV  
= Volume of the liquid phase 

jRx
 

= Net production of component j by reaction 

jm
 

= Mass of component j in the gas phase 

inq  
= Gas flow into the control volume 

q  = Gas flow out of the control volume 

in
jc

 
= Influent gas concentration of component j 

jc
 

= Effluent gas concentration of component j 

The “Net Production by Reaction” term accounts for biological generation and 
consumption of the component of interest.   

Note : A simplification of the model assumes that the gas phase concentration of the 
component is constant, and therefore the saturation concentration of the dissolved 
component is constant for a given temperature.  In this case a gas phase material 
balance is not required however, for many systems (e.g., anaerobic digesters), a 
material balance is also required for the gas phase.  In BioWin the user has the option 
to decide whether or not to include a gas phase material balance for bioreactor (for 
digesters a gas phase material balance is always required).  If the user elects to omit 
the gas phase material balance then BioWin will use the “off-gas” concentrations 
specified by the user on the “Aeration” parameters tab.  For Surface aerators, 
BioWin uses the “Supply gas” concentrations to determine the saturation 
concentration. 

Application of the model described above requires a method for determining the 
saturation concentration, and the overall mass transfer coefficient, for each species 
subject to gas transfer. 

Determination of the Steady State Saturation 
Concentration at Field Conditions 
The required saturation concentration at field conditions may be estimated using a 
Henry’s law expression of the form: 

j

j
j H

p
C =*

 
(3) 

where 
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jp
 

 = Partial pressure of component j 

jH
 

 = Henry’s law constant 

The Henry’s law constant is a function of the temperature.  In BioWin the partial 
pressure is calculated, at 1 atmosphere, from the dry mole fraction of the solute in the 
gas phase (corrected for humidity) and the temperature.   

Note: If the gas phase is not modelled then BioWin uses off-gas concentrations 
specified to calculate the saturated concentration, except in surface aerated vessel in 
which BioWin uses the supply gas concentrations. 

The impact of diffuser submergence on pressure is calculated from: 
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where 

in situP  
= Average pressure in the liquid phase 

StdP  
= Standard atmospheric pressure 

FieldP  
= Atmospheric pressure at the liquid surface at field conditions 

v
waterP  

= Saturated water vapour pressure at field liquid temperature 

waterρ  
= Density of water at field liquid temperature 

ed  
= Fractional equivalent saturation depth 

g  = Gravitational acceleration constant 

The saturated vapour pressure of water at temperature T°C can be obtained from 
tables, or estimated (for T > 0) using the following correlation: 

( )Tv
waterP 21.058297460.73402303 ⋅=  (5) 

Note: For reactors with surface aeration the diffuser submergence term, evaluates to 
zero and the correction reduces to a field pressure correction only. 

The steady state dissolved component concentration may now be determined from: 

j
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Determination of the Overall Mass Transfer 
Coefficient at Field Conditions 
The most appropriate method for estimating the overall mass transfer coefficient 
depends on the aeration method. 

Determination of the Overall Transfer Coefficient for 
Oxygen in Surface Aerated Vessels 
In systems aerated using a surface aeration device BioWin allows the user to enter 
the “Device Standard oxygen transfer rate” (mass transfer rate per unit power input 
at standard conditions).  By specifying this value the user is essentially specifying 
the overall mass transfer coefficient for the device in clean water.  BioWin uses the 
entered value to determine the overall mass transfer coefficient for surface aerators. 

( )

( ) *
,

*
,

Std
OxygenLL

StdOxygenLL

C
RSOTak

or

Cak
RSOT

∞

∞

′
⋅Ψ=

Ψ

⋅
=′

 

(7) 

where 
*

,StdC∞  
= Steady state dissolved oxygen concentration at 20°C and 1 atmosphere and the 
supply gas oxygen concentration (dry basis) 

Ψ  
= Power input 

Determination of the Overall Transfer Coefficient for 
Oxygen in Diffused Aeration Systems 
Research has shown that the oxygen mass transfer coefficient, correlates well with 
the superficial gas velocity in diffused air systems.  In BioWin the oxygen value is 
estimated using a correlation of the form: 

( ) Y
SGOxygenLL UCak ⋅=

 
(8) 

where 

 tankof area sectional Cross

in

SG
qU =

 

= Superficial gas velocity 

C, Y = Correlation parameters 

Selection of the correlation parameters C and Y depends on the type and are 
discussed in more detail in the Modeling Fine Pore Diffuser Performancesection. 

Note: Correlation parameters for the mass transfer coefficient, kLaL, in BioWin are 
included in the model parameter editor on the Diffuser tab.  This tab can be 
accessed by clicking the Model Parameters button on the Operation tab of an 
aerated bioreactor element. 
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Determination of the Overall Transfer Coefficient for Other 
Components 
There is little information about the overall mass transfer coefficient for other 
components (NH3, CO2, etc) in wastewater treatment processes; consequently 
BioWin uses the overall mass transfer coefficient determined for oxygen to calculate 
the overall mass transfer coefficient of the other components.  By noting that:  
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where 

iLk ,  
= Liquid phase mass transfer coefficient for component j 

L

interface Gas

V
AaL =

 

= Specific interfacial gas transfer area 

BioWin allows the user to enter liquid phase mass transfer coefficient for all 
components except oxygen (which is assumed to be 12.96 m d-1 for the purpose of 
this calculation).   

Modeling Fine Pore Diffuser Performance 
This section describes the use of the BioWin diffused air correlation to model the 
performance of different fine bubble diffusers.  In the section Determination of the 
Overall Transfer Coefficient for Oxygen in Diffused Aeration Systems the following 
correlation was introduced: 

( ) Y
SGOxygenLL UCak ⋅=

 
An example of a fit using this correlation, to full-scale experimental data for 9 inch 
ceramic domes is shown in Figure 2. 
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Figure 2 : Overall oxygen mass transfer coefficient as a function of superficial gas velocity at 
a diffuser density of 25%.   

The figure demonstrates that the correlation can accurately predict the observed data.  
Manufacturers generally provide diffuser performance data in the form of a set of 
curves for a range of diffuser densities showing SOTE/depth (%/m or %/ft) versus 
air flow rate per diffuser.  Typically, for fine bubble systems the curves start in the 
region of 8%/m (2.5%/ft) for low air flow rates, decrease with increasing air flow 
rate, and level off at higher air flows.  An example is shown in Figure 3. 

 
Figure 3 : Impact of air flow per diffuser on standard oxygen transfer efficiency 

These data reflect the change in the mass transfer coefficient, with increasing air 
flow rate and diffuser density since SOTE is a function of the mass transfer 
coefficient.   

Impact of Diffuser Density 
The overall oxygen mass transfer coefficient for a given air flow per diffuser 
obviously increases with increasing diffuser density because there is a greater total 
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air flow.  However, Figure 4 shows that the increase is not proportional to the 
increase in diffuser density.   

 
Figure 4 : Oxygen mass transfer coefficient versus air flow per diffuser for a range of diffuser 
densities. 

In effect, the parameter C in Eq. 8 increases with diffuser density while Y is fixed for 
a specific diffuser type.  Analysis of data for a number of different diffuser types and 
sizes showed that the parameter C in Eq. 8 can be related to the diffuser density as 
follows (see Figure 5): Relationship of correlation parameter C to diffuser density.)  

2
25.0

1 % KDDKC +⋅=  (10) 

where 

K1 and K2  
= Correlation parameters with the following default values in BioWin  
K1 = 2.5656       K2 = 0.0432 

DD% 
= Percentage diffuser density see Formulation of diffuser density, 
DD% 

Note: Correlation parameters for the mass transfer coefficient, kLaL, in BioWin are 
included in the model parameter editor on the Diffuser tab.  This tab can be 
accessed by clicking the Model Parameters  button on the Operation tab of an 
aerated bioreactor element. 

The exponent parameter value in equation was determined empirically.  However, 
there may be some underlying theoretical basis for the value of 0.25.  A theoretical 
analysis of aerated systems with separate mixing by Kawase and Moo-Young (1990) 
indicated that the C parameter value should be related to the power dissipation rate 
raised to the 0.25 power.  In fine bubble diffuser systems power dissipation rate 
should be related to diffuser density for a given air flow per diffuser.   



 

 Gas-Liquid Mass Transfer  •  649 

 
Figure 5 : Relationship of correlation parameter C to diffuser density.   

Figure 6 illustrates the result of using Eq. 10 to determine C in Eq. 8.  The figure 
demonstrates that a single parameter set can be used to predict SOTE (%/m) with 
changing air flow per diffuser and diffuser density (4 and 25%]. 

 
Figure 6 : Predictions of SOTE (% per unit depth) versus air flow rate per diffuser for two 
diffuser densities [ATAD = 100/DD%]. 

Note: An important consideration in the design of diffused air systems is that the 
overall mass transfer coefficient changes with changing air flow rate; that is, kLaL is 
not “constant”.  Under dynamic loading conditions, over periods when the oxygen 
demand is high, and a higher air flow is required, there is a drop-off in transfer 
efficiency.  This is an important factor when determining peak blower air delivery 
requirements.   

BioWin allows the user to set up plots for bioreactors showing SOTE/depth (%/m or 
%/ft) versus air flow rate per diffuser [An example system including an SOTE plot 
can be downloaded from the EnviroSim Web site (www.envirosim.com)].  The chart 
is shown below.  SOTE data are plotted for the diffuser density of the bioreactor in 
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question, and for four other user-selected diffuser densities.  The example includes 
experimental data for a number of diffuser types].  The plot can be compared to 
manufacturer data, and used as a basis for selecting appropriate parameters (K1 and 
K2) for a particular diffuser type.  Alternatively users can contact EnviroSim to 
obtain a spreadsheet to assist in parameter selection. 

Bioreactor SOTE (%) at coverage of    20.00%
Bioreactor SOTE (%) at coverage of    15.00%
Bioreactor SOTE (%) at coverage of    10.00%
Bioreactor SOTE (%)
Bioreactor SOTE (%) at coverage of     5.00%
4.6m - 240mm Ceramic discs 7.5% coverage
4.6m - 240mm Ceramic discs 11.8% coverage
4.6m - 240mm Ceramic discs 15% coverage
4.6m - 220mm Ceramic discs 6.1 to 6.4% coverage
4.6m - 220mm Ceramic discs 7.0 to 7.8% coverage
4.6m - 220mm Ceramic discs 8.8 to 10.3% coverage
4.6m - 220mm Ceramic discs 12.1 to 12.9% coverage
4.6m - 220mm Ceramic discs 16.5 to 21.7% coverage
4.6m - 180mm Ceramic domes 4.8% coverage
4.6m - 180mm Ceramic domes 6.1 to 6.4% coverage
4.6m - 180mm Ceramic domes 8.1 to 8.4% coverage
4.6m - 180mm Ceramic domes 10.7 to 12.1% coverage
4.6m - 180mm Ceramic domes 17.8% coverage
4.6m - Ceramic plates
4.6m - Ceramic discs
4.6m - Ceramic domes
4.6m - Porous plastic discs
4.6m - Perforated membrane discs
4.6m - Rigid porous plastic tubes (Grid)
4.6m - Rigid porous plastic tubes (Dual spiral)
4.6m - Rigid porous plastic tubes (Single spiral)
4.6m - Non-rigid porous plastic tubes (Grid)
4.6m - Non-rigid porous plastic tubes (Single spiral)
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Figure 7 : BioWin SOTE plot to assist with correlation parameter calibration  

Modeling Coarse Bubble Diffuser Performance 
In general the performance of coarse bubble diffuser systems is very application 
specific and the concept of diffuser density and superficial gas velocity are not as 
useful as in fine bubble systems.  Nevertheless, the BioWin correlation Eq. 8  can 
usually be used to adequately predict performance.  For coarse bubble systems the 
impact of increasing superficial gas velocity is usually much less and consequently 
the correlation between superficial gas velocity and overall mass transfer coefficient 
is almost linear (the Y parameter approaches 1.0).  The parameters K1 and K2 can be 
used to adjust the slope of the curve appropriately (generally K1 is a small number 
reflecting the reduced impact of diffuser density). 

Basic Parameters and Relationships 
There are a number of parameters used to assist in describing and analysing the mass 
transfer behavior of a system that warrant definition or further discussion.   
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Formulation for SOTR 
Standard Oxygen Transfer Rate (SOTR) is defined as the mass rate at which oxygen 
is transferred to clean water at 20°C and 1 atm surface pressure.  In BioWin this is 
calculated as: 

( ) LStdatmOxygenLL VCaKSOTR ⋅⋅Ω′⋅= ∞
*

,
20

1
20

 
(11) 

where 
*

,StdC∞  
= Steady state dissolved oxygen concentration at 20°C and 1 atmosphere and 
an oxygen mole fraction of 0.209 (dry basis). 

   

Formulation of SOTE 
The efficiency of aeration equipment usually is quantified in terms of the mass of 
oxygen transferred per mass of oxygen input in clean water tests (Standard Oxygen 
Transfer Efficiency, SOTE).  Diffuser performance is often presented as a series of 
curves (for different diffuser densities and one diffuser submergence) showing SOTE 
(% per unit depth) versus air flow per diffuser.   

%100
2

⋅=
OM

SOTRSOTE
 

(12) 

where 

2OM
 

= Mass rate of oxygen supply 

   

Formulation for OTR 
The oxygen transfer rate (OTR) is the rate at which oxygen is actually transferred 
under field conditions.   

( ) LjjjLL VCCakFOTR
UN

⋅−⋅⋅= ∞ )( ,
*α

 
(13) 

   

Formulation for OTE 
The oxygen transfer efficiency (OTE) is the field efficiency of oxygen transfer.   

%100
2

⋅=
OM

OTROTE  (14) 

   

Formulation of Diffuser Density, DD% 
Diffuser density is defined in terms of the coverage: 
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100
ATAD

1

100
area bioreactor

diffuserper  areadiffusers #
%DD

×=

×
⋅
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(15) 

where AT = Area of aeration tank. 

therefore: 

DD%
100

AD
AT

ATAD ==
 

(16) 

where AD = Total area of diffusers in aeration tank. 

   

Bubble Size 
Bubble size and gas/liquid interfacial area are important parameters in the analysis of 
mass transfer behavior.  In a typical fine bubble diffused air system the size of 
individual bubbles is not uniform; rather the bubbles range in size.   

   

Gas Hold-Up 
The gas hold-up is an important parameter in mass transfer studies and is frequently 
used in correlations for bubble diameter or Sauter diameter and interfacial area.  Gas 
hold-up is generally reported as the fractional gas hold-up; that is, the gas volume 
per unit dispersed phase volume.  In BioWin when a gas hold up is specified it is 
specified as a percentage of the liquid volume.  The fractional gas hold-up can be 
determined as follows: 

1100

100
+

== φ

φ
ε

D

G

V
V

 

(17) 

where 

ε  = Fractional gas hold-up 

GV  
= Volume of gas phase 

DV  
= Volume of dispersed phase 

φ  
= BioWin gas hold-up percentage 

   

Liquid Phase Mass Transfer Coefficient 
The liquid phase resistance to mass transfer is the rate controlling process in most 
gas-liquid contacting operations (Treybal, 1981).  The liquid phase mass transfer 
coefficient kL is the parameter used to describe this resistance and consequently is a 
fundamental parameter in oxygen transfer.  Unfortunately direct measurement of the 
transfer coefficient in bubble aeration systems is not possible and it is generally 
inferred from measurements of the overall mass transfer coefficient.  This method 
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results in an average value for kL, since it is conceivable that kL varies even on the 
surface of a single bubble and probably from bubble to bubble.  It should also be 
noted that calculation of kL from the overall transfer coefficient assumes that the 
specific interfacial area can be represented adequately by a single value for the whole 
reactor (unless the overall transfer coefficient is found as a function of position in the 
reactor which is uncommon in experimental work).   

   

Units for Air Flow 
BioWin presents air flowrates in: 

   

• m3/hr 

• ft3/min (SCFM) 

In each case the basis is 20°C, 1atm (14.7 psi, 101.325 kPa) 

The units for the off-gas are m3/day (in SI units) and ft3/min (CFM) at field 
conditions. 

Conclusion 
The current approach for the design of aeration systems typically involves using a 
spreadsheet program to estimate peak, average and minimum air demand in each 
aerated zone of a system, based on the estimated oxygen demand.  The peaks and 
minimums in different zones usually will not be coincident, so it is difficult to 
accurately estimate total air requirements, as well as time-varying requirements.  The 
modeling approach in BioWin overcomes these problems through quantifying (1) the 
change in oxygen mass transfer coefficient (kLaL) with changing air flow in each 
zone, and (2) accounting for different diffuser densities.  BioWin quantifies time-
and-space variations in oxygen demand, providing accurate estimates of time-
varying air supply in different zones and hence more realistic estimates of total air 
supply needs.  It also allows a comprehensive analysis of the interaction between 
diffuser density and oxygen transfer efficiency for the optimal design of aeration 
systems. 
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Anaerobic Digestion Modeling 

Introduction to Anaerobic Digestion Modeling 
This section provides a general description of the modeling of anaerobic processes in 
BioWin particularly as they would occur in anaerobic digestion processes.  The 
following subsections are included in this discussion.   

Background on Model Development:  This sub-section provides a brief 
literature review on anaerobic digestion modeling. 

Model Formulation:  This sub-section provides an overview of the structure and 
interactions of the model processes that predominate in an anaerobic digestion 
simulation. 

Anaerobic Digestion vs. Activated Sludge:  In BioWin, one comprehensive 
model for the biochemical and physical-chemical systems is used for the entire 
treatment plant.  However, the behavior of a specific unit process element and the 
dominant reactions in that element are dependant on the process environmental 
conditions such as SRT, temperature, and pH.  This sub-section describes how 
certain processes behave differently in anaerobic digestion vs. activated sludge. 

Anaerobic Digester Performance Relationships:  A series of simulations 
was conducted to examine the relationship of anaerobic digester performance to a 
number of process variables.  This sub-section summarizes the results from the 
simulations. 

Simulation of Sidestream Impact on BNR Processes:  To investigate the 
impact of the digester on biological phosphorus removal behavior, published data 
from a municipal BNR demonstration study were examined. This sub-section 
discusses this investigation. 

Background on Anaerobic Model Development 
Early mechanistic mathematical models of anaerobic digestion considered only 
methanogenic reactions based on the assumption that methane production is the rate-
limiting step in the process (Andrews, 1969; Andrews and Graef, 1971).  An initial 
extension of this conceptual framework (Hill and Barth, 1977) included the reactions 
of “acid-formers” which considered both particulate hydrolysis and production of 
volatile fatty acids (VFAs).  These early models represented the VFA concentration 
as one “bulk” component that was considered to be the sole substrate for the 
methanogens. 

The role of hydrogen in the regulation of product distribution and consumption was a 
key development that formed the basis for many subsequent models of anaerobic 
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digestion (Mosey, 1983).  This advancement allowed models to predict the formation 
of various fermentation products in addition to acetic acid, such as the higher acids 
propionic and butyric.   In addition, methane production from both acetic acid and 
hydrogen could be included.  A number of models were developed based on the 
“four population” framework of Mosey, including Costello et al. (1991) and Jones et 
al. (1992). 

Most new models for anaerobic digestion include hydrogen regulation functions and 
are being presented using the same structured matrix approach as used for activated 
sludge models such as ASM1 and ASM2.  Examples include the work of Massé and 
Droste (2000), and Bagley and Brodkorb (1999). 

Important considerations in an anaerobic sludge digestion model when included in a 
comprehensive wastewater treatment plant simulator, include: 

• Fate of influent biomass in the digester; 

• Net release of ammonia and phosphate in the digester; 

• Role of the anaerobic reactions in the activated sludge process. 

   

The International Water Association recently has published the Anaerobic Digestion 
Model No. 1 (ADM1).  Although this is a detailed and comprehensive model for 
anaerobic digestion processes, it has a number of limitations for application to plant-
wide wastewater treatment plant simulation: 

• ADM1 contains a set of state variables that is not consistent with 
standard activated sludge models (i.e. the ASM-series, the BioWin 
model and others).  An "Interface Model" is required between the liquid 
and solids line if ADM1 is used to model the digester.  Some of the 
activated sludge state variables must be “combined” into ADM1 state 
variables, and important information is lost on the fate of specific 
states. 

• ADM1 does not include phosphorus as a state variable.  The release of 
phosphorus in digesters is particularly important in simulating 
performance of BNR treatment plants. 

• ADM1 does not include nitrogen release on organism decay and does 
not maintain a nitrogen mass balance.  Ammonia release in the digester 
and return of the digester supernatant to the liquid line is an important 
consideration in a plant-wide simulation. 

Model Formulation 
A key objective in formulation of the anaerobic processes in the model was to 
maintain a consistent set of state variables, stoichiometry, and process rate equations 
throughout the BioWin model.  This allows BioWin to use one comprehensive model 
for the biochemical systems in the treatment plant – the behavior of a specific unit 
process element and the dominant reactions in that element being dependant on the 
process environmental conditions such as SRT, temperature, and pH. 

The anaerobic degradation processes in the model are based on the “four population” 
model concept.  A conceptual schematic of the model is shown in the figure below.  
The following points describe the key stages: 

• Influent biomass (which would be present in significant quantities in 
waste activated sludge) undergoes anaerobic decay in the digester.  The 
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process rates and stoichiometry are the same as for anaerobic decay in 
the activated sludge process.  The products of decay include 
unbiodegradable organic (ZE, SUS), nitrogen (XIN, NUS), and phosphorus 
(XIP) components.  If polyP organisms (Zbp) are present, the decay 
process also releases ammonia (NH3), phosphate (PO4-P), Magnesium 
(Mg) and Calcium (Ca). 

• Hydrolysis of particulate matter is mediated by the (non-polyP) 
heterotrophs.  Particulate matter may be present in the influent, or may 
consist of products from biomass decay.  The products of hydrolysis 
are phosphate (PO4-P) soluble organic nitrogen (NOS), and readily 
biodegradable COD (Sbsc). 

• Soluble organic nitrogen undergoes ammonification to produce 
ammonia (NH3-N).  This process is mediated by the heterotrophs (Non-
polyP and polyP).  

• Precipitation of struvite and calcium phosphates removes PO4-P and 
NH3-N from solution.  These are kinetically controlled processes 
described in the Spontaneous Chemical Precipitation section of 
the "Process Model Formulation" chapter. 

• Non-polyP heterotrophs ferment the complex readily degradable COD 
(Sbsc) to acetic acid (Sbsa), propionic acid (Sbsp) hydrogen (SbH2), and 
carbon dioxide (SCO2t).  There are two model processes for this reaction 
step.  One is for low dissolved hydrogen concentrations while the other 
is for high dissolved hydrogen concentrations.  The stoichiometry of 
each of these processes can be calibrated to achieve the appropriate 
product mix (see the Fermentation section of the "Process Model 
Formulation" chapter). 

• Dissolved hydrogen (SbH2) and carbon dioxide (SCO2t) are stripped from 
solution at a rate that is proportional to the difference between the 
saturated dissolved component concentration and the actual dissolved 
component concentration (see the Aeration and Gas Transfer 
Model section of the "Process Model Formulation" chapter.  It is only 
the undissociated carbonic acid form (H2CO3)  of the SCO2t component 
that is stripped from solution, so carbon dioxide stripping is pH 
dependent (see the Modeling of pH in BioWin chapter). 

• Propionic acid (Sbsp) is converted to acetic acid by acetogenic bacteria.  
This process also produces hydrogen and is switched off at high 
hydrogen concentrations. 

• Methane production occurs as a result of the growth of two different 
groups of organisms.  Acetoclastic methanogens consume acetic acid.  
The substrate of hydrogenotrophic methanogens is dissolved hydrogen 
and dissolved carbon dioxide.  

• The growth of the heterotrophs, acetogens, and methanogens is 
switched off at high pH and at low pH. 
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Conceptual schematic for the anaerobic degradation model. 

Activated Sludge vs. Anaerobic Digestion 
There are some differences in the model processes in activated sludge vs. anaerobic 
digestion. These are noted here:  
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• The anaerobic digester hydrolysis process is separate from the activated 
sludge process. Hydrolysis rate parameters are set specifically for the 
digester.  

• The anaerobic fermentation process is the same for both the anaerobic 
digester and activated sludge elements. However, the fermentation rate 
is reduced in the activated sludge process.  

   

There are a number of processes in the model that, although present in the activated 
sludge process, are not likely to be significant under the typical conditions in that 
element. These are described below:  

• The growth rate of acetogens is very low at ambient temperatures, and 
these organisms only grow under anaerobic conditions. In addition, the 
acetogen substrate concentration, Sbsp, is typically quite low in an 
activated sludge process. For these reasons, propionate acetogens will 
usually washout in the activated sludge process.  

• Methanogen growth rates are very low at ambient temperatures, and 
methanogens are obligate anaerobes. As a result, methanogens will 
usually washout in the activated sludge process.  

• In an anaerobic digester, hydrogen COD (SbH2) is converted to 
methane. In an activated sludge system, there is an insignificant 
concentration of hydrogenotrophic methanogens, so that SbH2 formed is 
largely stripped through aeration. 

• The struvite precipitation model process exists in both the activated 
sludge and the anaerobic digester elements. However, struvite 
precipitation only occurs at the high NH3-N, PO4-P and alkalinity 
concentrations usually found in the anaerobic digester. 

   

Anaerobic Digestion of BNR Biosolids – A Case Study 

Case Study Description 
To investigate the impact of the anaerobic digester on biological phosphorus removal 
behavior, data from a municipal BNR demonstration study at the York River, 
Virginia WWTP were examined (Randall, et al., 1992).  A BioWinTM2.1 
configuration for the plant during the period it was operated as an anaerobic-aerobic 
process is shown in Figure 2.  The BNR configuration includes a mixed liquor 
recycle, but the recycle rate was set to zero during the period of operation considered 
in this simulation study.  Primary solids and waste activated biosolids were 
combined and thickened prior to anaerobic digestion.  A small bioreactor is included 
in the simulator configuration following the digester to represent the point where the 
stripping of carbon dioxide and a subsequent rise in pH of the digested solids would 
occur.  Biosolids are dewatered in the configuration, and in the actual plant, filtrate 
was returned to the primary influent.  Simulation examined the impact of this filtrate 
by looking at a “No recycle” case in addition to the actual case.  A list of the BNR 
bioreactor process elements and sizes is included in Table 1. 
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Figure 1 – BioWinTM 2.1 schematic for the York River WWTP operated as an anaerobic-
aerobic process during a BNR demonstration study. 

   

Unit Process Element Description Volume (ML) 

Cell #1 Anaerobic Zone 0.42 

Cell #2 Anaerobic Zone 0.42 

Cell #3 Anaerobic Zone 0.42 

Cell #4 Anaerobic Zone 0.42 

Cell #5 Aerobic Zone 0.85 

Cell #6 Aerobic Zone 1.27 

Cell #7 Aerobic Zone 1.27 

Total BNR Liquid Volume  5.07 

Table 1 - BNR Bioreactor process elements in the simulated York River BNR Case 
Study 

   

The simulation case study considered data from the York River BNR demonstration 
period from October, 1986 to April, 1987.  Table 2 summarizes the measured 
influent characteristics during this period. 

   

Parameter Value Units 

Average Flow 32.9 ML/d 

COD 374 mg/L 

BOD5 172 mg/L 

TP 8.7 mg/L 

TKN 27.9 mg/L 

Table 2 - Measured raw influent characteristics at the York River BNR 
Demonstration for the period from October, 1986 to April, 1987. 

   

The BioWinTM 2.1 influent characteristics were calibrated using the available data.  
The resulting calibrated influent parameters are shown in Table 3.  Steady state 
simulations results were compared to reported average plant operating parameters 
during the period of interest.  The results are summarized in Table 4.  Although 
there are some differences between the reported measurements and the simulation 
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results, the values are reasonably close for the purpose of illustrating the impact of 
solids digestion recycles on the BNR process. 

   

Parameter Description Value Units 

fbs Readily 
biodegradable 

0.14 mg COD/mg total COD 

fxsp Non-colloidal slowly 
biodegradable 

0.75 mg COD/mg slowly biodegradable 
COD 

fus Unbiodegradable 
soluble 

0.08 mg COD/mg total COD 

fup Unbiodegradable 
particulate 

0.18 mg COD/mg total COD 

fna Ammonia 0.66 mg NH3-N /mg TKN 

Table 3 - Calibrated BioWinTM 2.1 influent characteristics 

   

Parameter Measured 
(mg/L) 

Simulated 
(mg/L) 

Primary Effluent Concentrations:   

COD 255 219 

BOD5 114 106 

Filtered BOD5 45 75 

TKN 30 30 

TP 10.6 10.6 

Bioreactor Concentrations:   

MLSS 2,740 2,800 

MLVSS 1,900 1,950 

Waste Activated Solids Concentrations   

TSS 6,100 6,200 

VSS 4,220 4,330 

TP 430 520 

Table 4 - Simulated and actual average operating parameters for the period 
October, 1986 to April, 1987 

Case Study Results 
As an initial indication that the simulation of the digesters was reasonable, the 
simulated biosolids produced in the case study were used in a series of steady state 
simulations of the anaerobic digesters to check the dependence of predicted 
performance on digester hydraulic retention time (HRT).  Predicted volatile 
suspended solids (VSS) destruction is shown in Figure 3.  In the typical operating 
region of 20 to 30 days, the VSS destruction is approximately 50%, which is within 
an expected range of typical performance (Parkin and Owen, 1986).  The digesters at 
York River were reported to be underloaded with an unusually long retention time.  
In this case study, they were simulated with a 90 day HRT, resulting in a VSS 
destruction of 60%. 
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Figure 2 – Predicted VSS destruction as a function of digester HRT. 

Simulation of Sidestream Impact on BNR 
Processes 
A key concern is the amount of nutrient release in the digesters, and therefore the 
additional loading on the BNR process caused by the return of solids processing 
sidestreams to the liquid train.  To illustrate this impact, a series of simulations was 
conducted to look at the amount of digester influent N and P released as a function of 
digester HRT.  Two cases were examined for each nutrient.  First, the system was 
simulated without considering struvite precipitation.  Second, the struvite 
precipitation reactions were included in the simulations.  The results are summarized 
for N as a digester concentration and as a percent of the influent N released in 
Figures 4 and 5, respectively.  The corresponding results are shown for P in 
Figures 6 and 7.  If struvite precipitation did not occur, more than 50% of the 
nitrogen in the solids would be released at a 90 day HRT, resulting in an ammonia-N 
concentration of about 500 mg/L in a filtrate recycle.  Struvite precipitation would 
reduce the net release of nitrogen to about 35%, resulting in a recycle ammonia-N 
concentration of about 350 mg/L.  The proportion of phosphorus released in the 
digester is even greater due to the storage of excess phosphorus in the biological 
phosphorus removal process.  If struvite precipitation did not occur, more then 70% 
of the phosphorus in the digester influent solids would be released at a 90 day HRT, 
resulting in a PO4-P concentration of more than 600 mg/L in a filtrate recyle.  When 
struvite precipitation reactions are considered, the proportion of P released is reduced 
to about 50%, and the corresponding PO4-P concentration in a filtrate recycle stream 
would be reduced to about 400 mg/L. 
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Figure 3 – Predicted digester NH3-N concentrations as a function of digester HRT for 
digester simulation with and without struvite precipitation reactions. 
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Figure 4 – Predicted percent of digester influent N released as a function of digester HRT for 
digester simulation with and without struvite precipitation reactions. 
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Figure 5 – Predicted digester PO4-P concentrations as a function of digester HRT for 
digester simulation with and without struvite precipitation reactions. 
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Figure 6 – Predicted percent of digester influent P released as a function of digester HRT for 
digester simulation with and without struvite precipitation reactions. 
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To illustrate the importance of digester simulation in analysing the overall behaviour 
of the BNR plant, the impact of the PO4-P in the recycle streams was examined by 
comparing simulated primary effluent and final effluent TP concentrations to 
reported results for three cases: 

• No recycle of belt press filtrate; 

• Recycle of the filtrate but without considering struvite precipitation in 
the digester; 

• Recycle of the filtrate with struvite precipitation reactions included in 
the digester simulation. 

   

The simulated results for each of the cases are compared to reported results in 
Figure 8.  At the plant, the primary effluent TP concentration typically was about 2 
mg/L greater than the raw influent concentration.  The simulated results confirm that 
this increase was due to the belt press filtrate recycle.  The primary effluent without 
the recycle would have decreased to less than 6 mg/L, resulting in a final effluent 
concentration of less then 1 mg/L.  If the recycle concentrations predicted without 
considering precipitation reactions in the digester were included in the simulation, 
the resulting primary effluent concentration would be 12.5 mg/L, resulting in a final 
effluent concentration of 5.6 mg/L.  The predicted primary effluent and final effluent 
TP concentrations were very close to the reported values when precipitation 
reactions were included in the digester simulation. 
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Figure 7 – Measured and predicted raw influent, primary effluent and final effluent TP 
concentrations for three cases of digester simulation; no recycle of belt press filtrate; recycle 
when the digester is simulated without struvite precipitation; recycle when struvite 
precipitation reactions are included in digester simulation. 
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Biofilm 

Modeling Fixed Film Processes In BioWin 
The objective of this chapter is to describe the biofilm model provided in BioWin. 
The model is implemented in the media bioreactor element and is calibrated to 
simulate MBBR and IFAS systems. 

 
 

The introduction provides general background information on the model. 

Model Formulation : this section describes the model structure, including the 
underlying assumptions. The model belongs in the 1D dynamic layered biofilm 
model category, with modifications that allow it to be used with one parameter set 
for a large range of process situations. The biofilm model is integrated with a general 
Activated Sludge/Anaerobic Digestion model combined with a chemical equilibrium, 
precipitation and pH module. This allows the model to simulate the complex 
interactions that occur in the aerobic, anoxic and anaerobic layers of the biofilm.  

Model Calibration : this section describes the basic process performance of the 
model with the default parameter set. 

Pre-Configured File 
Cabinet : Click the arrow 
next to this button (at the 
top of the main window) to 
select and load pre-
configured BioWin process 
files. 

Examples : this section contains several simulation examples. The model is shown to 
match a variety of design guidelines, as well as experimental results from batch 
testing and full-scale plant operation. Both Moving Bed BioReactors (MBBR) and 
Integrated Fixed Film Activated Sludge (IFAS) systems were simulated using the 
same model and parameter set. Several examples are provided for the user in the Pre-
Configured File Cabinet (found on the BioWin main window toolbar). 
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Introduction 
Several biofilm models have been published over the past 20 years. These vary in 
complexity from simple analytical models to full 3-D dynamic models. An extensive 
summary is provided by Wanner et al. (2006). The simpler models are easy to solve, 
but usually do not capture enough details of the important engineering 
considerations. Their parameters are highly variable from situation to situation, and 
design engineers often cannot allocate the time and effort required to calibrate them 
for different processes and process conditions. On the other hand, the complex 
models, despite their sound fundamentals, are still not used widely in engineering 
practice, unlike the activated sludge process models. The reason seems to be that 
complex, detailed models require too much computer time to solve, and are 
impractical for everyday engineering use. Their major purpose is for research. 

For the specific purpose of engineering design and analysis, a balance is required 
between the simplified and the complex mechanistic approach.  This model should 
be based on biofilm and diffusion theories but include certain empirical features that 
ensure solution stability and reasonable computational times. The biofilm model 
must be integrated with a biological process model which includes all relevant 
reactions occurring in current wastewater treatment systems. Such a model should 
see widespread application in engineering practice.  This in turn will provide better 
designs and a basis for improving the model itself. The engineering objective is to 
have a model that requires minimal calibration, and works for a wide range of 
loadings and configurations, such as  IFAS, MBBR, trickling filter (TF), rotating 
biological contactor (RBC), biological aerated filter (BAF) with the same parameter 
set. In BioWin 3.0, the physical setup for IFAS and MBBR systems is provided. 
However, other fixed film processes may be approximated using the existing model. 

Model usage 
The BioWin user working with wastewater treatment plants employing fixed film 
technology will be able to obtain answers for the following questions: 

• How much carrier material (i.e. area for biofilm growth) is required to 
achieve a specific process objective? 

• How much active biomass will the biofilm contain?  

• How thick will the biofilm grow (in mm and in gTSS/m2)  depending 
on loading and turbulence conditions? 

• How will soluble and particulate components be distributed inside the 
biofilm? 

• What part of the biofilm will be penetrated by DO, substrate, what will 
be anoxic, and what part will be anaerobic? 

• How will the reaction rates for the biological processes (growth and 
decay of heterotrophic and autotrophic biomass, fermentation, etc.) be 
distributed within the biofilm? 

• How much will release of gases (N2, CH4, CO2) in the deeper layers of 
the biofilm contribute to solids detachment? 

• Will pH effects and precipitation reactions within the biofilm 
significantly change porosity, density and conversion rates? 

 

The typical use of models in BioWin is design, optimization, training and operations. 
This requires simplicity, stability, quick solution times and proper process 
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performance predictions on a wide range of systems. The BioWin biofilm model 
achieves these objectives through the use of: 

• a well calibrated, advanced biological/chemical model, including 
aerobic, anoxic, anaerobic, fermentation, pH, chemical equilibrium, 
precipitation and gas transfer processes; 

• a one dimensional (1D) fully dynamic biofilm model configuration; 

• modified attachment/detachment and density calculation methods; 

• one validated parameter set for a wide range of systems; 

• calibration of the model to various design guidelines, batch test 
experiments and pilot and full-scale performance indicators on several 
systems; 

• a fast numerical method that provides solutions within a few minutes 
(note: the BioWin biofilm model is a complex model and runs slower 
than a bioreactor model. However every effort was made to provide a 
reasonable convergence and dynamic runtime). 

Model Formulation 
The dynamic mixed-culture biofilm model implemented in BioWin belongs to the 
class of 1D models as described by Wanner and Reichert (1996) and Reichert and 
Wanner (1997). 1D models describe soluble and particulate component profiles 
perpendicular to the media. Fundamental equations are listed in the two references. 
The model includes diffusion of soluble and particulate components, a boundary 
layer between the biofilm surface as a diffusion resistance for solutes, exchange of 
particulates due to detachment (erosion) and attachment (impingement) of solids 
between the film surface and the bulk liquid concentration. Film thickness can 
change dynamically due to substrate loading and solids exchange between the film 
and the bulk liquid. 

There are several differences and additions to the Wanner/Reichert model to improve 
its ability to predict typical process conditions using one parameter set in the 
majority of cases. 

The Biofilm Model Uses the Full ASDM Process Model 
Due to the complexity of the numerical solution, 1D biofilm models have typically 
been integrated with simple biological models. For example, models with 5-10 
components [one or two biomasses (XH, XA) and two or three limiting substrates 
(DO, SS, NH3), etc.].  The process model integrated with the biofilm model in 
BioWin is the full General Activated Sludge/Anaerobic Digestion Model (ASDM).  
The process model integrated with the biofilm model in BioWin is the full General 
Activated Sludge/Anaerobic Digestion Model (ASDM).  This model is described in 
detail in the Process Model Fornulation Chapter. The model includes reactions for 
activated sludge and anaerobic digestion environments, as well as pH, gas transfer 
and chemical precipitation within the same model matrix. The model tracks over 50 
components, with more than 80 processes acting on these components. The main 
processes are summarized below: 

• Aerobic heterotrophic growth using complex substrate, acetate, 
propionate and methanol 

• Anoxic heterotrophic growth on NO3
- and NO2

- using complex 
substrate and VFAs 
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• Anaerobic fermentation of complex substrate, propionate and methanol 

• Growth of bio-P microorganisms and storage of polyphosphate 

• Various hydrolysis, ammonification and colloid flocculation reactions  

• Assimilative nitrate and nitrite reduction 

• Anoxic growth of methylotrophs on nitrate and nitrite  

• Growth of ammonia and nitrite oxidizer biomasses 

• Growth of Anammox microorganisms 

• Growth of autotrophic and heterotrophic methanogens 

• Decay of all nine (9) active biomasses in different environments 

• pH estimation based on the phosphate, carbonate, ammonia, acetate and 
propionate systems, including strong acids and bases, plus other 
relevant reactions 

• Precipitation of various calcium, magnesium, aluminum and iron 
complexes (struvite, HDP, HAP, etc) 

• Gas transfer of O2, CO2, N2, NH3, H2 and CH4 gases 

• Inorganic suspended solids fixation during polyphosphate storage and 
heterotrophic growth 

 

This complex model has been applied extensively for modelling the large number of 
processes occurring in suspended growth biological systems, and hence calibration 
requirements are significantly reduced. 

Turbulence and Diffusion 
The mean velocity gradient (G-value) approximating turbulence in the bulk liquid is 
calculated according to Grady et al. (1999). Soluble component diffusion is 
described by Fick’s Second Law, with a diffusion resistance added due to the 
laminar layer at the biofilm surface. Diffusion coefficients are taken at 80% of clean 
water values. The model provides a simple “streamer” function to increase diffusion 
(through increasing available area) to the top layers of the biofilm in the case of 
porous films or films with streamers in high turbulence situations (e.g. an aerated 
IFAS tank).  

Attachment/Detachment 
Particulate attachment and detachment rates have a major role in establishing biofilm 
thickness, dynamics, and system activity, similar to SRT in activated sludge. 
Particulate attachment in this model is related to bulk particulate concentration. 
Detachment is a combined function reflecting the most important variables affecting 
film detachment, such as film thickness or mass per area in the film, and the effect of 
N2 or CH4 gas generation inside deeper film layers. Turbulence (G-value) is not 
included explicitly in the attachment and detachment expressions above. An 
environment with a higher G-value will usually result in a denser, more resistant 
biofilm, not necessarily a thinner film. 

Biofilm Density 
There are various mathematical descriptions in the literature to approximate density 
and porosity (Wanner et al., 2006). In the BioWin model the long term activity is 
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linked to overall biofilm density through the abundance of individual particulate state 
variables. Each particulate state variable has a characteristic density or maximum 
concentration in the film. For example, heterotrophs and autotrophs grow to a 
maximum concentration of 50 and 100 kgCOD.m-3, respectively, while inorganic 
solids have a maximum density of 1300 kg.m-3 in the film. Particulate substrate (XS) 
and organic inerts (XI) are assigned a low density (5 kgCOD.m-3). The total solids 
density, in each layer, is a weighted combination of the individual particulate 
variable densities and is used to estimate biofilm volume, thickness and the density 
profile. Inorganic suspended solids are less “sticky” and will detach easier than 
organic variables. This accounts for higher VSS/TSS ratios found in biofilms. 

Biofilm parameters at a glance 
Project|Parameters|Biofilm 
Name Default Value Typical use 

Attachment rate [ g / (m2 d)  ] 80  

Attachment TSS half sat.  [mg/L] 100  

Detachment rate [1/d] 8.00E+04 Increase to reduce biofilm thickness 

Solids movement factor [-] 10  

Diffusion neta [-] 0.8 Effects all diffusivities (min 0.5) 

Thin film limit  [mm] 0.5  

Thick film limit [mm] 3  

Assumed film thickness for tank volume 
correction [mm] 0.75  

Film surface area to media area ratio - 
Max.[ ] 1 

Increase to form streamers (max 
1.5) 

Minimum biofilm conc. for streamer 
formation [gTSS/m2] 4  

 

Project|Parameters|State variable properties 
This menu item provides access to three groups of parameters: 

• maximum biofilm concentrations 

• Effective diffusivities 

• EPS strength coefficients 

Flyby panes  
Flyby panes report the following values for the Media Bioreactor (example is using a 
typical IFAS reactor): 

Physical parameters (bottom left): 
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Performance parameters (bottom right): 

Model Calibration 

Calibration to Design and Engineering Criteria 
Various design loading guidelines for IFAS and MBBR systems were checked 
against model performance for each loading condition. A range of characteristics 
were monitored: DO and substrate penetration, heterotrophic and autotrophic activity 
and location, the level of nitrification, substrate removal efficiency, film thickness, 
biofilm mass per unit area, denitrification, fermentation, gas production in deep 
biofilm layers, as well as pH. The model provides results according to engineering 
expectations. A few selected examples are shown in Table 1. 

 
Table 1. Calibration to design guidelines 

System loading level  Low Medium High 

MBBR :     

Design BOD loading gBOD.m-2.d-1 2.0 6.7 15.0 

Model film thickness mm 0.1 0.5 1.0 

Model mass  gTSS.m-2 1.5 11.0 14.7 
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Model effluent NO3 gN.m-3 14.5 0 0 

IFAS :     

Design BOD loading gBOD.m-2.d-1 3.3 10.0 16.7 

Model film thickness mm 0.7 0.9 1.7 

Model mass  gTSS.m-2 8.3 14.2 22.1 

Model effluent NO3 gN.m-3 18.6 19.7 15.9 

  

Examples 

MBBR System 
Rusten et al. (1994) conducted an MBBR demonstration study on one of a number of 
parallel trains at the 90,000 m3.d-1 Bekkelaget treatment plant.  The MBBR unit 
received an average primary effluent flow of 5200 m3.d-1.  The process consisted of 
eight reactors in series with a total volume of 568 m3 (average empty bed HRT of 2.6 
hours).  Carrier elements provided an active biofilm surface area of approximately 
300 m2.m-3 in each zone.  The first five reactors were aerated for removal of organic 
material and nitrification.  Methanol for denitrification was introduced into Reactor 
6, and Reactors 6 and 7 were unaerated.  Reactor 8 provided post-aeration. 

Rusten et al. (1994) provide only limited information on (a) influent concentrations 
and wastewater characteristics; (b) influent load and temperature variations with time 
during the study; and (c) bulk DO concentrations in aerated zones.  Therefore it is 
not possible to conduct a comprehensive modelling exercise.  However, the paper 
does show ammonia and nitrate concentration profiles in the first 5 aerated zones for 
typical ‘high’ and ‘normal’ load situations.  The ‘normal’ load case was simulated to 
assess whether the model would at least predict reasonable trends in ammonia and 
nitrate.  The results are shown in Figure 1, comparing the model predictions (darker 
shaded bars) to the reported data (lighter shaded bars).  The simulation shows 
reasonable correspondence between predicted and observed profiles.  The under-
prediction of nitrate in Reactor 5 (and ammonia over-prediction) could be corrected 
readily by modifying bulk DO concentration.  However, the purpose is not to force a 
fit to the data given the uncertainties over operating conditions; rather, the purpose is 
to demonstrate that the model predicts the general performance reasonably.    

Ammonia Profile
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Nitrate Profile
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Figure 1:  Approximate simulation of ammonia and nitrate profiles in the Bekkelaget MBBR 
demonstration study of Rusten et al. (1994).  [Darker bars are model predictions; lighter bars 
are reported data for Reactors 1 to 5].  

IFAS System – Simulation of Full-Scale Performance 
Demonstration   
The Waterdown STP is an activated sludge plant in Ontario, Canada with a design 
capacity is 2700 m3.d-1.  Between October 1995 and June 1998, studies were 
conducted at Waterdown to evaluate IFAS options for reducing the cost of 
retrofitting larger plants for year-round nitrification (Jones et al., 1998; Jones et al., 
1999).  Between April 1997 and June 1998, an IFAS process that employed a plastic 
free-floating media was evaluated.  The study was conducted in a section of the plant 
(Plant A) that consists of two separate trains each with 224 m3 aeration tanks in 
parallel.  For the IFAS studies, media was introduced in one tank with the other train 
serving as the control.  In each aeration tank a baffle and a mixer were installed to 
create a separate 44 m3 anoxic/aerobic swing zone (20% volume fraction) at the 
influent end of the tank.  Primary effluent was split equally between the two trains, 
and each train had separate wasting (WAS) from the mixed liquor, separate 
secondary clarification and separate return activated sludge (RAS). 

The IFAS study used media that consisted of polypropylene plastic cylinders that 
were 22 mm in diameter and approximately 15 mm long with a specific (internal) 
surface area of 389 m2.m-3 at a 100% fill volume.  On April 11, 1997, 24 m3 of the 
media was installed in the section of the aeration tank downstream of the baffle in 
one of the aeration trains.  On January 20, 1998, an additional 17 m3 of media was 
added to the east aeration tank, resulting in a total fill fraction of 18 % based on the 
total aeration tank volume (22% in media zone). The performance of the media and 
control trains was monitored over the period from December, 1997 until June 1998 
to span the winter months.  The process temperature during this period reached a 
minimum of 8oC.  The solids retention time was controlled to the same target of 3 
days in both trains in an attempt to stress the nitrification performance. 

The model configuration of the Waterdown STP media and control trains is shown in 
Figure 2.  The December, 1997 to June, 1998 period was simulated by inputting 
daily primary effluent flows and wastewater characteristics, process temperatures, 
WAS flows and RAS flows, and running a dynamic simulation for the study period.  
Simulated and measured values of MLSS in each train are shown in Figure 3.  The 
excellent agreement of the simulated and measured values confirms the loading and 
wastage rates on the two trains.  Figure 4 shows the media and control train effluent 
ammonia (NH3-N) concentrations.  The figure demonstrates that the model was able 
to correctly predict the enhancement in nitrification performance provided by the 
media.  
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Figure 2:  Configuration for the Waterdown STP Media and Control trains. 
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 Figure 3:  Simulation of MLSS concentrations in the media and control trains. 
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Figure 4: Simulation of effluent NH3-N concentrations in the media and control trains. 
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IFAS System - Aerobic Batch Test 
Yerrell et al. (2001) reported on a full-scale demonstration of the IFAS system using 
a free-floating plastic media at a 7500 m3.d-1 module of the Christies Beach WWTP 
in South Australia.  The purpose of the project was to evaluate whether the existing 
plant could be retrofit to attain complete nitrification and partial denitrification 
without adding bioreactor volume or settling capacity.  The plant was step-fed with 
primary effluent and contained two anoxic zones (no media), and three IFAS zones 
each with an active biofilm surface area of approximately 86 m2.m-3.   

During the study batch testing of mixed liquor alone and mixed liquor with IFAS 
media removed from the aeration tank allowed an assessment of the nitrification 
enhancement.  The initial ammonia concentration was increased to 20 or 30 gN.m-3 
by adding NH4Cl at the start of the test, and then supplemented to maintain an 
ammonia concentration greater than 15 gN.m-3 during the batch test.  The appropriate 
amount of alkalinity to maintain a stable pH of approximately 7.2 was supplied by  
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Figure 5:  Predicted and observed nitrate response in the IFAS batch test with dissolved 
oxygen (DO) concentration increasing in stages from 0.5 to 2.0 and 4.0 g.m-3.  

adding NaHCO3.  Figure 5 shows an example of a batch test (40 L volume) 
conducted with mixed liquor (and media) removed from the IFAS-3 reactor.  
Aeration was adjusted during the test to step the bulk DO concentration from 0.5 to 
2.0 and to 4.0 g.m-3 at intervals of approximately 2 hours.  The nitrate response 
shows three distinct linear phases at each DO concentration. The figure shows the 
results of the simulated batch test response as well.  The model predicts the 
increasing nitrate production rate with each increase in DO concentration. 
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Sidestream Treatment Processes 

Modeling Sidestream Treatment Processes in BioWin 
The objective of this chapter is to describe how sidestream treatment processes are 
modeled in BioWin.  A sidestream reactor element is available to represent these 
processes in BioWin configurations. 

 
   

The Introduction provides general background information on modeling sidestream 
processes. 

Model Formulation : this section describes the model structure.  Sidestream 
modeling employs the general Activated Sludge/Anaerobic Digestion model 
combined with a chemical equilibrium, precipitation and pH module. This allows the 
model to simulate the complex interactions that occur in sidestream processes. 

Model Calibration : this section describes a number of cases where the model 
performance was compared to various process systems where suitable data was 
available for calibration. 

Pre-Configured File 
Cabinet : Click the arrow 
next to this button (at the 
top of the main window) to 
select and load pre-
configured BioWin process 
files. 

Examples: this section contains several simulation examples.  Several examples are 
provided for the user in the Pre-configured File Cabinet. 
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Introduction 
Anaerobic digestion of waste activated sludge results in release of nitrogen as 
ammonia.  Typically digested sludge is dewatered before disposal, and the liquid 
stream from the dewatering step is returned to the activated sludge process.  The 
nutrient load of the reject water stream is considerable, and can increase the influent 
nitrogen load by 15-25%.  This additional load increases the cost and complexity of 
meeting stringent effluent requirements for total nitrogen (TN).  Also, the capacity of 
the liquid train to treat additional ammonia load may be limited by factors such as 
influent alkalinity, insufficient aeration capacity, or insufficient SRT. 

A number of ‘named’ side-stream biological processes have been developed for 
treating the ammonia component of the reject water before returning it to the liquid 
train (InNitri, BABE, SHARON, ANAMMOX, CANON, DEMON, etc.).  These 
systems involve one or more of the following biological transformations, or a 
combination of these: 

• Nitritation mediated by ammonia oxidizing autotrophic bacteria – AOBs (i.e. 
conversion of ammonia to NO2) or partial nitritation (i.e. converting a portion of 
the ammonia to NO2); 

• Nitratation mediated by nitrite oxidizing autotrophic bacteria – NOBs (i.e. 
conversion of nitrite to nitrate –NO3); 

• Denitritation mediated by heterotrophic bacteria where nitrite serves as an 
electron acceptor on the addition of organic substrate with production of 
nitrogen gas; 

• Denitratation mediated by heterotrophic bacteria where nitrate serves as an 
electron acceptor on the addition of organic substrate with production of nitrite; 

• Nitrogen removal by autotrophic anammox bacteria (ANaerobic AMMonia 
OXidation).  The process converts ammonia directly into nitrogen gas in 
unaerated conditions, utilizing nitrite as an electron acceptor. 

The following terminology is used to describe combinations of the basic biological 
transformations: 

• Nitrification: nitritation followed by nitratation (i.e. conversion of ammonia to 
nitrite and then nitrate); 

• Denitrification: denitratation followed by denitritation (i.e. conversion of nitrate 
to nitrite and then nitrogen gas); 

• Deammonification: partial nitritation (i.e. converting a portion of the ammonia 
to nitrite) followed by the anammox reaction (i.e. conversion of ammonia and 
nitrite to nitrogen gas); 

A range of benefits have been identified for the different side-stream treatment 
systems; for example: 

• Seeding the activated sludge train with AOBs and NOBs grown in the side-
stream stage, allowing shorter SRTs (bioaugmentation).  

• Less carbon substrate is required to denitrify nitrite rather than nitrate. 

• Less aeration (and alkalinity) is required to convert ammonia to nitrite rather 
than nitrate. 

• In the ANAMMOX process no organic carbon is added for denitrification, and 
so there is not increased biosolids production or emission of CO2. 
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Side-stream systems focused on ammonia treatment have been implemented in a 
number of reactor configurations; for example, single and series flow-through 
CSTRs, reactor-clarifiers with sludge recycle, SBRs, attached growth systems.  The 
operating conditions of side-stream biological processes are considerably different 
from those in the main stream process.  This leads to a number of unique 
considerations for operation and control: 

• Stopping nitrification at the nitrite stage and preventing nitrate formation relies 
on the difference in growth rates between AOBs and NOBs, and the different 
temperature dependencies. 

• High concentrations of substrate and product species such as ammonia and 
nitrous acid can lead to inhibitory conditions for AOBs and NOBs.  In some 
cases successful performance depends on inhibition of certain reaction steps. 

• Careful pH control often is required for successful operation. 

• Anammox organisms have very low growth rates necessitating long SRTs, and 
long process start-up times. 

Model Formulation 
Table 1 summarizes key process considerations that a model for side-stream 
processes should include.  Several models for a number of side-stream processes 
have been reported.  For example, Volcke (2006) developed a two-step nitrification 
and denitrification model to represent the SHARON process.  Wett and Rauch 
(2003) developed a two-step nitritation-denitritation model based on detailed data 
from two full-scale reject water SBR treatment processes.  Van Hulle (2005) 
incorporated Anammox reactions into a two-step nitrification/denitrification model. 

Table 1:  Summary of key process aspects that a model for side-stream processes must 
include. 

Process 
Aspect 

Model Process Important Considerations 

Nitrification • AOB growth and decay 
• NOB growth and decay 

Different growth rates, temperature 
dependencies and inhibition effects. 

Heterotrophic 
Denitrification 

• Growth on substrate 
through denitritation 
(using nitrite as an electron 
acceptor) 

• Growth on substrate 
through denitratation 
(using nitrate as an 
electron acceptor) 

Differences in yield must be 
accounted for. 

Deammonification 
(Anammox) 

Growth and decay of Anammox 
bacteria 

Appropriate inhibitions (i.e. nitrite 
toxicity) and limitations must be 
included. 

pH All significant equilibrium 
relationships (i.e. nitric and 
nitrous acid, ammonia and 
carbonate system) 

pH modeling is essential because, for 
example, some inhibition effects are 
caused by unionized species 
concentrations. 

Gas-liquid 
interactions 

Stripping of certain model 
components such as ammonia 
and carbon dioxide 

Gas-liquid interactions are essential 
to represent pH and in some cases, to 
properly represent growth-limiting 
conditions. 
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Sidestream Modeling Uses the Full ASDM Process Model 
The reported models for the biological transformations described in the Introduction 
as important in sidestream processes were refined, and incorporated into the full 
General Activated Sludge/Anaerobic Digestion Model (ASDM).  This model is 
described in detail in the "Process Model Formulation" Chapter. The model includes 
reactions for activated sludge, anaerobic digestion and sidestream reactor 
environments, as well as pH, gas transfer and chemical precipitation within the same 
model matrix. The model tracks over 50 components, with more than 80 processes 
acting on these components. The main processes are summarized below: 

• Aerobic heterotrophic growth using complex substrate, acetate, 
propionate and methanol 

• Anoxic heterotrophic growth on NO3- and NO2- using complex 
substrate and VFAs 

• Anaerobic fermentation of complex substrate, propionate and methanol 

• Growth of bio-P microorganisms and storage of polyphosphate 

• Various hydrolysis, ammonification and colloid flocculation reactions  

• Assimilative nitrate and nitrite reduction 

• Anoxic growth of methylotrophs on nitrate and nitrite  

• Growth of ammonia and nitrite oxidizer biomasses 

• Growth of Anammox microorganisms 

• Growth of autotrophic and heterotrophic methanogens 

• Decay of all nine (9) active biomasses in different environments 

• pH estimation based on the phosphate, carbonate, ammonia, acetate and 
propionate systems, including strong acids and bases, plus other 
relevant reactions 

• Precipitation of various calcium, magnesium, aluminium and iron 
complexes (struvite, HDP, HAP, etc) 

• Gas transfer of O2, CO2, N2, NH3, H2 and CH4 gases 

• Inorganic suspended solids fixation during polyphosphate storage and 
heterotrophic growth 

This complex model has been applied extensively for modeling the large number of 
processes occurring in suspended growth biological systems, and hence calibration 
requirements are significantly reduced. 

The key difference between a sidestream reactor element and a bioreactor element, is 
that the sidestream reactor element has the Local temperature option selected by 
default as it is frequently used to model digester effluents that may be elevated in 
temperature.  The default setting is a constant temperature of 35 degrees celcius.  
Also, the sidestream reactor element is seeded appropriately to improve solution 
speed. 
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Model Calibration 

Calibration to High F/M nitrification rate tests 
High F/M tests conducted to measure nitrification rates (WERF, 2003), often result 
in a significant accumulation of nitrite in addition to nitrate.  Therefore, these tests 
provided excellent data for calibrating parameters related to nitritation (i.e. 
conversion of ammonia to NO2) as mediated by ammonia oxidizing autotrophic 
bacteria (AOBs) and nitratation (i.e. conversion of nitrite to nitrate –NO3) as 
mediated by nitrite oxidizing autotrophic bacteria (NOBs).  These tests represented a 
case where ammonia concentrations were relatively high.  Figure 1 shows a 
configuration that was used to simulate a High F/M test.  The results from the 
simulation are compared to measured data in Figure 2 

Figure 1:  BioWin configuration used to simulate a High F/M test for measurement of 
nitrification rates.  

   



 

684  •  Sidestream Treatment Processes  
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Figure 2:  BioWin simulation results and measurements from a High F/M for measurement 
of nitrification rates. 

 

Calibration to Low F/M nitrification rate tests 
Low F/M tests conducted to measure nitrification rates (WERF, 2003), sometimes 
result in some accumulation of nitrite.  In such cases, these tests provided excellent 
data for calibrating parameters related to nitritation (i.e. conversion of ammonia to 
NO2) as mediated by ammonia oxidizing autotrophic bacteria (AOBs) and 
nitratation (i.e. conversion of nitrite to nitrate –NO3) as mediated by nitrite oxidizing 
autotrophic bacteria (NOBs).  These tests represented a case where ammonia 
concentrations were low. 

The BioWin configuration used to simulate a low F/M nitrification rate test in a 
sequencing batch reactor is shown in Figure 3.  The results from the simulation are 
compared to measured data in Figure 4. 
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Figure 3:  BioWin configuration used to simulate a Low F/M test for measurement of 
nitrification rates 
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Figure 4:  BioWin simulation results and measurements from a Low F/M test for 
measurement of nitrification rates. 

   

Calibration to Sharon Process Data 
Data published on a pilot-scale SHARON process (Caffaz et al., 2005) have been 
simulated to verify the ability of the model to predict nitritation only and the washout 
of NOBs under suitable conditions.  The configuration used to simulate this process 
is shown in Figure 5.  Table 2 lists some parameters on the system.  Table 3 
summarizes the characteristics of the centrate.  The results from the simulation are 
compared to measured data in Figure 6. 
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Table 2:  Key design and operating information on a simulated nitritation reactor 

Reactor Parameter Value 
Nitritation Volume 7.4 m3 
 Dissolved Oxygen 3 mg/L 
 Temperature 35oC 

   

Table 3:  Characteristics of the centrate before treatment in the nitritation reactor 

Parameter Value Units 
Flow 5.03 m3/d 

COD 286 mg/L 

TKN 745 mg/L 

Ammonia-N 730 mg/L 

Total P 65 mg/L 

TSS 67 mg/L 

   

Figure 5:  BioWin configuration used to simulate a pilot scale SHARON  process. 
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Figure 6:  BioWin simulation results and measurements for a pilot scale SHARON process. 
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Examples 

Nitritation-Deammonification System 
A number of examples are available in the Pre-Configured File Cabinet.  Figure 7 
shows an example BioWin configuration used to simulate a nitritation-
deammonification process.  Key design and operating parameters for the sidestream 
treatment system are shown in Table 4.  The operating strategy in this system is to 
achieve approximately 100% ammonia oxidation to nitrite in the nitritation reactor, 
rather than attempting to maintain partial ammonia conversion.  The appropriate 
proportions of ammonia and nitrite in the feed to the deammonification reactor are 
achieved by adjusting the amount of centrate that bypasses the first reactor.  In this 
arrangement, 40% of the centrate bypasses the nitritation reactor and flows directly 
to the deammonification reactor.  Characteristics of the centrate flowing to the 
sidestream treatment process are shown in Table 5.  Figure 8 shows the simulated 
nitrogen removal performance in this system. 

Table 4:  Key design and operating information on a simulated sidestream treatment system 

Reactor Parameter Value 
Nitritation Volume 80 m3 

 Dissolved Oxygen 1 mg/L 

 Temperature 31 oC 

 Fraction of centrate bypassing 
nitritation reactor 

0.40 

Deammonification 
(Anammox) 

Volume 350 m3 

 Dissolved Oxygen 0 mg/L (unaerated) 

 Temperature 31 oC 

   

Table 5:  Characteristics of the centrate before treatment in the sidestream process 

Parameter Value Units 
Flow 144 m3/d 

COD 464 mg/L 

TKN 427 mg/L 

Ammonia-N 410 mg/L 

Total P 493 mg/L 

TSS 217 mg/L 
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Figure 7:  BioWin configuration used to simulate a sidestream treatment system within a 
whole-plant configuration. 
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Figure 8:  BioWin simulation results for a sidestream treatment system within a whole-plant 
configuration. 
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